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New features

New Features in Version 3.5.10

Tempo track import
● When importing tempo tracks, you can now choose to import into a new flow instead of an 

existing flow. See Importing tempo tracks.

Figured bass improvements
● The figured bass popover now accepts and interprets more entries, including double and 

triple accidentals and the overall and suspension durations of figured bass figures. See 
Figured bass popover.

Text improvements
● You can now align individual text objects with the start of systems. See Aligning text objects 

with the start of systems.

Deleting and renaming endpoint configurations
● There is a new Edit Endpoint Configurations dialog that allows you to rename and delete 

custom endpoint configurations. It also displays the plug-ins and players contained in each 
endpoint configuration. See Edit Endpoint Configurations dialog.

Expression map playback options overrides
● You can now override individual playback options in each expression map independently. 

See Expression Maps dialog.

Guitar post-bends
● You can now show post-bends, including microtonal post-bends, on notes belonging to 

fretted instruments. See Guitar post-bends.

New Features in Version 3.5.0

Highlights

Properties panel control
● New options have been added to the top of the Properties panel, allowing you to search 

and filter properties, making it easier to find properties for items with many possible 
groups. See Properties panel (Write mode).

● You can now change the property scope for local properties, allowing you to specify in 
advance that you want subsequent changes to affect all layouts and frame chains. See 
Changing the property scope.

Pitch before duration note input
● You can now input notes by selecting or playing the pitch first and only inputting the note 

once you select the duration afterwards. See Inputting notes using pitch before duration.
● Alongside pitch before duration input, you can change whether any rhythm dots, 

accidentals, and articulations you select apply to the last input note or the next note you 
input. See Changing the note-based notation input setting.

8
Dorico SE 3.5.12



Manual staff visibility
● You can now change staff visibility manually from system/frame breaks, including showing 

individual empty staves or hiding individual non-empty staves. See Hiding/Showing staves 
from system/frame breaks.

Blank staves
● You can now automatically fill pages after the final flow in layouts with blank staves, 

including filling the width of the final system with blank staves when the final system is 
not fully horizontally justified. This is a convention used by some copyists when preparing 
parts for recording sessions. See Hiding/Showing blank staves after final flows.

Expression map improvements
● A number of new options have been added to the Expression Maps dialog, allowing you 

to create new and edit existing expression maps more easily and with better results in 
playback. See Expression Maps dialog.

Used chord diagrams grids
● You can now automatically show a grid above the start of each flow that contains all chord 

diagrams used in the flow, including different voicings of the same chord. See Hiding/
Showing used chord diagrams grids.

Figured bass
● Dorico SE now offers comprehensive support for figured bass, including allowing you to 

input figures using numbers or chord symbols, from which Dorico SE calculates the figures 
required. See Figured bass.

Guitar techniques
● Guitar bends, releases, and vibrato bar dives and returns with bend intervals of up to a 

whole step (tone) are now reflected in playback as smooth adjustments in pitch. See Guitar 
bends.

● Dorico SE now supports a variety of techniques typically found in music for guitars, such as 
microtonal post-bends in Blues music and vibrato bar dives and scoops. These techniques 
can be shown on both notation staves and tablature. See Guitar techniques.

More New Features

Workspace customization
● You can now change the page color according to the layout type, such as having a different 

color for pages in part layouts than in full score layouts. See Changing the page color.
● You can now change the background color of the music area. See Changing the 

background color.

XML import/export improvements
● Text playing techniques, such as pizz. and arco, are now included when importing 

MusicXML files. Additionally, Dorico SE now identifies text-based objects, such as tempo 
marks, more reliably. See Importing MusicXML files.

● Non-default noteheads, absolute and gradual tempo marks, a wider range of time 
signatures, percussion instruments and kits, and more dynamics than previously, including 
messa di voce hairpins with specific line styles, are all now included when exporting projects 
to MusicXML. See Exporting MusicXML files.

Instant print preview
● You can temporarily hide, in any mode, all visible elements that do not print. See Hiding 

non-printing elements.

Hiding text objects
● You can now hide individual text objects, either in the current layout and frame chain only 

or in all layouts and frame chains. This allows you, for example, to show text objects in part 
layouts without showing them in the full score as well. See Hiding/Showing text objects.

New features
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Slur improvements
● You can now change the placement of individual articulations of duration relative to slur 

endpoints. See Changing the placement of articulations relative to slurs.
● The default appearance, position, and shape of slurs in various contexts has been 

improved, such as when they cross system/frame breaks or join notes with different stem 
directions. See Slurs over system and frame breaks, Slur endpoint positions, and Slur 
collision avoidance.

Clef transposition
● You can now change the octave transposition of individual clefs, for example, to 

accommodate different horn and bass clarinet transposition conventions. See Changing 
the octave of clefs.

Last but Not Least

Value field calculations
● You can now enter calculations into numeric value fields to change values, such as doubling 

or halving the existing values. See Changing values in numeric value fields.

Custom tunings for chord diagrams
● Any custom fretted instrument tunings in your project are now available when showing 

chord diagrams above staves and in used chord diagrams grids. See Hiding/Showing chord 
diagrams.

Breath mark vertical position
● You can now change whether or not to move breath marks vertically according to the 

pitches of adjacent notes, such as positioning breath marks higher above the staff when 
they are between high notes so they are easier to see. See Positions of holds and pauses.

Jazz articulation playback
● Jazz articulations now play back, provided your sound library includes the corresponding 

samples. See Jazz articulations.

Rehearsal marks below bottom staff
● You can now optionally show rehearsal marks below the bottom staff in systems in addition 

to their other system object positions. See Changing the positions of system objects.

New features
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Introduction

Thank you very much for purchasing Dorico SE.

We are delighted that you have chosen Steinberg's scoring application and hope that you will 
enjoy using it for years to come.

Dorico is a next-generation application for producing beautiful sheet music, whether you are 
a composer, arranger, music engraver, publisher, instrumentalist, teacher, or student. Whether 
you want to print your music or share it in a digital format, Dorico is the most sophisticated 
program available.

Like all of Steinberg's products, Dorico has been designed from the ground up by a team of 
musicians who understand your needs and who are dedicated to producing a tool that is both 
easy to learn and use, but also capable of results of the highest quality. Dorico also integrates 
with your existing workflow and can import and export files in a variety of formats.

Dorico thinks about music the same way a human musician does and has a deeper 
understanding of the elements of music and musical performance than other scoring 
applications. Its unique design allows an unprecedented degree of flexibility, in music input and 
editing, in score layout, in rhythmic freedom, and many other areas besides.

Most sincerely yours,

Your Steinberg Dorico Team

Platform-independent documentation
This documentation applies to the operating systems Windows and macOS.

Features and settings that are specific to one of these platforms are clearly indicated. In all other 
cases, the descriptions and procedures in the documentation are valid for Windows and macOS.

Some points to consider:

● The screenshots are taken from macOS and use the dark theme in Dorico SE.

● Some functions that are available on the File menu on Windows can be found in the 
program name menu on macOS.

Usage of musical terms
This documentation uses American terminology for musical items.

The following table lists all the notes and notations that have different names in American and 
British English:

American name British name

Double whole note Breve

Whole note Semibreve
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American name British name

Half note Minim

Quarter note Crotchet

Eighth note Quaver

Sixteenth note Semiquaver

Thirty-second note Demisemiquaver

Sixty-fourth note Hemidemisemiquaver

Hundred twenty-eighth note Semihemidemisemiquaver

Two hundred fifty-sixth note Demisemihemidemisemiquaver

Half-step Semitone

Whole step Whole tone

Staff Stave

Bar/Measure

NOTE

This documentation only uses “bar”.

Bar

Conventions
In our documentation, we use typographical and markup elements to structure information.

Typographical elements
The following typographical elements mark the following purposes.

Prerequisite
Requires you to complete an action or to fulfill a condition before starting a procedure.

Procedure
Lists the steps that you must take to achieve a specific result.

Important
Informs you about issues that might affect the system, the connected hardware, or 
that might bring a risk of data loss.

Note
Informs you about issues that you should consider.

Introduction
Conventions 
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Tip
Adds further information or useful suggestions.

Example
Provides you with an example.

Result
Shows the result of the procedure.

After Completing This Task
Informs you about actions or tasks that you can perform after completing the 
procedure.

Related Links
Lists related topics that you can find in this documentation.

Markup
Elements of the user interface are highlighted throughout the documentation.

Names of menus, options, functions, dialogs, windows, and so on, are highlighted in bold.

EXAMPLE
To open the Project Info dialog, choose File > Project Info.

If bold text is separated by a greater-than symbol, this indicates a sequence of different menus 
to open.

EXAMPLE
Choose Setup > Layout Options.

File names and folder paths are shown in a different font.

EXAMPLE
example_file.txt

Key commands
Key commands are sets of keys that perform defined tasks when pressed together. They are also 
known as “keyboard shortcuts” or “hotkeys”. Many of the default key commands use modifier 
keys, some of which are different depending on the operating system.

When key commands with modifier keys are described in this manual, they are indicated with the 
Windows modifier key first, followed by the macOS modifier key and the key.

EXAMPLE
Ctrl/Cmd-Z  means: press Ctrl  on Windows or Cmd  on macOS, then press Z .

Key commands in Dorico SE
The default key commands in Dorico SE depend on your keyboard layout.

If you move the mouse over a tool or a function, the information in brackets shows the key 
command that is used to activate or deactivate a tool or a function.

Introduction
Conventions 
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You can also do one of the following:

● Choose Help > Key Commands to open the Dorico Key Commands window, which provides 
an overview of all available key commands.

● Search for key commands of specific functions or menu items in the Preferences dialog. In 
this dialog, you can also assign new key commands or change default key commands.

RELATED LINKS
Interactive Dorico key commands map on page 48
Searching for the key commands of functions on page 49
Preferences dialog on page 45
Key Commands page in the Preferences dialog on page 47
Assigning key commands on page 50

How you can reach us
On the Help menu you find items linking to additional information.

The menu contains links to various Steinberg web pages. Selecting one of these menu items 
automatically launches your web browser and opens the page. On these pages, you can find 
support and compatibility information, answers to frequently asked questions, information 
about updates and other Steinberg products, and so on.

This requires that you have a web browser installed on your computer and a working Internet 
connection.

Introduction
How you can reach us 
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Dorico concepts

Dorico is based on a number of key concepts that come from its design philosophy.

We recommend familiarizing yourself with these concepts, as this will greatly enhance your 
ability to work efficiently with Dorico and to navigate more easily through this documentation.

Design philosophy and higher-level concepts
Deep design considerations are required to create a notation software like Dorico, which might 
be of particular interest to users familiar with scoring applications. Dorico has a forward-thinking 
design that is led by musical concepts rather than computational convenience, and this provides 
many benefits.

In most other graphically-orientated scoring applications, the highest-level concept is the staff or 
the instrument definition that creates a staff or staves. When setting up your full score in such 
programs, you start by adding the correct number of staves, and you are immediately forced 
into making decisions about the layout. This means that you must know in advance whether two 
flutes share a staff or have their own individual staves, or whether there should be two trumpets 
or three. Many of these decisions have significant effects throughout the process of inputting, 
editing, and producing individual instrumental parts.

Typically, every system of a score must contain the same number of staves, even if some 
are hidden on particular systems. This requires the user to manage common conventions for 
themselves, such as multiple players of the same instrument sharing staves. This can be time-
consuming and is naturally error-prone.

By contrast, Dorico is designed to conform more closely to how music is performed in the real 
world and to make the score a flexible expression of the practical choices that go into a musical 
performance, rather than to make the musical performance subservient to the way the score was 
initially prepared.

To that end, the highest-level concept of Dorico is the group of human musicians that performs a 
score. A score can be written for one or more groups, for example, a double choir or an orchestra 
plus off-stage chamber ensemble, and so on. Each group includes one or more players which 
correspond to the humans who play one or more instruments. Players may either be individuals 
who play more than one instrument, such as an oboist doubling cor anglais, or groups in which 
everyone plays only one instrument, such as eight desks of violinists.

One crucial difference between Dorico and other scoring applications is that the musical content 
exists independently of the score layout in which it is viewed.

The actual music played by the group in your score belongs to one or more flows. A flow is 
any span of music that stands alone, for example, a whole song, a movement of a sonata or 
symphony, a number in a musical show, or even a short scale or exercise. Players might or might 
not have any music to play in a given flow. For example, all the brass players might be omitted 
from the slow movement of a classical symphony, or certain players might have nothing to play 
in some cues in a movie score. This is no problem as you can combine players in flows in any 
combination.

Dorico’s design philosophy provides several benefits. Chief among them is its ability to produce 
different score layouts that share the same musical content. For example, in the same project 
you can create a conductor's score with as many instruments as possible condensed onto a 
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smaller number of staves, a full score with each player's music on separate staves, a custom 
score layout containing just the piano and vocal staves for choral rehearsals, and an instrumental 
part for each player that only contains the music belonging to them.

Projects in Dorico
A project is an individual file that you create within Dorico SE. It can contain multiple separate 
pieces of music of any duration, written for any combination of instruments, and use as many 
layouts as required.

For example, you can create a single project that contains all the preludes and fugues in Bach’s 
“The Well-Tempered Clavier” as separate flows. You could then have one layout that contains only 
the flows for Book 1 and another layout that contains the flows for Book 2.

In addition to the notated music, projects save other relevant information, such as the playback 
template applied.

Dorico projects are saved as .dorico files.

RELATED LINKS
Flows in Dorico on page 17
Layouts in Dorico on page 21

Modes in Dorico
Modes in Dorico SE represent a logical sequence of the workflow phases of preparing music, but 
you can switch between them at any time as required for your own workflow.

Dorico SE contains the following modes:

Setup
In Setup mode, you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how 
they interact with each other, for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and 
layouts, but you cannot select or interact with anything in the music area in Setup 
mode.

Write
In Write mode, you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. The 
available toolboxes and panels allow you to input all the notes and notation items that 
are most commonly used.

By design, you cannot move notes and items graphically on the page in Write mode. 
Graphical adjustments are only possible in Engrave mode in Dorico Pro.

Play
In Play mode, you can change how your music sounds in playback. You can do this by 
changing the playback template and assigning VST instruments, inputting automation, 
adjusting the mix, and changing the sounding duration of notes in playback without 
affecting their notated duration.

Print
In Print mode, you can print your layouts or export them as graphics files. When 
printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing. When exporting layouts, you can specify different graphics file types, 
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such as PDF or PNG, and the information you want to include in their exported file 
names.

RELATED LINKS
Setup mode on page 80
Write mode on page 143
Print mode on page 518
Play mode on page 412

Flows in Dorico
Flows are separate spans of music that are completely independent in musical content, for 
example, a single song in an album, a movement in a sonata or symphony, a number in a stage 
musical, or a short scale or sight-reading exercise of only a few bars in length. A single project 
can contain any number of flows.

Each flow can contain music for any combination of players, independently of other flows. For 
example, brass players are often tacet in the second movements of Classical-period symphonies, 
so you can remove brass players from the flow for the second movement but leave them in the 
flows for other movements. In a set of cues for a movie, for example, specific players might not 
be required in some cues, so the corresponding flows can contain only those players who have 
anything to play.

The correct assignment of players to flows allows Dorico SE, for example, to generate tacet 
sheets automatically for individual instrumental parts.

RELATED LINKS
Players, layouts, and flows on page 93
Flows on page 122
Tacets on page 389
Flow headings on page 364

Players in Dorico
In Dorico SE, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

● A solo player represents a single person who can play one or more instruments. For 
example, a clarinettist who doubles on alto saxophone or a percussionist who plays bass 
drum, clash cymbals, and triangle.

● A section player represents multiple people who all play the same instrument. For example, 
a violin section player might represent all eight desks of the Violin I section in an orchestra, 
or a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players cannot double instruments, but they can play divisi. This means that they can 
be divided into smaller units, which is commonly required for strings.

By using the concept of players, Dorico SE makes it much easier to handle, for example, 
instrument changes, divisi, and condensing music for multiple players onto a smaller number 
of staves.
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You can also group players together, for example, to separate off-stage players from on-stage 
players in a large-scale work. Grouping players together means they are positioned together in 
the score, numbered independently of players outside the group, and are bracketed together 
according to the ensemble type set for each layout.

Players can be assigned to any combination of layouts and flows.

RELATED LINKS
Players, layouts, and flows on page 93
Players on page 94
Player groups on page 119
Divisi on page 916
Brackets according to ensemble type on page 594

Instruments in Dorico
In Dorico SE, an instrument is an individual musical instrument, such as a piano, a flute, or a 
violin. Human voices, such as soprano or tenor, are also considered instruments.

In Dorico SE, instruments are held by players, just as real instruments are held by human players. 
Section players can only hold a single instrument but solo players can hold multiple instruments. 
This allows you to handle instrument changes easily, such as when an oboist doubling the cor 
anglais switches from one instrument to the other.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same solo player can appear on the same staff as 
long as no notes overlap.

Dorico SE has a database of information about the properties of each instrument. These 
include the playable range, common and uncommon playing techniques, notational conventions, 
transposition properties, tunings, clef, number of staves, type of staff, and so on. Having these 
properties predetermined makes it easier and quicker to set up projects correctly. For example, 
selecting the horn instrument with the appropriate transposition and clef setting for its part 
layout means you do not have to input a layout-specific clef. Similarly, there is a timpani 
instrument that automatically hides all key signatures.

RELATED LINKS
Instruments on page 100
Instrument changes on page 102
Transposing instruments on page 104

Popovers
Popovers allow you to input different notations and perform tasks, such as transposing a 
selection of notes, using only your computer keyboard. They are temporary value fields that use 
text entries for different items and tasks, and there are specific popovers for different purposes.

The dynamics popover with an example entry
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One of the key benefits of popovers is that you can use them as you input notes: once you 
reach the position where you want to input a new time signature, for example, you can open the 
time signatures popover using its key command, input the time signature you want, and then 
continue inputting notes.

Although specific entries are required for many notations, the correct entries for different 
notations are consistently and logically structured. For example, tuplets are always expressed as 
a ratio, such as 3:2 or 5:4. Key signatures are expressed using capital letters for major keys and 
lowercase letters for minor keys. Time signatures are expressed as a pair of separated numbers; 
common time signatures use a slash, such as 3/4 or 6/8.

During note input, and depending on the notation you are inputting with the respective popover, 
notations are input either on the currently selected note, which is usually the last note you input, 
or at the current rhythmic position, indicated by the caret.

You can always identify popovers by looking at the icon on their left-hand side. These are the 
same icons used in the Notations toolbox on the right of the window and allow you to hide/show 
the corresponding notation’s panel, which is another way you can input notations if you prefer to 
use the mouse.

You can only use popovers in Write mode, as that is the only mode where you can input notes 
and items together and change the pitch of notes.

RELATED LINKS
Caret on page 157
Note input on page 157
Notations input on page 209
Notations toolbox on page 151
Notations panel on page 153

Notes and rests in Dorico
In Dorico, the notation and division of notes and rests is determined semantically by rules based 
on convention. This means that note and rest durations can change and appear differently later 
than when you first input them.

Dorico is able to update how notes and rests are notated depending on their context because of 
the following key concepts:

1. Notes are treated as a single unit, even if they appear as a tie chain that contains multiple 
notes tied together.

2. Implicit rests automatically fill the gaps between the notes you input.

In combination with time signatures and Dorico’s understanding of their corresponding meters, 
this allows you to input only the notes you want with the duration required. It is not necessary 
to input rests between notes or input ties for notes that cross the half-bar, for example. If you 
subsequently change the time signature or move notes rhythmically to start earlier or later, 
Dorico updates how notes and rests are notated, such as by notating a quarter note as two tied 
eighth notes if it now straddles a barline or consolidating two eighth note rests into a single 
quarter note rest if they are now in the same bar.

If you tie existing notes together, you might find that they turn into a single note, such as a half 
note instead of two tied quarter notes, or into a tie chain containing more notes. This is because 
tie chains are treated as single notes in Dorico, and Dorico automatically notates and beams 
notes appropriately depending on their duration, the current time signature, and their position 
in the bar. Similarly, notes can change after you input notes immediately following them as this 
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changes the context, such as a quarter note tied to an eighth note becoming a dotted quarter 
note when it is followed by an eighth note rather than a rest.

TIP

In Write mode, selecting any part of a tie chain selects the whole tie chain because it is a single 
note. However, you can still input notations, such as dynamics, in the middle of tie chains by 
activating the caret and moving it to the required rhythmic position within the tie chain.

You can force the duration of individual notes and rests, for example, if you want to specify 
subdivisions within a tie chain that are different than the prevailing meter.

RELATED LINKS
Notes on page 718
Ties on page 938
Implicit vs. explicit rests on page 880
Note and rest grouping on page 590
Beam grouping according to meters on page 575
Caret on page 157
Inputting notes on page 161
Forcing the duration of notes/rests on page 171
Inputting ties on page 189

Rhythmic position
In Dorico, notes and items exist at rhythmic positions, which are calculated using their place in 
musical time in the flow rather than their position in a specific bar that has a particular time 
signature.

In Dorico, musical time is the number of beats starting from the beginning of each flow. For 
example, instead of a note existing on beat 3 in bar 4 in a 4/4 time signature, Dorico considers 
that note to exist at beat 15, regardless of the time signature and its position in a bar.

This approach allows for a lot of flexibility. For example, because notes and items exist 
independently of bars and time signatures in Dorico, you can change the time signature without 
changing when notes happen in relation to each other or adding rests at the end of each 
bar. Instead, the barlines simply move to different positions and note grouping is updated as 
required, such as notating a quarter note as two tied eighth notes if it now straddles a barline or 
crosses the half-bar. You can even start writing notes without inputting a time signature at all.

Similarly, you can easily push notes to later rhythmic positions or pull them in to earlier ones 
using Insert mode without the risk of them being incorrectly notated. It also means you can 
think of items existing in the music independently of notes, because items exist at a particular 
rhythmic position, rather than being attached to notes.

In Dorico, the rhythmic position of notes and items is separate from their graphical position on 
the page. The benefit of this is that you can input items at the position in the music where they 
must apply and then move them graphically without causing them to apply to different notes or 
inadvertently split multi-bar rests. For example, if you want strings to play pizzicato from the start 
of a bar, but because of tight vertical spacing you want to move the pizz. indication slightly to 
the side. Attachment lines link items to the rhythmic positions to which they apply, so it is always 
clear where they belong, but are not printed.

RELATED LINKS
Note and rest grouping on page 590
Beam groups on page 575
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Time signatures on page 949
Inputting notes in Insert mode on page 178
Notes on page 718
Caret on page 157
Rhythmic grid on page 155
Annotations on page 537

Layouts in Dorico
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts only include the music for that 
player whereas full score layouts contain all staves in the project.

A typical project for an ensemble contains several layouts. Typically, projects contain at least a 
full score layout that contains the music for all players and a part layout for each player that only 
contains their music. However, you can also create as many layouts as required.

By default when you add a player to a project, Dorico SE creates a full score layout and a part 
layout. For all subsequent players you add to the project, Dorico SE creates a part layout for each 
player and assigns them all to the existing full score layout.

Layouts can contain any combination of players and flows.

You can control practically every aspect of the visual appearance of the music in each layout 
independently, including staff size, note spacing, and system formatting. Each layout can also 
have independent page formatting settings, such as page size, margins, running headers, and 
footers.

The default formatting of pages in layouts is determined by master pages.

Deleting layouts does not delete any music from the project.

RELATED LINKS
Players, layouts, and flows on page 93
Page formatting on page 367

Master pages in Dorico
Master pages function like templates in Dorico SE, allowing the same page formatting to be 
applied to multiple different pages in different layouts.

Master pages contain arrangements of frames. Frames are boxes in which you can display text, 
music, and graphics. The default master pages contain text frames at the tops of pages, to 
display the page number and running header information, and a large music frame that takes up 
most of the page.

All pages in your score and parts inherit their layout formats from master pages. However, in 
Dorico SE, you cannot edit master pages or create new ones; this is only available in Dorico Pro.

NOTE

Changing individual pages in layouts is considered a master page override in Dorico SE. This 
includes, for example, editing the title or running header in Write mode. Pages with master page 
overrides are not automatically deleted, even if they are now empty because the layout became 
shorter.

If you want to change the information shown at the tops of pages, that is, the title and running 
header text that you cannot select, we recommend that you do so in the Project Info dialog to 
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avoid master page overrides. The big title at the top of the first page is the project title, and the 
running header on subsequent pages uses the flow title for the top flow on that page.

RELATED LINKS
Master pages on page 363
Frames on page 365
Project Info dialog on page 88
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User interface

The user interface of Dorico SE is designed to be as unobtrusive as possible while keeping all 
of the important tools at your fingertips. This chapter introduces you to key aspects of the user 
interface.

Project window
Dorico SE’s main project window allows you to access all the options and tools you need to 
work on a project. You can open multiple project windows for the same project or for different 
projects.

The project window consists of the following areas:

1 Toolbar

Allows you to access the modes, the workspace options, the Mixer, the Video window, and 
the main transport options.

2 Tab bar

In Setup mode and Write mode, the tab bar shows the tabs that are currently open. If you 
split the music area and open several tabs, tab groups are shown.

3 Project start area/Music area/Event display/Print preview area

The central part of the project window where you work on your project. When you set up 
a new empty project, this area in Setup mode and Write mode shows the project start area 
that allows you to add your first players. Once you have added a player or an ensemble, this 
area becomes the music area that shows the music notation of the currently selected layout. 
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In Play mode, this area contains an event display that shows the effects of manipulating the 
playback of your score. In Print mode, the print preview area shows a preview of how your 
project will appear when printed onto paper or exported into a graphics file format.

4 Panel

Provides notes and notations that you need to create and edit your music. Different panels 
contain different items and functions according to the mode.

5 Toolbox

Provides access to items and tools that you can use to input and edit your music. Different 
toolboxes contain different items and tools according to the mode.

6 Status bar

Allows you to choose a different view and page arrangement of the music area. It also 
contains zoom options and a summary of your current selection in the music area.

RELATED LINKS
Starting new projects on page 54
Opening multiple project windows on page 41
Showing multiple tabs in the same project window on page 40
Switching between layouts on page 36
Project window in Setup mode on page 80
Project window in Write mode on page 143
Project window in Play mode on page 412
Project window in Print mode on page 518

Toolbar
The toolbar allows you to access the modes and workspace options as well as the Mixer and 
main transport options. It is located at the top of the project window and is available in all 
modes.

● You can hide/show the toolbar by clicking the disclosure arrow above the toolbar or by 
pressing Ctrl/Cmd-6 .

The toolbar contains the following items:

1 Modes

Selectable workspaces in the project window that represent different phases in the workflow 
of preparing a score. If the width of the main project window becomes sufficiently small, the 
mode buttons become a menu.

2 Workspace options

Provide options that allow you to select different layouts to open in the music area and to 
change the working environment.

3 Show Video

Hides/Shows the Video window.

4 Show Mixer

Hides/Shows the Mixer window.

5 Mini transport

Allow to you quick access to the main transport functions, including Play, Record, and Click.

6 Activate Project

User interface
Project window 
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Shows which project is activated for playback when you have multiple projects open.

RELATED LINKS
Modes in Dorico on page 16
Mini transport on page 25
Videos on page 136
Mixer on page 469

Workspace options
The workspace options in the middle of the toolbar provide options that allow you to select 
different layouts and to change the working environment.

Layout selector

Allows you to select other layouts to show in the current tab.

Show Tabs
Shows/Hides the tab bar above the music area.

Appearance when the tab bar is hidden Appearance when the tab bar is shown

Hide/Restore Panels
Shows/Hides all open panels.

Appearance when panels are shown Appearance when all panels were previously 
shown but are now all hidden

Mini transport
The mini transport on the right of the toolbar provides quick access to the main transport 
functions of Dorico SE.

Show Transport Bar

Hides/Shows the Transport window, which contains playback and MIDI recording 
functions.

Time display
Shows the position of the playhead in one of the following formats:

● Bars, beats, and ticks

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

User interface
Project window 
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Time display showing bars 
and beats

Time display showing 
elapsed time

Time display showing the 
timecode

You can change the content shown in the time display by clicking it.

Fixed Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the current position of the playhead and its appearance changes 
according to its current mode.

You can change the tempo mode by clicking the beat unit. You can change the 
metronome mark value used in fixed tempo mode by clicking and dragging upwards/
downwards on the number.

How Fixed Tempo Mode appears when 
fixed tempo mode is active

How Fixed Tempo Mode appears when 
follow tempo is active

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Play
Starts/Stops playback from the previous playhead position.

Play when playback is stopped Play during playback

Record

Starts/Stops MIDI recording.

Click

Plays/Mutes the metronome click during playback and recording.

Activate Project

Shows which project is activated for playback when you have multiple projects open.

TIP

The Transport window contains additional transport functions.

RELATED LINKS
Transport window on page 472
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Playing back music on page 458
Moving the playhead on page 457
Changing the tempo mode on page 463
Changing the content shown in the transport display on page 473
MIDI recording on page 204
Mixer on page 469

Tab bar
The tab bar in Dorico SE allows you to display different layouts within the same project window. It 
is located between the toolbar and the music area.

TIP

If you cannot see the tab bar, click Show Tabs in the toolbar. If Show Tabs is activated, the tab 
bar is always displayed, even if only a single tab is open.

The tab bar contains the following:

1 Tabs

All tabs currently open are displayed, with their position from left to right reflecting the order 
in which you opened them. Each tab is labeled with the name of the selected layout. The tab 
currently in view in the music area is highlighted.

When you hover over an individual tab, an x appears that allows you to close the tab.

2 New Tab

Allows you to open a new tab. Tabs can contain a different layout, or an additional view of a 
layout that is already open in another tab or window.

User interface
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Project start area
The project start area is displayed in the middle of the project window in Setup mode and Write 
mode when you set up a new empty project. When you add at least one player, the view changes 
into the music area.

Project start area

The project start area shows cards that allow you to add your first players. To add players, click 
one of the cards:

Add Solo Player
Adds an individual player to whom you can assign one or more instruments.

Add Section Player
Adds a player that represents multiple players who all play the same instrument.

Add Ensemble
Adds multiple players who play different instruments. The ensembles that you can add 
represent standard combinations of musicians.

Music area
In Setup mode and Write mode, the music area shows the music notation of the currently 
selected layout. It is the central part of the project window where you work on your project.

User interface
Project window 
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Music area showing a new choir piece in page view

The music area displays layouts in either galley view or page view. The tab bar above the music 
area allows you to open multiple layouts in the project simultaneously and switch between them. 
The scroll bars to the right and to the bottom of the music area allow you to scroll within the 
layout.

You can also use the layout selector in the toolbar to show other layouts in the music area.

When panels are open on the right, left, and at the bottom of the window, the size of the music 
area can be reduced. You can hide/show panels when necessary.

RELATED LINKS
Toolbar on page 24
Switching to galley/page view on page 42
Switching between layouts on page 36
Hiding/Showing panels on page 37
Navigation on page 345
Layouts on page 124
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Print preview area
The print preview area is the central part of the project window in Print mode that shows a 
preview of what will be printed or exported as a graphic.

Print preview area displaying a score set to print 2-up

In the print preview area, you can scroll through the pages that are shown, but you cannot edit 
your layouts. If you want to make changes, you must switch to Setup or Write mode.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

If you select multiple layouts to be printed as part of the same print job, the print preview area 
only displays the first layout. If you want to show the expected page arrangement for each layout 
in the print preview, you must check each layout individually before you start printing.

RELATED LINKS
Project window in Print mode on page 518
Key Commands page in the Preferences dialog on page 47
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Panels
The panels in the project window provide the notes, notations, and functions that you need to 
set up, write, edit, and format your music. They are located on the left, right, and bottom of the 
project window.

Panels in Write mode

1 Left panel. In Write mode, this is the Notes panel.

2 Right panel. In Write mode, this is the Notations panel.

3 Bottom panel. In Write mode, this is the Properties panel.

The panels have different names and functions in each mode in Dorico SE.

Modes and their panels

Mode Left Panel Right Panel Bottom Panel

Setup Players Layouts Flows

Write Notes Notations Properties

Play n/a VST and MIDI 
Instruments

n/a

Print Layouts Print Options n/a

Some panels are displayed by default. You can hide/show each panel individually or all of them at 
the same time.

User interface
Project window 

31
Dorico SE 3.5.12



RELATED LINKS
Modes in Dorico on page 16
Hiding/Showing panels on page 37
Project window in Setup mode on page 80
Project window in Write mode on page 143
Project window in Play mode on page 412
Project window in Print mode on page 518

Toolboxes
Toolboxes are available in Write mode and Play mode. They contain different tools and options 
according to the current mode, but in general they allow you to input and modify notes and 
notation items. The Notations toolbox also determines which options are shown in the Notations 
panel.

The following toolboxes are available in the different modes:

Write mode

● Notes toolbox on the left of the project window

● Notations toolbox on the right of the project window

Play mode

● Play toolbox on the left of the project window

RELATED LINKS
Project window on page 23
Notes toolbox on page 144
Notations toolbox on page 151
Play toolbox on page 413

Status bar
The status bar at the bottom of the project window allows you to choose different views and 
page arrangements for the music area.

NOTE

Not all options in the status bar are available in all modes.

Status bar in Write mode

1 Rhythmic Grid selector

Allows you to change the rhythmic grid resolution, which affects certain aspects of inputting 
and editing, such as the amount by which items move.

2 Status display

Displays information about the current layout and selection, divided in up to three sections, 
which are, from left to right:

● Transposition of the current layout

● The bar/range of bars of the current selection
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● Summary of the selection, for example, the pitch and voice of a single selected note or 
the implied chord of multiple selected notes

3 Disclosure arrow

Allows you to show/hide the bottom panel in Setup mode and Write mode.

4 Selection tools

Allow you to switch between using the Marquee Tool and the Hand Tool in Write mode.

5 View type selector

Allows you to select one of the provided view types for the music area in Setup and Write 
mode.

6 Page arrangement options

Allow you to choose between different horizontal and vertical arrangements of either 
individual pages or pairs of pages, which are called spreads.

7 Zoom options

Allow you to change the zoom factor of the music area and its musical contents. There are 
preset zoom levels but you can also use a custom zoom level.

8 MIDI activity indicator/Audio engine connection warning

Indicates that there might be MIDI or audio problems that require your attention.

● A brief green light  indicates that Dorico SE is receiving MIDI input from a connected 
device. If the green light is persistent, a connected MIDI device is sending lots of data, 
which can cause problems.

● A warning icon  indicates that Dorico SE is unable to send MIDI events to the audio 
engine, for example, if no device is chosen or the sample rate is wrong. You can click the 
warning icon to open the Device Setup dialog, where you can fix the problem in most 
cases.

RELATED LINKS
Rhythmic grid on page 155
View types on page 34
Page arrangements for page view on page 35
Zoom options on page 35
MIDI recording on page 204
Playing back music on page 458

Selection tools
The status bar in Dorico SE contains selection tools that you can use to select items and change 
the music shown within the music area.

Marquee Tool

Allows you to drag a rectangle to select multiple notes and notations.

Hand Tool

Allows you to move the view within the music area.

TIP

● To use the other tool briefly without selecting it, you can press Shift  in addition to using the 
mouse.
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● You can change the default selection tool for all future projects on the Note Input and 
Editing page in Preferences.

RELATED LINKS
Selecting multiple items using marquee selections on page 335
Dragging pages in the music area on page 348
Preferences dialog on page 45

View types
In Dorico SE there are different ways to view your layouts. Dorico SE saves your chosen view type 
for each layout, so you only need to set it once.

The following view types are available:

Galley View
Lays out all the staves in the current layout and flow on a single continuous system.

This view type is most useful during the process of inputting the music as it allows 
you to focus on the musical content of your project. Because it shows all staves, 
galley view is particularly useful when inputting notes for solo players holding multiple 
instruments.

By default, bar numbers are shown every bar above every staff. Staff labels are also 
shown above every staff, and follow the view as you scroll so they are always visible.

NOTE

Note spacing in galley view is unjustified, meaning it neither expands nor contracts to 
fit the width of a page or a music frame. However, changes made to note spacing in 
galley view also apply to page view.

Additionally, there is no automatic vertical collision avoidance in galley view, so notes 
and items might overlap.

Page View
Displays your layout paginated exactly as it appears when you print or export it.

This view type is useful if you want to view spreads or single pages. Spreads allow you 
to work out page turns, because the performer only needs to turn the page at the end 
of the right-hand page of a pair. Viewing single pages can be helpful if you want to 
print the layout as a series of single pages. This might be necessary if you are using, for 
example, a fan-fold or concertina approach, in which case the distinction between left- 
and right-hand pages is insignificant.

TIP

You can change the default view type used for all future projects on the General page in 
Preferences.

RELATED LINKS
Preferences dialog on page 45
Switching to galley/page view on page 42
Page formatting on page 367
Players on page 94
Instruments on page 100
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Page arrangements for page view
You can change the way pages are arranged for display in the music area.

Spreads Horizontally

Displays pages in pairs as two-page spreads, with each pair laid out from left to right in 
a row.

Spreads Vertically

Displays pages in pairs as two-page spreads, with each pair laid out from top to bottom 
in a column.

Single Pages Horizontally

Displays individual pages laid out from left to right.

Single Pages Vertically

Displays individual pages laid out from top to bottom.

RELATED LINKS
Switching to galley/page view on page 42

Zoom options
Zoom options in the status bar allow you to change the displayed size of pages in the music area.

Custom Zoom
Opens a dialog that allows you to set a custom zoom percentage.

Set Zoom
Allows you to select one of the preset zoom scaling factors. You can set a permanent 
zoom factor for all future projects on the General page in Preferences.

Zoom Out
Decreases the size of notes and notations in the music area.

Zoom In
Increases the size of notes and notations in the music area.

RELATED LINKS
Preferences dialog on page 45
Zooming in/out of the music area on page 348

Disclosure arrows
Disclosure arrows indicate that objects and menus can be expanded/contracted, either vertically 
or horizontally.

In Dorico SE, disclosure arrows are commonly used to hide/show panels, sections, and advanced 
options, and to expand/contract cards, such as player cards in the Players panel in Setup mode.
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Disclosure arrow for the bottom 
panel

Disclosure arrows for both the 
player card and the instrument 
within it

Disclosure arrows for sections in 
the Tempo panel

RELATED LINKS
Hiding/Showing panels on page 37
Players panel on page 81
Instruments on page 100

Workspace setup
Dorico SE enables you to set up your workspace according to your working style.

Dorico SE allows you to open multiple tabs to display multiple layouts in the same project within 
the same window. You can also open the same project in several windows.

RELATED LINKS
Hiding/Showing panels on page 37
Navigation on page 345
Starting new projects on page 54

Switching between layouts
If you have created several layouts in your project, you can switch between which is displayed in 
the music area in every mode, for example, to check individual part layouts. In Setup mode and 
Write mode, this changes the layout displayed in the current tab only.

NOTE

You can only switch between layouts to which players are assigned.

PROCEDURE

● Switch to another layout in any of the following ways:

● Press Shift-Alt/Opt-]  to switch to the next layout.

● Press Shift-Alt/Opt-[  to switch to the previous layout.

● Select an item on a staff or in the piano roll of the player whose layout you want to open 
and press W .

NOTE

Implicit rests are not items.

● Select a layout from the layout selector in the toolbar.
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RESULT
The selected layout is opened in the music area. It replaces the layout previously open in the tab.

RELATED LINKS
Layouts on page 124
Implicit vs. explicit rests on page 880

Hiding/Showing panels
You can hide/show individual or multiple panels. This is useful if you want to see more of the 
music area, for example.

PROCEDURE

● Hide individual panels or all panels in the following ways:

● To hide/show the left panel:

Press Ctrl/Cmd-7 .

Click the disclosure arrow on the left edge of the main window.

Choose Window > Show Left Panel.

● To hide/show the right panel:

Press Ctrl/Cmd-9 .

Click the disclosure arrow on the right edge of the main window.

Choose Window > Show Right Panel.

● To hide/show the bottom panel:

Press Ctrl/Cmd-8 .

Click the disclosure arrow at the bottom of the main window.

Choose Window > Show Bottom Panel.

● To hide/show all panels:

Press Ctrl/Cmd-0 .

Click Hide/Restore Panels .

Choose Window > Hide/Restore Panels.

RESULT
The corresponding panels are hidden/shown. Panels are hidden when no tick is shown beside 
the corresponding panel in the menu, and shown when a tick is shown in the menu.

If you hide all active panels, the Hide/Restore Panels button in the toolbar changes its look and 
indicates which panels were active but are now hidden.
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EXAMPLE

Appearance when panels are shown Appearance when all panels were previously shown 
but are now all hidden

Opening new tabs
You can open multiple tabs in the same project window, which you can use to display multiple 
layouts or different views of the same layout. For example, you can show your full score layout in 
page view in one tab and in galley view in another tab.

Each tab can contain a separate layout or a different view of a layout already open in another tab 
or window. Whenever you open a new tab, you are prompted to select a layout that you want to 
display in the tab.

You can find tabs in the tab bar, located at the top of the music area, below the toolbar. If you do 
not see any tabs, click Show Tabs  in the toolbar.

PROCEDURE

1. Open a new tab in any of the following ways:

● Press Ctrl/Cmd-T .

● At the right end of the tab bar, click New Tab .

● Choose Window > New Tab.

A new tab opens that shows recent layouts at the top and a list of other layouts in the project 
at the bottom.
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2. Select a layout to open in the new tab in any of the following ways:

● Click one of the icons.

● Select a layout from the list at the bottom.

● Select a layout from the layout selector in the toolbar.

RESULT
The layout that you choose opens in the active tab.

TIP

You can also switch between different layouts within the same tab.

RELATED LINKS
Tab bar on page 27
Toolbar on page 24
Switching between layouts on page 36

Closing tabs
You can close individual tabs of layouts that you no longer need, and you can close multiple tabs 
at the same time.

PROCEDURE

● Close tabs in any of the following ways:

● Select the tab you want to close and press Ctrl/Cmd-W .

● Hover over the tab you want to close and click x.

● Right-click the single tab you want to close and choose Close Tab from the context 
menu.

● Right-click the tab you do not want to close and choose Close Other Tabs from the 
context menu.

NOTE

You cannot close the last tab in a window. If only one tab is open and you no longer want to 
see the tabs, deactivate Show Tabs in the main toolbar. The tab is no longer displayed, but 
the corresponding layout is still shown.

RESULT
If you selected a single tab and closed it, the selected tab and its corresponding layout are 
closed.

If you selected a single tab and closed other tabs, all open tabs except for the selected tab are 
closed.

Switching between tabs
You can switch between different open tabs to show different layouts in the music area.

PROCEDURE

● Switch tabs in any of the following ways:
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● Press Ctrl-Tab  to cycle through all open tabs.

● Press Ctrl-Shift-Tab  to cycle through all open tabs in reverse order.

● Click the tab to which you want to switch.

Changing the order of tabs
You can move tabs to a different position on the tab bar.

PROCEDURE

● Click and drag a tab to the new position.

The other tabs move to show where the dragged tab will be positioned.

Showing multiple tabs in the same project window
You can split your project window to display two tabs at the same time. The split can be either 
vertical or horizontal, allowing you to display different layouts either side by side or above one 
another.

Splitting your project window divides your currently open tabs into two groups. You can move 
tabs between the groups, for example, to compare different layouts or to compare two views of 
the same layout.

PROCEDURE

1. Select the tab of the layout that you want to move to a new tab group.

2. Split the view in one of the following ways:

● To show layouts side by side, choose Window > Vertical Split.

● To show layouts above one another, choose Window > Horizontal Split.

RESULT
The project window is split to show two tabs at the same time. The selected tab is moved to the 
new tab group.

Moving tabs to another tab group
You can move tabs to other tab groups.

PREREQUISITE
You have opened at least two tabs and they are both shown in the same project window.

PROCEDURE

● Click and drag the tab into the target tab group.

RELATED LINKS
Opening new tabs on page 38
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Moving tabs to other windows
You can move tabs to another open window of the same project to show the corresponding 
layouts in a new window.

NOTE

● The layouts must belong to the same project. If you attempt to move a tab to a window of a 
different project, a new window is created for the project to which the layout belongs.

● You can only move tabs to other windows if you have opened at least two tabs.

PROCEDURE

● Do one of the following:

● To create a new window of the same project with the tab inserted, click and drag a tab 
horizontally to the right/left, away from the tab bar and release it.

● To insert the tab into the tab bar of another window of the same project, click and drag a 
tab onto the tab bar.

● Select a tab, right-click it, and choose Move Tab To New Window from the context 
menu.

● Select a tab and choose Window > Move Tab To New Window.

Opening multiple project windows
You can open multiple project windows for the same project, for example, if you want to work 
on multiple layouts at the same time. You can also show a different mode of the same project in 
each window, such as having one window show Write mode and another show Play mode.

During playback, all windows that belong to the same project show the playhead and move the 
view to follow the music.

PROCEDURE

● Open a new project window in any of the following ways:

● Press Ctrl/Cmd-Shift-T .

● Choose Window > New Window.

RESULT
A duplicate of the window opens. It contains the same tabs and the same view options as the 
original window.

RELATED LINKS
Playhead on page 457

Changing to full screen mode
You can maximize the amount of screen space available for your music by making any project 
window cover the whole screen.

You can also hide the desktop elements provided by your operating system, for example, the 
task bar in Windows or the system menu bar and Dock in macOS.
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Within Dorico SE, you can also hide/show the panels on the right, left, and at the bottom of the 
window.

PROCEDURE

● Choose View > Full Screen.

AFTER COMPLETING THIS TASK
To return to the default view, choose View > Full Screen again.

RELATED LINKS
Hiding/Showing panels on page 37
Zooming in/out of the music area on page 348

Switching to galley/page view
You can switch between different view types in the music area in Setup mode and Write mode, 
for example, if a flute player in your project is doubling piccolo, you can switch to galley view to 
see the piccolo staff in addition to the flute staff.

PROCEDURE

1. Switch to galley or page view in any of the following ways:

● Press Ctrl/Cmd-Alt/Opt-2  to switch to galley view.

● Press Ctrl/Cmd-Alt/Opt-1  to switch to page view.

● In the status bar, select Galley View or Page View from the view selector.

2. Optional: If you selected Page View, choose one of the available page arrangements in the 
status bar.

Spreads Horizontally Spreads Vertically Single Pages 
Horizontally

Single Pages Vertically

RESULT
The view type in the music area is changed. In page view, only staves containing notes or items 
are shown by default. For players holding multiple empty instruments, only the top instrument is 
shown in full scores.

In galley view, all staves in the project are shown. By default, guide bar numbers are shown 
above each staff and guide instrument labels are shown above each instrument. For players 
holding multiple instruments, the player name is also shown in guide instrument labels.

NOTE

● Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps between 
staves in galley view on the Vertical Spacing page in Setup > Layout Options.
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● You can change the default view type used for all projects in the View section of the General 
page in Preferences.

RELATED LINKS
View types on page 34
Page arrangements for page view on page 35
Changing the staff spacing in galley view on page 410
Zooming in/out of the music area on page 348
Hiding/Showing guide bar numbers on page 566
Renaming players on page 130
Music area on page 28

Changing the window color theme
You can change the color theme used throughout Dorico SE, for example, you might switch to 
the light theme if you prefer to read dark text on a light background. By default, Dorico SE uses 
the dark theme, which shows light text on a dark background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Window section, select one of the following options from the Theme menu:

● Dark

● Light

4. Click Apply, then Close.

RESULT
The color theme used in Dorico SE is changed. This affects the current project immediately and 
all future projects you open, until you next change your setting.

EXAMPLE

Dark theme Light theme
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Changing the page color
You can change the color of pages in each of the different layout types, for example, to help you 
identify whether you are in a part layout or full score layout, or to make reading the music easier 
or more comfortable.

By default, full score and custom score layouts have white pages, while part layouts have cream 
pages.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Page Colors subsection of the View section, change the page color for Full score 
layouts, Part layouts, and/or Custom score layouts in any of the following ways:

● Click the corresponding color preview and select a color in the Select Color (Windows)/
Colors (macOS) dialog.

● Enter a color code into the corresponding value field.

4. Click Apply, then Close.

RESULT
The page color in layouts of the corresponding type is changed in the current project and 
all future projects you open. This does not affect the resulting page color when exporting or 
printing layouts.

TIP

You can reset page colors back to the default factory settings by clicking Reset for each layout 
type.

RELATED LINKS
Layouts on page 124
Printing layouts on page 522
Exporting layouts as graphics files on page 525

Changing the background color
You can change the background color of the music area. The background can be a gradient of up 
to four colors or a single block color.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Background Colors subsection of the View section, choose one of the following 
options for Use for Write mode:

● Gradient

● Single Color

4. Change the background color in one of the following ways:

● If you chose Gradient and want to use a preset selection of colors, select it from the 
Preset menu.
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● If you chose Gradient and want to use a custom selection of colors, either click each 
color preview and select a color in the Select Color (Windows)/Colors (macOS) dialog or 
enter color codes into the value fields.

● If you chose Single Color, either click the Stop 1 color preview and select a color in the 
Select Color (Windows)/Colors (macOS) dialog or enter a color code into the value field.

RESULT
The background color is changed in the current project and all future projects you open.

TIP

● The background color set for Write mode is also used in Setup mode.

● You can reset background colors back to the default factory settings by clicking Reset.

Changing your preferred unit of measurement
You can change your default preferred unit of measurement to be used throughout Dorico SE for 
options that use absolute measurements, such as the size of page margins in Layout Options.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the General section, select one of the following options from the Preferred unit of 
measurement menu:

● Points (pt)

● Millimeters (mm)

● Inches (in)

● Centimeters (cm)

4. Click Apply, then Close.

Preferences dialog
In the Preferences dialog, you can make permanent settings for your workspace and define key 
commands.

You can open Preferences in any of the following ways:

● Press Ctrl/Cmd-, .

● Choose Dorico > Preferences (macOS).

● Choose Edit > Preferences (Windows).
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The Preferences dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the current setting is highlighted.

NOTE

The arrangement of options on the Key Commands page is significantly different to other 
pages in the Preferences dialog. This page is described separately in further detail.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:
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● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

RELATED LINKS
View types on page 34
Zoom options on page 35
Selection tools on page 33
Layout Options dialog on page 90
Key commands on page 13
Changing values in numeric value fields on page 150

Key Commands page in the Preferences dialog
The Key Commands page in the Preferences dialog allows you to view all the items and 
functions that can be assigned key commands, change existing key commands, and assign new 
key commands to items and functions that have no key command assigned by default.

Most of the main menus in Dorico SE have key commands for certain menu items. In addition, 
there are other Dorico SE functions that can be assigned key commands. This can be helpful for 
items or actions that you find yourself performing regularly, such as changing the rhythmic grid 
resolution or exporting all layouts to PDF.

● You can find the Key Commands page by opening the Preferences dialog and clicking Key 
Commands in the category list.

The Key Commands page comprises the following:

1 Search field
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Allows you to search for menu items and functions to view, change, or add key commands. 
Because there are multiple levels of disclosure arrows before you reach many menu items 
and functions, this is often the quickest way to find what you are looking for.

2 Menu items and functions

Displays the menu items and functions that can be assigned key commands. The list can be 
filtered using the Search field. Disclosure arrows beside options indicate that further options 
are available when the option is expanded.

Hovering over menu items and functions shows a tool tip, which is helpful for some 
functions with particularly long names.

3 Key Commands section

Allows you to see any existing key commands set for the selected menu item or function in 
the list of assigned key commands and to set new ones. If you enter a key command that has 
already been assigned to another menu item or function, a warning tells you that you cannot 
use that key command.

You can assign multiple key commands to the same menu item or function, and the 
Keyboard language menu allows you to assign different key commands for each of the 
available languages.

● Add Key Command: Adds the key command you pressed to the selected menu item or 
function.

● Remove Key Command: Removes the currently selected key command from the 
selected menu item or function.

● Print Summary: Directs you to an offline page in a web browser that displays your key 
commands on an interactive keyboard.

● Reset Key Commands: Resets all of your key commands to their defaults.

4 MIDI Learn section

Allows you to assign MIDI controllers, notes, and combinations of notes to control menu 
items and functions.

● MIDI Learn : Prepares Dorico SE to receive the MIDI input data that you want to save 
as a command.

● Add MIDI Command: Adds the MIDI controllers or notes you changed or pressed to the 
selected menu item or function.

● Remove MIDI Command: Removes the MIDI command from the selected menu item or 
function.

RELATED LINKS
Assigning key commands on page 50
Assigning MIDI commands on page 50

Interactive Dorico key commands map
The interactive Dorico Key Commands map shows a virtual computer keyboard, with keys that 
have been assigned key commands highlighted in different colors according to the modifier 
keys they contain. All key commands for the selected keyboard language layout are listed below, 
divided into global and mode-specific groups.

You can open the Dorico Key Commands map in any of the following ways:

● Choose Help > Key Commands.

● Choose Edit > Preferences, and click Print Summary in the Key Commands section of the 
Preferences dialog.
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The interactive key commands map as it appears when US English is selected

The Dorico Key Commands map opens in a web browser. It allows you to do any of the 
following:

● To see the available key commands, select a context. The context of a key command is the 
mode in which it can be used. Key commands that have a global context work in all modes.

● To highlight the keys that you can press in combination with modifier keys to form a key 
command, press one or more modifier keys on your computer keyboard, such as Shift  or 
Ctrl/Cmd - Alt/Opt , or click a modifier key on the virtual keyboard. The virtual computer 
keyboard highlights the pressed/clicked keys and displays the assigned functions on each 
key.

● To search for a specific key command, enter one or multiple words in the search field.

● To get an overview of all available key commands, browse the key commands that are listed 
below the virtual keyboard. The key commands are listed according to the context in which 
they can be used.

RELATED LINKS
Changing the keyboard layout on page 51

Searching for the key commands of functions
You can search for key commands that are assigned to functions or menu items in Dorico SE.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Key Commands in the category list.

3. Enter the name of a function in the Search field.

The entries that are listed below are filtered according to the words that you enter.

4. Expand an entry and select the function for which you want to see the key command.
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For particularly long names, you can hover over them to see a tool tip.

RESULT
If the function has a key command, it is shown in the list of assigned key commands.

TIP

You can also search for functions in the interactive key commands map.

Assigning key commands
You can assign key commands to many menu items and functions, for example, if you use 
a menu item frequently and want to be able to access it quickly but it does not have a key 
command assigned by default. You can also change existing key commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Key Commands in the category list.

3. Search for the name of a function and select it.

For particularly long names, you can hover over them to see a tool tip.

4. Optional: Press Remove Key Command if the function already has an assigned key 
command.

If you assign a new key command without removing an existing one, you can use either key 
command.

5. Click the Press shortcut input field.

6. Press the key command that you want to assign on your computer keyboard.

7. Click Add Key Command.

The key command is added to the list of assigned key commands.

8. Click Apply, then Close.

RESULT
The key command you pressed is assigned to the selected menu item or function. You can use it 
immediately.

RELATED LINKS
Resetting key commands on page 51

Assigning MIDI commands
You can assign specific keys or buttons on your MIDI keyboard to perform functions and access 
menu items. For example, if you want to navigate using MIDI keys during chord symbol input.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Key Commands in the category list.

3. Select the menu item or function to which you want to assign MIDI commands.

For particularly long names, you can hover over them to see a tool tip.
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4. Click MIDI Learn .

5. Press the key or button on your MIDI keyboard that you want to assign to the selected 
parameter.

6. Click Add MIDI Command.

7. Click Apply, then Close.

Changing the keyboard layout
You can change the keyboard layout in Dorico SE to that of another language. This allows you to 
use the predefined key commands for the selected language.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Key Commands in the category list.

3. Select a different keyboard layout from the Keyboard language menu.

4. Click Apply, then Close.

RESULT
You can immediately use the available key commands for the selected language.

Removing key commands
You can remove individual key commands from a function.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Key Commands in the category list.

3. Search for the name of a function and select it.

4. Click Remove Key Command.

5. Click Apply, then Close.

RESULT
The key command is removed from the selected function.

RELATED LINKS
Searching for the key commands of functions on page 49

Resetting key commands
You can reset all the key commands in your project to their defaults.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Key Commands in the category list.

3. Click Reset Key Commands.
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4. Click Apply, then Close.

RESULT
All custom key commands are deleted and the default key commands are reinstated.
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Project and file handling

In addition to opening and importing/exporting projects and other file formats, project and file 
handling also includes auto-save and project backups.

RELATED LINKS
Starting new projects on page 54
File import and export on page 59
Auto-save on page 76
Project backups on page 78

Hub
When you start Dorico SE, the Hub opens. The Hub keeps you up-to-date with the latest Dorico 
information and tutorials, and assists you with organizing your projects.

The Hub contains the following:

1 Recent Projects

Allows you quick access to the projects that you worked on last. Selecting Recent Projects 
shows them in the list. You can scroll through the list using either a mouse/touchpad or the 
Up Arrow / Down Arrow  keys.

2 Project template categories

Allows you quick access to a suitable project template in the available categories. Selecting a 
category shows the possible templates in that category in the list.

3 New Empty Project

Starts a new project with no players or flows.

4 List
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Displays either recent projects or project templates, depending on your selection on the left 
of the dialog.

5 Open Other

Allows you to search for and open any other project file in the File Explorer/macOS Finder.

6 New from Template (project template selected)

Creates a new project using the selected project template. This option is only available if you 
have selected a project template.

Open Selected Project (recent project selected)

Opens the recent project file that you selected in the list.

7 User Forum

Links you to the user forum on the Steinberg website.

8 Downloads

Links you to the downloads page on the Steinberg website, where you can find relevant 
update installers and a link to the documentation.

9 Upgrade

Links you to the Steinberg online shop and automatically puts an upgrade to Dorico 
Elements in your cart for purchase.

10 News

Displays recent Dorico news from the Dorico blog. Double-clicking a news item, or selecting 
it and clicking Read More, opens it in a web browser.

11 Video Tutorials

Displays recent Dorico video tutorials. Double-clicking a video tutorial, or selecting it and 
clicking Watch Now, opens it in a web browser.

12 More Videos

Links you directly to the Dorico YouTube channel, where you can find tutorial videos and 
information about new features.

RELATED LINKS
Opening recent projects from the Hub on page 57
Project template categories on page 55

Starting new projects
Dorico SE provides several ways to start new projects.

PROCEDURE

● Start a new project in any of the following ways:

● Press Ctrl/Cmd-N .

● Choose File > New.

● In the Hub, click New Empty Project.

RESULT
A new project window opens.
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Starting new projects from project templates
Dorico SE provides multiple project templates that you can use to start a new project, for 
example, multiple types of orchestras and vocal ensembles.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two, so only 
templates containing one or two players are available.

PROCEDURE

1. In the Hub, select one of the following project template categories:

● Orchestral

● Band

● Jazz

● Chamber

● Choral and Vocal

● Solo

2. Select a project template in the list.

3. Click New from Template.

RESULT
The project template opens in a new project window.

TIP

You can also start a new project from a template at any time by choosing File > New From 
Template > [Template category] > [Project template].

AFTER COMPLETING THIS TASK
You can add additional players/instruments and delete players/instruments that were included in 
the template to customize your project.

RELATED LINKS
Brackets according to ensemble type on page 594
Adding solo/section players on page 95
Adding instruments to players on page 105
Deleting players on page 98
Deleting instruments on page 108

Project template categories
Dorico SE provides a number of different project template categories. Projects started from 
different project template categories have different default settings that follow conventions as 
appropriate for the ensemble, such as for bracketing and bracing or staff labels.

Orchestral
Large ensembles containing most Western instruments, including strings, woodwinds, 
brass, and percussion.
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Band
Large ensembles containing primarily wind instruments, including woodwind and 
brass instruments, and optionally percussion and other instruments, such as strings 
and guitars.

Jazz
Popular ensembles commonly used to perform jazz, such as big band or jazz trio.

Chamber
Typically small ensembles containing only a few players, such as string quartet.

Choral and Vocal
Ensembles containing voices, including popular choir arrangements, such as SATB 
unaccompanied.

Solo
Ensembles containing only a single player/instrument, such as a solo organ or guitar 
with tablature.

RELATED LINKS
Brackets according to ensemble type on page 594
System objects on page 913

Opening projects/files
You can open Dorico SE projects at any time and in addition to other open projects, for example, 
if the project you want to open is not listed as a recent project in the list in the Hub. You can also 
open MusicXML and MIDI files.

PROCEDURE

1. Open the File Explorer/macOS Finder in any of the following ways:

● In the Hub, click Open Other.

● Choose File > Open.

● Choose File > Open Recent > [Project file name].

2. Locate and select the files you want to open.

3. Click Open.

RESULT
The selected Dorico projects are opened.

If you opened MusicXML or MIDI files, Dorico SE creates new project files from the MusicXML or 
MIDI content, which you can save as default Dorico projects.

If MusicXML files include page size, margin, and staff size settings, Dorico SE imports those 
values. If they are not included, Dorico SE creates suitable settings according to the number of 
instruments in the file.

NOTE

● You can also import MusicXML and MIDI files as new flows in existing projects rather than 
opening them as separate projects.

● In Dorico SE, the maximum number of players you can have in a single project is two. If you 
open a project that contains more than two players, it opens in read-only mode.
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RELATED LINKS
Hub on page 53
Importing MusicXML files on page 63
Importing MIDI on page 65

Opening recent projects from the Hub
You can open a project on which you have recently worked from the Steinberg Hub.

PROCEDURE

1. In the Hub, click Recent Projects.

2. In the list, select a recent project in any the following ways:

● Press Up Arrow / Down Arrow  to navigate to the project file name, then press Return 
to open it.

● Double-click a project file name.

● Select a project file name and click Open Selected Project.

RESULT
The selected Dorico projects are opened.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. If you open 
a project that contains more than two players, it opens in read-only mode.

Projects from different versions of Dorico
You can open projects that were last saved in other versions of Dorico than the one you have. In 
such cases, Dorico SE shows a warning message to make you aware of any implications.

The contents of the warning message vary according to the version of Dorico in which the project 
was last saved:

● When opening a project last saved in an older version, it shows the version number the 
project was last saved in and informs you that the project will be updated to your current 
version.

● When opening a project last saved in a newer version, it shows only that the project is from 
a newer version. It also informs you that items and notations from that version might not 
appear and will be deleted if you save the project in your current version.

In both cases, opening the project is non-destructive. This means that its contents and 
formatting are unaffected if you do not save it.

You can prevent Dorico SE from showing you warnings about projects from different versions 
in the Files section of the General page in Preferences. In the same section, you can also tell 
Dorico SE to prompt you to choose a new location for projects from different versions when you 
save them. This reduces the risk of you overwriting them by mistake.

RELATED LINKS
Preferences dialog on page 45
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Missing Fonts dialog
The Missing Fonts dialog appears when you open a project that contains a font that you do not 
have installed on your computer. It allows you to select replacement fonts that are installed on 
your computer as substitutes.

The Missing Fonts dialog displays a table with multiple columns that identify the specific font 
families and styles that are missing for font, character, and paragraph styles and text objects. 
Every place in the project where a font is missing has its own row. For example, if the bold style 
of a font family is used in three different paragraph styles, three rows are shown in the dialog, 
one for each paragraph style.

The Missing Fonts dialog comprises the following:

1 Missing Family

Contains a list of font families included in the project but missing on your computer.

2 Missing Style

Contains a list of the specific styles within the corresponding font families that are included 
in the project but missing on your computer.

3 Used By

Contains a list of the places in the project where the corresponding font is used.

4 Replacement Family

Allows you to select replacement font families. Once selected, their names are displayed in 
the corresponding entry.

5 Replacement Style

Allows you to select any of the available styles within the corresponding replacement font 
families. Once selected, the styles are displayed in the corresponding entry.

6 Fonts
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Contains a list of all the available fonts installed on your computer. You can access the menu 
in the Replacement Family and Replacement Style columns by double-clicking any entry.

TIP

You can choose whether or not the Missing Fonts dialog appears when you open a project 
containing fonts not installed on your computer on the General page in Preferences.

RELATED LINKS
Preferences dialog on page 45
Text editor options in Write mode on page 308

File import and export
External files are files in different formats than Dorico projects, such as MIDI, MusicXML, or 
tempo tracks. It is possible in Dorico SE both to import and export different types of files.

This can be useful if, for example, you want to share your project with others who use a different 
notation software, or to convert the notes, audio, or time signatures and tempo information in 
your project into other formats.

RELATED LINKS
Exporting layouts as graphics files on page 525

Importing flows
You can import individual flows into existing projects, for example, if you want to bring together 
multiple existing pieces into one project for publishing, or if you have an empty project file with 
your preferred settings saved and want to reuse those settings.

PROCEDURE

1. Choose File > Import > Flows to open the File Explorer/macOS Finder.

2. Locate and select the project files of the flows you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected project.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. In the Import flows list, activate the checkbox for each flow you want to import.

6. Click OK to import the selected flows and close the dialog.

7. Optional: If you selected multiple projects from which to import flows, repeat steps 4 to 6 for 
each project. The Flow Import Options dialog reopens automatically for each project.

RESULT
The selected flows are imported into the project.

● If you chose Create All New Players, new players are added as required for each flow.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
flows and existing project have in common are merged, for example, if you imported a flow 
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containing a solo piano into a project containing a piano and viola, the imported flow is 
added to the existing piano player.

NOTE

● Players are not automatically added to flows that you imported into the project.

● You can also open flows directly if you want them to be separate projects rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 56
Flows on page 122

Flow Import Options dialog
The Flow Import Options dialog allows you to determine whether players in imported flows are 
merged with existing players in the project and which flows from within other projects you want 
to import.

● You can open the Flow Import Options dialog by choosing File > Import > Flows and 
opening a Dorico project from the File Explorer/macOS Finder.

The Flow Import Options dialog comprises the following:

1 Player handling

Allows you to determine how imported flows are assigned to players.

● Create All New Players adds separate players for each imported flow.

● Merge with Existing Players Where Possible merges players from imported flows with 
any existing compatible players in the project.

2 Import flows

Contains a list of all the flows in the selected project. Flows are included in the import when 
their checkbox is activated.
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Exporting flows
You can export individual flows from projects, for example, to save small excerpts of large 
projects separately.

NOTE

These steps export flows as separate Dorico projects. If you want to export flows as other file 
formats, such as MusicXML or MP3, there are different methods.

PROCEDURE

1. Choose File > Export > Flows to open the Export Flows dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export. 
You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list. You can also click Select All or 
Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows and layouts and close the dialog.

RELATED LINKS
Flows on page 122
Exporting MusicXML files on page 63
Exporting MIDI on page 69
Exporting tempo tracks on page 72
Exporting audio on page 73

Export Flows dialog
The Export Flows dialog allows you to save individual flows and layouts as separate Dorico files.

● You can open the Export Flows dialog by choosing File > Export > Flows.

Project and file handling
File import and export 

61
Dorico SE 3.5.12



The Export Flows dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow as a separate file instead of all the selected flows as a single 
file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name, for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the current export path where exported flows will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.
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Importing MusicXML files
You can import MusicXML files into existing Dorico SE projects as separate flows, for example, to 
continue work on a piece started in a different notation software.

PROCEDURE

1. Choose File > Import > MusicXML to open the File Explorer/macOS Finder.

2. Locate and select the MusicXML files you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected MusicXML file.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. Click OK to import the selected flows and close the dialog.

6. Optional: If you selected multiple MusicXML files, repeat steps 4 and 5 for each file. The Flow 
Import Options dialog reopens automatically for each file.

RESULT
The selected MusicXML files are imported into the project as new flows.

● If MusicXML files include page size, margin, and staff size settings, Dorico SE imports those 
values. If they are not included, Dorico SE creates suitable settings according to the number 
of instruments in the file.

● If you chose Create All New Players, new players are added as required for each MusicXML 
file.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
MusicXML files and existing project have in common are merged, for example, if you 
imported a MusicXML file containing a solo piano into a project containing a piano and viola, 
the imported MusicXML file is added to the existing piano player.

TIP

● You can also open MusicXML files directly if you want them to be separate projects rather 
than new flows in existing projects.

● You can change your default preferences for the handling of imported MusicXML files on the 
MusicXML Import page in Preferences.

RELATED LINKS
Flow Import Options dialog on page 60
Opening projects/files on page 56

Exporting MusicXML files
You can export flows and layouts as separate MusicXML files, for example, if you want to export 
just the soloist’s layout containing the first flow.

PROCEDURE

1. Choose File > Export > MusicXML to open the Export MusicXML dialog.

2. Choose one of the following file format options:
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● Export compressed XML (.mxl)

● Export uncompressed XML (.xml)

3. In the Select flows to export list, activate the checkbox for each flow you want to export. 
You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list. You can also click Select All or 
Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows/layouts as MusicXML files and close the dialog.

Export MusicXML dialog
The Export MusicXML dialog allows you to save individual flows and layouts as separate 
MusicXML files.

● You can open the Export MusicXML dialog by choosing File > Export > MusicXML.

The Export MusicXML dialog contains the following options and lists:

1 File format options
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Allows you to choose the MusicXML file format you want to export. Compressed MusicXML 
files contain the same information as uncompressed MusicXML files but have a smaller file 
size.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name, for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the current export path where exported files will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing MIDI
You can import MIDI files into existing Dorico SE projects as separate flows, for example, to work 
on a different version of a section of a piece.

PROCEDURE

1. Choose File > Import > MIDI to open the File Explorer/macOS Finder.

2. Locate and select the MIDI files you want to import.

3. Click Open to open the MIDI Import Options dialog for the first selected MIDI file.

4. Change the settings as required.

5. Optional: If you want to customize the quantization settings, click Quantize Options and 
change the settings in the MIDI Quantize Options dialog.

6. Optional: Click OK to save your quantization settings and return to the MIDI Import Options 
dialog.

7. Click OK to close the MIDI Import Options dialog, which automatically opens the Flow 
Import Options dialog for the first selected MIDI file.

8. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

9. Click OK to import the selected flows and close the dialog.
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10. Optional: If you selected multiple MIDI files, repeat steps 4 to 9 for each file. The MIDI 
Import Options and Flow Import Options dialogs reopen automatically for each file.

RESULT
The selected MIDI files are imported into the project as new flows. Dorico SE uses an algorithm 
on imported MIDI notes to produce the correct enharmonic spelling for the imported notes.

● If the MIDI files contained markers, they are also imported, and if they have SMPTE offset 
values defined, Dorico SE uses them to set the timecode position for the start of the flow.

● If you chose Create All New Players, new players are added as required for each MIDI file.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
MIDI files and existing project have in common are merged, for example, if you imported a 
MIDI file containing a solo piano into a project containing a piano and viola, the imported 
MIDI file is added to the existing piano player.

TIP

You can also open MIDI files directly if you want them to be separate projects rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 56
Requantizing notes on page 206
Changing the sustain pedal controller settings for MIDI recording/import on page 208
Importing tempo tracks on page 70
Exporting tempo tracks on page 72

MIDI Import Options dialog
The MIDI Import Options dialog allows you to customize the settings Dorico SE uses to translate 
MIDI data into a Dorico project when importing MIDI files.

● You can open the MIDI Import Options dialog by choosing File > Import > MIDI and 
opening a MIDI file from the File Explorer/macOS Finder.
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The MIDI Import Options dialog contains the following sections:

1 Instrument handling

The options in this section determine how Dorico SE chooses and names instruments based 
on the imported MIDI file.

The Quantize Options button opens the MIDI Quantize Options dialog, which allows you 
to customize the quantization settings.

2 Keyboard handling

The options in this section determine how Dorico SE interprets keyboard music based on the 
imported MIDI file, including the MIDI note number at which notes are split between the 
right and left hand staves and whether CC64 indicates pedal lines.

3 Performance preservation

The options in this section allow you to determine how much of the original performance 
in the MIDI file you want to preserve for playback purposes. They do not affect how the 
imported MIDI notes are notated, as this is controlled by the quantization options set.

4 Player handling

The options in this section allow you to determine the players and layouts to which 
instruments in the MIDI file are assigned. For example, if you are importing a MIDI file 
into an existing project in order to orchestrate, you might want to activate Create player 
group for new players and deactivate Create part layouts for new players to add a single, 
independent group of players without creating any extra part layouts for them.
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MIDI Quantize Options dialog
The MIDI Quantize Options dialog allows you to customize the quantization settings you want 
to apply to imported MIDI files and notes input by recording with a MIDI device.

You can open the MIDI Quantize Options dialog in any of the following ways:

● Click Quantize Options in the MIDI Import Options dialog.

● Click Quantization Options in the Recording subsection of the Play page in Preferences.

NOTE

Your settings are linked between both ways of accessing the dialog.

The MIDI Quantize Options dialog contains the following options:

Quantization unit
Allows you to set the smallest beat unit to which you want notes to be quantized. For 
example, if the smallest intentional note duration in your imported file is an eighth 
note, set Quantization unit to eighth notes.

Detect tuplets
Allows you to control whether off-beat notes can be considered tuplets. If you know 
there are no intentional tuplets in your imported MIDI file, deactivating Detect tuplets 
ensures no notes are imported as tuplets.

Quantization unit for tuplets
Allows you to set the smallest beat unit to which you want tuplet notes to be quantized. 
For example, if the smallest intentional tuplet note duration in your imported file is a 
quarter note, set Quantization unit for tuplets to quarter notes.

Fill gaps
Allows you to determine whether Dorico SE fills in gaps between short notes. If you are 
importing already precisely quantized music, we recommend that you deactivate Fill 
gaps to ensure that note and rest durations are notated exactly as quantized.

RELATED LINKS
MIDI recording on page 204
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Exporting MIDI
You can export flows as separate MIDI files, for example, if you want to edit the audio in further 
detail in a DAW. MIDI files exported from Dorico SE contain any markers in the project by default.

PREREQUISITE
You have positioned a layout containing the players whose MIDI you want to export at the top of 
the Layouts panel in Setup mode.

PROCEDURE

1. Choose File > Export > MIDI to open the Export MIDI dialog.

2. In the Select flows to export list, activate the checkbox for each flow you want to export. 
You can also click Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as MIDI files and close the dialog.

RESULT
The selected flows are exported as MIDI files. They contain the MIDI of all the players assigned to 
the layout at the top of the Layouts list in Setup mode.

RELATED LINKS
Sorting layouts on page 128
Layouts panel (Setup mode) on page 85
Assigning players to layouts on page 125
Importing tempo tracks on page 70
Exporting tempo tracks on page 72

Export MIDI dialog
The Export MIDI dialog allows you to save individual flows as separate MIDI files.

● You can open the Export MIDI dialog by choosing File > Export > MIDI.

Project and file handling
File import and export 

69
Dorico SE 3.5.12



The Export MIDI dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name, for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the current export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing tempo tracks
You can import tempo tracks into individual flows and new flows in existing projects, for 
example, if you are writing music for a film and changes to the footage require tempo and 
time signature changes. This does not overwrite the notes and notations in the flow.

PROCEDURE

1. Choose File > Import > Tempo Track to open the File Explorer/macOS Finder.

2. Locate and select the MIDI file whose tempo track you want to import.

3. Click Open to open the Import Tempo Track dialog.
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4. In the Import into flow list, select the flow into which you want to import the tempo track.

5. In the Import and replace section, activate the checkbox for each tempo track aspect you 
want to include.

6. Optional: If you activated the checkbox for Markers as, choose one of the following options:

● Markers

● System Text

7. Optional: If you chose System Text for Markers as, activate/deactivate Show border 
around system text markers.

8. Click OK to import the tempo track and close the dialog.

RESULT
The tempo track is imported into the selected flow. If you selected New Flow in the Import into 
flow list, a new flow is added to the project. All selected aspects are applied to the existing music 
or the new flow, and notes and tempo marks are adjusted as required.

RELATED LINKS
Flows on page 122
Exporting tempo tracks on page 72
Importing MIDI on page 65
Exporting MIDI on page 69

Import Tempo Track dialog
The Import Tempo Track dialog allows you to import tempo tracks to individual flows within 
projects and to control which aspects of the tempo track you want to apply to the flow.

● You can open the Import Tempo Track dialog by choosing File > Import > Tempo Track 
and opening a MIDI file from the File Explorer/macOS Finder.

The Import Tempo Track dialog comprises the following:

1 Import into flow
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Contains a list of all the flows in the project. The currently selected flow is highlighted.

NOTE

You can only import tempo tracks into a single flow at a time.

2 Import and replace

Allows you to control which tempo track aspects you want to include in your import and 
apply to the selected flow.

● Timecode display offset sets the initial timecode position at the start of the flow.

● Tempo changes replaces all immediate and gradual tempo changes in the flow with the 
tempo changes from the MIDI file.

● Time signatures replaces all time signatures in the flow with time signatures from the 
MIDI file.

● Markers as adds any markers from the MIDI file to the flow as either Markers or 
System Text.

Importing markers as Markers replaces any existing markers in the flow with markers 
from the MIDI file, while importing markers as System Text does not replace any 
existing markers or system text objects.

● Show border around system text markers adds borders to markers imported as 
system text objects when activated. Only available if you have chosen System Text for 
Markers as.

Exporting tempo tracks
You can export flows as separate tempo tracks, for example, if you want to apply the tempo 
marks and time signatures of one flow to a different flow, which can be in the same project.

PROCEDURE

1. Choose File > Export > Tempo Track to open the Export Tempo Track dialog.

2. Activate the checkbox for each flow you want to export as a tempo track. You can also click 
Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as tempo tracks and close the dialog.

RELATED LINKS
Importing tempo tracks on page 70
Importing MIDI on page 65
Exporting MIDI on page 69

Export Tempo Track dialog
The Export Tempo Track dialog allows you to save individual flows as separate tempo tracks in 
the format of MIDI files.

● You can open the Export Tempo Track dialog by choosing File > Export > Tempo Track.
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The Export Tempo Track dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name, for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the current export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Exporting audio
You can export projects as audio files in either MP3 or WAV format, including exporting flows and 
players as separate files, for example, if you want to share an audio mock-up of only the soloist’s 
part in the second flow.

PREREQUISITE
You have positioned the full score layout from which you want to export audio at the top of the 
Layouts panel in Setup mode.
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PROCEDURE

1. Choose File > Export > Audio to open the Export Audio dialog.

2. Choose one of the following file format options:

● Export compressed mp3 (.mp3)

● Export uncompressed WAV (.wav)

3. Activate/Deactivate Export each selected flow as a separate file.

4. In the Select flows to export list, activate the checkbox for each flow you want to export as 
audio. You can also click Select All or Select None at the bottom of the list.

5. Activate/Deactivate Export players as separate files.

6. Optional: If you activated Export players as separate files, activate the checkbox for each 
player you want to export in the Select players to export list. You can also click Select All or 
Select None at the bottom of the list.

7. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

8. Locate and select the destination folder you want.

9. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Export to field.

10. Click OK to export the selected flows/players as the selected type of audio file and close the 
dialog.

RELATED LINKS
Sorting layouts on page 128
Layouts panel (Setup mode) on page 85
Assigning players to layouts on page 125

Export Audio dialog
The Export Audio dialog allows you to save individual flows and players as separate audio files, 
either MP3 or WAV.

● You can open the Export Audio dialog by choosing File > Export > Audio.
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The Export Audio dialog contains the following options and lists:

1 File format options

Allows you to choose the audio file format you want to export. Compressed MP3 files are 
smaller than WAV files but this corresponds to a reduced audio quality.

2 Export each selected flow as a separate file

Allows you to export each flow in the project as a separate audio file instead of as a single 
audio file.

3 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

4 Export players as separate files

Allows you to export each player in the project as a separate audio file instead of all players 
in a single audio file.

5 Select players to export

Contains a list of all the players in the project. Players are included in the export when their 
checkbox is activated. Only available if you have activated Export players as separate files.

6 Selection options

Allow you to select/deselect all the flows/players in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

7 Export to field

Displays the current export path where exported audio files will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.
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Auto-save
The auto-save function stores a version of the currently active project at regular intervals, 
including new projects you have not explicitly saved yet. This reduces the chances of losing 
significant amounts of work if you accidentally close a project without saving or in the unlikely 
event that Dorico SE or your computer crashes.

Dorico SE saves auto-saved projects in an AutoSave folder inside the application data folder for 
your user account. You cannot change this location.

NOTE

Dorico SE might become less responsive briefly in order to perform auto-saves, particularly for 
larger projects.

Auto-save with multiple projects open

Only the currently activated project is auto-saved at each auto-save interval if you have multiple 
projects open. This is because only a single project at a time can be activated for playback. If 
you are switching between multiple projects frequently, we recommend that you set a smaller 
auto-save interval.

Removal of auto-save files

All files in the AutoSave folder are automatically deleted when you close their corresponding 
projects and also when you quit Dorico SE. You can find deleted auto-saved projects in the bin 
on your computer. Dorico SE automatically adds “[AutoSave]” to the end of auto-saved project file 
names so you can identify them.

IMPORTANT

When Dorico SE deletes files from the AutoSave folder, this includes any files in the folder, not 
just auto-saved Dorico projects. Therefore, it is important that you do not manually save anything 
in the AutoSave folder.

TIP

If you want to access earlier versions of projects, you can use project backups.

RELATED LINKS
Project backups on page 78
Toolbar on page 24
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Recover Auto-saved Projects dialog
The Recover Auto-saved Projects dialog allows you to recover individual auto-saved projects, 
for example, after you accidentally closed a project without saving or if Dorico SE or your 
computer crashed.

The Recover Auto-saved Projects dialog contains the following:

Auto-saved projects list
Contains all the auto-saved projects that are available for recovery. Displays the file 
name of each project and the date and time of the auto-save.

You can activate the checkbox for each project you want to recover.

Discard All
Deletes all auto-saved projects in the list and moves them to the bin on your computer.

Recover Selected Projects
Recovers the selected auto-saved projects and opens them in separate project 
windows.

RELATED LINKS
Changing the auto-save frequency on page 78

Recovering auto-saved projects
If Dorico SE crashes, you can recover the most recent auto-saved version of each project that was 
open.

PROCEDURE

1. Reopen Dorico SE.

2. In the Recover Auto-saved Projects dialog that opens after the Dorico SE splash screen, 
activate the checkbox for each auto-saved project you want to recover.

NOTE

Any auto-saved projects you do not recover are permanently deleted once you close the 
dialog.

3. Click Recover Selected Projects to recover the selected auto-saved projects and close the 
dialog.

RESULT
The selected auto-saved projects are recovered and opened in separate project windows.
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AFTER COMPLETING THIS TASK
You can save auto-saved projects permanently in any folder location and with new file names if 
required.

Changing the auto-save frequency
You can change how frequently Dorico SE auto-saves projects. By default, the auto-save interval 
is five minutes for the currently active project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Files section, change the value for Auto-save every [n] minutes.

4. Click Apply, then Close.

Disabling auto-save
You can disable auto-save completely, for example, if it is significantly affecting the performance 
of a large project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Files section, deactivate Auto-save every [n] minutes.

4. Click Apply, then Close.

Project backups
Dorico SE stores backup versions of your projects each time you save them explicitly. By default, 
the previous five saves are stored as backups.

Their default location is in a folder named after the corresponding project file name in 
the Backup Projects folder in the Dorico Projects folder, whose default location is in the 
Documents folder for your user account.

You can find deleted project backups in the bin on your computer.

Changing the number of backups per project
You can change the number of backups that Dorico SE stores for each project, for example, if you 
want to store a greater range of changes.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Files section, change the value for Number of backups per project.

4. Click Apply, then Close.
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Changing the backup location
You can change the folder that Dorico SE uses to store project backups. By default, Dorico SE 
uses the Backup Projects folder inside your Dorico Projects folder, whose default location is in 
the Documents folder for your user account.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Files section, click Choose beside the Project backup folder field to open the File 
Explorer/macOS Finder.

4. Locate and select the folder where you want to save project backups.

5. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Project backup 
folder field.

6. Click Apply, then Close.

RESULT
The default folder for project backups is changed. If the folder specified does not exist, Dorico SE 
creates it.
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Setup mode

Setup mode allows you to set up the fundamental elements of the project: instruments and the 
players that hold them, flows, layouts, and videos. You can also determine how they interact with 
each other, for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and layouts, but 
you cannot select or interact with anything in the music area in Setup mode.

Project window in Setup mode
The project window in Setup mode contains the default toolbar, the music area, and the status 
bar. It provides panels with all the tools and functions that allow you to add players and 
instruments as well as to create layouts and flows for your project.

You can switch to Setup mode in any of the following ways:

● Press Ctrl/Cmd-1 .

● Click Setup in the toolbar.

● Choose Window > Setup.

Panels in Setup mode

The following panels are available in Setup mode:

1 Players

Lists the players, instruments, and groups in your project. By default, players are assigned to 
all flows, all full score layouts, and their own part layout.
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2 Layouts

Lists the layouts in your project. A single full score layout and a part layout for each player 
are created automatically, but you can create and delete layouts as required. By default, 
layouts contain all flows and full score layouts contain all players.

3 Flows

Shows the flows in your project, ordered left to right. By default, flows contain all players and 
are assigned to all layouts.

The three panels work together to allow you to control how and where the players, layouts, and 
flows in your project are used. When you select an item in one of the panels, that panel and the 
selected item are highlighted in a different color and checkboxes appear in cards in the other 
panels. You can activate/deactivate these checkboxes independently to change how material is 
distributed across players, layouts, and flows.

RELATED LINKS
Project window on page 23
Layouts panel (Setup mode) on page 85
Flows panel on page 87
Players, layouts, and flows on page 93
Starting new projects on page 54

Players panel
The Players panel contains all the players and groups in the project, shown in a list. It is located 
on the left of the window in Setup mode.

You can hide/show the Players panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Panel.
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In the Players panel, each player is shown as a card that contains the instruments held by that 
player. Each player card shows the following:

1 Disclosure arrow

Expands/Collapses the player card.

2 Player type

Shows the type of player from the following options:

● Solo player 

● Section player 

3 Player name

Shows the name of the player. Dorico SE automatically adds the names of the assigned 
instruments to the player name. If required, you can rename the player.

4 Add instruments icon

Opens the instrument picker from which you can select an instrument for the player.

5 Instrument labels

Each instrument assigned to a player has its own instrument label. If you hover the mouse 
pointer over an instrument label, an arrow  appears that allows you to open a menu with 
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further options that allow you to, for example, change the instrument names or move the 
instrument to another player.

The action bar at the bottom of the panel contains the following options:

Add Solo Player

Adds an individual player to your project. Dorico SE also automatically adds a part 
layout for the player to the Layouts panel.

Add Section Player

Adds a player to your project that represents multiple players who all play the same 
instrument. Dorico SE also automatically adds a part layout for the player to the 
Layouts panel.

Add Ensemble

Adds multiple players to your project that represent standard combinations of musical 
instruments. Dorico SE also automatically adds part layouts for each player in the 
ensemble to the Layouts panel.

Add Group

Adds a group to your project to which you can assign all types of players.

Delete Player

Deletes selected players or groups from the project. When you delete a player, a 
warning message appears that allows you to delete only the player but leave their part 
layouts in the project, delete both the player and their part layouts, or cancel.

The order in which the players are listed in the panel is the default order in which they appear in 
layouts. You can change the player order for each layout individually in the Players section of the 
Players page in Setup > Layout Options.

RELATED LINKS
Players on page 94
Layouts panel (Setup mode) on page 85
Layout Options dialog on page 90

Instrument picker
The instrument picker allows you to find and add instruments and ensembles to your project. 
It contains multiple versions of some instruments that have specific formatting and tuning 
requirements, such as French Horn, which has a version whose part layouts are always in treble 
clef.

You can open the instrument picker in Setup mode in any of the following ways:

● Click the plus symbol  in solo player cards in the Players panel.

● Select a player in the Players panel and press Shift-I .

● Right-click a player in the Players panel and choose Add Instrument to Player.
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● Add a new player or ensemble.

Instrument picker when adding an instrument

The instrument picker contains the following sections and options:

1 Search field

Allows you to enter the instrument/ensemble you are searching for directly. You can enter 
only part of the instrument/ensemble name, such as cello for Violoncello.

2 Instrument family column

Contains instrument families to help you focus your instrument/ensemble search.

3 Instrument/Ensemble column

Contains the instruments/ensembles available in the selected instrument family.

4 Instrument type/Ensemble contents column

For instruments: Contains options for multiple possible transpositions, tunings, key 
signature options, or different behavior in part layouts for the selected instrument. This 
column is not populated for instruments that do not have further options.

For ensembles: Displays the instruments included in the selected ensemble.

5 Create Empty Kit

Adds an empty percussion kit to the player.

6 Import Kit

Imports an existing percussion kit previously exported as a library file.

7 Add/Add Ensemble to Score

Adds the selected instrument/ensemble to the project. Adding an ensemble adds multiple 
players at once.

In addition to entering the instrument or ensemble you want directly into the Search field, you 
can click options in the instrument picker to select them, and you can also select other items in 
the same column by pressing Up Arrow / Down Arrow .
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You can cycle forwards through the instrument picker by pressing Tab , which navigates in the 
following order: Search field, Instrument, Instrument type, Instrument family. You can also 
cycle backwards by pressing Shift-Tab , which navigates in the opposite direction.

An enclosure line shows which instrument family, instrument, or ensemble is selected when 
using the keyboard to navigate.

RELATED LINKS
Transposing instruments on page 104
Adding solo/section players on page 95
Adding ensembles on page 99
Adding empty percussion kits to players on page 106
Importing percussion kits on page 980

Layouts panel (Setup mode)
The Layouts panel contains all the layouts in the project, shown in a list. In Setup mode, it is 
located on the right of the window.

You can hide/show the Layouts panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Panel.

In the Layouts panel, each layout is shown as a card. Each layout card shows the following:
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1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico SE automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation

Shows the size and orientation of the layout as set on the Page Setup page in Setup > 
Layout Options.

5 Space size

Shows the space size between two staff lines in points, as set on the Page Setup page in 
Layout Options. This indicates the size of staves in the layout.

6 Layout number

Allows you to set a unique number for the layout that can be used as part of its file name 
when exported as a graphic. This can be useful to ensure exported part layout files are 
organized in their orchestral order, as this is usually different to their alphabetical order.

The action bar at the bottom of the panel contains the following options:

Add Full Score Layout

Adds a full score layout to your project. By default, every player and flow is 
automatically included in the layout.

Add Instrumental Part Layout

Adds an empty instrumental part layout to your project. You can then add one or 
multiple players to the layout. By default, a part layout contains all flows that are 
created in your project.

Add Custom Score Layout

Adds a custom score layout that initially without players or flows.

Setup mode
Project window in Setup mode 

86
Dorico SE 3.5.12



Sort Layouts

Sorts all layouts in the Layouts panel according to their type in the following order: 
full score layouts, instrumental part layouts, custom score layouts. It does not sort part 
layouts according to orchestral order.

Layout Options

Opens the Layout Options dialog for one or multiple selected layouts.

Delete Layout

Deletes selected layouts from the project.

RELATED LINKS
Project window in Setup mode on page 80
Layouts on page 124
Layout Options dialog on page 90
Layouts panel (Print mode) on page 519

Flows panel
The Flows panel contains all the flows in the project, shown in horizontal list. It is located at the 
bottom of the window in Setup mode.

You can hide/show the Flows panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Bottom Panel.

In the Flows panel, each flow is shown as a card. Each flow card shows the following:
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1 Flow name

Shows the name of the flow. If you create multiple flows without renaming them, each flow 
name shows a number that increments with each new flow that you create. The number also 
indicates the position of the flow in a layout.

2 Film reel icon

Indicates the flow has an attached video.

3 Flow timecode

Shows the start timecode for the flow.

4 Flow number

Shows the number of the flow. The number increments with each new flow that you create. 
The number also indicates the position of the flow in a layout.

To the right of the Flows panel, the following options are available:

Add Flow

Adds a new flow to your project. By default, every new flow is automatically included in 
all layouts, and every player is added to the new flow.

Delete Flow

Deletes the selected flows from the project.

RELATED LINKS
Project window in Setup mode on page 80
Flows on page 122
Videos on page 136

Project Info dialog
The Project Info dialog allows you to specify information about the whole project and each 
flow within it separately, such as the title, composer, and lyricist, as these might be different for 
different flows. You can then refer to these entries using tokens in text frames.

You can open the Project Info dialog in any mode in any of the following ways:

● Press Ctrl/Cmd-I .

● Choose File > Project Info.
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The Project Info dialog comprises the following:

1 Flows list

Contains all the flows in the project, with a separate entry for the project as a whole at the 
top. You can select individual or multiple flows in the flows list.

NOTE

The flows list uses the names of flows as shown in the Flows panel in Setup mode, which can 
be different to their entry in the Title field if you have changed their flow title.

The action bar at the bottom of the list contains the following options:

● New Flow : Creates a new flow with no information. Its default name is New Flow.

● Duplicate Flow : Creates a new flow with all the information of the selected flow. Its 
default name is Copy of [selected flow].

● Rename Flow : Opens the Rename Flow dialog, which allows you to change the name 
of the flow.

NOTE

If you have already manually changed the flow title, changing the name of the flow does 
not automatically change the flow title.
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● Move Down : Moves the selected flows down the flows list, which changes their order 
in the project.

● Move Up : Moves the selected flows up the flows list, which changes their order in the 
project.

● Delete Flow : Deletes the selected flows.

2 Information fields

Allow you to enter information about the currently selected flows or the whole project in 
the corresponding field, such as Composer and Lyricist. If you have selected multiple flows 
with different entries in the same fields, such as flows with different composers, those fields 
display Mixed.

3 Copy info from menu

Allows you to select another flow or the whole project whose information you want to copy, 
for example, for a project containing multiple flows that all have the same composer and 
lyricist.

4 Copy

Copies all the information from the specified flow/project to the selected flows/project.

TIP

● You can use tokens in text frames to refer to information in the Project Info dialog.

● You cannot specify line breaks in single-line fields. However, you can enter line breaks in 
larger fields, namely Copyright and Other information, which you can then copy into 
single-line fields.

RELATED LINKS
Text tokens on page 397
Flow names and flow titles on page 135
Starting new projects on page 54

Layout Options dialog
The Layout Options dialog allows you to change various aspects of each layout independently. 
For example, you can change the physical properties of the layout, such as page size, staff size, 
or margins, and how the music appears and is laid out, such as note spacing or staff labels.

Options in Layout Options affect only the selected layouts but apply to all flows in those layouts.

TIP

● You can save all options currently set in Layout Options as the default for new projects by 
selecting a layout type from the Layout type menu and clicking Save as Default.

● If you make changes and close the dialog without clicking Apply, you are prompted to save 
or discard your changes.

You can open Layout Options in any of the following ways:

● Press Ctrl/Cmd-Shift-L  in any mode.

● Choose Setup > Layout Options in Setup mode.

● Click Layout Options  in the Layouts panel in Setup mode.
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The Layout Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the current setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .
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● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Layouts list

Contains all the layouts in your project. By default, the layout currently open in the music 
area is selected when you open the dialog. You can select multiple layouts in any of the 
following ways:

● Click one of the selection options in the action bar.

● Ctrl/Cmd -click to select multiple layouts.

● Shift -click to select multiple adjacent layouts.

7 Action bar

Contains selection options that allow you to select layouts in the Layouts list according to 
their type.

● Select All selects all layouts, regardless of their type.

● Select All Full Score Layouts selects all full score layouts only.

● Select All Part Layouts selects all part layouts only.

● Select All Custom Score Layouts selects all custom score layouts only.

8 Layout type

Allows you to select the layout type for which you want to save your settings as the default. 
For example, you can save new default settings for part layouts without affecting the default 
settings for full score layouts.

9 Save as Default/Remove Saved Defaults

This button has different functions depending on whether you have existing saved defaults 
for the selected layout type.

● Save as Default saves all options currently set in the dialog as the default for the 
selected layout type in new projects.

● Remove Saved Defaults deletes your previous saved defaults without resetting the 
options in the current project. After removing your saved defaults, all layouts of 
the selected type in future projects start with the default factory settings. If you 
have existing saved defaults, you can access Remove Saved Defaults by pressing 
Ctrl (Windows) or Opt (macOS) .

10 Reset to Factory/Reset to Saved Defaults

This button has different functions depending on whether you have existing saved defaults 
for the selected layout type.

● If you have no saved defaults for the selected layout type, this button is Reset to 
Factory, which resets all the options in the dialog back to the default factory settings for 
the selected layout type.

● If you have existing saved defaults for the selected layout type, this button is Reset to 
Saved Defaults, which resets all the options in the dialog back to your saved defaults 
for the selected layout type. You can access Reset to Factory instead by pressing 
Ctrl (Windows) or Opt (macOS) . Resetting options back to the default factory settings 
only affects the selected layout type in the current project and does not delete your 
saved defaults, meaning future projects still start with your saved defaults.
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RELATED LINKS
Staves on page 909
Page formatting on page 367
Changing your preferred unit of measurement on page 45
Changing values in numeric value fields on page 150

Players, layouts, and flows
In Dorico SE, players, layouts, and flows are all connected to each other. Because they exist in the 
project rather than in a single score, you can, for example, have players and flows saved in the 
project without showing them in the full score.

● Players can be assigned to any combination of layouts and flows. For example, you can 
assign a single player to both the full score layout and their own part layout, and remove 
them from flows in which they do not play. By default, players are assigned to all flows that 
originated in the project, all full score layouts, and their own part layout.

● Layouts can contain any combination of players and flows. For example, you can assign all 
the singers to a single part layout, then remove the flows from the layout in which they do 
not sing. By default, layouts contain all flows and full score layouts contain all players.

● Flows can contain any combination of players and be assigned to/removed from layouts. By 
default, flows contain all players and are assigned to all layouts.

NOTE

● If you remove a player from a flow, any notes you have already input for that player in that 
flow are deleted.

● Removing a flow from a layout automatically removes that layout from the flow, and vice 
versa. The same is true for players and layouts, and players and flows.

When you select a card in one of the panels in Setup mode, each card in the other panels 
shows a checkbox. Connected cards appear highlighted and have activated checkboxes, while 
unconnected cards are not highlighted and have deactivated checkboxes. For example, if you 
select a single player card in the Players panel, all the flows to which the player is assigned are 
highlighted and activated in the Flows panel and all layouts to which the player is assigned are 
highlighted and activated in the Layouts panel.
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A piano player selected in the Players panel with connected flows and layouts highlighted in the Flows and 
Layouts panels

EXAMPLE
A work for string quartet and choir is divided into three movements. The string quartet is tacet 
for the third movement, which the choir sings a cappella.

The Dorico project contains three flows (one for each movement), four solo players for the string 
quartet, four section players for the choir, and another solo player for a piano reduction. It uses 
the following layouts to produce the required performance materials:

● Four instrumental part layouts, one for each string quartet player. Each part layout contains 
all three flows but because the string players are not assigned to the third flow, automatic 
tacets are shown for it.

● One full score layout containing all three flows, the string quartet players, and the choir 
players but omitting the piano reduction player.

● One custom score layout for the vocal score. It contains all three flows, the choir players, and 
the piano reduction player.

RELATED LINKS
Project window in Setup mode on page 80
Flows on page 122
Layouts on page 124
Assigning flows to layouts on page 126
Assigning players to layouts on page 125
Assigning players to flows on page 123
File import and export on page 59
Tacets on page 389
Flow headings on page 364

Players
In Dorico SE, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

In Dorico SE, there are the following types of players:
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Solo player
Represents a single person who can play one or more instruments. For example, a 
clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, 
clash cymbals, and triangle.

Section player
Represents multiple people who all play the same instrument. For example, a violin 
section player might represent all eight desks of the Violin I section in an orchestra, or 
a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players cannot double instruments.

When you add a player in Dorico SE, the following happens automatically:

● A part layout is created and the new player is assigned to it.

● The player is added to any full score layouts that already exist. If no full score layouts exist, a 
new full score layout is created.

● The player is assigned to all existing flows that originated in the project. It is not added to 
any flows that you imported into the project.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. If you open 
a project that contains more than two players, it opens in read-only mode.

RELATED LINKS
Players, layouts, and flows on page 93
Flows on page 122
Layouts on page 124
Instruments on page 100
Changing the default player order on page 97
Player, layout, and instrument names on page 129
Brackets according to ensemble type on page 594
Instrument numbering on page 101
Instrument changes on page 102

Adding solo/section players
You can add both solo and section players to your project. Solo players can hold multiple 
instruments, whereas section players can divide.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two.

PROCEDURE

1. Add an empty-handed player in any of the following ways:

● To add a solo player, press Shift-P .

● To add a section player, press Shift-Alt/Opt-P .

● If you have started a new project, click Add Solo Player  in the project start area.
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● If you have started a new project, click Add Section Player  in the project start area.

● In the Players panel action bar, click Add Solo Player .

● In the Players panel action bar, click Add Section Player .

The instrument picker opens.

TIP

You can also open the instrument picker by selecting an existing player in the Players panel 
and pressing Shift-I .

2. Select the instrument you want in the instrument picker.

3. Press Return  to add the selected instrument.

RESULT
The solo/section player is added and is automatically named after the selected instrument. By 
default, the player appears below any existing players in the Players panel. It is assigned to its 
own new part layout, all full score layouts, and all flows that originated in the project.

Dorico SE automatically loads sounds for the instrument according to the current playback 
template.

NOTE

● Players are not automatically added to flows that you imported into the project.

● If you want to add multiple instruments to your project at the same time, you can add 
ensembles or use a project template.

AFTER COMPLETING THIS TASK

● If you added a solo player and you want them to hold multiple instruments, you can add 
other instruments to the solo player.

● You can change the default order of players in all layouts and set custom player orders in 
each layout independently.

RELATED LINKS
Players panel on page 81
Instrument picker on page 83
Players, layouts, and flows on page 93
Player, layout, and instrument names on page 129
Instrument numbering on page 101
Layouts on page 124
Renaming players on page 130
Project start area on page 28
Adding instruments to players on page 105
Adding ensembles on page 99
Starting new projects from project templates on page 55
Playback templates on page 473
File import and export on page 59
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Duplicating players
You can duplicate existing players. This adds another player of the same type holding the same 
instruments as the original.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two.

PROCEDURE

● In the Players panel, right-click the player you want to duplicate and choose Duplicate 
Player from the context menu.

RESULT
A new player is added, with the same instruments as the original player and is named after 
those instruments. By default, the player appears below the original player in the Players panel. 
The original and new players are automatically numbered to ensure their names are unique. 
However, any existing music belonging to the original player is not duplicated.

The new player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

RELATED LINKS
Players panel on page 81
Renaming players on page 130
Players, layouts, and flows on page 93
Arranging tools on page 350
Copying and pasting items on page 351
Setting custom player orders on page 98

Changing the default player order
You can change the default order in which players’ staves appear in all layouts, for example, if 
you added a solo violin player after adding all other players but want it to appear above the 
string section.

PROCEDURE

1. In the Players panel, select the player whose default position you want to change.

2. Click and drag the player card upwards/downwards in the panel.

An insertion line indicates where the player will be positioned.

RESULT
The default player order is changed. This does not change the player order in layouts with 
custom player orders.

RELATED LINKS
Players panel on page 81
Adding solo/section players on page 95
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Setting custom player orders
You can change the order in which players’ staves appear in each layout independently, for 
example, if you want to have a different player order in a custom score layout than the default 
player order for your other layouts, as set by the order of players in the Players panel.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layout in which you want to set a custom player order.

NOTE

You can only set custom player orders in one layout at a time. By default, the layout currently 
open in the music area is selected when you open the dialog.

3. Click Players in the category list.

4. In the Players section, activate Uses custom player order.

5. In the list, select a player whose position you want to change.

6. Change its position relative to other players in one of the following ways:

● Click Move up.

● Click Move down.

7. Optional: Repeat steps 5 to 6 for other players in the selected layout whose position you 
want to change.

8. Click Apply, then Close.

RESULT
The player order in the selected layout is changed. This overrides the default player order. Any 
subsequent changes you make to the default player order in the Players panel are not reflected 
in layouts with custom player orders.

RELATED LINKS
Layouts on page 124
Layout Options dialog on page 90

Deleting players
You can delete players from your project, which also deletes all instruments held by those 
players.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In the Players panel, select the players that you want to delete.

2. Press Backspace or Delete .

3. Choose one of the following options in the warning message that appears:

● Delete Player Only: Deletes the player and the music that you created for the 
instruments belonging to that player.
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● Delete Player and Part Layouts: Deletes the player, the music, and all part layouts to 
which the player is assigned.

NOTE

The part layout cannot be deleted if it also contains other players.

RELATED LINKS
Players panel on page 81
Deleting instruments on page 108

Ensembles
If you add an ensemble in Dorico SE, multiple players are added to your project at the same time.

Dorico SE provides a set of predefined ensembles that you can use. Adding an ensemble is one of 
the ways to achieve building up an instrumentation quickly. The predefined ensembles that you 
can create with Dorico SE follow standard patterns, such as double woodwind which refers to two 
flutes, two oboes, two clarinets, and two bassoons.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. If you open 
a project that contains more than two players, it opens in read-only mode.

Adding ensembles
You can add multiple players at once by adding ensembles, such as a complete string section or 
four-part choir.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two.

PROCEDURE

1. Open the instrument picker for ensembles in any of the following ways:

● If you have started a new project, click Add Ensemble  in the project start area.

● In the Players panel action bar, click Add Ensemble .

2. Select the ensemble you want in the instrument picker.

3. Click Add Ensemble to Score.

RESULT
The ensemble players are added to the Players panel, either as solo or as section players. They 
are assigned to all flows that originated in the project.

TIP

You can also add multiple instruments to your project at the same time by using a project 
template.
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RELATED LINKS
Players panel on page 81
Instrument picker on page 83
Renaming players on page 130
Project start area on page 28
Starting new projects from project templates on page 55
Players, layouts, and flows on page 93
File import and export on page 59

Instruments
In Dorico SE, an instrument is an individual musical instrument, such as a piano, a flute, or a 
violin. Human voices, such as soprano or tenor, are also considered instruments.

In Dorico SE, instruments are held by players, just as real instruments are held by human players. 
Section players can only hold a single instrument but solo players can hold multiple instruments, 
which allows you to handle instrument changes easily, such as when an oboist doubling the cor 
anglais switches from one instrument to the other.

This means that before you can add instruments to a project, you must first add players or 
ensembles, which may in turn also be assigned to groups if needed. If you add ensembles, the 
appropriate instruments for the ensemble are automatically added to the players.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same solo player can appear on the same staff as 
long as no notes overlap. By default, Dorico SE allows instrument changes in all layouts and 
automatically shows instrument change labels. This means that only the top instrument held by 
players is shown automatically in the music area. You can see staves for all instruments in galley 
view, and you can allow/disallow instrument changes in each layout independently. You can also 
hide/show empty staves in each layout independently.

Instruments in Dorico SE do not have limited ranges; it is possible to notate any pitch in any 
register on every instrument. However, in the piano roll editor in Play mode, only pitches that fall 
in the MIDI note range 0-127 can be represented. Similarly, if you input a pitch beyond the range 
of samples in the assigned VST instrument, the pitch does not sound in playback.

You can change instruments at any time, add/delete them from players, and move them 
between players.

RELATED LINKS
Players on page 94
Piano roll editor on page 420
VST and MIDI Instruments panel on page 415
Inputting notes on page 161
Adding instruments to players on page 105
Player, layout, and instrument names on page 129
Staff labels on page 901
Brackets according to ensemble type on page 594
Changing the open pitches of fretted instrument strings on page 118
Changing instruments on page 107
Moving instruments on page 107
Changing the default player order on page 97
Deleting instruments on page 108
Switching to galley/page view on page 42
Allowing/Disallowing instrument changes on page 102
Hiding/Showing empty staves on page 373
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Edit Percussion Kit dialog on page 109

Instrument numbering
It is customary to number instruments when there is more than one in a piece so that they can 
be easily identified, such as Horn 1 and Horn 2. Dorico SE automatically numbers instruments 
where there are multiple instruments of the same type in the same project.

For example, if there is only one flute in a project, it is called Flute, but if there are three flutes, 
they are automatically called Flute 1, Flute 2, and Flute 3.

One violin with no number Adding a second violin automatically generates 
numbers for both violins

Instrument numbering applies to individual instruments, rather than players. For example, if an 
ensemble contains two flute players and a piccolo player, but the second flute is also holding a 
piccolo, then the instruments are numbered in the following way:

● Flute 1

● Flute 2 & Piccolo 1

● Piccolo 2

TIP

You can move individual instruments to different players if you want to change which numbered 
instruments are held by each player. For example, if you want the second flute to double second 
piccolo rather than first piccolo, you can swap the piccolo instruments between the players.

Dorico SE automatically generates instrument numbers for players if the following criteria are 
met:

● There are multiple instruments of the same type in the project.

● The instrument names are the same.

● The instruments have the same transposition.

● The players holding them are the same type, either solo or section.

● The players are in the same group.

For example, if you have two flutes in your project, but one flute is a section player and the 
other flute is a solo player, they are not numbered automatically. Similarly, if the two flutes are in 
different player groups, they are not numbered automatically.

RELATED LINKS
Player, layout, and instrument names on page 129
Changing instrument names on page 131
Player groups on page 119
Instrument transpositions in staff labels on page 904
Moving instruments on page 107
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Instrument names in staff labels on page 902
Transposing instruments on page 104

Instrument changes
Instruments changes are when a player holding multiple instruments switches from playing one 
instrument to a different instrument. They are usually indicated in full scores and parts with text 
indications both after the last note before the change and at the first note after the change.

Dorico SE handles instrument changes automatically, including showing the appropriate 
instrument change labels, when you have input notes onto multiple instrument staves held by 
the same solo player, as long as the notes do not overlap.

An instrument change from Oboe to Cor Anglais

You can see staves for all instruments in galley view, and you can allow/disallow instrument 
changes in each layout independently.

RELATED LINKS
Adding instruments to players on page 105
Switching to galley/page view on page 42
Hiding/Showing instrument change labels at the start of flows on page 906

Allowing/Disallowing instrument changes
You can allow/disallow instrument changes in each layout independently, for example, if you 
want to show multiple percussion instruments on as few staves as possible in the score but on 
separate staves for each percussion instrument in the percussion part.

Disallowing instrument changes shows all instrument staves in the selected layouts, including 
multiple instruments held by a single solo player.

TIP

If you want to input notes for other instruments held by solo players but keep instrument 
changes in the layout, you can switch to galley view to see all staves in the project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow/disallow instrument 
changes.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Instrument Changes section, activate/deactivate Allow instrument changes.

5. Click Apply, then Close.
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RESULT
Instrument changes are allowed in the selected layouts Allow instrument changes is activated, 
and disallowed when it is deactivated.

NOTE

Multiple instruments can only appear on the same staff with an instrument change if none of 
their notes overlap. If any of their notes do overlap, multiple staves are shown.

RELATED LINKS
Instruments on page 100
Inputting notes on page 161
Hiding/Showing empty staves on page 373

Editing the default instrument change label text
You can change the default instrument change label prefix and whether instrument change 
labels show full or short instrument names by default in each layout independently, for example, 
if you want to show full instrument names in part layouts but short instrument names in full 
score layouts.

Using custom prefixes/suffixes also allows you to show instrument change labels in a different 
language, for example, if you want to recreate a French score.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default content in 
instrument change labels.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Instrument Changes section, choose one of the following options for Instrument 
names to use in change labels:

● Full Names

● Short Names

5. Choose one of the following options for Prefix for instrument change warnings:

● To

● Take

● Custom

6. Optional: If you chose Custom, enter the text you want in the Custom prefix and/or Custom 
suffix fields.

7. Click Apply, then Close.

RESULT
The length of instrument names and prefixes/suffixes in all instrument change labels in the 
selected layouts is changed.

Setup mode
Instruments 

103
Dorico SE 3.5.12



RELATED LINKS
Hiding/Showing instrument change labels at the start of flows on page 906
Staff labels on page 901

Transposing instruments
While most instruments produce notes at concert pitch, transposing instruments produce a note 
that is different to the one that is written. For example, two common orchestral transposing 
instruments are clarinet in B♭ and horn in F.

When a clarinet in B♭ plays a C, the sound produced is a B♭, one whole step (tone) below. 
When a horn in F plays a C, the sound produced is an F, a fifth below. Other instruments 
that conventionally produce a pitch different to the one notated include the piccolo (sounding 
an octave above written), double bass (sounding an octave below written), and glockenspiel 
(sounding two octaves above written).

Dorico SE stores all note information in concert pitch and automatically transposes notes as 
appropriate for the transposition of the instrument. This means notes, key signatures, and chord 
symbols are automatically changed in transposing layouts compared to non-transposing layouts. 
You can also change instruments at any time, and the music is adjusted automatically to ensure 
the correct pitches are shown.

You can also change the octave of individual clefs.

RELATED LINKS
Instrument picker on page 83
Instrument numbering on page 101
Instrument transpositions in staff labels on page 904
Concert vs. transposed pitch on page 127
Making layouts transposing/concert pitch on page 127
Setting different clefs for concert/transposed pitch on page 619
Changing instruments on page 107
Hiding/Showing clefs according to layout transpositions on page 619
Clefs with octave indicators on page 621

Fretted instrument tuning
Fretted instruments can have different numbers of strings and frets. In order to display tablature 
for fretted instruments in Dorico SE, you must specify information about the tuning of fretted 
instruments.

Dorico SE requires the following information to display tablature:

● The number of strings the instrument has

● The open pitch of each string

● The number of frets

● The fret number at which each string starts, such as for the fifth string on a banjo

● The pitch intervals between frets

When you assign a fretted instrument to a player or change an existing instrument, any available 
tunings for that instrument are shown in the instrument picker.

You can also customize all aspects of fretted instruments in the Edit Strings and Tuning dialog.
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NOTE

Any fretted instruments in projects created in earlier versions of Dorico SE are automatically 
assigned the standard set of strings and tunings associated with that instrument when the 
project is first opened in Dorico SE 3. The quickest way to change their tuning is changing the 
instrument type in the instrument picker.

RELATED LINKS
Instrument picker on page 83
Changing instruments on page 107
Edit Strings and Tuning dialog on page 116

Adding instruments to players
You can add instruments to both solo and section players. You can add multiple instruments to 
solo players but only a single instrument to section players.

PREREQUISITE
You have added a solo or section player.

PROCEDURE

1. In the Players panel, select the player to which you want to add instruments.

NOTE

You can only add instruments to a single player at a time.

2. Press Shift-I  to open the instrument picker.

3. Select the instrument you want in the instrument picker.

4. Press Return  to add the selected instrument.

5. Optional: Repeat steps 2 to 4 to add multiple instruments to a single solo player.

NOTE

You can only add a single instrument to each section player.

RESULT
The selected instrument is added to the selected player. Dorico SE automatically loads sounds for 
the instrument according to the current playback template.

NOTE

● Before you have input any notes, only the first instrument held by solo players is shown in 
full scores in page view. All instrument staves are shown in galley view, so we recommend 
switching to galley view to input notes for any other instruments held by solo players.

● If you want to add multiple players to your project at the same time, you can add ensembles 
or use a project template.

RELATED LINKS
Players panel on page 81
Instrument picker on page 83
Adding ensembles on page 99
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Starting new projects from project templates on page 55
Switching to galley/page view on page 42
Playback templates on page 473
Instrument changes on page 102
Player, layout, and instrument names on page 129
Changing instrument names on page 131

Adding empty percussion kits to players
You can add empty percussion kits to players, to which you can then add unpitched percussion 
instruments.

PROCEDURE

1. In the Players panel, open the Edit Percussion Kit dialog in any of the following ways:

● Select a solo or section player, press Shift-I , and click Create Empty Kit in the 
instrument picker.

● Click the plus symbol  to the right of the added empty-handed player and click Create 
Empty Kit in the instrument picker.

● Right-click a player and choose Create Empty Kit from the context menu.

2. Add the percussion instruments you want to the kit in the Edit Percussion Kit dialog.

RELATED LINKS
Players panel on page 81
Percussion kits vs. individual percussion instruments on page 978
Edit Percussion Kit dialog on page 109
Instrument picker on page 83
Percussion kit presentation types on page 983

Combining individual percussion instruments into kits
If a player is holding one or more individual percussion instruments, you can combine them into 
a percussion kit.

PROCEDURE

1. In the Players panel, right-click the card of the player whose percussion instruments you 
want to combine into a kit and choose Combine Instruments into Kit from the context 
menu.

2. Edit the kit in the Edit Percussion Kit dialog that opens.

For example, you can change the order in which the instruments appear in a grid or on a 
five-line staff.

RESULT
A new kit is created containing all the instruments held by the player.

NOTE

If the player was already holding one or more kit instruments, all individual instruments and any 
other kits are combined into the first kit.
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Changing instruments
You can change the instruments held by players without affecting any music already entered 
onto their staves, for example, if your Clarinet part is very low and you want to change it to a 
Bass Clarinet or you want to change the tuning of a guitar.

NOTE

● You cannot change percussion kits into other instruments, you can only change individual 
unpitched percussion instruments.

● You cannot change a pitched instrument into an unpitched instrument, and vice versa.

● These steps describe changing the instrument type, not an instrument change partway 
through a flow.

PROCEDURE

1. In the Players panel, expand the card of the player whose instrument you want to change.

The card lists the instruments of the player.

2. Hover over the label of the instrument you want to change, click the arrow  that appears, 
and choose Change Instrument to open the instrument picker.

3. Select the instrument you want in the instrument picker.

4. Press Return  to change to the selected instrument.

RESULT
The selected instrument is changed without affecting any music on its staff.

NOTE

Where appropriate, new clefs are input. This means that notes can appear differently so that they 
are notated correctly according to the new clef.

AFTER COMPLETING THIS TASK
You can change the player order, for example, if the new instrument requires a different position 
according to orchestral convention.

RELATED LINKS
Players panel on page 81
Instrument picker on page 83
Fretted instrument tuning on page 104
Transposing instruments on page 104
Edit Strings and Tuning dialog on page 116
Instrument changes on page 102
Changing the default player order on page 97

Moving instruments
You can move individual instruments without affecting any music already input for those 
instruments. You can move instruments between players or to a different position in the 
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instrument list for a solo player, for example, if you want to change the order of staves in the 
score.

PREREQUISITE
You have added the players to which you want to move instruments.

PROCEDURE

1. In the Players panel, expand the cards of the players holding the instruments you want to 
move.

2. Move instruments in any of the following ways:

● To change the order of instruments for a single player, click and drag a single 
instrument and release it at the required position.

● To move instruments to another player, click and drag a single instrument and release it 
over the player card to which you want to move them.

● To move instruments to another player, click the arrow  that appears in the instrument 
label when you hover over it and choose Move Instrument to Player > [Player].

RELATED LINKS
Players panel on page 81
Adding solo/section players on page 95
Changing the default player order on page 97

Deleting instruments
You can delete individual instruments without deleting the player holding them or other 
instruments held by the same player.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In the Players panel, expand the card of the player holding the instrument you want to 
delete.

2. Click the arrow  that appears in the instrument label when you hover over it and choose 
Delete Instrument.

3. Click OK.

RESULT
The instrument is deleted from the player.

TIP

If you want to delete all instruments held by a single player, you can also delete the player.

RELATED LINKS
Players panel on page 81
Deleting players on page 98
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Edit Percussion Kit dialog
The Edit Percussion Kit dialog allows you to make changes to percussion kits, including which 
instruments are included in them and how instruments are arranged in the different available kit 
presentations.

● The Edit Percussion Kit dialog opens automatically when you create empty kits or combine 
existing instruments into a kit.

● You can also open the Edit Percussion Kit dialog manually for existing percussion kit 
instruments by expanding the card of the player holding the percussion kit in the Players 
panel in Setup mode, then clicking the arrow in its label and choosing Edit Percussion Kit.

NOTE

Percussion kit instrument labels are green in the Players panel in Setup mode.

1 Name

Allows you to enter or change the full name for the percussion kit. This is used in Full staff 
labels for percussion kits that use the five-line staff presentation type.

2 Short name

Allows you to enter or change the abbreviated name for the percussion kit. This is used in 
Abbreviated staff labels for percussion kits that use the five-line staff presentation type.

3 Drum set

Percussion kits are defined as drum sets when the checkbox is activated. Percussion kits that 
are defined as drum sets have different default settings, including for voicing and default 
stem directions.

4 Presentation types

Setup mode
Instruments 

109
Dorico SE 3.5.12



Allows you to select a percussion kit presentation type in order to edit how the selected 
percussion kit appears in that presentation type.

● 5-line Staff: Kit instruments are shown on a five-line staff. You can determine which 
instruments are shown on each line and in each space of the staff. A single staff label 
containing the name of the kit is shown.

● Grid: Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize how large the gaps between each line are. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

● Single-line Instruments: Kit instruments are shown as individual instruments with their 
own lines. Normal-sized staff labels are shown for each instrument.

5 Editor

Displays the current arrangement of instruments in the selected percussion kit presentation 
type. You can change the order of instruments and the layout of lines and spaces in the grid 
presentation type by using the controls.

6 Controls

Allows you to change the order and stem direction of instruments in the selected percussion 
kit presentation type. It also allows you to add slash voices to the kit.

You can access dialogs to change the noteheads used for each instrument in the kit by 
clicking Edit Noteheads. You can also change how combinations of noteheads, articulations, 
and tremolos affect playback by clicking Edit Percussion Playing Techniques.

You can also change the names of individual instruments within percussion kits. Click Edit 
Names to open the Edit Instrument Names dialog.

NOTE

This changes the appearance of percussion instrument names in all presentations. 
Depending on the percussion kit presentation type, staff labels might use different 
information than these instrument names.

7 Action bar

Contains options that apply to all presentation types.

● Add New Instrument : Opens the instrument picker, which allows you to choose a 
new unpitched percussion instrument to be added to the kit.

● Add Existing Instrument From Player : Shows a menu listing the other players in 
your project that are holding individual percussion instruments not in kits. You can 
select a percussion instrument from another player to move to this kit, bringing its 
music with it.

● Remove Instrument From Kit : Removes the selected instrument from the kit, so 
it appears as an individual instrument. You can move individual instruments to other 
players or into other kit instruments.

● Change Instrument : Opens the instrument picker, which allows you to choose a new 
unpitched instrument to replace the selected instrument while retaining its music.

● Delete Instrument : Deletes the instrument from the kit, including its music.

8 Export Kit

Allows you to export the percussion kit as a library file so you can use it in other projects.

RELATED LINKS
Percussion kits and drum sets on page 979
Staff labels for percussion kits on page 907
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Percussion kit presentation types on page 983
Changing the percussion kit presentation type on page 984
Percussion Instrument Playing Techniques dialog on page 985
Playing techniques for unpitched percussion instruments on page 985

Adding instruments to percussion kits
You can add new instruments to percussion kits within the Edit Percussion Kit dialog.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit to which you want to add 
instruments.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click Add New Instrument  to open the instrument picker.

4. Select the percussion instrument you want in the instrument picker.

5. Press Return  to add the selected instrument.

6. Click Close.

RESULT
The selected instrument is added to the percussion kit.

RELATED LINKS
Players panel on page 81
Percussion kit presentation types on page 983

Changing instruments in percussion kits
You can change existing instruments in percussion kits while retaining any existing music for that 
instrument.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit in which you want to 
change instruments.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click the instrument you want to change.

4. Click Change Instrument  in the action bar to open the instrument picker.

5. Select the percussion instrument you want in the instrument picker.

6. Press Return  to change to the selected instrument.

7. Click Close.

RESULT
The instrument is changed to the one selected in the instrument picker. Any music input for the 
previous instrument is retained.
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NOTE

Playing techniques expressed using playing technique-specific noteheads are not retained.

Defining percussion kits as drum sets
You can define individual percussion kits as drum sets. Drum sets use a different voicing than 
percussion kits when using the five-line staff presentation.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit you want to define as a 
drum set.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Activate Drum set in the top right of the dialog.

4. Click Apply, then Close.

RESULT
The selected percussion kit is defined as a drum set. The arrangement of voices for instruments 
in the kit when using the five-line staff presentation type follows the default settings for drum 
sets.

NOTE

If you no longer want a percussion kit to be defined as a drum set, you can deactivate Drum set 
in the Edit Percussion Kit dialog for that kit.

RELATED LINKS
Players panel on page 81
Percussion Instrument Playing Techniques dialog on page 985

Creating groups of instruments within grid presentation percussion kits
You can create groups of instruments within percussion kits that use the grid presentation type 
in order to have a better overview of the instruments in the kit.

In grid presentation percussion kits, the name of each individual instrument is shown in the staff 
label. You can simplify the staff label of grid presentation percussion kits by creating groups, for 
example, to show Wood Blocks instead of Wood Block (High), Wood Block (Medium), and Wood 
Block (Low).

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit in which you want to 
create groups in the grid presentation.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the first instrument you want to include in the group.

5. Shift -click the last instrument you want to include in the group.
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NOTE

You can only include adjacent instruments in groups.

6. Click Add .

RESULT
A group is created containing the selected instruments. The group is given a default name that 
you can change.

RELATED LINKS
Players panel on page 81
Percussion kit presentation types on page 983

Renaming groups in grid presentation percussion kits
Group names are shown as instrument labels. You can change the names of groups in 
percussion kits using grid presentation.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit in which you want to 
change the names of groups in the grid presentation.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Double-click the group you want to rename to open the Edit Percussion Grid Group Names 
dialog.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Enter the names you want to give the group in the corresponding fields in the Edit 
Percussion Grid Group Names dialog:

● Full Name

● Short Name

6. Click OK to save your changes and close the dialog.

RESULT
The name of the group is changed. This also changes the staff label for the group.

NOTE

Staff labels for groups in grid presentation percussion kits use a different paragraph style to the 
staff labels for non-grouped instruments in grid presentation percussion kits.
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EXAMPLE

Ungrouped grid presentation percussion kit Grid presentation percussion kit with wood blocks 
grouped

RELATED LINKS
Staff labels for percussion kits on page 907

Deleting groups within grid presentation percussion kits
You can delete groups in percussion kits using grid presentation without deleting the 
instruments within the group.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit from whose grid 
presentation you want to delete groups.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the group you want to delete.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Click Delete .

RESULT
The group is deleted. The individual staff labels for each instrument in the group are restored.

Changing the positions of instruments within percussion kits
You can change the positions of instruments within percussion kits of all presentation types 
to change the order in which the instruments appear in the score and parts. In five-line staff 
presentation types, you can also change the staff position of slash voices.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit in which you want to 
change the positions of instruments.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click the kit presentation type in which you want to change the order of instruments.

For example, click Grid to change the order of instruments when the kit uses the grid 
presentation type.
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4. Click the percussion instruments and/or slash voices whose position you want to change.

NOTE

When using the mouse, you can only move one instrument or slash voice at a time.

5. Change the position of the selected instruments/slash voices in any of the following ways:

● Click Move up arrow to move them upwards.

● Click Move down arrow to move them downwards.

● Click and drag a single instrument upwards/downwards (five-line staff presentation 
only).

6. Optional: Repeat these steps for other instruments in the percussion kit, and for other kit 
presentation types for the same percussion kit.

7. Click Apply, then Close.

RESULT
The positions of the selected instruments and/or slash voices within the kit is changed. Multiple 
instruments can share the same staff position, but we recommend that they use different 
noteheads so that the player can tell them apart.

RELATED LINKS
Players panel on page 81
Moving notes to different instruments in percussion kits on page 981

Changing the size of gaps between lines in percussion grids
You can change the size of gaps between lines in percussion kits using the grid presentation 
type.

PROCEDURE

1. In the Players panel, expand the card of the player in whose percussion kit you want to 
change the size of gaps in the grid presentation.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the instruments below which you want to change the gap size.

5. Change the value for Gap.

6. Click Apply, then Close.

RESULT
The size of the gaps below the selected instruments is changed.

Removing individual instruments from percussion kits
You can remove individual instruments from percussion kits, for example, if you want to move an 
instrument from one percussion kit to another player.

PROCEDURE

1. In the Players panel, expand the card of the player holding the kit from which you want to 
remove instruments.
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2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click the instruments you want to remove from the kit.

4. Click Remove Instrument From Kit  in the action bar.

5. Click Close.

RESULT
The selected instruments appears as individual instruments belonging to the same player but 
separate from the percussion kit.

You can then move the instruments to other players if required.

RELATED LINKS
Players panel on page 81
Moving instruments on page 107

Edit Strings and Tuning dialog
The Edit Strings and Tuning dialog allows you to customize the tuning of individual fretted 
instruments by changing the number of strings and frets they have, the pitches of their open 
strings, and the spacing of their frets.

● You can open the Edit Strings and Tuning dialog in Setup mode by expanding the card of 
the player holding the fretted instrument in the Players panel, then clicking the arrow in its 
label and choosing Edit Strings and Tuning.

The Edit Strings and Tuning dialog comprises the following:

1 Instrument

Displays the name of the selected fretted instrument.

2 String editor

Allows you to select and edit individual or all strings of the fretted instrument. The 
arrangement of strings in the editor matches that of the real instrument. The pitch and 
total number of frets of each string is shown to the left of the vertical line that represents the 
nut.

3 Controls
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Allow you to edit individual or multiple strings. The following controls are available when at 
least one string is selected in the string editor:

● Open pitch: Allows you to set the open pitch of the string using the note name and 
octave, such as C4 for middle C. If necessary, you can add # for sharp and b for flat.

● No. of frets: Allows you to set the number of frets for the selected strings.

● Starting fret: Allows you to set the number of the first fret on the selected strings. For 
example, the fifth string on the banjo starts at fret 5.

● Tune Up Half-Step: Allows you to raise the open pitch of the selected strings by a 
half-step (semitone).

● Tune Down Half-Step: Allows you to lower the open pitch of the selected strings by a 
half-step (semitone).

● Irregular fret spacing: Allows you to set non-chromatic fret arrangements for 
instruments with fretboards that correspond to other scales, such as the dulcimer. Enter 
1 for a half-step and 2 for a whole step, with each step separated by a comma. For 
example, enter 2,2,1,2,2,2,1 to set the pattern for a major scale.

4 Select all

Selects all strings at once.

5 Action bar

Contains options that allow you to change the number and arrangement of strings.

● Add String: Adds a new string below the lowest currently selected string. The new string 
is a duplicate of the lowest currently selected string.

● Add String at Top: Adds a new string at the top of the fretboard. The new string is a 
duplicate of the previous top string.

● Move string buttons: Allow you to move the currently selected strings up/down the 
fretboard.

● Reset to Default: Returns all strings and corresponding tunings to the factory default 
settings for the fretted instrument.

● Delete String : Deletes the selected strings.

6 Import Tuning

Opens the File Explorer/macOS Finder, where you can select the .doricotuning file that 
you want to import and apply to the fretted instrument.

7 Export Tuning

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the strings and tuning settings of the fretted instrument as a .doricotuning file. 
You can then import the .doricotuning file into other instruments/projects and share it 
with other users.

RELATED LINKS
Players panel on page 81
Chord diagrams on page 608
Tablature on page 917
Fretted instrument tuning on page 104
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Changing the open pitches of fretted instrument strings
You can change the open pitch of each fretted instrument string independently, for example, if 
your project requires an unconventional tuning that is not available as an instrument type in the 
instrument picker.

PROCEDURE

1. In the Players panel, expand the card of the player holding the fretted instrument whose 
open pitches you want to change.

2. Click the arrow  that appears in the instrument label when you hover over it and choose 
Edit Strings and Tuning to open the Edit Strings and Tuning dialog.

3. Select the string whose open pitch you want to change.

4. Change the Open pitch value, for example, to G2.

5. Optional: Repeat steps 3 and 4 to change the open pitch of other strings.

6. Click OK to save your changes and close the dialog.

RESULT
The open pitches of the selected strings are changed. This affects the tuning of the instrument 
and the pitch of all fret positions on those strings.

The new tuning becomes available for chord diagrams.

RELATED LINKS
Players panel on page 81
Chord diagrams on page 608
Hiding/Showing chord diagrams on page 609

Importing fretted instrument tunings
You can import custom fretted instrument tunings that you have already created and apply them 
to instruments. This allows you to reuse tunings without having to create them from scratch.

PROCEDURE

1. In the Players panel, expand the card of the player holding the fretted instrument to which 
you want to apply an imported tuning.

2. Click the arrow  that appears in the instrument label when you hover over it and choose 
Edit Strings and Tuning to open the Edit Strings and Tuning dialog.

3. Click Import Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. Locate and select the .doricotuning library file you want to import.

5. Click Open.

RESULT
The selected .doricotuning file is applied to the fretted instrument. The imported tuning 
becomes available for chord diagrams.
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Exporting fretted instrument tunings
You can export fretted instrument tunings so you can reuse them for other instruments and in 
other projects. Fretted instrument tunings are exported as .doricotuning library files.

PROCEDURE

1. In the Players panel, expand the card of the player holding the fretted instrument whose 
tuning you want to export.

2. Click the arrow  that appears in the instrument label when you hover over it and choose 
Edit Strings and Tuning to open the Edit Strings and Tuning dialog.

3. Click Export Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The tuning of the selected fretted instrument is exported and saved as a .doricotuning library 
file.

AFTER COMPLETING THIS TASK
You can import the library file into other projects to reuse the fretted instrument tuning.

Player groups
A group represents a collection of musicians that are considered together, such as one choir in 
a work for double choir or an off-stage ensemble. Player groups can have their own brackets, 
depending on the bracket grouping set for each layout.

Grouping players together means they are positioned together in the default player order, 
numbered independently of players outside the group, and are bracketed together according 
to the ensemble type set for each layout.

For example, if your project is for double choir (SATB/SATB), all voices are joined by a single 
bracket by default because they are in the same family. However, if you add each choir to its own 
group, they are bracketed separately. This is useful in works containing multiple groups, such as 
in Britten's “War Requiem”, which has three distinct groups, or in Walton's “Belshazzar's Feast” 
which requires two separate off-stage brass groups.

You can add as many player groups as required, for example, to allow easy separation of 
forces or to prevent automatic instrument numbering for percussion instruments when multiple 
percussion players hold the same instrument to accommodate instrument changes.

RELATED LINKS
Instrument numbering on page 101
Brackets and braces on page 592
Brackets according to ensemble type on page 594
Changing the default player order on page 97
Setting custom player orders on page 98
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Adding player groups
You can organize players into groups, for example, if you want to bracket them together. Players 
in different groups are also numbered separately.

PROCEDURE

1. Optional: If you want to add a group that includes existing players, select those players in 
the Players panel.

2. In the Players panel action bar, click Add Group .

RESULT
A new player group is added to the Players panel. If you selected players, those players are 
added to the group. If you did not select players, the new group is empty.

AFTER COMPLETING THIS TASK
You can add players to groups and move them between groups.

RELATED LINKS
Players panel on page 81
Adding players to groups on page 121
Moving players between groups on page 121

Renaming player groups
You can change the name of player groups after you have added them.

PROCEDURE

1. In the Players panel, double-click the name of the group.

2. Enter a new name for the group or edit the existing name.

3. Press Return .

Deleting player groups
You can delete groups of players, for example, if you no longer need a group of players that you 
created when importing a MIDI file. When deleting player groups, you can choose to keep the 
players within the group or delete them as well.

PROCEDURE

1. In the Players panel, select the group that you want to delete.

2. Press Backspace or Delete .

3. Choose one of the following options in the warning message that opens:

● Keep Players: Deletes the group but keeps the players.

● Delete Players: Deletes the group and the players it contains.
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Adding players to groups
You can add existing or new players to player groups.

PREREQUISITE
You have added at least one player, one ensemble, or one group.

PROCEDURE

● In the Players panel, do one of the following:

● Select one or more players and click Add Group.

● Select a group, and click Add Solo Player, Add Section Player, or Add Ensemble.

RESULT
If you clicked Add Group, a new group is added for the selected players.

If you clicked Add Solo Player, Add Section Player or Add Ensemble, a new player or ensemble 
is added to the selected group.

RELATED LINKS
Adding solo/section players on page 95

Moving players between groups
You can move players from one group to another.

PROCEDURE

1. In the Players panel, select the players that you want to move to another group.

2. Click and drag the selected players to the position you want in the other group.

An insertion line indicates where the players will be positioned.

RESULT
The players are moved to the other group.

Removing players from groups
You can remove players from groups.

PROCEDURE

● In the Players panel, remove players from groups in any of the following ways:

● Click and drag multiple selected players out of the group and release the mouse.

● Right-click a single player and choose Remove Player from Group from the context 
menu.

NOTE

You can only remove a single player from a group at a time when using the context 
menu.

RESULT
The players are removed from their groups but remain in the project as individual players.
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Flows
Flows are separate spans of music that are completely independent in musical content, meaning 
they can contain completely different players from each other and have different time signatures 
and key signatures. A single project can contain any number of flows.

Depending on the purpose of each project, a flow could be, for example, a single song in an 
album, a movement in a sonata or symphony, a number in a stage musical, or a short scale or 
sight-reading exercise of only a few bars in length.

Dorico SE automatically adds a flow to projects once you have added at least one player. You 
cannot add flows until you have added at least one player to the project.

When you add a flow in Dorico SE, the following happens automatically:

● The flow is assigned to all full score and part layouts in the project.

● All players are assigned to the new flow.

By default, all layouts include all flows in the project. If necessary, you can change the layouts to 
which flows are assigned and which players are assigned to flows.

IMPORTANT

If you exclude a player from a flow, any notes that you have already input for that player in that 
flow are deleted.

RELATED LINKS
Flows panel on page 87
Players on page 94
Layouts on page 124
Tacets on page 389
Players, layouts, and flows on page 93
Importing flows on page 59
Exporting flows on page 61
Flow headings on page 364

Adding flows
You can add any number of new flows to your project.

PREREQUISITE
You have added at least one player to the project.

PROCEDURE

1. In the Flows panel, click Add Flow .

2. Optional: Repeat for as many flows as you require.

RESULT
A new flow is added to your project each time you click Add Flow. All existing players are 
assigned to new flows, and new flows are automatically assigned to all existing full score and 
part layouts.

AFTER COMPLETING THIS TASK
You can double-click the flow card to rename the flow. You can also change the players assigned 
to the flow and the layouts to which the flow is assigned.
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RELATED LINKS
Flows panel on page 87
Importing flows on page 59
Adding solo/section players on page 95
Assigning players to flows on page 123
Assigning flows to layouts on page 126

Duplicating flows
You can duplicate flows, for example, if you want to experiment with some ideas without 
affecting the original flow or if you want to copy material with any barlines you have added.

PROCEDURE

● In the Flows panel, right-click the flow you want to duplicate and choose Duplicate Flow 
from the context menu.

RESULT
A new flow is added, containing all the music and players of the original flow. It is automatically 
added to all full score and part layouts.

Assigning players to flows
By default, all players in your project are added to all flows that originated in the project. You can 
assign players to and remove players from flows manually, for example, if the soloists in a choral 
work do not sing for an entire flow.

NOTE

If you remove a player from a flow, any notes you have already input for that player in that flow 
are deleted.

PROCEDURE

1. In the Flows panel, select the flow whose assigned players you want to change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the flow.

TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

3. Optional: Repeat steps 1 and 2 for other flows whose assigned players you want to change.

RESULT
Players are assigned to the selected flow when the checkbox in their player card is activated, and 
removed from the flow when the checkbox is deactivated.

RELATED LINKS
Flows panel on page 87
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Tacets on page 389
Assigning flows to layouts on page 126
Assigning players to layouts on page 125

Deleting flows
You can delete flows that you no longer need. This deletes all music for all instruments belonging 
to all players in the flows.

PROCEDURE

1. In the Flows panel, select the flows you want to delete.

2. Press Backspace or Delete .

Layouts
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts only include the music for that 
player whereas full score layouts contain all staves in the project.

You can control practically every aspect of the visual appearance of the music in each layout 
independently, including staff size, note spacing, and system formatting. Each layout can also 
have independent page formatting settings, such as page size, margins, running headers, and 
footers.

Dorico SE provides the following layout types:

Full score
A full score layout includes all players and all flows in your project by default. Full score 
layouts are concert pitch by default.

Part
A part layout is automatically created when you add a player to your project. You can 
also create empty part layouts and assign players to them manually.

By default, instrumental part layouts contain all flows. They are also transposed pitch 
by default.

Custom score
A custom score layout initially does not contain any players or flows. This allows you 
to create your score manually and, for example, assign only one flow instead of all 
flows or only vocal and piano players to create a vocal score. Custom score layouts are 
concert pitch by default.

TIP

You can combine players, layouts, and flows together in any combination. For example, you 
might add all percussion players to a single part layout so that the performers can manage 
instrument changes themselves. In a large-scale work, you might also create a piano reduction 
for choir rehearsals, but only assign that piano player to the vocal score, meaning it does not 
appear in the orchestral full score at all.

You can also create as many layouts as required.
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RELATED LINKS
Page formatting on page 367
Flows on page 122
Players on page 94
Players, layouts, and flows on page 93
Player, layout, and instrument names on page 129
Brackets according to ensemble type on page 594
Local vs. global properties on page 149

Creating layouts
You can create any number of full score, custom score, and part layouts in each project. By 
default, Dorico SE creates a single full score layout and a part layout for each instrument.

PROCEDURE

● In the Layouts panel action bar, click one of the following layout types:

● Add Full Score Layout 

● Add Instrumental Part Layout 

● Add Custom Score Layout 

RESULT
The layout is added to the list of layouts in the Layouts panel.

NOTE

Layouts are not available in the layout selector until you have assigned at least one player to 
them.

AFTER COMPLETING THIS TASK

● You can assign players and flows to your layout.

● If you want to change the position of the new layout in the layouts list, you can sort and 
renumber layouts.

RELATED LINKS
Layouts panel (Setup mode) on page 85
Workspace options on page 25
Sorting layouts on page 128
Renumbering layouts on page 128
Switching between layouts on page 36
Opening new tabs on page 38

Assigning players to layouts
By default, all players are included in full score layouts and each player is automatically assigned 
its own part layout. You can assign players to and exclude players from layouts manually, for 
example, if you want to remove unnecessary players from the full score, or you want to add the 
soloists’ music to the part for the accompanist.

PROCEDURE

1. In the Layouts panel, select the layout whose assigned players you want to change.
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2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the layout.

TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

3. Optional: Repeat steps 1 and 2 for any other layouts whose assigned players you want to 
change.

RESULT
Players are assigned to the selected layout when the checkbox in their player card is activated, 
and removed from the layout when the checkbox is deactivated. If you have not changed the 
name of the layout, it is automatically updated to reflect the players included in the layout.

RELATED LINKS
Players panel on page 81
Layouts panel (Setup mode) on page 85
Player, layout, and instrument names on page 129
Renaming layouts on page 131
Assigning players to flows on page 123

Assigning flows to layouts
By default, all flows in your project are added to all layouts. You can exclude flows that you do not 
want to show in a layout. You can assign flows to and remove flows from layouts manually, for 
example, if a flow in your project contains specific performance instructions for strings that you 
want to show in string part layouts but not in other part layouts.

PROCEDURE

1. In the Layouts panel, select the layout whose assigned flows you want to change.

2. In the Flows panel, activate the checkbox in the flow card of each flow you want to assign to 
the layout.

TIP

You can Shift -click to activate/deactivate the checkboxes in multiple flow cards at once.

3. Optional: Repeat steps 1 and 2 for other layouts whose assigned flows you want to change.

RESULT
Flows are assigned to the selected layout when the checkbox in their flow card is activated, and 
removed from the layout when the checkbox is deactivated.

Dorico SE automatically creates enough pages to display the flows assigned to the layout.
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RELATED LINKS
Layouts panel (Setup mode) on page 85
Flows panel on page 87

Making layouts transposing/concert pitch
You can change whether each layout in your project is transposing or concert pitch. In Dorico SE, 
full score layouts are concert pitch and part layouts are transposing by default.

For example, full scores are often concert pitch, to show notes at their sounding pitch, but part 
layouts are transposing so the player can read the notes they must play in order to achieve the 
desired sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to make transposing/non-transposing.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Players section, activate/deactivate Transposing layout.

5. Click Apply, then Close.

RESULT
The selected layouts are transposed pitch when Transposing layout is activated, and concert 
pitch when it is deactivated.

TIP

You can also make layouts transposing by choosing Edit > Transposed Pitch, and concert pitch 
by choosing Edit > Concert Pitch. This automatically updates the layout option but only for the 
layout currently open in the music area.

RELATED LINKS
Transposing instruments on page 104
Transposing selections on page 202
Setting different clefs for concert/transposed pitch on page 619
Hiding/Showing clefs according to layout transpositions on page 619

Concert vs. transposed pitch
Layouts in Dorico SE can use concert or transposed pitch. This affects the pitches and key 
signatures on staves belonging to transposing instruments.

Concert pitch
When music is in concert pitch, all notes are written as they sound. This means that 
players with transposing instruments reading music in concert pitch must transpose 
the music themselves. For example, if a clarinet in B♭ reads a C in concert pitch, they 
must play the note D on their instrument to produce the sounding note C.

Setup mode
Layouts 

127
Dorico SE 3.5.12



Transposed pitch
When music is in transposed pitch, the notes written are the ones each instrument 
must play in order to produce the desired sounding pitch. For example, if a clarinet in 
B♭ reads a D in transposed pitch, the pitch that sounds from the instrument is C.

Transposing scores and parts also transpose key signatures according to the transposition of the 
instrument.

RELATED LINKS
Transposing key signatures alongside selections on page 697
Enharmonic equivalent key signatures on page 698
Clefs with octave indicators on page 621

Sorting layouts
You can change the order in which layouts appear in the Layouts panel and the layout selector, 
for example, if you added a custom score layout and want it to be positioned at the top next to 
the full score layout.

PROCEDURE

1. In the Layouts panel, click and drag a layout card to a different position.

An insertion line indicates where the players will be positioned.

2. Release the mouse.

RESULT
The layout is inserted at the selected position.

RELATED LINKS
Layouts panel (Setup mode) on page 85

Renumbering layouts
You can renumber all the layouts in their project according to their current position in the 
Layouts panel in Setup mode, for example, after you have dragged layouts to different positions.

PROCEDURE

● In the Layouts panel, right-click any layout card and choose Renumber Layouts from the 
context menu.

RESULT
All layouts are renumbered according to their current position in the panel. Full score layouts, 
custom score layouts, and part layouts are all numbered separately.

Deleting layouts
You can delete any layout from the project, for example, if you only want to use a combined 
Violin I and II part, you can delete their separate parts. Deleting layouts does not delete any 
music from the project.

PROCEDURE

1. In the Layouts panel, select the layouts that you want to delete.
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2. Press Backspace or Delete .

RELATED LINKS
Layouts panel (Setup mode) on page 85
Players, layouts, and flows on page 93

Restoring default layouts
You can recreate all the part layouts that Dorico SE provides by default, for example, if you 
accidentally deleted some part layouts.

PROCEDURE

● Choose Setup > Create Default Part Layouts.

RESULT
The default set of part layouts is restored, recreating a single part layout for each player that 
contains all flows in the project. Any part layouts that were recreated are added at the bottom 
of the Layouts list. Their order matches the order of the corresponding players in the Players 
panel.

Player, layout, and instrument names
In Dorico SE, you can use three different names to refer to the same player in different contexts. 
This allows you to show relevant information in different places in the score.

The following names relate to players and instruments:

Player name
The name of each player in the Players panel. Player names do not appear in any 
layouts by default. Instead, you can use the player name as part of your own workflow, 
independently of what instruments and players are called in staff labels and layout 
names.

Player names are automatically generated when you add instruments.

Layout name
The name for each layout in the Layouts panel. They are used at the top of individual 
part layouts by default.

Layout names for part layouts are automatically generated when you add instruments 
to the corresponding players, and are linked to the corresponding players’ names until 
you rename the layout.

Instrument names
Used in staff labels. This means that the instrument label on each staff is relevant 
to the instrument or percussion kit currently being played by that player, rather than 
listing all instruments that player is playing in the flow.

For example, if a clarinettist is doubling bass clarinet, the staff label where the player 
plays clarinet automatically shows Clarinet, and the staff label automatically shows 
Bass Clarinet where the player plays bass clarinet.

All instruments in Dorico SE come with a set of instrument names that you can change 
for individual instruments, independently of other players in the project holding the 
same instrument. You can also save changes to instrument names as default, which 
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are then used whenever you add that instrument again in the current project and all 
future projects.

NOTE

Changing the default instrument names does not change the instrument names of 
existing instruments of that type in your project.

RELATED LINKS
Instrument numbering on page 101
Text tokens on page 397
Staff labels on page 901
Percussion legends on page 990
Players on page 94
Layouts on page 124
Assigning players to layouts on page 125
Changing instrument names on page 131

Renaming players
You can change the player names of players, and reset renamed players to their default name. 
Player names do not appear in any layouts by default, but are used to generate layout names 
and appear in guide instrument labels in galley view for players holding multiple instruments.

PROCEDURE

1. In the Players panel, select player you want to rename.

2. Press Return  to open the player name text field.

3. Enter a new name, or click Reset to Default  to revert the name to the default name.

4. Press Return .

RESULT
The selected player is renamed, or reverted to its default name.

NOTE

This does not affect staff labels or the name at the top of part layouts. You can change the 
instrument names used in staff labels in the Edit Instrument Names dialog, and rename layouts 
to change the name that appears at the top of part layouts.

RELATED LINKS
Player, layout, and instrument names on page 129
Players panel on page 81
Changing instrument names on page 131
Edit Instrument Names dialog on page 132
Staff labels on page 901
Switching to galley/page view on page 42
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Renaming layouts
You can rename layouts and reset renamed layouts to their default name, for example, to include 
the appropriate instrument transposition for layouts with transposition overrides. Layout names 
appear at the top of part layouts by default.

PROCEDURE

1. In the Layouts panel, select the layout you want to rename.

2. Press Return  to open the layout name text field.

3. Enter a new name, or click Reset to Default  to revert the name to the player name.

TIP

If you want to include an accidental in the instrument transposition, you can enter the 
appropriate text token, such as {@flat@} for ♭.

4. Press Return .

RESULT
The selected layout is renamed, or reverted to its default name.

NOTE

This does not affect staff labels. You can change the instrument names used in staff labels in the 
Edit Instrument Names dialog.

RELATED LINKS
Player, layout, and instrument names on page 129
Layouts panel (Setup mode) on page 85
Text tokens on page 397
Staff labels on page 901

Changing instrument names
Instrument names are used in staff labels and instrument change labels shown above the staff. 
You can change the different instrument names used for each instrument, for example, if you 
want them to appear in a different language.

NOTE

Changing instrument names does not change the name shown at the top of part layouts. If you 
want to change the name used at the top of part layouts, rename the layout.

PROCEDURE

1. In the Players panel, click the disclosure arrow in the card of the player holding the 
instrument whose names you want to change.

This expands the card to show the instruments held by the player.

2. Click the arrow  that appears in the instrument label when you hover over it and choose 
Edit Names to open the Edit Instrument Names dialog.

3. Enter new names in any of the name fields.

4. Optional: Activate Save as default for instrument.
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5. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are changed.

● If you did not save your changes as default, only the names of the selected instrument are 
changed. Any instruments of the same type added later or in future projects use the original 
default names.

● If you saved your changes as default, any instruments of the same type added later 
or in future projects use your new instrument names. This does not affect any existing 
instruments of that type unless you reset their names.

RELATED LINKS
Players panel on page 81
Instruments on page 100
Instrument changes on page 102
Editing the default instrument change label text on page 103

Edit Instrument Names dialog
The Edit Instrument Names dialog allows you to change the content and formatting of each 
instrument’s names, which are used in staff labels and instrument change labels shown above 
the staff. You can edit both singular/plural full instrument names and singular/plural short 
instrument names.

● You can open the Edit Instrument Names dialog in Setup mode by clicking the arrow in an 
instrument label in the Players panel and choosing Edit Names.
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The Edit Instrument Names dialog contains the following options and sections:

1 Editing instrument

Displays the permanent underlying name of the instrument.

2 Editing

Allows you to switch between editing the Singular names and Plural names of the selected 
instrument.

Singular names is used when staff labels are shown by default, Plural names is used when 
the staff contains multiple players.

3 Full name section

Contains options that allow you to edit the appearance of the full instrument name.

4 Full name text editor options

Allows you to customize the font, size, and formatting of the long staff label of the selected 
instrument.

NOTE

The horizontal alignment of staff labels always uses the alignment of the paragraph style, 
not the alignment set in the Edit Instrument Names dialog.

5 Full name text editing area

Shows the current long name for the selected instrument, as it appears in Full staff labels. 
You can select any part of the instrument name and edit it independently of other parts, for 
example, if you want to add additional information on a new line and in italics. However, 
when used for instrument change labels above the staff, instrument names are always 
shown on a single line.

Staff labels are right-aligned by default, so appear at the right edge of the text editing area.

NOTE

Staff labels always use the alignment set for the paragraph style, they do not use the 
alignment set in the Edit Instrument Names dialog. This ensures consistent alignment 
across the whole system.

6 Short name section

Contains options that allow you to edit the appearance of the short instrument name.

7 Short name text editor options

Allows you to customize the font, size, and formatting of the short staff label of the selected 
instrument.

NOTE

The horizontal alignment of staff labels always uses the alignment of the paragraph style, 
not the alignment set in the Edit Instrument Names dialog.

8 Short name text editing area

Shows the current short staff label for the selected instrument, as it appears in Abbreviated 
staff labels. You can select any part of the instrument name and edit it independently of 
other parts, for example, if you want to add additional information on a new line and in 
italics. However, when used for instrument change labels above the staff, instrument names 
are always shown on a single line.

Staff labels are right-aligned by default, so appear at the right edge of the text editing area.
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NOTE

Staff labels always use the alignment set for the paragraph style, they do not use the 
alignment set in the Edit Instrument Names dialog. This ensures consistent alignment 
across the whole system.

9 Show transposition

Allows you to choose when the transposition is shown in the instrument name for the 
selected instrument. It is common to see the transposition included in the name of 
transposing instruments, such as Clarinet in B♭.
You can choose when the transposition is shown from the following options:

● Always: Instrument transpositions are shown even if you have chosen to hide them on 
the Staves and Systems page in Setup > Layout Options.

● Follow Layout Options: Instrument transpositions can be hidden and shown, 
depending on your per-layout settings in Layout Options.

● Never: Instrument transpositions are never shown, even if you have chosen to show 
them in Layout Options.

10 Save as default for instrument

Activating the checkbox saves your changes in the dialog as the default. This affects all new 
instruments of that type that you add to the project and all future projects. It does not affect 
any existing instruments of that type unless you reset their names.

11 Reset to Default

Removes all your changes to the names of the selected instrument type and reverts them to 
the current default settings. If you changed the default name for an instrument type after 
adding an instrument, resetting its names changes them to your new default names.

RELATED LINKS
Resetting instrument names on page 134
Staff labels on page 901
Hiding/Showing staff labels on page 903

Resetting instrument names
You can reset all your changes to the names of individual instruments and revert them to the 
current default settings for their instrument type.

NOTE

Resetting instrument names does not change the name shown at the top of part layouts. If you 
want to change the name used at the top of part layouts, rename the layout.

PROCEDURE

1. In the Players panel, click the disclosure arrow in the card of the player holding the 
instrument whose names you want to reset.

This expands the card to show the instruments held by the player.

2. Click the arrow  that appears in the instrument label when you hover over it and choose 
Edit Names to open the Edit Instrument Names dialog.

3. Click Reset to Default.

4. Click OK to save your changes and close the dialog.
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RESULT
The instrument names for the selected instrument are reset to the current default settings for 
its instrument type. If you changed the default name for the instrument type after adding the 
instrument, resetting its names changes them to your new default names.

TIP

You can assign a key command for Reset Instrument Names on the Key Commands page in 
Preferences, which resets all instrument names in the project to their default settings.

RELATED LINKS
Players panel on page 81
Key Commands page in the Preferences dialog on page 47
Renaming layouts on page 131

Flow names and flow titles
Whenever you add a flow to a project, the default name of a flow is Flow plus an incremental 
number. In Dorico SE, flows have both a flow name and a flow title, which are the same by 
default but can be different if, for example, you want to organize sketch versions of flows without 
affecting their displayed titles in the music.

When you enter names for flows in flow cards in the Flows panel in Setup mode, those names 
are automatically added in the Title field for the corresponding flow in the Project Info dialog. If 
you later rename flows in the Flows panel, the corresponding flow titles are updated.

Changing the names or titles of flows in the Project Info dialog removes the link between their 
flow title and flow name, meaning that renaming flows in Setup mode no longer automatically 
updates the corresponding flow titles in the Project Info dialog.

Titles shown in scores and parts are linked to the Title field for each flow in the Project Info 
dialog, using the {@projectTitle@} and {@flowTitle@} tokens. This allows you to organize flows 
with different names to their displayed title in the music.

TIP

You can change both flow names and flow titles in the Project Info dialog, and you can also 
change flow names in the Flows panel in Setup mode.

RELATED LINKS
Text tokens on page 397
Project Info dialog on page 88
Flows panel on page 87

Renaming flows
You can change the names of flows in Setup mode. This automatically updates the title of the 
corresponding flow until you change the title in the Project Info dialog.

PROCEDURE

1. In the Flows panel in Setup mode, double-click the card of the flow you want to rename to 
open the flow name text field.

2. Enter a new name for the flow or edit the existing name.
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3. Press Return .

RESULT
The name of the flow is changed. If you have not entered a different title for the flow in the 
Project Info dialog, the title shown in the music area is updated to match the new flow name.

TIP

You can also rename flows in the Project Info dialog.

RELATED LINKS
Flows panel on page 87

Changing flow titles
You can change flow titles in the Project Info dialog. Once you have done so, flow titles are no 
longer automatically changed if you change their flow name.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. Select the flow whose title you want to change in the flows list.

3. Enter a new title in the Title field.

4. Optional: Repeat steps 2 and 3 for other flows in your project.

5. Click OK to save your changes and close the dialog.

RESULT
The titles of the selected flows are changed.

NOTE

This breaks the link between flow names and the title shown in the music area.

RELATED LINKS
Project Info dialog on page 88

Videos
Dorico SE supports the use of videos within the program as well as the associated notations, 
such as markers and timecodes, and allows you to find appropriate tempos based on where 
important markers occur.

Videos are a fast sequence of images that create the impression of a moving image. They can be 
any length, from only a few seconds up to several hours for feature-length films.

Videos in Dorico SE are shown in a separate Video window and play back in sync with the music. 
Any existing audio in the video is also played back, and you can control the volume of this audio 
independently of the volume of the music.
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TIP

You can use these features, including setting a project frame rate, without having a video 
attached.

RELATED LINKS
Adding videos on page 139
Frame rates on page 141
Timecodes on page 849
Markers on page 844
Changing the volume of video audio on page 141

Supported video formats
Dorico SE uses the same video engine that was introduced in Cubase and Nuendo in 2017. It 
supports the most commonly-used video formats.

The following video formats are supported:

● MOV: Including H263, H264, Apple ProRes, DV/DVCPro and Avid DNxHR codecs

● MP4: Including H263 and H264

● AVI: Including DV/DVCPro and MJPEG/PhotoJPEG

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico SE.

NOTE

● Videos with variable frame rates are not supported.

● Support for more formats is planned for future versions.

You can consult the Steinberg support site for more information about the supported formats as 
well as how to identify and change video formats.

RELATED LINKS
Frame rates on page 141

Video Properties dialog
The Video Properties dialog allows you to change video-related settings, including their frame 
rate and start position.

● You can open the Video Properties dialog in Setup mode by right-clicking a flow in the 
Flows panel and choosing Video > Properties from the context menu.

It also opens automatically when you add a new video.
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The Video Properties dialog contains the following fields and options:

Video file
Shows the location of the video file on your computer. This field is read-only.

Video frame rate
Shows the frame rate of the video file. This field is read-only.

Project frame rate
Allows you to select a frame rate for your project from the menu. You can only have a 
single frame rate across the project.

Use video frame rate
Sets the project frame rate to be the same as the video file.

Flow attachment position
Allows you to set the rhythmic position at which the video attaches. This is set using 
the Beat count and Beat unit settings in combination, such as eight dotted quarter 
notes.

Video start offset
Allows you to set a position within the video that syncs with the flow attachment 
position, for example, you can set the fifth second of the video to attach to the start of 
the third bar.

Timecode start
Allows you to set the timecode at the start of the video. This also affects the timecode 
of the flow, but the initial timecode of the flow adjusts to accommodate the video. For 
example, if the initial timecode of the video is 02:00:00:00 but the video does not start 
until the start of the third bar in 4/4, the initial timecode of the flow is eight beats of 
time less than 02:00:00:00; if the tempo is 60 bpm, this makes the initial flow timecode 
01:59:52:00.

NOTE

Flow timecodes are shown in their flow cards in the Flows panel.

RELATED LINKS
Timecodes on page 849
Flows panel on page 87
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Adding videos
You can add a video to each flow in your project. You can also follow these steps to reload videos 
previously added to the project that Dorico SE can no longer locate.

Flows with missing videos show a warning icon  instead of the video icon in the flow card in the 
Flows panel. This can happen if you send a project to someone else without the video file.

PREREQUISITE
You have added at least one player to the project.

PROCEDURE

1. In the Flows panel, right-click the flow to which you want to add/reload a video and choose 
Video > Attach from the context menu to open the File Explorer/macOS Finder.

2. Locate and select the video file you want to add.

3. Click Open to open the Video Properties dialog.

4. Change the settings as required.

5. Click OK to save your changes and close the dialog.

RESULT
The selected video file is added to the flow and is shown in the Video window. A video reel icon 
appears in the flow card in the Flows panel, beside a timecode indicating the combination of the 
Video start offset and Timecode start.

If you reloaded a video, all your previous settings are retained.

RELATED LINKS
Flows panel on page 87
Adding solo/section players on page 95
Timecodes on page 849
Changing the initial timecode value on page 850

Changing the start position of videos
You can change both the rhythmic position in the music at which videos start, and the position in 
the video that coincides with that rhythmic position, for example, if you want the fifth second of a 
video to sync with the start of the third bar of music.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Change the values for the following options, individually or together:

● Flow attachment position

● Video start offset

3. Click OK to save your changes and close the dialog.
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RESULT
Changing the value for Flow attachment position changes the rhythmic position in the music at 
which the video starts.

Changing the value for Video start offset changes the position in the video that occurs at the 
Flow attachment position.

For example, if you change the Video start offset to 00:00:05:00 and the Flow attachment 
position to 8, then the fifth second in the video happens on the eighth beat in the music.

NOTE

● The initial rhythmic position is 0. Therefore, if the Flow attachment position is set to 8 and 
the time signature is 4/4, the flow attachment occurs on the first beat in the third bar.

● Changing the Video start offset changes what part of the video coincides with the Flow 
attachment position, but this does not cut the video before this point. Any preceding video 
material is shown as long as it happens within the flow.

Hiding/Showing the Video window
You can hide and show the Video window at any time and in any mode, for example, if you do 
not want it in view when working on the music in the music area.

PROCEDURE

● Hide/Show the Video window in any of the following ways:

● Press F4 .

● In the toolbar, click Show Video .

● Choose Window > Video.

RESULT
The Video window is hidden/shown. It is shown when a tick appears beside Video in the Window 
menu, and hidden when no tick appears.

RELATED LINKS
Toolbar on page 24

Changing the size of the Video window
You can change the size of the Video window at any time.

PREREQUISITE
The Video window is shown.

PROCEDURE

● Change the size of the Video window in any of the following ways:

● Click and drag the corners/edges in any direction.

● Shift -click and drag a corner/edge to change the size without changing the shape.

RESULT
The size of the Video window is changed. Dorico SE saves the new size and shape and uses this 
for all projects until you change the size again.

Setup mode
Videos 

140
Dorico SE 3.5.12



Removing videos
You can remove videos from each flow independently.

PROCEDURE

● In the Flows panel, right-click the flow from which you want to remove a video and choose 
Video > Detach from the context menu.

RESULT
The video is removed from the selected flow.

RELATED LINKS
Flows panel on page 87

Changing the volume of video audio
Any audio that is part of a video you have added is played back in sync with the music in the 
project. You can change the video volume manually.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. Optional: If the Video channel is not shown in the Mixer window, click Video in the Mixer 
toolbar.

2. Change the Video channel volume in any of the following ways:

● Click and drag the Video channel fader upwards/downwards.

● Click Mute at the top of the Video channel.

RESULT
The volume of audio from videos in your project is changed. If you clicked Mute, no audio from 
videos sounds in playback.

RELATED LINKS
Hiding/Showing the Mixer window on page 471

Frame rates
The frame rate of a video is the number of still images that are used per unit of time in order to 
create the impression of a moving image, commonly measured in frames per second, or “fps”.

The number of frames per second required to create the impression of a moving image is 
determined by how fast the human eye processes movement, and so the most common frame 
rate is around 24 fps. However, recent major films have been released at 48 fps, which results in 
sharper images.

Dorico SE supports frame rates from 23.976 fps to 60 fps, for example, the US and Canadian 
broadcast standard NTSC, which is used in, uses 29.97 fps.

Frame rates are closely linked to timecodes, as timecodes include both the time and the current 
frame position.
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All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico SE.

By default, Dorico SE uses the same frame rate for the project as the video file, but you can 
manually choose a different frame rate.

RELATED LINKS
Timecodes on page 849

Changing the project frame rate
By default, Dorico SE uses the video frame rate as the project frame rate. You can change the 
project frame rate if you want it to be different, for example, if your project contains multiple 
videos with different frame rates.

TIP

You can change the frame rate even if there are no videos in the project.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Select the frame rate you want to use for the project from the Project frame rate menu.

3. Click OK to save your changes and close the dialog.

RESULT
The project frame rate is changed.

Setup mode
Videos 

142
Dorico SE 3.5.12



Write mode

Write mode allows you to input and edit your music, including changing the rhythmic positions 
of items, changing the pitch of notes, and deleting notes and items. The available toolboxes and 
panels allow you to input all the notes and notation items that are most commonly used.

By design, you cannot move notes and items graphically in Write mode. Graphical adjustments 
are only possible in Engrave mode in Dorico Pro.

Project window in Write mode
The project window in Write mode contains the default toolbar, the music area, and the status 
bar. It provides toolboxes and panels with the tools and functions required to write your music.

You can switch to Write mode in any of the following ways:

● Press Ctrl/Cmd-2 .

● Click Write in the toolbar.

● Choose Window > Write.

Toolboxes and panels in Write mode

The following panels and toolboxes are available in Write mode:

1 Notes toolbox

Contains tools that affect note input.

2 Notes panel
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Contains the note durations, accidentals, and articulations that are most commonly used 
during note input.

3 Notations panel

Contains notation items that you can add to your music, such as dynamics and playing 
techniques, divided into separate categories. Your current selection in the Notations toolbox 
determines which notation items are shown.

4 Notations toolbox

Allows you to determine which notation items are shown in the Notations panel, and to input 
certain items directly, such as rehearsal marks, chord symbols, and fingerings.

5 Properties panel

Contains properties that allow you to make individual modifications to the currently selected 
notes and notations.

NOTE

If the property scope is set to Locally, changing local properties only affects the current 
layout and frame chain. You can set the property scope to Globally if you want subsequent 
changes to local properties to affect all layouts and frame chains. You can also copy property 
changes to other layouts and frame chains later.

RELATED LINKS
Notes panel on page 146
Properties panel (Write mode) on page 147
Notations toolbox on page 151
Notations panel on page 153
Copying property settings to other layouts/frame chains on page 395

Notes toolbox
The tools in the Notes toolbox allow you to modify notes and change the type of notes you input. 
The Notes toolbox is located on the left of the window in Write mode.

Select

Activates/Deactivates mouse input. When mouse input is deactivated, you cannot input 
notes by clicking on the staff.

TIP

You can assign a key command for Disable Mouse Input on the Key Commands page 
in Preferences.

Pitch Before Duration

When this option is activated, you can select the pitch before specifying the duration 
and inputting the note. This allows you to experiment with pitches without having to 
stop note input because you only input the note when you specify the duration.

You can also activate/deactivate Pitch Before Duration by pressing K .
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Chords

When this option is activated, you add multiple notes at the same rhythmic position in 
order to build a chord. This function prevents the caret from advancing automatically 
after inputting a note. It also allows you to copy notes and items without overwriting 
any existing notes or items.

You can also start/stop chord input by pressing Q .

Insert

When this option is activated, the notes you input are inserted before existing music 
in the current voice ahead of the caret instead of overwriting it. Insert mode also 
affects edits you make outside of note input, such as deleting notes or changing their 
duration. For example, reducing the duration of notes with Insert mode activated pulls 
them closer together without leaving rests between the notes. This applies to the 
selected voice only.

When inputting or changing time signatures, Insert mode instructs Dorico SE to add 
any extra beats required to fill bars.

You can also activate/deactivate Insert mode by pressing I .

Lock to Duration

When this option is activated, the durations of existing notes are used as you input 
notes. This allows you to maintain the duration of notes while you change their pitches.

You can also activate/deactivate Lock to Duration by pressing L .

Force Duration

When this option is activated, Dorico SE always inputs notes/rests with the explicit 
duration you have selected. For example, you can activate Force Duration to force the 
input of a dotted quarter note on the second quarter beat of 4/4, where Dorico SE 
splits the note with a tie by default.

IMPORTANT

You can get unexpected results if you force the duration of notes and later change the 
time signature or move barlines, for example.

If you activated Force Duration during input, you can remove the restrictions on how 
Dorico SE notates the music by selecting the affected passage of music and selecting 
Edit > Reset Appearance.

You can also activate/deactivate Force Duration by pressing O .

Dotted Notes

During note input, this inputs dotted notes, rests, or chords based on the currently 
selected duration. When editing existing notes, you can use this tool to add/remove 
rhythm dots from existing notes, rests, and chords.

You can also activate/deactivate Dotted Notes by pressing . . You can increase the 
number of dots on notes by pressing Alt/Opt-. .
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Rests

When this option is activated, you input rests of the currently selected duration instead 
of notes.

You can also start/stop rest input by pressing , .

Tuplets

Clicking this option inputs a triplet bracket and the respective number of rests at the 
specified rhythmic position. If the notes are beamed, no brackets are used.

You can input other types of tuplet, such as quintuplets, by using the tuplets popover.

Grace Notes

When this option is activated, you input grace notes at the current rhythmic position 
instead of normal notes.

You can also start/stop grace note input by pressing / .

Tie

During note input, this ties the note to be input to the previous note of the same pitch. 
When editing existing notes, you can use this tool to tie together notes of the same 
pitch in different voices or to tie grace notes to rhythmic notes.

You can also activate Tie by pressing T .

NOTE

You cannot deactivate Tie. If you want to delete ties, you must use Scissors.

Scissors

During note input, this splits notes, chords, and explicit rests in two at the caret 
position. When editing existing notes, it deletes all ties in tie chains.

You can also activate Scissors by pressing U .

RELATED LINKS
Key Commands page in the Preferences dialog on page 47
Inputting notes with rhythm dots on page 172
Inputting chords on page 192
Inputting tuplets on page 194
Inputting grace notes on page 190
Activating/Deactivating mouse input on page 169
Input methods for time signatures and pick-up bars on page 220

Notes panel
The Notes panel contains buttons that allow you to select note and rest durations, and to input 
accidentals, slurs, and articulations. It is located on the left of the window in Write mode.

You can hide/show the Notes panel in any of the following ways:
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● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Panel.

The upper part of the Notes panel contains note durations that you can select for input or to 
change the duration of existing notes. By default, only the most common note durations are 
shown. You can see all note durations by clicking the Show/Hide All Notes disclosure arrows at 
the top and bottom of the section.

In the middle part of the Notes panel, you can activate/deactivate accidentals and activate slurs. 
However, you cannot deactivate slurs, you must delete them.

In the bottom part of the Notes panel, you can activate/deactivate articulations.

RELATED LINKS
Project window in Write mode on page 143
Inputting notes on page 161
Inputting accidentals on page 185
Inputting articulations on page 209
Inputting slurs on page 211

Properties panel (Write mode)
The Properties panel in Write mode contains quick access properties that allow you to change 
notes and notations, both during note input and by changing existing notes. It is located at the 
bottom of the window in Write mode.

You can hide/show the Properties panel in Write mode in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Bottom Panel.
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The Properties panel contains a group of properties for each notation item. When you select a 
note or item in the music area, the Properties panel displays the groups and options that you 
might require to edit the selected note or item. If there are more available groups than can fit in 
the panel simultaneously, you can scroll to the right/left along the displayed groups.

NOTE

● If you select multiple different types of notation items, only the groups that they have in 
common are displayed. For example, if you select a slur, the Common and Slurs groups are 
displayed in the Properties panel. However, if you select a slur and a note, only the Common 
group is displayed.

● If the property scope is set to Locally, changing local properties only affects the current 
layout and frame chain. You can set the property scope to Globally if you want subsequent 
changes to local properties to affect all layouts and frame chains. You can also copy property 
changes to other layouts and frame chains later.

● You can only change the properties of complete notes and items. For example, you can only 
change the line style of whole pedal lines, even if they extend across multiple systems.

Properties panel in Write mode, filtered by a search term

At the top of the Properties panel there are the following options:

Search
Allows you to filter properties according to your entry.

Show (active status)
Allows you to filter properties according to their activated status.

● Active: Shows only activated properties.

● All: Shows all properties.

Show (property scope)
Allows you to filter properties according to their property scope.

● Local Only: Shows only local properties.

● Global Only: Shows only global properties.

● All: Shows all properties.

Set local properties
Allows you to change the scope of subsequent local properties you change.

● Locally: Local properties only take effect locally.

● Globally: Local properties take effect globally.

RELATED LINKS
Project window in Write mode on page 143
Changing the property scope on page 149
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Copying property settings to other layouts/frame chains on page 395
Changing your preferred unit of measurement on page 45
Changing values in numeric value fields on page 150
Resetting the appearance of items on page 344
Resetting the position of items on page 344

Local vs. global properties
Properties can affect items only in the current layout and frame chain or in all layouts and frame 
chains. This allows you to have the same items appear differently in different layouts, such as if 
you want to show gradual dynamics as hairpins in part layouts but as “cresc.” text in full score 
layouts.

Local properties
Local properties are layout- and frame chain-specific. By default, changing local 
properties for an item in one layout does not affect the same item in other layouts 
or other frame chains.

You can force local properties to apply globally by changing the property scope in 
the Properties panel to Globally before changing their setting. Local properties that 
have been set globally appear with a bolder font in the Properties panel than local 
properties that have been set locally. You can also show only local properties in the 
Properties panel by using the property scope filter.

NOTE

Changing local properties with the property scope set to Globally overrides any local 
settings for those properties for the selected notes or items in other layouts.

Global properties
Global properties affect items in all layouts and frame chains, including new layouts 
you subsequently create. They appear with a bolder font in the Properties panel than 
local properties. You can also show only global properties in the Properties panel by 
using the property scope filter.

RELATED LINKS
Layouts on page 124
Music frame chains on page 366
Properties panel (Write mode) on page 147
Copying property settings to other layouts/frame chains on page 395

Changing the property scope
You can change the property scope of local properties, for example, if you want the subsequent 
properties you change to affect all layouts and frame chains.

PROCEDURE

● In the Properties panel, choose one of the following options for Set local properties:

● Locally

● Globally
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RESULT
The property scope is changed. All subsequent local properties you change take effect only in 
the current layout and frame chain if you chose Locally, or in all layouts and frame chains if you 
chose Globally.

NOTE

This only applies to subsequent properties you change. If you want to change the property scope 
of existing properties, you can copy property settings to other layouts and frame chains.

RELATED LINKS
Copying property settings to other layouts/frame chains on page 395

Changing values in numeric value fields
You can change the values in numeric value fields in multiple different ways, such as doubling or 
halving the existing values. In Dorico SE, value fields are most commonly used in the Properties 
panel and in options dialogs.

Numeric value fields have up/down buttons. They are also known as “spin boxes”.

A numeric value field in the Properties panel

PREREQUISITE
For value fields that are only accessible when their corresponding property/option is activated, 
you have activated their property/option.

PROCEDURE

● Change the value in numeric value fields in any of the following ways:

● Enter a number directly.

● To increase/decrease the value by 1/8 space, click the up/down buttons.

● To increase/decrease the value by 1/32 space, Ctrl/Cmd - Shift -click the up/down 
buttons.

● To increase/decrease the value by 1/2 space, Shift -click the up/down buttons.

● To increase/decrease the value by 1 space, Ctrl/Cmd -click the up/down buttons.

● To increase the current value by a specific amount, enter += followed by the amount into 
the spin box. For example, enter +=2 to increase the current value by two.

● To decrease the current value by a specific amount, enter -= followed by the amount into 
the spin box. For example, enter -=3.5 to decrease the current value by three and a half.

● To multiply the current value by a specific amount, enter * followed by the amount into 
the spin box. For example, enter *3 to triple the current value.

● To divide the current value by a specific amount, enter / followed by the amount into the 
spin box. For example, enter /2 to halve the current value.

NOTE

You must replace the existing value with your calculation entry.
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RELATED LINKS
Properties panel (Write mode) on page 147
Layout Options dialog on page 90
Changing your preferred unit of measurement on page 45

Notations toolbox
The options in the Notations toolbox allow you to determine what notation items are available in 
the Notations panel. The Notations toolbox is located on the right of the window in Write mode.

Clefs

Hides/Shows the Clefs panel, which contains sections for the different clefs and octave 
lines that you can input.

Key Signatures, Tonality Systems, and Accidentals

Hides/Shows the Key Signatures, Tonality Systems, and Accidentals panel, which 
contains sections for the different key signatures, tonality systems, and accidentals 
that you can input. You can also create and edit custom tonality systems from this 
panel.

Time Signatures (Meter)

Hides/Shows the Time Signatures (Meter) panel, which contains sections for the 
different types of time signatures that you can input, including a section where you 
can create custom time signatures, such as interchangeable time signatures and time 
signatures with pick-up bars.

Tempo

Hides/Shows the Tempo panel, which contains sections for the different types of tempo 
changes that you can input, including gradual tempo changes, metronome marks, and 
tempo equations.

Dynamics

Hides/Shows the Dynamics panel, which contains sections for the different dynamics 
that you can input, including immediate, gradual, and custom combined dynamics.

Ornaments

Hides/Shows the Ornaments panel, which contains sections for the different 
ornaments and glissando lines that you can input.

Repeat Structures

Hides/Shows the Repeat Structures panel, which contains sections for the different 
types of repeat structures, including repeat endings and segments, repeat markers, 
single-note and multi-note tremolos, bar repeats, and slash regions.
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Bars and Barlines

Hides/Shows the Bars and Barlines panel, which allows you to insert bars and to input 
the different types of barlines.

Holds and Pauses

Hides/Shows the Holds and Pauses panel, which contains sections for the different 
types of fermatas, breath marks, and caesuras that you can input.

Playing Techniques

Hides/Shows the Playing Techniques panel, which contains sections for the various 
instrument family groups. Each section contains playing techniques for the 
corresponding instrument family.

Lines

Hides/Shows the Lines panel, which contains sections for the different types of lines 
that you can input.

Cues

Hides/Shows the Cues panel, which allows you to find suitable places for cues and 
input cues.

Video

Hides/Shows the Video panel, which allows you to open the Video Properties dialog 
and to view and edit markers in the current flow.

Rehearsal Marks

Inserts a rehearsal mark at the selected rhythmic position.

Text

Opens the text editor, which allows you to insert text at the selected rhythmic position.

Lyrics

Opens the lyrics popover above the selected note on the staff, which allows you to 
input lyrics.

Chord Symbols

Opens the chord symbols popover above the selected note on the staff, which allows 
you to input chord symbols.
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Fingering

Opens the fingerings popover above the selected note on the staff, which allows you to 
input fingerings.

RELATED LINKS
Project window in Write mode on page 143
Notations input on page 209
Text editor options in Write mode on page 308
Video Properties dialog on page 137

Notations panel
The Notations panel contains different notation items for your music depending on your 
selection in the Notations toolbox. The Notations panel is located on the right of the window 
in Write mode.

You can hide/show the Notations panel at any time, for example, if you want to find a notation to 
input but then want to increase the size of the music area after inputting it. You can hide/show 
the Notations panel in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Panel.

RELATED LINKS
Project window in Write mode on page 143
Hiding/Showing panels on page 37
Clefs panel on page 258
Key Signatures, Tonality Systems, and Accidentals panel on page 217
Time Signatures (Meter) panel on page 222
Tempo panel on page 231
Dynamics panel on page 245
Ornaments panel on page 270
Repeat Structures panel on page 325
Bars and Barlines panel on page 238
Holds and Pauses panel on page 263
Playing Techniques panel on page 294
Lines panel on page 305
Markers section of the Video panel on page 319
Comments panel on page 358

Inputting vs. editing
Dorico SE distinguishes the processes for inputting and editing music.

Inputting

If you can see the caret, you are inputting new music. The caret must be activated in order to 
input notes and notations. If the caret is activated, selecting tools or items in the Notes toolbox 
and the Notes panel affects the note or chord that you are about to input, as you can specify 
the duration, rhythm dot, accidentals, and articulations. Then you specify the pitch by clicking the 
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note into the score, by pressing the letter name of the note on your computer keyboard, or by 
playing the note or chord on your MIDI keyboard.

When the caret is activated, notes and notations are input at the caret position.

If no notes or chords are selected in the music area and you select a duration, either by pressing 
its key command or by clicking it in the Notes panel, mouse input is activated. If you move the 
mouse pointer over the staff, a shadow note is displayed to indicate where the note will be input 
if you click.

NOTE

Deactivating mouse input prevents Dorico SE from starting mouse input in this circumstance.

Editing

If you cannot see the caret, you can edit existing music. Editing music includes deleting notes 
and notations, which you can only do in Write mode, although you can also delete notes in Play 
mode but not notations. You can switch back and forth between inputting and editing at any 
time.

When the caret is not activated, new items are input at the position of the first selected item in 
the music area. If there is no selection, the mouse pointer is loaded with the new item. The item 
is then created at the location where you click.

To edit existing notes and notations, you must select them in the music area. This allows 
you to update the selected notes or items when you select, for example, new note durations, 
accidentals, or articulations in the Notes panel.

We recommend that you spend a moment to understand the difference between how Dorico SE 
behaves if the caret is shown and if it is not. In the latter case, all editing functions operate on the 
items that you have selected in the music area.

RELATED LINKS
Editing and selecting on page 334
Caret on page 157
Note input on page 157
Notations input on page 209

Mouse input settings
There are a number of different settings that you can choose from to determine how mouse 
input functions in Dorico SE.

You can set your preferences for mouse input in the Editing section of the Note Input and 
Editing page in Preferences.

You can choose between the following options for mouse input:

● Create item at selection: Items are input at the position of selected items or notes in the 
music area.

● Load pointer with item: Items are loaded onto the mouse pointer so you can click in the 
music area where you want to input the item.

You can also activate/deactivate Allow multiple items to be created with the mouse. When 
this option is activated, you can load an item onto your mouse pointer and input the same item 
in the music area multiple times without having to reselect the item each time you input it. When 
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this option is deactivated, you can only input an item loaded onto your mouse pointer once. If 
you want to input the item at multiple positions, you must reselect it each time.

NOTE

Changing your preferences permanently changes the functionality for the current project and all 
new projects.

RELATED LINKS
Preferences dialog on page 45

Changing your mouse input settings
You can change your mouse input settings, for example, if you want to load a playing technique 
on the pointer once and input it in multiple places without having to reselect the playing 
technique each time.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Note Input and Editing in the category list.

3. In the Editing section, choose one of the following options for Creating items with the 
mouse:

● Create item at selection

● Load pointer with item

4. Optional: If you chose Load pointer with item, activate/deactivate Allow multiple items to 
be created with the mouse.

5. Click Apply, then Close.

RESULT
Your mouse input settings are changed in the current project and for all future projects.

RELATED LINKS
Notations input on page 209

Rhythmic grid
The rhythmic grid is a unit of rhythmic duration whose value affects certain aspects of inputting 
and editing, such as the amount by which items move. However, it does not control the duration 
of notes and items that you input.

Rhythmic grid set to eighth notes (quavers) shown above the staff

The current rhythmic grid resolution is shown by the note value in the status bar, and by ruler 
markings above the staff on which the caret is active. Longer lines in the rhythmic grid indicate 
beat divisions, while shorter lines indicate beat subdivisions. In Play mode, the rhythmic grid is 
shown by the frequency of vertical lines in tracks and in the ruler at the top of the event display.
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The rhythmic grid controls the following:

● The possible input positions when using the caret or the mouse, and when copying and 
pasting. For example, setting the rhythmic grid resolution to 32nd notes allows you to input 
notes and items at a greater number of possible rhythmic positions than when the rhythmic 
grid is set to quarter notes.

● The amount by which the caret moves when using Right Arrow / Left Arrow .

● The amount by which notes and items are lengthened/shortened.

● The amount by which notes and items move.

You can change the rhythmic grid resolution at any time.

RELATED LINKS
Rhythmic position on page 20
Caret on page 157
Moving the caret manually on page 161
Event display on page 418
Tracks on page 426
Inputting notes on page 161

Changing the rhythmic grid resolution
You can change the resolution of the rhythmic grid. The resolution is indicated by the note value 
symbol in the status bar and by the beat divisions and subdivisions in the ruler markings above 
the caret.

The rhythmic grid resolution is set to eighth notes (quavers) by default.

PROCEDURE

● Change the resolution of the rhythmic grid in any of the following ways:

● Press Alt/Opt-]  to decrease the rhythmic grid resolution.

● Press Alt/Opt-[  to increase the rhythmic grid resolution.

● Choose Write > Rhythmic Grid > Decrease Grid Resolution.

● Choose Write > Rhythmic Grid > Increase Grid Resolution.

● Choose Write > Rhythmic Grid > [Beat division].

● Select a value from the Rhythmic Grid selector in the status bar.

RESULT
Decreasing the rhythmic grid resolution makes it finer by making the note value shorter. 
Increasing the rhythmic grid resolution makes it coarser by making the note value longer.

TIP

You can assign your own key commands for increasing and decreasing the rhythmic grid 
resolution.

RELATED LINKS
Status bar on page 32
Assigning key commands on page 50
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Note input
In Dorico SE, you can only input notes during note input, which is when the caret is activated. 
This allows you to input notations at the caret position at the same time as inputting notes, and 
also reduces the risk of you adding notes to staves accidentally.

You can input notes in different ways and using any of the following devices, including switching 
between them at any time:

● MIDI keyboard

● Computer keyboard

● Mouse or touchpad

TIP

A MIDI keyboard is the fastest way to input notes.

RELATED LINKS
Notes on page 718
Inputting notes on page 161
Accidental selection during MIDI input on page 187

Caret
In Dorico SE, the caret is a vertical line that extends above and below five-line staves but appears 
shorter on percussion staves and tablature. It shows the rhythmic position at which notes, 
chords, or notation items are input.

A caret is a mark that is commonly used when proofreading published text to denote the position 
at which something should be inserted or added, for example, a missing letter or a word. In 
software, the caret shows where something is inserted. The caret is also known as an “insertion 
point” or “cursor”. In this documentation, we use “caret” to refer to the line that appears during 
note input, and “cursor” to refer to the line that appears during text input.

If you are inputting notes, the caret advances to the next rhythmic position automatically. If you 
are inputting chords or notes on tablature, the caret does not move automatically, and you must 
move it to the next rhythmic position manually. The caret has a note symbol beside it, which 
indicates the stem direction and type of the currently selected voice. It is accompanied by a + 
symbol if the voice is new.

The caret

The appearance of the caret changes depending on the input mode and the currently selected 
voice number.

Multiple staves
The caret extends vertically across all the staves onto which notes and notations will be 
input. This allows you to input, for example, the same dynamics or playing techniques 
on multiple staves simultaneously or play in chords on a MIDI keyboard and distribute 
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the notes in those chords onto multiple staves. The note symbol and rhythmic grid also 
appear for each included staff.

Caret when inputting notes onto multiple staves

Insert
The caret shows V and inverted V shapes at the top and bottom. In Insert mode, 
inserted notes shift all music in the current voice after the caret along by the input 
duration instead of replacing existing notes. Similarly, reducing the duration of notes 
with Insert mode activated pulls them closer together without leaving rests between 
the notes.

Caret in Insert mode

Chords
The caret shows a plus symbol at the top left. During chord input, you can input 
multiple notes at the same rhythmic position.

Caret when inputting chords

Lock to Duration
The caret is dashed. Lock to Duration allows you to repitch notes without changing 
their duration or rhythm.

Caret when Lock to Duration is activated
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Grace Notes
The caret is shorter than the default caret. It allows you to input grace notes at the 
caret position.

Caret when inputting grace notes

Voices
If you input multiple voices, the caret shows the following:

● A plus symbol at the bottom left

● The voice number into which you are inputting notes

● An up-stem note or a down-stem note symbol to indicate the stem direction of the 
voice

Caret when inputting notes into a new 
down-stem voice

Caret when inputting notes into a new, 
second up-stem voice

Slash voices
The note beside the caret indicates a slash notehead.

If you input multiple slash voices, the caret shows the following:

● A plus symbol on the left at the bottom

● The number of the slash voice into which you are about to input notes

● An up-stem slash note or a down-stem slash note symbol indicating the stem 
direction of the voice, and whether it has stems or is stemless

Caret when inputting notes 
into an up-stem slash voice

Caret when inputting notes 
into a new, second up-stem 
slash voice

Caret when inputting notes 
into a new, stemless slash 
voice

Percussion kits
The caret appears significantly smaller than usual when inputting notes into 
percussion kits. The name of the kit instrument into which you are currently inputting 
notes is shown above the rhythmic grid.
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Caret when inputting notes into percussion kits

Tablature
The caret appears significantly smaller than usual when inputting notes into tablature. 
On tablature, the caret behaves as if chord input is always active, meaning you must 
advance the caret and move it to other string lines manually.

Caret when inputting notes on tablature

RELATED LINKS
Inputting notes in Insert mode on page 178
Inputting chords on page 192
Repitching notes without changing their rhythm on page 201
Inputting grace notes on page 190
Inputting notes into multiple voices on page 174
Inputting notes for unpitched percussion on page 180
Inputting notes on tablature on page 184

Activating/Deactivating the caret
When the caret is activated, you can input notes and notations at the caret position, for example, 
if you want to input a dynamic in the middle of a tie chain. When the caret is deactivated, you 
cannot input notes, instead you can select and edit items in the music area.

PROCEDURE

1. Activate the caret in any of the following ways:

● Select an item and press Shift-N .

● Double-click a rhythmic position on a staff.

2. Deactivate the caret in any of the following ways:

● Press Shift-N , Return , or Esc .

● If you have deactivated mouse input, click any selectable item in the music area.

● Switch to another mode.

RELATED LINKS
Moving the caret manually on page 161
Activating/Deactivating mouse input on page 169
Inputting notes on page 161
Notations input on page 209
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Extending the caret to multiple staves
You can extend the caret so it spans multiple staves. This allows you to input notes and notations 
onto multiple staves simultaneously, including automatically exploding the notes in chords that 
you play on a MIDI keyboard onto the appropriate staves.

PROCEDURE

1. Activate the caret in any of the following ways:

● Select an item and press Shift-N .

● Double-click a rhythmic position on a staff.

2. Extend the caret to other staves in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

3. Optional: Repeat step 2 as many times as you require.

RELATED LINKS
Inputting notes and notations onto multiple staves on page 177

Moving the caret manually
During normal note input, the caret moves automatically as you input notes, but you can also 
move it manually. For example, the caret does not move automatically when inputting chords.

PROCEDURE

● Move the caret in any of the following ways:

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space .

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

● To move the caret to the staff above/below, press Up Arrow / Down Arrow .

● To move the caret to the top/bottom staff in the system, press Ctrl/Cmd-Up Arrow /
Ctrl/Cmd-Down Arrow .

RELATED LINKS
Inputting chords on page 192

Inputting notes
You can input notes into your project during note input, which is when the caret is activated. 
You can input notes with a computer keyboard, with the mouse, or by playing notes with a MIDI 
keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.
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● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform step 7 before steps 4 to 6.

● You do not have to input rests between notes, as Dorico SE automatically shows implicit rests 
of the appropriate duration between the notes you input. Similarly, you do not have to input 
ties, as Dorico SE shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in Galley View.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. Start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

If you select a notation, such as a dynamic, pressing Return  opens the corresponding 
popover instead of starting note input.

● Double-click the staff where you want to input notes.

2. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

4. Optional: Select any required rhythm dots.

5. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

6. Optional: Select any required articulations.

7. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico SE automatically selects the note whose register is the smallest interval away 
from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note, for example, Shift-Alt/Opt-A .
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● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note, for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● Play the notes on a MIDI keyboard.

8. Optional: Press Space  to advance the caret by the currently selected note duration without 
inputting notes.

TIP

You can also move the caret in different ways and by different increments.

9. Press Esc  or Return  to stop note input.

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.

Dorico SE notates and beams notes appropriately according to their duration, the current time 
signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico SE fills the gaps between notes with 
implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico SE automatically 
allocates these notes to the strings on which they can be played closest to the nut. Because this 
calculation is done for each note separately, multiple notes can be allocated to the same string. 
In such cases, the notes are shown next to each other on tablature and are colored green. You 
can then select them individually and make your own string allocation.

TIP

You can specify custom beat groupings within individual time signatures.

AFTER COMPLETING THIS TASK
You can move notes to different rhythmic positions and other staves after they have been input.

You can also show brackets on noteheads individually.

RELATED LINKS
Inputting notes using pitch before duration on page 165
Changing the note-based notation input setting on page 168
Changing the input pitch setting on page 167
Switching to galley/page view on page 42
Accidental selection during MIDI input on page 187
Notes toolbox on page 144
Notes panel on page 146
Rhythmic grid on page 155
Caret on page 157
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Selecting note/rest durations on page 169
Inputting notes with rhythm dots on page 172
Inputting accidentals on page 185
Inputting articulations on page 209
Inputting chords on page 192
Inputting rests on page 187
Inputting tuplets on page 194
Adding notes above/below existing notes on page 197
Moving notes rhythmically on page 725
Creating cross-staff beams on page 583
Note and rest grouping on page 590
Beam grouping according to meters on page 575
Notations input on page 209
Playing/Muting notes during note input/selection on page 341
Changing the allocated string for notes on tablature on page 919
Disabling MIDI input devices on page 209
Implicit vs. explicit rests on page 880
Ties on page 938
Key signatures on page 693
Arranging tools on page 350
Bracketed noteheads on page 728

Register selection during note input
Dorico SE automatically selects the register of pitches during note input, but you can override 
this and select the register manually.

During note input, Dorico SE automatically selects the note whose register is the smallest interval 
away from the previously input note. For example, if you input an F and then press A , an A is 
input a third above the F, rather than a sixth below.

You can override this automatic register selection in the following ways:

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the letter for 
the note, for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or Ctrl (macOS) 
as well as the letter for the note, for example, Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

Register selection when inputting chords

During chord input, Dorico SE automatically inputs notes above the highest note at the caret 
position. For example, if you press A  then E  then A , a chord of A-E-A is input at the caret 
position.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name, for example, Ctrl-Alt-
A (Windows) or Ctrl-A (macOS) .

RELATED LINKS
Changing the pitch of individual notes on page 199
Accidental selection during MIDI input on page 187
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Inputting notes using pitch before duration
You can input notes into your project by specifying their pitch before their duration, meaning you 
can test pitches before inputting them without leaving note input. You can input notes with a 
computer keyboard, with the mouse, or by playing notes with a MIDI keyboard.

By default in Dorico SE, you must specify the duration before the pitch of notes.

NOTE

● These steps describe selecting the pitch before the duration when inputting notes. However, 
you can also specify the duration before the pitch instead, which is the default note input 
behavior in Dorico SE.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform steps 7 and 8 before steps 4 to 
6.

● When inputting notes on tablature using pitch before duration, you must select note 
durations by clicking them in the Notes panel.

● You do not have to input rests between notes, as Dorico SE automatically shows implicit rests 
of the appropriate duration between the notes you input. Similarly, you do not have to input 
ties, as Dorico SE shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in Galley View.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. Start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

If you select a notation, such as a dynamic, pressing Return  opens the corresponding 
popover instead of starting note input.

● Double-click the staff where you want to input notes.

2. Activate Pitch Before Duration in any of the following ways:

● Press K .

● In the Notes toolbox, click Pitch Before Duration .

3. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

4. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

5. Optional: Select any required articulations.
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6. Optional: Select any required rhythm dots.

7. Select a pitch in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico SE automatically selects the note whose register is the smallest interval away 
from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note, for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note, for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

When inputting notes using pitch before duration, you can press these key commands 
multiple times to select higher/lower octaves.

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● Play the notes on a MIDI keyboard.

Once you have selected a pitch, a shadow note of the corresponding pitch appears at the 
caret position. You can release the pitch after selecting it.

8. Select a note duration and input the note in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

NOTE

When inputting notes on tablature, you must click durations in the Notes panel.

9. Optional: Press Space  to advance the caret by the currently selected note duration without 
inputting notes.

TIP

You can also move the caret in different ways and by different increments.

10. Press Esc  or Return  to stop note input.

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.
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Dorico SE notates and beams notes appropriately according to their duration, the current time 
signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico SE fills the gaps between notes with 
implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico SE automatically 
allocates these notes to the strings on which they can be played closest to the nut. Because this 
calculation is done for each note separately, multiple notes can be allocated to the same string. 
Similarly, when you input chords on tablature using pitch before duration with a MIDI keyboard, 
all notes in the chord are allocated to the same string. In such cases, the notes are shown next to 
each other on tablature and are colored green. You can then select them individually and make 
your own string allocation.

TIP

● You can switch between using pitch before duration and duration before pitch note input at 
any time by pressing K  or clicking Pitch Before Duration , for example, duration before 
pitch can be easier when inputting a sequence of notes with the same duration.

● You can specify custom beat groupings within individual time signatures.

● You can change whether note input uses pitch before duration or duration before pitch by 
default on the Note Input and Editing page in Preferences.

AFTER COMPLETING THIS TASK
You can move notes to different rhythmic positions and other staves after they have been input.

You can also show brackets on noteheads individually.

RELATED LINKS
Changing the note-based notation input setting on page 168
Changing the input pitch setting on page 167
Inputting notes on page 161
Register selection during note input on page 164
Accidental selection during MIDI input on page 187
Switching to galley/page view on page 42
Notes toolbox on page 144
Notes panel on page 146
Rhythmic grid on page 155
Caret on page 157
Notations input on page 209
Disabling MIDI input devices on page 209

Changing the input pitch setting
You can input and record notes at either sounding pitch or written pitch according to the current 
layout, for example, if you want to record notes at their sounding pitch in transposing part 
layouts.

In concert pitch layouts, written pitch and sounding pitch are the same.

PROCEDURE

● Choose one of the following input pitch settings:

● To input/record notes at their written pitch, choose Write > Input Pitch > Written Pitch.
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● To input/record notes at their sounding pitch, choose Write > Input Pitch > Sounding 
Pitch.

RESULT
The resulting pitch notated or recorded is changed. For example, if you input a C in a Horn in F 
transposing part layout with the input pitch set to Sounding Pitch, the note is written as a G.

RELATED LINKS
Inputting notes on page 161
Inputting notes using MIDI recording on page 204
Making layouts transposing/concert pitch on page 127

Changing the note-based notation input setting
You can change your default setting for whether rhythm dots, accidentals, and articulations 
apply to the last input note or the next note you input during note input. This setting also affects 
whether or not the last input note remains selected after entry when using pitch before duration 
for inputting notes.

For example, changing the setting to After inputting note when using pitch before duration 
for notes ensures the last input note remains selected after you input it, making it easier to 
change its enharmonic spelling when inputting notes using a MIDI keyboard. The last input note 
is always selected when using duration before pitch for notes, regardless of your note-based 
notation input setting.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Note Input and Editing in the category list.

3. In the Note Input section, choose one of the following options for Specify accidental, 
rhythm dot and articulations in the Pitch and Duration subsection:

● After inputting note

● Before inputting note

4. Click Apply, then Close.

RESULT
The setting is changed in the current project and for all future projects. If you chose Before 
inputting note, notes do not remain selected after you input them during pitch before duration 
note input.

RELATED LINKS
Inputting notes on page 161
Inputting notes using pitch before duration on page 165
Inputting accidentals on page 185
Inputting notes with rhythm dots on page 172
Inputting articulations on page 209
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Activating/Deactivating mouse input
You can activate/deactivate mouse input, for example, if you only want to input notes using your 
computer keyboard or MIDI device. Deactivating mouse input also allows you to click other items 
to stop note input.

PROCEDURE

● In the Notes toolbox, activate/deactivate Select .

RESULT
Mouse input is activated in the current project when Select  is deactivated. Mouse input is 
deactivated in the current project when Select  is activated.

TIP

You can change the default setting for whether mouse input is activated/deactivated by 
activating/deactivating Enable note input using the mouse on the Note Input and Editing 
page in Preferences.

RELATED LINKS
Notes toolbox on page 144
Preferences dialog on page 45

Selecting note/rest durations
You can select different durations for notes/rests either from the Notes panel or by using one of 
the assigned key commands, both during note input and for existing notes/rests.

PROCEDURE

1. Optional: If you want to select a note duration not shown in the Notes panel, click the Show/
Hide All Notes disclosure arrows at the top and bottom of the notes list to show more note 
durations.

2. Select a note/rest duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) or 4  for 16th notes (semiquavers). Press 
larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

3. Optional: Add rhythm dots to the duration in one of the following ways:

● For a single rhythm dot, press . .

● For multiple rhythm dots, press Alt/Opt-.  as many times as required. You can specify up 
to four rhythm dots.

RELATED LINKS
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Key commands in Dorico SE on page 13
Inputting notes on page 161
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Changing the duration of notes
You can lengthen/shorten the duration of notes after they have been input.

PROCEDURE

1. Select the notes whose duration you want to change.

NOTE

If you want to extend a note to the end of the current selection, select both that note and an 
item at the rhythmic position to which you want to extend the note.

2. Change the duration in any of the following ways:

● Press the key command of the duration you want. For example, press 4  for a 16th note 
(semiquaver).

● In the Notes panel, click the duration you want.

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● To lengthen notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Lengthen Duration by Grid Value.

● To shorten notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Shorten Duration by Grid Value.

● To double the length of notes, choose Write > Edit Duration > Double Note Duration.

● To halve the length of notes, choose Write > Edit Duration > Halve Note Duration.

● To lengthen notes up to the next existing note in their voice, choose Write > Edit 
Duration > Extend to Next Note.

NOTE

This does not apply to grace notes.

● To lengthen a single note up to the rhythmic position of the end of the current selection, 
choose Write > Edit Duration > Extend to End of Selection.

● To shorten overlapping notes in the same voice so that they no longer overlap, choose 
Write > Edit Duration > Shorten to Next Note.

RESULT
The duration of the selected notes is changed. Dorico SE automatically notates and beams 
the notes appropriately according to their new duration, the current time signature, and their 
position in the bar.

When extending notes, their duration fills in any intervening rests. Extending notes to the end 
of the current selection does not delete any intervening notes, instead they combine with the 
extended note to create chords where necessary.
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TIP

You can assign your own key commands to lengthen/shorten notes by specific durations and to 
extend them. You can find these by searching for Shorten duration by, Lengthen duration by, 
and Extend to on the Key Commands page in Preferences.

RELATED LINKS
Notes panel on page 146
Key Commands page in the Preferences dialog on page 47
Insert mode on page 179
Chord mode on page 194

Forcing the duration of notes/rests
Dorico SE automatically notates and beams notes/rests appropriately according to the current 
time signature and their position in the bar. You can force the duration of notes/rests to specify 
their notation.

For example, if you input a half note at the start of a 6/8 bar, it is notated as a dotted quarter 
note (crotchet) tied to an eighth note (quaver). This is because, according to convention, 6/8 bars 
are subdivided into two groups of three eighth notes. To reflect this for a half note (four eighth 
notes), Dorico SE automatically divides the note to show the correct grouping but you can force 
the note duration to show a half note instead.

TIP

If you want to force the duration of all notes on a staff to imply a different meter, for example, 
to show three quarter note groups in 6/8 to indicate a hemiola, you can also input a time 
signature only on those staves to group notes according to that meter. You can then hide the 
time signatures if required.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Selecting existing notes whose duration you want to force.

2. Optional: If you want input rests with forced durations, start rest input in any of the following 
ways:

● Press , .

● In the Notes toolbox, click Rests .

3. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

4. Select the note/rest duration you want.

TIP

When forcing the duration of existing notes notated as tie chains, you must reduce their 
duration first, then increase it to the duration you want.

5. Optional: During note or rest input, input the notes or rests you want.
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RESULT
During note or rest input, any notes you input are notated with their whole rhythmic value, 
whatever their position in the bar. If you move them later, they keep the same notation. Rests are 
input as explicit rests. Notes that cross barlines are notated as tied notes.

Forcing the duration of existing notes or rests preserves their current duration or any duration to 
which you subsequently change them.

TIP

Force position and duration in the Notes and Rests group of the Properties panel is activated 
automatically for rests input with forced durations. You can also use this property to force the 
duration and position of rests.

EXAMPLE

Default notation of notes in 6/8 Notes in the down-stem voice input with forced 
durations

RELATED LINKS
Implicit vs. explicit rests on page 880
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Inputting notes on page 161
Inputting rests on page 187
Selecting note/rest durations on page 169
Beam grouping according to meters on page 575
Note and rest grouping on page 590
Creating custom beat groupings for meters on page 590
Turning explicit rests into implicit rests on page 882

Inputting notes with rhythm dots
The Dotted Notes tool allows you to input notes with rhythm dots and add rhythm dots to 
existing notes. You can input notes with up to four rhythm dots.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots before inputting notes. However, you can 
change this setting if you prefer to specify rhythm dots after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select existing notes to which you want to add rhythm dots.

2. Optional: If you want to input notes with rhythm dots onto multiple staves at once, extend 
the caret to those staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

4. Activate Dotted Notes in any of the following ways:

● Press . .

● In the Notes toolbox, click Dotted Notes .

5. Optional: Press Alt/Opt-.  to change the number of rhythm dots.

Dotted Notes in the Notes toolbox updates to indicate the current number of rhythm dots. 
You can input notes with up to four rhythm dots.

6. Optional: Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

If Force Duration is not activated, the notes you input might be shown as tied notes rather 
than dotted notes, depending on their position in the bar and the prevailing meter.

7. Input the dotted notes you want.

Dotted Notes remains activated until you either select a different note duration or 
deactivate it.

8. Press .  or click Dotted Notes  again to deactivate Dotted Notes.

9. Press Esc  or Return  to stop note input.

RESULT
During note input, notes are input as dotted notes until you deactivate Dotted Notes or change 
the note duration.

If you add rhythm dots to multiple existing notes that would then overlap, Dorico SE adjusts the 
duration of notes in the selection to avoid deleting notes at the end of the selection.

EXAMPLE

A phrase containing eighth notes After adding rhythm dots to the whole selection

RELATED LINKS
Note and rest grouping on page 590
Notes toolbox on page 144
Notes panel on page 146

Write mode
Note input 

173
Dorico SE 3.5.12



Caret on page 157
Insert mode on page 179
Chord mode on page 194
Selecting note/rest durations on page 169
Activating/Deactivating the caret on page 160
Extending the caret to multiple staves on page 161
Inputting notes in Insert mode on page 178
Changing the note-based notation input setting on page 168

Inputting notes into multiple voices
By default, notes are input into the first up-stem voice, as indicated by the symbol of an up-stem 
quarter note beside the caret. You can input notes directly into other voices during note input, 
and switch between voices as required.

You can also create new voices on staves with existing notes and input notes into those voices 
anywhere else on those staves.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input multiple voices.

2. Press Shift-N  to start note input.

3. Select the voice into which you want to input notes in one of the following ways:

● To input notes into a new voice, press Shift-V  to create a new voice.

When a new voice is added, a + sign appears beside the symbol of a quarter note beside 
the caret. The quarter note symbol indicates the stem direction, and the number beside 
the quarter note indicates the voice number if applicable.

Caret when adding the first down-stem voice

TIP

You can press Shift-V  as many times as you require. For example, on a staff containing 
no notes, creating one new voice allows you to input notes into the first down-stem 
voice, but you can also create another new voice immediately if you want to input notes 
into the second up-stem voice.

● To input notes into an existing voice, press V  until you reach the voice you want.

4. Input the notes you want.

5. Optional: Press V  to cycle between all the active voices on the staff.

6. Press Esc  or Return  to stop note input.

RESULT
Notes are input into new voices, as indicated by the caret indicator. They are input at the caret 
position or where you click. If you are inputting notes into a new voice on a staff that already 

Write mode
Note input 

174
Dorico SE 3.5.12



contains notes in another voice, the stem directions of existing notes at the same rhythmic 
position change automatically as necessary.

The quarter note symbol beside the caret changes to indicate which voice is currently selected. 
Any notes input are input into the voice indicated by this symbol.

You can switch between voices as often as you like.

NOTE

● If you have three or more voices on a single staff, you can only cycle through all the voices 
in a set order. For example, if you have two up-stem voices and two down-stem voices, the 
order is: first up-stem voice, first down-stem voice, second down-stem voice, second up-stem 
voice.

● You can show voice colors to check which notes are in which voice. You can also identify 
voices by selecting individual notes and looking at the display in the status bar.

EXAMPLE

Caret when inputting notes into 
the first up-stem voice

Caret when inputting notes into 
the first down-stem voice

Caret when inputting notes into a 
new, second up-stem voice

RELATED LINKS
Caret on page 157
Notes toolbox on page 144
Notes panel on page 146
Rhythmic grid on page 155
Inputting notes on page 161
Inputting notes using pitch before duration on page 165
Inputting bar rests into specific voices on page 188
Adding notes above/below existing notes on page 197
Changing the voice of existing notes on page 353
Voices on page 997
Status bar on page 32
Hiding/Showing notes alongside slash regions on page 872
Hiding/Showing voice colors on page 997

Inputting notes into slash voices
You can input notes into multiple slash voices, for example, if you want to indicate a precise 
rhythm without specifying pitches. By default, the first slash voice is up-stem, but you can add 
extra slash voices both with and without stems, and switch between them as often as you want.

You can also input notes into new slash voices on a staff with existing notes. Once you have 
created a slash voice somewhere on a staff, you can input notes into that slash voice anywhere 
else on the same staff.
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PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input slash voices.

2. Press Shift-N  to start note input.

3. Select the slash voice into which you want to input notes in one of the following ways:

● To input notes into a new slash voice, press Shift-Alt/Opt-V  to create a new slash voice.

When a new slash voice is added, a + sign appears beside the symbol of a note beside 
the caret, which now appears as a slash note. The slash note symbol indicates the stem 
direction, and the number beside the slash note symbol indicates the voice number if 
applicable.

Caret when adding the first down-stem slash voice

TIP

You can press Shift-Alt/Opt-V  as many times as you require. For example, on a staff 
containing no notes in slash voices, creating one new slash voice allows you to input 
notes into the first up-stem slash voice. You can also create a second new slash voice 
immediately if you want to input notes into a down-stem slash voice, or a third new slash 
voice if you want to input notes into a stemless slash voice.

● To input notes into an existing slash voice, press V  until you reach the slash voice you 
want.

4. Input the notes you want.

Notes in slash voices appear at the same staff position, regardless of their pitch. By default, 
this is the middle line of the staff, but this changes in multiple-slash-voice contexts.

5. Optional: Press V  to cycle between all the active voices on the staff.

6. Press Esc  or Return  to stop note input.

RESULT
Notes are input into new slash voices, as indicated by the caret indicator. The slash note symbol 
beside the caret changes to indicate which voice is currently selected and into which notes are 
input.

You can switch between voices as often as you like.

NOTE

● If you are inputting notes into a new slash voice on a staff that already contains notes in 
other voices/slash voices, the stem directions of existing notes and the staff positions of 
slash voices at the same rhythmic position change automatically as necessary.

● If you have three or more voices of any type on a single staff, you must cycle through all the 
voices in a set order. For example, if you have two up-stem voices, two down-stem voices, 
and a slash voice, the order is: first up-stem voice, first down-stem voice, second down-stem 
voice, second up-stem voice, slash voice.
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EXAMPLE

Caret when inputting 
notes into the first up-
stem slash voice

Caret when inputting 
notes into the first down-
stem slash voice

Caret when inputting 
notes into a new 
stemless slash voice

Caret when inputting 
notes into a new, second 
up-stem slash voice

RELATED LINKS
Slash voices on page 1001
Rhythm slashes on page 869
Inputting slash regions on page 332
Changing the voice of existing notes on page 353

Inputting notes and notations onto multiple staves
You can input notes and notations onto multiple staves simultaneously, including automatically 
exploding the notes in chords that you play on a MIDI keyboard onto the appropriate staves. 
For example, if you want to input notes onto both piano staves or input the same dynamics for 
multiple instruments.

Inputting notes and notations onto multiple staves is most useful for multiple adjacent pitched 
instruments whose music is only a single voice.

PREREQUISITE
If you want to explode individual notes in chords onto multiple staves during note input, you 
have connected a MIDI keyboard. You can only input the different notes in chords onto separate 
staves when using a MIDI keyboard.

PROCEDURE

1. In Write mode, select an item at the rhythmic position where you want to input notes/
notations onto multiple staves.

2. Press Shift-N  to start note input.

3. Extend the caret to another staff in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

4. Optional: Repeat step 3 for as many staves as you require.

5. Input the notes and notations you want.

NOTE

You must input notes using a computer keyboard or MIDI keyboard. If you use the mouse, 
notes are only input on the staff you click. Similarly, you must use the corresponding 
popover to input notations on multiple staves. When inputting notations using the 
corresponding panel, they are only input on the top staff.
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6. Press Esc  or Return  to stop note input.

RESULT
The notes and notations you input are input at the caret position on all staves across which 
the caret extends. If the caret extends across both staves of a piano, notes are input on either 
the top or bottom staff according to their pitch and your set split point on the Play page in 
Preferences.

When inputting notes using a MIDI keyboard, the individual notes in any chords you input are 
automatically exploded across the staves.

RELATED LINKS
Caret on page 157
Notes panel on page 146
Inputting notes on page 161
Inputting chords on page 192
Inputting notes using pitch before duration on page 165
Notations input on page 209
Preferences dialog on page 45

Inputting notes in Insert mode
In Insert mode, you can input notes before existing notes in a single voice without overriding 
them. This allows you to push existing notes ahead at the same time as inputting new notes at 
their previous positions.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You can only input chords in Insert mode when using a MIDI keyboard.

PROCEDURE

1. In Write mode, start note input.

2. Optional: Press V  to select the voice into which you want to insert notes.

3. Activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

In Insert mode, the caret shows V and inverted V shapes at the top and bottom.

4. Optional: If you want to input notes in Insert mode onto multiple staves at once, extend the 
caret to those staves.

5. Input the notes you want.

6. Optional: Press I  or click Insert  again to deactivate Insert mode and return to normal 
note input.
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7. Press Esc  or Return  to stop note input.

RESULT
Notes are inserted before existing notes in the voice indicated by the caret indicator, without 
overwriting any existing notes in the same voice at rhythmic positions after the caret. They are 
input at the caret position or where you click. Any existing notes in the same voice after the caret 
are pushed ahead to subsequent rhythmic positions.

RELATED LINKS
Notes toolbox on page 144
Rhythmic grid on page 155
Inputting notes on page 161
Inputting chords on page 192
Moving the caret manually on page 161

Insert mode
Insert mode changes how notes are input and how edits you make outside of note input affect 
the music. When Insert mode is activated, notes are pushed to subsequent rhythmic positions 
instead of being overwritten if you input new notes or lengthen existing notes. Similarly, deleting 
notes or reducing their duration with Insert mode activated pulls surrounding notes closer 
together without leaving rests between them.

For example, if you input four quarter notes with Insert mode activated, all subsequent notes in 
the same voice are pushed four quarter note beats back to accommodate the new notes.

Edits outside of note input that are affected by Insert mode include copying/pasting notes, 
deleting notes, changing the duration of notes including by adding/removing rhythm dots, or 
inputting time signatures.

● You can activate/deactivate Insert mode in Write mode by pressing I  or clicking Insert  in 
the Notes toolbox.

NOTE

● Insert mode applies to the selected voices only.

● You cannot have both Insert mode and Chord mode activated simultaneously.

When Insert mode is not activated, Dorico SE does not add extra beats before an existing time 
signature if you change a previous time signature. When Insert mode is activated, Dorico SE 
inserts beats before existing time signatures to fill the final bar.

3/4 time signature input without Insert mode 
activated

3/4 time signature input with Insert mode activated

RELATED LINKS
Chord mode on page 194
Caret on page 157
Inputting notes on page 161
Copying and pasting items on page 351
Changing the duration of notes on page 170
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Inputting notes with rhythm dots on page 172
Deleting notes and items on page 350

Inputting notes for unpitched percussion
You can input notes for individual unpitched percussion instruments and on all percussion 
instruments in percussion kits using any presentation type, including selecting playing 
techniques, such as playing technique-specific noteheads, for individual instruments.

When inputting notes in percussion kits, the caret is smaller than when inputting notes on 
pitched instrument or individual percussion instrument staves. Instead of occupying the whole 
height of the staff, the caret in percussion kits is positioned at a particular staff position.

The name of the percussion instrument or slash voice currently selected by the caret, and any 
applicable playing technique, is shown directly above the rhythmic grid display.

NOTE

● You can only input notes into slash voices in percussion kits when using the five-line staff 
presentation.

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

Inputting notes on instruments with five-line staff kit presentation

PREREQUISITE
If you want to use additional playing techniques for instruments in the kit, you have defined 
these in the Percussion Instrument Playing Techniques dialog.

PROCEDURE

1. In Write mode, select an item on the unpitched percussion instrument/kit staff and at the 
rhythmic position where you want to input notes.

2. Start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

If you select a notation, such as a dynamic, pressing Return  opens the corresponding 
popover instead of starting note input.

● Double-click the staff where you want to input notes.

3. Optional: When inputting into percussion kits, move the caret up/down to other instruments 
in the kit in any of the following ways:

● Press Up Arrow  to move it up.

● Press Down Arrow  to move it down.

4. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.
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For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

5. Select an appropriate playing technique for the instrument currently selected by the caret 
before inputting notes.

● Press Alt/Opt-Up Arrow  to cycle upwards through playing techniques.

● Press Alt/Opt-Down Arrow  to cycle downwards through playing techniques.

● Play the pitch for the playing technique you want on a MIDI keyboard.

NOTE

You can define MIDI pitches for playing techniques on the Note Input and Editing page 
in Preferences.

6. Input notes in one of the following ways:

● Any kit presentation type/Individual instruments: Press Y  to input notes for the 
instrument and playing technique shown above the rhythmic grid.

● Any kit presentation type/Individual instruments: Click on the staff where you want to 
input notes, and at the rhythmic positions where you want them.

● Five-line staff presentation type: Press letters on a computer keyboard or play notes on 
a MIDI keyboard, corresponding to staff positions for the clef set in Preferences. For 
example, press B  to input notes for the instrument assigned to the middle line of a 
five-line staff when Treble G clef is set.

● Grid and single-line instruments presentation types/Individual instruments: Press the 
letter of any note name A  to G  on a computer keyboard or play any note on a 
MIDI keyboard to input notes for the instrument on whose line the caret is currently 
positioned.

NOTE

Notes played on MIDI keyboards are interpreted differently, depending on whether Use 
percussion map or Use staff position is set for the different kit presentation types in 
the Note Input section of the Note Input and Editing page in Preferences.

7. Optional: Press Space  to advance the caret by the currently selected note duration without 
inputting notes.

TIP

You can also move the caret in different ways and by different increments.

8. Press Esc  or Return  to stop note input.

RESULT
Notes are input at the caret position or where you click with the selected duration and are 
played back as you input them by default. If you selected playing techniques, their noteheads 
appear as set in the Percussion Instrument Playing Techniques dialog for the corresponding 
instrument and playing technique, or in the Override Percussion Noteheads dialog for five-line 
staff presentations only.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them.
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Dorico SE notates and beams notes appropriately according to their duration, the current time 
signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico SE fills the gaps between notes with 
implicit rests of the appropriate duration.

NOTE

● You can specify custom beat groupings within individual time signatures.

● You cannot delete rests from unpitched percussion instruments.

RELATED LINKS
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Percussion kits vs. individual percussion instruments on page 978
Percussion kits and drum sets on page 979
Playing techniques for unpitched percussion instruments on page 985
Percussion Instrument Playing Techniques dialog on page 985
Changing the playing techniques of unpitched percussion notes on page 988
Inputting notes using pitch before duration on page 165
Note and rest grouping on page 590
Beam grouping according to meters on page 575
Inputting notes on page 161

Note input setup for percussion kits
Inputting music for unpitched percussion instruments works differently than for pitched 
instruments. You can use any of the usual methods for unpitched percussion input, but using 
a MIDI keyboard or a computer keyboard is most efficient.

● You can find options relating to note input for percussion in the Note Input section of the 
Note Input and Editing page in Preferences.

There is one set of options for input onto five-line staves, and another set of options for input 
onto grids and individual instruments.

The main choice affects input via MIDI keyboards and computer keyboards.

Use percussion map
A percussion map defines which MIDI notes produce which sound for a particular 
patch in a sound library. For example, in General MIDI percussion, C2 (note 36) 
produces bass drum, and D2 (note 38) produces snare drum, and so on.

If you know a particular mapping well, you may find it helpful to use the mapping 
directly for input.

Use staff position
This option uses the staff position defined in the Edit Percussion Kit dialog. For 
example, on a drum set, the bass drum is normally positioned in the bottom space 
of the staff, while the snare drum is positioned in the third space from the bottom.

You can think of staff positions relative to what they would be when using a treble G 
clef (F4 and C5 respectively) or using a bass F clef (A2 and E3 respectively).

You can choose which clef is used to interpret staff positions for five-line staves:

● Treble G clef

● Bass F clef
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When you select Use staff position, you can designate one octave of your MIDI keyboard to 
input playing techniques.

By default, the Input techniques from MIDI key option is set to MIDI note 48, which is C3, the 
C one octave below middle C (C4 = MIDI note 60). You can click the MIDI learn button and then 
play a note on your MIDI keyboard to change the starting pitch. Assuming a starting pitch of C3, 
ascending notes operate as follows:

● C3 (48): Previous playing technique

● C♯3 (49): Next playing technique

● D3 (50): First mapped playing technique

● E♭3 (51): Second mapped playing technique

● E3 (52): Third mapped playing technique

And so on, up to:

● B3 (59): Tenth mapped playing technique

In general, we recommend that you set Use staff position for percussion input. Use percussion 
map is normally only useful when you are inputting notes onto a drum set and you have already 
memorized the General MIDI percussion map.

RELATED LINKS
Preferences dialog on page 45
Edit Percussion Kit dialog on page 109
Inputting notes for unpitched percussion on page 180
Changing the playing techniques of unpitched percussion notes on page 988

Default note selection during note input for percussion kits
During note input in percussion kits, you can press the letters on a computer keyboard that 
correspond to staff positions for kits using the five-line staff presentation type. For example, you 
can press F  to input a note on the F space or line.

In Preferences, you can set options for inputting notes into percussion kits in the Note Input 
section of the Note Input and Editing page. For example, if you want to use staff positions to 
determine notes, choose Use staff position for Input onto kit or grid.

If you have the staff positions set relative to Treble G clef, then F could mean either the bottom 
space on the staff or the top line on the staff. In a standard drum set, this means either the kick 
drum in the bottom space, or the ride cymbal on the top line.

When inputting notes in pitched instruments, Dorico SE chooses the lower or upper possible staff 
position based on which is closer to the current position of the caret.

However, when inputting notes in percussion kits, Dorico SE chooses the staff position of the 
note with the same stem direction as the last input note, rather than the staff position that is 
closest to the current position of the caret. This makes it easier to input common note patterns 
used in percussion kits.

For example, inputting kick drum and snare drum notes on a standard drum set is a common 
pattern. The kick drum is in the bottom space, and the snare drum is two spaces above: five staff 
positions away from the bottom space, and four staff positions away from the top line.

You can press F  for the kick drum and C  for the snare drum.
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The default stem direction behavior for inputting notes in kits in Dorico SE means that you can 
alternate pressing F  and C , and the notes are input at the positions of the kick drum and snare 
drum, even though the top line is the closer position after inputting a snare drum note.

This is because the kick drum uses the same stem direction, and therefore voice, as the snare 
drum.

NOTE

Dorico SE automatically changes the directions of stems according to the positions of notes on 
the staff when only one voice on the staff contains notes, regardless of their voice.

RELATED LINKS
Stem direction on page 921

Inputting notes on tablature
You can input notes directly into tablature in the same ways as inputting normal notes. When 
inputting notes on tablature, the caret is smaller than when inputting notes on standard five-line 
staves and behaves as if chord input is always active, meaning you must advance the caret 
manually to input notes at other rhythmic positions.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting notes on tablature using pitch before duration, you must select note durations 
by clicking them in the Notes panel.

PROCEDURE

1. In Write mode, select an item on the tablature and at the rhythmic position where you want 
to input notes.

NOTE

If both notation staves and tablature are shown in the current layout, you must select an 
item on the notation staff and then move the caret to the tablature after starting note input.

2. Press Shift-N  to start note input.

3. Select a note value in any of the following ways:

● To select the next longer note value, press = .

● To select the next shorter note value, press - .

● In the Notes panel, click the note value you want.

4. Input the pitch you want for the current string in any of the following ways:

● Press the number on your computer keyboard or numeric keypad that corresponds to 
the fret number you want. For example, press 6  for fret 6.
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For fret numbers 10 and above, press the two digits quickly.

● Press the corresponding letters on your computer keyboard.

NOTE

When using letters, Dorico SE automatically chooses the octave closest to the nut on the 
corresponding string.

● Play the note on a MIDI keyboard.

5. Move the caret up/down to input notes on different strings at the same rhythmic position in 
any of the following ways:

● Press Up Arrow  to move it up.

● Press Down Arrow  to move it down.

6. Move the caret to other rhythmic positions in any of the following ways:

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space .

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

RESULT
Notes are input at the caret position with the selected duration on the string indicated by the 
caret and are played back as you input them by default. Notes continue to be input at the caret 
position until you move the caret manually and overwrite any previous note on the same string. 
If you attempt to input a note that is impossible on the current string, it is input on the closest 
available string in addition to any existing notes.

If you have input two or more notes on the same string at the same rhythmic position, they 
are shown next to each other on tablature and are colored green. Similarly, when you input 
chords on tablature using pitch before duration with a MIDI keyboard, all notes in the chord 
are allocated to the same string. You can then select them individually and change their string 
allocation.

RELATED LINKS
Caret on page 157
Moving the caret manually on page 161
Tablature on page 917
Hiding/Showing notation staves and tablature on page 918
Changing the allocated string for notes on tablature on page 919
Inputting notes using pitch before duration on page 165

Inputting accidentals
You can input accidentals during note input and by adding them to existing notes. You can also 
change the accidentals of existing notes.

NOTE

● Accidentals that are part of the prevailing key signature are input automatically. For example, 
if you press F  in G major, an F♯ is input automatically. You would only need to specify an 
accidental if you want to input an F♮, for example.
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This also applies if you are using a MIDI keyboard, though you can respell notes if the 
accidentals chosen automatically are not the ones that you expected.

● These steps describe selecting accidentals before inputting each note. However, you can 
change this setting if you prefer to specify accidentals after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add accidentals or whose accidentals you 
want to change.

2. Select the accidental you want to input in one of the following ways:

● Press -  for flat.

● Press =  for sharp.

● Press 0  for natural.

● In the Notes panel, click the accidental you want.

TIP

You can find uncommon accidentals, such as double sharps and flats, or microtonal 
accidentals, in the Accidentals section of the Key Signatures, Tonality Systems, and 
Accidentals panel on the right of the window.

3. Optional: During note input, input the note you want with your selected accidental.

RESULT
The accidental is added to the selected existing notes. If you selected existing notes with 
different accidentals, they are changed to have the accidental you selected.

During note input, the selected accidental is only input on the next note you input. You must 
reselect the accidental for each subsequent note.

NOTE

● Due to the default accidental duration rule in Dorico SE, subsequent accidentals for the same 
note in the same register do not appear in the same bar.

● If you input notes using a MIDI device, Dorico SE automatically shows an accidental if 
necessary. It selects a sharp, flat, or natural based on key signature and context. You 
can later respell notes so they are shown as their enharmonic equivalents with different 
accidentals.

RELATED LINKS
Accidentals on page 541
Inputting notes on page 161
Changing the note-based notation input setting on page 168
Changing the pitch of individual notes on page 199
Accidental duration rules on page 545
Respelling notes on page 200
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Accidental selection during MIDI input
Dorico SE interprets MIDI data to create accidentals, and automatically determines the spelling of 
notes according to preset rules.

Dorico SE automatically displays an accidental if one is required. It selects a sharp or flat based 
on key signature and context.

The algorithm for this takes into account the key signature and the intervals between successive 
notes and chords. Therefore Dorico SE prefers sharp accidentals in a key with sharps, and flats 
in a key with flats. If you change the spelling of an accidental, Dorico SE follows your spelling 
preference whenever that note is used again in the score.

If you input notes with accidentals outside the key signature, Dorico SE uses sharps if the figure 
is rising, and flats if it is falling. The spelling is also calculated vertically, meaning a simpler 
interval is produced where possible, such as a major third rather than a diminished fourth.

By default, Dorico SE makes retrospective changes to how it has spelled accidentals, depending 
on how your music develops. For example, in C major, if you input a sequence of pitches C-E-G♯, 
but then input a G♭, the G♯ is respelled as an A♭.

Inputting rests
Dorico SE automatically shows rests as appropriate in the gaps between the notes you input. 
However, you can also input rests manually, for example, to show fermatas on specific beats for 
players without notes in that bar.

NOTE

These steps describe selecting the duration before inputting rests. However, you can also input 
rests when Pitch Before Duration is active, in which case step 7 is unnecessary.

PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to input rests.

2. Press Shift-N  to start note input.

3. Optional: If you want to input rests onto multiple staves at once, extend the caret to those 
staves.

4. Start rest input in any of the following ways:

● Press , .

● In the Notes toolbox, click Rests .

5. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

6. Select the rest duration you want.

7. Input rests in any of the following ways:

● Press Y  or any of the letters from A  to G .

● Click the staff at the rhythmic position of each rest you want to input.

A shadow rest appears when inputting with the mouse to indicate where the rest will be 
input.

● Play notes on a MIDI keyboard.
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8. Optional: Press ,  or click Rests  again to stop rest input.

9. Press Esc  or Return  to stop note input.

RESULT
Rests of the selected duration are input. If Force Duration is not activated, Dorico SE 
automatically combines adjacent rests as appropriate for their position in relation to notes and 
according to the current meter.

RELATED LINKS
Rests on page 879
Implicit vs. explicit rests on page 880
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Extending the caret to multiple staves on page 161
Selecting note/rest durations on page 169
Forcing the duration of notes/rests on page 171
Inputting notes on page 161
Inputting notes using pitch before duration on page 165

Inputting bar rests into specific voices
When inputting music in multiple voices, rests are normally created automatically when there is a 
gap in the secondary voice. However, if you want secondary voices to begin with explicit bar rests 
in strict contrapuntal music, you can input a bar rest into those voices.

For music in a single voice, you do not have to input bar rests as they appear in each new bar 
automatically when you advance the care. You can also hide/show bar rests in all empty bars in 
each layout independently.

PROCEDURE

1. In Write mode, start note input.

2. Select the appropriate secondary voice by pressing V  until the voice direction indicator 
shows the correct voice.

Alternatively, if you want to input bar rests into a new voice, press Shift-V  until the voice 
direction indicator shows the correct voice.

3. Press Shift-B  to open the bars and barlines popover.

4. Enter rest into the popover to add a bar rest.

5. Press Return  to close the popover.

6. Press Ctrl/Cmd-Right Arrow  to advance the caret to the start of the next bar after the bar 
rest.

7. Optional: If you want to show bar rests in multiple bars for the selected voice, repeat steps 3 
to 6 as many times as required.

RESULT
Bar rests are input into the selected voice at the caret position. If the caret position is within a bar 
that contains notes for the selected voice, these notes are replaced by the bar rest.

Write mode
Note input 

188
Dorico SE 3.5.12



NOTE

Alternatively, you can click Insert Bar Rest in the Insert Bar Rest section of the Bars and 
Barlines panel to input bar rests during note input.

RELATED LINKS
Bars on page 553
Bars and barlines popover on page 235
Inputting notes into multiple voices on page 174
Caret on page 157
Hiding/Showing bar rests in empty bars on page 884

Inputting ties
You can input ties manually to join two notes of the same pitch, both during note input and by 
joining two existing notes with a tie. You can tie existing notes in different voices or on different 
staves belonging to the same instrument, or that are not rhythmically adjacent.

For example, you might have input a melody across multiple voices in order to accommodate 
passing notes, but want to tie two notes together even though they are in different voices. 
Similarly, you might have written multiple notes before a chord that are all held down and want 
to reduce the number of tied notes.

TIP

Dorico SE automatically creates ties as required for note durations in each meter. For example, 
if you want to input a tie between two quarter notes across a barline, you can input a half note 
at the rhythmic position where you want to input the first quarter note. Dorico SE automatically 
splits the half note into two quarter notes, one on each side of the barline, and joins them with a 
tie.

PREREQUISITE
If you want to preserve the durations of existing notes, you have forced their duration. For 
example, if you want to specify subdivisions within a tie chain that are different than the 
prevailing meter.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the note from which you want the tie to start. If you want to input a tie between 
two specific notes or between a grace note and a normal note, select those two notes.

NOTE

The two notes must be the same pitch but can be in different voices or on different 
staves belonging to the same instrument.

2. Optional: During note input, input the note that you want at the start of the tie.

3. Input a tie in any of the following ways:

● Press T .

● In the Notes toolbox, click Tie .

4. Optional: During note input, input the note that you want at the end of the tie.
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NOTE

The second note must be the same pitch as the first note.

RESULT
During note input, the two notes input are joined by a tie.

If you selected a single existing note, it is joined by a tie to the next note of the same pitch in the 
same voice and staff. If you selected two existing notes, they are tied together, provided they are 
the same pitch and belong to the same instrument.

NOTE

● During note input, Dorico SE ties the first note you input after inputting the tie to the 
previous note of the same pitch in the same voice and staff, even if there are other notes of 
other pitches between them.

● Depending on the current time signature and the position of the start of the note in the bar, 
inputting a tie between two notes can instead create a single note of a different duration, 
such as a half note instead of two tied quarter notes. You can override your note grouping 
settings and fix your notated rhythm by forcing their duration. Dorico SE then notates your 
input notes with the rhythmic durations specified, as long as they can fit inside the bar.

EXAMPLE

Spread chord with ties between all adjacent notes Spread chord with ties between non-adjacent notes

RELATED LINKS
Inputting notes on page 161
Forcing the duration of notes/rests on page 171
Notes toolbox on page 144
Ties on page 938
Ties vs. slurs on page 940
Note and rest grouping on page 590
Beam grouping according to meters on page 575

Inputting grace notes
You input grace notes in the same ways as normal notes, and they can have any rhythmic note 
value, accidental, and articulation. You can only input grace notes during note input.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.
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PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to input grace notes.

2. Press Shift-N  to start note input.

3. Optional: If you want to input grace notes onto multiple staves at once, extend the caret to 
those staves.

4. Start grace note input in any of the following ways:

● Press / .

● In the Notes toolbox, click Grace Notes .

5. Press the number for the note duration you want. For example, press 5  for eighth grace 
notes.

6. Optional: Press Alt/Opt-/  to switch between inputting slashed/unslashed grace notes.

When inputting unslashed grace notes, Grace Notes  in the Notes toolbox appears with an 
unslashed note.

7. Input the grace notes you want.

TIP

There is no limit to the number of grace notes that can exist at the same rhythmic position.

8. Press /  or click Grace Notes  again to stop grace note input and return to normal note 
input.

RESULT
The pitches you enter are input as grace notes at the caret position.

TIP

● You can also change the type of grace notes after they have been input.

● Slashed and unslashed grace notes are handled differently in playback.

RELATED LINKS
Grace notes on page 682
Grace notes in playback on page 686
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Extending the caret to multiple staves on page 161
Inputting notes on page 161
Selecting note/rest durations on page 169
Inputting accidentals on page 185
Inputting articulations on page 209
Changing the type of grace notes on page 685
Inputting notes using pitch before duration on page 165
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Inputting chords
You can input chords during note input when both note input and Chords are activated. You 
can input notes with a computer keyboard, with the mouse, or by playing notes with a MIDI 
keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting chords using pitch before duration, you must use your computer keyboard 
or a MIDI keyboard and complete step 6 before step 5.

● You can only input chords in Insert mode when using a MIDI keyboard.

PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to input chords.

2. Start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

If you select a notation, such as a dynamic, pressing Return  opens the corresponding 
popover instead of starting note input.

● Double-click the staff where you want to input notes.

3. Start chord input in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .

In chord input, a + sign appears at the top of the caret. This allows you to input multiple 
notes at the caret position.

4. Optional: If you want to input chords onto multiple staves at once, extend the caret to those 
staves.

5. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

6. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your keyboard.
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TIP

Dorico SE automatically inputs notes above the highest note at the caret position when 
Chords is activated.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name, for example, 
Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

● Click the staff at the rhythmic positions where you want to input notes.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● Play the notes on a MIDI keyboard.

7. Optional: Advance the caret to input chords at other rhythmic positions.

During chord input, notes are input at the same rhythmic position and above the previous 
note until you advance the caret manually.

8. Press Q  or click Chords  again to stop chord input.

RESULT
Multiple notes are input at the caret position.

● If entering pitches by clicking with the mouse, you can put the same pitch into the chord 
twice by clicking again on the same line.

● If entering pitches with the keyboard, repeated notes are automatically input an octave 
above. You can change the register of notes by forcing the register selection during note 
input, or by transposing them after they have been input.

NOTE

● You can stop chord input and immediately continue inputting notes as before, with a single 
note at each rhythmic position and the caret advancing automatically to the next rhythmic 
position.

● When chords contain two pitches in the same register but with different accidentals, that is 
known as an altered unison. Altered unisons are shown as split stems by default in Dorico SE.

● When you input chords on tablature using pitch before duration with a MIDI keyboard, all 
notes in the chord are allocated to the same string. In such cases, the notes are shown next 
to each other on tablature and are colored green. You can then select them individually and 
make your own string allocation.

RELATED LINKS
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Register selection during note input on page 164
Extending the caret to multiple staves on page 161
Moving the caret manually on page 161
Altered unisons on page 544
Inputting notes using pitch before duration on page 165
Changing the note-based notation input setting on page 168
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Chord mode
Chord mode changes how notes are input and how edits you make outside of note input affect 
the music. When Chord mode is activated, notes can overlap or stack on top of each other to 
create chords rather than overwriting existing notes. During chord input, the caret does not 
advance automatically.

Edits outside of chord input that are affected by Chord mode include copying/pasting notes or 
changing their duration. For example, if you copy four notes and paste them to a staff that 
already has notes with Chord mode activated, the existing notes are not overwritten but instead 
combine with the new notes to make chords.

● You can activate/deactivate Chord mode in Write mode by pressing Q  or clicking Chords 
in the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.

RELATED LINKS
Insert mode on page 179
Caret on page 157
Copying and pasting items on page 351
Changing the duration of notes on page 170
Inputting notes with rhythm dots on page 172

Inputting tuplets
You can input all types of tuplets using the tuplets popover. Tuplets are input like normal notes, 
and so can only be input during note input.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting tuplets using pitch before duration, Dorico SE determines the base value 
of the tuplet on either the first note you input after specifying the tuplet or the note value 
included in your tuplet ratio.

● You can also input triplets by clicking Tuplets  in the Notes toolbox. However, you can only 
input one triplet at a time this way.

PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to input tuplets.

2. Press Shift-N  to start note input.

3. Optional: If you want to input tuplets onto multiple staves at once, extend the caret to those 
staves.

4. Press ;  to open the tuplets popover.

5. Enter the tuplet you want into the popover as a ratio followed by the beat unit.

For example, enter 3:2e to input triplets based on eighth notes or 5:4x to input quintuplets 
based on sixteenth notes.
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NOTE

If you do not specify the beat unit, the tuplet is based on the note value currently selected in 
the Notes panel.

6. Press Return  to close the popover.

The tuplet is entered.

7. Optional: Change the selected note duration.

For example, you can input a tuplet based on eighth notes but input a quarter note within 
that tuplet.

8. Enter or play in the pitches you want.

9. Optional: Press Space  to advance the caret to continue inputting tuplets of the same ratio at 
later rhythmic positions.

10. Stop tuplet input in any of the following ways:

● To return to inputting normal notes, press :  or move the caret with the arrow keys.

● To stop note input completely, press Esc .

RESULT
The pitches you enter or play in are input as tuplets, starting from the caret position.

If you want to input a different type of tuplet immediately after inputting tuplets, you must stop 
the first type of tuplet before inputting the second type. If you do not stop the first type, the 
second type is input as a nested tuplet.

RELATED LINKS
Tuplets on page 967
Nested tuplets on page 968
Notes toolbox on page 144
Notes panel on page 146
Caret on page 157
Inputting notes on page 161
Extending the caret to multiple staves on page 161
Inputting notes using pitch before duration on page 165

Tuplets popover
The table contains examples of what you can enter into the tuplets popover to input different 
types of tuplets. The tuplets popover can only be opened during note input.

You can open the tuplets popover during note input in Write mode in any of the following ways:

● Press ; .

As tuplets are often described in ratios, such as 3:2, the tuplets popover uses the semicolon 
key to be memorable.

● Choose Write > Create Tuplet.

The icon on the left-hand side of the popover matches the corresponding button in the Notes 
toolbox on the right of the window.
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Tuplets popover with an example entry
Tuplets button in the Notes toolbox

NOTE

Clicking Tuplets  in the Notes toolbox only inputs a single triplet. It does not open the tuplets 
popover.

When inputting tuplets with the keyboard, Dorico SE continues inputting notes as the specified 
tuplet until any of the following happens:

● You press :  to return to inputting normal notes.

● You move the caret with the arrow keys.

● You stop note input.

Type of tuplet Popover entry

Triplet, three notes in the space of two. 3, 3:2, or 3 2

Triplet, three notes in the space of four. 3:4 or 3 4

Quintuplet, five notes in the space of four. 5:4 or 5 4

Quintuplet, five notes in the space of two. 5:2 or 5 2

Septuplet, seven notes in the space of four. 7:4 or 7 4

Septuplet, seven notes in the space of two. 7:2 or 7 2

Duplet, two notes in the space of three. Often 
used in compound meters.

2:3 or 2 3

Quintuplet, five notes in the space of six. Often 
used in compound meters.

5:6 or 5 6

Quintuplet, five dotted quarter notes in the 
space of four.

NOTE

When using a number to specify the beat unit, 
you must separate the tuplet ratio from the 
beat unit using a space or hyphen.

5:4q., 5 4q., or 5:4-6.

This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different tuplets.
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NOTE

Unless you specify a beat unit in your entry, the total duration of the tuplet depends on the note 
value selected when you open the popover. For example, if a quarter note is selected when you 
input a triplet, the triplet input is three quarter notes in the space of two.

Tuplet beat units

Tuplet beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

RELATED LINKS
Turning existing notes into tuplets on page 969
Selecting note/rest durations on page 169

Adding notes above/below existing notes
You can add notes above/below existing notes. You can add multiple notes at the same time, 
according to their intervals relative to the existing notes.

PROCEDURE

1. Select the notes to which you want to add notes.

2. Press Shift-I  to open the add intervals popover.

3. Enter the intervals of the notes you want, relative to your selected notes. For example, enter 
-m3,4 to add notes a minor third below and a fourth above the selected notes.

4. Press Return  to close the popover.

RESULT
Notes are added to the selected notes according to the intervals you entered into the add 
intervals popover.
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Add intervals popover
The add intervals popover allows you to add notes above and below existing notes, and also 
transpose existing notes. It makes much of the functionality provided by the Add Notes Above 
or Below and Transpose dialogs accessible directly via the keyboard.

You can open the add intervals popover in Write mode in any of the following ways when notes 
are selected, including during note input:

● Press Shift-I .

● Choose Write > Add Intervals Popover.

The table contains examples of what you can enter into the add intervals popover to transpose 
notes or add notes to existing notes.

Example action Popover entry

Transpose notes upwards by a third. t3

Transpose notes downwards by a sixth. t-6

Add notes a third above. 3 or 3rd

Add notes a fourth below. -4 or -4th

Add multiple notes.

NOTE

Separate notes with commas, not with spaces.

3,6 or -3,3,4

Add notes above and/or below all notes in 
selected chords.

NOTE

Separate notes with commas, not with spaces.

3 all or -M2,m3 to all

Add notes only to the top notes in chords. -3 top or dim5 top

Add notes only to the bottom notes in chords. aug4 bottom or -2 bottom

Specify perfect interval. p, per, or perf

Specify major interval. M, maj, or major

Specify minor interval. m, min, or minor

Specify diminished interval. d, dim, or diminished

Specify augmented interval. a, aug, or augmented
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Example action Popover entry

Specify diatonic interval. diat or diatonic

Transpose notes by microtonal intervals.

NOTE

The first number is the interval degree. The 
second number is the number of quarter 
tones.

t 3 8 qt

If you do not otherwise specify it, the interval is calculated by adding or transposing notes by the 
number of staff positions specified. For example, in C major, if the selected note is a D♮ and you 
specify 3 to add a third above, the added note is an F♮. You can specify the quality of the interval 
by including it before the interval.

If the selected material already includes chords, notes are added above the top note in the chord, 
and added below the bottom note in the chord. You can add notes to all notes in selected chords 
by including all or to all at the end of your entry.

For microtonal transpositions, the first number is the interval degree, and the second number 
is the number of quarter tones. For example, if you have a C natural and you enter T 3 8 qt, it 
changes to an E natural.

RELATED LINKS
Transposing existing notes with the add intervals popover on page 201

Changing the pitch of individual notes
You can raise/lower the pitch and register of individual notes, including grace notes, after they 
have been input by octave divisions, staff position, and octaves.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to change.

2. Raise/Lower the pitches of the selected notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

RESULT
The pitch or register of the selected notes is changed. Any figured bass shown on the affected 
staves is updated automatically.
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If the pitch is now impossible to play on a fretted instrument, such as if a note would have to be 
played below the nut on the lowest string, it appears on tablature as a question mark.

NOTE

You can press Alt/Opt-Up Arrow  and Alt/Opt-Down Arrow  to change the staff positions of 
notes in percussion kits using grid and five-line staff presentation types. However, this also 
changes the instrument playing the note.

RELATED LINKS
Equal Division of the Octave (EDO) on page 700
Adding notes above/below existing notes on page 197
Inputting accidentals on page 185
Figured bass on page 651

Respelling notes
You can change the enharmonic spelling of notes so they are shown as their enharmonic 
equivalents, for example, to show the stepwise movement in a phrase clearly, or to avoid altered 
unisons in a chord. You can do this for all layouts or just for part layouts.

Dorico SE uses an algorithm that automatically decides the spelling of pitches, based on key 
signature and context.

There are always at least three options for every pitch, as Dorico SE allows enharmonic spellings 
to show up to two accidental glyphs. This means the same note can be spelled four ways if the 
original pitch can be spelled with the note name either two notes below or two notes above, 
using a maximum of two accidental glyphs. For example, B is a possible enharmonic spelling of 
G♯ because a triple-flat uses a single accidental glyph, whereas an F♯ uses two accidental glyphs.

PROCEDURE

1. In the music area, open the layout in which you want to respell accidentals.

NOTE

If you respell accidentals in a full score layout, this also affects their spelling in part layouts. 
However, if you respell accidentals in part layouts, this only affects their spelling in that part 
layout.

2. Select the notes you want to respell.

3. Respell the selected notes in any of the following ways:

● To respell them upwards, press Alt/Opt-= .

● To respell them downwards, press Alt/Opt-- .

RESULT
The enharmonic spelling of the selected notes is changed.
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EXAMPLE

A G sharp When respelled 
downwards, the G sharp 
becomes an F triple-
sharp

When respelled upwards, 
the G sharp becomes an 
A flat

When respelled upwards 
again, the G sharp 
becomes a B triple-flat

RELATED LINKS
Accidentals on page 541

Transposing existing notes with the add intervals popover
You can change the pitch of notes after they have been input using the add intervals popover.

PROCEDURE

1. Select the notes you want to transpose.

2. Press Shift-I  to open the add intervals popover.

3. Enter the transposition interval you want into the popover.

For example, enter t3 to transpose the notes up a third, or t-min6 to transpose the notes 
down a minor sixth.

4. Press Return  to close the popover.

RESULT
The selected notes are transposed by the degree specified. Any figured bass shown on the 
affected staves is also transposed accordingly.

RELATED LINKS
Add intervals popover on page 198
Figured bass on page 651

Repitching notes without changing their rhythm
You can repitch notes after you have input them while keeping their durations the same, for 
example, if you want to duplicate the rhythm but have different pitches.

PROCEDURE

1. Select the first note you want to repitch.

2. Press Shift-N  to start note input.

3. Optional: If you want to repitch notes on multiple staves at once, extend the caret to those 
staves.

4. Activate Lock to Duration in any of the following ways:

● Press L .

● In the Notes toolbox, click Lock to Duration .

5. Enter the pitches you want.
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6. Optional: Press L  or click Lock to Duration  again to deactivate Lock to Duration.

NOTE

Lock to Duration automatically deactivates when you reach the last existing note on the 
staff. By default, normal note input continues using the previous note value selected before 
you activated Lock to Duration.

RESULT
Existing notes on the selected staff are repitched without their rhythms being changed. The caret 
automatically advances from note to note, even if there are large rests between notes on the 
staff.

RELATED LINKS
Caret on page 157
Extending the caret to multiple staves on page 161

Transposing selections
You can transpose whole selections together, including key signatures within selections, using 
the Transpose dialog.

PROCEDURE

1. In Write mode, make a selection in the music area.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings, for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Click OK to save your changes and close the dialog.

RESULT
All notes in your selection are transposed according to the interval or number of divisions of 
the octave specified in the Transpose dialog. If your selection included key signatures and you 
activated Transpose key signatures, all key signatures in the selection are also transposed.

Any figured bass shown on the affected staves is also transposed accordingly.

RELATED LINKS
Figured bass on page 651
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Transpose dialog
The Transpose dialog allows you to transpose selections of notes simultaneously, including key 
signatures. You can transpose according to an interval and quality or by a set number of octave 
divisions.

● You can open the Transpose dialog in Write mode by making a selection in the music area 
and choosing Write > Transpose.

The Transpose dialog contains the following sections:

1 Transposition options

Contains options that allow you to specify the transposition you want. For example, you can 
choose to transpose by an interval quality, such as a major third, or by a set number of 
divisions of the octave. You can choose the direction of the transposition, whether it includes 
octaves, and the interval and quality or number of divisions by which you want to transpose 
your selection.

According to convention, different intervals have different possible qualities. For example, 
you can specify a major third but not a major octave. Therefore, we recommend selecting 
the interval before the quality.

Additional options also allow you to transpose any key signatures included in your selection, 
keep relative respelled notes and chord symbols where possible, and avoid double and triple 
accidentals.

NOTE

You can only use Respell to avoid double and triple sharps and flats when transposing 
music in tonality systems that are compatible with 12-EDO.

2 Calculate interval

Allows you to set transposition options according to a starting note and the resulting note 
you want. For example, if you want to transpose a selection relative to a C natural becoming 
a G♯ but you are not certain of the interval and quality required, you can enter those two 
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notes in the Calculate interval section, click Apply, and Dorico SE automatically sets the 
required transposition options for you.

NOTE

The Transpose dialog does not allow transpositions that would result in impossible notations, 
such as sharper than a triple sharp, or that require a microtonal accidental that does not exist in 
the tonality system in place at the position of your selection.

RELATED LINKS
Add intervals popover on page 198
Equal Division of the Octave (EDO) on page 700
Tonality systems on page 700

MIDI recording
MIDI recording is a way of inputting notes into Dorico SE by playing them in real time on a MIDI 
device. This can be particularly useful if, for example, you prefer to improvise your music rather 
than plan pitches and note durations in advance.

In Dorico SE, you can record MIDI notes using any MIDI device.

Outside of note input, Dorico SE uses the instrument sounds of your most recent selection for 
the notes you play on your MIDI device. In Play mode, this is the most recent track header you 
clicked, while in Write mode, this is the last instrument staff on which you selected an item, 
started note input, or into which you recorded MIDI. During note input, Dorico SE always uses 
the instrument sounds of the instrument into which you are recording notes.

TIP

You can enable/disable MIDI thru on the Play page in Preferences, for example, if you do not 
want to hear sounds in Dorico SE when playing on your MIDI keyboard.

As you play notes on your MIDI device, Dorico SE uses an algorithm to produce the correct 
enharmonic spelling for those notes.

RELATED LINKS
Optimization for MIDI recording on page 207
Preferences dialog on page 45

Inputting notes using MIDI recording
You can input notes by recording what you play on a MIDI device in real time. You can record 
notes in both concert and transposed pitch.

PREREQUISITE

● You have connected the MIDI device you want to use.

● You have set the quantization options in the MIDI Quantize Options dialog as appropriate 
for the music you intend to record.

● You have set the options in the Recording section of the Play page in Preferences as 
appropriate for the music you intend to record.

● You have input enough bars or empty rhythmic space for the amount of music you want to 
record. Dorico SE does not automatically add extra bars or rhythmic space.

Write mode
MIDI recording 

204
Dorico SE 3.5.12



● If you want to hear a click during your recording, you have input a time signature. There is 
no click in open meter or when there is no time signature.

● You have chosen the appropriate input pitch setting.

PROCEDURE

1. Select a note or rest on the staff/instrument track into which you want to record notes, at the 
position from which you want to record. You can do this in Write mode and Play mode.

NOTE

● In Play mode you cannot select rests, meaning you can only record into instrument 
tracks that already contain at least one note.

● You can also record MIDI during note input, but this prevents Dorico SE from using both 
staves in grand staff instruments.

2. Optional: If you want to record notes without overwriting any existing notes on the staff, 
press Q  to activate Chords.

3. Optional: If you want to record into a specific voice on the staff, press Shift-N  to start note 
input and then do one of the following:

● If the voice you want already exists on the staff, press V  until the note symbol beside 
the caret indicates the correct voice.

● If the voice you want does not exist on the staff yet, press Shift-V  until the note symbol 
beside the caret indicates the correct voice.

4. Press Ctrl/Cmd-R  to start recording.

During recording, the playhead appears red and moves along in time. By default, there is 
one bar of count-in before the playhead reaches the rhythmic position of either your original 
selection or the caret.

5. Play the notes you want on your MIDI device.

In Write mode, no music appears on the staff until you stop recording. In Play mode, notes 
appear in the piano roll in real time.

6. Press Space or Enter  or Ctrl/Cmd-R  to stop recording.

RESULT
The notes you played on the MIDI device are input onto the selected staff. If you did not specify 
the voice, notes are recorded into the first available voice on the staff, which is usually the first 
up-stem voice. If you activated Chords, the notes you played are merged into the first available 
voice on the staff without overwriting any existing notes.

The notated duration of the notes follows your quantization settings, but their played durations 
are retained for playback.

AFTER COMPLETING THIS TASK
If the notes you played in are not notated as you intended, you can requantize them.

RELATED LINKS
Disabling MIDI input devices on page 209
Changing the input pitch setting on page 167
Changing the sustain pedal controller settings for MIDI recording/import on page 208
Repeats in MIDI recording on page 206
Input methods for bars, beats, and barlines on page 235
Input methods for time signatures and pick-up bars on page 220
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Inputting notes into multiple voices on page 174
Resetting playback overrides on page 516
MIDI Quantize Options dialog on page 68

Retrieving played notes that you did not record
During playback, you can play notes on your MIDI keyboard and hear them without recording 
them into the score. You can use retrospective recording to retrieve these notes and input them 
into the project without previously explicitly recording them.

PREREQUISITE
You have started playback, played notes on a MIDI device alongside playback, then stopped 
playback.

PROCEDURE

1. Select a note or rest on the staff where you want to input the retrieved notes.

2. Optional: If you want to input retrieved notes without overwriting any existing notes on the 
staff, press Q  to activate Chords.

3. Press Ctrl/Cmd-Alt/Opt-R .

RESULT
All the notes you played on your MIDI device during the previous playback are input on the 
selected staff, starting from the selected rhythmic position. They are input into the first available 
voice on the staff and overwrite any existing notes in that voice by default. If you activated 
Chords, the retrieved notes are merged into the first available voice on the staff without 
overwriting any existing notes.

NOTE

The retrospective recording buffer is cleared each time you start playback, meaning you cannot 
retrieve music you played before the most recent playback.

RELATED LINKS
Playing back music on page 458

Repeats in MIDI recording
When recording MIDI into flows that contain repeat structures, such as repeat barlines, Dorico 
SE records the notes you play during each playthrough and merges them together into the same 
voice.

Any differences in rhythms between the recordings are notated according to the current meter.

Requantizing notes
You can requantize notes using different quantization settings, for example, if you want to 
change notated rhythms after importing MIDI or recording notes using a MIDI device. This does 
not affect the played duration of notes in playback.

PROCEDURE

1. Select all the notes you want to requantize. You can do this in Write mode and Play mode.

2. Choose Edit > Requantize to open the MIDI Quantize Options dialog.
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3. Change the quantization settings as appropriate for your selection.

4. Click OK to save your changes and close the dialog.

RESULT
The notated durations of all selected notes are changed according to the quantization options 
you set. This does not affect their played duration in playback.

RELATED LINKS
MIDI Quantize Options dialog on page 68
Resetting playback overrides on page 516

Optimization for MIDI recording
Depending on your operating system and the MIDI devices you use for recording, you might find 
that the notes you record are not notated with the durations or at the rhythmic positions you 
expected. Optimizing the settings related to MIDI recording can help you achieve better results.

Because there can be a time latency between you pressing keys on a MIDI device and the notes 
being picked up by Dorico SE, we recommend that you check the latency by inputting a simple 
rhythm against the click, for example, recording quarter notes in a 4/4 time signature.

Depending on the results, there are different settings you can change:

● If your notes are notated with incorrect durations, such as sixteenth notes notated as eighth 
notes, we recommend that you change your quantization settings in the MIDI Quantize 
Options dialog.

● If your notes are notated ahead of the beat, we recommend that you increase the latency 
compensation value.

● If your notes are notated behind the beat, we recommend that you reduce the buffer size 
for your audio device to the lowest possible value that still produces stable playback with no 
drop-outs.

NOTE

The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

RELATED LINKS
MIDI Quantize Options dialog on page 68
Changing the sustain pedal controller settings for MIDI recording/import on page 208

Changing the MIDI latency compensation value
You can change the MIDI latency compensation value to correct any discrepancy between when 
you press keys during MIDI recording and where the corresponding notes are notated relative to 
the beat.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Play in the category list.

3. In the Recording subsection, change the value for MIDI input latency compensation.
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4. Click Apply, then Close.

RESULT
Increasing the latency compensation value increases the time between pressing the key and the 
note being notated. This is useful if the notes you record were previously notated ahead of the 
beat.

Decreasing the latency compensation value decreases the time between pressing the key and 
the note being notated. This is useful if the notes you record were previously notated behind the 
beat.

Changing the audio device buffer size
You can change the audio buffer size, for example, if the current buffer size is causing notes 
input using MIDI recording appear significantly after the beat.

NOTE

● If the notes you play when recording MIDI are notated behind the beat, we recommend 
that you reduce the buffer size for your audio device to the lowest possible value that still 
produces stable playback with no drop-outs.

● The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

PROCEDURE

1. Choose Edit > Device Setup to open the Device Setup dialog.

2. Select the audio device whose buffer size you want to change from the ASIO Driver menu.

3. Click Device Control Panel to open the device settings dialog for the selected audio device.

4. In the audio device settings dialog, change the buffer size in one of the following ways, as 
appropriate for your operating system:

● For Windows systems, in the Audio buffer size section, either drag the slider to a 
different position or activate User definable and change the value in the Selected 
buffer size field.

● For macOS systems, select a sample rate from the Buffer Size menu.

5. Click OK (Windows)/Close (macOS) to close the audio device settings dialog.

6. Click Close to close the Device Setup dialog.

Changing the sustain pedal controller settings for MIDI recording/
import

You can change your default setting for whether Dorico SE interprets sustain pedal controllers as 
pedal lines when recording MIDI and importing MIDI files.

NOTE

These options are also available in the MIDI Import Options dialog, and your settings are linked 
between this dialog and Preferences.
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PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Play in the category list.

3. In the Recording subsection, activate/deactivate Import CC64 as pedal lines.

4. Optional: If you activated Import CC64 as pedal lines, activate/deactivate Snap pedal lines 
to previous beat.

5. Click Apply, then Close.

RESULT
When Import CC64 as pedal lines is activated, the MIDI controller CC64 is interpreted as pedal 
lines.

When Snap pedal lines to previous beat is activated, the start of pedal lines is automatically 
moved back to the start of the beat.

RELATED LINKS
MIDI Import Options dialog on page 66

Disabling MIDI input devices
By default, Dorico SE accepts MIDI input from all connected MIDI devices, including virtual MIDI 
cables and inter-application buses. You can disable MIDI devices individually, for example, if you 
are using devices that continuously output MIDI data or if you want particular devices to remain 
routed exclusively to another application.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Play in the category list.

3. In the Recording subsection, click MIDI Input Devices to open the MIDI Input Devices 
dialog.

4. Deactivate the checkbox for each MIDI input device you want to disable.

5. Click OK to save your changes and close the dialog.

6. Click Apply, then Close.

Notations input
You can input many types of notations, both during note input and by adding them to existing 
notes. In Dorico SE, “notation” is a broad term that includes many different items, including 
articulations, slurs, dynamics, and more.

Inputting articulations
You can input notes with articulations during note input, and you can add articulations to notes 
after they have been input.

NOTE

These steps describe selecting articulations before inputting notes. However, you can change 
this setting if you prefer to specify articulations after inputting notes.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add articulations.

2. Optional: If you want to input notes with articulations onto multiple staves at once, extend 
the caret to those staves.

3. Select the articulations you want to input in any of the following ways:

● Press the key commands for the articulations you want.

● Click the articulations you want in the Notes panel.

4. Optional: Enter the notes or chords you want with your selected articulations.

RESULT
The selected articulations are added to the selected notes. They are positioned between 
noteheads or stems and tuplet brackets, so they are closer to the notes than tuplet brackets 
or tuplet numbers/ratios.

During note input, the selected articulations are added to all notes that are input until the 
articulations are deactivated.

NOTE

Some combinations of articulations on the same notes are not possible. For example, you cannot 
have both staccato and staccatissimo marks on the same notes, as both articulations indicate 
that notes are played shorter.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments, for example, if you have 
slurs in one voice and staccatos in another voice.

RELATED LINKS
Articulations on page 547
Note input on page 157
Extending the caret to multiple staves on page 161
Enabling independent voice playback on page 460

Key commands for articulations
In addition to clicking them in the Notes panel, you can input common articulations by pressing 
key commands on your computer keyboard.

You can use the following key commands to input articulations with the keyboard:

Type of articulation Key command

Accent:  [

Marcato:  '

Stressed:  {
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Type of articulation Key command

Unstressed:  @ (Windows) or " (macOS)

Staccato:  ]

Tenuto:  # (Windows) or \ (macOS)

Staccatissimo: , , or  }

Combined tenuto and staccato:  ~ (Windows) or | (macOS)

RELATED LINKS
Articulations on page 547

Inputting slurs
You can input slurs, both during note input and by adding them to existing notes. You can also 
add slurs to existing notes on multiple staves at the same time and to notes in different voices 
or on different staves belonging to the same instrument, for example, when phrases span both 
staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add slurs.

TIP

● If you only select a single note, the slur connects that note to the next note in 
the same voice on the staff. To input slurs between notes in different voices, you 
must select both notes, for example, by selecting the first note and then Ctrl/Cmd -
clicking the second.

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff slurs. However, you cannot create 
cross-staff slurs between different instruments.

● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input slurs onto multiple staves at once, extend the caret to those 
staves.

3. Press S .

TIP

Alternatively, click Slur in the Notes panel, and then click and drag to input a slur and extend 
it to your preferred length.

NOTE

If you added slurs to existing notes, stop here.
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4. During note input, input the notes you want.

The slur extends automatically, even if there are rests between the notes you input.

5. During note input, press Shift-S  to end the slur on the currently selected note.

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection.

AFTER COMPLETING THIS TASK

● You can enable independent voice playback for individual instruments, for example, if you 
have slurs in one voice and staccatos in another voice.

● You can change the curvature direction of individual slurs.

RELATED LINKS
Slurs on page 887
Inputting nested slurs on page 896
Inputting notes on page 161
Extending the caret to multiple staves on page 161
Slurs in playback on page 900
Enabling independent voice playback on page 460
Cross-staff and cross-voice slurs on page 895
Changing the curvature direction of slurs on page 894

Inputting fingerings
You can input fingerings on existing notes using the fingerings popover, both during note input 
and by adding them to existing notes.

NOTE

● You can only add fingerings to notes at one rhythmic position at a time, and you can only 
input as many fingerings as there are notes at each rhythmic position. For example, you can 
input three fingerings at the rhythmic position of a chord containing three notes, but only 
one fingering at the rhythmic position of a single note.

● If you select notes in multiple voices, fingerings are only input into the top voice.

● Although they contain two numbers, substitution fingerings are considered one fingering, 
meaning you can add substitution fingerings to single notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing note on a single staff to which you want to add fingering.

If you want to add fingerings to all notes in a chord, select all the notes in the chord.
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2. Optional: During note input, input at least one note.

3. Press Shift-F  to open the fingerings popover.

4. Optional: If you are inputting fingerings for fretted instruments, change the hand in one of 
the following ways:

● To switch to the right hand, press Down Arrow .

● To switch to the left hand, press Up Arrow .

The popover icon updates to show the current hand.

Fingerings popover when inputting right-hand 
fingerings

Fingerings popover when inputting left-hand 
fingerings

5. Enter the fingerings you want into the popover.

For example, enter:

● 3-2 for a substitution fingering from the third finger to the second finger.

● 1,3,5 for a chord.

● 12 to show the first two valves should be depressed on a valved brass instrument.

● p for a right-hand thumb fingering or t for a left-hand thumb fingering.

6. Optional: When adding fingerings to existing notes, move the popover in one of the 
following ways:

● To advance the popover to the next note/chord in the current voice, press Space .

● To move the popover back to the previous note/chord in the current voice, press Shift-
Space .

● To advance the popover to the first note/chord in the current voice in the next bar, press 
Tab .

● To move the popover back to the first note/chord in the current voice in the previous 
bar, press Shift-Tab .

● To move the cursor and popover to the right/left and to the next/previous note/fingering 
in the current voice, press Right Arrow / Left Arrow .

7. Press Return  to close the popover.

RESULT
The fingerings are input on the selected notes, including during note input. The popover 
advances through notes in the voice as indicated by the caret or in the same voice as your 
initial selection.

RELATED LINKS
Fingering on page 660
Changing the rhythmic position of substitution fingerings on page 662
Fingerings for valved brass instruments on page 670
Deleting fingerings on page 665
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Fingerings popover
The following tables contain examples of what you can enter into the fingerings popover to input 
the different types of fingerings available. The fingerings popover behaves differently for fretted 
instruments compared to other instruments, so there is a separate table for fretted instrument 
fingerings.

You can open the fingerings popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-F .

● Choose Write > Create Fingerings.

● Click Fingerings  in the Notations toolbox.

When inputting fingerings for non-fretted instruments, the icon on the left-hand side of the 
popover matches the corresponding button in the Notations toolbox. When inputting fingerings 
for fretted instruments, the icon on the left-hand side of the popover indicates whether you are 
inputting left-hand or right-hand fingerings.

Fingerings popover with an 
example entry for inputting a non-
fretted instrument fingering

Fingerings popover with an 
example entry for a left-hand 
fretted instrument fingering

Fingering button in the Notations 
toolbox

Fingerings popover with an 
example entry for a right-hand 
fretted instrument fingering

Non-fretted instruments

Type of fingering Example popover entry

Single fingerings for individual notes, including 
for brass valve numbers and trombone slide 
positions

1, 2, 3, and so on

Valved brass instruments 12

Single fingerings for each note in chords

For keyboard instruments, Dorico SE 
automatically orders numbers appropriately 
according to the hand playing the notes. The 
default is:

● Right hand for the upper staff

● Left hand for the lower staff

1,3,5

Left-hand fingerings (non-fretted instruments) L2, G2, S5, I2, or H2
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Type of fingering Example popover entry

Right-hand fingerings (non-fretted 
instruments)

R5, D5, or M5

Thumb indicator (non-fretted instruments) T

Multiple fingerings for individual notes, for 
example, for ornaments such as mordents or 
turns

2343

Single fingerings for multiple notes: enter 
the same fingering number for two adjacent 
notes.

For example, in keyboard music the thumb 
may depress two keys simultaneously.

1,1

Alternative fingerings 2(3)

Editorial fingerings [4]

Finger substitutions 1-3

Fretted instruments

Type of fingering Example popover entries

Left-hand fingerings 0, 1, 2, 3, 4, 5

Left-hand thumb t

Right-hand fingerings 1, 2, 3, 4, 5

p, i, m, a, e

Right-hand thumb p, t, or 1

Right-hand pinky finger e, x, c, o, or 5

These lists are not comprehensive as there are many possible fingerings. It is intended to 
illustrate how you can structure your entries to input different types of fingerings.

NOTE

Finger substitutions are shown as immediate by default, but you can change the rhythmic 
position of the substitution by changing the deferral duration.

RELATED LINKS
Fingering on page 660
Changing the rhythmic position of substitution fingerings on page 662
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Fingerings for valved brass instruments on page 670

Input methods for key signatures
You can input key signatures with the keyboard by using the key signatures popover, and with 
the mouse by using the Key Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Key signatures on page 693

Key signatures popover
The table contains the entries for the key signatures popover that you can use to input the 
different key signatures available.

You can open the key signatures popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-K .

● Select an existing key signature and press Return .

● Choose Write > Create Key Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Key signatures popover with an example entry
Key Signatures, Tonality Systems, and Accidentals 
button in the Notations toolbox

Type of key signature Popover entry

Open or atonal key signature open or atonal

Major keys (capital letters) C, D or G#, Ab, and so on

Minor keys (lowercase letters) g, d, f#, bb, and so on

Number of sharps

NOTE

Assumes the major key for that many sharps.

3s, 2#, and so on

Number of flats

NOTE

Assumes the major key for that many flats.

4f, 5b, and so on

This list is not comprehensive as you can input every possible key signature. It is intended to 
illustrate how you can structure your entry to input different types of key signatures.
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RELATED LINKS
Key signatures on page 693

Key Signatures, Tonality Systems, and Accidentals panel
The Key Signatures, Tonality Systems, and Accidentals panel allows you to create and input 
common key signatures.

● You can hide/show the Key Signatures, Tonality Systems, and Accidentals panel by clicking 
Key Signatures, Tonality Systems, and Accidentals  in the Notations toolbox on the right 
of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Key Signatures, Tonality Systems, and Accidentals panel contains the following sections:

Used in This Flow
Contains all the key signatures currently used in the flow.

Key Signatures
Allows you to create key signatures.

The Key Signatures section contains the following parts:

1 Major/Minor

Allow you to choose whether your key signature is Major or Minor.

2 More Sharps/Fewer Flats

Each time you click, you add one sharp accidental to the key signature, or remove 
one flat accidental from the key signature.

3 Fewer Sharps/More Flats

Each time you click, you remove one sharp accidental from the key signature, or 
add one flat accidental to the key signature.

4 Input key signature

Shows how the key signature looks on a staff. Clicking this button inputs the 
displayed key signature. If nothing in the project is selected, the key signature is 
loaded onto the mouse pointer.

Accidentals
Contains all accidentals available in the currently selected tonality system.

RELATED LINKS
Key signatures on page 693
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Inputting key signatures with the popover
You can input key signatures using the key signatures popover, both during note input and by 
adding them to existing music. You can also input key signatures only on single staves.

NOTE

It is not necessary to input different key signatures for transposing instruments, as Dorico SE 
automatically shows the appropriate key signatures for transposing instruments in transposing 
layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input key signatures onto multiple specific staves at once, extend the 
caret to those staves.

3. Press Shift-K  to open the key signatures popover.

4. Enter the key signature you want into the popover.

For example, enter g for G minor or 3s for 3 sharps.

NOTE

Entering 3s creates a key signature of A major, rather than F♯ minor.

5. Input the key signature and close the popover in one of the following ways:

● To input a key signature on all staves, press Return .

● To input a key signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar. However, it is preferable to input key signature changes at barlines.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. If playing in notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines and clefs, and to the left of other 
items, even if this is in the middle of an existing bar. If you selected an existing key signature, the 
new key signature directly replaces the existing one.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Extending the caret to multiple staves on page 161
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Key signatures popover on page 216
Accidental selection during MIDI input on page 187
Key signatures on page 693
Moving key signatures rhythmically on page 697
Transposing instruments on page 104
Making layouts transposing/concert pitch on page 127

Inputting key signatures with the panel
You can input key signatures using the Key Signatures, Tonality Systems, and Accidentals panel, 
both during note input and by adding them to existing music. You can also input key signatures 
only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● It is not necessary to input different key signatures for transposing instruments, as Dorico 
SE automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on a single staff, select an item that belongs to that staff 
only.

2. In the Notations toolbox, click Key Signatures, Tonality Systems, and Accidentals  to 
show the Key Signatures, Tonality Systems, and Accidentals panel.

3. Optional: If you have not already used the key signature you want in the current flow, create 
the key signature you want using the Key Signatures editor in the Key Signatures, Tonality 
Systems, and Accidentals panel.

4. Input the key signature you want in one of the following ways:

● To input a key signature on all staves, click it in the Key Signatures, Tonality Systems, and 
Accidentals panel.

● To input a key signature on the selected staff only, Alt/Opt -click it in the Key Signatures, 
Tonality Systems, and Accidentals panel.

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar. However, it is preferable to input key signature changes at barlines.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. If playing in notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines and clefs, and to the left of other 
items, even if this is in the middle of an existing bar. If you selected an existing key signature, the 
new key signature directly replaces the existing one.
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NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Key signatures on page 693
Key Signatures, Tonality Systems, and Accidentals panel on page 217
Accidental selection during MIDI input on page 187
Moving key signatures rhythmically on page 697
Mouse input settings on page 154
Transposing instruments on page 104
Making layouts transposing/concert pitch on page 127

Input methods for time signatures and pick-up bars
You can input time signatures, including time signatures with pick-up bars, with the keyboard 
by using the time signatures popover, and with the mouse by using the Time Signatures (Meter) 
panel.

NOTE

You can create most types of custom time signatures using the Create Time Signature section 
of the Time Signatures (Meter) panel, but certain time signatures are only possible using the time 
signatures popover. For example, you can only specify beat subdivisions with the time signatures 
popover.

RELATED LINKS
Preferences dialog on page 45
Time signatures on page 949
Types of time signatures on page 951

Time signatures popover
The table contains the entries for the time signatures popover that you can use to input the 
different types of time signatures available.

You can open the time signatures popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-M .

● Select an existing time signature and press Return .

● Choose Write > Create Time Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Time signatures popover with an example entry
Time Signatures (Meter) button in the Notations 
toolbox
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Time signatures

Type of time signature Popover entry

Simple time signatures

For example, 2/4, 6/8, 3/4, 5/4 and so on

2/4, 6/8, 3/4, 5/4, and so on

Alternating time signatures, such as 6/8+3/4 6/8 + 3/4

NOTE

You must include spaces either side of the plus 
sign.

Common time, the equivalent of 4/4 c

Cut common time, the equivalent of 2/2 cutc or ¢

Open meter indicated by X X or x

Open meter with no indication

NOTE

A time signature signpost is shown at the 
position of the open meter.

open

Additive time signature with explicit beat 
grouping

3+2+2/8, 3+2/4, and so on

Beat grouping specified but not shown in the 
time signature

For example, a time signature of 7/8 is shown 
but beams are subdivided into 2+3+2 eighth 
notes.

[2+3+2]/8

Aggregate time signature with dashed barlines 
shown in each bar, indicating the divisions 
between the different meters

2/4|6/8

Aggregate time signature without dashed 
barlines shown in each bar

2/4:6/8

Interchangeable time signature with different 
styles: parenthesized, slash, equals sign, and 
dashed

2/4 (6/8), 2/4 / 6/8, 2/4 = 6/8, or 2/4 – 6/8

NOTE

You must include spaces either side of the 
slashes, equals signs, or dashes, and before 
opening parentheses.
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Pick-up bars

Example time signature with pick-up bar Popover entry

4/4 time signature with a dotted quarter note 
pick-up

4/4,1.5

6/8 time signature with a pick-up of two eighth 
notes

6/8,2

2/2 time signature with a quarter note pick-up 2/2,0.5

TIP

The number after the comma indicates multiples of the rhythmic unit specified by the 
denominator of the time signature.

These lists are not comprehensive, as there are many possible time signatures and pick-up 
bars. They are intended to illustrate how you can structure your entry to input different time 
signatures and pick-up bars.

RELATED LINKS
Time signatures on page 949
Types of time signatures on page 951
Inputting time signatures with the popover on page 224
Inputting pick-up bars with the popover on page 226
Creating custom beat groupings for meters on page 590

Time Signatures (Meter) panel
The Time Signatures (Meter) panel allows you to input different time signatures. In the Create 
Time Signature section of the panel, you can create uncommon time signatures.

● You can hide/show the Time Signatures (Meter) panel by clicking Time Signatures (Meter) 
 in the Notations toolbox on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Time Signatures (Meter) panel contains the following sections:

Used in This Flow
Contains any time signatures already used in the current flow.

Common
Contains common time signatures, such as 4/4, 3/4, 6/8, and 7/8.

Create Time Signature
Allows you to design your own time signatures, including alternating time signatures 
and aggregate time signatures.

Write mode
Notations input 

222
Dorico SE 3.5.12



The Create Time Signature section contains the following parts:

1 Time signature type menu

Allows you to select one of the following types of time signatures:

● Regular

● Additive

● Interchangeable

● Aggregate

● Alternating

2 Time signature spaces

Allows you to combine up to four time signatures. For example, you can specify 
only one time signature for a regular time signature, but for an alternating time 
signature, you might want to include three time signatures.

3 Pick-up bar of

Allows you to include a pick-up bar before the time signature. A pick-up bar is 
not a complete bar, and so allows you to include only a few beats before the first 
complete bar.

You can select one of the following options for the number of beats in a pick-up 
bar:

● 1/2 beat

● 1 beat

● 2 beats

● 3 beats

4 Input time signature button

Click the button that displays the time signature to input it. If nothing in the project 
is selected, the time signature is loaded onto the mouse pointer.

RELATED LINKS
Time signatures on page 949
Inputting time signatures with the panel on page 225
Inputting pick-up bars with the panel on page 227
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Inputting time signatures with the popover
You can input time signatures using the time signatures popover, both during note input and by 
adding them to existing music. You can also input time signatures only on single staves.

NOTE

Dorico SE does not automatically add beats to fill bars according to the new time signature at the 
end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input time signatures onto multiple specific staves at once, extend 
the caret to those staves.

3. Optional: If you want Dorico SE to add beats at the end of the region affected by the new 
time signature if required, press I  to activate Insert mode.

4. Press Shift-M  to open the time signatures popover.

5. Enter the time signature you want into the popover.

For example, enter 4/4 for a 4/4 time signature or [2+2+3]/8 for a 7/8 time signature with a 
custom beat grouping.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, time signatures are added at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines, key signatures, and clefs, and to the 
left of other items, even if this is in the middle of an existing bar. If you selected an existing time 
signature, the new time signature directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly.

RELATED LINKS
Time signatures popover on page 220
Extending the caret to multiple staves on page 161
Time signatures on page 949
Pick-up bars on page 953
Time signature styles on page 956
Changing the separator style of interchangeable time signatures on page 958
Inputting pick-up bars with the popover on page 226
Inputting notes in Insert mode on page 178
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Inputting barlines with the popover on page 240

Inputting time signatures with the panel
You can input time signatures using the Time Signatures (Meter) panel, both during note input 
and by adding them to existing music. You can also input time signatures only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico SE does not automatically add beats to fill bars according to the new time signature at 
the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want Dorico SE to add beats at the end of the region affected by the new 
time signature if required, press I  to activate Insert mode.

3. In the Notations toolbox, click Time Signatures (Meter)  to show the Time Signatures 
(Meter) panel.

4. Optional: If you want to input a time signature that is not available in the Used in This Flow 
or Common sections, select the type of time signature you want to input from the menu in 
the Create Time Signature section.

5. Optional: Enter the time signature(s) you want into the available space(s).

6. Input the time signature you want in one of the following ways:

● To input a time signature on all staves, click it in the Time Signatures (Meter) panel.

● To input a time signature on the selected staff only, Alt/Opt -click it in the Time 
Signatures (Meter) panel.

RESULT
During note input, time signatures are added at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines, key signatures, and clefs, and to the 
left of other items, even if this is in the middle of an existing bar. If you selected an existing time 
signature, the new time signature directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly.

RELATED LINKS
Time Signatures (Meter) panel on page 222
Mouse input settings on page 154
Time signatures on page 949
Pick-up bars on page 953
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Time signature styles on page 956
Changing the separator style of interchangeable time signatures on page 958
Inputting pick-up bars with the panel on page 227
Inputting barlines with the panel on page 242
Inputting notes in Insert mode on page 178

Inputting pick-up bars with the popover
You can input pick-up bars as part of time signatures using the time signatures popover, both 
during note input and by adding them to existing music. You can also input time signatures with 
pick-up bars only on single staves.

NOTE

Dorico SE does not automatically add beats to fill bars according to the new time signature at the 
end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input a pick-up bar onto multiple specific staves at once, extend the 
caret to those staves.

3. Optional: If you want Dorico SE to add beats at the end of the region affected by the pick-up 
bar if required, press I  to activate Insert mode.

4. Press Shift-M  to open the time signatures popover.

5. Enter the time signature and the number of pick-up beats you want into the popover.

For example, enter 3/4,0.75 for a 3/4 time signature with a dotted eighth note (dotted 
quaver) upbeat or 4/4,1 for a 4/4 time signature with one quarter note upbeat. The number 
after the comma indicates multiples of the rhythmic unit specified by the denominator of the 
time signature.

6. Input the pick-up bar and close the popover in one of the following ways:

● To input a pick-up bar on all staves, press Return .

● To input a pick-up bar only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. They appear to the right of barlines, 
key signatures, and clefs, and to the left of other items, even if this is in the middle of an existing 
bar. If you selected an existing time signature, the new time signature with pick-up bar directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly.
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NOTE

Dorico SE does not automatically insert beats at the start of existing music to which you add time 
signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that flow now begins 
in the pick-up bar, not in the first full bar. You can insert beats at the start to push existing music 
to later rhythmic positions.

RELATED LINKS
Time signatures popover on page 220
Pick-up bars on page 953
Defining partial bars as pick-up bars or irregular bars on page 953
Inputting time signatures with the popover on page 224
Inputting bars/beats with the popover on page 238
Inputting bars/beats with the system track on page 240
Inputting barlines with the popover on page 240
Rhythmic position on page 20
Inputting notes in Insert mode on page 178

Inputting pick-up bars with the panel
You can input pick-up bars as part of time signatures using the Time Signatures (Meter) panel, 
both during note input and by adding them to existing music. You can also input time signatures 
only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico SE does not automatically add beats to fill bars according to the new time signature at 
the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want Dorico SE to add beats at the end of the region affected by the pick-up 
bar if required, press I  to activate Insert mode.

3. In the Notations toolbox, click Time Signatures (Meter)  to show the Time Signatures 
(Meter) panel.

4. In the Create Time Signature section, select the type of time signature you want from the 
menu.

5. Enter the time signature(s) you want into the available space(s).

6. Activate Pick-up bar of section and select one of the following options:

● 1/2 beat

● 1 beat

● 2 beats

● 3 beats
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NOTE

Not all pick-up bar lengths are possible when using the panel. For example, you cannot 
produce a single eighth note upbeat in 6/8 with the available options. In such cases, you 
must use the time signatures popover.

7. Input the pick-up bar in one of the following ways:

● To input a pick-up bar on all staves, click the input time signature button in the Create 
Time Signature section.

● To input a pick-up bar on the selected staff only, Alt/Opt -click the input time signature 
button in the Create Time Signature section.

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. They appear to the right of barlines, 
key signatures, and clefs, and to the left of other items, even if this is in the middle of an existing 
bar. If you selected an existing time signature, the new time signature with pick-up bar directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly.

NOTE

Dorico SE does not automatically insert beats at the start of existing music to which you add time 
signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that flow now begins 
in the pick-up bar, not in the first full bar. You can insert beats at the start to push existing music 
to later rhythmic positions.

RELATED LINKS
Time Signatures (Meter) panel on page 222
Pick-up bars on page 953
Inputting pick-up bars with the popover on page 226
Defining partial bars as pick-up bars or irregular bars on page 953
Inputting bars/beats with the popover on page 238
Inputting bars/beats with the system track on page 240
Inputting barlines with the panel on page 242
Rhythmic position on page 20
Inputting notes in Insert mode on page 178

Input methods for tempo marks
You can input tempo marks with the keyboard by using the tempo popover, with the mouse 
by using the Tempo panel, and in the Time track in Play mode. You can input a tempo mark 
containing just a text instruction, just a metronome mark, or a combination of the two.

RELATED LINKS
Tempo marks on page 926
Time track on page 447
Inputting tempo changes in the Time track on page 449
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Tempo popover
The following tables contain examples of what you can enter into the tempo popover to input 
tempo marks, tempo equations, and rhythmic feels for swing playback.

When you start entering a tempo into the tempo popover, a menu appears with suggestions 
containing the letters/words you enter. You can select one of these suggestions to input, or enter 
your own tempo into the popover.

You can open the tempo popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-T .

● Select an existing tempo mark and press Return .

● Choose Write > Create Tempo.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Tempo popover with an example entry

Tempo button in the Notations toolbox

Tempo marks

Example tempo mark Popover entry

Adagio Adagio

Presto  = 176 Presto q = 176 or Presto q=176

Largo ( = 52) Largo (q = 52) or Largo (q=52)

 = 96-112 q = 96-112, q=96-112, 6 = 96-112, or 6=96-112

  = 84 q. = 84, q.=84, 6. = 84, or 6.=84

 = 60 h = 60, h=60, 7 = 60, or 7=60

 = 120 e = 120, e=120, 5 = 120, or 5=120

rit. rit. or rit

ritardando ritardando

accel. accel. or accel

accelerando accelerando
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Example tempo mark Popover entry

più più or piu

meno meno

Faster, with energy Faster, with energy

This list is not comprehensive as you can enter tempos freely and there are many possible 
metronome marks, tempo marks, and tempo equations. It is intended to illustrate how you can 
structure your entry to input different types of tempo marks and metronome marks.

NOTE

The tempo popover is case-sensitive. If you want your tempo mark to start with a capital letter, 
you must enter a capital letter into the popover.

Metronome mark beat units

Metronome mark beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

Tempo equations

Example tempo equation Popover entry

 =   e = e., e=e., 5 = 5., or 5=5.

 =  q = e, q=e, 6 = 5, or 6=5
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Rhythmic feels for swing playback

Rhythmic feel Popover entry

Light 16th note swing rhythmic feel light swing 16ths

Light eighth note swing rhythmic feel light swing 8ths

Medium 16th note swing rhythmic feel medium swing 16ths

Medium eighth note swing rhythmic feel medium swing 8ths

Heavy 16th note swing rhythmic feel heavy swing 16ths

Heavy eighth note swing rhythmic feel heavy swing 8ths

Straight rhythmic feel straight (no swing)

Triplet 16th fixed rhythmic feel 2:1 swing 16ths (fixed)

Triplet 8th fixed rhythmic feel 2:1 swing 8ths (fixed)

Dotted 16th-32nd fixed rhythmic feel 3:1 swing 16ths (fixed)

Dotted 8th-16th fixed rhythmic feel 3:1 swing 8ths (fixed)

RELATED LINKS
Tempo marks on page 926
Types of tempo marks on page 927
Swing playback on page 466
Enabling swing playback on page 467

Tempo panel
The Tempo panel contains the different types of tempo marks available in Dorico SE, organized 
into sections. It is located on the right of the window in Write mode.

● You can hide/show the Tempo panel by clicking Tempo  in the Notations toolbox on the 
right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

Used in This Flow
Contains any tempo marks already used in the flow, including custom tempo marks 
added using the tempo popover.

Tap Tempo
Allows you to create an absolute tempo change based on the speed with which you 
click the Tap button. It appears as a metronome mark with no text by default. The 
metronome mark value is always rounded to the nearest integer.

You can use the available options to set the beat unit on which you want to base the 
tempo.
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Absolute Tempo Change
Contains a range of tempos with both an Italian tempo indication and a metronome 
mark. You can later choose to show or hide the metronome mark for individual tempo 
marks.

You can change the range shown in the list by adjusting the slider at the top.

Gradual Tempo Change
Contains tempo marks that indicate a change in tempo over a defined period of time, 
such as rallentando or accelerando.

You can add modifiers to gradual tempo changes. Available modifiers are shown at the 
top of the section.

Relative Tempo Change
Contains tempo marks that indicate a change in tempo that is relative to the previous 
tempo, such as mosso (movement, or with movement). They often include modifiers 
that qualify the change, such as poco meno mosso (a little less movement), and are not 
defined by a metronome mark.

You can add modifiers to relative tempo changes. Available modifiers are shown at the 
top of the section.

You can later set a relative metronome mark change as a percentage of the previous 
metronome mark for individual tempo marks.

Reset Tempo
Contains tempo marks that indicate a return to the previous tempo, such as A tempo, 
or a previously defined tempo, such as Tempo primo.

Tempo Equation
Allows you to input a tempo equation, using beat units from 16th notes to whole notes 
and up to two rhythm dots.
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RELATED LINKS
Tempo marks on page 926
Types of tempo marks on page 927
Changing the metronome mark value on page 933

Inputting tempo marks with the popover
You can input tempo marks using the tempo popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span that 
duration.

2. Press Shift-T  to open the tempo popover.

3. Enter the tempo you want into the popover.

For example, enter q=72 or Allegretto.

When you start entering a tempo into the tempo popover, a menu appears that shows 
suggested tempos containing the letters/words you enter. You can select one of these 
suggestions or you can enter your own tempo into the popover.

NOTE

If you want to show gradual tempo changes separated into syllables spread across their 
duration, such as rit-e-nu-to, we recommend selecting a suggested entry from the menu. 
Only gradual tempo changes with valid full text appear separated into syllables.

4. Press Return  to close the popover.
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RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

NOTE

Metronome mark values appear as integers without decimal places, even if you input decimal 
places. However, the exact metronome mark value you input is always reflected in playback.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Tempo marks on page 926
Time track on page 447
Tempo mark components on page 927
Gradual tempo changes on page 935
Metronome marks on page 932
Lengthening/Shortening gradual tempo changes on page 935
Changing the style of gradual tempo changes on page 936

Inputting tempo marks with the panel
You can input tempo marks using the Tempo panel, both during note input and by adding them 
to existing music.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● You cannot specify decimal places for metronome marks using the panel. You can specify 
decimal places using the popover or by changing the metronome mark value of existing 
tempo marks.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span that 
duration.

2. In the Notations toolbox, click Tempo  to show the Tempo panel.

3. In the Tempo panel, click the tempo mark you want.

TIP

If you want Dorico SE to calculate the metronome mark for you, you can click Tap in the Tap 
Tempo section multiple times at the required speed.

4. Optional: Select a modifier from the available options.
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NOTE

You can only add modifiers to a Gradual Tempo Change or a Relative Tempo Change.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Tempo marks on page 926
Lengthening/Shortening gradual tempo changes on page 935
Mouse input settings on page 154
Changing the metronome mark value on page 933
Changing the style of gradual tempo changes on page 936

Input methods for bars, beats, and barlines
You can input both bars and barlines with the keyboard by using the bars and barlines popover, 
and also with the mouse by using the available options in the Bars and Barlines panel. The bars 
and barlines popover also allows you to input beats. Additionally, you can input bars and beats 
using the system track.

Normally you do not need to create bars in Dorico SE, as they are created automatically as 
needed when you input music. However, you can add bars in advance if, for example, you are 
copying or arranging an existing piece of music.

RELATED LINKS
Bars on page 553
Barlines on page 558
System track on page 337
Inputting bar rests into specific voices on page 188
Repeats in playback on page 464

Bars and barlines popover
The following tables contain examples of what you can enter into the bars and barlines popover 
to add and delete bars and beats, and the entries you can use to input the different barlines 
available.

You can open the bars and barlines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-B .

● Choose Write > Create Bar or Barline.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.
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Bars and barlines popover with an 
example entry for inputting bars

Bars and barlines popover with an 
example entry for a barline

Bars and Barlines button in the 
Notations toolbox

Bars

Example action Popover entry

Add two bars 2 or +2

Add fourteen bars 14 or +14

Delete one bar –1

Delete six bars –6

Add a bar rest rest

Delete empty bars at the end of the flow trim

This list is not comprehensive, as you can add and delete any number of bars using the popover. 
This table is intended to illustrate how you can structure your entry to input and delete bars, and 
input bar rests.

Beats

You can specify a number of beats that you want to add/delete by entering the number of beats 
you want followed by either the number that corresponds to the beat unit, such as 5 for eighth 
notes, or the letter that corresponds to the beat unit, such as h for half notes. When using 
numbers for both the number of beats and the beat unit, you must separate them with a space 
or hyphen. You can also specify beats in the form of a time signature, such as 3/4 for three 
quarter note beats.

Example action Popover entry

Add one whole note beat 1w, 1-8, 1 8, or 4/4

Add two quarter note beats 2q, 2-6, 2 6, or 2/4

Add four eighth note beats 4e, 4-5, 4 5, 4/8, or 2/4

Delete two quarter note beats –2q, -2-6, -2 6, or -2/4

This list is not comprehensive, as you can add and delete any number of beats using the 
popover. This table is intended to illustrate how you can structure your entry to input and delete 
beats.
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Beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

Barlines

Type of barline Popover entry

Normal (Single) |, single, or normal

Double || or double

Final |] or final

Triple triple

Start repeat |: or start

End repeat :| or end

End/Start repeat :|:, :||:, end-start, or endstart

RELATED LINKS
Inputting bar rests into specific voices on page 188
Bars on page 553
Barlines on page 558
Deleting bars/beats on page 553
Repeats in playback on page 464
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Bars and Barlines panel
The Bars and Barlines panel allows you to input bars, bar rests, and different types of barlines. It 
is located on the right of the window in Write mode.

● You can hide/show the Bars and Barlines panel by clicking Bars and Barlines  in the 
Notations toolbox on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Bars and Barlines panel contains the following sections:

Insert Bars
Allows you to determine how many bars you want to insert and where to insert them, 
such as at the end of the flow.

Insert Bar Rest
Allows you to insert a bar rest.

Create Barline
Contains the different barlines you can input.

RELATED LINKS
Repeats in playback on page 464
Hiding/Showing panels on page 37

Inputting bars/beats with the popover
You can input bars/beats using the bars and barlines popover, both during note input and by 
adding them to or inserting them into existing music.

PREREQUISITE
If you want to input bars, you have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to add bars/beats. If you want to 
add bars/beats to a single staff, select an item that belongs to that staff only.

Bars/Beats are added after selected barlines and before other selected items, including 
time signatures.

2. Optional: If you want to input bars/beats onto multiple specific staves at once, extend the 
caret to those staves.

3. Press Shift-B  to open the bars and barlines popover.

4. Enter the number of bars/beats you want to input.

For example, enter 2 to input two bars or 2q to input two quarter note beats.

5. Input the bars/beats and close the popover in one of the following ways:

● To input bars/beats for all staves, press Return .

● To input bars/beats only on the selected staff or staves across which the caret extends, 
press Alt/Opt-Return .
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RESULT
The number of bars or beats specified is input.

During note input, bars/beats are input from the caret position. If the caret is in the middle of 
the bar when inputting bars, sufficient beats are added to ensure that the final bar created has 
the correct number of beats. The caret position stays at its previous position so you can continue 
inputting music from the same position.

When you add bars/beats to existing music, they are added after selected barlines and before 
other selected items, including time signatures.

TIP

Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 time 
signature, and pressing Space  repeatedly during note input.

RELATED LINKS
Bars and barlines popover on page 235
Bars on page 553
Inputting time signatures with the popover on page 224

Inputting bars with the panel
You can input bars using the Bars and Barlines panel, both during note input and by adding 
them to existing music.

PREREQUISITE
You have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing barline after which you want to input bars.

● Select an existing item before which you want to input bars.

2. In the Notations toolbox, click Bars and Barlines  to show the Bars and Barlines panel.

3. In the Insert Bars section of the Bars and Barlines panel, change the number of bars you 
want to input by changing the value in the value field.

4. Select one of the following options for where you want to input bars:

● Start of Flow: Bars are input at the beginning of the flow.

● Start of Selection: Bars are input from the selected note or rest.

● End of Flow: Bars are input at the end of the flow.

NOTE

If you want to input bars from the caret position, make sure that you have selected Start 
of Selection from the menu.

5. Click Insert Bars.

RESULT
The number of bars specified is input. During note input, bars are input from the caret position.
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If you selected Start of Selection, bars are input directly after a selected barline, and directly 
before a selected note, bar, or time signature.

TIP

Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 time 
signature, and pressing Space  repeatedly during note input.

RELATED LINKS
Bars on page 553
Inputting time signatures with the panel on page 225

Inputting bars/beats with the system track
You can add bars/beats within existing music, for example, if you decide you want to repeat 
several bars before the next section. You can add whole bars and you can add just a few beats.

NOTE

You cannot use the system track during note input.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track, select the region whose duration you want to insert.

For example, if you want to insert two bars, select two bars in the system track immediately 
before where you want the two new bars to be input.

2. Click Add above the system track.

Add button above the system track The Add button is highlighted when you hover 
over it

RESULT
The rhythmic duration selected in the system track is added immediately after the end of the 
selection. Existing music after the selection is pushed back after the inserted bars/beats.

RELATED LINKS
System track on page 337

Inputting barlines with the popover
You can input barlines using the bars and barlines popover, both during note input and by 
adding them to existing music. You can also change the type of existing barlines.

PREREQUISITE
If you want to input barlines onto single staves only, you have input an independent time 
signature on those staves.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on a single staff, select an item that belongs to that staff only.

2. Optional: If you want to input barlines onto multiple specific staves at once, extend the caret 
to those staves.

3. Press Shift-B  to open the bars and barlines popover.

4. Enter the barline you want into the popover.

For example, enter || for a double barline.

5. Input the barline and close the popover in one of the following ways:

● To input a barline on all staves, press Return .

● To input a barline only on the selected staff or staves across which the caret extends, 
press Alt/Opt-Return .

NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. They appear to the right of clefs and to the left of other items. If you selected an 
existing barline, the new barline directly replaces the existing one.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

RELATED LINKS
Bars and barlines popover on page 235
Barlines on page 558
Inputting notes on page 161
Inputting time signatures with the popover on page 224
Extending the caret to multiple staves on page 161
Deleting barlines on page 560
Repeats in playback on page 464
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Inputting barlines with the panel
You can input barlines using the Bars and Barlines panel, both during note input and by adding 
them to existing music. You can also change the type of existing barlines.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PREREQUISITE
If you want to input barlines onto single staves only, you have input an independent time 
signature on those staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on a single staff, select an item that belongs to that staff only.

2. In the Notations toolbox, click Bars and Barlines  to show the Bars and Barlines panel.

3. Input the barline you want in one of the following ways:

● To input a barline on all staves, click it in the Create Barline section.

● To input a barline on the selected staff only, Alt/Opt -click it in the Create Barline 
section.

NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. They appear to the right of clefs and to the left of other items. If you selected an 
existing barline, the new barline directly replaces the existing one.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

RELATED LINKS
Barlines on page 558
Bars and barlines popover on page 235
Inputting notes on page 161
Inputting time signatures with the panel on page 225
Mouse input settings on page 154
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Repeats in playback on page 464

Input methods for dynamics
You can input dynamics with the keyboard by using the dynamics popover, and with the mouse 
by using the Dynamics panel.

RELATED LINKS
Dynamics on page 628
Inputting dynamics with the popover on page 245
Inputting dynamics with the panel on page 247
Niente hairpins on page 637
Adding modifiers to existing dynamics on page 639

Dynamics popover
The table contains examples of what you can enter into the dynamics popover to input the 
different dynamics available.

You can open the dynamics popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-D .

● Select an existing dynamic and press Return .

● Choose Write > Create Dynamic.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Dynamics popover with an example entry
Dynamics button in the Notations toolbox

Dynamics popover entries

Dynamic or modifier Popover entry

pianissimo:  pp

piano:  p

mezzo piano:  mp

mezzo forte:  mf

forte:  f

fortissimo:  ff

subito subito, sub, or sub.
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Dynamic or modifier Popover entry

possibile possibile, poss, or poss.

poco poco

molto molto

più piu or più

meno meno

mosso mosso

crescendo:  <

cresc. (text) cresc

diminuendo:  >

dim. (text) dim

crescendo then diminuendo messa di voce:  <>

diminuendo then crescendo messa di voce:  ><

niente hairpins that start/end with a small circle o< or >o

niente hairpins that start/end with the letter “n” n< or >n

sforzando:  sfz

rinforzando:  rfz

This list is not comprehensive as you can enter anything as a dynamic modifier. It is intended to 
illustrate how you can structure your entry to input different types of dynamics.

TIP

You can input hairpins directly into the score without the popover by pressing <  for a crescendo 
hairpin and >  for a diminuendo hairpin.

You can also change the appearance of individual gradual dynamics after they have been input.

Inputting modifiers into the dynamics popover

You can enter modifiers into the dynamics popover, such as poco, molto, subito, espressivo, or 
dolce. It appears in the correct italic font beside the dynamic. However, you must also enter 
an accompanying immediate dynamic, such as p or f, and separate the two with a space, for 
example, f molto or p espressivo.

You can hide immediate dynamics if you only want to show the modifier.
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RELATED LINKS
Dynamics on page 628
Dynamic modifiers on page 639
Niente hairpins on page 637
Hiding/Showing immediate dynamics on page 634
Changing the appearance of gradual dynamics on page 643

Dynamics panel
The Dynamics panel contains the different dynamics available in Dorico SE, including gradual 
dynamics and dynamic modifiers, such as poco and possibile.

● You can hide/show the Dynamics panel by clicking Dynamics  in the Notations toolbox on 
the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Dynamics panel contains the following sections:

Immediate Dynamics
Contains dynamics such as  and , and modifiers, such as subito and possibile. 
Available modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

Gradual Dynamics
Contains dynamics such as  and , and modifiers, such as poco and niente. Available 
modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

Force/Intensity of Attack
Contains dynamics such as  and .

Combined Dynamics
Allows you to create custom combinations of dynamics, such as . The controls 
allow you to increase and decrease the dynamic on each side, and to swap their order.

Inputting dynamics with the popover
You can input dynamics and modifiers using the dynamics popover, both during note input 
and by adding them to existing notes. You can also input different dynamics into each voice 
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independently in multiple-voice contexts, for example, to give the separate staves of grand staff 
instruments different dynamics.

TIP

You can also change dynamics during note input by following these steps when the caret is at the 
rhythmic position of the dynamic you want to change.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on the staff and at the rhythmic position where you want to input 
dynamics. If you want to input dynamics across a duration, select items on the staff 
that span that duration.

2. Optional: If you want to input dynamics onto multiple staves at once, extend the caret to 
those staves.

3. Press Shift-D  to open the dynamics popover.

4. Enter the dynamic you want into the popover.

For example, p, p<f>p, or f>.

5. Input the dynamics and close the popover in one of the following ways:

● To input the dynamics for all voices/staves belonging to the instrument, press Return .

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by pressing Alt/Opt-Return .

6. Optional: During note input, press Space  to advance the caret and extend open-ended 
gradual dynamics, such as p<.

Open-ended gradual dynamics also extend automatically as you continue inputting notes.

7. Optional: During note input, stop open-ended dynamics by pressing ?  or by opening the 
dynamics popover again and inputting another immediate dynamic, such as f.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments. Voice-
specific dynamics are placed below the staff by default, even if they are input into an up-stem 
voice.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing notes.

During note input, dynamics are input at the caret position, and extend automatically if 
you included an open-ended gradual dynamic. Voice-specific dynamics are input in the voice 
indicated by the quarter note symbol beside the caret.

When you add dynamics to existing notes, immediate dynamics are added to the first note in the 
selection while gradual dynamics are added across the selection.
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NOTE

● If you entered a dynamic phrase into the popover during note input, such as p<f>p, each 
dynamic and hairpin lasts a quarter note (crotchet) by default. You can lengthen/shorten 
gradual dynamics and groups of dynamics later.

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Extending the caret to multiple staves on page 161
Dynamics on page 628
Dynamics lanes on page 429
Gradual dynamics on page 641
Groups of dynamics on page 647
Voice-specific dynamics on page 637
Dynamic modifiers on page 639
Changing the appearance/position of subito modifiers on page 640
Hiding/Showing combined dynamic separators on page 634
Changing dynamic levels on page 633
Moving dynamics rhythmically on page 631
Lengthening/Shortening gradual dynamics and groups of dynamics on page 642
Hiding/Showing immediate dynamics on page 634
Changing the staff-relative placement of items on page 343

Inputting dynamics with the panel
You can input dynamics and modifiers using the Dynamics panel, both during note input 
and by adding them to existing notes. You can also input different dynamics into each voice 
independently in multiple-voice contexts, for example, to give the separate staves of grand staff 
instruments different dynamics.

NOTE

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.
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● Select an item on the staff and at the rhythmic position where you want to input 
dynamics. If you want to input dynamics across a duration, select items on the staff 
that span that duration.

2. In the Notations toolbox, click Dynamics  to show the Dynamics panel.

3. Input the dynamics you want in one of the following ways:

● To input dynamics for all voices/staves belonging to the instrument, click them in the 
Dynamics panel.

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by Alt -clicking them in the Dynamics panel.

NOTE

● If you want to add expressive or qualifying text to the dynamics, do not deselect them.

● When inputting voice-specific dynamics, you can release Alt  once you have input the 
dynamic level, such as .

● Gradual dynamics have a default duration of a quarter note. You can lengthen/shorten 
gradual dynamics later.

4. Optional: In the Dynamics panel, click the expressive/qualifying texts you want in the 
Immediate Dynamics and Gradual Dynamics sections.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments. Voice-
specific dynamics are placed below the staff by default, even if they are input into an up-stem 
voice.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing notes.

During note input, dynamics are input at the caret position. Voice-specific dynamics are input in 
the voice indicated by the quarter note symbol beside the caret.

When you add dynamics to existing notes, immediate dynamics are added to the first note in the 
selection while gradual dynamics are added across the selection.

NOTE

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● You can also input gradual dynamics by clicking the gradual dynamic you want in the 
Dynamics panel when nothing is selected in the music area. Then click and drag to input 
the gradual dynamic and extend it to the length you want.

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Dynamics on page 628
Changing the appearance of sforzando/rinforzando dynamics on page 635
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Hiding/Showing combined dynamic separators on page 634
Changing dynamic levels on page 633
Hiding/Showing immediate dynamics on page 634
Mouse input settings on page 154

Input methods for chord symbols
You can input chord symbols in Dorico SE with the computer keyboard and any connected MIDI 
keyboard.

RELATED LINKS
Chord symbols on page 598
Inputting chord symbols on page 253
Navigation during chord symbol input on page 252

Chord symbols popover
The following tables contain examples of what you can enter into the chord symbols popover to 
input the different possible chord symbol components. You can enter them in any combination.

You can open the chord symbols popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-Q .

● Select an existing chord symbol and press Return .

● Choose Write > Create Chord Symbol.

● Click Chord Symbols  in the Notations toolbox.

When inputting global chord symbols, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local chord symbols, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a solo player.

Chord symbols popover with an 
example entry for a global chord 
symbol

Chord symbols popover with an 
example entry for a local chord 
symbol

Chord Symbols button in the 
Notations toolbox

NOTE

You can combine multiple types of entries to create more complex chord symbols if you enter 
them one after another into the chord symbols popover without spaces between them. For 
example, enter Eblocrian for the following chord symbol:
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Chord symbol roots

Type of chord symbol root Popover entry

English note names

C, D♭, F♯, B, and so on

C, Db, F#, B, and so on

German note names

C, D♭, F♯, H, and so on

C, Des, Fis, H, and so on

Fixed-do solfège

C, D♭, F, F♯, B, and so on

do, reb, fa, fa#, ti, and so on

Nashville numbers representing scale degrees

Assuming C major:

C, D♭, F♯, B, and so on

1, 2b, 4#, 7, and so on

Chord symbol qualities

Chord symbol quality Popover entry

Major maj, M, ma, or nothing after entering the root.

Minor m, min, or mi

Diminished dim, di, or o

Augmented aug, au, ag, or +

Half-diminished half-dim, halfdim, or hd

6/9 6/9, 69, or %

Chord symbol intervals

Interval Popover entry

Major 7th ^7 or ^

Major 9th ^9, maj9, or 9maj7
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Chord symbol alterations

Type of chord symbol alteration Popover entry

Alterations b5, -5, #9, +9, and so on

Added notes add#11, add+11, addb9, add-9, addF#, 
addBb, and so on

Suspensions sus4, sus9, and so on

Omissions omit3, no7, and so on

Chord symbols with altered bass notes

Example altered bass note chord symbols Popover entry

G7/D G7,D or Gmaj7,D

C(♭5)/E♭ CMb5/Eb or Cmajb5/Eb

Fm/D♯ Fm/D# or Fmi/D#

Polychord chord symbols

Example polychord chord symbols Popover entry

G/E G;E or Gmaj;E

Cmaj7/D CM7|D or Cmaj7|D

Fm/D♯ Fm|D# Fmi|D#

No chord symbols

No chord symbol Popover entry

No chord N.C., NC, no chord, or none

Modal chord symbols

Modal chord symbol Popover entry

Ionian ionian
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Modal chord symbol Popover entry

Dorian dorian

Phrygian phrygian

Lydian lydian

Mixolydian mixolydian

Aeolian aeolian

Locrian locrian

Melodic minor melodicminor

Harmonic minor harmonicminor

Whole tone wholetone

Octatonic or diminished half-whole diminishedhalfwhole, 
diminishedsemitonetone, 
octatonichalfwhole, or 
octatonicsemitonetone

Octatonic or diminished whole-half diminishedwholehalf, 
diminishedtonesemitone, 
octatonicwholehalf, or 
octatonictonesemitone

This list is not comprehensive, as there are many possible chord symbols. It is intended to 
illustrate the different components you can use to input different chord symbols.

NOTE

The appearance of the resulting chord symbols is determined by Dorico SE’s default settings. The 
structure of your entry in the chord symbols popover is not considered. For example, entering a 
C major chord as C, Cmaj, or CM results in the same chord symbol.

RELATED LINKS
Chord symbols on page 598

Navigation during chord symbol input

You can input multiple chord symbols without re-opening the popover each time by manually 
advancing it to other positions.

Navigating with a computer keyboard

You can move the chord symbols popover to input chord symbols on other notes without having 
to close and reopen the popover on each note.
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Popover navigation Key command

Advance the popover to the next beat. Space

Move the popover back to the previous beat. Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note

● Next/Previous rest

● Next/Previous rhythmic grid position

Right Arrow / Left Arrow

Move the popover to the next/previous chord 
symbol.

Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

Navigating with a MIDI keyboard

When inputting chord symbols using a MIDI keyboard, by default the popover advances 
automatically to the next beat after you play a chord.

You can define specific keys or buttons on your MIDI keyboard to trigger different navigation 
behaviors. Use the MIDI Learn button on the Key Commands page in Preferences to assign 
specific keys to the Note Input > Advance Chord Symbol Input commands.

RELATED LINKS
Key Commands page in the Preferences dialog on page 47
Assigning MIDI commands on page 50
Assigning key commands on page 50

Inputting chord symbols
You can input chord symbols using the chord symbols popover, both for all instruments or only 
for individual instruments. You can also open the chord symbols popover during note input; 
however, inputting a chord symbol stops note input.

PREREQUISITE
If you want to input chord symbols using a MIDI device, you have connected the MIDI device you 
want to use.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input a chord symbol.

2. Press Shift-Q  to open the chord symbols popover.
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NOTE

If you selected an item on a staff that has local chord symbols at earlier rhythmic positions, 
the chord symbols popover is automatically set to input local chord symbols when it opens.

3. Optional: Change the type of chord symbol you want to enter in one of the following ways:

● To input local chord symbols, press Alt/Opt-L .

● To input global chord symbols, press Alt/Opt-G .

The popover icon updates to show the current type.

Chord symbols popover when inputting a global 
chord symbol

Chord symbols popover when inputting a local 
chord symbol

4. Enter the chord symbol you want into the chord symbols popover in any of the following 
ways:

● Enter the appropriate letters and numbers using the computer keyboard.

● Play the chord using a MIDI keyboard.

5. Optional: Press Space  to advance the popover to the next beat according to the current 
time signature.

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local chord symbol when the popover is set to global, and 
vice versa, press Alt/Opt-Return  to input the chord symbol.

7. Press Return  to close the popover.

RESULT
The chord symbol specified is input. If you selected an item belonging to an instrument that 
was not already set to show chord symbols in the current layout, the corresponding player is 
automatically updated to show chord symbols for all instruments.

Global chord symbols apply to all instruments in the project and appear on all staves set to show 
chord symbols. Local chord symbols only apply to the selected instrument. Local chord symbols 
always appear, even if global chord symbols exist at the same rhythmic positions.

NOTE

The chord symbol may look different to what you entered into the popover because Dorico SE 
provides a single default chord symbol appearance preset that applies to all chord symbols.

AFTER COMPLETING THIS TASK
You can hide/show chord symbols above specific staves and hide/show chord diagrams 
alongside them.

RELATED LINKS
Chord symbols on page 598
Enabling chord symbol playback on page 453
Hiding/Showing chord symbols on page 600
Hiding/Showing chord symbols in layouts on page 601
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Hiding/Showing chord diagrams on page 609
Disabling MIDI input devices on page 209

Inputting polychord chord symbols
Polychord chord symbols indicate that multiple different chords, commonly two, are played 
simultaneously. You can input polychords when inputting chord symbols with a MIDI keyboard.

PROCEDURE

1. In Write mode, open the chord symbols popover.

2. Play the first chord of the polychord with one hand.

Keep the keys of the first chord depressed.

3. Play the second chord with the other hand.

RESULT
The two chords you played are input as a polychord chord symbol.

TIP

You can also input polychords by entering the two chords separated by a semicolon or pipe 
character into the chord symbols popover.

RELATED LINKS
Chord symbols popover on page 249

Indicating root notes in chord symbols
You can indicate the root note of chord symbols when inputting chord symbols with a MIDI 
keyboard.

PROCEDURE

1. In Write mode, open the chord symbols popover.

2. Indicate the root note of a chord symbol in any of the following ways when using a MIDI 
keyboard:

● First play the root with one finger, and then play the remaining notes of the chord while 
still holding down the root.

● Play all the notes of the chord together, then release them all, then replay the root note.

TIP

To input a chord symbol that consists only of the root note, just play a single note.

RELATED LINKS
Chord symbols popover on page 249
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Indicating altered bass notes in chord symbols
You can indicate that chords have altered bass notes when inputting chord symbols with a MIDI 
keyboard.

PROCEDURE

1. In Write mode, open the chord symbols popover.

2. Indicate which note is the altered bass note of a chord in any of the following ways on your 
MIDI keyboard:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the chord, 
then play the altered bass note while keeping the rest of the keys of the chord 
depressed.

RELATED LINKS
Chord symbols popover on page 249

Inputting chord symbol regions
You can input specific regions in which you want to show chord symbols, for example, if an 
instrument that does not need chord symbols for most of the project has an improvisation 
section that requires chord symbols to be shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the region in which you want to show chord symbols.

2. Choose Write > Create Chord Symbol Region.

RESULT
During note input, chord symbol regions are input spanning the duration of the selected note or 
item, which is usually the last input note. When adding chord symbol regions to existing music, 
they span the selected duration.

The player holding the corresponding instrument is automatically set to show chord symbols in 
chord symbol regions and slash regions, even if it was set to hide all chord symbols before.

RELATED LINKS
Chord symbol regions on page 601
Hiding/Showing chord symbols on page 600

Input methods for clefs and octave lines
You can input clefs and octave lines with the keyboard by using the clefs and octave lines 
popover, and also with the mouse by using the Clefs panel.

Clefs and octave lines share the same popover and panel as both affect the pitch and register of 
notes.

RELATED LINKS
Clefs on page 616
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Octave lines on page 622

Clefs and octave lines popover
The following tables contain the entries for the clefs and octave lines popover that you can use to 
input the different clefs and octave lines available.

You can open the clefs and octave lines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-C .

● Select an existing clef or octave line and press Return .

● Choose Write > Create Clef.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Clefs and octave lines popover 
with an example entry for a clef

Clefs and octave lines popover 
with an example entry for an 
octave line

Clefs button in the Notations 
toolbox

Clefs

Type of clef Popover entry

Treble G clef g, G, g2, sol, or treble

Bass F clef f, F, f4, fa, or bass

Tenor C clef ct, CT, c4, ut4, or tenor

Alto C clef ca, CA, c3, ut3, or alto

Treble G clef, octave below g8ba, G8ba, g8d, G8d, treble8ba, or treble8d

Unpitched percussion perc

4-string tablature tab4

6-string tablature tab6

NOTE

The rectangular percussion clef is available in the Clefs panel.
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Octave lines

Function of octave line Popover entry

Shifts notes up by 1 octave. 8va, 8, 8u, or 1u

Shifts notes up by 2 octaves. 15ma, 15, 15u, or 2u

Shifts notes up by 3 octaves. 22ma, 22, 22u, or 3u

Shifts notes down by 1 octave. 8ba, 8vb, 8d, or 1d

Shifts notes down by 2 octaves. 15ba, 15vb, 15d, or 2d

Shifts notes down by 3 octaves. 22ba, 22vb, 22d, or 3d

Loco indication loco

End of octave line

For example, enter stop to specify where an 
octave line ends during note input.

| or stop

RELATED LINKS
Clefs on page 616
Octave lines on page 622

Clefs panel
The Clefs panel contains the different types of clefs and octave lines available in Dorico SE.

● You can hide/show the Clefs panel by clicking Clefs  in the Notations toolbox on the right 
of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Clefs panel contains the following sections:

Common Clefs
Contains the clefs you are most likely to need, including treble clef and bass clef.

Octave Lines
Contains octave lines, indicating up to three octaves above and below, and a loco line.

Inputting clefs with the popover
You can input clefs using the clefs and octave lines popover, both during note input and by 
adding them to existing music. You can also use the popover to change the type of existing clefs.

NOTE

● In Dorico SE, you cannot hide clefs. Therefore, if you do not want to show any clef, you must 
input an invisible clef.

Write mode
Notations input 

258
Dorico SE 3.5.12



● Many instruments in Dorico SE have different types that show alternative clefs by default. 
You can select the appropriate instrument type from the instrument picker when adding or 
changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a clef.

2. Optional: If you want to input clefs onto multiple staves at once, extend the caret to those 
staves.

3. Press Shift-C  to open the clefs and octave lines popover.

4. Enter the appropriate entry for the clef you want into the popover.

For example, enter bass for a bass clef or alto for an alto clef.

5. Press Return  to close the popover.

RESULT
During note input, clefs are input at the caret position. Note input continues after inputting the 
clef, so you can continue inputting notes and clefs as required.

When you add clefs to existing music, clefs are added directly before a selected notehead, and 
apply to all notes on that staff until the next clef, or the end of the flow.

Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Clefs on page 616
Extending the caret to multiple staves on page 161
Setting different clefs for concert/transposed pitch on page 619
Hiding/Showing clefs according to layout transpositions on page 619
Changing instruments on page 107
Adding instruments to players on page 105

Inputting clefs with the panel
You can input clefs using the Clefs panel, both during note input and by adding them to existing 
music.

NOTE

● In Dorico SE, you cannot hide clefs. Therefore, if you do not want to show any clef, you must 
input an invisible clef.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Many instruments in Dorico SE have different types that show alternative clefs by default. 
You can select the appropriate instrument type from the instrument picker when adding or 
changing instruments.

PROCEDURE

1. In Write mode, do one of the following:
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● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a clef.

2. In the Notations toolbox, click Clefs  to show the Clefs panel.

3. In the Clefs panel, click the clef you want.

RESULT
During note input, clefs are input at the caret position. Note input continues after inputting the 
clef, so you can continue inputting notes and clefs as required.

When you add clefs to existing music, clefs are added directly before a selected notehead, and 
apply to all notes on that staff until the next clef, or the end of the flow.

Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Clefs on page 616
Mouse input settings on page 154
Universal Indian Drum Notation on page 996

Inputting octave lines with the popover
You can input octave lines using the clefs and octave lines popover, both during note input and 
by adding them to existing music. You can also input octave lines only into specific voices in 
multiple-voice contexts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. Optional: If you want to input octave lines onto multiple staves at once, extend the caret to 
those staves.

3. Press Shift-C  to open the clefs and octave lines popover.

4. Enter the appropriate entry for the octave line you want into the popover.

For example, enter 8va for an octave line that shifts notes up one octave.

5. Input the octave line and close the popover in one of the following ways:

● To input an octave line for all voices on the staff, press Return .

● To input an octave line only for the currently selected voice, press Alt/Opt-Return .

6. Optional: During note input, press Space  to advance the caret and extend the octave line.

The octave line also extends automatically as you continue inputting notes.

7. Optional: During note input, stop any octave line by opening the clefs and octave lines 
popover again and entering | or stop.

RESULT
During note input, octave lines are input from the caret position. When you stop octave lines, 
they end at the caret position.
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When adding octave lines to existing music, they are input either above or below your selection, 
depending on whether the octave line indicates that notes are played higher or lower than 
notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.

TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Clefs and octave lines popover on page 257
Octave lines on page 622
Lengthening/Shortening octave lines on page 623
Extending the caret to multiple staves on page 161

Inputting octave lines with the panel
You can input octave lines using the Clefs panel, both during note input and by adding them to 
existing music. You can also input octave lines only into specific voices in multiple-voice contexts.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. In the Notations toolbox, click Clefs  to show the Clefs panel.

3. Input the octave line you want in one of the following ways:

● To input an octave line for all voices on the staff, click it in the Octave Lines section.

● To input an octave line only for the currently selected voice, Alt -click it in the Octave 
Lines section.

Alternatively, when adding octave lines to existing notes, you can click the octave line you 
want in the Clefs panel first, and then click and drag it to the length you want.

RESULT
During note input, octave lines are input at the caret position. However, if you input notes using 
the mouse, octave lines do not automatically extend as you continue inputting notes.

When adding octave lines to existing music, they are input either above or below your selection, 
depending on whether the octave line indicates that notes are played higher or lower than 
notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.
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TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Octave lines on page 622
Lengthening/Shortening octave lines on page 623
Mouse input settings on page 154

Input methods for holds and pauses
You can input holds and pauses with the keyboard by using the holds and pauses popover in 
Write mode, and with the mouse by using the Holds and Pauses panel.

RELATED LINKS
Holds and pauses on page 687
Correct positioning for caesura input on page 265

Holds and pauses popover
The table contains the entries for the holds and pauses popover that you can use to input the 
different holds and pauses available.

You can open the holds and pauses popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-H .

● Select an existing hold or pause and press Return .

● Choose Write > Create Hold or Pause.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Holds and pauses popover with an example entry
Holds and Pauses button in the Notations toolbox

Type of hold or pause Popover entry

Fermata fer or fermata

Very long fermata fermataverylong

Long fermata fermatalong

Short fermata fermatashort

Very short fermata fermataveryshort

Short fermata (Henze) fermatashorthenze
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Type of hold or pause Popover entry

Long fermata (Henze) fermatalonghenze

Curlew (Britten) curlew

Caesura caesura or //

Thick caesura caesurathick

Curved caesura caesuracurved

Short caesura caesurashort

Breath mark (Comma-like) breathmarkcomma, comma, or , (comma)

Breath mark (Tick-like) breathmarktick

Breath mark (Upbow-like) breathmarkupbow

Breath mark (Salzedo) breathmarksalzedo

NOTE

The Curlew mark was originally devised by Benjamin Britten for “Curlew River”, a parable for 
church performance inspired by Japanese Noh theater. It indicates that a player should hold a 
note or a rest until a synchronization point in asynchronous music.

RELATED LINKS
Holds and pauses on page 687
Types of fermatas on page 687
Types of caesuras on page 689
Types of breath marks on page 688

Holds and Pauses panel
The Holds and Pauses panel allows you to input all the different types of holds and pauses 
available in Dorico SE, including alternative versions of fermatas.

● You can hide/show the Holds and Pauses panel by clicking Holds and Pauses  in the 
Notations toolbox on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Holds and Pauses panel contains the following sections:

● Fermatas

● Breath Marks

● Caesuras
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NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

Inputting holds and pauses with the popover
You can input holds and pauses using the holds and pauses popover, both during note input and 
by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a hold or pause. If you 
want to input a breath mark on a specific staff, select an item that belongs to that staff 
only.

NOTE

You can only input one hold or pause at a time.

2. Optional: If you want to input breath marks onto multiple staves at once, extend the caret to 
those staves.

3. Press Shift-H  to open the holds and pauses popover.

4. Enter the hold or pause you want into the popover.

For example, enter fermata for a pause or caesura for a caesura.

5. Press Return  to close the popover.

RESULT
During note input, the specified hold or pause is input at the caret position. When adding holds 
or pauses to existing music, they are input at the rhythmic position of the earliest selected item.

● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Extending the caret to multiple staves on page 161
Holds and pauses on page 687

Inputting holds and pauses with the panel
You can input holds and pauses using the Holds and Pauses panel, both during note input and 
by adding them to existing music.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a hold or pause. If you 
want to input a breath mark on a specific staff, select an item that belongs to that staff 
only.

NOTE

You can only input one hold or pause at a time.

2. In the Notations toolbox, click Holds and Pauses  to show the Holds and Pauses panel.

3. In the Holds and Pauses panel, click the hold or pause you want.

RESULT
During note input, the specified hold or pause is input at the caret position. When adding holds 
or pauses to existing music, they are input at the rhythmic position of the earliest selected item.

● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Holds and pauses on page 687
Mouse input settings on page 154

Correct positioning for caesura input
Caesuras are commonly placed at the end of a bar, before a barline. In Dorico SE, caesuras must 
be attached to the note immediately after the position where you want it to appear, as then 
Dorico SE can automatically position them correctly.

If you input caesuras with your mouse input preference set to Load pointer with item, you must 
click the first note in the next bar for a caesura to appear to the left of the barline. You can also 
click directly on the barline.

A correctly input caesura. The dotted attachment 
lines are attached to the notehead after the barline, 
meaning the caesura is correctly positioned before 
the barline.

An incorrectly input caesura. By clicking to the left of 
the barline, the caesura is attached to the last eighth 
note in the bar.

When input correctly, the dotted attachment lines link the caesura to the notehead immediately 
after the barline.

If your dotted attachment lines do not link the caesura to the notehead immediately after 
the barline, delete the caesura and re-input it. Caesuras can cause spacing issues when input 
incorrectly.

Write mode
Notations input 

265
Dorico SE 3.5.12



RELATED LINKS
Holds and pauses on page 687
Types of caesuras on page 689

Input methods for ornaments, arpeggio signs, glissando lines, and 
jazz articulations

You can input ornaments, including arpeggio signs, glissando lines, and jazz articulations with 
the keyboard by using the ornaments popover, and with the mouse by using the Ornaments 
panel.

You can input ornaments and arpeggio signs during note input and by adding them to existing 
notes, but you cannot input glissando lines during note input. You can only input glissando lines 
by adding them to existing notes.

You can specify the type/length of jazz articulations when using the Ornaments panel but not 
when using the ornaments popover.

RELATED LINKS
Ornaments on page 741
Arpeggio signs on page 757
Glissando lines on page 763
Jazz articulations on page 786
Jazz ornaments on page 787
Lines on page 823
Input methods for lines on page 304

Ornaments popover
The following tables contain the entries for the ornaments popover that you can use to input the 
different ornaments, arpeggio signs, glissando lines, and jazz articulations available.

You can open the ornaments popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-O .

● Select an existing ornament and press Return .

● Choose Write > Create Ornament.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Ornaments popover with an example entry
Ornaments button in the Notations toolbox

Ornaments

Type of ornament Popover entry

Trill:  tr or trill
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Type of ornament Popover entry

Short trill:  shorttr

Mordent:  mor or mordent

Turn:  turn

Inverted turn:  invturn or invertedturn

Trill intervals

Trill interval Popover entry

Major second/Whole step tr 2 or tr M2

Minor third tr m3

Perfect fifth tr p5

Augmented fourth tr aug4

Diminished fifth tr dim5

This list is not comprehensive, as there are many possible trill intervals. It is intended to illustrate 
how you can structure your entry to input different trill intervals.

Jazz ornaments

Type of jazz ornament Popover entry

Bend brassbend

Flip flip

Jazz turn jazz or shake

Smear smear

Jazz articulations

Type of jazz articulation Popover entry

Plop (bend) plop

Plop (smooth) plopsmooth
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Type of jazz articulation Popover entry

Scoop scoop

Doit (bend) doit

Doit (smooth) doitsmooth

Fall (bend) fall

Fall (smooth) fallsmooth

TIP

Other ornaments are available in the Ornaments panel on the right of the window in Write mode.

You can specify the type/length of jazz articulations when using the Ornaments panel but not 
when using the ornaments popover.

Arpeggio signs

Type of arpeggio sign Popover entry

Up arpeggio sign arp, arpup, or arpeggioup

Down arpeggio sign arpdown or arpeggiodown

Non arpeggio sign nonarp or nonarpeggio

Curved arpeggio sign slurarp

Glissando lines

Type of glissando line Popover entry

Straight glissando line gliss

Wavy glissando line glisswavy

Guitar techniques

Type of guitar technique Popover entry

Guitar bend bend

Vibrato bar dive and return vibbend
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Type of guitar technique Popover entry

Vibrato bar scoop vibscoop

Vibrato bar dip vibdip

Vibrato bar line

NOTE

Must have duration to show its line.

wbar or w/bar

Hammer-on

NOTE

You must select at least two notes assigned 
to the same string with ascending pitch 
directions, such as C-D.

ho or hammer

Pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

po or pull

Hammer-on then pull-off or pull-off then 
hammer-on (ligado)

NOTE

You must select at least three notes assigned 
to the same string with alternating pitch 
directions, such as C-D-C or D-C-D.

hp, hopo, hammerpull, lig, or ligado

Right-hand tapping tap

Right-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

tappull

Left-hand tapping lhtap
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Type of guitar technique Popover entry

Left-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

lhtappull

RELATED LINKS
Inputting arpeggio signs with the popover on page 273
Inputting glissando lines with the popover on page 274
Inputting jazz articulations with the popover on page 276
Inputting guitar bends with the popover on page 279
Inputting vibrato bar dives on page 281
Inputting vibrato bar dives and returns with the popover on page 282
Inputting vibrato bar scoops with the popover on page 284
Inputting vibrato bar dips with the popover on page 286
Inputting hammer-ons/pull-offs on page 288
Inputting tapping on page 290
Specifying the string for individual notes on page 726
Changing the allocated string for notes on tablature on page 919
Ornaments on page 741
Trill intervals on page 748
Arpeggio signs on page 757
Glissando lines on page 763
Guitar bends on page 768
Guitar techniques on page 778
Jazz articulations on page 786
Jazz ornaments on page 787
Playing technique duration on page 819

Ornaments panel
The Ornaments panel allows you to input all the different types of ornaments available, including 
jazz articulations, as well as arpeggio signs, glissando lines, guitar bends, and vibrato bar 
techniques.

● You can hide/show the Ornaments panel by clicking Ornaments  in the Notations toolbox 
on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Ornaments panel contains the following sections:

Jazz
Contains ornaments and pitch alterations commonly used in jazz music, such as bends, 
scoops, and falls.

Baroque and Classical
Contains ornaments commonly used in Baroque and Classical music, such as 
mordents, turns, and trills.
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Arpeggiation
Contains the different types of arpeggio signs.

NOTE

You cannot input arpeggio signs with the mouse during note input.

Glissandi
Contains the different types of glissando lines.

Guitar
Contains techniques and pitch alterations commonly associated with guitars, such as 
guitar bends and vibrato bar scoops.

RELATED LINKS
Inputting ornaments/trills with the panel on page 272
Inputting arpeggio signs with the panel on page 274
Inputting glissando lines with the panel on page 275
Inputting jazz articulations with the panel on page 277
Input methods for guitar bends and guitar techniques on page 278

Inputting ornaments/trills with the popover
You can input ornaments, trills, and jazz ornaments using the ornaments popover, both during 
note input and by adding them to existing notes. When inputting trills, you can specify the trill 
interval, such as a minor third.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items on the staff 
that span that duration.

2. Optional: If you want to input ornaments onto multiple staves at once, extend the caret to 
those staves.

3. Press Shift-O  to open the ornaments popover.

4. Enter the appropriate entry for the ornament you want into the popover.

For example, enter tr m3 for a trill with a minor third interval or mor for a mordent.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
ornament.

RESULT
During note input, ornaments are input at the caret position. Trills last the duration of the 
rhythmic value of the note input at the caret position or the duration by which the caret 
advanced. Trills have a default interval of a second, either major or minor depending on the 
context. If you specified an interval for your trill, the interval applies only to the first note in the 
selection, but you can also change the interval partway through trills.

When adding ornaments to existing music, they are input at the rhythmic position of the earliest 
selected item. Trills are input at the rhythmic position of the earliest selected item, with an 
extender line across the rest of the selection.
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RELATED LINKS
Ornaments on page 741
Trills on page 744
Trill intervals on page 748
Changing trill intervals on page 749
Changing trill intervals partway through trills on page 750
Trill interval appearance on page 752
Jazz ornaments on page 787
Inputting notes on page 161
Inputting jazz articulations with the popover on page 276
Extending the caret to multiple staves on page 161

Inputting ornaments/trills with the panel
You can input ornaments, trills, and jazz ornaments using the Ornaments panel, both during 
note input and by adding them to existing notes.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items on the staff 
that span that duration.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Ornaments panel, click the ornament you want.

RESULT
During note input, ornaments are input at the caret position. Trills are input with a default 
duration of a quarter note.

When adding ornaments to existing music, they are input at the rhythmic position of the earliest 
selected item. Trills are input at the rhythmic position of the earliest selected item, with an 
extender line across the rest of the selection.

TIP

You can specify trill intervals when inputting trills using the popover.

RELATED LINKS
Ornaments panel on page 270
Inputting jazz articulations with the panel on page 277
Mouse input settings on page 154
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Inputting arpeggio signs with the popover
You can input arpeggio signs using the ornaments popover, both during note input and by 
adding them to existing notes. You can also input arpeggio signs across notes in multiple voices 
and on different staves that belong to the same instrument, such as piano or harp.

NOTE

You can only input one arpeggio sign at a time.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select at least one note in each voice to which you want to add an arpeggio sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
position.

2. If you started note input, press Q  to start chord input.

NOTE

You can only input arpeggio signs during chord input.

3. Press Shift-O  to open the ornaments popover.

4. Enter the appropriate entry for the arpeggio sign you want into the popover.

For example, enter arpup for an up arpeggio sign or arpdown for a down arpeggio sign.

5. Press Return  to close the popover.

6. Optional: During chord input, input the notes you want.

RESULT
During chord input, arpeggio signs are input at the caret position.

When adding arpeggio signs to existing notes, they are input to the left of the selected notes.

Arpeggio signs automatically span the pitch range of all notes at that rhythmic position in 
the current voice during chord input, and all notes in the selected voices/staves when adding 
arpeggio signs to existing notes.

RELATED LINKS
Ornaments popover on page 266
Arpeggio signs on page 757
Inputting notes on page 161
Inputting chords on page 192
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Inputting arpeggio signs with the panel
You can input arpeggio signs on existing notes using the Ornaments panel. You can also input 
arpeggio signs across notes in multiple voices and on different staves that belong to the same 
instrument, such as piano or harp.

NOTE

● You can only input one arpeggio sign at a time, and you cannot input arpeggio signs with 
the mouse during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

You cannot create cross-staff and cross-voice arpeggio signs if your preference is set to Load 
pointer with item.

PROCEDURE

1. In Write mode, select at least one note in each voice to which you want to add an arpeggio 
sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
position.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Arpeggiation section, click the arpeggio sign you want.

RESULT
The arpeggio sign specified is input to the left of the selected note or chord. Arpeggio signs 
automatically span the pitch range of all notes in the selected voices/staves at that rhythmic 
position.

RELATED LINKS
Ornaments panel on page 270
Arpeggio signs on page 757
Mouse input settings on page 154

Inputting glissando lines with the popover
You can input glissando lines between existing notes using the ornaments popover. You can 
input glissando lines between both adjacent and non-adjacent notes.

NOTE

You cannot input glissando lines during note input or on the last note on a staff. Instead, you can 
input a jazz articulation.

PREREQUISITE
You have input at least two notes that you want to join with a glissando.
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PROCEDURE

1. In Write mode, select the two notes you want to join with a glissando line.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. Press Shift-O  to open the ornaments popover.

3. Enter the appropriate entry for the glissando line you want into the popover.

● Enter gliss for a straight glissando line.

● Enter glisswavy for a wavy glissando line.

4. Press Return  to close the popover.

RESULT
The glissando line specified is input between the selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Ornaments popover on page 266
Glissando lines on page 763
Changing glissando line text on page 765
Changing when glissando line text is shown on page 765
Inputting jazz articulations with the panel on page 277

Inputting glissando lines with the panel
You can input glissando lines between existing notes using the Ornaments panel. You can input 
glissando lines between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

If your preference is set to Load pointer with item, you can only input glissando lines 
between the note you click on and the note immediately following it.

● You cannot input glissando lines during note input or on the last note on a staff. Instead, you 
can input a jazz articulation.

PREREQUISITE
You have input at least two notes that you want to join with a glissando.
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PROCEDURE

1. In Write mode, select the two notes you want to join with a glissando line.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Glissandi section, click the style of glissando line you want.

● Glissando (Straight) 

● Glissando (Wavy) 

RESULT
The glissando line specified is input between the selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Ornaments panel on page 270
Glissando lines on page 763
Mouse input settings on page 154
Changing glissando line text on page 765
Changing when glissando line text is shown on page 765
Inputting jazz articulations with the panel on page 277

Inputting jazz articulations with the popover
You can input jazz articulations using the ornaments popover, both during note input and by 
adding them to existing notes.

NOTE

You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .
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● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input jazz articulations onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. Press Shift-O  to open the ornaments popover.

5. Enter the appropriate entry for the jazz articulation you want into the popover.

For example, enter scoop for a scoop or fall for a fall.

6. Press Return  to close the popover.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

NOTE

When using the popover, all jazz articulations are input with a default line style for their type. You 
can change their type/length after they have been input.

When using the panel, you can specify the line style of jazz articulations when you input them.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Ornaments popover on page 266
Inputting ornaments/trills with the popover on page 271
Extending the caret to multiple staves on page 161
Jazz articulations on page 786
Changing the type/length of existing jazz articulations on page 788
Changing the line style of smooth jazz articulations on page 788
Enabling independent voice playback on page 460
Playback techniques on page 512

Inputting jazz articulations with the panel
You can input jazz articulations using the Ornaments panel, both during note input and by 
adding them to existing notes.

NOTE

● You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input jazz articulations onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

5. In the Jazz section, click the jazz articulation you want.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Ornaments panel on page 270
Inputting ornaments/trills with the panel on page 272
Extending the caret to multiple staves on page 161
Mouse input settings on page 154
Enabling independent voice playback on page 460
Playback techniques on page 512

Input methods for guitar bends and guitar techniques
You can input guitar bends (including pre-bends and post-bends), vibrato bar techniques 
(including dips, dives, scoops, and dives and returns) and tapping, hammer-on, and pull-off 
indications with the keyboard by using the ornaments popover, and with the mouse by using the 
Ornaments panel.

You can also input guitar pre-bends, post-bends, and vibrato bar pre-dives using properties in 
the Properties panel.

You can input guitar techniques during note input and by adding them to existing notes, but you 
cannot input guitar bends during note input. You can only input guitar bends by adding them to 
existing notes.

RELATED LINKS
Ornaments popover on page 266
Ornaments panel on page 270
Guitar bends on page 768
Guitar pre-bends and pre-dives on page 771
Guitar post-bends on page 772
Vibrato bar dives and returns on page 773
Vibrato bar techniques on page 778
Tapping on page 779
Hammer-ons and pull-offs on page 780
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Inputting guitar bends with the popover
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the ornaments popover. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. Press Shift-O  to open the ornaments popover.

3. Enter bend into the popover.

4. Press Return  to close the popover.

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for inputting guitar bends. The command is called Create 
Guitar Bend and is in the Note Input category on the Key Commands page in Preferences.

RELATED LINKS
Ornaments popover on page 266
Guitar bends on page 768
Inputting guitar pre-bends/pre-dives on page 280
Inputting guitar post-bends on page 281
Key Commands page in the Preferences dialog on page 47

Inputting guitar bends with the panel
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the Ornaments panel. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

If your preference is set to Load pointer with item, you can only input guitar bends 
between the note you click on and the note immediately following it.

Write mode
Notations input 

279
Dorico SE 3.5.12



● You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend .

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for inputting guitar bends. The command is called Create 
Guitar Bend and is in the Note Input category on the Key Commands page in Preferences.

RELATED LINKS
Ornaments panel on page 270
Guitar bends on page 768

Inputting guitar pre-bends/pre-dives
You can input guitar pre-bends on any existing notes belonging to fretted instruments. You can 
also specify that pre-bends should be played using the vibrato bar, a technique that is known as 
a “pre-dive”.

PROCEDURE

1. Select the notes before which you want to input guitar pre-bends/pre-dives.

2. In the Properties panel, activate Pre-bend interval in the Guitar Pre-bends group.

3. Change the interval as required.

4. Optional: To turn the guitar pre-bends into guitar pre-dives, activate Vibrato bar pre-bend 
and the corresponding checkbox in the Guitar Pre-bends group.

RESULT
Guitar pre-bends of the specified interval are input before the selected notes. They are shown as 
guitar pre-dives when Vibrato bar pre-bend and the corresponding checkbox are both activated.

RELATED LINKS
Guitar pre-bends and pre-dives on page 771
Vibrato bar techniques on page 778
Properties panel (Write mode) on page 147
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Inputting guitar post-bends
You can input guitar post-bends on any existing notes belonging to fretted instruments. You can 
also specify that post-bends are microtonal.

PROCEDURE

1. Select the notes after which you want to input guitar post-bends.

2. In the Properties panel, activate Post-bend interval in the Guitar Post-bends group.

3. Do one of the following:

● Change the interval as required.

● To turn the guitar post-bends into microtonal post-bends, activate Microtone bend in 
the Guitar Post-bends group.

RESULT
Guitar post-bends of the specified interval are input after the selected notes. They are shown as 
microtonal when Microtone bend is activated.

RELATED LINKS
Guitar post-bends on page 772
Properties panel (Write mode) on page 147
Inputting guitar bends with the popover on page 279

Inputting vibrato bar dives
You can input vibrato bar dives, both during note input and by adding them to existing notes.

Vibrato bar dives are notated using a smooth fall jazz articulation combined with a vibrato bar 
indication.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar dives.

2. Optional: If you want to input vibrato bar dives onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. Press Shift-O  to open the ornaments popover.

5. Enter fallsmooth into the popover to input a smooth fall jazz articulation.

6. Press Return  to close the popover.

7. Optional: During note input, move the caret back to the position of the note with the smooth 
fall.

8. Press Shift-O  to open the ornaments popover.

9. Enter wbar into the popover to input a vibrato bar indication.
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10. Press Return  to close the popover.

11. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
The smooth fall jazz articulation is input on all selected notes. During note input, this is usually 
the last note you input.

During note input, vibrato bar indications are input at the caret position. When adding vibrato 
bar indications to existing music, they are added at the rhythmic position of the earliest selected 
item.

NOTE

When using the popover, all jazz articulations are input with a default line style for their type. You 
can change their type/length after they have been input.

You can also input both smooth fall jazz articulations and vibrato bar indications using the 
Ornaments panel. When using the panel, you can specify the line style of jazz articulations when 
you input them.

AFTER COMPLETING THIS TASK
If you want vibrato bar indications to show a line, you can lengthen them to give them duration.

RELATED LINKS
Vibrato bar techniques on page 778
Ornaments popover on page 266
Ornaments panel on page 270
Extending the caret to multiple staves on page 161
Moving the caret manually on page 161
Jazz articulations on page 786
Inputting jazz articulations with the popover on page 276
Inputting jazz articulations with the panel on page 277
Changing the type/length of existing jazz articulations on page 788
Changing the line style of smooth jazz articulations on page 788
Deleting jazz articulations on page 789
Lengthening/Shortening vibrato bar indications/lines on page 784
Playing technique duration on page 819

Inputting vibrato bar dives and returns with the popover
You can input vibrato bar dives and returns between existing notes using the ornaments 
popover. You can input vibrato bar dives and returns between both adjacent and non-adjacent 
notes.

NOTE

You cannot input vibrato bar dives and returns during note input or on the last note on a staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.
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PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. Press Shift-O  to open the ornaments popover.

3. Enter vibbend into the popover to input the dive.

4. Press Return  to close the popover.

5. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

6. Press Shift-O  to open the ornaments popover.

7. Enter vibbend into the popover to input the return.

8. Press Return  to close the popover.

RESULT
Vibrato bar dives are input between notes with descending pitch directions and vibrato bar 
returns are input between notes with ascending pitch directions. If a vibrato bar dive ends on 
the same note that a vibrato bar return starts on, they appear as a V on tablature with the bend 
interval shown at the point. If you input vibrato bar dives on consecutive notes with the same 
pitch direction, such as E-D-C, they are notated on tablature with an additional line protrusion 
beyond the staff and bend interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Ornaments popover on page 266
Vibrato bar dives and returns on page 773
Vibrato bar techniques on page 778
Guitar bends on page 768
Inputting guitar bends with the popover on page 279

Inputting vibrato bar dives and returns with the panel
You can input vibrato bar dives and returns between existing notes using the Ornaments panel. 
You can input vibrato bar dives and returns between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

If your preference is set to Load pointer with item, you can only input vibrato bar dives and 
returns between the note you click on and the note immediately following it.

● You cannot input vibrato bar dives and returns during note input or on the last note on a 
staff.
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PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.

PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend with Vibrato Bar  to input the vibrato bar dive.

4. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

5. Click Guitar Bend with Vibrato Bar  to input the vibrato bar return.

RESULT
Vibrato bar dives are input between notes with descending pitch directions and vibrato bar 
returns are input between notes with ascending pitch directions. If a vibrato bar dive ends on 
the same note that a vibrato bar return starts on, they appear as a V on tablature with the bend 
interval shown at the point. If you input vibrato bar dives on consecutive notes with the same 
pitch direction, such as E-D-C, they are notated on tablature with an additional line protrusion 
beyond the staff and bend interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Ornaments panel on page 270
Vibrato bar dives and returns on page 773
Vibrato bar techniques on page 778
Guitar bends on page 768
Inputting vibrato bar dives on page 281

Inputting vibrato bar scoops with the popover
You can input vibrato bar scoops using the ornaments popover, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

Write mode
Notations input 

284
Dorico SE 3.5.12



2. Optional: If you want to input vibrato bar scoops onto multiple staves at once, extend the 
caret to those staves.

3. Optional: During note input, input at least one note.

4. Press Shift-O  to open the ornaments popover.

5. Enter vibscoop into the popover.

6. Press Return  to close the popover.

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.

By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.

AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Ornaments popover on page 266
Vibrato bar techniques on page 778
Inputting vibrato bar indications/lines with the popover on page 287
Deleting guitar techniques on page 785

Inputting vibrato bar scoops with the panel
You can input vibrato bar scoops using the Ornaments panel, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input vibrato bar scoops onto multiple staves at once, extend the 
caret to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

5. In the Guitar section, click Vibrato Bar Scoop .

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.

By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.
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AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Ornaments panel on page 270
Vibrato bar techniques on page 778
Inputting vibrato bar indications/lines with the panel on page 288
Deleting guitar techniques on page 785

Inputting vibrato bar dips with the popover
You can input vibrato bar dips using the ornaments popover, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. Optional: If you want to input vibrato bar dips onto multiple staves at once, extend the caret 
to those staves.

3. Press Shift-O  to open the ornaments popover.

4. Enter vibdip into the popover.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar dip.

RESULT
During note input, vibrato bar dips are input at the caret position. When adding vibrato bar dips 
to existing music, they are input at the position of the earliest selected item.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Ornaments popover on page 266
Vibrato bar techniques on page 778
Changing vibrato bar dip intervals on page 782
Inputting vibrato bar indications/lines with the popover on page 287
Changing the staff-relative placement of items on page 343

Inputting vibrato bar dips with the panel
You can input vibrato bar dips using the Ornaments panel, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item on the staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Dip .

RESULT
During note input, vibrato bar dips are input at the caret position. When adding vibrato bar dips 
to existing music, they are input at the position of the earliest selected item.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Ornaments panel on page 270
Vibrato bar techniques on page 778
Changing vibrato bar dip intervals on page 782
Inputting vibrato bar indications/lines with the panel on page 288
Changing the staff-relative placement of items on page 343

Inputting vibrato bar indications/lines with the popover
You can input vibrato bar indications/lines using the ornaments popover, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
vibrato bar indication. If you want to input a vibrato bar line, select items on the staff 
that span the required duration.

2. Optional: If you want to input vibrato bar indications onto multiple staves at once, extend the 
caret to those staves.

3. Press Shift-O  to open the ornaments popover.

4. Enter wbar into the popover to input the vibrato bar indication.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
During note input, vibrato bar indications are input at the caret position.

When adding vibrato bar indications to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding vibrato bar indications to a range of selected 
items, they are input at the rhythmic position of the earliest selected item and have duration, 
which applies until the end of the selection. Vibrato bar indications with duration show a duration 
line, which is dashed by default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.
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RELATED LINKS
Ornaments popover on page 266
Vibrato bar techniques on page 778
Extending the caret to multiple staves on page 161
Lengthening/Shortening vibrato bar indications/lines on page 784
Playing technique duration on page 819

Inputting vibrato bar indications/lines with the panel
You can input vibrato bar indications/lines using the Ornaments panel, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
vibrato bar indication. If you want to input a vibrato bar line, select items on the staff 
that span the required duration.

2. In the Notations toolbox, click Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Line .

RESULT
During note input, vibrato bar indications are input at the caret position.

When adding vibrato bar indications to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding vibrato bar indications to a range of selected 
items, they are input at the rhythmic position of the earliest selected item and have duration, 
which applies until the end of the selection. Vibrato bar indications with duration show a duration 
line, which is dashed by default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments panel on page 270
Vibrato bar techniques on page 778
Lengthening/Shortening vibrato bar indications/lines on page 784
Playing technique duration on page 819

Inputting hammer-ons/pull-offs
You can input hammer-ons/pull-offs on any notes belonging to fretted instruments using the 
ornaments popover, both during note input and by adding them to existing notes. If you select 
multiple notes, Dorico SE automatically inputs the appropriate slurs. You can also add tapping 
with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add hammer-ons/pull-offs.

NOTE

● If you want to input hammer-ons, you must select at least two notes assigned to the 
same string with ascending pitch directions, such as C-D.

● If you want to input pull-offs or tapping with pull-offs, you must select at least two 
notes assigned to the same string with descending pitch directions, such as D-C.

● If you want to input ligados, you must select at least three notes assigned to the 
same string with alternating pitch directions, such as C-D-C for a hammer-on then 
pull-off or D-C-D for a pull-off then hammer-on.

2. Optional: If you want to input hammer-ons/pull-offs onto multiple fretted instrument staves 
at once, extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Press Shift-O  to open the ornaments popover.

5. Enter the appropriate entry for the hammer-on/pull-off you want into the popover.

For example, enter ho for a hammer-on or hopo for a hammer-on then pull-off.

6. Press Return  to close the popover.

RESULT
The hammer-on/pull-off you specify is input on the selected notes. During note input, this is 
usually the last note you input.

If you selected multiple adjacent notes assigned to the same string, Dorico SE automatically 
inputs slurs spanning the selected notes and centers hammer-on/pull-off indications on the 
slurs. For slurs with multiple hammer-on/pull-off indications, each indication is centered over the 
range of notes in the corresponding direction.

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add hammer-ons/pull-offs to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu. To show hammer-on/pull-off indications centered on slurs, select all notes except 
the first note under each slur.

RELATED LINKS
Ornaments popover on page 266
Hammer-ons and pull-offs on page 780
Changing the staff-relative placement of guitar techniques on page 783
Specifying the string for individual notes on page 726
Changing the allocated string for notes on tablature on page 919
Deleting guitar techniques on page 785

Write mode
Notations input 

289
Dorico SE 3.5.12



Inputting tapping
You can input right-hand and left-hand tapping indications on any notes belonging to fretted 
instruments using the ornaments popover, both during note input and by adding them to 
existing notes. You can also add tapping with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tapping indications.

NOTE

If you want to input tapping with pull-offs, you must select at least two notes assigned to 
the same string with descending pitch directions, such as D-C.

2. Optional: If you want to input tapping onto multiple fretted instrument staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Press Shift-O  to open the ornaments popover.

5. Enter the appropriate entry for the tapping indication you want into the popover.

For example, enter tap for right-hand tapping or lhtappull for left-hand tapping with pull-
off.

6. Press Return  to close the popover.

RESULT
The tapping indication you specify is input on the selected notes. During note input, this is 
usually the last note you input.

By default, tapping indications appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add tapping indications to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu.

RELATED LINKS
Ornaments popover on page 266
Tapping on page 779
Changing the staff-relative placement of guitar techniques on page 783
Specifying the string for individual notes on page 726
Changing the allocated string for notes on tablature on page 919
Extending the caret to multiple staves on page 161
Deleting guitar techniques on page 785
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Input methods for playing techniques, pedal lines, string indicators, 
and harp pedal diagrams

You can input playing techniques with the keyboard by using the playing techniques popover, 
and with the mouse by using the Playing Techniques panel. Pedal lines are considered playing 
techniques in Dorico SE because both affect the sound that the instrument produces.

You can input string indicators outside the staff in the same ways, using either the playing 
techniques popover or Playing Techniques panel. However, you can only input harp pedal 
diagrams using the playing techniques popover.

You can input string indicators inside the staff using a property in the String Indicators group of 
the Properties panel.

RELATED LINKS
Playing techniques on page 813
Pedal lines on page 801
Harp pedaling on page 794
String indicators on page 674
Inputting playing techniques with the popover on page 295
Inputting playing techniques with the panel on page 297
Inputting pedal lines and retakes with the popover on page 298
Inputting pedal lines and retakes with the panel on page 299
Inputting harp pedal diagrams on page 300
Inputting string indicators outside the staff with the popover on page 301
Inputting string indicators outside the staff with the panel on page 302
Inputting string indicators inside the staff on page 303

Playing techniques popover
The following tables contain the entries for the playing techniques popover that you can use to 
input playing techniques, pedal lines, and retakes.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter. You can 
then select one of these playing techniques to input.

You can open the playing techniques popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-P .

● Select an existing playing technique and press Return .

● Choose Write > Create Playing Technique.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Playing techniques popover with 
an example entry for inputting a 
playing technique

Playing techniques popover with 
an example entry for inputting a 
pedal line

Playing Techniques button in the 
Notations toolbox
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Playing techniques

Playing technique Popover entry

Vibrato vibrato

Senza vibrato senza vibrato

Naturale (nat.) nat

Con sord. con sord

Strong air pressure strong air pressure

Double-tongue double-tongue

Down bow downbow

Up bow upbow

Sul ponticello sul pont

Sul tasto sul tasto

Poco sul tasto pst

Pizzicato pizz

Spiccato spicc

Arco arco

Tongue click (Stockhausen) tongue click

Finger click (Stockhausen) finger click

Vibraphone motor on motor on

Vibraphone motor off motor off

Open open

Damp damp

Damp (large) damp large

Full barré full barre

Half barré half barre

Write mode
Notations input 

292
Dorico SE 3.5.12



Playing technique Popover entry

Strum up strum up

Strum down strum down

Left hand lh

Right hand rh

This list is not comprehensive as there are many valid playing techniques. It is intended 
to illustrate how you can structure your entry to input different types of common playing 
techniques.

If you do not know the correct entry for a playing technique, start entering part of the playing 
technique and see if it becomes available in the popover menu.

NOTE

● To give playing techniques duration, add -> at the end of your entry, such as vibrato->. 
During note input, the duration of the playing technique extends as you continue inputting 
notes or advance the caret. When adding playing techniques to existing notes, they are 
added as a group.

● As playing techniques correspond to specific samples, they must be input as described or 
selected from the popover menu.

Pedal lines

Type of pedal line, retake, or pedal level 
change

Popover entry

Sustain pedal line ped

Retake in sustain pedal line ^, notch, or retake

Remove retake in sustain pedal line nonotch

Stop sustain pedal line *

Sostenuto pedal line sost

Stop sostenuto pedal line s*

Una corda pedal line unacorda

Stop una corda pedal line u*
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Harp pedaling

Example harp pedaling Popover entry

D, C, Bb, Eb, F, G, A DCBbEbFGA, BbEb, or --^|^---

D, C♯, B, E, F♯, G♯, A DC#BEF#G#A, C#F#G#, or -v-|-vv-

TIP

The pipe character is optional.

String indicators outside the staff

Example string indicator Popover entry

1 string1

3 string3

RELATED LINKS
Playing techniques on page 813
Groups of playing techniques on page 821
Pedal lines on page 801
Sustain pedal retakes and pedal level changes on page 802
Harp pedaling on page 794
Adding retakes to existing pedal lines with the popover on page 298
Inputting harp pedal diagrams on page 300
Inputting string indicators outside the staff with the popover on page 301

Playing Techniques panel
The Playing Techniques panel contains the different playing techniques available in Dorico SE, 
divided into instrument families. Pedal lines are included in the Keyboard section.

● You can hide/show the Playing Techniques panel by clicking Playing Techniques  in the 
Notations toolbox on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Playing Techniques panel contains the following sections:

Common
Contains commonly used playing techniques that also apply to multiple different 
instrument families, such as “mute” and “legato”.

Wind
Contains playing techniques typically only used for wind instruments, such as “key 
clicks” and “whistle tones”.
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Brass
Contains playing techniques typically only used for brass instruments, such as “cup 
mute” and “stopped”.

Unpitched Percussion
Contains playing techniques typically only used for unpitched percussion instruments, 
such as “rim” and “scrape”.

Pitched Percussion
Contains playing techniques typically only used for pitched percussion instruments, 
such as “motor on” and “½ Ped.” for vibraphones.

Keyboard
Contains playing techniques typically only used for keyboard instruments, such as 
“Ped.” and different pedal depression levels.

Choral
Contains playing techniques typically only used for the voice, such as “mouth open” 
and “tongue click”.

Strings
Contains playing techniques typically only used for string instruments, such as “col 
legno battuto” and “down bow”.

Guitar
Contains playing techniques typically only used for guitars and fretted instruments, 
such as string indicators, “half barré”, and “strum up”.

TIP

You can hover your mouse pointer over the options in each section to show the name of each 
playing technique.

RELATED LINKS
Inputting string indicators outside the staff with the panel on page 302

Inputting playing techniques with the popover
You can input playing techniques using the playing techniques popover, both during note input 
and by adding them to existing notes.

NOTE

You can only enter one playing technique into the popover during note input. You can enter two 
playing techniques when adding playing techniques to a selection if they are separated by ->.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
playing technique. If you want to input playing techniques with duration, select items on 
the staff that span that duration.

2. Optional: If you want to input playing techniques onto multiple staves at once, extend the 
caret to those staves.
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3. Press Shift-P  to open the playing techniques popover.

4. Enter the appropriate entry for the playing technique you want into the popover.

For example, enter pizz or non vibrato->.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter, which 
you can select. If you want the playing technique to have duration, you can add -> at the end.

5. Press Return  to close the popover.

Open-ended playing techniques, such as non vibrato->, automatically extend during note 
input as you continue inputting notes, or if you advance the caret by pressing Space .

6. Optional: During note input, stop open-ended playing techniques by opening the playing 
techniques popover again and entering one of the following entries:

● To end the current playing technique with another playing technique, enter that playing 
technique. For example, enter vibrato. This joins the current playing technique to the 
following one with a continuation line.

● To end the current playing technique with another open-ended playing technique, enter 
that playing technique followed by ->. For example, enter vibrato->. This joins the 
current playing technique to the following one with a continuation line.

● To end the current playing technique without inputting another playing technique, 
enter ? into the popover. This leaves the current playing technique with a duration line 
rather than a continuation line.

RESULT
The specified playing techniques are input. They are considered voice-specific by default, 
meaning they only apply to the voice indicated by the caret indicator during step input or the 
selected voice when adding playing techniques to existing notes. They are automatically placed 
above the staff for up-stem voices and below the staff for down-stem voices.

Adjoining playing techniques, or playing techniques that were input together or in sequence, are 
automatically grouped together, both during note input and when adding playing techniques to 
existing notes.

During note input, playing techniques are input at the caret position and extend automatically if 
you included an open-ended playing technique with duration.

When adding playing techniques to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding playing techniques to a range of selected 
items, they are input at the rhythmic position of the earliest select item and have duration, which 
applies until the end of the selection. For playing techniques whose continuation type is set to 
show lines, the appropriate continuation line is shown.

AFTER COMPLETING THIS TASK

● You can move playing techniques within playing technique groups, lengthen/shorten playing 
techniques, and hide/show playing technique duration lines.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Moving playing techniques rhythmically on page 816
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Groups of playing techniques on page 821
Playing technique continuation lines on page 818
Hiding/Showing playing technique duration lines on page 820
Extending the caret to multiple staves on page 161
Enabling independent voice playback on page 460
Playback techniques on page 512

Inputting playing techniques with the panel
You can input playing techniques using the Playing Techniques panel, both during note input and 
by adding them to existing notes.

NOTE

● You cannot input playing techniques with duration in sequence, which automatically groups 
them, when using the panel. If you want to input playing techniques with duration in 
sequence, you can use the popover.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

If you want to input the same playing technique in multiple places, change your mouse 
input preference to Load pointer with item so that you do not have to reselect the playing 
technique for each note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
playing technique. If you want to input playing techniques with duration, select items on 
the staff that span that duration.

2. In the Notations toolbox, click Playing Techniques  to show the Playing Techniques panel.

3. In the Playing Techniques panel, click the playing technique you want.

RESULT
The specified playing technique is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding playing techniques to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, playing techniques are input at the caret position, even if your preference is 
set to Load pointer with item.

When adding playing techniques to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding playing techniques to a range of selected 
items, they are input at the rhythmic position of the earliest select item and have duration, which 
applies until the end of the selection. For playing techniques whose continuation type is set to 
show lines, the appropriate continuation line is shown.

AFTER COMPLETING THIS TASK

● If you want to show transition lines between playing techniques, you can group them 
together.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.
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RELATED LINKS
Changing your mouse input settings on page 155
Grouping playing techniques together on page 821
Enabling independent voice playback on page 460
Playback techniques on page 512

Inputting pedal lines and retakes with the popover
You can input pedal lines using the playing techniques popover, both during note input and by 
adding them to existing music. Because the pedal line extends automatically as you input notes 
during note input, you can input retakes when you reach the appropriate rhythmic position.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select items that span the required duration of the pedal line.

2. Press Shift-P  to open the playing techniques popover.

3. Enter the appropriate entry for the pedal line you want into the popover.

For example, enter ped for a sustain pedal line.

4. Press Return  to close the popover.

The pedal line is input.

5. Optional: During note input, extend the pedal line by pressing Space  to advance the caret.

The pedal line also extends automatically as you continue inputting notes.

6. Optional: During note input, input retakes by opening the playing techniques popover again 
at the appropriate rhythmic position and entering ^ or retake into the popover.

7. Optional: During note input, stop the pedal line by opening the playing techniques popover 
again and enter the appropriate entry into the popover.

For example, enter * to stop a sustain pedal line.

8. Press Return  to close the popover.

RESULT
During note input, pedal lines start at the caret position, and end at the caret position.

When you add pedal lines to existing notes, pedal lines are added across the selected items.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 802
Inputting notes on page 161
Adding retakes to existing pedal lines with the popover on page 298
Positions of pedal lines on page 803

Adding retakes to existing pedal lines with the popover

You can add retakes to existing sustain pedal lines using the playing techniques popover.

NOTE

You cannot add retakes to sostenuto or una corda pedal lines.
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PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, select an item at the rhythmic position where you want the retake to apply.

2. Press Shift-P  to open the playing techniques popover.

3. Enter ^ or retake into the popover.

4. Press Return  to close the popover.

RESULT
The retake is input at the selected rhythmic position.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 802
Playing techniques popover on page 291

Inputting pedal lines and retakes with the panel
You can input pedal lines and retakes using the Playing Techniques panel.

NOTE

● When using the panel, you cannot input pedal lines or retakes during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, select the notes to which you want the pedal line to apply.

2. In the Notations toolbox, click Playing Techniques  to show the Playing Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. Click the pedal line you want.

Alternatively, with nothing selected, click the pedal line you want in the Keyboard section 
of the Playing Techniques panel, then click and drag in the score to create a pedal line and 
extend it to the duration you want.

5. Optional: Select an item at the rhythmic position where you want to input a retake.

6. Optional: In the Playing Techniques panel, click Retake Pedal in the Keyboard section.

RESULT
The pedal line is input across the selected range.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 802
Adding retakes to existing pedal lines with the panel on page 300
Mouse input settings on page 154
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Adding retakes to existing pedal lines with the panel

You can add retakes to existing sustain pedal lines using the Playing Techniques panel.

NOTE

You cannot add retakes to sostenuto or una corda pedal lines.

PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, select an item at the rhythmic position where you want the retake to apply.

2. Input the retake in one of the following ways:

● Click Retake Pedal in the Keyboard section of the Playing Techniques panel.

● Choose Edit > Pedal Lines > Add Retake. You can also choose this option from the 
context menu.

RESULT
The retake is input at the selected rhythmic position.

TIP

Alternatively, if nothing is selected in the score, you can click Retake Pedal in the Keyboard 
section of the Playing Techniques panel, and then click at the rhythmic position where you want 
to input the retake.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 802
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291

Inputting harp pedal diagrams
You can input harp pedal diagrams using the playing techniques popover, both during note input 
and by adding them to existing music.

If you do not input any harp pedaling, Dorico SE assumes all harp pedals are in their natural 
setting, as they would be for C major. Any pitches that do not fit with the current harp pedaling, 
excluding the two lowest harp strings, appear red when colors for notes out of range are shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input on a harp staff.

● Select an item on a harp staff at the rhythmic position where you want to input a harp 
pedal diagram.

2. Press Shift-P  to open the playing techniques popover.

3. Enter the appropriate entry for the harp pedals you want.

For example, enter C#F#G# for C♯, F♯, and G♯ pedals, such as in A major.
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4. Press Return  to close the popover.

RESULT
The corresponding harp pedal diagram is input at the selected rhythmic position. Depending on 
your per-layout settings, it is either displayed as a diagram, using note names, or not shown and 
instead indicated by a signpost.

During note input, harp pedal diagrams are input at the caret position.

RELATED LINKS
Playing techniques popover on page 291
Harp pedaling on page 794
Hiding/Showing harp pedaling in layouts on page 796
Changing the appearance of harp pedal diagrams on page 795
Hiding/Showing colors for notes out of range on page 727

Calculating harp pedal diagrams based on existing music

You can automatically calculate suitable harp pedal diagrams based on the notes you have 
already input, either from a single point onwards or within a selected region.

If you do not input any harp pedaling, Dorico SE assumes all harp pedals are in their natural 
setting, as they would be for C major. Any pitches that do not fit with the current harp pedaling, 
excluding the two lowest harp strings, appear red when colors for notes out of range are shown.

PROCEDURE

1. In Write mode, select the region you want to use to calculate harp pedaling in one of the 
following ways:

● Select an existing single note from which you want to calculate harp pedaling.

● Select a range of notes for which you want to calculate harp pedaling.

NOTE

Dorico SE ignores the lowest two harp strings, C and D, when calculating harp pedals.

2. Choose Write > Calculate Harp Pedals.

RESULT
A harp pedal diagram is input at the start of your selection. Depending on your per-layout 
settings, it is either displayed as a diagram, using note names, or not shown and instead 
indicated by a signpost.

Inputting string indicators outside the staff with the popover
You can input string indicators outside the staff using the playing techniques popover, both 
during note input and by adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items on the staff that span that duration.
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2. Optional: If you want to input string indicators onto multiple staves at once, extend the caret 
to those staves.

3. Press Shift-P  to open the playing techniques popover.

4. Enter the appropriate entry for the string indicator you want into the popover.

For example, enter string1 for just a string 1 indicator or string3-> for a string 3 indicator 
with duration.

5. Press Return  to close the popover.

Open-ended string indicators, such as string3->, automatically extend during note input as 
you continue inputting notes, or if you advance the caret by pressing Space .

6. Optional: During note input, stop open-ended string indicators by opening the playing 
techniques popover again and entering ?  into the popover.

This leaves the current string indicator with a duration line. You can also enter another string 
indicator into the popover, but this joins the current string indicator to the following one 
with a continuation line rather than a duration line, which is a less common notation.

RESULT
The specified string indicators are input. They are considered voice-specific by default, meaning 
they only apply to the voice indicated by the caret indicator during step input or the selected 
voice when adding string indicators to existing notes. They are automatically placed above the 
staff for up-stem voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, and extend automatically if 
you included an open-ended string indicator with duration.

When adding string indicators to a single existing note, they are added to the selected note only 
and have no duration. When adding string indicators to a range of notes, they are added to the 
first note in the selection and have duration, which applies until the end of the selection.

By default, string indicators have dashed duration lines with a hook cap at the end.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing techniques popover on page 291
String indicators on page 674
Lengthening/Shortening string indicators on page 675
Extending the caret to multiple staves on page 161
Changing the staff-relative placement of items on page 343

Inputting string indicators outside the staff with the panel
You can input string indicators outside the staff using the Playing Techniques panel, both during 
note input and by adding them to existing notes.

NOTE

● You cannot input string indicators with duration during note input when using the panel. 
You can only do so when using the popover.

● These steps describe inputting with the default mouse input preference Create item at 
selection.
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If you want to input the same string indicator in multiple places, change your mouse input 
preference to Load pointer with item so that you do not have to reselect the string 
indicator for each note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items on the staff that span that duration.

2. In the Notations toolbox, click Playing Techniques  to show the Playing Techniques panel.

3. In the Playing Techniques panel, expand the Guitar section.

4. Click the string indicator you want.

RESULT
The specified string indicator is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding string indicators to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, even if your preference is set 
to Load pointer with item.

When adding string indicators to a single existing note, they are added to the selected note only 
and have no duration. When adding string indicators to a range of notes, they are added to the 
first note in the selection and have duration, which applies until the end of the selection.

By default, string indicators have dashed duration lines with a hook cap at the end.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing Techniques panel on page 294

Inputting string indicators inside the staff
You can show a string indicator inside the staff for each fretted instrument note. You can do 
this for the current layout and frame chain only or for all layouts and frame chains. Dorico SE 
automatically detects a string that each pitch could be played on, but you can also specify the 
string manually.

NOTE

These steps only apply to notes belonging to fretted instruments.

PREREQUISITE
You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the notes belonging to fretted instruments beside which you want to show string 
indicators.

2. In the Properties panel, activate Show in the String Indicators group.

RESULT
String indicators are shown in the staff beside each selected note. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Unless you have specified a string for each note, the string number shown in the string 
indicators is calculated automatically. String indicators inside the staff for open strings appear 
as a bold number zero without a circle enclosure.

By default, string indicators appear on the left of noteheads without left-hand fingerings and on 
the right of noteheads with left-hand fingerings.

AFTER COMPLETING THIS TASK

● You can specify the string on which notes are played, which affects the number shown in 
their corresponding string indicators.

● You can change the notehead-relative position of string indicators.

RELATED LINKS
String indicators on page 674
Fingerings for fretted instruments on page 665
Fretted instrument tuning on page 104
Specifying the string for individual notes on page 726
Changing the notehead-relative position of string indicators on page 678
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Input methods for lines
You can input both horizontal and vertical lines by using the Lines panel. There is no popover for 
lines.

TIP

If you want lines to represent specific notations that affect playback if applicable, you can instead 
input these notations directly. For example, dynamics, arpeggios, glissandi, and trills all have 
dedicated features in Dorico SE.

RELATED LINKS
Lines on page 823
Input methods for dynamics on page 243
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Input methods for clefs and octave lines on page 256
Input methods for tempo marks on page 228
Input methods for repeats and tremolos on page 321
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Lines panel
The Lines panel contains the different types of lines available in Dorico SE. It is located on the 
right of the window in Write mode.

● You can hide/show the Lines panel by clicking Lines  in the Notations toolbox on the right 
of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Lines panel contains the following sections:

Horizontal
Contains the different horizontal lines available. The options at the top of the section 
allow you to determine the attachment type for the start and end of horizontal lines 
you subsequently input. Horizontal lines can be attached to noteheads, barlines, or 
rhythmic positions, and the start and end can have different attachment types.

Vertical
Contains the different vertical lines available.

RELATED LINKS
Lines on page 823
Line components on page 825

Inputting horizontal lines
You can input horizontal lines between existing notes or spanning a specified duration using the 
Lines panel. Horizontal lines can be attached to noteheads, barlines, or rhythmic positions, and 
can have different attachment types at their start and end.

You can also input barline-/rhythmic position-attached lines that apply to all staves.

NOTE

● You cannot change the attachment type of horizontal lines after they have been input.

● If you want to input notehead-attached horizontal lines to represent glissandi, you can 
instead input glissando lines directly.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to input notehead-attached lines, select the notes you want to join with a 
line.

TIP

The notes can be in different voices, on different staves, and belong to any instruments 
held by the same player.
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● If you want to input barline-/rhythmic position-attached lines, select items that span the 
required duration of the line.

● If you want to input horizontal lines that are attached to noteheads at one end but are 
attached to barlines/rhythmic positions at the other end, select the required note and 
any item at the required rhythmic position of the other end.

2. In the Notations toolbox, click Lines  to show the Lines panel.

3. In the Horizontal section, choose one of the following options for both Start and End:

● Attach to notehead 

● Attach to barline (where available) 

● Attach to rhythmic position 

4. Input a line with the specified attachments in one of the following ways:

● To input a notehead-attached line or barline-/rhythmic position-attached line on the 
selected staff only, click it in the Horizontal section.

● To input a barline-/rhythmic position-attached line that applies to all staves, Alt -click it 
in the Horizontal section.

RESULT
A horizontal line with the specified attachments is input. They are positioned according to their 
attachment types and their rhythmic positions.

Horizontal lines that apply to all staves are categorized as system objects. Therefore, they follow 
your per-layout settings for the visibility and positioning of system objects.

AFTER COMPLETING THIS TASK

● You can change the placement and staff position of barline-/rhythmic position-attached 
lines.

● You can add text to lines.

RELATED LINKS
Lines on page 823
Positions of lines on page 826
Length of lines on page 831
System objects on page 913
Changing the positions of system objects on page 913
Adding text to lines on page 835
Changing the placement of horizontal lines on page 828
Mouse input settings on page 154
Inputting glissando lines with the popover on page 274

Inputting vertical lines
You can input vertical lines on existing notes using the Lines panel, including across notes in 
multiple voices and on different staves that belong to the same instrument, such as piano or 
harp.

NOTE

● If you want to input vertical lines to represent arpeggios, you can instead input arpeggio 
signs directly.

● You can only input one vertical line at a time.
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● These steps describe inputting with the default mouse input preference Create item at 
selection.

You cannot create cross-staff and cross-voice vertical lines if your preference is set to Load 
pointer with item.

PROCEDURE

1. In Write mode, select at least one note at the same rhythmic position in each voice to which 
you want to add a vertical line.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff vertical lines. However, you cannot create 
cross-staff vertical lines between different instruments, even if they are held by the same 
player.

● Vertical lines are added to all notes in the selected voices at the selected rhythmic 
position.

2. In the Notations toolbox, click Lines  to show the Lines panel.

3. In the Vertical section, click the line you want.

RESULT
The vertical line specified is input to the left of the selected notes. Its length is adjusted 
automatically so that it spans the range of all notes in the selected voices/staves at that rhythmic 
position.

AFTER COMPLETING THIS TASK

● You can change the order of lines when multiple exist at the same rhythmic position and 
show vertical lines on the right of notes.

● You can lengthen/shorten vertical lines.

● You can add text to lines.

RELATED LINKS
Lines on page 823
Length of lines on page 831
Lengthening/Shortening vertical lines on page 832
Adding text to lines on page 835
Showing vertical lines on the right/left of notes on page 827
Changing the horizontal order of vertical lines on page 827
Inputting arpeggio signs with the popover on page 273

Inputting text
You can input text at specific rhythmic positions in the score. You can input text for single staves 
or input system text that applies to all staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input text.
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2. Open the text editor in any of the following ways:

● To input staff text, press Shift-X  or click Text  in the Notations toolbox.

● To input staff text with a specific paragraph style, choose Write > Create Text > 
[Paragraph style].

● To input system text, press Shift-Alt/Opt-X .

● To input system text with a specific paragraph style, choose Write > Create System 
Text > [Paragraph style].

3. Enter the text you want.

4. Optional: Press Return  to insert a line break.

5. Optional: Use the text editor options to format the text.

6. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
During note input, the text you entered into the text editor is input at the caret position. It is 
automatically placed above the staves to which it applies, using the default paragraph style, and 
follows the default settings for the vertical position of text.

When adding text to existing music, it is input at the position of the earliest selected item.

NOTE

● In Dorico SE, system text is categorized as a system object. Therefore, system text follows 
your per-layout settings for the visibility and positioning of system objects.

● You can assign key commands for inputting text with specific paragraph styles, for both 
Create Text and Create System Text, on the Key Commands page in Preferences.

RELATED LINKS
Hiding/Showing text objects on page 405
Changing the staff-relative placement of items on page 343
System objects on page 913

Text editor options in Write mode
The text editor allows you to add and format text. In Write mode, it opens when you add or 
change staff text or system text.

Text editor in Write mode

The text editor provides the following options:

1 Character Style

Allows you to change the appearance of selected text within paragraphs. This overrides the 
paragraph style applied to the corresponding paragraph.

2 Paragraph Style
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Allows you to change the paragraph style applied to the whole paragraph, which can change 
the appearance, formatting, and alignment of the text.

Staff text and system text are always treated as single paragraphs.

3 Font

Allows you to change the font family of selected text.

4 Font Style

Allows you to change the font style of selected text.

NOTE

● Depending on the font selected, some font styles might not be available.

● You can also change the font style using the following standard key commands:

● Ctrl/Cmd-B  for bold

● Ctrl/Cmd-I  for italic

5 Font Size

Allows you to change the size of selected text.

TIP

You can also change the font size using the following key commands:

● Ctrl/Cmd-Shift-.  to increase the font size

● Ctrl/Cmd-Shift-,  to decrease the font size

6 Font Stretch

Allows you to make selected text wider or narrower.

7 Baseline Shift

Allows you to shift the baseline of selected text gradually up or down.

8 Letter Spacing

Allows you to increase/decrease the space between the characters of selected text.

9 Word Spacing

Allows you to increase/decrease the space between the words of selected text.

10 Alignment

Allows you to choose the alignment of selected text relative to the rhythmic position of the 
text in the score. For text in a text frame, the text is aligned along the left margin of a text 
frame.

You can choose from the following alignments:

● Align Left

● Align Center

● Align Right

11 Line Types

Allows you to show any of the following types of lines, in any combination, on selected text:

● Underline

TIP

You can also make selected text underlined by pressing Ctrl/Cmd-U .
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● Overline

● Strikethrough

12 Script Types

Allows you to position selected text in one of the following positions relative to the text on 
the baseline:

● Superscript

● Subscript

13 Foreground Color

Allows you to change the color of selected text.

14 Background Color

Allows you to change the background color of selected text.

RELATED LINKS
Missing Fonts dialog on page 58

Editing text
You can edit the text shown in text objects added to staves, including changing the text and 
changing its formatting.

PROCEDURE

1. Open the text editor for the text object in any of the following ways:

● Select the text object and press Return .

● Double-click the text object.

2. Optional: Change the text in the text frame/object.

3. Optional: Use the text editor options to format the text.

4. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RELATED LINKS
Text objects vs. text in text frames on page 397
Hiding/Showing text objects on page 405

Inputting lyrics
You can input lyrics by entering text into the lyrics popover, and you can advance the lyrics 
popover to the next note on the staff without closing and reopening it for every note.

PROCEDURE

1. In Write mode, select the note on the staff from which you want to start inputting lyrics.

2. Press Shift-L  to open the lyrics popover.

By default, the lyrics popover opens with lyric line input selected.

3. Optional: Change the type of lyric in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To input lyrics above the staff, press Shift - Up Arrow .

● To input chorus lines, press Up Arrow .

● To input lyric line translations, press Alt/Opt - Down Arrow .
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4. Enter the word or syllable you want to add to the selected note into the popover.

● To enter multiple words on a single note, press Shift-Alt/Opt-Space .

● To include a hyphen within a single word or syllable, press Alt/Opt--  (hyphen).

● To include an elision in a lyric, press _  (underscore).

5. Advance the popover to the next note in one of the following ways:

● If you entered a complete word, or the final syllable in a multi-syllabic word, press 
Space .

● If you entered one syllable of a multi-syllabic word that is not the final syllable, press - 
(hyphen).

● If you do not want the syllable to be followed by an extension line or hyphen, press 
Right Arrow .

6. Continue entering words and syllables into the popover for the rest of the notes to which 
you want to add lyrics.

7. Press Return  or Esc  to close the popover.

The popover closes automatically when you reach the last note on the staff.

RESULT
The text you entered into the popover is input as lyrics of the type indicated by the icon on the 
left-hand side of the popover.

If you advanced the popover to the next note by pressing - , a hyphen appears after the last 
entered lyric. This is used for multi-syllabic words across multiple notes.

If you advance the popover by pressing Space , a gap appears after the last entered lyric. This is 
used for single-syllable words or for the final syllable in multi-syllabic words.

TIP

● You can later change whether a gap or a hyphen appears between lyrics by changing their 
syllable type.

● You can also input lyrics by copying and pasting them, for example, from an external text 
editor.

RELATED LINKS
Copying/Pasting lyrics on page 706
Lyrics on page 701
Navigation during lyric input on page 313
Types of lyrics on page 703
Types of syllables in lyrics on page 704
Lyric line numbers on page 712
Lyric hyphens and lyric extender lines on page 712

Lyrics popover
You can input lyrics, including chorus lines and lyric line translations, using the lyrics popover. 
You can use key commands to change the type of lyric being input at any time.

You can open the lyrics popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-L .

● Select an existing lyric and press Return .
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● Choose Write > Create Lyrics.

● Click Lyrics  in the Notations toolbox.

Lyric lines
The popover automatically opens ready to input lyrics into Line 1, except if you are 
changing an existing lyric.

The number shown on the left-hand side of the lyrics popover indicates the lyric line 
into which the lyric is input.

The lyrics popover with an example entry for Line 1

You can change the lyric line number by pressing Down Arrow  when the lyrics 
popover is open.

The lyrics popover with an example entry for Line 2

Lyric lines above the staff
You can input lyrics into lines above the staff by pressing Shift - Up Arrow  when the 
lyrics popover is open.

You can then press Up Arrow  and Down Arrow  to change the lyric line number 
above the staff.

Chorus lines
You can input chorus lines by pressing Up Arrow  when the lyrics popover is open. You 
can do this when inputting lyrics below the staff and above the staff.

A c, for “chorus lines”, is shown on the left-hand side of the popover.

The lyrics popover with an example entry for a chorus line

Lyric line translations
You can input lyric line translations by pressing Alt/Opt - Down Arrow  when the lyrics 
popover is open.

An asterisk (*) is shown beside the lyric line number to which you want to add a lyric 
line translation on the left-hand side of the popover.

The lyrics popover with an example entry for a lyric line translation

RELATED LINKS
Inputting lyrics on page 310
Lyrics on page 701
Types of lyrics on page 703
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Navigation during lyric input
You can move the lyrics popover to input new lyrics and edit existing lyrics without having to 
close and reopen the lyrics popover.

Popover navigation Key command

Finish the current word and advance the 
popover to the next note or chord.

Space

Finish the current syllable and advance the 
popover to the next note or chord.

-  (hyphen)

Advance the popover to the next note without 
showing an extension line or hyphen.

Right Arrow

Move the cursor to the next/previous letter. If 
the next/previous letter is in another lyric, the 
popover advances to that lyric.

Right Arrow / Left Arrow

Move the popover forwards/backwards from 
syllable to syllable within lines of lyrics.

Alt/Opt-Right Arrow / Alt/Opt-Left Arrow

Add spaces within a word or syllable without 
advancing the popover.

Shift-Alt/Opt-Space

Add a hyphen within a single word or syllable 
without advancing the popover.

Alt/Opt--  (hyphen)

Add an elision slur within a word or syllable. _  (underscore)

RELATED LINKS
Lyrics on page 701
Inputting lyrics on page 310

Inputting figured bass
You can input figured bass using the figured bass popover, both for all instruments or only for 
individual instruments. You can also open the figured bass popover during note input; however, 
inputting a figure stops note input.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
start inputting figured bass.

2. Press Shift-G  to open the figured bass popover.

NOTE

If you selected an item on a staff that has local figures at earlier rhythmic positions, the 
figured bass popover is automatically set to input local figures when it opens.

3. Optional: Change the type of figure you want to enter in one of the following ways:
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● To input local figures, press Alt/Opt-L .

● To input global figures, press Alt/Opt-G .

The popover icon updates to show the current type.

Figured bass popover when inputting a global 
figure

Figured bass popover when inputting a local 
figure

4. Enter the figure you want into the figured bass popover.

For example, enter 4->3d=4r=2 for a 4-3 suspension that lasts a whole note, with the 
resolution to the third after a half note. If you want Dorico SE to follow your entry exactly, 
include O, o, or ! at the start of your entry. For example, to force Dorico SE to show 5,3 
figures.

5. Optional: Advance the figured bass popover in one of the following ways:

● Press Space  to advance the popover to the next beat according to the current time 
signature.

● Press Right Arrow / Left Arrow  to move the popover to the next/previous rhythmic grid 
position.

● Press Tab / Shift-Tab  to move the popover to the start of the next/previous bar.

6. Optional: To input an individual local figure when the popover is set to global, and vice versa, 
press Alt/Opt-Return  to input the figure.

7. Press Return  to close the popover.

RESULT
The figured bass specified is input. If you selected an item belonging to an instrument that was 
not already set to show figured bass in the current layout, its player is automatically updated to 
show them. If Dorico SE cannot identify the bass note at the position of a figure, such as if you 
input a figure on a rest, it appears as a signpost.

Dorico SE calculates and saves the pitches implied by the figures you enter in relation to the 
lowest note at that rhythmic position. This semantic understanding of the harmony implied by 
figures allows Dorico SE to update the displayed figures on different staves and if you transpose 
or change the pitch of notes.

Global figures apply to all instruments in the project and appear on all staves whose players are 
set to show figured bass. Local figures only apply to the selected instrument, and by default refer 
to its lowest staff. Local figures always appear, even if global figures exist at the same rhythmic 
positions.

NOTE

Unless you included an entry for Follow input literally at the start of your popover entry, the 
appearance of the resulting figure is determined by the default settings in Dorico SE

AFTER COMPLETING THIS TASK

● You can hide/show figured bass above specific players in each layout independently.

● You can simplify compound figures, that is, figures 9 and above.

● You can show figures on individual rests.
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RELATED LINKS
Figured bass on page 651
Lengthening/Shortening figured bass figures on page 654
Hiding/Showing figured bass in layouts on page 652
Simplifying figured bass compound intervals on page 658
Showing figured bass on rests on page 653
Fixing the current appearance of figured bass on page 658
Resetting figured bass on page 659

Figured bass popover
The following tables contain examples of what you can enter into the figured bass popover to 
input the different possible figured bass figures, including alterations and suspensions.

You can open the figured bass popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-G .

● Choose Write > Create Figured Bass.

● Click Figured Bass  in the Notations toolbox.

When inputting global figured bass, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local figured bass, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a solo player.

Figured bass popover with an 
example entry for a global figure

Figured bass popover with an 
example entry for a local figure

Figured Bass button in the 
Notations toolbox

Figures and suspensions

Type of figure Example popover entry

Figures (1-19) 1, 2, 3 and so on up to 19

Figures determined by chord symbols

Dorico SE automatically converts chord 
symbols, as you would enter into the chord 
symbols popover, into correct figured bass.

Em7, Amaj7, or G/B and so on

Hold duration d=2 (number of quarter notes) or d=1/2n 
(fraction of bass note duration)

Multiple figures

TIP

You can separate figures with commas to 
remove ambiguity.

6#42 or 6,#4,2
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Type of figure Example popover entry

Hide figures <3> or {3}

Suspensions 4->3, 4_3, or 4~3

Suspension duration r=2 (number of quarter notes) or r=1/2n 
(fraction of bass note duration)

Hold and suspension durations both specified

In this example, the hold duration is a whole 
note, the suspension duration is a half note, 
and the bass note at this position is a whole 
note.

4->3d=4r=2, 4->3,d=4,r=2, 4->3d=1nr=1/2n, or 
4->3,d=1n,r=1/2n

Follow Engraving Options for this figure only

NOTE

Must be at the start of the popover entry.

R, r, V, v, or ?

Follow input literally for this figure only

NOTE

Must be at the start of the popover entry.

O, o, or !

This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different tuplets.

NOTE

Unless you include an entry for Follow input literally at the start of your popover entry, the 
appearance of resulting figures is determined by Dorico SE’s default settings.

Accidentals and alterations

Type of accidental/alteration Popover entry

Sharp

TIP

For raised thirds, you can enter just without 
the number.

# or s

Flat b or f

Natural N or n
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Type of accidental/alteration Popover entry

Double sharp x, ##, or ds

Triple sharp x#, #x, ###, or ts

Double flat bb or db

Triple flat bbb or tb

Raise figure by a half-step (semitone) +

Lower figure by a half-step (semitone) -

Diminished figure d

Unaltered figure u

RELATED LINKS
Chord symbols popover on page 249

Inputting rehearsal marks
You can input rehearsal marks with the mouse and the keyboard. You can input rehearsal marks 
during note input and later by adding them to existing music.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a rehearsal mark. For 
example, a barline or a note.

NOTE

You can only input one rehearsal mark at a time, even if multiple items are selected.

2. Input a rehearsal mark in any of the following ways:

● Press Shift-A .

● In the Notations toolbox, click Rehearsal Marks .

RESULT
A rehearsal mark is input at the selected barline, or at the rhythmic position of other selected 
items.

The order of rehearsal marks is updated automatically, meaning you can input them in any 
order, including before and between existing rehearsal marks.
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AFTER COMPLETING THIS TASK
If you want to change the letter/number displayed in the rehearsal mark, you can change its 
index and/or sequence type.

RELATED LINKS
Rehearsal marks on page 839
Changing the index of rehearsal marks on page 841
Changing the rehearsal mark sequence type on page 842
Adding prefixes/suffixes to rehearsal marks on page 842
Mouse input settings on page 154

Inputting markers/timecodes
You can input markers at specific positions in time. In Dorico SE, timecodes are automatically 
shown alongside markers.

PROCEDURE

1. In Write mode, move the playhead to the time position where you want to input a marker.

2. Press Shift-Alt/Opt-M  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the timecode position set in the Add Marker dialog, which by default is the 
position of the playhead. It shows the text you entered, or the default text “Marker” if you did not 
change the marker text, and a timecode reflecting its position.

TIP

You can also input markers by clicking Add Marker in the Markers section of the Video panel or 
using the Markers track in Play mode.

RELATED LINKS
Markers on page 844
Timecodes on page 849
Moving the playhead on page 457
Editing marker text on page 846
Markers track on page 454
Inputting markers in the Markers track on page 454

Add Marker dialog
The Add Marker dialog allows you to input markers with custom text at specific timecodes.

● The Add Marker dialog opens automatically when you input markers in Write mode, either 
by pressing Shift-Alt/Opt-M  or by clicking Add Marker  in the Markers section of the 
Video panel.
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The Add Marker dialog contains the following options:

Text
Allows you to enter custom text that is shown in the marker.

Timecode
Allows you to specify the timecode at which you want to input the marker. For example, 
if you already know the timecodes for each marker, you can enter them directly rather 
than positioning the playhead at the position of each marker.

Valid range
Displays the timecode range of the flow.

RELATED LINKS
Markers on page 844
Timecodes on page 849

Markers section of the Video panel
In the Markers section of the Video panel in Write mode, you can input and edit markers and 
timecodes, and also define markers as important.

● You can hide/show the Video panel by clicking Video in the Notations toolbox.

The Markers section of the Video panel contains a table of markers, divided into the following 
columns:

Timecode
Shows the timecode of the marker. You can edit the timecode by double-clicking in the 
field.

Text
Shows the text of the marker. You can edit the text by double-clicking in the field.

Imp.
Stands for “important”. Allows you to define markers as important by activating their 
checkbox in this column.

When markers are defined as important, their entry uses a bold font in the table and 
they are considered when finding a suitable tempo in the Find Tempo dialog.
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Find Tempo dialog
The Find Tempo dialog allows you to calculate tempos that best accommodate your important 
markers, for example, by identifying which tempos cause markers to coincide as closely as 
possible with strong beats.

● You can open the Find Tempo dialog in Write mode by clicking Find Tempo in the Markers 
section of the Video panel.

NOTE

● The Find Tempo dialog only considers markers in a single flow. You can change which flow 
by selecting an item in the corresponding flow and then opening the dialog.

● The Find Tempo dialog is only available if you have input at least one marker in the flow and 
defined at least one marker as important.

The Find Tempo dialog contains the following options and sections:

Flow
Shows the name of the flow whose tempo you are determining. This field is read-only.

Beat unit
Allows you to change the beat unit considered for the tempo. For example, if the time 
signature for the flow is 6/8, you might want to change the beat unit to a dotted 
quarter note.

Tempo range
Allows you to set the minimum/maximum tempos you want to consider.

Tempo increments
Allows you to filter the suggested tempos according to their precision.

● Integral only: Only whole number tempos, that is, tempos without decimal places, 
are suggested.

● Allow increment by 0.25: Allows tempos with decimal places of .25, .5, and .75 to 
be suggested.
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Tempos found
Contains a list of possible tempos that you can select to see how they affect the 
position of your markers relative to beats. The list is updated automatically when you 
change options such as Tempo range and Beat unit.

The list contains columns for the following information:

● BPM: Stands for “beats per minute”. Lists different possible tempos according to 
their metronome mark value.

● IFO: Stands for “important frames off”. Indicates the average number of frames by 
which important markers miss significant beats, either before or after.

● NFO: Stands for “non-important frames off”. Indicates the average number of 
frames by which non-important markers miss significant beats, either before or 
after.

● AFO: Stands for “all frames off”. Indicates the average number of frames by which 
all markers in the flow miss significant beats, either before or after.

Found tempos are listed in descending order of average frames off for important 
markers.

Markers
Shows the impact that the tempo currently selected in the Tempos found list would 
have on each marker in the flow in more detail.

● Timecode: Shows the exact timecode of each marker.

● Text: Shows the marker text of each marker to help you identify them.

● Imp.: Indicates whether a marker has been defined as important.

● Fr. Off: Stands for “frames off”. Shows the average number of frames by which 
each marker misses being aligned to beats.

● Time Diff.: Stands for “time difference”. Shows the time difference between the 
position of the marker and the position of the nearest beat, expressed in fractions 
of a second.

● Not. Diff.: Stands for “notated difference”. Shows the notated difference between 
the position of the marker and the position of the nearest beat, expressed in 
fractions of a whole note.

Selected tempo
Displays the currently selected tempo for the flow.

Apply
Applies the selected tempo to the flow by inputting it as a tempo mark at the 
beginning of the flow. Any other tempo marks in the flow are automatically deleted.

RELATED LINKS
Defining markers as important on page 847
Metronome marks on page 932

Input methods for repeats and tremolos
You can input repeats and tremolos, including repeat endings, repeat markers, and rhythm 
slashes, with the keyboard by using the repeats popover, and with the mouse by using the 
Repeat Structures panel.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.
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TIP

To indicate repeats using repeat barlines, you can input repeat barlines using the available input 
methods for barlines.

RELATED LINKS
Input methods for bars, beats, and barlines on page 235
Barlines on page 558
Types of barlines on page 558
Repeat endings on page 853
Repeat markers on page 857
Tremolos on page 963
Rhythm slashes on page 869
Bar repeats on page 861
Repeats in playback on page 464

Repeats popover
The following tables contain the entries for the repeats popover that you can use to input 
the different tremolos, bar repeats, rhythm slash regions, repeat markers, and repeat endings 
available.

You can open the repeats popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-R .

● Select an existing repeat marker, slash region, or bar repeat and press Return .

● Choose Write > Create Repeat.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Repeats popover with an example entry
Repeat Structures button in the Notations toolbox

Repeat endings

Part of repeat ending Popover entry

Whole repeat ending end or ending

Additional repeat ending segment add

Repeat markers

Type of repeat marker Popover entry

D.C. dc, D.C., da capo, and so on
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Type of repeat marker Popover entry

D.C. al Fine dcalf, DC al Fine, D.C. al Fine, and so on

D.C. al Coda dcalc, DC al Coda, D.C. al Coda, and so on

D.S. ds, D.S., dal segno, and so on

D.S. al Fine dsalf, DS al Fine, D.S. al Fine, and so on

D.S. al Coda dsalc, DS al Coda, D.S. al Coda, and so on

to Coda toc, tc, to coda, To Coda, and so on

Segno s, seg, segno, and so on

Fine f, fin, fine, and so on

Coda c, co, coda, and so on

The list of entries for repeat markers is not comprehensive, as the flexibility of the popover 
means you can enter any reasonable version or abbreviation of the type of repeat marker you 
want and the popover recognizes it in most cases.

Single-note tremolos

Type of tremolo Popover entry

One stroke /, \, or 1

Two strokes //, \\, or 2

Three strokes ///, \\\, or 3

Four strokes ////, \\\\, or 4

Z on stem (buzz roll) z or zonstem

Remove all tremolos 0 or clear

Multi-note tremolos

Type of tremolo Popover entry

One stroke /2, \2, or 12

Two strokes //2, \\2, or 22
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Type of tremolo Popover entry

Three strokes ///2, \\\2, or 32

Four strokes ////2, \\\\2, or 42

Z on stem (buzz roll) z or zonstem

Remove all tremolos 0 or clear

Slash regions

Slash region Popover entry

New slash region slash

Bar repeats

Type of bar repeat Popover entry

Repeat last bar % or %1

Repeat last 2 bars %2

Repeat last 4 bars %4

Repeat last bar, group in 2 %1,2

Repeat last bar, group in 4 %1,4

Repeat last 2 bars, group in 2 %2,2

Repeat last 4 bars, group in 4 %4,4

RELATED LINKS
Inputting repeat markers with the popover on page 329
Inputting tremolos with the popover on page 330
Inputting slash regions on page 332
Inputting bar repeats on page 333
Bars and barlines popover on page 235
Repeat endings on page 853
Repeat markers on page 857
Tremolos on page 963
Rhythm slashes on page 869
Bar repeats on page 861
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Repeat Structures panel
The Repeat Structures panel contains the different types of repeat notations, including repeat 
endings, repeat markers, tremolos, rhythm slashes, and bar repeats.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

● You can hide/show the Repeat Structures panel by clicking Repeat Structures  in the 
Notations toolbox on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

The Repeat Structures panel contains the following sections:

Repeat Endings
Contains options that allow you to input new repeat endings and add additional 
endings to existing repeat endings.

Repeat Jumps
Contains different types of repeat markers that instruct players to jump to a specific 
point in the piece, such as “D.S. al Coda”.

Repeat Sections
Contains different sections used in conjunction with repeat jumps, such as “Coda”.

Tremolos
Contains different types of single-note and multi-note tremolos.

Rhythm Slashes
Allows you to input a region that displays rhythm slashes that are automatically 
formatted to be compatible with the prevailing time signature.

Bar Repeats
Allows you to input a region that indicates a set number of bars is repeated without 
re-notating those bars.

Inputting repeat endings with the popover
You can input repeat endings using the repeats popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. Press Shift-R  to open the repeats popover.

3. Enter end or ending into the popover.

4. Press Return  to close the popover.
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RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeats popover on page 322
Repeat endings on page 853

Adding additional repeat endings with the popover

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the repeats popover. You can add repeat ending segments both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar following the previous repeat ending 
segment.

2. Press Shift-R  to open the repeats popover.

3. Enter add into the popover.

4. Press Return  to close the popover.

5. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.

RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.
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EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

RELATED LINKS
Repeat endings on page 853
Repeats popover on page 322

Inputting repeat endings with the panel
You can input repeat endings using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. In the Notations toolbox, click Repeat Structures  to show the Repeat Structures panel.

3. In the Repeat Endings section, click Create Repeat Ending .

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeat endings on page 853

Adding additional repeat endings with the panel

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the Repeat Structures panel. You can add repeat ending segments 
both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar following the previous repeat ending 
segment.

2. In the Notations toolbox, click Repeat Structures  to show the Repeat Structures panel.

3. In the Repeat Endings section, click Add Section To Repeat Ending .

NOTE

If increasing the number of endings makes the repeat ending collide with any part of 
another repeat ending, the other repeat ending is deleted. However, its repeat barlines are 
not deleted.

4. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.

RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.

EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

RELATED LINKS
Repeat endings on page 853
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Inputting repeat markers with the popover
You can input repeat markers, including repeat jumps and repeat sections, using the repeats 
popover, both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. Press Shift-R  to open the repeats popover.

3. Enter the appropriate entry for the type of repeat marker you want into the popover.

For example, enter coda to input a coda section or enter $ to input a segno.

4. Press Return  to close the popover.

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

RELATED LINKS
Repeats popover on page 322
Repeat markers on page 857
Repeats in playback on page 464

Inputting repeat markers with the panel
You can input repeat markers using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

Write mode
Notations input 

329
Dorico SE 3.5.12



For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. In the Notations toolbox, click Repeat Structures  to show the Repeat Structures panel.

3. Click the repeat marker you want to input in any of the following sections:

● Repeat Jumps

● Repeat Sections

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

RELATED LINKS
Repeat markers on page 857
Repeats in playback on page 464

Inputting tremolos with the popover
You can input both single-note and multi-note tremolos using the repeats popover, both during 
note input and by adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.

NOTE

If you want to input multi-note tremolos, you must select at least two notes on the same 
staff or cross-staff notes that have the same notated duration. The notes can also be 
tuplets.

2. Press Shift-R  to open the repeats popover.

3. Enter the appropriate entry for the type of tremolo you want into the popover.

For example, to input a three-stroke multi-note tremolo, enter ///2.

4. Press Return  to close the popover.

5. Optional: Repeat steps 2 to 3 to input other tremolos on the selected notes.

For example, if you want notes to have both single-stem and multi-stem tremolos.
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RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

EXAMPLE

Multi-note tremolos with three tremolo strokes across tuplets

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments, for example, if you have 
tremolos in one voice and slurs in another voice.

RELATED LINKS
Repeats popover on page 322
Tremolos on page 963
Enabling independent voice playback on page 460

Inputting tremolos with the panel
You can input both single-note and multi-note tremolos using the Repeat Structures panel, both 
during note input and by adding them to existing notes.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.

NOTE

If you want to input multi-note tremolos, you must select at least two notes on the same 
staff or cross-staff notes that have the same notated duration. The notes can also be 
tuplets.

2. In the Notations toolbox, click Repeat Structures  to show the Repeat Structures panel.

3. In the Tremolos section, click the button with the number of single-note or multi-note 
tremolo strokes you want.
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For example, click Two Strokes Single-note Tremolo  to input single-note tremolos with 
two strokes or click Three Strokes Multi-note Tremolo  to input multi-note tremolos with 
three strokes.

RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

EXAMPLE

Multi-note tremolos with three tremolo strokes across tuplets

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments, for example, if you have 
tremolos in one voice and slurs in another voice.

RELATED LINKS
Tremolos on page 963
Deleting tremolos on page 965
Enabling independent voice playback on page 460

Inputting slash regions
You can input slash regions using the repeats popover.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On the staff where you want to input a slash region, select items that span the required 
duration.

2. Press Shift-R  to open the repeats popover.

3. Enter slash into the popover.

4. Press Return  to close the popover.

RESULT
During note input, slash regions are input spanning the duration of the selected note or item, 
which is usually the last input note. When adding slash regions to existing music, they span the 
selected duration.

Slash regions are automatically formatted as appropriate for the meter. If you later change the 
time signature, slash regions retain their duration but the appearance of slashes within them 
automatically updates.
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TIP

You can also input slash regions by clicking Create Slash Region in the Rhythm Slashes group 
of the Repeat Structures panel.

RELATED LINKS
Repeats popover on page 322
Rhythm slashes on page 869
Slash regions on page 869
Slash voices on page 1001

Inputting bar repeats
You can input bar repeat regions when at least one bar before the region contains notes.

PROCEDURE

1. In Write mode, select the bars on a single staff that you want to show as a bar repeat.

NOTE

You cannot input bar repeat regions in the first bar of a flow.

2. Press Shift-R  to open the repeats popover.

3. Enter the appropriate entry for the type of bar repeat region you want into the popover.

For example, enter %2,2 to repeat the previous two bars, grouped in two.

4. Press Return  to close the popover.

RESULT
A region of the selected duration is input, in which the specified type of bar repeat symbol is 
shown in the staff at the intervals specified.

NOTE

● You can also input bar repeat regions during note input; however, this inputs bar repeat 
regions from the bar containing the currently selected note. As bar repeats are mostly 
shown in empty bars, this is likely to produce unintended results.

● You can also input bar repeat regions by clicking Create Bar Repeat Region in the Bar 
Repeats group of the Repeat Structures panel. However, this only inputs a bar repeat region 
containing single-bar repeats.

AFTER COMPLETING THIS TASK
You can change how bar repeats are grouped.

RELATED LINKS
Repeats popover on page 322
Bar repeats on page 861
Bar repeat grouping on page 867
Changing bar repeat grouping on page 867
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Editing and selecting
In Dorico SE, there are multiple different ways you can select and edit the items in your project, 
from selecting items individually to making large selections covering multiple staves.

RELATED LINKS
Filters on page 340
Selection tools on page 33

Selecting/Deselecting notes and items individually
You can select/deselect existing notes and other notation items individually in the music area, 
for example, if you want to add articulations to a selection of notes or delete a short passage of 
music.

TIP

If you want to select a large number of notes/items, we recommend that you use one of the 
larger selection methods.

PROCEDURE

1. Select individual notes/items in the music area in any of the following ways:

● Ctrl/Cmd -click individual notes/items.

● Shift -click adjacent notes/items.

● Click a single note/item.

TIP

If the item you want to select is behind another item, Shift - Alt/Opt -click it.

● Make a marquee selection around multiple notes/items.

● Navigate to other items from an existing selection.

2. Deselect all currently selected items in any of the following ways:

● Press Ctrl/Cmd-D .

● Click outside of the staves within the music area.

RELATED LINKS
Selecting multiple items using marquee selections on page 335
Playing/Muting notes during note input/selection on page 341
Navigating to other items in the music area on page 345
Filters on page 340

Selecting more items of the same type
You can incrementally extend your current selection to more items of the same type and notes 
in the same voices, which is particularly helpful if you want to select multiple different items at 
once, such as dynamics and lyrics.

PROCEDURE

1. Select the notes and items you want to select more of.
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TIP

You can select notes and items on multiple staves and in specific voices, for example, if you 
only want to select notes in up-stem voices on four staves.

2. Press Ctrl/Cmd-Shift-A  to expand your selection.

3. Optional: Continue pressing Ctrl/Cmd-Shift-A  to extend your selection further.

RESULT
More of the same types of items and notes in the same voices as your original selection are 
selected, with the range of selected items expanding each time you press the key command: 
firstly to the boundaries of the bar, secondly to the boundaries of the system, and finally to the 
rest of the flow. If there are no other items available in the bar, Dorico SE automatically advances 
to the second expansion. In galley view, the second expansion is to the entire flow directly as 
there is only a single system in galley view.

For items that span multiple bars and systems, they are selected in the earliest bar/system in 
which they exist.

NOTE

Dorico SE selects the following items differently if you select only a single one of them:

● Lyrics: The selection expands only to other lyrics with the same line number, placement, and 
line type as the originally selected lyric.

● Dynamics: The first expansion is to all other dynamics in the same group and on the same 
staves as the original selection, with further expansions selecting other dynamics in other 
groups.

● Playing techniques: The selection expands only to playing techniques of the same category, 
such as Strings or Choral. Additionally, if you select either an up bow or down bow playing 
technique, the selection expands only to other up bow and down bow playing techniques. It 
does not select any other playing techniques.

Selecting multiple items using marquee selections
You can use a marquee selection to select multiple notes and notations at the same time within a 
specific area in Write mode and Play mode.

PROCEDURE

1. In the status bar, click Marquee Tool .

2. In the music area, click and drag across the area where you want to select everything.

A gray rectangle is shown to indicate which notes and notations will be selected. We 
recommend that you click in one corner of the area you want to select and drag diagonally 
across to the other corner.

RESULT
All notes and notations in the area within the gray rectangle are selected.

NOTE

Only items completely within the area are selected. However, if any part of a note/tie chain is 
within the area, the whole note/tie chain is selected.
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RELATED LINKS
Status bar on page 32
Selection tools on page 33

Large selections
You can make large selections, including selecting the contents of whole staves or the whole 
flow.

Select everything in a specific area
You can use the Marquee Tool to specify an area in which you want to select 
everything.

Select everything in the whole flow

● Press Ctrl/Cmd-A .

● Choose Edit > Select All.

Select everything on a single staff

● Select the first note on the staff, hold down Shift , and select the last note on the 
staff.

● Select the first note on the staff and choose Edit > Select To End Of System or 
Edit > Select To End Of Flow.

● Make a marquee selection that includes the staff you want to select.

Select everything on multiple adjacent staves

● Select one whole staff at the top/bottom of the range of staves you want to select 
and press Shift-Up Arrow  or Shift-Down Arrow  until all the staves you want are 
selected.

● Select one whole staff at the top/bottom of the range of staves you want to select 
and Shift -click the staff at the other end of the range of staves you want to select.

● Make a marquee selection that includes the staves you want to select.

Select more of the currently selected types of items
You can use Edit > Select More ( Ctrl/Cmd-Shift-A ) to expand your current selection 
horizontally and incrementally to other items of the same types and in the selected 
voices and staves in Write mode. For items that span multiple bars and systems, they 
are selected in the earliest bar/system in which they exist.

1. The first expansion is to the boundaries of the current bar, both to the left and 
right. If there is nothing to select within the bar, such as if you selected a whole 
note in a 4/4 bar, Dorico SE automatically advances to the second expansion.

2. The second expansion in page view is to the boundaries of the current system, 
both to the left and right. In galley view, the second expansion is to the rest of the 
flow, as there is only a single system in galley view.

3. In page view, the third expansion is to the entire flow.

Select everything in the system within a range of beats/bars
You can use the system track to select a region of beats/bars and then select 
everything on all staves in the system within that region.

TIP

If you want to select only a certain type of item, such as lyrics or dynamics, you can then use the 
corresponding filters.
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RELATED LINKS
Filters on page 340
Selecting/Deselecting notes and items individually on page 334
Selecting more items of the same type on page 334

System track
The system track is a translucent line above the top of each system in Write mode. It allows you 
to add and delete bars and beats, and to select everything on all staves in the system.

The system track above a staff, showing bars The system track above a staff, showing beat units 
reflecting the current rhythmic grid resolution

The color of the system track changes depending on how you are interacting with it.

● When you hover the mouse over it, it becomes opaque.

● When you select a region in the system track, it appears highlighted.

The system track when the mouse pointer hovers 
over it

The system track with a region selected

When you have selected a region in the system track, the following options are available:

1 Delete

Allows you to delete the selected region.

NOTE

When you hover over Delete, the highlight color of the selected region changes.

2 System Track Select

Allows you to select all items, including system objects, on all staves in the system across the 
selected region.

3 Add
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Allows you to add bars or beats of the same duration as the selection in the system track. 
The extra time is inserted immediately after the end of the selection.

NOTE

Selections on the system track are cleared whenever you make any other kind of selection, or 
when you switch layouts. However, selections on the system track are retained when switching 
between page and galley view.

RELATED LINKS
Inputting bars/beats with the system track on page 240
Deleting bars/beats with the system track on page 554
System objects on page 913

Hiding/Showing the system track
The system track is shown by default in new projects, but you can hide/show it at any time.

PROCEDURE

● Hide/Show the system track in any of the following ways:

● Press Alt/Opt-T .

● Choose View > System Track.

RESULT
The system track is shown when a tick appears beside System Track in the View menu, and 
hidden when no tick appears.

TIP

If you do not want the system track to be shown in all future projects by default, deactivate Show 
system track in new projects in the View section of the General page in Preferences.

RELATED LINKS
Preferences dialog on page 45

Selecting bars with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected bars.

PREREQUISITE
The system track is shown.

PROCEDURE

1. Click a bar in the system track.

2. Optional: Select multiple bars to the right/left of the first selected bar in any of the following 
ways:

● Shift -click bars to the right/left along the system track.

● Click and drag to the right/left along the system track.

3. Click System Track Select in the system track. It can also appear above the system track if 
your selection is narrow.
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System Track Select button in the system track The System Track Select button appears filled in 
when you hover over it

RESULT
Everything on all staves in the selected bars is selected and highlighted, including system objects, 
notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout, for example, by removing ossia staves whose signposts were included in the 
selection.

RELATED LINKS
Hiding/Showing the system track on page 338
Deleting the contents of bars on page 555
Deleting bars/beats with the system track on page 554
System objects on page 913

Selecting beats with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected beats.

PREREQUISITE
The system track is shown.

PROCEDURE

1. Press and hold Alt/Opt .

Grid lines that match the current rhythmic grid resolution appear in the system track.

2. Without releasing Alt/Opt , click and drag to the right/left along the system track.

NOTE

You cannot Shift -click when selecting beats.

3. Click System Track Select in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select button in the system track The System Track Select button appears filled in 
when you hover over it

RESULT
Everything on all staves in the selected beats is selected and highlighted, including system 
objects, notations, and signposts.
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NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout, for example, by removing ossia staves whose signposts were included in the 
selection.

RELATED LINKS
Hiding/Showing the system track on page 338
Deleting the contents of bars on page 555
Deleting bars/beats with the system track on page 554
System objects on page 913

Filters
Filters in Dorico SE allow you to select only a specific type of item from a larger selection. Dorico 
SE includes a filter for every notation item.

● You can find the available filters by choosing Edit > Filter > [Item] > [Item type].

You can also choose filters from the context menu.

All significant notation items have their own filter, for example, arpeggio signs, chord symbols, 
key signatures, and playing techniques. You can also filter for note spacing changes.

The following items have multiple filters because they have multiple types:

Notes
Allows you to filter notes, grace notes, and chords. You can also filter notes according 
to their position in chords.

Voices
Allows you to filter voices according to their stem-direction. You can also filter slash 
voices.

Dynamics
Allows you to filter all dynamics, or just gradual or immediate dynamics.

Tempos
Allows you to filter all tempo marks, or just absolute, relative, or gradual tempo 
changes.

Lyrics
Allows you to filter all lyrics, or just lyrics with a specific line number, type, or staff-
relative placement.

NOTE

There is no filter for barlines. You also cannot filter fingerings, beams, articulations, or tremolos, 
as they are considered part of the notes to which they apply.

RELATED LINKS
Filters for lyrics on page 702
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Changing filters to select/deselect
You can change whether the available filter options select or deselect the specified items. By 
default, filters select items, meaning that the resulting selection only includes the item being 
filtered.

When filters are set to deselect, the resulting selection includes everything except the item being 
filtered.

PROCEDURE

● Change the filter behavior in one of the following ways:

● To change filters to select, choose Edit > Filter > Select Only.

● To change filters to deselect, choose Edit > Filter > Deselect Only.

TIP

You can also choose these options from the context menu.

RELATED LINKS
Filters for lyrics on page 702

Playing/Muting notes during note input/selection
You can change your default setting for whether notes are played back as you input them or not. 
By default, notes are played back with the prevailing dynamic but you can set a fixed volume 
instead.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Note Input and Editing in the category list.

3. In the Note Input section, activate/deactivate Play notes during note input and selection 
in the Auditioning subsection.

4. Optional: If you want notes to play back with a fixed volume instead of the prevailing 
dynamic, activate Use fixed volume to play selected notes and change the value in the 
value field.

5. Click Apply, then Close.

RESULT
When the option is activated, notes play back as you input them during note input and when you 
select them. When it is deactivated, notes do not play back.

When Use fixed volume to play selected notes is activated, notes play back with the set 
volume. When it is deactivated, notes play back with the prevailing dynamic.

RELATED LINKS
Inputting notes on page 161
Selecting/Deselecting notes and items individually on page 334
Playing back music on page 458
Mixer on page 469
Input methods for dynamics on page 243
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Playing all/individual notes in chords during note input/selection
You can change your default setting for whether all notes in chords are played when you select 
any note in the chord or whether only the selected notes are played.

PREREQUISITE
Notes are played during note input/selection.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Note Input and Editing in the category list.

3. In the Note Input section, activate/deactivate Play all notes in chord when any is selected 
in the Auditioning subsection.

4. Click Apply, then Close.

RESULT
When the option is activated, all notes in chords are played when any note in the chord is 
selected. When it is deactivated, only the selected notes are played.

Disabling automatic linking of dynamics and slurs when pasting
By default, dynamics and slurs are automatically linked when you copy them to other staves at 
the same rhythmic position. You can disable this behavior so dynamics and slurs are not linked 
by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Note Input and Editing in the category list.

3. In the Editing section, deactivate Link dynamics and slurs to existing items when 
pasting.

4. Click Apply, then Close.

RELATED LINKS
Linked dynamics on page 648
Linked slurs on page 899

Changing existing items
You can change all items that have an associated popover, rather than deleting them and 
inputting new ones. For example, if you want to change an 8va octave line into a 15va octave line 
or change a short fermata into a long fermata.

PROCEDURE

1. Select the item or the signpost of the item you want to change.

2. Press Return  to open the popover for that item.

3. Change the existing entry in the popover.

For chord symbols, you can also play the new chord on your MIDI keyboard.
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4. Press Return  to close the popover.

RESULT
The selected item is changed according to the new entry in the popover. This changes different 
parameters for different items, such as the duration of a hold or pause or the volume of a 
dynamic.

NOTE

● If you change a fermata to a breath mark, only the fermata on the top staff is changed to 
a breath mark. If you change a caesura to a breath mark, a breath mark is input on the top 
staff at the end of the bar to which the caesura is attached. However, the existing caesura 
also remains on all staves.

● If you open the playing techniques popover in this way, Dorico SE inputs your new entry as a 
separate playing technique and does not delete the previous one.

● If you change an immediate dynamic to a combined dynamic, such as  to , or vice versa, 
Dorico SE inputs your new entry as a separate dynamic and does not delete the previous 
one.

RELATED LINKS
Editing existing lyrics on page 708
Assigning key commands on page 50
Changing dynamic levels on page 633

Changing the staff-relative placement of items
You can flip any item that can be placed both above/below the staff to change their staff-relative 
placement, for example, if you want to change the stem direction of notes quickly. For many 
items, you can do this for the current layout and frame chain only or for all layouts and frame 
chains.

NOTE

These steps do not apply to text in text frames or pedal lines.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items you want to flip.

NOTE

You cannot flip items during note input. You cannot flip text items when the text editor is 
open.

2. Press F .

RESULT
The staff-relative placement of the selected items is changed by setting Placement, Position, or 
Direction properties appropriately in the corresponding groups of the Properties panel. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain for items whose staff-relative placement properties are local.
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Deactivating these properties resets items to their default placement.

NOTE

If you flipped multiple multi-segment slurs or tuplet brackets with different hook directions at the 
same time, all selected items are set to either above or below the staff, unless they all originally 
had compatible directions set.

RELATED LINKS
Local vs. global properties on page 149
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Changing the staff-relative placement of beams on page 579
Changing the staff-relative placement of fingerings on page 663
Changing the staff-relative placement of tuplet brackets on page 974
Positions of lyrics on page 710

Resetting the appearance of items
You can reset all changes you have made to the appearance of individual items, which returns 
them to the default settings. Properties relating to the appearance of items include those that 
change their style, type, and some additions, such as poco a poco text for dynamics.

PROCEDURE

1. Select the items whose appearance you want to reset.

2. Choose Edit > Reset Appearance.

RESULT
All properties that affect the appearance of the selected items are reset to their default settings. 
For properties that are layout-specific and frame chain-specific, this only resets the appearance 
of the selected items in the current layout and frame chain.

RELATED LINKS
Copying property settings to other layouts/frame chains on page 395

Resetting the position of items
You can reset the position of individual items you have moved graphically, which returns them to 
their default position. Properties relating to the position of items include horizontal and vertical 
offsets, beat-relative position, and staff-relative placement.

PROCEDURE

1. Select the items whose position you want to reset.

2. Choose Edit > Reset Position.

RESULT
All properties that affect the position of the selected items are reset to their default settings. For 
properties that are layout-specific and frame chain-specific, this only resets the position of the 
selected items in the current layout and frame chain.
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Hiding non-printing elements
You can temporarily hide all visible elements that do not print, such as signposts and selection 
highlights. This allows you to view the current layout as it will appear when printed/exported 
without switching to Print mode.

PROCEDURE

● Press and hold \ (Windows) or ` (macOS) .

RESULT
All non-printing elements in the current layout are hidden until you release the key command. 
Printing elements appear as they will when printed/exported.

TIP

You can also hide/show individual non-printing elements permanently.

RELATED LINKS
Annotations on page 537
Printing layouts on page 522
Exporting layouts as graphics files on page 525
Hiding/Showing signposts on page 350
Hiding/Showing the system track on page 338
Hiding/Showing guide bar numbers on page 566
Hiding/Showing colors for notes out of range on page 727
Hiding/Showing voice colors on page 997
Hiding/Showing bar repeat region highlights on page 864
Hiding/Showing slash region highlights on page 870

Navigation
There are different ways you can navigate around the layout currently open in the music area, 
such as moving the selection to different items or bringing specific bar numbers or pages into 
view. Many navigation methods function in multiple modes.

If you have an item selected, you can navigate to other notes/items, which moves the selection to 
those notes/items.

RELATED LINKS
Workspace setup on page 36

Navigating to other items in the music area
You can navigate to other notes and items in the music area after you have selected a note/item, 
for example, if you want to move the selection to other notes along the staff without using the 
mouse.

PROCEDURE

1. Select an item in the music area.

● If you want to navigate through notes, select a note.
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● If you want to navigate through a particular type of item, such as rehearsal marks, select 
an item of that type.

NOTE

You can only navigate forwards/backwards through items on the same staff. You cannot 
navigate to other items of the same type on other staves.

2. Navigate to other notes or items in any of the following ways:

● To navigate to the next item or note in the same voice, press Right Arrow .

● To navigate to the previous item or note in the same voice, press Left Arrow .

● To navigate to the closest note above the current selection, press Up Arrow .

This navigates to any existing notes on the same staff first, then to the lowest note/rest 
on the staff above. If a whole chord was selected, this leaves the bottom note in the 
chord selected.

● To navigate to the closest note below the current selection, press Down Arrow .

This navigates to any existing notes on the same staff first, then to the highest note/rest 
on the staff below. If a whole chord was selected, this leaves the top note in the chord 
selected.

● To navigate forwards to the note/rest at the start of the next bar, press Ctrl/Cmd-
Right Arrow .

● To navigate backwards to the note/rest at the start of the previous bar, press Ctrl/Cmd-
Left Arrow .

● To navigate to the top staff in the system, press Ctrl/Cmd-Up Arrow .

● To navigate to the bottom staff in the system, press Ctrl/Cmd-Down Arrow .

3. Optional: Switch the selection to another type of item at the same rhythmic position in one 
of the following ways:

● Press Tab  to cycle forwards through items.

● Press Shift-Tab  to cycle backwards through items.

NOTE

You cannot switch the selection to system objects, such as system text or rehearsal marks. 
However, you can select system objects directly and navigate through them.

4. Optional: After switching the selection to another type of item, navigate to other items of 
that type.

RELATED LINKS
System objects on page 913

Going to flows
You can go to the next/previous flow in the current layout, which automatically brings the start of 
that flow into view in the music area. This is particularly useful when navigating around layouts 
that contain many flows.

These steps function in Setup mode and Write mode.
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PROCEDURE

● Go to a different flow in one of the following ways:

● To go to the previous flow in the layout, choose Edit > Go To > Go To Previous Flow.

● To go to the next flow in the layout, choose Edit > Go To > Go To Next Flow.

RESULT
The music area updates to show the start of the corresponding flow. Dorico SE automatically 
positions the top staff towards the top left of the music area.

TIP

You can assign key commands to both Go To Previous Flow and Go To Next Flow on the Key 
Commands page in Preferences.

RELATED LINKS
Key Commands page in the Preferences dialog on page 47

Going to pages
You can go to any specified page in the current layout using its page number, for example, to 
jump quickly to the exact page that requires changes when editing music.

These steps function in Setup mode and Write mode.

PROCEDURE

1. Choose Edit > Go To > Go To Page to open the Go To Page dialog.

2. Enter the page number to which you want to go into the Page field.

3. Click OK.

RESULT
The music area updates to show the start of the corresponding page. Dorico SE automatically 
centers the top of the page in the music area.

TIP

You can assign a key command for Go To Page on the Key Commands page in Preferences.

Going to bars
You can go to any specific bar in any flow in the current layout, for example, to jump quickly to 
the exact bar that requires changes when editing music.

These steps function in Setup, Write, and Play modes.

PROCEDURE

1. Press Ctrl/Cmd-G  to open the Go To Bar dialog.

2. Select the flow containing the bar to which you want to go from the Flow menu.

3. Enter the bar number to which you want to go into the Bar field.
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4. Click OK.

RESULT
The music area updates to show the corresponding bar. Dorico SE automatically positions the 
top staff towards the top left of the music area.

In Play mode, the playhead moves to the start of the corresponding bar. Dorico SE automatically 
positions the playhead at the start of the ruler.

Dragging pages in the music area
You can drag pages in the music area in Write mode to bring other parts of your music into view, 
including in galley view.

PROCEDURE

1. In the status bar, click Hand Tool .

2. Click and drag in any empty space within the page boundaries in the music area.

The mouse pointer changes into a hand symbol during the move.

RELATED LINKS
Status bar on page 32
Selection tools on page 33

Zooming in/out of the music area
You can change the zoom level in the music area, for example, if you want a larger overview 
when inputting notes but to see notes and notations more closely when making detailed 
graphical amendments.

PREREQUISITE
If you want to keep a specific item in the center of the music area when you zoom in/out, you 
have selected that item.

PROCEDURE

1. Zoom in in any of the following ways:

● Press Ctrl/Cmd-= or Z .

● Spread two fingers outwards on a touchpad.

● Scroll upwards on a mouse wheel.

● Use the zoom options in the status bar.

2. Zoom out in any of the following ways:

● Press Ctrl/Cmd-- or X .

● Pinch two fingers together on a touchpad.

● Scroll downwards on a mouse wheel.

● Use the zoom options in the status bar.
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RESULT
The zoom level in the music area is changed. If you had anything selected, Dorico SE uses your 
selection as the focal point of the zoom. If you had nothing selected, Dorico SE focuses on the 
area previously in the center of the view.

RELATED LINKS
Zoom options on page 35
Zooming in/out of tracks in the event display on page 426
Workspace setup on page 36

Signposts
In Dorico SE, signposts indicate the positions of important items or changes that cannot be 
seen in the score, such as key signatures with no accidentals, hidden items, and rhythmic feel 
changes.

Signposts have different colors depending on the item they mark because many items can 
show signposts, such as hidden bar numbers and time signatures. They are selectable, meaning 
you can use signposts to change properties of hidden/invisible items, for example, by selecting 
system break signposts in order to change the staff size from that position.

Signposts include a text summary of the hidden/invisible item to help you identify it. For 
example, time signature signposts include the time signature, expressed as a fraction, and its 
beat subdivision.

The signpost of a hidden time signature

When multiple signposts can exist at a single rhythmic position, they stack vertically so that they 
do not overlap and remain legible.

Multiple signposts for different items at the same rhythmic position

NOTE

By default, signposts are not printed or included when you export graphics files.

RELATED LINKS
Annotations on page 537
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Hiding/Showing signposts
You can hide/show all signposts or only hide/show signposts for specific items at any time in 
Setup mode and Write mode.

PROCEDURE

● Hide/Show signposts in any of the following ways:

● To hide/show all signposts, choose View > Signposts > Hide Signposts.

● To hide/show signposts for specific items, choose View > Signposts > [Type of item].

RESULT
Signposts for individual items are shown when a tick appears beside the corresponding item in 
the menu, and hidden when no tick appears.

All signposts are shown when no tick appears beside Hide Signposts in the menu, and hidden 
when a tick appears.

Arranging tools
Arranging tools in Dorico SE allow you to allocate notes to different staves and voices quickly and 
efficiently.

These tools include copying notes and items to multiple staves at the same time, and multiple 
times within a selected range, moving notes between staves, and changing the voices of notes.

RELATED LINKS
Filters on page 340
Changing the duration of notes on page 170

Deleting notes and items
You can delete any notes/items you have input into your project independently of each other, 
such as deleting repeat endings without deleting the notes in them. However, you must be in 
Write mode. You cannot delete notes and items in Setup mode or Print mode.

You can also delete notes in Play mode, but not other notation items.

PROCEDURE

1. In Write mode, select the notes/items you want to delete.

2. Press Backspace or Delete .

RESULT
All selected notes/items are deleted from your project. Deleted notes are replaced by implicit 
rests as appropriate. Dorico SE moves your selection to the most logical and nearby item to the 
deleted items. For example, if you deleted a note, Dorico SE’s first choice is the nearest note in 
the same voice.

If a slur began or ended on a deleted note, the slur is automatically repositioned to the next/
previous notehead. If only one note is left under a slur, the slur is automatically deleted.

Holds and pauses are not automatically deleted if they are not selected when you delete notes. 
They are positioned above the note/rest closest to their rhythmic position, or over whole bar 
rests if you delete all notes in a bar.
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Any repeat barlines input as part of repeat endings are not deleted automatically when you 
delete repeat endings.

TIP

You can also delete markers by selecting them in the Markers section of the Video panel and 
clicking Delete in the action bar.

RELATED LINKS
Editing and selecting on page 334
Deleting rests on page 883
Deleting barlines on page 560
Insert mode on page 179

Copying and pasting items
You can copy and paste items, including notes and notations, to other rhythmic positions and 
staves in different ways.

PROCEDURE

1. In Write mode, select the items you want to copy.

2. Copy the selected items to other rhythmic positions in any of the following ways:

● Alt/Opt -click each position to which you want to paste them.

● Press R  to repeat the material directly after itself.

● Press Ctrl/Cmd-C , select the position to which you want to paste them, and press Ctrl/
Cmd-V .

● To copy items to the staff above, select them and choose Edit > Paste Special > 
Duplicate to Staff Above.

● To copy items to the staff below, select them and choose Edit > Paste Special > 
Duplicate to Staff Below.

RESULT
The selected items are copied without deleting them from their original positions.

RELATED LINKS
Copying and pasting automation points on page 443
Large selections on page 336
Selecting/Deselecting notes and items individually on page 334
Moving notes to other staves on page 353
Disabling automatic linking of dynamics and slurs when pasting on page 342
Repitching notes without changing their rhythm on page 201
Insert mode on page 179
Chord mode on page 194
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Copying and pasting items to multiple staves
You can copy and paste notes and other items to multiple staves at once, for example, to copy a 
single phrase to all the woodwind staves when they are playing in unison.

PROCEDURE

1. In Write mode, select the items you want to copy to multiple staves.

2. Press Ctrl/Cmd-C  to copy the selected items.

3. Select an item on each staff to which you want to paste the selected items.

4. Press Ctrl/Cmd-V  to paste the selected items.

RESULT
The selected items are copied to all of the selected staves.

TIP

If you selected a range of items on each staff, the selected items are also pasted multiple times 
to fill the selected range.

RELATED LINKS
Large selections on page 336
Disabling automatic linking of dynamics and slurs when pasting on page 342

Copying and pasting items to fill a selected range
You can copy and paste items, including notes and notations, multiple times within a selected 
range at once, for example, if you want to fill multiple bars with the same phrase.

NOTE

You can only copy and paste items that have a duration to fill a selection. For example, you can 
copy and paste gradual dynamics to fill a selection but not immediate dynamics.

PROCEDURE

1. In Write mode, select the items you want to copy throughout a range.

2. Press Ctrl/Cmd-C  to copy the selected items.

3. Select the range throughout which you want to paste the selected items.

4. Press Ctrl/Cmd-V  to paste the selected items.

RESULT
The selected items are copied as many times as will fit within the selected range without 
extending beyond it.

TIP

If you selected a range on multiple staves, the selected items are also pasted to multiple staves.

RELATED LINKS
Large selections on page 336
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Moving notes to other staves
You can move notes to other staves of any type, for example, if you want to move individual 
notes from one keyboard staff to another after importing a keyboard part from a MIDI file.

PROCEDURE

1. In Write mode, select the notes you want to move to another staff.

2. Move the notes to another staff in one of the following ways:

● To move notes to the staff above, press Alt/Opt-N .

● To move notes to the staff below, press Alt/Opt-M .

RESULT
The selected notes are moved to another staff by cutting them from their original staff and 
pasting them to the new staff. By default, they are pasted into the first voice active on that staff.

Notes within tuplets remain tuplets even if you did not select the tuplet bracket, tuplet number/
ratio, or tuplet signpost.

RELATED LINKS
Creating cross-staff beams on page 583
Copying and pasting items to multiple staves on page 352
Changing the duration of notes on page 170

Swapping the contents of staves
You can swap the contents of two staves for a selected range, for example, if you change your 
mind about which players have each line in an arrangement.

PROCEDURE

1. In Write mode, select the range of music on two staves that you want to swap.

2. Choose Edit > Paste Special > Swap. You can also choose this option from the context 
menu.

RESULT
The contents of the selected staves for the selected duration are swapped.

RELATED LINKS
Swapping the contents of voices on page 354

Changing the voice of existing notes
You can change the voice of notes after they have been input, including notes in slash voices. For 
example, you can change notes in an up-stem voice to a down-stem voice or a slash voice.

PROCEDURE

1. In Write mode, select the notes whose voice you want to change.

TIP

You can use large selections and filters to select many notes in the same voice quickly.

2. Change the voice in any of the following ways:
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● Choose Edit > Voices > Change Voice > [Voice].

● Choose Edit > Voices > Change Voice > [Slash Voice].

TIP

● You can also choose these options from the context menu.

● If there is only one voice on the staff, you can create a new voice for your selected notes.

RESULT
The voice of the selected notes is changed, which might cause Dorico SE to change the stem 
directions of the selected notes and other notes on the staff, and add implicit rests to ensure 
correct notation based on convention.

If you changed notes to a slash voice, they no longer play back.

AFTER COMPLETING THIS TASK
You can later delete or hide rests and change the stem direction of notes manually.

You can also change whole voices into slash voices.

RELATED LINKS
Hiding/Showing voice colors on page 997
Inputting notes into multiple voices on page 174
Inputting notes into slash voices on page 175
Large selections on page 336
Filters on page 340
Implicit rests in multiple-voice contexts on page 881
Deleting rests on page 883
Changing the stem direction of notes on page 923
Changing the slash voice type on page 1002
Changing the duration of notes on page 170

Swapping the contents of voices
You can swap the contents of two voices that contain musical material.

PROCEDURE

1. In Write mode, select the notes in two voices that you want to swap.

2. Choose Edit > Voices > Swap Voice Contents. You can also choose this option from the 
context menu.

RESULT
The contents of the voices are swapped. For example, the notes previously in an up-stem voice 
are now in a down-stem voice, and the notes previously in a down-stem voice are now in an 
up-stem voice.

NOTE

Depending on the pitches involved in the swap and their stem directions, the notes might 
overlap. Dorico SE automatically positions notes with the noteheads partially overlapping, in 
order to minimize the horizontal space they occupy and maintain the clarity of the rhythm. 
However, if you want to change this arrangement, you can change the order of voices or change 
the voice column index.

Write mode
Arranging tools 

354
Dorico SE 3.5.12



EXAMPLE

An E is in the up-stem voice, an F in the down-stem 
voice.

After swapping their voice contents, the E is in the 
down-stem voice, and the F is in the up-stem voice.

RELATED LINKS
Swapping the order of voices on page 999
Voice column index on page 999

Splitting flows
You can split flows at specific rhythmic positions. Flows in Dorico SE are independent of each 
other, meaning they can contain different players and have different time signatures and key 
signatures.

PREREQUISITE
The layout currently open in the music area contains all players with music in the flow, such as a 
full score layout.

IMPORTANT

We strongly recommend only splitting flows in layouts that contain all players.

PROCEDURE

1. In Write mode, select a note or item at the position where you want to split the flow.

2. Choose Write > Split Flow.

RESULT
The flow is split into two flows: the existing flow and a new flow that begins from the position of 
the item you selected. By default, new flows in full score layouts start on a new page in page view 
and are shown on a separate background in galley view.

RELATED LINKS
Flows on page 122
Adding flows on page 122
Deleting flows on page 124
Deleting empty bars at the end of flows on page 554
Allowing/Disallowing multiple flows on the same page on page 377
Switching to galley/page view on page 42
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Comments
Comments allow you to add notes or instructions at precise positions in your project without 
affecting the music. They are considered annotations in Dorico SE, meaning they are not printed 
by default.

Comments exist outside of the music, so they do not affect note spacing, vertical spacing, or 
casting off. However, you can attach them to specific items and staves in order to show the 
precise subject of each comment.

A passage with comments and replies

By default, comments are shown in the music area. They appear as speech bubble symbols as 
close as possible to their attached position. Comments that are replies are stacked vertically 
below the original comment.

All comments in the current flow are listed in the Comments panel in Write mode. Clicking a 
comment, either in the Comments panel or in the music area, automatically moves the view to 
bring that rhythmic position into focus.

In addition to its content, each comment identifies the following:

● Author of the comment, using either the current user account name or a custom name

On macOS, the user account name uses the long account name; on Windows, it uses the 
full name associated with the account. If Dorico SE cannot determine your account name, a 
dialog appears into which you can add the name and initials you want to use for comments. 
You can also change these in Preferences.

● Date the comment was added

● Instrument to which the comment applies

● Bars to which the comment applies

NOTE

In the music area, only the initials of the author are shown. In the Comments panel, all 
information is shown.

You can hide/show comments at any time, and you can choose to include them, alongside other 
view options, when printing/exporting layouts.

RELATED LINKS
Deleting notes and items on page 350
Comments panel on page 358

Write mode
Comments 

356
Dorico SE 3.5.12



Changing the author name used for comments on page 361
Annotations on page 537

Adding comments
You can add comments at any rhythmic position in your project, including adding different 
comments to multiple staves at the same rhythmic position.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
add a comment. If you want your comment to apply to a range, select multiple items.

2. Press Alt/Opt-C  to open the Comment dialog.

3. Enter your comment into the dialog.

4. Click OK to close the dialog and add the comment.

RESULT
The text you entered into the dialog is saved as a comment. In the music area, it is indicated by a 
speech bubble symbol that contains your initials. In the Comments panel, the text you entered is 
shown alongside your full username, the date, and the instrument and bar number to which you 
added the comment.

TIP

You can also add comments by clicking Create Comment in the action bar in the Comments 
panel, or by choosing Write > Create Comment.

EXAMPLE

A comment in the music area

Comment dialog
The Comment dialog allows you to enter and edit text as comments.

● You can open the Comment dialog by adding a comment, replying to a comment, or double-
clicking an existing comment, either in the music area or in the Comments panel.
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Comments panel
The Comments panel shows all the comments in the current flow as a list. Replies to comments 
are indented to indicate their relationship to the original comment. The Comments panel is 
located on the right of the window in Write mode.

● You can hide/show the Comments panel by clicking Comments  in the Notations toolbox 
on the right of the window in Write mode.

You can also hide/show the panel whose icon is currently selected in the Notations toolbox 
by pressing Ctrl/Cmd-9  or clicking the disclosure arrow on the right of the window.

Comments panel

Each comment in the panel shows the following:
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Comments 

358
Dorico SE 3.5.12



1 Author name

This uses either the current user account or a custom name, depending on the preference 
that was set when the comment was added.

2 Comment content

3 Date the comment was added to the project

4 Instrument to which the comment applies

5 Bars to which the comment applies

The action bar at the bottom of the panel contains the following options:

Create Comment

Adds a comment to the selected rhythmic position and staff.

Edit Comment

Opens the selected comment in the Comment dialog and allows you to change its 
content.

Reply to Comment

Adds a comment that is a reply to the selected comment. Replies are shown indented 
in the Comments panel and stacked in the music area.

Export Comments

Exports all the comments in the project as an HTML file, which opens automatically in 
your default web browser. The HTML file is automatically saved in the same location as 
the project.

Delete Comment

Deletes the selected comments.

RELATED LINKS
Changing the author name used for comments on page 361
Exporting comments on page 361
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Replying to comments
You can add replies to existing comments, which is useful when co-ordinating with others as this 
organizes the list of comments in the Comments panel into clear sections.

PROCEDURE

1. In Write mode, select the comment to which you want to reply. You can do this in the music 
area and in the Comments panel.

2. Press Alt/Opt-R  to open the Comment dialog.

3. Enter your reply into the dialog.

4. Click OK to close the dialog and add the reply.

RESULT
The text you entered into the dialog is saved as a reply to the selected comment. In the music 
area, it is indicated by a speech bubble symbol that contains your initials and is positioned 
immediately below the selected comment.

In the Comments panel, the reply is indented below the selected comment.

TIP

You can also reply to comments by clicking Reply to Comment  in the action bar in the 
Comments panel, or by choosing Write > Reply to Comment.

EXAMPLE

A reply stacked below the selected comment

Editing existing comments
You can change the contents of existing comments after you have added them, for example, to 
correct misspellings or add further information.

PROCEDURE

1. Double-click the comment you want to edit to open the Comment dialog. You can do this in 
the music area and in the Comments panel.

2. Change the text in the dialog.

3. Click OK to save your changes and close the dialog.
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Changing the author name used for comments
You can change the author name used for comments to either your user account name or a 
custom name. This affects subsequent comments you add to the project without changing the 
author name used for existing comments.

For the custom name, you can specify both the full name that is shown in the Comments panel 
and the initials shown in the music area.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click General in the category list.

3. In the Comments subsection, choose one of the following options for Author name for 
comments:

● User Name

● Custom Name

4. Optional: If you chose Custom Name, enter the full name you want to use into the Full 
name field.

5. Optional: If you chose Custom Name, enter the initials you want to use into the Initials 
field.

6. Click Apply, then Close.

Exporting comments
You can export all comments in all flows in your project to an HTML file, for example, to view 
them all in a single place.

PROCEDURE

1. In Write mode, click Comments  in the Notations toolbox to show the Comments panel.

2. In the Comments section action bar, click Export Comments .

RESULT
All comments in the project are saved as an HTML file, which opens automatically in your default 
web browser. The comments are displayed in a table. The HTML file is automatically saved in the 
same location as the project.

RELATED LINKS
Annotations on page 537
Printing layouts on page 522
Exporting layouts as graphics files on page 525

Hiding/Showing comments
You can hide/show comments at their positions in the music, for example, if you want to hide 
them when inputting music but show them when engraving.

Comments are considered annotations in Dorico SE, meaning they are not printed by default.
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PROCEDURE

● Choose View > Comments.

RESULT
Comments are shown in the music as speech bubbles when a tick appears beside Comments in 
the menu, and hidden when no tick appears.
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Layout and formatting

There are various ways you can control the layout and formatting of pages in your project, 
including changing the size of pages and adjusting note spacing.

NOTE

In Dorico SE, you cannot edit all the objects and settings used to determine page formatting, 
such as frames and master pages. However, we have included basic information about these for 
your information.

RELATED LINKS
Master pages on page 363
Page formatting on page 367
Note spacing on page 406
Staff spacing on page 408

Engrave mode
Engrave mode is only available in Dorico Pro. It provides finer controls over the appearance of 
your music, such as positioning items graphically wherever you want and creating/editing master 
pages that determine the appearance and layout of pages.

Master pages
Master pages function like templates in Dorico SE, allowing the same page formatting to be 
applied to multiple pages and in different layouts.

NOTE

Page size and margins, page orientation, and staff size for all layouts are specified in Setup > 
Layout Options.

All pages in your scores and parts inherit their layout formats from master pages. However, in 
Dorico SE, you cannot edit master pages or create new ones; this is only available in Dorico Pro.

Dorico SE provides default master pages for first (First) and subsequent (Default) pages. This 
ensures that there is appropriate page formatting for first pages independently of subsequent 
pages, as the first page typically includes additional information, such as the title, composer, and 
copyright.

Master pages are contained in master page sets for full score and part layouts. Master page sets 
are automatically applied to every layout that you create.

NOTE

Changing individual pages in layouts is considered a master page override in Dorico SE. This 
includes, for example, editing the title or running header in Write mode. Pages with master 
page overrides are not automatically deleted, even if they are empty because the layout became 
shorter.
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If you want to change the information shown at the tops of pages, that is, the title and running 
header text that you cannot select, we recommend that you do so in the Project Info dialog to 
avoid master page overrides. The big title at the top of the first page is the project title, and the 
running header on subsequent pages uses the flow title for the top flow on that page.

RELATED LINKS
Layout Options dialog on page 90
Applying master page sets to layouts on page 370

Master page sets
In Dorico SE, master pages are provided as parts of master page sets. Master page sets group 
master page formats together, so there is a master page for all possible situations in your 
project.

New projects contain the following master page sets by default:

● Default Full Score: Used for full score and custom score layouts by default.

● Default Part: Used for part layouts by default.

The default master page sets contain master pages for first (First) and subsequent (Default) 
pages.

Master page sets also contain flow headings that allow you to show flow titles above the start 
of each flow automatically, including when they start on the same page as a previous flow. The 
default master page sets each contain a single flow heading.

The default master page sets are applied automatically to the appropriate layouts in each new 
project. You can apply different master page sets to each layout independently.

RELATED LINKS
Flow headings on page 364
Applying master page sets to layouts on page 370

Flow headings
Flow headings allow you to show the titles of flows immediately above their first system 
automatically. They function like templates, in much the same way as master pages, allowing 
the same flow heading formatting to be applied to multiple flows in different layouts.

Flow headings exist as part of master page sets. By default, Dorico SE provides one flow heading 
in each master page set, which contains tokens to display the flow number and flow title; in a 
new project, this appears as “1. Flow 1”. This is used automatically for all flow headings. In Dorico 
SE, you cannot edit flow headings or create new ones; this is only available in Dorico Pro.

Flow headings are automatically inserted above the first system of the flow to which they apply, 
meaning they do not have a fixed vertical position on the page like other frames and follow 
the music if it moves. They also occupy vertical space within music frames. You can change the 
margins for the space above and below flow headings.
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A flow heading above the third flow in a part layout

NOTE

Changing individual flow headings in layouts is considered a master page override in Dorico 
SE. This includes, for example, deleting a token from a flow heading. Pages with master page 
overrides are not automatically deleted, even if they are empty because the layout became 
shorter.

RELATED LINKS
Tacets on page 389
Hiding/Showing flow headings on page 379
Changing the margins above/below flow headings on page 379
Hiding/Showing information in running headers above flow headings on page 380
Frames on page 365
Text tokens on page 397

Frames
Dorico uses boxes called frames to position music, additional text, and graphics inside the 
margins of pages. In Dorico SE, you cannot input or edit frames, but frames on master pages 
control the formatting of pages in your project.

In Dorico SE, there are the following types of frames:

Music frames
Music frames display the music of selected players and flows or blank staves.

A music frame displaying the start of a piano piece

Text frames
Text frames display text, which you can enter directly or by using text tokens.

A text frame displaying a project title, "Sechs Lieder"

Graphics frames
Graphics frames display the images that you load into them, which can be in a variety 
of formats.
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A graphics frame with image loaded

EXAMPLE

The first page of a piano piece. It contains a music frame, text frames for the title, dedication, and composer, 
a flow heading frame inside the top of the music frame, and graphics frames in the top corners.

RELATED LINKS
Flows in Dorico on page 17
Layouts in Dorico on page 21
Frame breaks on page 387
Text tokens on page 397
Master pages on page 363
Flow headings on page 364
Changing page margins on page 369

Music frame chains
A music frame chain is a collection of music frames that show the same selection of music in a 
set order, often in sequence. Music frame chains can include any number of frames, including 
only a single music frame.

The default master pages contain a single frame chain that is set to display all flows and all 
players in the layout. Therefore, Dorico SE automatically creates enough pages and frames to 
display all flows in all the layouts that use those master pages. In Dorico SE, you cannot create 
new frame chains or change the flows and players assigned to frame chains; this is only available 
in Dorico Pro.

RELATED LINKS
Master pages on page 363
Layouts in Dorico on page 21
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Page formatting
The formatting of pages in Dorico SE is determined by a number of factors, including the layout’s 
staff size, page margins, the master page applied to them, any casting off values applied to 
them, system and frame breaks, and frame padding.

The most important factors that determine how pages are formatted in Dorico SE are:

Staff size
Staff size refers to the distance between the top and bottom lines of staves. The most 
appropriate staff size depends on the intended purpose and contents of the layout. In 
many cases, changing the staff size is the quickest way to produce legible layouts.

Staff spacing
Staff spacing mostly involves the height of staves and the necessary gaps between 
staves and systems.

Casting off
Casting off, that is, the process of determining a set number of bars per system and 
systems per page, allows you to fix a regular appearance across entire layouts.

System and frame breaks
System and frame breaks allow you to adjust layouts on a local level, by determining 
which bars are shown on each system and where music is pushed into the next frame.

Page margins
Page margins determine the dimensions of pages in layouts. Frames cannot exceed 
the boundaries set by the margins of the layout, which you can change on the Page 
Setup page in Setup > Layout Options. You can change the size of margins on each 
edge of each page.

Master pages
All pages in your layouts inherit their layout formats from master pages. Although you 
cannot create or edit master pages in Dorico SE, we recommend being familiar with 
them as a concept, so you are aware of how pages are formatted. For example, if you 
override a master page, such as by editing the title directly in the music area, empty 
pages that are no longer required might not be deleted automatically.

TIP

The default master pages in Dorico SE contain tokens for the project title, lyricist, and 
composer on the first pages in layouts, and the flow title (score layouts) or layout name 
(part layouts) at the top of subsequent pages. Part layouts also automatically show the 
layout name in the top left of the first page. These tokens refer to information in the 
Project Info dialog, so we recommend entering information in the Project Info dialog 
in order to show it in your layouts.

Flow headings
Flow headings show the number and title of each flow immediately above their first 
system automatically. They have no fixed vertical position and follow the music if it 
moves. The default flow heading contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”. In Dorico SE, you cannot edit flow 
headings or create new ones.

You can hide/show flow headings on a per-layout basis. Deleting or editing individual 
flow headings is considered a master page override, which is a type of page format 
change.
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Music frame margins
Music frames have margins at the top and bottom. Music frame margins provide 
padding to ensure that musical material displayed within the frame remains on the 
page. For example, if music frames have no padding, the top line on the top staff in the 
frame is positioned at the top of the frame. Any notes that require ledger lines above 
the staff might then be positioned off the top of the page. You can change the music 
frame margins for each layout.

We recommend familiarizing yourself with these concepts, and how to use them together and in 
different contexts, in order to produce well-formatted layouts.

RELATED LINKS
Staff size on page 382
Staff spacing on page 408
Casting off on page 385
System breaks on page 388
Frame breaks on page 387
Master pages on page 363
Flow headings on page 364
Hiding/Showing flow headings on page 379
Tacets on page 389
Hiding/Showing empty staves on page 373
Hiding/Showing used chord diagrams grids on page 610
Layouts on page 124
Flows on page 122
Players on page 94
Project Info dialog on page 88

Changing the page size and/or orientation
You can change the page size and/or orientation of each layout independently. For example, you 
can use a large, landscape page in full score layouts and a small, portrait page for part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page size and/or 
orientation.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Page Size section, select a page size from the Size menu.

For example, you can select fixed page sizes, such as A3 or Letter, or select Custom to 
define your own page size.

5. Optional: If you selected Custom, change the Width and Height of the page by changing 
the values in the value fields.

6. Choose one of the following options for Orientation:

● Portrait

● Landscape
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7. Optional: Repeat steps 2 to 6 for other layouts whose page size/orientation you want to 
change.

8. Click Apply, then Close.

RESULT
The page size and/or orientation is changed for all the selected layouts.

NOTE

Changing the page size of layouts might not change the paper size automatically selected for 
those layouts in the Print Options panel in Print mode. For example, if your default printer 
cannot print the page size selected for layouts, the largest paper size the printer can handle is 
selected. Similarly, if you had already set options for printing layouts before changing the page 
size in Layout Options, Dorico SE attempts to preserve your original print options.

Similarly, the page orientation is independent of the paper orientation. We recommend that you 
check that layouts have the correct paper orientation set for their page orientation in the Print 
Options panel in Print mode before printing/exporting, as it is possible to print landscape layouts 
on portrait paper and vice versa.

RELATED LINKS
Page sizes and paper sizes on page 533
Paper orientation on page 534
Paper size and orientation setup on page 534
Changing the default staff/system spacing on page 371
Printing layouts on page 522
Exporting layouts as graphics files on page 525

Changing page margins
You can change the page margins of each layout independently, for example, if you want wider 
margins for layouts in your project that will be spiral bound.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page margins.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Page Margins section, choose one of the following options for Page margins:

● Same: All pages in the selected layouts have the same margins.

● Different: Left and right pages in the selected layouts can have completely different 
margins.

● Mirrored: Left and right pages in the selected layouts use the same margin values but 
they correspond to the inside/outside edges of pages.

5. Optional: Change the margins by changing the values in the value fields.

6. Click Apply, then Close.
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RESULT
The page margins in the selected layouts are changed.

RELATED LINKS
Changing the default music frame margins on page 381
Changing the margins above/below flow headings on page 379
Hiding/Showing used chord diagrams grids on page 610

Applying master page sets to layouts
You can change the master page set used by each layout in your project, for example, if you want 
a custom score layout to use the Default Part master page set because that set shows the layout 
name on the first page.

By default, full score and custom score layouts use the Default Full Score master page set and 
part layouts use the Default Part master page set.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose master page set you want to change.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Master Page section, select the master page set you want from the Master page set 
menu.

5. Click Apply, then Close.

RESULT
The selected master page set is applied to the selected layouts.

RELATED LINKS
Changing when the First master page is used on page 378
Allowing/Disallowing multiple flows on the same page on page 377
Hiding/Showing flow headings on page 379

Changing the default staff size
You can change the default size of staves in each layout independently. For example, you can 
have a small staff size in full score layouts but a larger staff size in part layouts.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose staff size you want to change.
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Space Size section, select the staff size you want from the Rastral size menu.

NOTE

If you select Custom, you can set a custom value in the Space size field, expressed in your 
preferred unit of measurement.

You can also set a Custom value by changing the value when any Rastral size is selected.

5. Optional: Repeat steps 2 to 4 for other layouts.

6. Click Apply, then Close.

RESULT
The staff size is changed throughout the selected layouts.

TIP

You can also change the size of individual staves.

RELATED LINKS
Staff size on page 382
Brackets and braces on page 592
System objects on page 913
Changing the size of individual staves on page 383

Changing the default staff/system spacing
You can change the default gaps between staves and systems in each layout independently. For 
example, you can have smaller gaps between staves in full score layouts to accommodate more 
staves, and larger gaps between systems in part layouts to give players space to add pencil 
markings.

TIP

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● We recommend that you set the ideal gaps to the minimum value acceptable to you, as 
Dorico SE automatically allocates additional space for other items, such as system objects 
and dynamics, and avoids collisions between notes and staves above/below.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default staff/system 
spacing.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Vertical Spacing in the category list.
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4. In the Ideal Gaps section, change the values for the different contexts as required.

5. Click Apply, then Close.

RESULT
The minimum gaps between staves and systems in the corresponding contexts are changed. This 
affects how much space Dorico SE allows for staves/systems in its casting off estimations and 
whether frames are considered full enough to justify vertically automatically.

RELATED LINKS
Per-layout vertical spacing options on page 408
Note spacing on page 406
Changing the default note spacing on page 406
Hiding/Showing empty staves on page 373
Changing the default player order on page 97

Changing the vertical justification of staves/systems
You can change the minimum fullness threshold above which Dorico SE automatically vertically 
justifies staves and systems, which means they are evenly distributed to fill the height of frames. 
You can also control whether staves and systems are both vertically justified or only systems are 
vertically justified.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the automatic vertical 
justification of staves/systems.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Vertical Spacing in the category list.

4. In the Ideal Gaps section, choose one of the following options for Gap to use for divisi 
staves:

● Staff to staff

● Braced staff to braced staff

5. In the Vertical Justification section, change the values for the following options, individually 
or together:

● Justify distance between staves and systems when frame is at least [n]% full

● Justify distance only between systems when frame is at least [n]% full

6. Activate/Deactivate Justify staves when frame with single system is above this threshold.

7. Click Apply, then Close.

RESULT
The automatic vertical justification of staves and systems in the selected layouts is changed. 
Braced staves are never vertically justified.
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EXAMPLE

A page with staves and systems both justified The same page with only systems justified

RELATED LINKS
Per-layout vertical spacing options on page 408
Changing the default staff/system spacing on page 371
Hiding/Showing blank staves after final flows on page 375

Hiding/Showing empty staves
You can hide/show empty staves differently in each layout independently. For example, you can 
show all staves, including empty staves, in a full score layout for the conductor but hide empty 
staves in a full score layout intended for reference only.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show empty staves.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Vertical Spacing in the category list.

4. In the Staff Visibility section, choose one of the following options for Hide empty staves:

● After first system

● All systems

● Never

5. Activate/Deactivate Allow individual staves of multi-staff instruments to be hidden.
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6. Optional: For Players excluded from Hide Empty Staves, activate the checkbox for each 
instrument you want to be shown regardless of your choice for Hide empty staves.

7. Click Apply, then Close.

RESULT
Empty staves in the selected layouts are hidden/shown according to your choice. If you activated 
Allow individual staves of multi-staff instruments to be hidden, any single empty staves in 
multi-staff instruments, such as piano or harp, can be hidden in the selected layouts.

RELATED LINKS
Extra staves on page 910
Divisi on page 916
Changing the default staff/system spacing on page 371
Per-layout vertical spacing options on page 408
Hiding/Showing blank staves after final flows on page 375
Changing the default player order on page 97
Setting custom player orders on page 98

Hiding/Showing staves from system/frame breaks
You can manually change staff visibility from the rhythmic positions of system/frame breaks 
onwards by hiding, showing, and resetting individual staves, for example, if you have hidden 
empty staves in the layout but want specific empty staves to appear in some sections.

PROCEDURE

1. Optional: If you want to change staff visibility manually from a rhythmic position that does 
not yet have a system/frame break, select an item at the position from which you want to 
change staff visibility.

2. Open the Manual Staff Visibility dialog in one of the following ways:

● If a system/frame break signpost exists at the position where you want to change staff 
visibility, select it and press Return  or double-click it.

● If no system/frame break exists, choose Edit > Staff > Manual Staff Visibility. You can 
also choose this option from the context menu.

3. Change staff visibility as required.

For example, you can activate and change the setting for individual staves or use the options 
in the action bar to change the setting for all staves simultaneously.

4. Click OK to save your changes and close the dialog.

RESULT
Staff visibility is changed from the selected rhythmic position or system/frame break signpost 
onwards until the next staff visibility change or the end of the flow, whichever comes first.

If a system/frame break signpost did not yet exist at the selected rhythmic position, a system 
break with your staff visibility settings is inserted at the selected rhythmic position.

RELATED LINKS
Frame breaks on page 387
System breaks on page 388
Staff spacing on page 408
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Manual Staff Visibility dialog
The Manual Staff Visibility dialog allows you to hide, show, and reset individual staves manually 
from system/frame breaks.

You can open the Manual Staff Visibility dialog in Write mode in any of the following ways:

● Choose Edit > Staff > Manual Staff Visibility when an item is selected in the music area. You 
can also choose this option from the context menu.

● Select a system/frame break signpost and press Return , or double-click a system/frame 
break signpost.

The Manual Staff Visibility dialog comprises the following:

1 Staff list

Contains all the staves that exist at the selected rhythmic position, including hidden empty 
staves. Activating staves includes them in the manual staff visibility change.

For each staff, the following staff visibility options are available:

● Reset: Resets the visibility of the staff to the default setting in the layout, as set on the 
Vertical Spacing page in Layout Options.

● Show: Shows the staff from the selected rhythmic position onwards, whether it is empty 
or not.

● Hide: Hides the staff from the selected rhythmic position onwards, whether it is empty 
or not.

2 Action bar

Contains options that allow you to change the staff visibility setting of all staves 
simultaneously.

● Clear All: Deactivates all staves.

● Reset All: Activates all staves and sets them to Reset.

● Show All: Activates all staves and sets them to Show.

● Hide All: Activates all staves and sets them to Hide.

Hiding/Showing blank staves after final flows
You can hide/show additional blank staves to fill the page after the final flow in each layout 
independently, for example, if you want to emulate the convention of showing additional blank 
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staves between the final system and the bottom of the page when formatting part layouts for 
recording sessions.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show blank staves after the 
ends of flows.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Flows section, activate/deactivate Fill frame with blank staves.

5. If you activated Fill frame with blank staves, activate/deactivate Show blank staves in 
systems identical to final flow.

6. Customize the appearance of blank staves in one of the following ways:

● If you activated Show blank staves in systems identical to final flow and want to 
show clefs that follow the previous flow on blank staves, choose Include clefs.

● If you activated Show blank staves in systems identical to final flow and want to hide 
clefs on blank staves, choose Exclude clefs.

● If you deactivated Show blank staves in systems identical to final flow, change the 
number of staff lines in blank staves by changing the value for Number of staff lines 
for blank staves.

RESULT
Blank staves are shown after the final flow in the selected layouts when Fill frame with blank 
staves is activated, and hidden when it is deactivated. When shown, blank staves appear below 
the final system in the final flow and fill the width of the final system if it is not fully horizontally 
justified.

When Show blank staves in systems identical to final flow is activated, blank staves follow the 
staff grouping of the final flow, such as two bracketed staves in a part layout with two players 
assigned to it. When it is deactivated, single blank staves without clefs are shown.

NOTE

You cannot input music or change brackets/braces on blank staves.

RELATED LINKS
Changing the default staff/system spacing on page 371
Changing the vertical justification of staves/systems on page 372
Changing the horizontal justification of final systems on page 382
Staff labels on page 901
Brackets and braces on page 592
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Starting layouts on left-hand pages
By default, all layouts start on a right-hand page, as convention dictates that odd numbered 
pages are always on the right-hand page. However, you can set individual layouts to start on a 
left-hand page, for example, to facilitate page turns better in that layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to start on a left-hand page.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Page Numbers section, change the value for Initial page number to an even 
number.

5. Click Apply, then Close.

RESULT
The first page in the selected layouts is shown on a left-hand page when the initial page number 
is even.

Allowing/Disallowing multiple flows on the same page
You can allow/disallow new flows to be shown on the same page as previous flows if there is 
space, for example, to reduce the number of pages required for parts in works with multiple 
movements. By default, new flows are allowed on the same page in part layouts and are not 
allowed in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow multiple flows to be shown 
on each page.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Flows section, choose one of the following options for New flows:

● Always start new page

● Allow on existing page

5. Click Apply, then Close.

RESULT
Always start new page ensures flows in the selected layouts always begin at the start of the 
next page after the end of the previous flow.

Allow on existing page allows flows in the selected layouts to continue immediately after each 
other, including within the same music frame if there is sufficient space. Flow headings are 
automatically shown above the start of flows if you have chosen to show flow headings in the 
selected layouts.
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NOTE

Flows are not automatically split into separate music frames. You must insert frame breaks 
manually to divide flows into separate music frames if required.

RELATED LINKS
Text tokens on page 397
Casting off on page 385
Assigning flows to layouts on page 126
Assigning players to flows on page 123
Hiding/Showing information in running headers above flow headings on page 380
Hiding/Showing blank staves after final flows on page 375

Changing when the First master page is used
You can change the circumstances when the First master page is used in each layout 
independently, for example, if you want to use it for the start of every flow in the full score 
but only want to use it for the first flow in part layouts, even when subsequent flows start at the 
top of the page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change when the First master 
page is used.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Flows section, choose one of the following options for Use ‘First’ master page:

● Never

● First flow only

● Any flow starting at top of page

5. Click Apply, then Close.

RESULT

● Choosing Never means the First master page is not used for any page in the selected 
layouts.

● Choosing First flow only means the First master page is used for the first page in the layout 
but no other pages, even if some subsequent flows start at the top of a page.

● Choosing Any flow starting at top of page means the First master page is used for all 
pages in the layout that begin with the start of a flow.

RELATED LINKS
Layout Options dialog on page 90
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Hiding/Showing flow headings
You can hide/show flow headings in each layout independently, for example, if your project only 
contains a single flow and you only want to show the project title. You can also hide the heading 
for the first flow but show flow headings for subsequent flows.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show flow headings.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Flows section, choose one of the following options for Show flow headings:

● Never

● Not for first flow

● For all flows

5. Click Apply, then Close.

RESULT
Flow headings are shown above the first system in each flow in the selected layouts when you 
choose For all flows, hidden when you choose Never, and hidden above the first system in the 
first flow but shown above all other flows when you choose Not for first flow.

They are automatically positioned above each flow and below the preceding flow according to 
the margins set for each layout.

NOTE

Hiding flow headings does not hide the flow title shown at the top of the second page onwards 
by default.

RELATED LINKS
Flow headings on page 364
Allowing/Disallowing multiple flows on the same page on page 377
Hiding/Showing information in running headers above flow headings on page 380
Changing when the First master page is used on page 378

Changing the margins above/below flow headings
You can change the margins both above and below flow headings, which control the gap 
between the preceding flow and the flow heading, and the gap between the flow heading and 
the start of the next flow.

PREREQUISITE
Flow headings are shown in the layouts in which you want to change the margins above/below 
flow headings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts in which you want to change the margins above/below 
flow headings.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Flows section, change the values for Flow heading top margin and/or Flow heading 
bottom margin.

5. Click Apply, then Close.

RESULT
Changing the value for Flow heading top margin increases/decreases the gap between the top 
of flow headings and the end of the preceding flow.

Changing the value for Flow heading bottom margin increases/decreases the gap between the 
bottom of flow headings and the start of the next flow. For example, when the bottom margin is 
set to 0, the bottom of the lowest frame in the flow heading aligns with the top staff line of the 
first system in the flow below the flow heading.

EXAMPLE

Flow heading with default margins above/below Flow heading with decreased margins above/below

RELATED LINKS
Flow headings on page 364
Changing page margins on page 369
Changing the default music frame margins on page 381
Hiding/Showing used chord diagrams grids on page 610

Hiding/Showing information in running headers above flow 
headings

You can hide/show flow titles, page numbers, and flow page numbers separately when they 
appear above flow headings at the top of a new page in each layout independently. Hiding such 
information in running headers is a custom in publishing.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show information in running 
headers above flow headings.
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Flows section, choose one of the following options for Flow title in header:

● Show above flow heading

● Hide above flow heading

5. Choose one of the following options for Page number in header:

● Show above flow heading

● Hide above flow heading

6. Choose one of the following options for Flow page number in header:

● Show above flow heading

● Hide above flow heading

7. Click Apply, then Close.

RESULT
The corresponding information is hidden/shown when they appear above flow headings at the 
top of the page.

NOTE

In order to hide running header information, the top of the music frame containing the 
flow heading frame must be lower than the top of text frames containing the corresponding 
information. If the top of the music frame is the same height as a running header text frame, any 
corresponding information in the text frame is shown, regardless of your setting.

RELATED LINKS
Frames on page 365
Master pages on page 363
Hiding/Showing page numbers on page 792

Changing the default music frame margins
You can change the default margins in all music frames in each layout independently. For 
example, you might want more padding at the top of music frames in part layouts containing lots 
of notes above the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose music frame margins you want to change.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Music Frame Margins section, change the values for Top and/or Bottom.

5. Click Apply, then Close.

Layout and formatting
Page formatting 

381
Dorico SE 3.5.12



RESULT
The margins within all music frames in the selected layouts are changed.

RELATED LINKS
Changing page margins on page 369
Changing the margins above/below flow headings on page 379
Changing the default staff/system spacing on page 371
Hiding/Showing used chord diagrams grids on page 610

Changing the horizontal justification of final systems
You can change whether the final systems of flows always fill the width of frames or only do so 
above a certain fullness threshold in each layout independently. By default in Dorico SE, the final 
systems of flows only justify to the full width of the frame when they are more than half full.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the justification of the 
final systems in flows.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Note Spacing in the category list.

4. Change the justification of final systems in flows in one of the following ways:

● If you always want the final systems in flows to justify fully, deactivate Only justify final 
system in flow when more than [n]% full.

● If you want to change the minimum fullness of final systems before they justify, change 
the value for Only justify final system in flow when more than [n]% full.

5. Click Apply, then Close.

RESULT
The automatic justification of the final systems in flows in the selected layouts is changed.

TIP

You can also change the width of individual systems independently of your default settings by 
changing their start/end positions.

RELATED LINKS
Changing the first system indent on page 915
Fixing the number of bars per system on page 385
Hiding/Showing blank staves after final flows on page 375

Staff size
Staff size refers to the distance between the top and bottom lines of staves, and can be 
expressed as a point size or in another supported unit of measurement, such as millimeters. 
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For individual staves, you can use a scale size of the default staff size in the layout. The most 
appropriate staff size depends on the intended purpose of the layout.

For example, full orchestral scores that are quite dense need a much smaller staff size than 
individual parts, which require large enough notes so that performers can read them easily. 
Staves can overlap and the music can become illegible if the staff size is too large in dense 
scores.

In Dorico SE, you can set the staff size using the rastral size and the space size, depending on 
which measurement is more appropriate for the selected layouts.

● Rastral size is the size of the full staff, measured from the bottom line to the top line.

● Space size is the distance between two staff lines.

When changing the staff size of each layout in Layout Options, we recommend that you use one 
of the preset rastral sizes, as these are based on traditional and generally accepted staff sizes 
that are all widely used in music engraving.

NOTE

The size of staves can affect the size of system objects.

RELATED LINKS
System objects on page 913
Changing your preferred unit of measurement on page 45
Changing the default staff size on page 370
Staff spacing on page 408

Changing the size of individual staves
You can change the size of individual staves in each flow independently of other staves and 
your layout settings. For example, piano accompaniment parts often include the solo line of the 
instrument the piano is accompanying on a smaller staff.

A piano part with smaller viola staff above

You can change the size of individual staves to a set scale size, expressed as a percentage of the 
normal staff size in the layout, or set a custom scale.
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TIP

If you want to change the staff size to represent an alternative version of a passage, you can 
instead add an ossia staff, which you can show for specific regions.

PROCEDURE

1. Select an item on the staff whose size you want to change.

NOTE

You can only change the size of a single staff at a time.

2. Choose Edit > Staff Size > [Staff size]. You can also choose this option from the context 
menu.

3. Optional: If you choose Custom Staff Size, you must set the staff size using the Custom 
Staff Size dialog that opens.

RESULT
The size of the selected staff is changed in the current flow. This also works in combination with 
the other ways of changing the staff size, such as changing the size of all staves in the layout or 
changing the size of staves from specific system/frame breaks.

NOTE

● Changing the staff size of individual staves affects the staff size of all instruments held by 
that player.

● Changing the staff size of individual staves affects its size for the whole flow.

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

RELATED LINKS
Brackets and braces on page 592
System objects on page 913

Custom Staff Size dialog
The Custom Staff Size dialog allows you to change the size of individual staves by a custom scale 
factor.

● You can open the Custom Staff Size dialog by selecting an item in the music area and 
choosing Edit > Staff Size > Custom Staff Size.
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The Custom Staff Size dialog contains the following options:

Default staff size
Displays the default size of staves in the current layout. This size is set on the Page 
Setup page in Setup > Layout Options.

The default staff size is expressed as both a point size and in your preferred unit of 
measurement.

Rastral size
Allows you to select the rastral size on which you want to base your custom staff size.

Scale factor
Sets the custom staff size, expressed as a percentage of the selected rastral size.

New staff size
Displays the new custom staff size for the selected staff as a result of the changes you 
have made in the dialog.

The new staff size is expressed as both a point size and in your preferred unit of 
measurement.

RELATED LINKS
Changing your preferred unit of measurement on page 45

Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as setting 
the number of systems per page. In Dorico SE, you can fix both the number of bars per system 
and the number of systems per music frame in each layout independently.

RELATED LINKS
Per-layout vertical spacing options on page 408
Hiding/Showing blank staves after final flows on page 375

Fixing the number of bars per system
You can define a fixed number of bars you want included in each system in each layout 
independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Layout and formatting
Casting off 

385
Dorico SE 3.5.12



2. In the Layouts list, select the layouts in which you want to fix the number of bars per 
system.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Casting Off section, activate Fixed number of bars per system.

5. Change the number of bars you want in each system by changing the value in the value field.

6. Click Apply, then Close.

RESULT
The number of bars automatically contained in each system in the selected layouts is changed. 
If any of the layouts contain two-bar or four-bar repeat regions, Dorico SE automatically adjusts 
casting off to ensure phrases are not split across systems.

RELATED LINKS
Bar repeats on page 861
Inserting system breaks on page 388
Inserting frame breaks on page 387
Changing the horizontal justification of final systems on page 382

Fixing the number of systems per frame
You can define a fixed number of systems you want included in each music frame in each layout 
independently. Because the default master pages have a single music frame per page, fixing the 
number of systems per frame usually fixes the number of systems per page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to fix the number of systems per 
frame.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Casting Off section, activate Fixed number of systems per frame.

5. Change the number of systems you want in each frame by changing the value in the value 
field.

6. Activate/Deactivate Scale number of systems by frame height.

7. Click Apply, then Close.

RESULT
The number of systems automatically contained in each music frame in the selected layouts is 
changed.

If you activated Scale number of systems by frame height, the number of systems contained in 
each frame is adjusted according to the size of the music frame. For example, pages with smaller 
frames, such as the first page, contain fewer systems than your casting off setting.
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Frame breaks
In Dorico SE, you can use frame breaks to push musical material into the next frame, which is 
usually on the next page, meaning you can use frame breaks to create page breaks. For example, 
you can use frame breaks to insert page turns at specific positions in part layouts.

Frame breaks are indicated by signposts, which you can hide/show at any time. They are also 
layout-specific, meaning each layout can have frame breaks at different rhythmic positions.

TIP

You can also control the content of music frames by fixing the number of systems per music 
frame in each layout.

RELATED LINKS
Signposts on page 349
Per-layout vertical spacing options on page 408
Hiding/Showing staves from system/frame breaks on page 374

Inserting frame breaks
You can insert frame breaks at any rhythmic position, for example, to create page turns at 
appropriate places in the current layout.

PREREQUISITE
If you want to insert frame breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.

PROCEDURE

1. In Write mode, select a note or item at the rhythmic position where you want to insert a 
frame break.

For example, if you select a clef, the clef is placed at the end of the frame and all following 
notes are moved to the start of the next music frame.

2. Choose Edit > Frame Break.

RESULT
A frame break is inserted immediately before the rhythmic position of the earliest selected item. 
All notations after the frame break are moved to the next music frame.

NOTE

If you insert a frame break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico SE does not automatically move the frame break to before/after the phrase, causing it to 
be split across the frame break.

RELATED LINKS
Hiding/Showing multi-bar rests on page 885
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Hiding/Showing frame break signposts
You can hide/show frame break signposts at any time.

PROCEDURE

● Choose View > Signposts > Frame Breaks.

RESULT
Frame break signposts are shown when a tick appears beside Frame Breaks in the menu, and 
hidden when no tick appears.

Deleting frame breaks
You can delete frame breaks after you have inserted them.

PREREQUISITE
Frame break signposts are shown.

PROCEDURE

1. Select the frame break signposts of the frame breaks you want to delete.

2. Press Backspace or Delete .

System breaks
System breaks are where musical material reaches the right page margin and must continue on 
a new system, usually below the previous system on the same page or on a new page. Dorico SE 
automatically arranges music across systems so that notes are correctly spaced and legible, but 
you can also control system breaks manually.

System breaks are indicated by signposts, which you can hide/show at any time. They are also 
layout-specific, meaning each layout can have system breaks at different rhythmic positions.

TIP

You can also control the content of systems by fixing the number of bars per system in each 
layout.

RELATED LINKS
Signposts on page 349
Fixing the number of bars per system on page 385
Per-layout vertical spacing options on page 408
Hiding/Showing staves from system/frame breaks on page 374

Inserting system breaks
You can insert system breaks at any rhythmic position.

PREREQUISITE
If you want to insert system breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.
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PROCEDURE

1. In Write mode, select a note or item at the rhythmic position where you want to insert a 
system break.

For example, if you select a clef, the clef is placed at the end of the system, and the notes are 
moved to the start of the next system.

2. Choose Edit > System Break.

RESULT
A system break is inserted immediately before the rhythmic position of the earliest selected item. 
All notations after the system break are moved to the next system.

NOTE

If you insert a system break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico SE does not automatically move the system break to before/after the phrase, causing it to 
be split across the system break.

RELATED LINKS
Hiding/Showing multi-bar rests on page 885

Hiding/Showing system break signposts
You can hide/show system break signposts at any time.

PROCEDURE

● Choose View > Signposts > System Breaks.

RESULT
System break signposts are shown when a tick appears beside System Breaks in the menu, and 
hidden when no tick appears.

Deleting system breaks
You can delete system breaks after you have inserted them.

PREREQUISITE
System break signposts are shown.

PROCEDURE

1. Select the system break signposts of the system breaks you want to delete.

2. Press Backspace or Delete .

Tacets
Tacet is the indication used to show that a player does not play anything in an entire flow, which 
might be a movement in a symphony or cue in a film score. In Dorico SE, you can generate tacets 
automatically.

Dorico SE shows tacets for flows in part layouts when the following conditions are met:
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● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.

● The flows are assigned to the master page frame chain in the part layout.

● You have chosen to show tacets in the part layout.

An extract of a part layout where the player is tacet in the second flow

NOTE

We do not recommend that you use Copy Staff Spacing and Lock Frame on pages where tacets 
are the first or last system in frames. Because tacets do not contain any bars, Dorico SE cannot 
insert system or frame breaks at the ends of tacets in order to lock the frame contents.

However, you can insert system and frame breaks at the start of tacets.

You can change the text shown in tacets and the margin above/below them in each layout 
independently.

RELATED LINKS
Assigning players to flows on page 123
Allowing/Disallowing multiple flows on the same page on page 377
Staff spacing on page 408
Inserting system breaks on page 388
Inserting frame breaks on page 387
Flow headings on page 364

Hiding/Showing tacets
You can hide/show tacets in each layout independently, for example, if you want to show empty 
bars or multi-bar rests in some layouts to allow those players to add in notes on those staves 
later.

PREREQUISITE

● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.
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● The flows are assigned to the master page frame chain in the part layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tacets.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Tacets section, activate/deactivate Show tacet for flows where no players are 
assigned.

5. Click Apply, then Close.

RESULT
Tacets are shown in the selected layouts when Show tacet for flows where no players are 
assigned is activated and the prerequisite criteria are also met.

When it is deactivated, any flows to which the player is not assigned do not appear in the layout. 
When the player is assigned to those flows, all bars in the flow are shown in the part, split into 
empty bars and multi-bar rests as appropriate for the flow.

RELATED LINKS
Tacets on page 389
Multi-bar rests on page 884
Assigning players to flows on page 123
Hiding/Showing multi-bar rests on page 885

Editing tacet text
You can change the text shown in tacets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose tacet text you want to edit.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Tacets section, enter the text you want in the Tacet text field.

5. Click Apply, then Close.

RESULT
The text shown in all tacets in the selected layouts is changed.

Layout and formatting
Tacets 

391
Dorico SE 3.5.12



Changing the margins above/below tacets
You can change the margins both above/below tacets in each layout independently, for example, 
if you want smaller gaps between flow headings and tacets in some layouts to facilitate page 
turns better.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
tacets.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Tacets section, change the values for Margin above tacet and/or Margin below 
tacet.

5. Click Apply, then Close.

RESULT
Changing the value for Margin above tacet increases/decreases the minimum gap between 
tacets and whatever precedes them.

Changing the value for Margin below tacet increases/decreases the minimum gap between 
tacets and whatever follows them.

RELATED LINKS
Flow headings on page 364

Condensing
Condensing is the process of showing the music for multiple players on fewer staves than 
normal, usually by allowing multiple instruments of the same type to share a staff, such as Flutes 
1-2 or Horns 1-4.

In Dorico SE, you cannot enable automatic condensing as it is only available in Dorico Pro. 
However, if you import or open a project that contains layouts with condensing enabled, those 
staves remain condensed.

NOTE

● You cannot select anything on condensed staves.

● Condensing is never enabled in galley view, so you can switch to galley view to see all staves 
separately. This does not disable condensing in the current layout.

● Having condensing enabled in any layout in a project can cause Dorico SE to operate more 
slowly, due to the large number of calculations involved.

RELATED LINKS
Staff labels on condensed staves on page 908
Switching to galley/page view on page 42
Divisi on page 916
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Part formatting propagation
The propagation of part formatting involves copying the layout options and system formatting 
that determine the layouts of pages in specific part layouts and applying them to other part 
layouts. This can save time when formatting similar parts.

System formatting includes the positions of system and frame breaks, but also note spacing 
changes that affect the horizontal space that notes require.

In Dorico SE, you can copy layout options and system formatting both together and 
independently of each other from a selected source layout to other destination layouts. For 
example, for source layouts whose formatting relies primarily on their Casting Off settings in 
Setup > Layout Options, it is likely that copying only their layout options is sufficient to produce 
the required formatting in the destination layouts without adding system/frame breaks on every 
system.

You can also copy the layout-specific property settings from the layout currently open in the 
music area to all other layouts in which those items appear.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

Propagate Part Formatting dialog
The Propagate Part Formatting dialog allows you to copy the page formatting and layout 
options from a source layout to destination layouts.

You can open the Propagate Part Formatting dialog in Setup mode in any of the following 
ways:

● Right-click a part layout in the Layouts panel and choose Propagate Part Formatting from 
the context menu. This automatically selects that layout as the source layout in the Copy 
formatting from list.

● Choose Setup > Propagate Part Formatting.
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The Propagate Part Formatting dialog contains the following sections and options:

1 Copy formatting from list

Contains a list of all the part layouts in the project. You can only select a single part layout as 
the source layout.

2 Propagate formatting to list

Contains a list of all the part layouts in the project. You can select multiple part layouts as 
destination layouts.

3 Selection options

Allow you to select/deselect all the part layouts in the Propagate formatting to list.

4 Include layout options

Allows you to copy layout options relating to part formatting from the source layout to the 
destination layouts. These options include page size, page margins, the default master page 
set, space size, vertical spacing, note spacing, casting off, multi-bar rest settings, and staff 
labels.

5 Include system formatting

Allows you to copy the distribution of bars in systems, systems on pages, and note spacing 
changes from the source layout to the destination layouts. Dorico SE achieves this by copying 
system breaks, frame breaks, and note spacing changes, inputting additional system and 
frame breaks as required, and deleting any existing system breaks, frame breaks, and note 
spacing changes in the destination layouts.

Copying part formatting to other layouts
You can copy all the formatting from one part layout to other part layouts, for example, to save 
time if multiple part layouts in your project require similar formatting. You can include layout 
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options, such as page size and margins, and other page formatting, such as system and frame 
breaks.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

PROCEDURE

1. In the Layouts panel in Setup mode, right-click the card of the part layout whose part 
formatting you want to copy and choose Propagate Part Formatting from the context 
menu.

2. In the Copy formatting from list, select the part layout whose part formatting you want to 
copy.

By default, the layout whose card you used to open the dialog is selected.

3. In the Propagate formatting to list, select the part layouts to which you want to copy part 
formatting.

You can use the selection options in the action bar, Shift -click adjacent layouts, and Ctrl/
Cmd -click individual layouts.

4. Activate/Deactivate Include layout options.

5. Activate/Deactivate Include system formatting.

6. Click OK to copy part formatting to the selected layouts and close the dialog.

RESULT
Part formatting from the selected source layout is copied to the selected destination layouts.

● If you activated Include layout options, layout options are copied from the source layout to 
the destination layouts.

● If you activated Include system formatting, Dorico SE copies the distribution of bars 
in systems, systems on pages, and note spacing changes from the source layout to the 
destination layouts.

TIP

If the formatting of the source layout relies primarily on its Casting Off settings in Setup > 
Layout Options, it is likely that only activating Include layout options is sufficient to produce 
very similar formatting in the destination layouts without adding system/frame breaks on every 
system.

Copying property settings to other layouts/frame chains
Local properties are layout- and frame chain-specific, meaning that by default, changing local 
properties for an item in one layout does not affect the same item in other layouts or other 
frame chains. You can copy the properties set on notes and items to all other layouts and frame 
chains in which they appear, for example, to show gradual dynamics with the same style in part 
layouts after changing their style in the full score layout.

PROCEDURE

1. Select the notes or items whose properties you want to copy to other layouts.
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2. Choose Edit > Propagate Properties.

RESULT
All properties set on the selected notes/items are copied to all layouts and frame chains in which 
those notes/items appear.

TIP

If you know in advance that you want your changes to affect all layouts and frame chains, you 
can change the property scope before changing property settings.

RELATED LINKS
Large selections on page 336
Local vs. global properties on page 149
Changing the property scope on page 149
Resetting the appearance of items on page 344
Resetting the position of items on page 344

Music Fonts dialog
The Music Fonts dialog allows you to change the font used for notations and glyphs project-
wide. Any font you use for notations and glyphs must be SMuFL-compliant.

● You can open the Music Fonts dialog by choosing Edit > Music Fonts.

The Music Fonts dialog contains all available SMuFL fonts you have installed on your computer 
that have the appropriate metadata for Dorico SE to recognize them. By default, Dorico SE comes 
with the following SMuFL-compliant fonts:

● Bravura: The default music font, inspired by traditional classical music engraving.

● Petaluma: Handwritten music font style, similar to the traditional style used for jazz music.

Changing the music font used in the Music Fonts dialog changes the fonts used for notations, 
glyphs, and other items that are not text, such as clefs, dynamics, and bold tuplet numbers/
ratios.

The Music Fonts dialog also contains the following options:
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Update text fonts when changing music fonts
Allows you to include/exclude text fonts when changing the music font. For example, 
deactivating this option allows you to change the appearance of notes and notations 
without affecting the appearance of flow titles and staff labels.

● For the Bravura music font, the equivalent text font is Academico.

● For the Petaluma music font, the equivalent text font is Petaluma Script.

Use font’s recommended engraving options
Allows you to import the default settings that come with the font.

NOTE

Certain items that are marked as optional in SMuFL fonts, such as clef changes and non-bold 
tuplet numbers/ratios, are not affected when you change the music font.

Text objects vs. text in text frames
Text in Dorico SE can exist as a text object, added to individual staves or as system text, and in 
text frames, which are fixed to the page rather than the music.

As you cannot see or edit frames in Dorico SE, both types of text look very similar. You can tell the 
difference between text objects and text in text frames by clicking them once: if the text appears 
highlighted with an attachment line to a staff, it is a text/system text object. If the text does not 
appear highlighted or has no attachment line, it is in a text frame.

You can edit both types of text in the same ways, but you can only use text tokens in text frames. 
You cannot use tokens in text added to staves/systems.

NOTE

The project title, page numbers, and running headers that are automatically shown in layouts are 
in text frames. Their contents and formatting come from master pages, which you cannot edit or 
create in Dorico SE. Editing text frames in layouts is considered a master page override. Pages 
with master page overrides are not automatically deleted, even if they are empty because the 
layout became shorter.

If you want to change the information shown at the tops of pages, we recommend that you do 
so in the Project Info dialog to avoid master page overrides. The big title at the top of the first 
page is the project title, and the running header on subsequent pages uses the flow title for the 
top flow on that page.

RELATED LINKS
Editing text on page 310
Text tokens on page 397
Hiding/Showing text objects on page 405

Text tokens
Text tokens are codes that you can use as substitutes for information stored in your project, such 
as titles, composers, and the time and date. This can reduce the risk of mistakes or outdated 
information appearing in your project. Text tokens are also known as “wildcards” or “text codes”.

For example, if you use a token for the title of your project, you can change the project title in the 
Project Info dialog as often as you want, and the project title in every layout in your project is 
updated automatically.
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Tokens can refer to information in the Project Info dialog, including for the whole project or 
each flow individually. Tokens can also refer to the current time and date or the time and date 
the project was last saved.

NOTE

● You can only use text tokens in text frames. You cannot use tokens in staff/system text 
objects.

● Flow tokens refer to the nearest flow below the top edge of their text frame and on the same 
page. When the top edge of a text frame containing a flow token is in line with or above the 
top staff line of the first staff in a system, it then refers to that flow.

You can specify the flow number to which you want flow tokens to refer, such as 
{@flow2title@}. This always shows the specified flow, regardless of the token’s position.

You can see the flow number of each flow in the Flows panel in Setup mode.

● You can access all the available tokens from the context menu when the cursor is inside a 
text frame. In the context menu, tokens are organized into submenus.

The following tokens are available in Dorico SE:

General tokens

Description Token

Page number {@page@}

Player list {@playerlist@}

Player names {@playernames@}

Layout name {@layoutname@}

Layout number, as set in the Layouts panel in 
Setup mode

{@layoutnumber@}

Project file name {@projectfilename@}

Path to the project’s save location, including 
the project file name

{@projectfilepath@}

Staff label tokens

Music symbol Token

Full staff labels of the players in the current 
layout

{@staffLabelsFull@}

Abbreviated staff labels of the players in the 
current layout

{@staffLabelsShort@}
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You can use staff label tokens, for example, as an alternative way to name part layouts, instead of 
using the default {@layoutName@} token shown at the top left of the first page in part layouts.

NOTE

Staff label tokens might not exactly match the appearance of staff labels shown before initial 
barlines; however, staff label tokens respect your per-layout options for how transpositions 
appear in staff labels.

Music symbol tokens

Music symbol Token

Flat accidental: ♭ {@flat@}

Sharp accidental: ♯ {@sharp@}

Natural accidental: ♮ {@natural@}

Treble clef (G clef) {@gClef@}

Bass clef (F clef) {@fClef@}

Alto clef (C clef) {@cClef@}

Fermata above {@U+E4C0@}

TIP

● This list is not comprehensive, as you can enter the code point for any SMuFL symbol within 
a token. You can find the necessary code points in the SMuFL specification online.

● Music symbol tokens in text frames automatically use the Music text character style, which 
is set to Bravura Text by default.

● You can include music symbol tokens in fields in the Project Info dialog. For example, if you 
enter Symphony in B{@flat@} major into the Title field, the title displayed in text frames 
using the corresponding title token is Symphony in B♭ major.

Project/Flow information tokens

Field in the Project Info 
dialog

Token for Project page Token for Flow pages

Title {@projecttitle@} {@flowtitle@}

Subtitle {@projectsubtitle@} {@flowsubtitle@}

Dedication {@projectdedication@} {@flowdedication@}

Composer {@projectcomposer@} {@flowcomposer@}
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Field in the Project Info 
dialog

Token for Project page Token for Flow pages

Arranger {@projectarranger@} {@flowarranger@}

Lyricist {@projectlyricist@} {@flowlyricist@}

Artist {@projectartist@} {@flowartist@}

Copyist {@projectcopyist@} {@flowcopyist@}

Publisher {@projectpublisher@} {@flowpublisher@}

Editor {@projecteditor@} {@floweditor@}

Copyright {@projectcopyright@} {@flowcopyright@}

Work number {@projectworknumber@} {@flowworknumber@}

Composer dates {@projectcomposerdates@} {@flowcomposerdates@}

Composition year {@projectcompositionyear@} {@flowcompositionyear@}

Other information {@projectotherinfo@} {@flowotherinfo@}

Flow tokens

Per-flow token function Token

Flow number of the current flow, according to 
its position in the Flows panel in Setup mode

{@flownumber@}

Flow number of the current flow, according to 
its position in the current layout

{@flowInLayoutNumber@}

Flow number of the current flow shown in 
lower case Roman numerals, such as iii or xvi

{@flowNumberRomanLower@}

Flow number of the current flow shown in 
upper case Roman numerals, such as III or XVI

{@flowNumberRomanUpper@}

Number of this page within the current flow, 
counting from 1

{@flowPage@}

Total number of pages in the current flow {@flowPageCount@}

The displayed page number on which 
the specified flow “n” begins, such as 
{@flow3PageCount@}

{@flownPageCount@}
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Per-flow token function Token

Duration of the current flow in minutes and 
seconds

{@flowDuration@}

Duration of the specified flow “n” in minutes 
and seconds, such as {@flow3Duration@}

{@flownDuration@}

Page number tokens

Page number token function Token

Total number of pages in the layout {@pageCount@}

Number of this page within the current flow, 
counting from 1 for the first page of the flow 
and including pages with no displayed page 
number

{@flowPage@}

Total number of pages in the current flow {@flowPageCount@}

Displayed page number of the page on which 
the specified flow “n” begins, according to its 
position in the Flows panel in Setup mode, for 
example, {@flow5FirstPage@}

{@flownFirstPage@}

NOTE

{@flowPage@} and {@flowPageCount@} tokens only consider the flow that is active at the 
beginning of the first system of the music frame closest to the top left corner of the page on 
which the tokens are used.

Time/Date tokens: project last saved

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@projectdate@}

Four-digit year 2017 {@projectdateyear@}

Two-digit year 17 {@projectdateyearshort@}

Full month name (locale 
dependent)

October {@projectdatemonth@}

Short month name (locale 
dependent)

Oct {@projectdatemonthshort@}
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Time/Date description Time/Date example Token

Month as a decimal number, 
range 1-12

10 {@projectdatemonthnum@}

Full weekday name (locale 
dependent)

Friday {@projectdateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@projectdatedayshort@}

Day of month as decimal 
number, range 1-31

24 {@projectdatedaynum@}

ISO 8601 date 2017-12-31 {@projectdateymd@}

Month day, year December 31, 2017 {@projectdatemdy@}

Day month year 31 December 2017 {@projectdatedmy@}

Time representation (locale 
dependent)

11:10:12 {@projectdatetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@projectdatetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@projectdatetimeHHMMSS
@}

Hour in 24-hour clock range 23 {@projectdatetimehour24@}

Hour in 12-hour clock range 11 {@projectdatetimehour12@}

Minute as decimal number, 
range 00-59

10 {@projectdatetimeminute@}

Second as decimal number, 
range 00-59

44 {@projectdatetimesecond@}

Time/Date tokens: current time and date

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@date@}

Four-digit year 2017 {@dateyear@}

Two-digit year 17 {@dateyearshort@}
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Time/Date description Time/Date example Token

Full month name (locale 
dependent)

October {@datemonth@}

Short month name (locale 
dependent)

Oct {@datemonthshort@}

Month as a decimal number, 
range 1-12

10 {@datemonthnum@}

Full weekday name (locale 
dependent)

Friday {@dateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@datedayshort@}

Day of month as decimal 
number, range 1-31

24 {@datedaynum@}

ISO 8601 date 2017-12-31 {@dateymd@}

Month day, year December 31, 2017 {@datemdy@}

Day month year 31 December 2017 {@datedmy@}

Time representation (locale 
dependent)

11:10:12 {@datetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@datetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@datetimeHHMMSS@}

Hour in 24-hour clock range 23 {@datetimehour24@}

Hour in 12-hour clock range 11 {@datetimehour12@}

Minute as decimal number, 
range 00-59

10 {@datetimeminute@}

Second as decimal number, 
range 00-59

44 {@datetimesecond@}

RELATED LINKS
Project Info dialog on page 88
Player, layout, and instrument names on page 129
Flow names and flow titles on page 135
Renumbering layouts on page 128
Instrument transpositions in staff labels on page 904
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Adding borders to text objects
You can add borders to text and system text objects individually, for example, if you want to 
make the boundaries of text objects clear.

PROCEDURE

1. Select the text objects to which you want to add borders.

2. In the Properties panel, activate Border in the Text group.

RESULT
Borders are added to the selected text objects.

TIP

Deactivating Border removes borders from the selected text objects.

EXAMPLE

Text with no border Text with border shown

Aligning text objects with the start of systems
You can align individual text objects whose rhythmic position is at the start of systems with the 
systemic barline rather than the first note/rest, independently of the system alignment setting 
for their paragraph style. You can do this for the current layout and frame chain only or for all 
layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text objects you want to align with the start of systems.

2. In the Properties panel, activate Align with system start in the Text group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected text objects are aligned with the start of systems when the checkbox is activated, 
and aligned with the first note/rest in systems when the checkbox is deactivated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, text objects follow the system alignment setting of their 
paragraph style.
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EXAMPLE

Text aligned with the first note in the system Text aligned with the start of the system

RELATED LINKS
Inputting text on page 307
Changing the paragraph style of text on page 405
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the paragraph style of text
You can change the paragraph style that is applied to individual staff/system text objects, for 
example, if you want to use different paragraph styles according to the information included in 
different text objects.

PROCEDURE

1. In Write mode, double-click the text object whose paragraph style you want to change to 
open the text editor.

2. Select a paragraph style from the paragraph style menu in the text editor.

3. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
The paragraph style of the selected text object is changed. The formatting of the selected text 
object now follows the paragraph style, such as its font size, font style, or horizontal alignment.

Hiding/Showing text objects
You can hide/show individual text objects. You can do this for the current layout and frame chain 
only or for all layouts and frame chains. For example, you can show specific text objects in part 
layouts but hide them in full score layouts.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text objects you want to hide, or the signposts of text objects you want to show.

2. In the Properties panel, activate/deactivate Hide in the Text group.
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RESULT
The text objects are hidden when Hide is activated, and shown when it is deactivated. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Signposts are shown at the position of each hidden text object. However, signposts are not 
printed by default.

TIP

● If you do not want to show text signposts, choose View > Signposts > Text. Text signposts 
are shown when a tick appears beside Text in the menu, and hidden when no tick appears.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text objects, 
and time signatures.

RELATED LINKS
Signposts on page 349
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Key Commands page in the Preferences dialog on page 47
Annotations on page 537

Note spacing
The positions of notes and rests relative to each other, and the automatic gaps between them, 
are known as note spacing.

● You can change the default note spacing values for each layout independently on the Note 
Spacing page in Setup > Layout Options.

The options available include changing the default space for quarter notes (crotchets) and the 
scale space for grace notes and cues. You can also change the minimum percentage value for 
how full final systems must be before they are justified.

RELATED LINKS
Layout Options dialog on page 90
Staff spacing on page 408
Changing the default staff size on page 370

Changing the default note spacing
You can change the default note spacing in each layout independently. For example, you can 
have tighter note spacing in full score layouts compared to part layouts. The options available 
include changing the default space for quarter notes and the scale space for grace notes and 
cues.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change note spacing.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.
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3. Click Note Spacing in the category list.

4. Change the values of the options you want to change.

5. Click Apply, then Close.

RESULT
The default note spacing is changed in the selected layouts.

RELATED LINKS
Changing the horizontal justification of final systems on page 382

Note Spacing page in Layout Options
The Note Spacing page in Layout Options allows you to change the default values for note 
spacing in each layout independently. You can also change how full the final system in flows 
must be before it is automatically justified.

● You can access the Note Spacing page by choosing Setup > Layout Options and clicking 
Note Spacing in the category list.

The Note Spacing page in Layout Options contains the following options:

Default space for crotchet/quarter note
Sets the default note spacing for quarter notes (crotchets). The spacing of other 
durations is scaled proportionally. Increasing the value increases note spacing, 
decreasing the value decreases note spacing. This is reflected in the preview as you 
change the value.

Minimum space for short notes
Sets the minimum note spacing for notes with short durations. This can be 
independent of the default note spacing value.

Custom spacing ratio
Sets the spacing of notes in relation to other notes according to their rhythmic values. 
For example, setting Custom spacing ratio to 2 means half notes (minims) take up 
twice as much space as quarter notes, and eighth notes (quavers) take up half as much 
space as quarter notes.

Scale space for grace notes by
Sets the note spacing for grace notes as a percentage of the note spacing normally 
used for notes of their duration. The value cannot be greater than 100%. Increasing the 
value increases the note spacing for grace notes, decreasing the value decreases the 
note spacing for grace notes.

Scale space for cue notes by
Sets the note spacing for cues as a percentage of the note spacing normally used for 
notes of their duration. The value cannot be greater than 100%. Increasing the value 
increases the note spacing for cues, decreasing the value decreases the note spacing 
for cues.

Make space for lyrics
Controls whether or not lyrics are included in note spacing calculations. When 
deactivated, lyrics are excluded from note spacing calculations, producing a result 
where notes are spaced as if lyrics were not there.

We recommend using this option with caution and only if you intend to space lyrics 
manually, such as in tightly-spaced hymnals.
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Only justify final system in flow when more than [n]% full
Allows you to change how full the final system in each flow must be before it is justified 
to the full width of the frame. By default, final systems that are 50% full or less are not 
justified.

Use optical spacing for beams between staves
When activated, stems in cross-staff beams are evenly spaced, which can mean the 
noteheads are unevenly spaced. When deactivated, noteheads in cross-staff beams are 
evenly spaced, which can mean stems appear unevenly spaced.

RELATED LINKS
Changing to optical cross-staff beam spacing on page 584
Creating cross-staff beams on page 583

Staff spacing
The vertical positioning of staves and systems within frames is known as staff spacing. Staff 
spacing calculations consider the height of staves and the necessary gaps between staves and 
systems.

● You can change the default vertical and staff spacing settings for each layout independently 
on the Vertical Spacing page in Setup > Layout Options.

The options available allow you to set your ideal spacing, which Dorico SE then produces as 
closely as possible. We recommend familiarizing yourself with the available vertical spacing 
options.

RELATED LINKS
Staff size on page 382
Staves on page 909
Changing the default staff/system spacing on page 371
Changing the staff spacing in galley view on page 410
Changing the default staff size on page 370
Note spacing on page 406

Per-layout vertical spacing options
Dorico SE provides multiple options that you can use to control the default vertical spacing and 
justification of staves and systems in each layout.

● You can access per-layout vertical spacing options by choosing Setup > Layout Options and 
clicking Vertical Spacing in the category list.

The Vertical Spacing page contains the following sections and options:

Ideal Gaps

Contains multiple scenarios that allow you to set the gap you want Dorico SE to allow between 
staves and systems in the corresponding context, including the default scaling of these gaps in 
galley view, as Dorico SE does not automatically avoid collisions between staves and items in 
galley view. The options are accompanied by diagrams to help you visualize the contexts to which 
each option applies.

We recommend setting the ideal gaps to the minimum value acceptable to you because Dorico 
SE never reduces the gap between staves to less than your set values. Setting smaller values 
gives Dorico SE greater flexibility when determining staff spacing, particularly in very full frames, 
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such as reducing the space between staves with no dynamics to allow more space between 
staves with dynamics. Similarly, we recommend setting vertical spacing options after you have 
finished inputting notes and items, as this allows you to consider the entire project when setting 
these options.

Depending on the context, the options are affected by automatic vertical justification in different 
ways:

● Staff to staff, Staff group to staff, Staff to staff group, Staff group to staff group, 
Inter-system gap, and Timecode staff to staff

These gaps do not apply in frames that are automatically justified.

● Braced staff to braced staff and Ossia staff to staff

These gaps always apply, including in frames that are automatically justified, because braced 
and ossia staves are never justified. This includes extra staves.

NOTE

● Divisi staves are vertically justified when they use the Staff to staff gap. When they use the 
Braced staff to braced staff gap, the staves in each divisi section use only the gap set for 
braced staves and are not vertically justified.

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● When calculating the number of systems that can fit in each frame in a layout, Dorico SE 
considers the height of staves, the minimum gaps between staves, the maximum distances 
between very high/low notes and staves, and other items that require vertical space, such as 
pedal lines and tempo marks. However, this calculation happens before horizontal spacing 
is finalized, which can result in either more or fewer systems being allocated to frames than 
ideally fit. In such circumstances, you can use fixed casting off settings and system/frame 
breaks to change which systems appear in frames.

Minimum Gaps

Contains options for the minimum gaps you want Dorico SE to allow for items in addition to the 
staff spacing gaps.

● Automatically resolve collisions between adjacent staves and systems: When activated, 
Dorico SE automatically allows extra space between staves and systems to avoid collisions. 
When deactivated, Dorico SE only uses your set gaps for vertical spacing, which produces 
evenly-spaced staves and systems but with the possibility of collisions between items.

● Minimum inter-staff gap with content: Allows you to set the extra space you want to allow 
between staves when items are present.

● Minimum inter-system gap with content: Allows you to set the extra space you want to 
allow between systems when items are present.

NOTE

Minimum gaps do not affect casting off. For example, increasing the Minimum inter-system 
gap with content value changes the space above/below systems on a page but does not push 
systems to later pages. Instead, you can change the ideal gaps.

Vertical Justification

Contains options that allow you to control the frame fullness thresholds above which you want 
staves and/or systems to justify vertically automatically.
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● Justify distance between staves and systems when frame is at least [n]% full: When 
frames are filled above this threshold, the staves and systems they contain are all 
automatically vertically justified, meaning they are evenly distributed to fill the height of 
the frame. Frames filled below this threshold are not automatically justified, instead staves 
follow your ideal gap settings. This can leave gaps between the bottom staff/system and the 
bottom of the frame.

● Justify distance only between systems when frame is at least [n]% full: When frames are 
filled above this threshold, only the distance between systems in the frame is justified. Staves 
follow your per-layout ideal gap settings. This helps keep a clear distance between systems 
on very full pages.

● Justify staves when frame with single system is above this threshold: When activated, 
all the staves in a single system taller than the set threshold are vertically justified, which 
distributes them evenly to fill the height of the frame.

Staff Visibility

Contains options allowing you to control when and which empty staves are hidden in the layout.

● Hide empty staves: Allows you to control when empty staves are hidden. For example, it is a 
common practice to show all staves in the first system even if some are empty, but this is not 
always required.

● Allow individual staves of multi-staff instruments to be hidden: Allows you to control 
whether individual empty staves belonging to multi-staff instruments can be hidden 
independently or all multi-staff instrument staves must always be shown.

● Players excluded from Hide Empty Staves: Allows you to identify specific players whose 
staves you always want to show, even if their staff is empty on systems where you have 
hidden empty staves.

RELATED LINKS
Hiding/Showing empty staves on page 373
Hiding/Showing staves from system/frame breaks on page 374
Page formatting on page 367
Casting off on page 385
Staff size on page 382
Brackets and braces on page 592
Staves on page 909
Ossia staves on page 911
Tablature on page 917
Changing the vertical justification of staves/systems on page 372
Changing the vertical position of markers on page 845
Changing the vertical position of timecodes on page 850

Changing the staff spacing in galley view
You can change the vertical space between staves in galley view in each layout independently, 
expressed as a percentage of the set ideal gaps. Increasing the gaps between staves in layouts 
with very high/low notes can be useful because Dorico SE does not perform automatic collision 
avoidance in galley view.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff spacing in galley 
view.
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Vertical Spacing in the category list.

4. In the Ideal Gaps section, change the value for In galley view, expand ideal staff gaps to.

5. Click Apply, then Close.
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Play mode

Play mode allows you to change how your music sounds in playback, including by changing the 
playback template and assigning VST instruments, inputting automation, adjusting the mix, and 
changing the sounding duration of notes in playback without affecting their notated duration.

Project window in Play mode
The project window in Play mode contains the default toolbar and the event display, and also a 
toolbox and panels that contain all the tools and functions that allow you to set up your project 
for playback.

You can switch to Play mode in any of the following ways:

● Press Ctrl/Cmd-4 .

● Click Play in the toolbar.

● Choose Window > Play.

Project window in Play mode

NOTE

There is no Properties panel in Play mode.

The project window in Play mode comprises the following:

1 Play toolbox

Contains tools that allow you to select and edit note events in the event display.
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2 Event display

Allows you to view, input, and edit the playback of each flow in your project, including 
changing the played duration of notes and the tempo at any rhythmic position.

3 VST and MIDI Instruments panel

Allows you to load new VST and MIDI instruments. You can also select existing VST and MIDI 
instruments and edit their settings.

RELATED LINKS
Project window on page 23
Event display on page 418

Play toolbox
The Play toolbox contains tools that allow you to select and edit the note events in the event 
display in Play mode. It is located on the left of the window in Play mode.

Played Durations

Allows you to change when notes start/end in playback without affecting their notated 
durations. When Played Durations is selected, the played durations of notes are 
shown as a lighter event, above a thinner line that shows the notated duration of 
notes.

Notated Durations

Allows you to change the rhythmic duration of notes, which affects the position 
and notation of those notes. When Notated Durations is selected, the full, notated 
durations of notes are shown as single events in the piano roll editor.

Object Selection

Allows you to select events, such as notes in the piano roll editor/drum editor and 
points in automation lanes and dynamics lanes.

You can also select Object Selection by pressing S .

Draw

Allows you to input and edit notes in the piano roll editor and drum editor. You can 
click and drag in the piano roll editor to input notes with the durations you want. 
The ends of the notes you draw snap to rhythmic positions according to the current 
rhythmic grid resolution.

It also allows you to add points in the Time track and automation and velocity lanes. 
Using the Draw tool rather than the Line tool adds a point at regular intervals 
according to the current rhythmic grid resolution.

You can also select Draw by pressing D .

Line

Allows you to draw straight lines between two points in the Time track and automation 
and velocity lanes without adding extra values between those points.
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You can also select Line by pressing L .

Draw Percussion

Allows you to add notes to percussion staves in the drum editor with one click. You do 
not have to click and drag to a duration when using Draw Percussion.

You can also select Draw Percussion by pressing W .

Erase

Allows you to delete notes. You can make marquee selections to delete multiple notes 
when Erase is selected.

You can also select Erase by pressing E .

TIP

To deselect Erase, select Object Selection.

RELATED LINKS
Event display on page 418
Inputting notes in the event display on page 421
Deleting notes in the event display on page 425
Time track on page 447
Automation lanes on page 439
Velocity lanes on page 437
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VST and MIDI Instruments panel
The VST and MIDI instruments panel contains the VST and MIDI instruments available and used 
in your project, and allows you to edit their settings. It is located on the right of the window in 
Play mode.

VST and MIDI Instruments panel

The VST and MIDI Instruments panel contains the following sections:

1 VST Instruments

2 MIDI Instruments

VST Instruments

The VST Instruments section of the panel contains plug-in instances that each contain a VST 
instrument plug-in. Dorico SE automatically loads plug-ins and enough plug-in instances for the 
instruments you add to your project according to the current playback template, but you can also 
load VST instruments manually.
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Plug-in instances are automatically numbered to help you differentiate between instances when 
you have multiple instances of the same plug-in.

NOTE

Dorico SE only shows VST 3 instruments in the VST Instruments section by default. If you also 
want VST 2 instruments to be available, you must allow them. Only Kontakt and NotePerformer 
are allowed by default.

Each plug-in instance contains the following:

1 Activate Instrument

Activates/Deactivates the plug-in instance.

2 Edit Instrument

Opens/Closes the VST instrument window.

3 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

4 VST Instruments menu

Displays the VST instrument currently loaded in the plug-in instance and allows you to select 
another available VST instrument from the menu.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Duplicate : Creates a copy of the selected plug-in instance that you can edit separately 
from the original.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

MIDI Instruments

The MIDI Instruments section of the panel contains plug-in instances that each contain a MIDI 
device to use for output during playback. Which MIDI devices are available depends on your 
operating system.

● On Windows, you can select any MIDI device that is plugged into your computer.

● On macOS, you can select any MIDI device that is plugged into your computer, and any other 
device set up in the Audio MIDI Setup application. For example, this allows you to use MIDI 
from one application in another application.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico SE. Similarly, if 
your device is not recognized, we recommend restarting Dorico SE.
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Plug-in instances are automatically numbered to help you differentiate between instances when 
you have multiple instances of the same plug-in.

Each MIDI instance contains the following:

1 Activate Instrument

Activates/Deactivates the plug-in instance.

2 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

3 MIDI Instruments menu

Displays the MIDI device currently loaded in the plug-in instance and allows you to select 
another available MIDI device from the menu.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

RELATED LINKS
Project window in Play mode on page 412
Playback templates on page 473
Endpoints on page 481
Endpoint Setup dialog on page 482
Custom endpoint configurations on page 484
Save Endpoint Configuration dialog on page 485

Loading VST/MIDI instruments manually
Dorico SE automatically loads the plug-in instances required for your project, according to the 
current playback template. However, you can also load VST/MIDI instruments manually, either 
into new plug-in instances or into existing ones to replace existing VST/MIDI instruments.

PREREQUISITE

● Any VST instruments you want to use are saved on your computer.

● You have connected any MIDI devices you want to use.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico SE. 
Similarly, if your device is not recognized, we recommend restarting Dorico SE.

PROCEDURE

1. Optional: If you want to load a VST/MIDI instrument into a new plug-in instance, click Add 
in the corresponding section of the VST and MIDI Instruments panel.
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2. In the plug-in instance into which you want to load a new VST/MIDI instrument, select the 
one you want to load from the menu.

RELATED LINKS
Playback templates on page 473

Allowing/Blocking VST plug-ins
You can allow individual VST 2 instrument plug-ins that you want to use in Dorico SE and block 
plug-in you want to prevent Dorico SE from using. Allowed plug-ins are subsequently available in 
any project.

Dorico SE automatically blocks plug-ins that crash and plug-ins that Steinberg has not already 
qualified for use with Dorico SE. Only Kontakt and NotePerformer are allowed by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click VST Plug-ins in the category list.

3. In the Allowed VST 2 Plug-ins subsection, allow plug-ins in any of the following ways:

● To allow individual blocked plug-ins, select them in the Blocked Plug-ins list and click 
Allow selected plug-ins  in the action bar.

● To allow all blocked plug-ins, click Allow All in the Blocked Plug-ins list action bar.

● To allow a plug-in not included in the Blocked Plug-ins list, click Add plug-in name  in 
the Allowed Plug-ins list action bar and enter the name of the plug-in in the new entry.

4. Block plug-ins in any of the following ways:

● To block individual allowed plug-ins, select them in the Allowed Plug-ins list and click 
Block selected plug-ins  in the action bar.

● To block all allowed plug-ins, click Block All in the Allowed Plug-ins list action bar.

5. Click Apply, then Close.

6. Quit Dorico SE.

RESULT
When Dorico SE next opens, your allowed VST plug-in entries are available for use in the 
program.

RELATED LINKS
Preferences dialog on page 45
VST and MIDI Instruments panel on page 415
Playing back music on page 458
Playback templates on page 473

Event display
The event display in Play mode is the equivalent of the music area in Write mode. It allows you 
to view and edit your music, but focuses more on how it sounds in playback rather than its 
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notation. The event display presents your project in a similar way to that used in a digital audio 
workstation, or “DAW”, such as Cubase.

Event display in Play mode

The event display comprises the following:

1 Flow menu

Allows you to select the flow you want to be shown in the event display. Only a single flow is 
shown at a time.

2 Track headers

Display the name of each track and contain appropriate options for the track type. You can 
expand the track headers of some track types, which reveals further options.

3 Ruler

Displays bar numbers and shows beat divisions that match the current rhythmic grid 
resolution.

4 Playhead

Shows the current rhythmic position in playback.

5 Tracks

Horizontal rows that contain musical elements represented in time from left to right.

6 Drum editor

Displays notes for unpitched percussion instruments.

7 Piano roll editor

Displays notes for pitched instruments.

Tools and options in the Play toolbox allow you to input, edit, and delete notes and other events, 
such as tempo changes, in the event display.
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RELATED LINKS
Playhead on page 457
Tracks on page 426
Play toolbox on page 413
Bar numbers on page 563

Piano roll editor
The piano roll editor displays MIDI notes for pitched instruments in a continuous sequence, with 
the vertical position of note events indicating their pitch.

In Dorico SE, pitched instruments are displayed in an individual piano roll editor for their 
instrument track. Their notes are positioned vertically according to their pitch, which is 
demonstrated by a piano keyboard on the left edge of the piano roll editor. Notes are positioned 
horizontally according to their rhythm and duration.

Piano roll editor

Each instrument is automatically assigned a color when you add them in Setup mode, so that you 
can tell them apart more easily in Play mode. This color is used for notes in the piano roll on that 
instrument track, as well as shown as a strip on the instrument track header.

You can edit notes in the piano roll editor, including moving and transposing them.

NOTE

● When instrument tracks have independent voice playback enabled, you can show notes in all 
voices or only in a single voice in the piano roll editor. By default, the piano roll editor shows 
all notes belonging to all voices for the corresponding instrument.

● Editing the played duration of notes causes them to appear in a darker color in the piano roll 
editor to notes whose played duration you have not changed.

RELATED LINKS
Instrument tracks on page 427
Played vs. notated note durations on page 515
Enabling independent voice playback on page 460

Drum editor
The drum editor displays MIDI notes for unpitched percussion instruments in a continuous 
sequence. The drum editor appears different to the piano roll editor and has different 
functionality.

Instead of showing the piano roll view as used in the piano roll editor, in the drum editor the 
onset of each note on each percussion instrument is shown. Each note is shown as an event of 
the same size, unlike note events in the piano roll, whose width reflects the duration of the notes.
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Drum editor

Each unpitched percussion instrument has its own instrument track, including when they are in 
a percussion kit. You can expand unpitched percussion instrument tracks like other instrument 
tracks if you want to make changes, such as assigning the instrument to another playback 
endpoint.

NOTE

If you change the endpoint for an unpitched percussion instrument, that endpoint must have an 
appropriate percussion map chosen, otherwise Dorico SE does not know how to play the music 
for that instrument.

You can move notes in the drum editor to new rhythmic positions. Unpitched percussion 
instruments only have one vertical position for their notes, so you cannot transpose notes in 
the drum editor.

RELATED LINKS
Instrument tracks on page 427
Expanding/Collapsing tracks on page 455

Inputting notes in the event display
You can input notes into the instruments in your project using the event display in Play mode. 
You can follow these steps for both pitched and unpitched instruments.

PREREQUISITE
If you want to input notes into a specific voice for an instrument, you have done the following:

● Created that voice in Write mode and input at least one note into it.

● Enabled independent voice playback for that instrument.

PROCEDURE

1. Optional: If you want to input notes for pitched instruments, expand those instrument 
tracks.

2. Optional: If you want to input notes into a specific voice, select that voice from the Voice 
menu.

3. Select one of the following tools, depending on the instrument type:

● To input notes in pitched instrument tracks, select Draw by pressing D  or clicking Draw 
 in the Play toolbox.

● To input notes in unpitched percussion instrument tracks, select Draw Percussion by 
pressing W  or clicking Draw Percussion  in the Play toolbox.

4. Input notes in one of the following ways, depending on the instrument type:
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● For pitched instruments, click and drag horizontally in the piano roll for the required 
duration at the pitch position you want.

● For unpitched percussion instruments, click in the drum editor at the positions where 
you want to input notes.

RESULT
In the piano roll editor, notes are input at the pitches indicated by the piano keyboard on the 
left of the piano roll. If you selected a voice from the Voice menu, they are input into that voice, 
otherwise notes are input into the first available voice for that instrument.

In the drum editor, a note is input in the corresponding instrument each time you click. The 
current rhythmic grid resolution determines the duration of the notes. The duration of notes is 
indicated by a highlighted area in the track. The shape of the note event in the drum editor is the 
same for all durations.

AFTER COMPLETING THIS TASK
You can change both the notated and played durations of notes. You can also change the 
duration of notes in the score in Write mode.

RELATED LINKS
Instrument tracks on page 427
Expanding/Collapsing tracks on page 455
Changing the played duration of notes on page 516
Changing the duration of notes on page 170
Inputting notes into multiple voices on page 174
Changing the voice of existing notes on page 353
Enabling independent voice playback on page 460

Moving notes in the event display
You can move notes rhythmically within the event display. This also affects how the selected 
notes are notated in any relevant score and part layouts.

PREREQUISITE

● Notated Durations is selected in the Play toolbox.

● Object Selection is selected in the Play toolbox.

PROCEDURE

1. Optional: If you want to move notes belonging to pitched instruments, expand those 
instrument tracks.

You can move notes belonging to unpitched percussion instruments without expanding their 
instrument tracks.

2. In the piano roll/drum editor, select the notes you want to move rhythmically.

NOTE

When instrument tracks have independent voice playback enabled, only notes in the 
currently selected voice appear in the piano roll editor. Selecting All voices from the Voices 
menu in the track header shows all notes belonging to the corresponding instrument.

3. Move the selected notes according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.
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● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag them to the right/left.

RESULT
The selected notes are moved to new rhythmic positions. If you selected multiple notes, they are 
moved together as a block.

NOTE

When using the keyboard, you can both transpose and move notes in the piano roll editor in 
the same action. When using the mouse, you must release the mouse between transposing and 
moving.

RELATED LINKS
Expanding/Collapsing tracks on page 455
Play toolbox on page 413
Enabling independent voice playback on page 460

Lengthening/Shortening notes in the piano roll editor
You can change the duration of notes belonging to pitched instruments from within the piano 
roll editor in Play mode. This automatically changes the notated duration of notes in any relevant 
score and part layouts.

PREREQUISITE

● Notated Durations is selected in the Play toolbox.

● Object Selection is selected in the Play toolbox.

PROCEDURE

1. Expand the instrument tracks whose notes you want to lengthen/shorten.

2. In the piano roll editor, select the notes you want to lengthen/shorten.

NOTE

When instrument tracks have independent voice playback enabled, only notes in the 
currently selected voice appear in the piano roll editor. Selecting All voices from the Voices 
menu in the track header shows all notes belonging to the corresponding instrument.

3. Lengthen/Shorten the notes in any of the following ways:

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● Click and drag the right end of one of the selected notes to the length you want.

RESULT
The selected notes are lengthened/shortened.
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NOTE

If you select multiple notes that end at different rhythmic positions and drag them with the 
mouse pointer, changing their duration forces all the notes to end at the same rhythmic position.

RELATED LINKS
Expanding/Collapsing tracks on page 455
Played vs. notated note durations on page 515
Changing the played duration of notes on page 516
Changing the duration of notes on page 170
Play toolbox on page 413
Enabling independent voice playback on page 460

Transposing notes in the piano roll editor
You can transpose notes in the piano roll editor by moving them vertically to other pitch 
positions. You cannot transpose notes in the drum editor, or move them to other unpitched 
percussion instruments.

PREREQUISITE
Object Selection is selected in the Play toolbox.

PROCEDURE

1. Expand the instrument tracks whose notes you want to transpose.

2. In the piano roll editor, select the notes you want to transpose.

NOTE

When instrument tracks have independent voice playback enabled, only notes in the 
currently selected voice appear in the piano roll editor. Selecting All voices from the Voices 
menu in the track header shows all notes belonging to the corresponding instrument.

3. Transpose the notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

RESULT
The selected notes are transposed according to their new pitch positions in the piano roll editor.

NOTE

● This also affects how the selected notes are notated in any relevant score and part layouts.
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● When using the keyboard, you can both transpose and move notes in the piano roll editor in 
the same action. When using the mouse, you must release the mouse between transposing 
and moving.

RELATED LINKS
Moving notes in the event display on page 422
Equal Division of the Octave (EDO) on page 700
Play toolbox on page 413
Enabling independent voice playback on page 460

Deleting notes in the event display
You can delete notes in the event display in Play mode. This also removes notes from any 
relevant score and part layouts.

NOTE

When instrument tracks have independent voice playback enabled, only notes in the currently 
selected voice appear in the piano roll editor. Selecting All voices from the Voices menu in the 
track header shows all notes belonging to the corresponding instrument.

PROCEDURE

1. Optional: If you want to delete notes from pitched instruments, expand those instrument 
tracks.

2. Optional: For instrument tracks with independent voice playback enabled, select one of the 
following from the Voices menu in the track header:

● If you want to delete notes from one voice only, select that voice.

● If you want to delete notes from multiple voices, select All voices.

3. Press E  to select Erase.

4. Delete notes in any of the following ways:

● Click individual notes.

● Make a marquee selection to delete multiple notes at once.

NOTE

You can only make marquee selections on a single instrument, including percussion 
instruments in percussion kits.

RESULT
The notes you click or include in a marquee selection are deleted.

TIP

You can also delete notes by selecting Object Selection in the Play toolbox, then selecting the 
notes you want to delete and pressing Backspace or Delete .

RELATED LINKS
Selecting multiple items using marquee selections on page 335
Enabling independent voice playback on page 460
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Zooming in/out of tracks in the event display
You can change the zoom level in the tracks in the event display to make notes appear larger/
smaller. This does not affect the height of tracks.

PROCEDURE

● Change the zoom in any of the following ways:

● To make notes appear wider, press Ctrl/Cmd-= or Z .

● To make notes appear narrower, press Ctrl/Cmd-- or X .

● To make notes appear taller, Shift -click and drag upwards on the piano keyboard on the 
left.

● To make notes appear shorter, Shift -click and drag downwards on the piano keyboard 
on the left.

● To make notes appear wider and taller, spread two fingers outwards on a touchpad.

● To make notes appear narrower and shorter, pinch two fingers together on a touchpad.

● To make notes appear wider, click and drag downwards in the ruler.

● To make notes appear narrower, click and drag upwards in the ruler.

RELATED LINKS
Changing the height of tracks on page 456

Tracks
Tracks are rows in the event display that represent time horizontally from left to right. They allow 
you to control multiple musical elements in a project simultaneously but independently of each 
other.

The term was established when audio mixing was done on tapes, and multitracking allowed 
separate elements of the music to be recorded and edited independently of each other before 
being combined into the final piece of music.

In modern programs, such as Cubase, tracks can contain many types of sounds, including 
audio recordings and software instruments. Tracks containing audio recordings often display the 
waveform of the audio, while tracks containing software instruments often display the pitches as 
rectangular note events positioned horizontally in time and vertically in pitch on a piano roll.

Dorico SE provides the following types of tracks in the event display in Play mode:

Instrument tracks
Display the notes belonging to the instrument in a piano roll editor or drum editor, 
depending on the type of instrument. Each instrument in the project has its own 
instrument track, including when a single player holds multiple instruments.

Each instrument track also has its own dynamics lane, velocity lane, automation lane, 
and playing techniques lane.

Time track
Displays tempo changes in the flow, including tempo marks input in Write mode as 
well as tempo changes input in the Time track.

Chords track
Displays any chord symbols in the flow.

Play mode
Tracks 

426
Dorico SE 3.5.12



Markers track
Displays any markers in the flow, including their text.

Video track
Shows any video regions in the flow, including their file names.

RELATED LINKS
Event display on page 418
Time track on page 447
Chords track on page 452
Markers track on page 454
Video track on page 455
Expanding/Collapsing tracks on page 455

Instrument tracks
Instrument tracks allow you to view, input, and edit notes belonging to the corresponding 
instrument. Notes are displayed on a piano roll editor or drum editor, depending on the type 
of instrument.

Each instrument in the project has its own instrument track in the event display in Play mode, 
including when a single player holds multiple instruments. Instrument tracks are labeled using 
the full instrument name set for each instrument.

Instruments are automatically assigned a track color when you add them in Setup mode, so that 
you can tell them apart more easily in Play mode. This color appears around track disclosure 
arrows, as a strip on expanded instrument tracks, and is used for notes in the event display and 
events in lanes.

Each instrument track comprises the following:

1 Track height adjuster

Allows you to change the height of the track by clicking and dragging its bottom corner.

2 Track disclosure arrow/Color strip

The track disclosure arrow allows you to expand/collapse the track. The color strip displays 
the color assigned to the track. This color is also used for notes in the piano roll editor/drum 
editor, colored regions on collapsed instrument tracks, and events in the track’s lanes.

● Collapsed instrument tracks show colored regions in the event display where the 
instrument has notes. You cannot select or move colored regions.

● Expanded instrument tracks show notes in either a piano roll editor or drum editor, 
depending on the instrument type.

3 Track name
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Shows the name of the track. Instrument tracks use the full instrument name set in the Edit 
Instrument Names dialog for the instrument.

4 Track header

Contains appropriate options for instrument tracks, such as VST or MIDI port/channel 
menus.

5 Piano roll editor/Drum editor

Displays notes belonging to the instrument in either a piano roll editor or drum editor, 
depending on the instrument type.

Instrument track headers

Each instrument track header contains the following:

1 Enable independent playback of voices

Allows you to enable/disable independent voice playback for the instrument track. When 
enabled, Dorico SE automatically loads enough additional endpoints, and additional plug-in 
instances if necessary, to accommodate all voices belonging to the instrument.

2 Voices menu

Allows you to select individual voices or all voices belonging to the instrument. Only available 
when independent voice playback is enabled. Selecting different voices affects which notes 
appear in the piano roll editor or drum editor.

3 Set for This Flow/Set for All Flows

Allows you to determine whether changing the endpoint of the selected voice affects only 
its endpoint in the current flow or in all flows in the project. This selection only applies once 
to the changes you make immediately after choosing either Set for This Flow or Set for All 
Flows.

4 Plug-in instance menu

Allows you to select a VST or MIDI instrument plug-in instance to use for the instrument 
track or selected voice. Not available when independent voice playback is enabled and All 
voices is selected.

5 Edit Instrument

Opens the corresponding VST or MIDI instrument, which allows you to edit its settings.

6 Port menu
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Allows you to change the endpoint to which the instrument or voice is assigned by selecting 
the port you want to use when using a plug-in that has multiple ports of 16 channels. Not 
available when independent voice playback is enabled and All voices is selected.

7 Channel menu

Allows you to change the endpoint to which the instrument or voice is assigned by selecting 
the channel in the selected VST or MIDI instrument that you want to use for the instrument 
track. Not available when independent voice playback is enabled and All voices is selected.

8 Show the dynamics lane

Hides/Shows the dynamics lane below the instrument track. Not available when independent 
voice playback is enabled and All voices is selected.

9 Show the MIDI note velocity editor

Hides/Shows the velocity lane below the instrument track.

10 Show the automation lane

Hides/Shows the automation lane below the instrument track. Not available when 
independent voice playback is enabled and All voices is selected.

11 Show the playing techniques lane

Hides/Shows the playing techniques lane below the instrument track. Not available when 
independent voice playback is enabled and All voices is selected.

RELATED LINKS
Expanding/Collapsing tracks on page 455
Event display on page 418
Piano roll editor on page 420
Drum editor on page 420
Playing techniques lanes on page 445
Automation lanes on page 439
Player, layout, and instrument names on page 129
Changing instrument names on page 131
Endpoint Setup dialog on page 482
Enabling independent voice playback on page 460
Assigning instruments/voices to endpoints on page 487

Dynamics lanes
Dynamics lanes allow you to view, input, and edit the dynamics that apply to the corresponding 
instrument/voice. Each instrument track has its own dynamics lane that you can show in the 
event display.

● You can hide/show the dynamics lane for an instrument track/voice by clicking Show the 
dynamics lane  in the instrument track header.

NOTE

For instrument tracks with independent voice playback enabled, you can only show the 
dynamics lane when a single voice is selected. You cannot show the dynamics lane for All 
voices.
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Dynamics lane below an instrument track

Dynamics lanes comprise the following:

1 Lane height adjuster

Allows you to change the height of the lane by clicking and dragging its bottom corner.

2 Show the dynamics lane

Hides/Shows the dynamics lane. This button is located in the track header for the 
corresponding instrument track.

3 Lane header

Shows the name of the lane.

4 Reference lines

Indicate the vertical positions of the most common dynamic levels. The maximum range of 
dynamic levels is from 8 to -8, loudest to quietest.

● Top line: Dynamic level 3, equivalent to the dynamic 
● Middle line: Dynamic level 0, equivalent to the dynamic 
● Bottom line: Dynamic level -3, equivalent to the dynamic 

5 Dynamic event

An immediate change in dynamic, input either in Write mode or using the Draw tool in 
the dynamics lane. Immediate dynamic events comprise a single point that is constant by 
default.

6 Dynamic text

Shows the text of the corresponding dynamic, if applicable, to help you identify different 
dynamics and orientate yourself within the flow. This is also useful when identifying whether 
points represent dynamics input in Write mode or were input directly in the dynamics lane, 
as the points of dynamics input in Write mode function differently, for example, when 
moving or deleting dynamic points.

7 Selected dynamic point

The currently selected dynamic point appears larger and highlighted.

TIP

Clicking and dragging dynamic points in the dynamics lane causes a read-out to appear 
temporarily, showing their dynamic level.

8 Dynamic event region

A highlighted region that contains multiple dynamic points, input by clicking and dragging in 
a single motion with the Draw or Line tools in the dynamics lane. When you use the Draw 
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tool, points within a dynamic event region are constant by default. When you use the Line 
tool, dynamic event regions have a linear point at the start and a constant point at the end.

NOTE

Dynamic event regions that you input in the dynamics lane override default playback 
adjustments for dynamics, such as humanization and increased dynamics for notes with 
accents. However, the dynamic curve setting still applies to dynamic event regions.

9 Gradual dynamic

A smooth change in dynamic between two dynamic points, representing gradual dynamics 
input in Write mode. Gradual dynamics have a linear point at the start, a constant point at 
the end, and a highlighted region. Messa di voce gradual dynamic events have an additional 
linear point in the middle.

NOTE

Default playback adjustments for dynamics, such as humanization and increased dynamics 
for notes with accents, still apply to notes within gradual dynamics that you input in Write 
mode.

10 Combined/Force dynamic

A highlighted region that contains multiple dynamic points, representing combined or 
force dynamics input in Write mode, such as  and . Combined/Force dynamics have 
multiple points to control their envelopes. Combined dynamics have three points, while force 
dynamics have four points.

NOTE

Because the points of combined/force dynamics correspond to parameters of their 
envelopes, they function differently than other dynamic points. For example, if you change 
the value of the second point of a force dynamic, the third point also moves because it 
controls the duration of the second point.

RELATED LINKS
Making dynamic points constant/linear on page 433
Dynamics on page 628
Types of dynamics on page 628
Gradual dynamics on page 641
Input methods for dynamics on page 243
Changing dynamic levels on page 633
Play toolbox on page 413
Rhythmic grid on page 155
Automation lanes on page 439
Enabling independent voice playback on page 460

Hiding/Showing dynamics lanes

You can hide/show the dynamics lane for each instrument track independently.

PROCEDURE

1. Expand the instrument tracks whose dynamics lanes you want to show.

2. Optional: For instrument tracks with independent voice playback enabled, select a voice from 
the Voice menu.
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3. In each instrument track header, click Show the dynamics lane .

RESULT
The dynamics lane for each instrument track is shown when the button is highlighted, and 
hidden when it is not highlighted. For instrument tracks with independent voice playback 
enabled, the dynamics lane shows dynamics for the currently selected voice only.

Inputting dynamic points

You can input dynamic points, including gradual dynamic events, in the dynamics lane for each 
instrument track. Dynamic points input in dynamics lanes do not appear in layouts.

PREREQUISITE
The dynamics lane is shown for each instrument to which you want to add dynamic points.

PROCEDURE

1. Select one of the following tools, depending on the type of dynamic points you want to input:

● To input single dynamic points, or dynamic event regions containing multiple dynamic 
points at regular intervals, select Draw by pressing D  or clicking Draw  in the Play 
toolbox.

● To input gradual dynamic events, select Line by pressing L  or clicking Line  in the Play 
toolbox.

2. Input dynamic points in one of the following ways:

● To input single dynamic points, click in the dynamics lane at each position where you 
want a dynamic point.

● To input a dynamic event region containing multiple dynamic points at regular intervals, 
click and drag in a single motion in the dynamics lane.

● To input gradual dynamic events, click and drag in the dynamics lane from where you 
want the gradual dynamics event to start to where you want it to end.

RESULT
Dynamic points are input. If you used the Draw tool, separate dynamic points are input at each 
position you clicked. If you clicked and dragged in a single motion using the Draw tool, dynamic 
points are input at sixteenth note intervals, or at smaller intervals if the rhythmic grid resolution 
is finer than sixteenth notes. If you used the Line tool, two dynamic points are input, one at each 
end of the range.

By default, dynamic points input using the Draw tool are constant while gradual dynamic events 
have a linear point at the start and a constant point at the end.

Gradual dynamic events and dynamic event regions appear with highlighted regions in the 
dynamics lane.

Dynamic points input in dynamics lanes affect playback but are not shown in layouts.

NOTE

● Inputting dynamic points/events at the positions of dynamics input in Write mode overrides 
default playback adjustments for those dynamics. Single dynamic points only override 
the dynamic level. Dynamic event regions also override, for example, humanization and 
increased dynamics for notes with accents. However, the dynamic curve setting still applies 
to dynamic event regions.
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● For sound libraries that use MIDI CC 1 to control dynamics, the automation lane for CC1 
displays values from the dynamics you input, including dynamic points, combined with 
humanization.

RELATED LINKS
Dynamics on page 628
Automation lanes on page 439
Play toolbox on page 413
Moving dynamic points on page 435
Changing dynamic levels on page 633
Input methods for dynamics on page 243

Making dynamic points constant/linear

You can make individual dynamic points constant or linear after they have been input, for 
example, if you want to make constant points that you input by clicking and dragging using 
the Draw tool linear so they have smooth transitions between them.

By default, dynamic points you input in the dynamics lane are constant when you use the Draw 
tool and linear at the start when you use the Line tool.

NOTE

These steps do not apply to the points of dynamics input in Write mode.

PREREQUISITE
The dynamics lane is shown for each instrument whose dynamic points you want to make 
constant/linear.

PROCEDURE

1. Press S  to select Object Selection.

2. Select the dynamic points you want to make constant/linear in one of the following ways:

● Click a single dynamic point.

● Make a marquee selection around multiple dynamic points.

NOTE

You can only make dynamic points constant/linear in a single dynamics lane at a time.

3. Right-click in the dynamics lane and choose one of the following options from the context 
menu:

● To make the selected points constant, choose Make Points Constant.

● To make the selected points linear, choose Make Points Linear.

RESULT
The selected dynamic points become constant or linear. Constant points appear as squares with 
short horizontal lines extending to their right, indicating that their value continues. Linear points 
appear as circles.

The value line always appears horizontal after constant points. The value line appears angled 
after linear points if the next point has a different value, indicating a smooth transition between 
the points.
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EXAMPLE

Constant points in a dynamics lane Linear points in a dynamics lane

Copying and pasting dynamic points

You can copy and paste dynamic points, including to other dynamics lanes and repeating them 
directly after themselves in the same dynamics lane.

PREREQUISITE
The dynamics lane is shown for each instrument whose dynamic points you want to copy/paste.

PROCEDURE

1. Press S  to select Object Selection.

2. Select the dynamic points you want to copy in one of the following ways:

● Click a single dynamic point.

● Make a marquee selection around multiple dynamic points.

NOTE

You can only copy and paste dynamic points in a single dynamics lane at a time.

3. Copy the selected dynamic points in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy. You can also choose this option from the context menu.

4. Move the playhead to the position to which you want to paste the selected dynamic points.

5. Paste the selected dynamic points in any of the following ways:

● Select the header of the dynamics lane into which you want to paste them and press 
Ctrl/Cmd-V .

● Right-click in the dynamics lane into which you want to paste them and choose Paste 
from the context menu.

6. Optional: Repeat step 5 for each dynamics lane into which you want to paste the selected 
dynamic points.

RESULT
The selected dynamic points are copied to the selected positions and dynamics lanes without 
deleting them from their original positions.

NOTE

● All the points of dynamics input in Write mode are copied, even if you only selected a single 
point.

Play mode
Tracks 

434
Dorico SE 3.5.12



● You can also repeat selections of two or more dynamic points immediately after themselves 
by pressing R . Each repetition starts at the same position as the last point in the previous 
repetition. However, you cannot repeat single dynamic points or the points of immediate, 
combined, or force dynamics input in Write mode.

RELATED LINKS
Moving the playhead on page 457
Copying dynamics on page 636

Moving dynamic points

You can move individual dynamic points, including moving them upwards and downwards to 
change their dynamic level. For example, if you want individual dynamics to take effect slightly 
earlier or to adjust the volume of specific existing dynamics.

PREREQUISITE
The dynamics lane is shown for each instrument whose dynamic points you want to move.

PROCEDURE

1. Press S  to select Object Selection.

2. Select the dynamic points you want to move in one of the following ways:

● Click a single dynamic point.

● Make a marquee selection around multiple dynamic points.

NOTE

● To move dynamics input in Write mode rhythmically, select only their start point, 
including for gradual dynamics and combined/force dynamics that have multiple points. 
We recommend only moving one dynamic rhythmically at a time.

● We recommend that you select either only points of dynamics input in Write mode or 
only points input in the dynamics lane.

● You can only move dynamic points in a single dynamics lane at a time.

3. Move the selected dynamic points in any of the following ways:

● To move points input in the dynamics lane to the right/left only, Ctrl/Cmd -click and 
drag them to the right/left.

● To move points input in the dynamics lane upwards/downwards only, Ctrl/Cmd -click 
and drag them upwards/downwards.

NOTE

● If you want to move dynamic points upwards/downwards by smaller increments, 
you can press Alt  when dragging.

● You cannot move dynamic points beyond other existing dynamic points during the 
same action when using the mouse. You must release the mouse before reselecting 
the dynamic point and move it further.

● To move a single dynamic input in Write mode to the next notehead on the staff, press 
Alt/Opt-Right Arrow .

● To move a single dynamic input in Write mode to the previous notehead on the staff, 
press Alt/Opt-Left Arrow .
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● To move points of dynamics input in Write mode to the right according to the current 
rhythmic grid resolution, press Ctrl/Cmd-Alt/Opt-Right Arrow .

● To move points of dynamics input in Write mode to the left according to the current 
rhythmic grid resolution, press Ctrl/Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple dynamics are selected, you can only move them according to the current 
rhythmic grid resolution.

RESULT
The selected dynamic points are moved to new positions. Moving them to the right/left affects 
their rhythmic positions. Moving them upwards/downwards affects their dynamic level.

Moving the end points of gradual dynamics to the right/left lengthens/shortens the 
corresponding gradual dynamics rhythmically. Their notated length is automatically updated in 
all applicable layouts.

NOTE

● Moving dynamic points for linked dynamics affects all linked dynamics.

● If a single dynamic input in Write mode passes over another dynamic input in Write mode as 
part of its move, the existing one is unaffected as multiple dynamics can exist at the same 
rhythmic position. However, if you move multiple dynamics input in Write mode together, 
any existing dynamics input in Write mode they pass over are deleted.

You can undo this action, but any dynamics deleted in the process are only restored if you 
moved dynamics using the keyboard.

RELATED LINKS
Changing dynamic levels on page 633
Gradual dynamics on page 641
Lengthening/Shortening gradual dynamics and groups of dynamics on page 642
Moving dynamics rhythmically on page 631
Linked dynamics on page 648

Deleting dynamic points

You can delete individual or multiple dynamic points.

PREREQUISITE
The dynamics lane is shown for each instrument whose dynamic points you want to delete.

PROCEDURE

1. Press E  to select Erase.

2. Delete dynamic points in any of the following ways:

● Click each dynamic point you want to delete.

● Make a marquee selection around the dynamic points you want to delete.
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RESULT
The dynamic points you click or include in a marquee selection are deleted. Deleting points that 
overrode dynamics that you input in Write mode reverts those dynamics to their default points. 
Deleting the points of dynamics input in Write mode also deletes the corresponding dynamics.

TIP

You can also delete dynamic points that you input in the dynamics lane by selecting Object 
Selection in the Play toolbox, then selecting the dynamic points you want to delete and pressing 
Backspace or Delete .

RELATED LINKS
Hiding/Showing dynamics lanes on page 431

Velocity lanes
Velocity lanes allow you to view and edit the velocity of each note in the corresponding 
instrument. Each instrument track has its own velocity lane that you can show in the event 
display.

● You can hide/show the velocity lane for an instrument track by clicking Show the MIDI note 
velocity editor  in the instrument track header.

Velocity is often used to control the dynamics of non-sustaining instruments.

Velocities appear as vertical bars in the velocity lane. Each note belonging to each instrument has 
its own velocity. When multiple notes exist at the same rhythmic position, such as in chords, the 
velocities for all notes appear stacked on top of each other. You can select an individual velocity 
by selecting its corresponding note in the instrument track.

Velocity lane below an instrument track

Velocity lanes comprise the following:

1 Lane height adjuster

Allows you to change the height of the lane by clicking and dragging its bottom corner.

2 Show the MIDI note velocity editor

Hides/Shows the velocity lane. This button is located in the track header for the 
corresponding instrument track.

3 Lane header

Contains the velocity value field.

4 Velocity value field
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Displays the velocity value of the currently selected note. You can change this value by 
changing the value in the value field.

5 Velocities whose value has been changed

When you have edited the velocity of notes, their velocities appear darker in the velocity 
lane.

6 Selected note and velocity

The currently selected notes and their velocities all appear highlighted.

7 Velocities with default values

All notes have a default velocity value of 100.

RELATED LINKS
Play toolbox on page 413
Instrument tracks on page 427
Inputting notes on page 161
Inputting notes in the event display on page 421

Hiding/Showing velocity lanes

You can hide/show the velocity lane for each instrument track independently.

PROCEDURE

1. Expand the instrument tracks whose velocity lanes you want to show.

2. In each instrument track header, click Show the MIDI note velocity editor .

RESULT
The velocity lane for each instrument track is shown when the button is highlighted, and hidden 
when it is not highlighted.

Changing the velocity of notes

You can change the velocity notes individually, including for a single note in a chord or creating a 
consistent increase/decrease in velocity across a range of notes.

PREREQUISITE
The velocity lane is shown for each instrument whose note velocity you want to change.

PROCEDURE

1. Select one of the following tools, depending on how you want to change velocities:

● To change the velocity of selected notes, select Object Selection by pressing S  or 
clicking Object Selection  in the Play toolbox.

● To change the velocity using free shapes, select Draw by pressing D  or clicking Draw 
in the Play toolbox.

● To change the velocity using consistent slopes, select Line by pressing L  or clicking Line 
 in the Play toolbox.

2. Optional: If you want to change the velocity of selected notes, such as a individual notes in 
chords, select those notes in the piano roll editor. This also selects their velocity bars.

3. Change the velocity in one of the following ways:

● If you have Object Selection  selected, click and drag the top of one of the selected 
velocity bars upwards/downwards.

Play mode
Tracks 

438
Dorico SE 3.5.12



● If you have Draw  selected, click and draw any shape across the required range in the 
velocity lane.

● If you have Line  selected, click and drag a line across the required range in the 
velocity lane.

RESULT
The velocity of the affected notes is changed. When using the Object Selection tool, the 
velocities of the selected notes are changed proportionally. When using the Draw or Line tools, 
the velocities of all notes within the range are updated when you release the mouse.

TIP

You can also set the same velocity for all selected notes by entering a value into the Velocity 
value field in the lane header.

Removing changes to note velocity

You can remove changes you have made to the velocity of individual notes and reset them to 
their default velocity.

PROCEDURE

1. In the piano roll/drum editor, select the notes whose note velocity you want to reset.

2. Choose Play > Reset Playback Overrides.

RESULT
Any changes you have made to the velocity of the selected notes are reset.

NOTE

This also resets any other playback overrides for the selected notes.

Automation lanes
Automation lanes allow you to view, input, and edit MIDI controller data that applies to the 
corresponding instrument/voice. Each instrument track has its own automation lane that you can 
show in the event display.

● You can hide/show the automation lane for an instrument track/voice by clicking Show the 
automation lane  in the instrument track header.

NOTE

For instrument tracks with independent voice playback enabled, you can only show the 
automation lane when a single voice is selected. You cannot show the automation lane for 
All voices.

● You can change the MIDI controller whose data is displayed in the automation lane by 
selecting the controller from the menu in the automation lane track header.

TIP

Dorico SE displays generated values as a non-editable value line in the corresponding 
automation lane. For example, for sound libraries that use MIDI CC 1 to control dynamics, 
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the automation lane for CC1 displays values from the dynamics you input, including dynamic 
points, combined with humanization.

Automation lane below an instrument track

Automation lanes comprise the following:

1 Lane height adjuster

Allows you to change the height of the lane by clicking and dragging its bottom corner.

2 Lane header

Contains the MIDI controller menu and MIDI value field.

3 Show the automation lane

Hides/Shows the automation lane. This button is located in the track header for the 
corresponding instrument track.

4 MIDI Controller menu

Allows you to select the MIDI controller whose automation data you want to view and edit 
in the automation lane. Controllers that already contain automation data are shown with an 
asterisk beside their name in the menu.

5 Automation value field

Displays the value of the currently selected automation point. You can change this value by 
changing the value in the value field. The available range depends on the type of controller. 
For example, MIDI CCs have values from 0 to 127.

6 Automation event region

A highlighted region that contains multiple automation points with smooth transitions 
between each event, input by clicking and dragging in a single motion with the Draw tool 
in the automation lane. By default, automation points within a region are linear and the last 
point is constant.

7 Gradual automation event

A smooth change in value between two automation points, input using the Line tool. 
Gradual automation events have a linear point at the start, a constant point at the end, 
and a highlighted region.

8 Automation point

A single change to the automation value, input using the Draw tool. Automation points are 
constant by default.

9 Selected automation point

The currently selected automation point appears larger and highlighted.
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TIP

Clicking and dragging automation points in the automation lane causes a read-out to appear 
temporarily, showing their value.

Although only a single automation lane can be displayed, it is possible to create data for multiple 
MIDI controllers in the same lane.

Automation data is included when exporting MIDI files.

RELATED LINKS
Play toolbox on page 413
Instrument tracks on page 427
Making automation points constant/linear on page 442
Exporting MIDI on page 69
Dynamics on page 628
Dynamics lanes on page 429

Hiding/Showing automation lanes

You can hide/show the automation lane for each instrument track independently.

PROCEDURE

1. Expand the instrument tracks whose automation lanes you want to show.

2. Optional: For instrument tracks with independent voice playback enabled, select a voice from 
the Voice menu.

3. In each instrument track header, click Show the automation lane .

RESULT
The automation lane for each instrument track is shown when the button is highlighted, and 
hidden when it is not highlighted. For instrument tracks with independent voice playback 
enabled, the automation lane shows automation for the currently selected voice only.

Inputting automation data

You can input automation data for multiple MIDI controllers, including pitch bend, in the 
automation lane for each instrument track.

PREREQUISITE
The automation lane is shown for each instrument to which you want to add automation.

PROCEDURE

1. In each automation lane header, select the MIDI controller into which you want to input 
automation from the MIDI Controller menu.

2. Select one of the following tools, depending on the type of automation you want to input:

● To input single automation points, or automation event regions containing multiple 
automation points at regular intervals, select Draw by pressing D  or clicking Draw  in 
the Play toolbox.

● To input gradual automation events, select Line by pressing L  or clicking Line  in the 
Play toolbox.

3. Input automation in one of the following ways:
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● To input single automation points, click in the automation lane at each position where 
you want an automation point.

● To input an automation event region containing multiple automation points at regular 
intervals, click and drag in a single motion in the automation lane.

● To input gradual automation events, click and drag in the automation lane from where 
you want the gradual automation event to start to where you want it to end.

NOTE

When you first start inputting pitch bend data, the horizontal line in the middle of the 
automation lane represents the unmodified pitch.

RESULT
Automation is input for the selected MIDI controller. If you used the Draw tool, separate 
automation points are input at each position you clicked. If you clicked and dragged in a single 
motion using the Draw tool, automation points are input at sixteenth note intervals, or at 
smaller intervals if the rhythmic grid resolution is finer than sixteenth notes. If you used the Line 
tool, two automation points are input, one at each end of the range.

By default, single automation points are constant, automation points in regions are linear, the 
last automation point in regions is constant, and gradual automation events have a linear point 
at the start and a constant point at the end.

Gradual automation events and automation event regions appear with highlighted regions in the 
automation lane.

RELATED LINKS
Moving automation points on page 444

Making automation points constant/linear

You can make individual automation points constant or linear after they have been input, for 
example, if you want to make constant points linear so they have smooth transitions between 
them.

By default, automation points are constant when you input them separately and linear when you 
click and drag them in a single motion. The last automation point in a clicked and dragged region 
is constant.

PREREQUISITE
The automation lane is shown for each instrument whose automation points you want to make 
constant/linear.

PROCEDURE

1. In the automation lane header, select the MIDI controller whose automation points you want 
to make constant/linear from the MIDI Controller menu.

2. Press S  to select Object Selection.

3. Select the automation points you want to make constant/linear in one of the following ways:

● Click a single automation point.

● Make a marquee selection around multiple automation points.
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NOTE

You can only make automation points constant/linear in a single automation lane at a time.

4. Right-click in the automation lane and choose one of the following options from the context 
menu:

● To make the selected points constant, choose Make Points Constant.

● To make the selected points linear, choose Make Points Linear.

RESULT
The selected automation points become constant or linear. Constant points appear as squares 
with short horizontal lines extending to their right, indicating that their value continues. Linear 
points appear as circles.

The value line always appears horizontal after constant points. The value line appears angled 
after linear points if the next event has a different value, indicating a smooth transition between 
the points.

EXAMPLE

Constant points in an automation lane Linear points in an automation lane

Copying and pasting automation points

You can copy and paste automation points, including to other automation lanes and repeating 
them directly after themselves in the same automation lane.

PREREQUISITE
The automation lane is shown for each instrument whose automation points you want to copy/
paste.

PROCEDURE

1. In the automation lane header, select the MIDI controller whose automation points you want 
to copy from the MIDI Controller menu.

2. Press S  to select Object Selection.

3. Select the automation points you want to copy in one of the following ways:

● Click a single automation point.

● Make a marquee selection around multiple automation points.

NOTE

You can only copy and paste automation points in a single automation lane at a time.
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4. Copy the selected automation points in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy. You can also choose this option from the context menu.

5. Move the playhead to the position to which you want to paste the selected automation 
points.

6. Paste the selected automation points in any of the following ways:

● Select the header of the automation lane into which you want to paste them and press 
Ctrl/Cmd-V .

● Right-click in the automation lane into which you want to paste them and choose Paste 
from the context menu.

7. Optional: Repeat step 6 for each automation lane into which you want to paste the selected 
automation points.

RESULT
The selected automation points are copied to the selected positions and automation lanes 
without deleting them from their original positions.

NOTE

You can also repeat automation points immediately after themselves by selecting them and 
pressing R . In each repetition, the first point in the selection replaces the last point in the 
automation lane.

RELATED LINKS
Hiding/Showing automation lanes on page 441
Moving the playhead on page 457
Copying and pasting items on page 351

Moving automation points

You can move individual automation points, including moving them upwards and downwards to 
change their values.

PREREQUISITE
The automation lane is shown for each instrument whose automation points you want to move.

PROCEDURE

1. In the automation lane header, select the MIDI controller whose automation points you want 
to move from the MIDI Controller menu.

2. Press S  to select Object Selection.

3. Select the automation points you want to move in one of the following ways:

● Click a single automation point.

● Make a marquee selection around multiple automation points.

NOTE

You can only move automation points in a single automation lane at a time.

4. Move the selected automation points in any of the following ways:
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● To move them to the right/left only, Ctrl/Cmd -click and drag them to the right/left.

● To move them upwards/downwards only, Ctrl/Cmd -click and drag them upwards/
downwards.

TIP

● If you want to move automation points upwards/downwards by smaller increments, 
you can press Alt  when dragging.

● You cannot move automation points beyond other existing automation points 
during the same action when using the mouse. You must release the mouse before 
reselecting the automation point and move it further.

Deleting automation points

You can delete individual or multiple automation points.

PREREQUISITE
The automation lane is shown for each instrument whose automation points you want to delete.

PROCEDURE

1. In the automation lane header, select the MIDI controller whose automation points you want 
to delete from the MIDI Controller menu.

2. Press E  to select Erase.

3. Delete automation points in any of the following ways:

● Click each automation point you want to delete.

● Make a marquee selection around the automation points you want to delete.

RESULT
The automation points you clicked or included in a marquee selection are deleted.

TIP

You can also delete automation points by selecting Object Selection in the Play toolbox, then 
selecting the automation points you want to delete and pressing Backspace or Delete .

Playing techniques lanes
Playing techniques lanes display where you have input playing techniques for the corresponding 
instrument. Each instrument track has its own playing techniques lane that you can show in the 
event display.

● You can hide/show the playing techniques lane for an instrument track/voice by clicking 
Show the playing techniques lane  in the instrument track header.

NOTE

For instrument tracks with independent voice playback enabled, you can only show the 
playing techniques lane when a single voice is selected. You cannot show the playing 
techniques lane for All voices.
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Playing techniques lane below an instrument track

Playing techniques lanes comprise the following:

1 Lane height adjuster

Allows you to change the height of the lane by clicking and dragging its bottom corner.

2 Lane header

Shows the name of the lane.

3 Show the playing techniques lane

Hides/Shows the playing techniques lane. This button is located in the track header for the 
corresponding instrument track.

4 Playing technique regions

Display the playing technique that applies to notes in the region. You can hover your mouse 
pointer over playing technique regions on the lane to see the following related information:

● Any playback techniques, switches, and other effects in place, such as adjustments for 
articulations

● Expression map used for the region

● Channel in the VST or MIDI instrument used for the region

● VST or MIDI instrument used for the region

NOTE

You cannot change playing techniques using this lane. You can only change them in Write mode.

RELATED LINKS
Playing techniques on page 813
Playback techniques on page 512
Instrument tracks on page 427
Event display on page 418
Expression maps on page 488
Enabling independent voice playback on page 460

Hiding/Showing playing techniques lanes

You can hide/show the playing techniques lane for each instrument track independently.

PROCEDURE

1. Expand the instrument tracks whose playing techniques lanes you want to show.

2. Optional: For instrument tracks with independent voice playback enabled, select a voice from 
the Voice menu.
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3. In each instrument track header, click Show the playing techniques lane .

RESULT
The playing techniques lane for each instrument track is shown when the button is highlighted, 
and hidden when it is not highlighted. For instrument tracks with independent voice playback 
enabled, the playing techniques lane shows playing techniques for the currently selected voice 
only.

Time track
The Time track allows you to view and edit the tempo of your project, including inputting new 
tempo changes. It appears above the top instrument track in the event display in Play mode, and 
is one of the tracks you can hide/show.

The Time track comprises the following:

1 Track height adjuster

Allows you to change the height of the track by clicking and dragging its bottom corner.

2 Track disclosure arrow

Allows you to expand/collapse the track.

3 Track name

Shows the name of the track.

4 Track header

Contains appropriate options for the track, such as the menu for the sound source for the 
click.

5 Fixed tempo read-out

Displays the tempo that corresponds to the current mouse pointer position in the Time 
track.

6 Absolute tempo change

An immediate change in tempo, input either in Write mode or using the Draw tool in the 
Time track. Absolute tempo changes comprise a single constant point.

7 Tempo mark text

Shows the text of the corresponding tempo change, if applicable, to help you identify 
different tempo marks and orientate yourself within the flow.

8 Gradual tempo change

A smooth change in tempo over time, either input in Write mode or using the Line tool in 
the Time track. Gradual tempo changes have a linear point at the start, a constant point at 
the end, and a highlighted region.

9 Selected tempo change

The currently selected tempo change appears larger and highlighted.
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TIP

Clicking and dragging tempo changes in the Time track causes a read-out to appear 
temporarily, showing their precise tempo.

Time track header

The Time track header contains the following:

1 Plug-in instance menu

Allows you to select a VST or MIDI instrument plug-in instance to use for the click.

2 Edit Instrument

Opens the corresponding VST or MIDI instrument, which allows you to edit its settings.

3 Port menu

Allows you to change the endpoint to which the Time track is assigned by selecting the port 
you want to use when using a plug-in that has multiple ports of 16 channels.

4 Channel menu

Allows you to change the endpoint to which the Time track is assigned by selecting the 
channel in the selected VST or MIDI instrument that you want to use for the click.

5 Tempo

Displays the metronome mark value of the currently selected tempo change without decimal 
places. You can change this value by changing the value in the value field.

Tempo changes input in the Time track in Play mode appear as signposts in Write mode by 
default to avoid changing the appearance of the printed score. Signposts are not printed by 
default, so if you want such tempo changes to be printed in the score as tempo marks, we 
recommend that you show them.

All tempo changes input in the Time track are included when exporting MIDI files.

RELATED LINKS
Hiding/Showing tracks on page 456
Play toolbox on page 413
Rhythmic grid on page 155
Tempo marks on page 926
Input methods for tempo marks on page 228
Changing the type and appearance of absolute tempo changes on page 928
Signposts on page 349
Hiding/Showing tempo marks on page 932
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Exporting MIDI on page 69

Inputting tempo changes in the Time track
You can input tempo changes, including gradual tempo changes, in the Time track in Play mode. 
Tempo changes input in the Time track do not appear in layouts, but instead are shown as 
signposts.

PREREQUISITE
The Time track is shown and expanded.

PROCEDURE

1. Select one of the following tools, depending on the type of tempo change you want to input:

● To input single absolute tempo changes, or multiple absolute tempo changes at regular 
intervals, select Draw by pressing D  or clicking Draw  in the Play toolbox.

● To input gradual tempo changes, select Line by pressing L  or clicking Line  in the Play 
toolbox.

2. Input tempo changes in one of the following ways:

● To input single absolute tempo changes, click in the Time track at each position where 
you want a tempo change.

● To input multiple absolute tempo changes at regular intervals, click and drag in the 
Time track.

● To input gradual tempo changes, click and drag in the Time track from where you want 
the gradual tempo change to start to where you want it to end.

TIP

The metronome value corresponding to the current vertical position of the mouse pointer is 
displayed in the Time track header.

RESULT
Tempo changes are input. If you used the Draw tool, separate tempo changes are input at each 
position you clicked. If you clicked and dragged in a single motion using the Draw tool, tempo 
changes are input at eighth note intervals, or at smaller intervals if the rhythmic grid resolution is 
finer than eighth notes. If you used the Line tool, two tempo changes are input, one at each end 
of the range. The range appears with a highlighted region in the Time track.

This affects the speed of playback, but the tempo changes are not shown in layouts. Instead, 
they appear as signposts.

Tempo changes are included when exporting MIDI files.

RELATED LINKS
Hiding/Showing tracks on page 456
Hiding/Showing tempo marks on page 932
Signposts on page 349
Changing the rhythmic grid resolution on page 156
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Moving tempo changes in the Time track
You can move tempo changes to new rhythmic positions in the Time track. This affects their 
rhythmic position in all applicable layouts.

PREREQUISITE
The Time track is shown and expanded.

PROCEDURE

1. Press S  to select Object Selection.

2. In the Time track, select the tempo changes you want to move in one of the following ways:

● Click a single tempo change.

● Make a marquee selection around multiple absolute tempo changes.

NOTE

For gradual tempo changes, you can only move a single point at a time.

3. To move the selected tempo changes without changing their tempo, Ctrl/Cmd -click and 
drag the selected tempo change, or one of the selected tempo changes, to the right/left.

NOTE

You cannot move tempo changes beyond other existing tempo changes during the same 
move. Releasing the mouse causes the moved tempo change to replace the existing one. 
You can then reselect it and move it further.

RESULT
The rhythmic positions of the selected tempo changes are changed. When you move multiple 
selected absolute tempo changes, they maintain their positions relative to each other. This also 
affects their rhythmic positions in any layouts in which they appear.

AFTER COMPLETING THIS TASK
You can also move tempo changes vertically, which changes their tempo.

RELATED LINKS
Time track on page 447
Hiding/Showing tracks on page 456
Hiding/Showing tempo marks on page 932
Selecting multiple items using marquee selections on page 335

Changing the tempo in the Time track
You can change the tempo of individual tempo changes in the Time track, expressed in beats per 
minute.

PREREQUISITE
The Time track is shown and expanded.

PROCEDURE

1. Press S  to select Object Selection.

2. In the Time track, select the tempo changes whose tempo you want to change in one of the 
following ways:
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● Click a single tempo change.

● Make a marquee selection around multiple absolute tempo changes.

NOTE

For gradual tempo changes, you can only change the tempo of a single point at a time.

3. To change the tempo of the selected tempo changes without moving them rhythmically, 
Ctrl/Cmd -click and drag the selected tempo change, or one of the selected tempo changes, 
upwards/downwards.

A tempo read-out appears beside the mouse pointer, providing visual feedback of the 
tempo.

TIP

If you want to change the tempo by smaller increments, you can press Alt  when dragging.

RESULT
The tempo of the selected tempo changes is changed. This affects the speed of playback and the 
displayed metronome mark of any tempo changes also shown in layouts.

TIP

You can also change the tempo of tempo changes by selecting them and changing the Tempo 
value in the Time track header.

RELATED LINKS
Hiding/Showing tracks on page 456

Deleting tempo changes in the Time track
You can delete tempo changes in the Time track.

PREREQUISITE
The Time track is shown and expanded.

PROCEDURE

1. Press E  to select Erase.

2. Delete tempo changes in any of the following ways:

● Click each tempo change you want to delete.

● Make a marquee selection around the tempo changes you want to delete.

RESULT
The tempo changes you click or include in a marquee selection are deleted. This also deletes 
their corresponding tempo marks or tempo mark signposts from layouts.

TIP

You can also delete tempo changes by selecting Object Selection in the Play toolbox, then 
selecting the tempo changes you want to delete and pressing Backspace or Delete .
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RELATED LINKS
Selecting multiple items using marquee selections on page 335

Chords track
A Chords track is included in every project. You can assign the Chords track to its own endpoint 
to hear any chords that you input into the score as chord symbols in playback.

The Chords track appears above the top instrument track in the event display, and is one of the 
tracks you can hide/show.

The Chords track comprises the following:

1 Track height adjuster

Allows you to change the height of the track by clicking and dragging its bottom corner.

2 Track disclosure arrow

Allows you to expand/collapse the track.

3 Track name

Shows the name of the track.

4 Track header

Contains appropriate options for the track, such as the button that enables/disables chords 
playback.

5 Chords

Indicates where chord symbols exist in the flow and shows the chord symbol name.

Chords track header

The Chords track header contains the following:

1 Plug-in instance menu

Allows you to select a VST or MIDI instrument plug-in instance to use for chords playback.

2 Edit Instrument

Opens the corresponding VST or MIDI instrument, which allows you to edit its settings.
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3 Enable Chords Playback

Allows you to include chords in, or exclude chords from, playback.

4 Port menu

Allows you to change the endpoint to which the Chords track is assigned by selecting the 
port you want to use when using a plug-in that has multiple ports of 16 channels.

5 Channel menu

Allows you to change the endpoint to which the Chords track is assigned by selecting the 
channel in the selected VST or MIDI instrument that you want to use for chords playback.

You can use an existing channel containing a sound already loaded in the project, or you can 
use a new channel with a new sound loaded just for chords.

NOTE

● You must assign a VST or MIDI instrument and a channel for the Chords track in order to 
hear chords in playback.

● If you manually load sounds into the channel you selected for your Chords track 
and later add more instruments to your project, the sounds for the new instruments 
overwrite the sounds you manually loaded in that channel.

RELATED LINKS
Chord symbols on page 598
Loading VST/MIDI instruments manually on page 417
Hiding/Showing tracks on page 456

Enabling chord symbol playback
You can include chord symbols in playback. They are played as sustained chords, with their 
duration taken from the gap between one chord symbol and the next. Chord symbols input using 
a MIDI keyboard use the same voicing as you used to input them, whereas chord symbols input 
using a computer keyboard use a default voicing.

PREREQUISITE
The Chords track is shown.

PROCEDURE

1. In the Chords track header, click Enable Chords Playback .

2. Optional: If you want to specify the sound used for chords playback, expand the Chords 
track.

3. In the Chords track header, select the endpoint you want using the Port and Channel 
menus.

RELATED LINKS
Hiding/Showing tracks on page 456
Endpoints on page 481
Endpoint Setup dialog on page 482
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Markers track
The Markers track allows you to view the markers in your project and input new ones. It appears 
above the top instrument track in the event display in Play mode, and is one of the tracks you can 
hide/show.

The Markers track comprises the following:

1 Track height adjuster

Allows you to change the height of the track by clicking and dragging its bottom corner.

2 Track header

Shows the name of the track and contains appropriate options.

3 Add Marker

Allows you to add a new marker at the current position of the playhead.

4 Markers

Show the position of each marker in the flow, including their text.

RELATED LINKS
Hiding/Showing tracks on page 456
Markers on page 844
Videos on page 136
Editing marker text on page 846

Inputting markers in the Markers track
You can input markers directly into the Markers track in Play mode.

PREREQUISITE
The Markers track is shown.

PROCEDURE

1. Move the playhead to the time position where you want to input a marker.

NOTE

You cannot input markers in negative time, such as when a video starts three bars into the 
flow, causing the initial timecode of the flow to be in negative time.

2. In the Markers track header, click Add Marker .

RESULT
A marker is input at the position of the playhead. It shows the default text “Marker”.
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EXAMPLE

Marker in the Markers track

AFTER COMPLETING THIS TASK
You can change the text shown in the marker.

RELATED LINKS
Changing the start position of videos on page 139
Editing marker text on page 846
Moving the playhead on page 457

Video track
The Video track shows where videos exist in the flow relative to the music. It appears above 
the top instrument track in the event display in Play mode, and is one of the tracks you can 
hide/show.

The Video track comprises the following:

1 Track height adjuster

Allows you to change the height of the track by clicking and dragging its bottom corner.

2 Track header

Shows the name of the track and contains appropriate options.

3 Show Video

Allows you to hide/show the Video window. This performs the same function as Show Video 
in the toolbar.

4 Video file name

Shows the video file name and file extension.

5 Video region

Shows the position of the video file relative to the music and its length.

RELATED LINKS
Videos on page 136
Adding videos on page 139
Hiding/Showing the Video window on page 140
Changing the start position of videos on page 139
Toolbar on page 24

Expanding/Collapsing tracks
You can expand/collapse tracks in Play mode individually, and you can expand/collapse all 
instrument tracks in the current flow at the same time. Expanding tracks allows you to access 
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controls in track headers and to input and edit track contents, such as notes in the piano roll 
editor and tempo changes in the Time track.

PROCEDURE

● Expand/Collapse tracks in any of the following ways:

● To expand/collapse an individual track, click its disclosure arrow.

● To expand/collapse all instrument tracks, Ctrl/Cmd -click any instrument track 
disclosure arrow.

Changing the height of tracks
You can change the height of all types of tracks at any time, for example, if you want a single 
track to occupy more space in the event display temporarily so you can work on it in more detail.

PROCEDURE

● Change the height of tracks in any of the following ways:

● To make tracks taller, select them and press Shift-H .

● To make tracks shorter, select them and press Shift-G .

● Click and drag the bottom left corner of a single track upwards/downwards.

TIP

When the mouse pointer is in the correct position, it appears as a split arrow.

RELATED LINKS
Zooming in/out of tracks in the event display on page 426

Hiding/Showing tracks
You can hide/show the tracks that appear above the top instrument track in the event display in 
Play mode.

By default, only the Time and Chords tracks are shown. If you have added at least one video to 
one flow in the project, the Markers and Video tracks are also shown by default.

NOTE

You cannot hide/show player and instrument tracks.

PROCEDURE

● Choose Play > Tracks > [track type].

For example, choose Play > Tracks > Time Track to hide/show the Time track.

RESULT
The selected track type is shown when a tick appears beside its entry in the submenu, and 
hidden when no tick appears.

RELATED LINKS
Tracks on page 426
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Playhead
The playhead is a vertical line that moves during playback, showing the current rhythmic 
position. It is also known as a “playback line”.

The playhead appears at all times in Play mode and during playback in other modes, and its 
current position is shown in both the Transport window and the mini transport in the toolbar. 
You can also choose to show the playhead when playback is stopped in other modes.

The playhead in Play mode

Dorico SE automatically keeps the playhead in view during playback by moving it along with the 
music, but you can also move the playhead manually. Dorico SE tries to keep systems in the same 
place on the screen when it scrolls along with the playhead for consistency as you follow your 
music.

NOTE

The playhead never appears in Print mode.

RELATED LINKS
Transport window on page 472
Mini transport on page 25

Moving the playhead
The playhead automatically moves along with the music during playback, but you can also move 
the playhead manually in any mode.

You can move the playhead both when it is stopped and during playback, but not all methods of 
moving the playhead work during playback.

By default, the playhead is only shown during playback but you can choose to show the playhead 
at all times.

PROCEDURE

● Move the playhead in any of the following ways:

● To move the playhead forwards, press Num +  (plus on a numeric keypad).

● To move the playhead backwards, press Num -  (minus on a numeric keypad).

● To move the playhead back to the start of the flow, press Num .  (period on a numeric 
keypad).

● To move the playhead to the start of the earliest selected item, press Alt/Opt-P .

● To move the playhead forwards by frames, press Ctrl/Cmd-Num + or Ctrl/Cmd-F9 .

● To move the playhead backwards by frames, press Ctrl/Cmd-Num - or Ctrl/Cmd-F7 .

Play mode
Playhead 

457
Dorico SE 3.5.12



● Click Fast Forward in the Transport window to navigate forwards.

● Click Rewind in the Transport window to navigate backwards.

● Click Rewind to Beginning of Flow in the Transport window to go back to the start of 
the flow.

● In Play mode, click the ruler at any position.

NOTE

You cannot click the ruler to move the playhead during playback.

RELATED LINKS
Transport window on page 472
Preferences dialog on page 45
Frame rates on page 141

Hiding/Showing the playhead
You can hide/show the playhead when playback is stopped, for example, to help line up your 
music when working with timecodes and video. By default, the playhead is hidden when playback 
is stopped, except in Play mode where it always appears.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Play in the category list.

3. In the Playhead subsection, activate/deactivate Show playhead when stopped.

4. Click Apply, then Close.

RESULT
The playhead is shown outside of playback when Show playhead when stopped is activated, 
and hidden when it is deactivated.

NOTE

This does not apply to Play mode or Print mode. The playhead always appears in Play mode and 
never appears in Print mode.

Playing back music
You can listen to the music you have written from the beginning of your project or from a specific 
point. You can also use the playback key commands in any mode.

PREREQUISITE

● You have applied a playback template to the project that includes sounds for the instruments 
in your project.

● If you want to use different sounds for different voices, you have enabled independent voice 
playback for those instruments.

PROCEDURE

1. Start playback in one of the following ways:
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● To play back all instruments from the selection, select a single note and press P .

● To play back all instruments from the selection, select a single note and choose Play > 
Play From Selection.

● To play back only a single staff, select multiple items on the staff and press P .

NOTE

This does not affect which channels are soloed or muted in Play mode.

● To play back multiple staves, select items on multiple staves and press P .

NOTE

This does not affect which channels are soloed or muted in Play mode.

● To continue playback from the playhead position, press Space or Enter .

● To play back from the last playback start position, press Shift-Space . This works even if 
you have since deselected the item at that position.

● To play back from the start of the flow, press Shift-Alt/Opt-Space .

● Click Play From Playhead Position in the Transport window.

● Click Play From Selection in the Transport window.

● Choose Play > Play From Playhead Position.

● Choose Play > Play From Last Start Position.

● Choose Play > Play From Start of Flow.

● Choose Play > Play From Start of Project.

2. Optional: Move the playhead during playback to later/earlier positions.

3. Optional: To enable/disable the metronome click, click Click  in the mini transport.

TIP

You can assign a key command for enabling/disabling the metronome click during playback 
on the Key Commands page in Preferences.

4. Stop playback in any of the following ways:

● Press Space or Enter  or P .

● Press Num 0  (0 on a numeric keypad).

● Click Stop in the Transport window.

TIP

If you notice a change in sound when stopping playback, you can deactivate Reset 
controllers and send ‘all notes off’ when stopping playback on the Play page in 
Preferences.

RELATED LINKS
Playback templates on page 473
Applying/Resetting playback templates on page 479
Allowing/Blocking VST plug-ins on page 418
Muting/Soloing tracks on page 461
Endpoint Setup dialog on page 482
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Mini transport on page 25
Key Commands page in the Preferences dialog on page 47
Status bar on page 32
Preferences dialog on page 45

Enabling independent voice playback
By default, all voices belonging to a single instrument, including divisi staves, use the same 
endpoint for playback. You can enable independent voice playback, for example, to hear the 
different playing techniques in playback for a string divisi where some parts are pizzicato and 
some parts are arco.

NOTE

You cannot enable independent voice playback for unpitched percussion kits.

PROCEDURE

1. Expand the instrument tracks for which you want to enable independent voice playback.

2. In each instrument track header, activate Enable independent playback of voices.

RESULT
Independent voice playback is enabled for each instrument. Dorico SE automatically loads 
enough additional channels, and additional plug-in instances if necessary, to accommodate all 
voices belonging to the corresponding instrument project-wide.

Voices are automatically assigned to endpoints according to their order in the Voices menu. 
Selecting an individual voice from the Voices menu shows only the corresponding notes in the 
piano roll editor.

NOTE

For instrument tracks with independent voice playback enabled, you can only show dynamics, 
automation, and playing techniques lanes when a single voice is selected.

AFTER COMPLETING THIS TASK
You can change the endpoints of each voice in each flow independently, for example, if some 
voices in some flows require a solo sound instead of an ensemble one.

RELATED LINKS
Playback templates on page 473
Endpoints on page 481
Instrument tracks on page 427
Dynamics lanes on page 429
Automation lanes on page 439
Playing techniques lanes on page 445
Piano roll editor on page 420
Assigning instruments/voices to endpoints on page 487
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Muting/Soloing tracks
You can mute/solo individual tracks. This allows you to set fixed groups to sound in playback, for 
example, if you only want to listen to certain groups of players at a time.

PROCEDURE

1. In the toolbar, click Show Mixer  to show the Mixer.

2. In the Mixer, click the appropriate button at the top of each channel you want to mute/solo.

● Mute 

● Solo 

RESULT
Each track is muted/soloed and the corresponding buttons are enabled.

This affects which tracks play back until you change which tracks are muted/soloed, meaning you 
do not have to reselect the tracks you want to hear each time. For example, if you have eight 
tracks and solo four, only those four are played back. If you mute two tracks, those tracks are not 
played back but the other six are played back.

NOTE

● Soloing tracks automatically mutes all other tracks. If you solo a track that was muted, it is 
automatically unmuted.

● You can also play back only certain tracks/staves by selecting notes/items on each track/staff 
you want to hear.

EXAMPLE

Mute when enabled Solo when enabled

RELATED LINKS
Expanding/Collapsing tracks on page 455
Muting notes/items individually on page 462

Muting/Soloing instruments
You can solo the currently selected instruments, which automatically mutes all other 
instruments. This can be useful if you want to ensure only certain instruments are played back 
while you are working on a specific section of a project.

PROCEDURE

1. Select at least one note belonging to each instrument you want to solo. You can do this in 
Write mode and Play mode.

2. Press Alt/Opt-S .
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RESULT
The selected instruments are soloed and all other instruments are muted by changing their 
mute/solo states in the Mixer. This affects which instruments are muted/soloed until you 
deactivate their mute/solo states.

TIP

You can also determine which staves are included in playback for each separate playback without 
changing their states in the Mixer.

RELATED LINKS
Mixer on page 469

Deactivating mute/solo instrument states
You can deactivate the mute and solo states of all instruments in your project, for example, if you 
want to hear all instruments in playback after soloing a small selection. You can do this in any 
mode.

PROCEDURE

● Deactivate mute/solo instrument states in the following ways:

● To deactivate all mute instrument states, press Alt/Opt-U .

● To deactivate all solo instrument states, press Shift-Alt/Opt-S .

● In the Mixer, click Deactivate All Mute States.

● In the Mixer, click Deactivate All Solo States.

RESULT
All instruments in the project have the corresponding state removed. For example, removing 
both mute and solo instrument states reverts all instruments to their default state, causing all 
instruments to be included in playback.

RELATED LINKS
Mixer on page 469

Muting notes/items individually
You can mute individual notes and items to exclude them from playback without deleting them, 
for example, to hear chords without their arpeggios, a passage with multiple dynamics at a 
single volume level, or without tempo changes from tempo marks.

PROCEDURE

1. In Write mode, select the notes/items you want to mute/suppress in playback.

2. In the Properties panel, activate Suppress playback in the Common group.

Resetting changes to volume faders
You can reset changes you have made to volume faders in the Mixer back to their default level.

PREREQUISITE
The Mixer window is shown.
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PROCEDURE

● In the Mixer, Ctrl/Cmd -click each volume fader that you want to reset.

RELATED LINKS
Hiding/Showing the Mixer window on page 471
Mixer on page 469

Changing the tempo mode
You can switch the tempo mode at any time between using a single fixed tempo and following 
tempo changes, for example, if you have a project with multiple tempo changes but want to use 
a single fixed tempo when recording MIDI.

PROCEDURE

1. Change the tempo mode in any of the following ways:

● In any mode, click Fixed Tempo Mode in the toolbar.

● In Play mode, choose Play > Fixed Tempo Mode.

2. Optional: When Fixed Tempo Mode is active, change the metronome mark value by clicking 
and dragging upwards/downwards on the Fixed Tempo Mode number in the toolbar.

TIP

If you want to change the metronome mark value by smaller increments, you can hold Shift 
when clicking and dragging.

RESULT
In follow tempo mode, the tempo for playback and recording is set by tempo marks in 
the project. Follow tempo mode is active when Fixed Tempo Mode in the toolbar appears 
highlighted, and when no tick appears beside Fixed Tempo Mode in the Play menu.

In fixed tempo mode, the tempo for playback and recording is a single tempo, as determined by 
the Fixed Tempo Mode metronome mark value. Fixed tempo mode is active when Fixed Tempo 
Mode in the toolbar is not highlighted, and when a tick appears beside Fixed Tempo Mode in 
the Play menu.

EXAMPLE

Fixed Tempo Mode when fixed tempo mode is 
active

Fixed Tempo Mode when follow tempo mode is 
active

RELATED LINKS
Tempo marks on page 926
Time track on page 447
MIDI recording on page 204
Playing back music on page 458
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Repeats in playback
Dorico SE supports the playback of repeat structures, including repeat endings, repeat barlines, 
and repeat markers, provided all the correct jumps and sections are in place.

There is no limit to the number of repeat structures you can have in a single flow and still obtain 
correct playback.

By default, Dorico SE plays sections between repeat barlines twice and includes repeats in 
playback, except after repeat jumps, such as D.S. al Coda.

During playback, the bars/beats and time displays in the mini transport and Transport window 
reflect the current position of the playhead in repeat structures.

Dynamics and tempo marks are reflected in repeats. Repeats are also included in both audio and 
MIDI exports.

RELATED LINKS
Transport window on page 472
Mini transport on page 25
Including/Excluding repeats in playback after repeat jumps on page 465
Repeat endings on page 853
Repeat markers on page 857
Types of barlines on page 558
Tremolos on page 963
Rhythm slashes on page 869
Bar repeats on page 861

Changing the number of playthroughs at repeat barlines
End repeat barlines typically indicate that the preceding music is played through twice. You can 
change the number of playthroughs for each end repeat barline individually.

PROCEDURE

1. Select the end repeat barlines whose number of playthroughs you want to change.

2. In the Properties panel, activate Play n times in the Time Signatures group.

3. Change the value in the value field.

NOTE

The minimum value is 2.

RESULT
The number of times the music preceding the selected end repeat barlines is played through 
is changed. A marker is shown at system object positions that indicates the number of 
playthroughs set when this is 3 or more.
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EXAMPLE

Final repeat barline with the default 2 playthroughs 
set

Final repeat barline with 4 playthroughs set and 
marker shown

RELATED LINKS
Types of barlines on page 558
Input methods for bars, beats, and barlines on page 235
Including/Excluding repeats in playback after repeat jumps on page 465
Changing the total number of playthroughs in repeat endings on page 853

Including/Excluding repeats in playback after repeat jumps
By default, Dorico SE plays back all playthroughs in all types of repeat structures. You can 
manually include/exclude repeats indicated by repeat markers, repeat endings, and repeat 
barlines in playback after individual repeat jumps.

NOTE

You can only include/exclude repeats after repeat jumps, such as D.C. al Fine and D.S. al Coda.

PROCEDURE

1. Select the repeat jumps after which you want to include/exclude repeats in playback.

2. In the Properties panel, activate Replay repeats in the Repeat Markers group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Repeats are included in playback after the selected repeat jumps when the checkbox is activated, 
and excluded from playback when the checkbox is deactivated.

Play mode
Repeats in playback 

465
Dorico SE 3.5.12



Swing playback
Swing is a style of performance where equally-notated notes are played in a regular pattern of 
alternating longer and shorter notes, which commonly entails eighth notes being played as a 
quarter note triplet followed by an eighth note triplet.

A swing phrase with simplified straight notation How the same phrase sounds with a 2:1 swing ratio

Swing playback allows you to hear the uneven rhythms you want whilst retaining their simplified 
notation, including if the second eighth note beat is divided into two 16th notes. In Dorico SE, 
you can enable swing playback for certain sections and for individual instruments only. You can 
swing either eighth notes or 16th notes.

Based on academic research into the rendering of swing by musicians, swing patterns in Dorico 
SE are tempo-dependent by default. This means that the swing feels more pronounced at lower 
tempos, and straighter at higher tempos.

RELATED LINKS
Enabling swing playback on page 467

Swing ratios and rhythmic feels
Swing ratios express the strength of the swing using beat units. For example, a swing ratio of 2:1 
means the first note in each pair is twice as long as the second, creating a triplet swing.

A swing ratio of 1:1 means the music is played straight, while a swing ratio of 5:1 means each 
pair of notes is played as if they were sextuplets, with the first note in the pair lasting five 
divisions and the second note lasting one.

Swing ratio 1:1 Swing ratio 5:1

The following rhythmic feels and swing ratios are provided by default in Dorico SE:

2:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be twice as long as the second, creating 
a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is maintained 
regardless of the tempo by default.
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2:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be twice as long as the second, 
creating a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is 
maintained regardless of the tempo by default.

3:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be three times as long as the second, 
creating a dotted 16th-32nd ratio (dotted semiquaver-demisemiquaver). This ratio is 
maintained regardless of the tempo by default.

3:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be three times as long as the 
second, creating a dotted eighth-16th ratio (dotted quaver-semiquaver). This ratio is 
maintained regardless of the tempo by default.

Heavy swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 3:1 at low tempos and 
1.5:1 at high tempos.

Heavy swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 3:1 at low tempos 
and 1.5:1 at high tempos.

Light swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Light swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Medium swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 2:1 at low tempos and 
1.5:1 at high tempos.

Medium swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 2:1 at low tempos 
and 1.5:1 at high tempos.

Straight (no swing)
Produces no swing, that is, even eighth notes in the ratio 1:1 at all tempos.

You can change the swing ratio used for specific sections and for individual players.

Enabling swing playback
You can enable swing playback for specific sections in your project and for individual instruments 
independently, for example, if you want only the soloist to swing for a twelve-bar section.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to enable swing playback from a specific rhythmic position onwards, select 
a single item at the start of the bar where you want swing playback/a different rhythmic 
feel.
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● If you want to enable swing playback within a section then return to straight playback, 
select multiple items that span the duration where you want swing playback/a different 
rhythmic feel.

NOTE

● If you want to enable swing playback for a single instrument, select an item or items that 
belong to that instrument only.

● If you select an item in the middle of a bar, the rhythmic feel change only takes effect 
from the start of the next bar.

2. Press Shift-T  to open the tempo popover.

3. Enter the appropriate entry for rhythmic feel you want into the popover.

When you start entering a rhythmic feel into the tempo popover, a menu appears that shows 
valid rhythmic feels containing the letters/words you enter, which you can select.

NOTE

If you do not enter the name of a rhythmic feel that exists in your project, the text you 
entered into the popover is input as a tempo mark and does not enable swing playback.

4. Input the rhythmic feel change and close the popover in one of the following ways:

● To input a rhythmic feel change for all staves, press Return .

● To input a rhythmic feel change only for the selected instrument, press Alt/Opt-Return .

RESULT
The rhythmic feel used for swing playback is changed from the start of the bar containing the 
earliest selected item, or the start of the next bar if you selected an item in the middle of a 
bar. If you selected multiple items, the rhythmic feel is automatically reset at the position of 
the last selected item. If you pressed Alt/Opt-Return , the rhythmic feel change only applies to 
the instrument on whose staff you selected an item. Rhythmic feels added to single instruments 
apply to all staves belonging to those instruments.

A signpost appears showing the name of the rhythmic feel you input. It is shown above the top 
staff in the system for rhythmic feel changes that apply to all staves, and directly above the top 
staff for rhythmic feel changes that apply only to single instruments.

RELATED LINKS
Tempo popover on page 229

Deleting rhythmic feel changes
You can delete rhythmic feel changes you have enabled for specific sections or for individual 
players only.

PREREQUISITE
Rhythmic change signposts are shown.
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PROCEDURE

1. In Write mode, select the signposts of the rhythmic changes you want to delete.

2. Press Backspace or Delete .

RESULT
The rhythmic changes are deleted. The affected staves return to the default non-swing playback 
until the next existing rhythmic change signpost, if applicable.

RELATED LINKS
Hiding/Showing signposts on page 350

Mixer
The Mixer allows you to control the sounds produced in playback, both for the master output and 
on each individual channel.

You can hide/show the Mixer window in any of the following ways:

● Press F3 .

● Click Show Mixer  in the toolbar.

The Mixer comprises the following:

1 Channel type buttons

Allow you to hide/show channels in the Mixer according to their type, and in any 
combination.

2 Channel controls

Allow you to hide/show the corresponding controls in the channel strip according to their 
type, and in any combination.

3 Deactivate All Mute States/Deactivate All Solo States

Allows you to deactivate all mute/solo states by clicking the corresponding button.

4 Zoom

Allows you to make channels wider/narrower.

5 VST channels

There is a mixer channel for each stereo output from the VST instruments in your project, 
and all instruments in your project are shown, even if they are spread across multiple VST 
instrument instances. Channels display the full instrument name set for that instrument in 
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the Edit Instrument Names dialog and its instrument number, if applicable. Channels are 
stereo by default.

6 Mute/Solo

Allows you to mute/solo individual tracks.

7 Balance panner

Allows you to position the sound of each individual track on the stereo spectrum for stereo 
playback.

8 Fader

Allows you to control the volume level of each individual track.

MIDI channels have a MIDI fader.

9 Channel meter

Indicates the output volume of each individual channel in real time.

10 MIDI channels

Every VST instrument in your project has its own MIDI channel in addition to its VST 
channel. These MIDI channels allow you to change the MIDI volume and MIDI pan of each 
instrument.

11 MIDI pan

Allows you to position the MIDI output of the channel on the stereo spectrum for stereo 
playback.

12 MIDI fader

Allows you to change the MIDI volume of the channel.

Some plug-ins require MIDI faders, and this is often useful if you are using a MIDI device for 
playback.

13 Click channel

Allows you to control the volume of the metronome click.

14 Video channel

Allows you to control the volume of video audio.

15 FX Send channel

Allows you to control the volume of send effects, such as reverb. By default, this channel has 
REVerence loaded automatically.

16 Output channel

Allows you to control the master output volume.

NOTE

In order to control the volume levels in your project, we recommend that you first input 
dynamics and adjust the dynamic curve to suit your project before using the track faders.

Any changes you make in the Mixer are automatically saved and applied to the project.

RELATED LINKS
Toolbar on page 24
Hiding/Showing the Mixer window on page 471
Muting/Soloing tracks on page 461
Resetting changes to volume faders on page 462
Edit Instrument Names dialog on page 132
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Mixer channel strips
Each channel in the Mixer has its own channel strip, which contains the channel controls. You can 
hide/show each type of channel control by clicking the corresponding button at the top of the 
mixer.

Each channel strip contains the following types of controls:

Inserts

Each channel has four slots into which you can load an insert. You can select an insert 
from the available options in the menu.

EQ

Each channel has four bands of EQ.

In order to make changes to the EQ bands on a channel, you must first click Enable EQ. 
You can use this to bypass the EQ on a channel without losing your settings.

Sends

Each channel has four slots for sends. By default, the first slot for each channel sends 
to the FX channel, which has reverb loaded on it.

Hiding/Showing the Mixer window
You can hide and show the Mixer window at any time, for example, if you do not want it in view 
when working on the music in the music area.

PROCEDURE

● Hide/Show the Mixer window in any of the following ways:

● Press F3 .

● Click Show Mixer  in the toolbar.

● Choose Window > Mixer.

The Mixer window is shown when a tick appears beside Mixer in the menu, and hidden 
when no tick appears.
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Transport window
The Transport window contains playback and MIDI recording functions, such as rewinding 
and fast-forwarding. It contains additional and more precise versions of the playback functions 
available in the toolbar.

You can hide/show the Transport window in any of the following ways:

● Press F2 .

● Click Show Transport Bar  in the toolbar.

The Transport window contains the following information and functions:

1 Bars/Beats display

Shows the position of the playhead relative to bars and beats in the current flow in the 
following order of units: bars, beats, 16th notes, 120ths of a 16th note.

2 Time display

Shows the position of the playhead as elapsed time in the following order of units: hours, 
minutes, seconds, milliseconds. Alternatively, it can show the timecode position of the 
playhead in the current flow in the following order of units: hours, minutes, seconds, frames.

You can switch between having the time display show the time and timecode by clicking it.

3 Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

4 Rewind

Moves the playhead back by a half note each time you click.

5 Fast Forward

Moves the playhead forwards by a half note each time you click.

6 Stop

Stops playback.

7 Play From Playhead Position

Plays back from the position of the playhead.

8 Play From Selection

Plays back from the position of the first selected item in the music area.

If you select items on multiple staves, or multiple items on a single staff, only the selected 
staves are played back.

9 Record

Starts/Stops MIDI recording.

10 Retrospective Record

Retrieves any MIDI notes you played during the previous playback and allows you to input 
them on any staff, even if you were not recording them explicitly.

11 Click
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Plays/Mutes the metronome click during playback and recording.

12 Fixed Tempo Mode

Displays the tempo used for both playback and recording. The value changes according to 
the current position of the playhead and its appearance changes according to its current 
mode.

RELATED LINKS
Toolbar on page 24
Mini transport on page 25
Changing the tempo mode on page 463

Changing the content shown in the transport display
You can switch between showing the timecode, the total elapsed time, and the current rhythmic 
position of the playhead expressed in bars, beats, and ticks in both the mini transport in the 
toolbar and the Transport window.

PROCEDURE

● In either the mini transport in the toolbar or the Transport window, click the transport 
display until the content you want appears.

In the Transport window, this is the display on the right.

RESULT
Each time you click in the mini transport display, it cycles through showing the rhythmic position 
of the playhead, elapsed time, and the timecode.

In the Transport window, it only switches between the timecode and elapsed time, as the 
rhythmic position of the playhead is shown permanently on the left of the window.

TIP

You can change what is shown in the mini transport by default for all future projects on the Play 
page in Preferences.

RELATED LINKS
Toolbar on page 24
Mini transport on page 25
Timecodes on page 849
Preferences dialog on page 45

Playback templates
Dorico SE uses playback templates to allocate sounds from VST instruments and MIDI devices to 
the instruments in your project.

Playback templates combine the following information in order to obtain correct playback:

● The instrument sounds, articulations, and playback techniques provided by plug-ins, such as 
VST instruments

● The expression/percussion maps required to obtain those sounds

● The endpoint configurations required for the sounds for each instrument
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When you add instruments to players in a project, Dorico SE automatically loads plug-ins for 
them according to the current playback template and sets up expression maps and percussion 
maps as required. Dorico SE also automatically loads enough plug-in instances, as many plug-ins 
can only load a limited number of sounds in each instance.

You can override playback templates and make your own manual changes to the sounds used 
by instruments in your project, such as by changing the expression maps assigned to endpoints. 
You can then save such changes as custom endpoint configurations, which you can include in 
your own custom playback templates.

You can also export custom playback templates, for example, to share them with other users. 
Playback templates are saved as .dorico_pt files.

NOTE

● Playback templates are available in all projects you open or create on your computer, 
meaning any changes you make to playback templates affect all projects that use those 
playback templates.

● Dorico SE automatically loads sounds for any new instruments you add to the project, 
using the sounds included in the current playback template. Therefore, we recommend that 
you always include a factory default playback template at the bottom of custom playback 
templates as a fallback to ensure that all instruments are assigned sounds.

● Any changes you make within plug-ins are saved when you save the project but are not 
communicated to Dorico SE, which can lead to unexpected low notes sounding in playback 
because Dorico SE is still using the expression and percussion maps for the original sounds. 
If you make changes in plug-ins, you must manually assign the correct expression and 
percussion maps to the appropriate endpoints.

RELATED LINKS
Edit Playback Template dialog on page 476
Applying/Resetting playback templates on page 479
Creating custom playback templates on page 479
Exporting playback templates on page 481
Endpoint Setup dialog on page 482
Assigning expression/percussion maps to endpoints on page 488
Endpoints on page 481
Custom endpoint configurations on page 484
Edit Endpoint Configurations dialog on page 486
Allowing/Blocking VST plug-ins on page 418

Apply Playback Template dialog
The Apply Playback Template dialog allows you to change the playback template applied to the 
current project and to import/export playback templates. It also allows you to access the Edit 
Playback Template dialog.

● You can open the Apply Playback Template dialog in Play mode by choosing Play > 
Playback Template.

The Apply Playback Template dialog shows all the playback templates available on your 
computer in a table. Dorico SE provides the following factory default playback templates:

● HSSE (Elements): Intended for use with HALion Sonic SE.

● HSSE+HSO (Pro): Intended for use with both HALion Sonic SE and HALion Symphonic 
Orchestra.
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● Silence: Prevents Dorico SE from loading sounds.

TIP

● Choosing the Silence template makes Dorico SE project files significantly smaller, for 
example, if you want to send them electronically.

● We recommend that you only use the HSSE+HSO (Pro) playback template if you own a 
separate HALion Symphonic Orchestra license, as Dorico SE only includes HALion Sonic SE.

The Apply Playback Template dialog comprises the following:

1 Search field

Allows you to filter playback templates in the list according to your entry.

2 Name column

Contains a list of the playback templates available on your computer. You can click the 
column header to change the sorting order.

3 Factory column

Contains the factory symbol if the playback template in the corresponding row is a factory 
default playback template. You can click the column header to change the sorting order.

4 Action bar

Contains the following options for playback templates:

● Add Playback Template : Opens the Edit Playback Template dialog and allows you 
to create a new playback template.

● Duplicate Playback Template : Opens the Edit Playback Template dialog and allows 
you to create a new playback template that starts as a duplicate of the selected one.

● Edit Playback Template : Opens the Edit Playback Template dialog and allows you 
to edit the existing selected playback template.
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NOTE

You cannot edit factory default playback templates.

● Show Factory : Allows you to hide/show factory default playback templates in the 
table.

● Export: Opens the File Explorer/macOS Finder, where you can select the location to 
which you want to export the currently selected playback templates as .dorico_pt 
files. You can then import the .dorico_pt files into Dorico SE on other computers and 
share them with other users.

● Import: Opens the File Explorer/macOS Finder, where you can select the .dorico_pt 
files that you want to import as playback templates.

● Delete : Deletes the selected playback templates.

NOTE

You cannot delete factory default playback templates.

5 Apply and Close

Applies the selected playback template to the project and closes the dialog.

RELATED LINKS
Creating custom playback templates on page 479
Applying/Resetting playback templates on page 479
Importing playback templates on page 480
Exporting playback templates on page 481
Edit Endpoint Configurations dialog on page 486

Edit Playback Template dialog
The Edit Playback Template dialog allows you to create new custom playback templates and 
edit existing ones. You can use any combination of custom endpoint configurations and existing 
playback templates and specify the order in which they should be used.

Playback templates are available in all projects you open or create on your computer.

● You can open the Edit Playback Template dialog by clicking Add Playback Template, 
Duplicate Playback Template, or Edit Playback Template in the Apply Playback Template 
dialog.

Play mode
Playback templates 

476
Dorico SE 3.5.12



The Edit Playback Template dialog contains the following sections and options:

1 Playback template data

Allows you to specify the following identifying information for the selected custom playback 
template:

● Name: Allows you to set the name of the playback template that appears in the 
program, for example, in the Apply Playback Template dialog.

● ID: Allows you to set the unique ID of the playback template. Dorico SE automatically 
populates the ID field with the information you enter into the Name field.

● Creator: Allows you to name the creator if you are sharing your playback template with 
other users.

● Version: Allows you to indicate the playback template version so you can identify the 
most recent one, for example, you can increase the Version number each time you 
make changes to the playback template.

● Description: Allows you to add any other information about the playback template.

NOTE

All fields in the playback template data section, except for Name, are locked by the Lock Info 
button. You must click this button in order to change the information in the fields.

2 Entries

Contains a table of all the custom endpoint configurations and existing playback templates 
used by the selected custom playback template. Entries are listed in order of priority, 
meaning that Dorico SE assigns sounds from the top entry first. We recommend that you 
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always include a factory default playback template at the bottom of the list as a fallback to 
ensure that all instruments are assigned sounds.

In most cases, listing entries in your order of preference in the Entries section is sufficient 
to achieve your desired playback. However, if multiple entries in your custom playback 
template provide sounds for the same instrument, you must set family and/or instrument 
overrides, for example, if you only want to use woodwind sounds from the first entry and use 
all other sounds from the second entry.

The column on the right identifies the type of the entry in the corresponding row.

● Manual: Entries that cannot load sounds automatically, including custom endpoint 
configurations

● Auto: Entries that can load sounds automatically, that is, factory default playback 
templates

The action bar at the bottom of the section contains the following options:

● Add Manual: Allows you to add a manual entry to the playback template.

● Add Automatic: Allows you to add an automatic entry to the playback template.

● Move up : Moves the selected entry up the list.

● Move down : Moves the selected entry down the list.

● Delete : Removes the selected entry from the playback template.

3 Family Overrides

Contains a list of family overrides applied to the selected entry and allows you to add/
remove overrides. Family overrides allow you to specify the instrument family sounds you 
want to use, for example, if you only want to use the woodwind sounds from an entry that 
also includes brass and string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument Family : Allows you to select an instrument family to apply as an 
override to the selected entry.

● Delete Instrument Family : Removes the selected family override from the selected 
entry.

4 Instrument Overrides

Contains a list of instrument overrides applied to the selected entry and allows you to add/
remove overrides. Instrument overrides allow you to specify individual instrument sounds 
you want to use, for example, if you only want to use a solo violin sound from an entry that 
also includes ensemble string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument : Allows you to select an instrument to apply as an override to the 
selected entry.

● Delete Instrument : Removes the selected instrument override from the selected 
entry.

5 Endpoint Configurations

Opens the Edit Endpoint Configurations dialog, which allows you to rename and delete 
custom endpoint configurations, and view the plug-ins and players they contain.

RELATED LINKS
Apply Playback Template dialog on page 474
Endpoints on page 481
Edit Endpoint Configurations dialog on page 486
Custom endpoint configurations on page 484

Play mode
Playback templates 

478
Dorico SE 3.5.12



Applying/Resetting playback templates
You can change the playback template applied to the current project, for example, if you do 
not need to use playback and so want to prevent Dorico SE from loading sounds. Re-selecting 
playback templates resets them to their default settings.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback template you want to use.

3. Click Apply and Close.

RESULT
The playback template applied to the current project is changed. If you re-selected the playback 
template already in use, the playback template is reset.

Sounds are loaded into plug-in instances in their score order.

TIP

● You can change the default playback template used for all future projects on the Play page 
in Preferences.

● You can also load sounds just for instruments without assigned sounds by choosing Play > 
Load Sounds for Unassigned Instruments.

RELATED LINKS
Playback templates on page 473
Preferences dialog on page 45

Creating custom playback templates
You can create custom playback templates that can include combinations of factory default 
playback templates, custom endpoint configurations, and other non-factory default playback 
templates that cannot load sounds automatically.

PROCEDURE

1. In Play mode, choose Play > Playback Template to open the Apply Playback Template 
dialog.

2. Open the Edit Playback Template dialog to create a new playback template in one of the 
following ways:

● To create an empty playback template, click Add Playback Template  in the action 
bar.

● To create a copy of an existing playback template, select it and click Duplicate Playback 
Template  in the action bar.

3. In the Edit Playback Template dialog, click Lock Info  to unlock the data fields.

4. Enter information for your playback template in the relevant fields.

5. In the Entries section, add the custom endpoint configurations and/or factory default 
playback templates you want.

● To add a custom endpoint configuration or non-factory default playback template, click 
Add Manual and select the one you want from the menu.
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● To add a factory default playback template, click Add Automatic and select the one you 
want from the menu.

TIP

We recommend that you always include a factory default playback template at the bottom of 
the list as a fallback to ensure that all instruments are assigned sounds.

6. Optional: To change the order of entries and their order of preference in the playback 
template, select an entry and click one of the following options in the action bar:

● To move the selected entry upwards, click Move up.

● To move the selected entry downwards, click Move down.

7. Optional: Repeat step 6 until all the entries are in the correct order of preference.

8. Optional: Select an entry for which you want to specify instrument family overrides.

9. In the Family Overrides section action bar, click Add Instrument Family and select the one 
you want from the menu.

For example, if you only want to use the woodwind sounds from a sound library that also has 
string sounds, select Woodwinds.

10. Optional: Select an entry for which you want to specify individual instrument overrides.

11. In the Instrument Overrides section action bar, click Add Instrument and select the one 
you want in the instrument picker.

For example, if you only want to use the piano sound from a sound library that has other 
keyboard instrument sounds, select Piano.

12. Optional: Repeat steps 8 to 11 for other entries for which you want to specify instrument 
family and instrument overrides.

13. Click OK to save your changes and close the dialog.

RESULT
Your new custom playback template is created. It is available to use in the current project and all 
projects you create/open on your computer.

RELATED LINKS
Apply Playback Template dialog on page 474
Edit Playback Template dialog on page 476
Endpoint Setup dialog on page 482
Custom endpoint configurations on page 484
Saving custom endpoint configurations on page 484
Allowing/Blocking VST plug-ins on page 418

Importing playback templates
You can import playback templates into projects, for example, if someone you are working 
with exported their custom playback template for you to use. Playback templates are saved 
as .dorico_pt files.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Click Import to open the File Explorer/macOS Finder.

3. Locate and select the playback template file you want to import.
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4. Click Open.

RESULT
The selected playback template is imported. It becomes available in the current project and all 
projects you create/open on your computer.

TIP

You can also import playback templates by dragging .dorico_pt files into a Dorico SE project 
window.

Exporting playback templates
You can export playback templates so you can send them to other users or use them on other 
computers. By default, any playback templates you create are available in all projects on your 
computer.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback templates you want to export.

3. Click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the playback template files.

5. Click Save.

RESULT
The selected playback templates are exported and saved in the selected location as 
separate .dorico_pt files.

Endpoints
“Endpoint” is the term used for the unique combination of inputs and outputs that together allow 
the correct sounds to be played for each instrument.

In Dorico SE, each endpoint brings together the following:

● A VST instrument or MIDI output device instance

● A specific channel on that VST instrument or MIDI output device

● The patch or program assigned to that channel

● The expression map and/or percussion map that describes the instrument or instruments 
that can be played by that patch or program, and the playback techniques and articulations 
provided

Each instrument in your project is connected to a specific endpoint. Assigning an expression/
percussion map to the same endpoint allows Dorico SE to translate any playing technique 
changes and articulations you input into the key switches and controller switches necessary to 
produce the required sounds for the instrument in playback.

When you use a factory default playback template, Dorico SE sets up endpoints and expression/
percussion maps automatically. If you want to load other plug-ins or change the patches within 
HALion Sonic SE, you can do so in the Endpoint Setup dialog.
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NOTE

Any changes you make within plug-ins are not communicated to Dorico SE, for example, 
changing a sound that the expression map expects to use a modulation wheel for dynamics to 
one that uses note velocity instead. This can lead to unexpected low notes sounding in playback 
because Dorico SE is still using the expression and percussion maps for the original sounds. If 
you make changes in plug-ins, you must manually assign the correct expression and percussion 
maps to the appropriate endpoints.

You can then save your changes as a custom endpoint configuration if you want to reuse them in 
other projects.

RELATED LINKS
Custom endpoint configurations on page 484
Edit Endpoint Configurations dialog on page 486

Endpoint Setup dialog
The Endpoint Setup dialog displays which expression and percussion maps are currently linked 
to each endpoint in the corresponding plug-in instance, and allows you to change these settings. 
It also allows you to save your current settings as custom endpoint configurations, which you can 
then include in custom playback templates.

● You can open the Endpoint Setup dialog by clicking Endpoint Setup  in each plug-in 
instance in the VST and MIDI Instruments panel.

The Endpoint Setup dialog contains the following options and sections:

1 Name

Allows you to change the name of the selected plug-in instance. This affects the name shown 
in the VST and MIDI Instruments panel and in the Mixer.

2 Number of MIDI ports
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Displays the number of MIDI ports the corresponding plug-in instance currently uses.

You can change the number of MIDI ports, for example, if you are using a plug-in that uses 
more than one port. Dorico SE does not load multiple MIDI ports by default.

3 Number of MIDI channels

Displays the number of MIDI channels the corresponding plug-in instance currently uses.

You can change the number of channels, for example, if you have a monotimbral plug-in 
such as a piano sampler which only has one MIDI channel, or a multitimbral plug-in with 16 
MIDI channels and 16 audio outputs.

4 Set

Sets the plug-in instance to have the number of MIDI ports and channels specified in the 
Number of MIDI ports and Number of MIDI channels value fields. This changes the 
number of rows in the table.

5 Endpoint setup table

Contains the settings for the corresponding plug-in instance, arranged into the following 
columns:

● Port: Displays the port used by the instrument in the corresponding row of the table.

NOTE

You cannot change the port from within the Endpoint Setup dialog. You must change 
the port in the instrument track headers.

● Channel: Displays the channel used by the instrument in the corresponding row of the 
table.

NOTE

You cannot change the channel from within the Endpoint Setup dialog. You must 
change the channel in the instrument track headers.

● Assigned Instruments: Displays the full name of the instrument in the corresponding 
row, as set for that instrument in the Edit Instrument Names dialog, and its instrument 
number, if applicable.

● Expression map: Displays the expression map currently assigned to the instrument in 
the corresponding row. You can change the expression map by double-clicking it and 
selecting another expression map from the menu.

● Percussion map: Displays the percussion map currently assigned to the instrument in 
the corresponding row. You can change the percussion map by double-clicking it and 
selecting another percussion map from the menu.

6 Number of audio outputs to show in Mixer
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Allows you to change the number of audio outputs shown in the Mixer, for example, if you 
want to hide unused outputs when using plug-ins that provide more audio outputs than 
Dorico SE uses.

7 Save Endpoint Configuration

Opens the Save Endpoint Configuration dialog, which allows you to enter a name for the 
current endpoint configuration and save it as a custom endpoint configuration.

RELATED LINKS
VST and MIDI Instruments panel on page 415
Playback templates on page 473
Expression Maps dialog on page 489
Edit Instrument Names dialog on page 132

Custom endpoint configurations
Custom endpoint configurations save the current state and settings of plug-ins in your project, 
such as the number and type of VST/MIDI instruments loaded and the instruments and 
expression/percussion maps assigned to endpoints.

You can save custom endpoint configurations that include the settings for all plug-ins currently 
loaded or only a single one.

Custom endpoint configurations are available in all projects you open or create on your 
computer. You can view, rename, and delete the custom endpoint configurations on your 
computer in the Edit Endpoint Configurations dialog.

RELATED LINKS
Edit Endpoint Configurations dialog on page 486
Playback templates on page 473
Edit Playback Template dialog on page 476
Creating custom playback templates on page 479

Saving custom endpoint configurations
You can save any overrides you have made to endpoint configurations, such as changing the 
instruments and expression maps assigned to particular endpoints. This allows you to use these 
overrides in custom playback templates and re-use the same endpoint configurations in other 
projects.

PREREQUISITE

● You have opened a project containing all instruments and plug-ins that are necessary for the 
custom endpoint configuration.

● You have created any necessary expression maps and playback technique combinations.

● You have created any necessary custom playing techniques.

PROCEDURE

1. Load the plug-ins you want.

You can do this by applying a playback template or by adding plug-in instances manually in 
the VST and MIDI Instruments panel.

2. Change the settings for the endpoints as required.

For example, change the instruments or expression maps assigned to each endpoint.

3. Open the Save Endpoint Configuration dialog in one of the following ways:
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● To save a custom endpoint configuration for only a single plug-in instance, open the 
Endpoint Setup dialog for that plug-in instance and click Save Endpoint Configuration.

● To save a custom endpoint configuration that includes all VST instrument or MIDI 
instrument plug-in instances, click Save Endpoint Configuration  in the action bar 
of the corresponding section of the VST and MIDI Instruments panel.

4. Enter a name for your custom endpoint configuration in the Name field.

NOTE

If you enter a name that already exists, or select an existing custom endpoint configuration 
from the menu, the existing custom endpoint configuration is overwritten.

5. Click OK to save your changes and close the dialog.

RESULT
The current state of either the selected plug-in instance or all plug-in instances in the 
corresponding section is saved as a custom endpoint configuration. This includes any custom 
playing techniques included in any of the expression/percussion maps.

AFTER COMPLETING THIS TASK
You can include custom endpoint configurations in custom playback templates, which allows you 
to use endpoint configurations in other projects.

RELATED LINKS
Edit Endpoint Configurations dialog on page 486
Playback templates on page 473
Creating custom playback templates on page 479
Adding/Editing switches in expression maps on page 503

Save Endpoint Configuration dialog
The Save Endpoint Configuration dialog allows you to save the current state and settings of 
plug-ins in your project. Saving custom endpoint configurations allows you to re-use them in 
other projects and include them in custom playback templates.

You can open the Save Endpoint Configuration dialog in Play mode in any of the following 
ways:

● In the VST and MIDI Instruments panel, click Save Endpoint Configuration in the VST 
Instruments or MIDI Instruments action bar. This saves the current state of all plug-ins in 
the corresponding section of the panel.

● In the Endpoint Setup dialog, click Save Endpoint Configuration. This saves the current 
state of the selected plug-in only.
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The Save Endpoint Configuration dialog contains a Name field that allows you to enter a name 
for the endpoint configuration you are saving. The arrow at the end of the field allows you to 
select an existing custom endpoint configuration to use to populate the field.

If you enter a name that already exists, you can overwrite the existing custom endpoint 
configuration. When you overwrite existing custom endpoint configurations, Dorico SE moves 
the previous version to your recycle bin.

RELATED LINKS
Playback templates on page 473
Edit Endpoint Configurations dialog on page 486

Edit Endpoint Configurations dialog
The Edit Endpoint Configurations dialog allows you to rename and delete custom endpoint 
configurations, and view the plug-ins and players they contain.

● You can open the Edit Endpoint Configurations dialog by clicking Endpoint Configurations 
in the Edit Playback Template dialog.

The Edit Endpoint Configurations dialog comprises the following:

1 Endpoint configurations list

Contains all the endpoint configurations on your computer.

Delete  in the action bar at the bottom of the list allows you to delete the selected 
endpoint configuration from your computer.

2 Name

Allows you to set the name of the selected endpoint configuration that appears in the 
program, for example, in the Edit Playback Template dialog.

3 Plug-ins and players list

Contains all the plug-ins and players contained within the selected endpoint configuration. 
If the endpoint configuration contains multiple instances of the same plug-in, each plug-in 
instance is listed separately.

RELATED LINKS
Endpoints on page 481
Custom endpoint configurations on page 484
Saving custom endpoint configurations on page 484
Edit Playback Template dialog on page 476
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Apply Playback Template dialog on page 474

Assigning instruments/voices to endpoints
You can assign instruments to any endpoint, for example, if you have loaded a plug-in with 
multiple ports and want to change the endpoint of an existing instrument to an endpoint on 
one of your new ports. For instruments with independent voice playback enabled, you can assign 
each voice to a different endpoint.

PREREQUISITE

● If you want to assign different voices belonging to the same instrument to different 
endpoints, you have enabled independent voice playback.

● If you want to assign instruments to endpoints in specific plug-in instances, you have loaded 
those plug-in instances. You can do this by applying a suitable playback template or by 
loading VST/MIDI instruments manually.

PROCEDURE

1. Expand the instrument track whose assigned endpoint you want to change.

2. Optional: For instruments with independent voice playback enabled, select the voice whose 
assigned endpoint you want to change from the Voice menu.

3. Optional: Change the flows to which you want your changes to apply in one of the following 
ways:

● To change the assigned endpoint for the selected voice in the current flow only, click Set 
for This Flow.

● To change the assigned endpoint for the selected voice in all flows, click Set for All 
Flows.

NOTE

This affects all voices in the same position in the Voices menu rather than by voice type.

4. Optional: To assign the instrument/voice to an endpoint in a different plug-in instance, select 
that plug-in instance from the menu in their track header.

5. In the instrument track header, select a new option from one or both of the following 
menus:

● Port

● Ch.

RESULT
The endpoint to which the instrument/voice is assigned is changed.

● Changing just the Ch. value changes the channel in the plug-in instance that the 
corresponding instrument uses.

● Changing both the Port and Ch. values changes both the port in the plug-in instance, and 
the channel in that port, that the corresponding instrument uses.

RELATED LINKS
Expression Maps dialog on page 489
Instrument tracks on page 427
Applying/Resetting playback templates on page 479
Loading VST/MIDI instruments manually on page 417
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Enabling independent voice playback on page 460

Assigning expression/percussion maps to endpoints
You can assign expression/percussion maps to the endpoints in your project, for example, if you 
have created a custom percussion map and must link it to the endpoint for the corresponding 
VST patch.

PREREQUISITE
You have made or imported any expression/percussion maps that you require but do not exist 
on your computer.

PROCEDURE

1. In the VST and MIDI Instruments panel, click Endpoint Setup  in the plug-in instance in 
which you want to change the expression/percussion maps assigned to endpoints to open 
the Endpoint Setup dialog.

2. Double-click the expression/percussion map you want to change.

3. Click the disclosure arrow to the right of the field.

A menu appears containing all maps of the same type currently loaded in your project.

4. Select the expression/percussion map you want from the menu.

5. Press Return .

6. Optional: Repeat steps 2 to 5 for any other endpoints whose assigned expression/percussion 
maps you want to change.

7. Click OK to save your changes and close the dialog.

RELATED LINKS
Percussion maps on page 506

Expression maps
Expression maps tell Dorico SE how to use appropriately the patches and sounds in the VST 
instruments that you have loaded into your project.

Expressing a range of dynamics on instruments means changing the volume and attack of 
notes. Because the strength of attack changes the character of the start of sounds as well as 
their volume, loud sounds often require stronger attacks and quiet sounds often require softer 
attacks.
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Different patches and instruments have different approaches to changing dynamics and volume 
in playback. For example, some patches only change the velocity whereas others use a controller 
in combination with changing the velocity.

Dorico SE also uses expression maps to specify the playback techniques that are supported by 
each patch in your project. For example, string instruments such as the violin have different 
techniques, because they can play arco, pizzicato, and col legno, and their bow position can be 
anywhere between sul ponticello and sul tasto.

In addition to the HALion Symphonic Orchestra expression maps, there are the following 
expression maps in Dorico SE:

● CC11 Dynamics: Uses MIDI controller 11 to play dynamics.

NOTE

This only applies to instruments that can change their dynamic while notes are sounding, 
such as violin or flute.

● Default: Uses note velocity to control dynamic volume.

● Modulation Wheel Dynamics: Uses a modulation wheel to control dynamic volume.

● Transpose down 1 octave: Used by some instrument patches that sound an octave higher 
than written so that they can be played without needing a full range keyboard.

● Transpose up 1 octave: Allows the bottom octave of keyboards to be used for key switches 
instead of notes, but is also used by some bass instrument patches that sound an octave 
lower than written so that they can be played without needing a full range keyboard.

You can edit, create, and import/export expression maps in the Expression Maps dialog. 
Expression maps are saved as .doricolib files.

NOTE

Although Dorico SE approaches expression maps in a different way to Cubase, Dorico SE 
correctly imports many switches from expression maps you import from Cubase, such as 
pizzicato, harmonics, and flutter tongue.

RELATED LINKS
Percussion maps on page 506
Types of actions on page 501
Creating new expression maps on page 502

Expression Maps dialog
The Expression Maps dialog allows you to create new expression maps, edit existing expression 
maps, and import/export expression maps. You can also import expression maps made in 
Cubase.

● You can open the Expression Maps dialog in Play mode by choosing Play > Expression 
Maps.
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The Expression Maps dialog contains the following sections and options:

Expression maps list

1 Expression maps list: Contains the expression maps currently available in your project.

2 Search field: Allows you to search for expression maps by name.

3 Show only expression maps used in this project: Allows you to filter the expression maps 
list so it only includes expression maps used in the current project.

4 Expression maps list action bar: Contains the following options:
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● Add Expression Map : Adds a new expression map that contains no existing settings.

● Duplicate Expression Map : Creates a copy of an existing expression map that you 
can edit separately from the original.

● Delete Expression Map : Deletes the selected expression maps.

NOTE

You can only delete custom expression maps. You cannot delete any default expression 
maps.

Expression Map Data

This section allows you to specify identifying information for the selected expression map.

You can hide/show the Expression Map Data section by clicking the section header.

The Expression Map Data section contains the following options:

● Name: Allows you to set the name of the expression map that appears in the program, for 
example, in the Endpoint Setup dialog.

● ID: Allows you to set the unique ID of the expression map. You can enter any content in the 
ID field.

It can be useful to include the instrument and sound library for which you created the map, 
as well as your name, for example, xmap.user.paulsmith.hso.violinpizz.

● Creator: Allows you to name the creator if you are sharing your expression map with other 
users.

● Version: Allows you to indicate the expression map version, so you can identify the most 
recent one.

● Plug-ins: Allows you to list the names of plug-ins to which the expression map applies, with 
each name separated by a comma. You can leave this field blank.

● Allow multiple notes at same pitch: Allows you to set whether or not the plug-in can treat 
identical pitches in multiple voices belonging to the same instrument as multiple separate 
notes when independent voice playback is disabled.

● Description: Allows you to add any other information about the expression map.

NOTE

All fields in the Expression Map Data section are locked by the Lock Info  button. You must 
click this button to unlock Lock Info  in order to change the information in the fields.

Base and Add-on Switches

This section allows you to view, edit, and control the switches for playback techniques in the 
selected expression map.

Play mode
Expression maps 

491
Dorico SE 3.5.12



You can hide/show the Base and Add-on Switches section by clicking the section header.

The Base and Add-on Switches section contains the following:

1 Switches table: Contains the switches in the currently selected expression map. Allows you 
to add new switches and edit existing ones.

2 Name: Allows you to change the name that appears for the currently selected switch in the 
Switches table, for example, so it appears the same as in your sound library.

TIP

You can still see which playback techniques are triggered by switches with custom names by 
hovering the mouse pointer over the corresponding row in the Switches table.

3 Enabled: Allows you to enable/disable the currently selected switch without removing it from 
the expression map.

4 Actions: Contains any actions required to produce the selected playback technique. Allows 
you to add new actions and edit existing ones.

5 Conditions: Contains any conditions that determine the circumstances in which the currently 
selected switch is used. Allows you to add new conditions and edit existing ones. Only 
available for Base switches.

6 Technique controls: Contains controls that affect the switch currently selected in the 
Switches table. Only available for Base switches.

Switches table

Contains the switches in the currently selected expression map.
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The Switches table comprises the following:

1 Type column: Displays the switch type. Switches can be any of the following types:

● Base

● Add-on

● Init

2 Name column: Displays the name of the switch. By default, this is the same as the playback 
technique or playback technique combination it triggers.

In simple cases, each switch triggers an individual playback technique, such as Staccato 
or Accent. However, some plug-ins have separate samples for different combinations of 
playback techniques. For example, Staccato + Accent might require a separate set of key 
switches to Staccato and Accent individually.

3 Switches table action bar: Contains the following options:

● Add Base Switch : Allows you to add a new base switch to the expression map 
by selecting the playback techniques you want the switch to trigger in the Playing 
Technique Combinations dialog that opens.

● Add Technique Add-on Switch : Allows you to add a new add-on switch to the 
expression map by selecting the playback techniques you want the switch to trigger 
in the Playing Technique Combinations dialog that opens.

● Duplicate Technique : Creates a copy of an existing switch that you can edit 
separately from the original.

● Edit Technique : Opens the Playing Technique Combinations dialog, which allows 
you to edit the combination of playback techniques triggered by the selected switch.

You can also edit the playback techniques of existing switches by double-clicking them in 
the Switches table.

● Audition switch : Plays two notes using the currently selected switch and any 
corresponding actions to demonstrate their effect on playback. Only available for 
expression maps used in the project.

● Transpose up 1 octave : Raises the octave of all key switch actions for the selected 
switch.

● Transpose down 1 octave : Lowers the octave of all key switch actions for the selected 
switch.
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● Delete Technique : Deletes the selected switch.

Selecting a switch in the Switches table allows you to edit its controls and actions. Different 
options are available in the Base and Add-on Switches section depending on the switch type.

NOTE

● Most instruments have a “natural” playback technique, which is the most common way 
of playing the instrument. Dorico SE requires every instrument to have a defined natural 
playback technique.

● You can only select one switch at a time in the Switches table.

Actions

Displays in a table any actions required to produce the selected playback technique. Allows you 
to determine how the switch that triggers each playback technique is controlled, either by adding 
new actions or editing existing ones.

NOTE

Depending on your plug-in, multiple types of actions can be required for each switch.

The Actions subsection comprises the following:

1 Middle C (note 60): Allows you to choose the pitch for middle C, as there are different 
conventions for this. We recommend that you consult the documentation for your sound 
libraries to check whether each one considers middle C to be C3, C4, or C5, and change this 
setting accordingly.

2 On events/Off events: Allows you to specify whether actions affect the start or end of notes. 
For example, you might want an event that resets the playback technique back to normal to 
apply only to the end of notes.

On events affects the start of notes. Off events affects the end of notes.

3 Actions table: Contains the following columns:

● First column: Displays the action type. Actions can be a control change, program change, 
or key switch.

● Second column: Controls the first parameter of the MIDI event. For key switches, this 
indicates the pitch. For control changes, this indicates the control change number. For 
program changes, this indicates the program number.

● Third column: Controls the second parameter of the MIDI event. For key switches, this 
indicates the velocity. For control changes, this indicates the amount of control change 
within the range 0 to 127. Program changes do not have a second parameter.
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NOTE

● You can change the values of cells in the Actions table by double-clicking them, or 
selecting them and pressing Return .

● You can only select one action at a time in the Actions table.

4 Actions table action bar: Contains the following options:

● Add Control Change Action : Adds a control change action with default settings.

● Add Program Change Action : Adds a program change action with default settings.

● Add Note Event Action : Adds a key switch action with default settings.

● Add Absolute Channel Change Action: Adds an absolute channel change action with 
default settings.

● Add Relative Channel Change Action: Adds a relative channel change action with 
default settings.

● Duplicate Action : Creates a copy of an existing action that you can edit separately 
from the original.

● Move Action Up : Moves the selected action up the table, which changes its order in 
the message sequence.

● Move Action Down : Moves the selected action down the table, which changes its 
order in the message sequence.

● Delete Action : Deletes the selected action.

Conditions

Displays in a table any conditions that determine the circumstances in which the base switch 
currently selected in the Switches table is used. Allows you to add new conditions and edit 
existing ones. Only available for Base switches.

For example, you can set conditions instructing the expression map to use a different legato 
sound with a quicker attack for short notes than for longer notes automatically.

The Conditions subsection comprises the following:

1 Any of/All of: Allows you to set whether the switch is used when one or more conditions are 
met or only when all conditions are met.

2 Conditions table: Contains the following columns:

● First column: Displays the condition type.

● Second column: Controls how the condition type in the first column relates to the note 
length set in the third column using operators. The following operators are available:

● ==: Equal to

Play mode
Expression maps 

495
Dorico SE 3.5.12



● !=: Not equal to

● <: Less than

● <=: Less than or equal to

● >: More than

● >=: More than or equal to

● Third column: Controls the note length used by the condition. The following note length 
values are available:

● Very short: A dotted 16th note at 120 bpm, or 0.1875 seconds

● Short: A dotted eighth note at 120 bpm, or 0.375 seconds

● Medium: A dotted quarter note at 120 bpm, or 0.75 seconds

● Long: A dotted half note at 120 bpm, or 1.5 seconds

● Very long: Any longer duration

NOTE

● You can change the values of cells in the Conditions table by double-clicking them, 
or selecting them and pressing Return .

● You can only select one condition at a time in the Conditions table.

3 Conditions action bar: Contains the following options:

● Add Technique : Adds a new technique condition with default settings.

● Duplicate Technique : Creates a copy of an existing technique condition that you can 
edit separately from the original.

● Delete Technique : Deletes the selected technique condition.

Technique controls

Contains controls that affect the base switch currently selected in the Switches table. Only 
available for Base switches.

The following technique controls are available:

● Transpose: Allows you to set the MIDI transposition.

● Length %: Allows you to set the note duration, which overrides the default value.
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● Volume dynamic: Allows you to choose whether the volume dynamic for the selected switch 
is controlled by its Note velocity or a Control change.

If you choose Control change, you must specify the controller by number. You can consult 
the documentation for the VST instrument and/or MIDI controller you are using to find the 
appropriate controller number.

● Volume dynamic Min/Max: Allow you to set the minimum and maximum range for 
dynamics using either note velocity or MIDI CC, depending on the sound library.

● Use Secondary dynamic: Allows you to define an additional volume control for sound 
libraries that use both note velocity and control changes for volume dynamic.

● Secondary dynamic Min/Max: Allow you to set the minimum and maximum range for 
dynamics using either note velocity or MIDI CC, depending on the sound library.

Playback Options Overrides

Allows you to override specific playback options for the selected expression map only. Activating 
a playback option overrides it. The available playback options include the default duration of 
notes with different articulations, unmeasured tremolo notes, and the effect that beat position 
and articulations have on dynamics.

You can hide/show the Playback Options Overrides section by clicking the section header.

Mutual Exclusion Groups

Allows you to define playback techniques that are mutually exclusive, that is, cannot be in use 
concurrently. For example, players cannot play vibrato and non-vibrato at the same time. Putting 
playback techniques into the same exclusion group means only one can be used at a time.

You can allow Dorico SE to define mutual exclusion groups automatically or define them yourself 
manually.

Mutual exclusion groups apply only to the selected expression map. This allows you to set 
different mutual exclusion groups in each expression map, for example, if one of your sound 
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libraries supports a particular playback technique combination for an instrument but another 
sound library does not.

You can hide/show the Mutual Exclusion Groups section by clicking the section header.

The Mutual Exclusion Groups section contains the following options and columns:

1 Auto: Allows Dorico SE to define mutual exclusion groups automatically.

NOTE

Activating Auto permanently deletes any manual exclusion groups you have created.

2 Mutual Exclusion Groups column: Allows you to add and delete mutual exclusion groups 
manually. The action bar at the bottom of the column contains the following options:

● Add : Opens a dialog that allows you to create a new mutual exclusion group and 
enter a name for it.

● Delete : Deletes the selected mutual exclusion group.

NOTE

You can only select one mutual exclusion group at a time.

3 Has techniques column: Allows you to change the playback techniques included in the 
selected mutual exclusion group. The action bar at the bottom of the column contains the 
following options:

● Add : Opens the Playing Technique Combinations dialog that allows you to select 
playback techniques to add to the selected mutual exclusion group.

● Delete : Deletes the selected playback technique from the mutual exclusion group.

NOTE

You can only select one playback technique at a time.

Expression map/Library management options

At the bottom of the Expression Maps dialog, there are the following expression map and library 
management options:
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Reset to Library Defaults
Allows you to revert any changes you have made to the expression maps from the 
Default Library.

Import Library
Opens the File Explorer/macOS Finder, where you can select the .doricolib files that 
you want to import as expression maps.

You can also import Dorico and Cubase expression maps by dragging and dropping 
them into the Expression Maps dialog.

Export Library
Opens the File Explorer/macOS Finder, where you can select the location to which you 
want to export the currently selected expression maps as a .doricolib file. You can 
then import the .doricolib file into other projects and share it with other users.

Import Cubase Expression Map
Opens the File Explorer/macOS Finder, where you can select the 
Cubase .expressionmap files you want to import as expression maps.

NOTE

Cubase expression maps that you have imported often require some editing to 
function correctly in Dorico SE. However, switch data is preserved.

RELATED LINKS
Types of switches on page 500
Types of actions on page 501
Playback techniques on page 512
Endpoint Setup dialog on page 482
Edit Playback Techniques dialog on page 513
Enabling independent voice playback on page 460
Creating new expression maps on page 502
Adding/Editing switches in expression maps on page 503
Adding/Editing mutual exclusion groups in expression maps on page 504

Playing Technique Combinations dialog
The Playing Technique Combinations dialog allows you to create combinations of playback 
techniques that you want to apply simultaneously. Playback techniques are used by expression 
maps to assign the correct sounds to the required playing techniques in the music.

You can open the Playing Technique Combinations dialog in the following ways:

● In the Expression Maps dialog, click Add Technique  in the Switches table action bar.

● In the Expression Maps dialog, select an existing playback technique in the Switches table 
and click Edit Technique  in the Techniques action bar. You can also double-click the 
playback technique.
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1 Techniques list

Allows you to select playback techniques to include in a new switch or to change the 
playback techniques in an existing switch.

You can select multiple playback techniques to combine by Ctrl/Cmd -clicking each playback 
technique.

2 Name

Displays the name of the selected playback technique. If you select multiple playback 
techniques, each name is automatically separated by a + symbol.

NOTE

You cannot rename playback techniques or playback technique combinations in the Playing 
Technique Combinations dialog. You can rename the switches that include them in the 
Base and Add-on Switches section of the Expression Maps dialog. You can rename 
individual playback techniques in the Edit Playback Techniques dialog.

RELATED LINKS
Expression Maps dialog on page 489
Edit Playback Techniques dialog on page 513
Adding/Editing switches in expression maps on page 503

Types of switches
Switches are used in expression maps to trigger the required playback technique or combination 
of playback techniques. Dorico SE supports multiple types of switches.

Base
A fundamental change to the playing technique or articulation, such as changing from 
arco to pizzicato or unmuted to muted. Base switches are mutually exclusive, meaning 
a new base switch replaces the previous one.
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Add-on
A switch that applies in addition to the existing base switch. For example, some sound 
libraries allow you to use the same legato switch in addition to different base switches. 
Add-on switches do not remove or change base switches. Add-on switches can only 
trigger simple key switch notes and controller values.

Init
A switch that sends instructions when playback starts, such as ensuring a MIDI 
controller always starts at a set value. By default, every expression map contains an 
empty init switch. Init switches can only trigger simple key switch notes and controller 
values.

RELATED LINKS
Expression Maps dialog on page 489
Adding/Editing switches in expression maps on page 503
Adding/Editing mutual exclusion groups in expression maps on page 504

Types of actions
Actions are used in expression maps to determine how individual switches are controlled in order 
to trigger the required playback technique or combination of playback techniques. Dorico SE 
supports multiple types of actions, as different sound libraries require different actions.

Control change actions
Control change actions use MIDI CC events to modulate sounds. They are particularly 
useful when using sound libraries whose sounds can be manipulated incrementally, 
such as increasing/decreasing the string vibrato intensity.

Program change actions
Program change actions use MIDI PC events to switch to different sounds. They are 
particularly useful when using sound libraries, such as General MIDI, that use separate 
programs for each playback technique or combinations of instrument sounds and 
effects presets.

Key switch actions
Key switch actions use MIDI note events to switch to different sounds. They are 
particularly useful when recording MIDI live, as you can press the specified notes on a 
MIDI keyboard to trigger key switch actions while simultaneously playing the notes you 
want to record. Usually, key switch actions are mapped to notes in the lowest octave of 
the MIDI keyboard as they are rarely used for note input.

Key switch actions are also known as “note events”.

Absolute channel change actions
Absolute channel change actions switch to a specific, explicitly numbered channel. 
They are particularly useful for sound libraries that have separate plug-in instances for 
each individual instrument. For example, you might use an absolute channel change 
action to switch from “natural” on channel 1 to “pizzicato” on channel 2 in your viola 
section plug-in instance.

Relative channel change actions
Relative channel change actions switch to a channel numbered relative to the starting 
channel. They are particularly useful for sound libraries that have multiple instruments 
with separate playback technique channels in the same plug-in instance, as they can 
switch between playback techniques according to their relative channel number rather 
than an absolute number. For example, if you have four trumpet instruments loaded in 
the same plug-in instance, each with three channels for different playback techniques, 
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and want to use the same switches for all four trumpets, you might use a relative 
channel change action to switch from the “natural” original channel to “muted” on the 
+1 relative channel.

Relative channel numbers relate to the original channel number of the endpoint for the 
corresponding instrument. A 0 relative channel change switches back to the original 
channel.

TIP

You can add actions to individual switches in the Expression Maps dialog.

Creating new expression maps
You can create new expression maps from scratch, and you can duplicate existing expression 
maps and edit the settings, for example, when using third-party sound libraries or MIDI devices 
that do not provide expression maps.

PROCEDURE

1. Choose Play > Expression Maps to open the Expression Maps dialog.

2. Create a new expression map in one of the following ways:

● To create an empty expression map, click Add Expression Map  in the expression 
maps list action bar.

● To create a copy of an existing expression map, select it in the expression maps list and 
click Duplicate Expression Map  in the action bar.

3. In the Expression Map Data section, click Lock Info  to unlock the fields.

4. In the Expression Map Data section, enter information for your expression map in the 
relevant fields.

5. Activate/Deactivate Allow multiple notes at same pitch.

6. Optional: In the Base and Add-on Switches section, add any new switches you require to 
trigger playback techniques or combinations of playback techniques.

7. In the Switches table, select a switch whose actions, conditions, and/or controls you want to 
edit.

8. Change any settings for the selected switch as required.

For example, you can add actions for all switch types or, for base switches only, choose 
whether the volume of a selected base switch is controlled by its Note velocity or a Control 
change.

9. Optional: Repeat steps 7 and 8 for all switches whose settings you want to change.

10. In the Playback Options Overrides section, activate each playback option you want to 
override for the expression map and change their values.

11. In the Mutual Exclusion Groups section, activate/deactivate Auto.

12. Optional: If you deactivated Auto, add or edit mutual exclusion groups manually.

13. Click OK to save your changes and close the dialog.

RELATED LINKS
Expression Maps dialog on page 489
Endpoint Setup dialog on page 482
Playing Technique Combinations dialog on page 499
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Adding/Editing mutual exclusion groups in expression maps on page 504

Adding/Editing switches in expression maps
You can create new and edit existing switches that trigger playback techniques or combinations 
of playback techniques in individual expression maps, for example, to add an add-on switch to an 
existing base switch or to create a new base switch with note length conditions.

Playback technique combinations are useful for expression maps that require different sets of 
key switches for Staccato + Accent compared to Staccato and Accent individually, for example.

PROCEDURE

1. Choose Play > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add switches or 
whose existing switches you want to edit.

3. Optional: In the Switches table in the Base and Add-on Switches section, add a new switch 
to trigger a playback technique or playback technique combination or edit an existing one in 
one of the following ways:

● To add a new base switch, click Add Base Switch .

● To add a new add-on switch, click Add Technique Add-on Switch .

● To create a copy of an existing switch, select it and click Duplicate Technique .

● To change the playing techniques triggered by an existing switch, select it and click Edit 
Technique .

4. Optional: If you added a new base/add-on switch or edited an existing switch, select the 
playback techniques you want the switch to trigger in the Playing Technique Combinations 
dialog.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

5. Optional: Click OK to add the selected playback techniques and close the Playing Technique 
Combinations dialog.

6. In the Switches table, select the switch whose actions, conditions, and/or controls you want 
to edit.

7. In the Actions subsection, choose the event type from one of the following options:

● On events

● Off events

8. In the Actions table, add an action of the selected event type for the currently selected 
switch in one of the following ways:

● Click Add Control Change Action .

● Click Add Program Change Action .

● Click Add Note Event Action .

● Click Add Absolute Channel Change Action.

● Click Add Relative Channel Change Action.

● Select an existing action and click Duplicate Action .

9. Double-click each cell whose value you want to change and change the value.
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10. Choose one of the following pitches for Middle C (note 60):

● C3

● C4

● C5

NOTE

Steps 11 to 15 only apply to base switches. For init and add-on switches, you can skip to step 
16.

11. Optional: Repeat steps 6 to 10 for each action you require for the currently selected switch.

12. In the Conditions table, add a condition for the currently selected base switch in one of the 
following ways:

● To create a new condition, click Add Technique  in the action bar.

● To create a copy of an existing condition, select it and click Duplicate Technique  in 
the action bar.

13. Double-click each cell whose value you want to change and select the required option from 
the menu.

14. Optional: Repeat steps 12 and 13 for each condition you want to add to the selected base 
switch.

15. Choose one of the following condition options:

● To use the switch when at least one condition is met, choose Any of.

● To use the switch when all conditions are met, choose All of.

16. Change any of the other settings in the Base and Add-on Switches section as required.

For example, choose whether the volume of the selected base switch is controlled by its 
Note velocity or a Control change.

17. Click OK to save your changes and close the Expression Maps dialog.

RELATED LINKS
Playback techniques on page 512
Expression Maps dialog on page 489
Playing Technique Combinations dialog on page 499

Adding/Editing mutual exclusion groups in expression maps
By default, Dorico SE automatically defines mutual exclusion groups. You can create new and edit 
existing mutual exclusion groups in individual expression maps manually.

PROCEDURE

1. Choose Play > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add mutual 
exclusion groups or whose existing mutual exclusion groups you want to edit.

3. Optional: If Auto is activated in the Mutual Exclusion Groups section, deactivate Auto.

4. Optional: If you want to add a new mutual exclusion group, click Add in the Mutual 
Exclusion Groups column action bar.

5. Enter a name for the new mutual exclusion group in the dialog that opens.

6. Click OK to add the group and close the dialog.
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7. In the Mutual Exclusion Groups column, select the mutual exclusion groups whose 
playback techniques you want to change.

8. Change the playback techniques in the selected mutual exclusion group in any of the 
following ways:

● To add new playback techniques to the mutual exclusion group, click Add in the Has 
techniques column action bar to open the Playing Technique Combinations dialog, 
select the playback techniques you want to add, then click OK.

● To remove playback techniques from the mutual exclusion group, select them in the Has 
techniques column, and click Delete in the action bar.

9. Click OK to save your changes and close the Expression Maps dialog.

Importing expression maps
You can import expression maps into projects, including .expressionmap files exported from 
Cubase. Expression maps exported from Dorico are saved as .doricolib files.

PROCEDURE

1. Choose Play > Expression Maps to open the Expression Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the expression map file you want to import.

4. Click Open.

RESULT
The selected expression map is imported into your project. It appears in the expression maps list.

NOTE

● You can also import Dorico and Cubase expression maps by dragging and dropping them 
into the Expression Maps dialog.

● Although Dorico SE approaches expression maps in a different way to Cubase, Dorico SE 
correctly imports many switches from expression maps you import from Cubase, such as 
pizzicato, harmonics, and flutter tongue.

Exporting expression maps
You can export expression maps for use in other projects. Expression maps are saved 
as .doricolib files.

PROCEDURE

1. Choose Play > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.
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RESULT
The selected expression maps are exported as a .doricolib file and saved in the selected 
location.

Percussion maps
Unpitched percussion instruments are played back using patches that map unpitched sounds 
onto different MIDI notes. The pitches required to produce different unpitched sounds vary 
by device, sound library, manufacturer, and so on, and have no connection to the position of 
percussion instruments on five-line staves.

The following list contains some examples of unpitched percussion instruments from the General 
MIDI percussion map.

● Bass drum: C2 (MIDI note 36, two octaves below middle C)

● Kick drum: D2 (MIDI note 38)

● Closed hi-hat: F♯2 (MIDI note 42)

● Cowbell: G♯3 (MIDI note 56)

● Open triangle: A5 (MIDI note 81)

Dorico SE uses percussion maps to connect the written representation of notes and playing 
techniques for percussion instruments to the samples required to play those sounds back.

NOTE

A percussion map describes which unpitched percussion instruments and their playback 
techniques are present in a particular patch, and how to play them back. For example, it 
describes which MIDI note to play, and if another MIDI note is needed as a key switch to trigger 
particular playing techniques.

A set of percussion maps for the unpitched percussion patches that are part of theHALion 
Symphonic Orchestra and HALion Sonic SE factory libraries is provided with Dorico SE. They are 
automatically chosen when you add percussion instruments to your project.

You can define custom percussion maps for third-party sound libraries or MIDI devices in the 
Percussion Maps dialog, in order to obtain correct playback.

RELATED LINKS
Unpitched percussion on page 978
Universal Indian Drum Notation on page 996
Importing percussion maps on page 511
Exporting percussion maps on page 511

Percussion Maps dialog
In the Percussion Maps dialog, you can define custom percussion maps for third-party sound 
libraries or MIDI devices in order to obtain correct playback.

● You can open the Percussion Maps dialog in Play mode by choosing Play > Percussion 
Maps.
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The Percussion Maps dialog is divided into the following sections:

1 Percussion maps list

Contains the percussion maps currently available in your project.

You can add and delete percussion maps using the following buttons in the action bar at the 
bottom of the percussion maps list:

● Add Percussion Map : Adds a new percussion map that contains no existing settings.

● Duplicate Percussion Map : Creates a copy of an existing percussion map that you 
can edit separately from the original.

● Delete Percussion Map : Deletes the selected percussion maps.

NOTE

You can only delete custom percussion maps. You cannot delete any default percussion 
maps.

2 Search field

Allows you to search for percussion maps by name.

3 Show only percussion maps used in this project

Allows you to filter the percussion maps list so it only includes percussion maps used in the 
current project.

4 Percussion Map Data section

Allows you to specify the following identifying information for the selected percussion map:

● Name: Allows you to specify the displayed name for the percussion map that appears in 
the Endpoint Setup dialog.
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● ID: Allows you to set the unique ID of the percussion map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name, for example, xmap.user.paulsmith.hso.cowbell.

● Version: Allows you to indicate the percussion map version so you can identify the most 
recent one.

● Map defines sounds for: Allows you to choose one of the following options, as 
appropriate for the current percussion map:

● Multiple Instruments: Choose this if the patch for which you are creating a map 
contains many different percussion instruments, such as the General MIDI drum 
map.

● Single Instruments: Choose this if the patch for which you are creating a map 
contains only a single percussion instrument, perhaps with multiple playback 
techniques for that instrument. For example, a snare drumline patch in Virtual 
Drumline or another specialist sound library.

This can also be useful when your VST instrument has several patches that have the 
same playback technique mappings. For example, there are both large and small 
cymbal patches in HALion Symphonic Orchestra which provide natural strike and roll 
sounds. Creating a single individual instrument percussion map allows you to use 
the same mapping for these sounds for multiple patches.

NOTE

● ID and Version are locked by the Lock Info button. You must click this button in order to 
change the information in the fields.

● The Endpoint Setup dialog is where you set which percussion map Dorico SE uses for 
each channel on your VST instrument or MIDI output device.

5 Drum Kit Note Map section

Contains subsections that allow you to view, edit, and control the drum kit notes in the 
selected percussion map.

6 Drum Kit Note Map table

By default, the table shows the drum kit notes in use by the selected percussion map 
in numerical order. The table also contains the following columns, which display the 
corresponding available data about the selected drum kit note:

● MIDI Note: Shows the MIDI note number, such as “48”.

● Note Name: Shows the pitch and octave of the note, such as “C3”.

● Name: Shows the name of the technique, such as Snare “(long roll)”.

● Instrument: Shows the unpitched percussion instrument, such as “Snare Drum”.

● Key Switch: Shows the number of the key switch that triggers the note, such as “24”.

● Playing Techniques: Shows the playback techniques triggered by the note, such as 
“Roll”.

At the bottom of the table there are the following options:

● Show all: Shows all MIDI notes from 0 to 127.

● Show MIDI Notes in Use: Only shows the MIDI notes in use by the selected percussion 
map.

● Add Key Switch Alternative: Duplicates the selected drum kit note.

● Clear: Deletes the selected drum kit note.
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You can change the data for the currently selected drum kit note in the Edit Drum Kit Note 
subsection.

7 Edit Drum Kit Note subsection

Allows you to specify data in the following fields for the drum kit note currently selected in 
the Drum Kit Note Map table:

● Name: The displayed name for the specific combination of instrument and playback 
technique. You may choose to input the name used in the manufacturer’s 
documentation for your VST instrument or MIDI output device.

● Instrument: Allows you to select an instrument for the drum kit note selected in the 
Drum Kit Note Map section from a list of all the unpitched percussion instruments you 
can create in Dorico SE.

● Key switches: Allows you to specify the MIDI note number of the key you want to use as 
a key switch if this sound requires another MIDI note to be played to trigger this specific 
combination of instrument and playback techniques.

NOTE

Key switches are not compulsory.

● Techniques: Allows you to select playback techniques to apply to the instrument 
selected in the Instrument field from a list of the available playback techniques.

8 Reset to Library Defaults

Allows you to revert any changes you have made to the percussion maps from the Default 
Library.

9 Import Library

Opens the File Explorer/macOS Finder, where you can select the .doricolib files that you 
want to import as percussion maps.

10 Export Library

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the currently selected percussion maps as a .doricolib file. You can then import 
the .doricolib file into other projects and share it with other users.

Creating new percussion maps
You can create new percussion maps from scratch and you can duplicate existing percussion 
maps and edit the settings, for example, to obtain correct playback when using third-party sound 
libraries or MIDI devices.

PROCEDURE

1. Choose Play > Percussion Maps to open the Percussion Maps dialog.

2. Create a new percussion map in any of the following ways:

● To create an empty percussion map, click Add Percussion Map  in the action bar.

● To create a copy of an existing percussion map, select it in the percussion maps list and 
click Duplicate Percussion Map  in the action bar.

3. In the Percussion Map Data section, click Lock Info  to unlock the fields.

4. Enter the display name you want for the percussion map in the Name field.

This name appears in the Endpoint Setup dialog.

5. Enter any unique identification name in the ID field.
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It can be useful to include the instrument and sound library for which you created the 
map, as well as your name, in the identification name for percussion maps, for example, 
xmap.user.paulsmith.hso.cowbell.

6. Choose one of the following options for Map defines sounds for, as appropriate for the 
current percussion map:

● Multiple Instruments

● Single Instruments

7. In the Drum Kit Note Map section, click Show all to show unmapped notes.

8. Select the row corresponding to the MIDI note for which you want to create a new mapping.

9. In the Edit Drum Kit Note subsection, click  beside the Instrument field to open a dialog 
containing a list of percussion instruments.

10. Select the instrument that corresponds to the sound produced by the selected MIDI note.

11. Click OK.

12. In the Edit Drum Kit Note subsection, click  beside the Techniques field to open the 
Playing Technique Combinations dialog.

13. Select the appropriate playback techniques for the sound produced by the selected MIDI 
note.

For example, Ctrl/Cmd -click Buzz roll and Rim.

14. Click OK.

15. In the Edit Drum Kit Note subsection, enter the display name you want for this combination 
of instrument and playing technique in the Name field.

16. Optional: If the key switch for this sound requires a MIDI note number, specify it in the Key 
switches field.

17. Click Apply.

18. Optional: Repeat these steps for each MIDI note until you have created all the required 
mappings for your project.

19. Click OK to save your changes and close the dialog.

RESULT
The new percussion map is created.

AFTER COMPLETING THIS TASK

● You must assign percussion maps to the same endpoints as the VST instruments or MIDI 
devices that provide the corresponding patches.

● You can export the percussion map if you want to use it in other projects.

RELATED LINKS
Percussion maps on page 506
Assigning expression/percussion maps to endpoints on page 488
Endpoint Setup dialog on page 482
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Importing percussion maps
You can import percussion maps into projects. Percussion maps are saved as .doricolib files.

PROCEDURE

1. Choose Play > Percussion Maps to open the Percussion Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the percussion map file you want to import.

4. Click Open.

RESULT
The selected percussion map is imported into your project. It appears in the percussion maps list.

Exporting percussion maps
You can export percussion maps so you can use them in other projects. Percussion maps are 
saved as .doricolib files.

PROCEDURE

1. Choose Play > Percussion Maps to open the Percussion Maps dialog.

2. In the percussion maps list, select the percussion maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The selected percussion maps are exported as a .doricolib file and saved in the selected 
location.

Defining how combinations of articulations and single-note 
tremolos sound in playback

You can define specific playback behaviors for particular combinations of articulations 
and single-note tremolos in playing technique-specific noteheads for unpitched percussion 
instruments.

PROCEDURE

1. In Setup mode, open the Percussion Instrument Playing Techniques dialog in any of the 
following ways:

● For an individual percussion instrument: In the Players panel, expand the card of the 
player holding the instrument, click the arrow  in the instrument label, and choose 
Edit Percussion Playing Techniques from the menu.

● For percussion instruments that are part of percussion kits: In the Players panel, click 
the arrow  in the kit instrument label, and choose Edit Percussion Kit to open the Edit 
Percussion Kit dialog, select the instrument whose playing techniques you want to edit 
in the main editing area, and click Edit Percussion Playing Techniques.

2. Select the playing technique-specific notehead whose playback behaviors you want to define 
in the list at the top of the dialog.
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3. Click Add Technique  in the action bar at the bottom left of the dialog.

4. Click Choose Playing Techniques  beside the Playback playing technique field to open 
the Playing Technique Combinations dialog.

5. Select the playback techniques you want.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

6. Click OK to add the selected playback techniques and close the Playing Technique 
Combinations dialog.

7. Choose one of the following options:

● Replace: Allows you to use this playing technique instead of the default playing 
technique defined for this combination of notehead and staff position.

● Add: Allows you to add this playing technique on top of the default playing technique 
defined for this combination of notehead and staff position.

8. Choose any articulations and the tremolo stroke that you want from the available options.

9. Click OK to save your changes and close the dialog.

RESULT
The behavior of the selected playing technique in playback is changed.

RELATED LINKS
Percussion Instrument Playing Techniques dialog on page 985
Creating new playing technique-specific noteheads for unpitched percussion instruments on 
page 989
Playing Technique Combinations dialog on page 499

Playback techniques
Playback techniques link together the notations you input into your music and techniques/
articulations in sound libraries in order to produce the correct sounds in playback. They are used 
by expression and percussion maps to trigger the appropriate commands, such as key switches 
or control changes.

When you input notations, such as playing techniques, tremolos, jazz articulations, or 
articulations, the corresponding expression maps look for the appropriate playback techniques. 
For example, inputting pizz. playing techniques causes expression maps to use the Pizzicato 
playback technique to switch to the pizzicato sound for playback. If the expression map cannot 
locate the sound, the playback technique applied either remains the same as the previous 
playback technique or reverts to the natural playback technique.

Custom playing techniques that use playback techniques which do not already exist in 
expression maps do not play back automatically. In order for them to play back appropriately, 
you must add them to the expression maps for each instrument for which you want to use them. 
You must also assign an action for each custom playing technique that determines how the 
switch that triggers the technique is controlled.

You can map playback techniques as required for different sound libraries in the Expression 
Maps dialog, including creating new combinations of existing playback techniques, such as 
Legato and Tremolo, which allows them to be used simultaneously.
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You can see which playback techniques are in use at any particular rhythmic position in the 
playing techniques lane for the corresponding instrument track.

TIP

● If you have input a playing technique but cannot hear a change in the sound, you might 
be using a combination of playback techniques that the expression map does not expect. 
For example, if you input a new playing technique without cancelling an existing playing 
technique, the expression map cannot process the two corresponding playback techniques 
together if the expression map does not have an entry for those two techniques combined.

To avoid playback technique clashes, you can add playback techniques that cannot be in use 
concurrently to the same mutual exclusion group in the corresponding expression maps. 
Alternatively, you can create a combination of those playback techniques in order to use 
them simultaneously.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques, tremolos, jazz articulations, or articulations in different voices 
simultaneously.

RELATED LINKS
Expression maps on page 488
Expression Maps dialog on page 489
Playing Technique Combinations dialog on page 499
Enabling independent voice playback on page 460
Creating new expression maps on page 502
Adding/Editing mutual exclusion groups in expression maps on page 504
Playing techniques lanes on page 445
Playing techniques on page 813
Tremolos on page 963
Jazz articulations on page 786
Articulations on page 547

Edit Playback Techniques dialog
The Edit Playback Techniques dialog allows you to define new playback techniques and edit 
existing ones. Playback techniques are used by expression maps to assign the correct sounds to 
the required notations in the music, such as playing techniques, tremolos, jazz articulations, and 
articulations.

● You can open the Edit Playback Techniques dialog in Play mode by choosing Play > 
Playback Techniques.
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The Edit Playback Techniques dialog contains the following sections and options:

1 Category menu

Allows you to filter the list of playback techniques by selecting a category from the menu, 
such as Techniques or Dynamics.

2 Playback techniques list

Contains all the playback techniques in the project within the currently selected category.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank playback technique.

● New from Selection : Creates a copy of an existing playback technique that you can 
edit separately from the original.

● Save as Default : Saves the selected playback technique to your user library, allowing 
you to use it in multiple projects. Appears as  for playback techniques saved as default.

● Revert to Factory : Removes all your changes to the selected playback technique, 
returning it to its saved settings.

● Delete : Deletes the selected playback technique.

NOTE

You cannot delete predefined playing techniques or any playing technique that is 
currently used in your project.

3 Name

Allows you to edit or enter the name of the playback technique. This is the name shown in 
lists in the Edit Playing Techniques, Expression Maps, Playing Technique Combinations, 
and Percussion Maps dialogs.

4 Playback options

● Alias for: Allows you to select another playback technique whose sound mapping you 
want to apply to the selected playback technique as well.

● Group: Sets the group in which this playback technique appears.

Play mode
Playback techniques 

514
Dorico SE 3.5.12



● Fallback: Allows you to specify another playback technique that can be used if the 
present one is not available.

● Articulation type: Sets the duration over which the playback technique takes effect. 
Attribute applies only to the note at the rhythmic position where the playing technique 
is found, such as a staccato articulation, while Direction applies to all following notes 
until it is replaced by another playing technique, such as pizzicato.

RELATED LINKS
Expression Maps dialog on page 489
Playing Technique Combinations dialog on page 499
Adding/Editing mutual exclusion groups in expression maps on page 504

Played vs. notated note durations
You can show notes in the piano roll editor in Play mode with their played duration or notated 
duration.

Played duration

When Played Durations in the Play toolbox is selected, note events in the piano roll editor are 
each shown with two components:

● A filled, light-colored rectangle showing the played duration of the note.

● A thin, darker rod showing the notated duration of the note.

For example, notes with staccato articulations are played for less time than their notated 
duration, whereas notes under slurs are played for longer than their notated duration.

By default in Dorico SE, notes in the piano roll editor in Play mode are shown with their played 
duration.

NOTE

Editing the played duration of notes causes them to appear in a darker color in the piano roll 
editor to notes whose played duration you have not changed.

Notated duration

You can select Notated Durations in the Play toolbox to see note events as single rectangles, 
which span the full width that corresponds to the notated duration of the note.

You can change the notated duration of notes in the piano roll editor when Notated Durations 
is selected.

EXAMPLE
The following examples all contain the same musical phrase, shown in different ways.

Played duration Notated duration Score
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RELATED LINKS
Slurs in playback on page 900

Changing the played duration of notes
You can change the played duration of notes individually, both at the start and end of notes. For 
example, you can make notes sound for longer or start sounding later.

PREREQUISITE

● Played Durations is selected in the Play toolbox.

● Object Selection is selected in the Play toolbox.

PROCEDURE

1. In the piano roll editor, select the notes whose played duration you want to change.

2. Click and drag the end of one of the notes to the right/left.

Your mouse pointer becomes a two-way arrow when you are in the correct position.

3. Optional: Repeat step 2 for the start of the notes.

RESULT
The played duration of the selected notes is changed.

RELATED LINKS
Play toolbox on page 413

Resetting playback overrides
You can remove all changes made to how individual notes play back, for example, if you 
previously changed the played duration of notes and want to revert them to their default start 
position, length, and velocity.

Removing playback overrides also removes any offsets to the start and end position of notes 
imported from MIDI files with preserved note positions.

NOTE

Any note velocities that are set on notes are reflected in playback, for example, from imported 
MIDI files or MIDI recording. If you want dynamics you input in Write mode to be reflected in 
playback instead, you must remove playback overrides.

PROCEDURE

1. In the piano roll editor or drum editor, select the notes whose playback overrides you want 
to reset.

2. Choose Play > Reset Playback Overrides.

RESULT
All playback overrides are removed from the selected notes.

NOTE

The played duration of the selected notes initially appears to revert to match their notated 
duration. However, starting playback or switching modes refreshes their appearance to their 
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default played duration. For example, if the notes are staccato, their played duration is half their 
notated duration by default.

RELATED LINKS
Velocity lanes on page 437
MIDI recording on page 204
Importing MIDI on page 65
MIDI Import Options dialog on page 66
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Print mode

Print mode allows you to print your layouts or to export them as graphics files, such as PDF and 
SVG.

● When printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing.

● When exporting layouts, you can specify different graphics file types and the information 
you want to include in their exported file names.

Project window in Print mode
The project window in Print mode contains the default toolbar and the print preview area as well 
as panels and sections that provide all the tools and functions that allow you to prepare printing 
or exporting your layouts.

You can switch to Print mode in any of the following ways:

● Press Ctrl/Cmd-5 .

● Click Print in the toolbar.

● Choose Window > Print.

Panels and sections in Print mode

The following panels and sections are available in Print mode:

1 Layouts panel
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Shows a list of all layouts in your project and allows you to select what to print or export.

NOTE

The layout selector in the toolbar is disabled in Print mode. If you want to see a different 
layout in the print preview area, select it in the Layouts panel.

2 Print Options panel

Contains options for printing or exporting your layouts.

3 System Dialogs (macOS only)

Contains macOS-specific printing options.

4 View options

Allows you to change the print preview area to show pages in one of the following views:

● Page Width: The page fills the width of the print preview area, which might not show 
the whole page depending on the orientation and format of the page.

● Whole Page: Shows the whole page in the print preview area.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

RELATED LINKS
Project window on page 23
Print Options panel on page 520
Toolbar on page 24
Print preview area on page 30
Key Commands page in the Preferences dialog on page 47

Layouts panel (Print mode)
In Print mode, the Layouts panel shows a list of all layouts in your project and allows you to 
select layouts to print or export. It is located on the left of the window.

You can hide/show the Layouts panel in Print mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Panel.
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The Layouts panel contains all the layouts in your project, displayed as cards. Each layout card 
shows the following:

1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico SE automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation

Shows the size and orientation of the layout as set on the Page Setup page in Setup > 
Layout Options.

5 Layout length

Shows the number of pages in the layout. You can use this in combination with its page size 
and orientation to determine the best job type for printing/exporting.

TIP

A layout with two pages might best be printed as 2-up, while a layout with five pages might 
best be printed as spreads with the final page printed on a different paper size. A layout with 
12 pages might best be printed as a booklet.

The selected layouts are printed/exported when you click Print or Export. If you have selected 
some layouts set to print and some set to export graphics, the button reads Print and Export.

RELATED LINKS
Project window in Print mode on page 518
Page arrangements for printing/exporting on page 530
Booklet printing on page 532

Print Options panel
The Print Options panel contains options for printing or exporting your layouts. It is located on 
the right of the window in Print mode.

You can hide/show the Print Options panel in any of the following ways:
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● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Panel.

All the options that you set in the Print Options panel are saved with your project. The options 
are divided into the following sections:

Destination
Allows you to select a physical printer for printing or a file location for exporting a 
graphics file. If you print your work, you can choose how many copies you want to 
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print. If you choose to export a graphics file, you can specify the format, color mode, 
image resolution, file name, and directory of the saved file.

Depending on the destination type selected, the button at the bottom of the panel 
reads either Print or Export. If you have selected some layouts set to print and some 
set to export graphics, the button reads Print and Export.

Job Type
Allows you to choose the range of pages to be printed or exported and how they are 
arranged.

Page Setup
Allows you to set the paper size and orientation. You can specify the scale factor of the 
image to be printed or exported.

Duplex Printing
Allows you to specify whether to print on one or on both sides of each sheet of paper. 
This option is only available if you select Printer in the Destination section.

Annotations
Allows you to activate options that are often required by publishing houses or printing 
agencies, such as crop marks or a border around the printed image.

Print button
Allows you to print/export selected layouts according to the settings you have set in 
the Print Options panel.

Depending on your selection, the print button can appear in one of the following ways:

● Print

● Export

● Print and Export

For example, if you selected layouts that are all set to print, Print is shown. If you 
selected some layouts set to export graphics and some layouts set to print, Print and 
Export is shown.

RELATED LINKS
Project window in Print mode on page 518
Exporting layouts as graphics files on page 525
Printers on page 530
Duplex printing on page 532
Page arrangements for printing/exporting on page 530
Page sizes and paper sizes on page 533
Graphics file formats on page 535
Annotations on page 537

Printing layouts
You can print layouts individually or multiple layouts together. You can specify print settings for 
each layout independently, for example, you can select different printers for different layouts in 
the same project.

Dorico SE uses settings for layouts to create automatic print settings, so you might find that 
many print options are already appropriate for the layouts you want to print. For example, if you 
are connected to a printer that can print A3 paper and the page size of your full score layout is 
set to A3 in Layout Options, Dorico SE automatically selects A3 in the Page Setup section of the 
Print Options panel.
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TIP

You can select individual layouts and set up their printing options without printing straight away. 
Once you have set up the printing options you want for different layouts, you can then select all 
the layouts you want to print and click Print. Your existing print settings are applied, even if your 
selection contains layouts with different print settings.

For example, you can set your full score layout to print 3 booklet copies and the part layouts to 
print 1 2-up copy each. You can then select all layouts to print them together and the previously 
set values are followed.

PROCEDURE

1. In the Layouts panel, select the layouts that you want to print.

NOTE

The layout selector in the toolbar is disabled in Print mode. If you want to see a different 
layout in the print preview area, select it in the Layouts panel.

2. In the Print Options panel, enter the number of copies you want into the Copies field in the 
Destination section.

NOTE

The Copies field appears blank when you have selected layouts with different values.

3. Activate/Deactivate Collate copies.

4. In the Destination section, choose Printer and select a printer from the menu.

5. In the Job Type section, select the page arrangement you want from the menu.

6. Optional: If you only want to print a specified range of pages, choose Page Range in the Job 
Type section.

7. Optional: If you selected Page Range, enter the pages you want into the value field.

● To specify a range, enter the first page and last page separated with a dash, such as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated with 
commas, such as 1,3,5-8.

8. In the Page Setup section, select a paper size from the menu.

9. Choose the paper orientation you want.

10. Optional: If you selected Spreads or 2-up for the job type, activate/deactivate Print odd final 
page on to specify the paper size on which you want to print final pages for layouts with odd 
numbers of pages.

11. Select a paper size and paper orientation for the odd final page.

12. Choose one of the following size options:

● Fit to Paper

● Custom Scale

13. Optional: If you selected Custom Scale, enter the scale factor you want into the Scale factor 
field.

14. In the Duplex Printing section, select one of the printing options from the Print on menu.

15. Optional: If you selected a duplex printing option, use the bottom two menus to select how 
the printed image is flipped when printing on the reverse side of the paper.
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16. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

17. Click Print.

RESULT
The selected layouts are printed according to the print settings you have applied.

If your selection included part layouts set to concert pitch, Dorico SE shows a warning and 
offers to switch them all to transposed pitch before printing/exporting. You can also select which 
layouts you want to switch to transposed pitch or proceed anyway with no changes.

TIP

You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.

RELATED LINKS
Key Commands page in the Preferences dialog on page 47
Printers on page 530
Paper size and orientation setup on page 534
Export File Names dialog on page 528
Page arrangements for printing/exporting on page 530
Print Options panel on page 520
Duplex printing on page 532
Annotations on page 537
Changing the page size and/or orientation on page 368

Printing/Exporting a page range
By default, Dorico SE prints/exports all pages of the selected layouts. You can specify a specific 
page range to print/export.

NOTE

You can only print booklets using the complete range of pages. You cannot define any page 
ranges.

PROCEDURE

1. In the Layouts panel, select the layouts from which you want to print/export a range of 
pages.

2. Optional: In the Destination section, check the layouts are set to print/export using the 
printer/graphics file formats you want.

3. In the Job Type section, choose Page Range.

4. Enter the pages you want into the value field.

● To specify a range, enter the first page and last page separated with a dash, such as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated with 
commas, such as 1,3,5-8.

NOTE

Separate ranges are exported as separate files.
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5. Click Print/Export/Print and Export.

RESULT
The specified pages in the selected layouts are printed/exported. Exported files use the file name 
recipe set for their graphics file format in the Export File Names dialog.

RELATED LINKS
Export File Names dialog on page 528
Page arrangements for printing/exporting on page 530

Specifying printing options (macOS only)
Dorico SE allows you to access the standard printing options of your operating system.

NOTE

If you use the standard printing options of your operating system, the settings in the Print 
Options panel are ignored. macOS-specific print settings are not saved with your project. These 
must be set each time you want to print, whereas the Dorico SE print options are always saved 
with your project.

PROCEDURE

1. In the Layouts panel, click Page Setup in the OS X Dialogs section to open the macOS Page 
Setup dialog.

2. In the Page Setup dialog, set the paper size.

3. Click OK.

4. In the OS X Dialogs section, click Print to open the macOS Print.

5. In the Print dialog, set up the printing options you want.

Exporting layouts as graphics files
You can export layouts as a variety of graphics files, such as PDF or PNG.

TIP

You can export layouts with different image settings and export paths simultaneously.

PROCEDURE

1. In the Layouts panel, select the layouts you want to export.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Optional: Change the image settings for the selected layouts.

4. Optional: Change the export path for the selected layouts.

5. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

6. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.
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TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

7. Optional: If you only want to export a specified range of pages, choose Page Range in the 
Job Type section.

8. Optional: If you selected Page Range, enter the pages you want into the value field.

● To specify a range, enter the first page and last page separated with a dash, such as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated with 
commas, such as 1,3,5-8.

NOTE

Separate ranges are exported as separate files.

9. In the Page Setup section, choose the page orientation you want.

10. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

NOTE

Watermarks are only included in layouts exported as Color graphics.

11. Click Export.

RESULT
The selected layouts are exported as the selected graphics format using the file name recipe set 
for their graphics file format in the Export File Names dialog. They are saved in the folder set in 
the Destination folder field, or in the same folder as the project file if the set export path is no 
longer accessible.

If your selection included part layouts set to concert pitch, Dorico SE shows a warning and 
offers to switch them all to transposed pitch before printing/exporting. You can also select which 
layouts you want to switch to transposed pitch or proceed anyway with no changes.

TIP

You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.

RELATED LINKS
Printing/Exporting a page range on page 524
Changing the page size and/or orientation on page 368
Export File Names dialog on page 528
Annotations on page 537
Graphics file formats on page 535
Image resolution on page 536
Monochrome and color graphics processing on page 536
Embedding of fonts in PDF and SVG files on page 537
Key Commands page in the Preferences dialog on page 47
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Changing the image settings for layouts
You can change the graphics file format, color mode, and image resolution of layouts 
individually, for example, if you want to export some layouts as PDF files but others as PNG 
files.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Select a graphics file format from the menu.

4. Optional: If you selected PNG or TIFF, select a resolution from the Resolution menu.

TIP

The Resolution setting does not affect PDF and SVG files as they are vector formats.

5. Choose a color mode.

● Mono exports the graphic in black and white.

● Color exports the graphic in full color.

NOTE

● When exporting graphics files with a resolution of 72 dpi, we recommend that you select 
Color. If you select Mono, staff lines can disappear.

● If you want to export layouts with watermarks, you must choose Color.

RESULT
The image settings for the selected layouts are changed. This also changes the file name recipe 
used for the corresponding layouts when you export them.

RELATED LINKS
Graphics file formats on page 535
Image resolution on page 536
Monochrome and color graphics processing on page 536
Embedding of fonts in PDF and SVG files on page 537

Changing the export path for layouts
You can specify an export path to any folder to which you want to export layouts as 
graphics files. You can specify a different export path for each layout and still export them all 
simultaneously.

By default, Dorico SE exports graphics files into the same folder as your project file. If you have 
not saved your project yet, graphics files are saved in your Dorico Projects folder.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Destination section of the Print Options panel, click Choose Folder  beside the 
Destination folder field to open the File Explorer/macOS Finder.

3. Locate and select the destination folder you want.
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4. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination 
folder field.

5. Optional: Repeat steps 1 to 4 for other layouts whose export path you want to change.

6. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

7. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

RESULT
The export path for the selected layouts is changed. When exported, the layouts use the file 
name recipe set for their graphics file format in the Export File Names dialog.

NOTE

If the export path specified is no longer accessible, such as if you receive a project from someone 
who uses a different operating system, Dorico SE automatically updates the export path to the 
same location as the project file.

Export File Names dialog
The Export File Names dialog allows you to determine the contents of file names for each 
graphics file format independently. You can use universal ingredients that update to show the 
correct information for each layout automatically, and you can enter text that is the same for all 
layouts.

You can open the Export File Names dialog in any of the following ways:

● Click File Name Options in the Destination section of the Print Options panel in Print mode 
when the currently selected layout is set to Graphics.

● Click Edit in the Exporting Files subsection of the General page in Preferences.

NOTE

Your settings are linked between both ways of accessing the dialog and are saved as the default 
for all future projects.
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The Export File Names dialog contains the following options:

1 File names for

Allows you to select different graphics file formats. You can set different file name recipes for 
each graphics file format.

2 Preview

Displays an example file name based on the current recipe. The layout used for the preview 
is the one shown in the layout selector in the toolbar.

For example, the preview for a full score PDF file name using the default recipe might be 
01 - Full score - Lieder.pdf.

3 File name recipe

Displays the recipe for the selected graphics file format. You can enter text directly into this 
field, and click ingredients to add them automatically.

For example, the default PDF file name recipe is $n - $l - $t.

4 Reset to Default

Resets the file name recipe to the default for the selected graphics file format.

5 Copy to All

Copies the file name recipe to all layouts in the project.

6 File name ingredients

Allow you to add ingredients to the file name recipe quickly that are automatically populated 
as appropriate for each layout. For example, the ingredient $l becomes Piano when used to 
export a piano part layout.

The buttons for each ingredient display both the information to which the ingredient refers 
and the characters for it.

When you click file name ingredients, they are added to the end of the file name recipe. They 
are automatically separated from the previous ingredient using the default separator.
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NOTE

The page number ingredient is not available for the PDF file name recipe as it is a multi-page 
format.

7 Default separator

Allows you to set the characters used to separate ingredients in the file name recipe by 
default.

RELATED LINKS
Exporting layouts as graphics files on page 525

Printers
You can print layouts from Dorico SE projects to any printer to which your computer is 
connected.

You can select different printers for each layout in your project. This allows you to send layouts 
to the most appropriate printer for their requirements. You can select a printer when Printer is 
chosen in the Destination section of the Print Options panel.

Dorico SE uses the same printer as designated by the operating system by default, unless you 
specify another printer. In this case, the settings in the following sections in the Print Options 
panel can change:

● In the Page Setup section, the list of available paper sizes lists only paper sizes that the 
chosen printer provides.

● In the Duplex Printing section, the option for automatic duplex printing is only available if 
the chosen printer has this function.

NOTE

The printer menu in the Destination section only shows the name of a printer if all currently 
selected layouts are set to print to the same printer. If you select a new printer from the menu, 
all selected layouts are set to print to that printer.

RELATED LINKS
Print Options panel on page 520
Printing layouts on page 522

Page arrangements for printing/exporting
Dorico SE provides several page arrangements that you can use for printing/exporting your 
layouts.

In the Job Type section of the Print Options panel, you can specify how you want the layouts to 
be printed/exported. You can select the following job types from the Job Type menu:

Normal
Prints one page on each sheet of paper. This produces single-sided pages, for example, 
for instrumental parts that do not have regular page turns and must be bound in a 
continuous line.
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Spreads
Prints two pages on each sheet of paper, with odd-numbered pages on the right-hand 
side and even-numbered pages on the left-hand side.

You can also specify a paper size on which to print odd final pages, for example, if you 
are printing a layout containing five pages.

2-up
Prints two pages on each sheet of paper. The first page in the range is printed on the 
left-hand side of the first sheet of paper. This can be useful for printing instrument 
parts as it reduces the number of edges that must be bound, because pages can also 
be folded in half.

You can also specify a paper size on which to print odd final pages, for example, if you 
are printing a layout containing five pages.

Booklet
Prints two pages on each sheet of paper according to imposition requirements. This 
means that if the paper is folded, the pages are laid out like a book. This can be 
useful for scores and choir parts in particular as they often contain more pages than 
instrumental parts.

NOTE

You can only print booklets using the complete range of pages. You cannot define any 
page ranges.

NOTE

● Depending on the job type that you choose, Dorico SE switches the page orientation 
automatically. The changed orientation is immediately displayed in the music area. If this 
is not what you want, you can override the orientation in the Page Setup section.

● All of the job types allow printing either onto a single side of each sheet of paper or on both 
sides of the paper.

● It is usual to print booklets, spreads, and 2-up onto paper in landscape orientation. Printing 
one page to each sheet typically uses portrait orientation, unless the layout itself uses 
landscape orientation.

Also in the Job Type section, you can choose which pages you want to print/export.

All Pages
Allows you to print/export all pages of the selected layouts.

Page Range
Allows you to set a range of pages to be printed. Choosing Page Range makes the 
value field available.

● To specify a range, enter the first page and last page separated with a dash, such 
as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated 
with commas, such as 1,3,5-8.

RELATED LINKS
Paper size and orientation setup on page 534
Printing/Exporting a page range on page 524
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Booklet printing
Booklets are documents printed on both sides of the paper and folded to resemble the pages in 
a book. When printed as a booklet, pages are reordered so that you can fold the printed pages 
and read the content in the same order as they were in the project.

Printing layouts as a booklet can be much quicker than printing pages single-sided or double-
sided. For example, if your full score is twenty pages long and you print it on both sides 
automatically, you must then bind one edge of the printed pages in order to keep them together. 
However, if you print the full score as a booklet, you can simply fold the printed pages in the 
middle.

Booklet printing settings reorder pages so that they appear in the correct order on the printed 
page. For example, a layout containing four pages printed as a booklet is laid out as follows:

● First side: page four on the left, page one on the right

● Reverse side: page two on the left, page three on the right

If the layout you are printing as a booklet contains an odd number of pages, Dorico SE 
automatically places any empty last pages at the end of the booklet. This follows the convention 
of showing odd-numbered pages on the right. For example, if you print a layout containing six 
pages as a booklet, a total of eight pages are printed with the last two pages in the booklet left 
blank. If you want the empty pages to be positioned differently, you can add extra pages to the 
layout, for example, a title page.

NOTE

● You can only print booklets using the complete range of pages. You cannot define any page 
ranges.

● If the order of inward pages is incorrect when you are printing booklets using manual 
duplexing, you can activate Reverse order of outward pages in the Duplex Printing section 
of the Print Options panel, which instructs Dorico SE to output the first set of pages in the 
opposite order.

RELATED LINKS
Printing layouts on page 522
Duplex printing on page 532

Duplex printing
Dorico SE allows duplex printing, which means that you can print on both sides of each sheet of 
paper.

If your printer supports automatic duplex printing, you can use this function in Dorico SE. If your 
printer can only print on one side of each sheet of paper, there is a manual duplex printing 
option.

The Print on menu in the Duplex Printing section of the Print Options panel contains the 
following options:

One side only
Prints on one side of each sheet of paper.

Both sides manually
Prints on both sides of each sheet of paper. Use this option if you printer lacks an 
automatic duplex printing function. After all outward pages have been sent to the 
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printer, a message box informs you to turn over the stack of printed pages and put 
them back into the printer. Click OK to continue printing the inward pages.

Both sides automatically
Prints on both sides of each sheet of paper automatically. This option is only available if 
your printer supports this type of printing.

The other menus in the Duplex Printing section allow you to set how the printed image is 
flipped when printing on the reverse side of the paper.

Flip image (portrait)

Determines how the image is flipped for reverse side printing in portrait orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Flip image (landscape)

Determines how the image is flipped for reverse side printing in landscape orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Reverse order of outward pages at the bottom of the section instructs Dorico SE, when 
activated, to output the first set of pages in the opposite order when printing booklets using 
manual duplexing. This is necessary for some printers so that you do not have to reverse sort the 
pages manually before returning them to the printer to print the other sides.

RELATED LINKS
Printing layouts on page 522

Page sizes and paper sizes
In Dorico SE, page sizes and paper sizes use different settings. This means that you can print 
layouts with any page size onto paper with a different paper size.

For each layout in your project, you can define a page size on the Page Setup page in Setup > 
Layout Options. This means that you define the dimensions of the layout. For printing your 
layout, you must usually choose a paper size that is provided by the printer that you are using.

Normally, the layout's page size and the printed paper size match. However, if you define a 
layout with an unusual page size that is not supported by your printer, such as 10" x 13", one of 
the standard page sizes for instrumental parts, you may have to print the layout onto a different 
paper size. You can change the paper size in the Page Setup section of the Print Options panel 
according to your needs. As long as your printer supports sufficiently large paper for your page 
size settings, and they match a standard paper size, your dimensions are included in the menu. 
Changing the paper size has no effect on your layout's page size, and does not, therefore, affect 
the way the music is laid out.
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If you do not select a specific paper size, Dorico SE automatically chooses a paper size that is 
based on your computer's locale settings. For example, if these are set to a European country, 
an international ISO standard might be used, such as A4. If they are set to a North American 
country, one of their typical standards might be used, such as US Letter.

If you have defined a page size for your layout that is larger than a typical standard, Dorico SE 
automatically chooses the next larger paper size, provided that your printer supports this. For 
example, if the layout's page size is larger than A4/US Letter, A3/Tabloid is used.

If you print to a different paper size than the layout's page size, Dorico SE automatically scales 
the image to fit the paper. You can change this setting by specifying a custom scale factor in the 
Page Setup section.

Paper orientation
Paper orientation is the direction of rectangular paper for viewing and printing. Paper can have 
either landscape or portrait orientation.

Instrumental parts are most often printed using portrait orientation, as this allows two or three 
pages to be spread out at a time on most music stands.

Full scores for conductors are also commonly printed using portrait orientation, as this allows 
more staves to fit on the page than with landscape orientation. However, full scores for small 
ensembles might use landscape orientation as fewer staves have to fit on the page. Having more 
horizontal room on the page allows more bars to fit on each page, reducing the number of page 
turns required.

In Dorico SE, you can set the orientation of pages independently of the paper orientation, for 
example, you can print portrait pages on landscape paper. You can also separately set the paper 
orientation of the odd final page in layouts using the Spreads and 2-up page arrangements.

RELATED LINKS
Changing the page size and/or orientation on page 368

Paper size and orientation setup
Layouts can have different paper sizes and orientation settings.

NOTE

If you have selected Graphics in the Destination section of the Print Options panel, you can only 
change the paper orientation. No other options are available.

The Page Setup section of the Print Options panel contains the following options when you have 
chosen Printer in the Destination section:

Paper size
Allows you to select one of the available paper sizes from the menu. The paper sizes 
available depend on the capabilities of the selected printer.

Paper orientation
You can choose one of the following paper orientation options:

● Portrait 

● Landscape 
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Print odd final page on
For Spreads and 2-up job types only: If this is activated, you can select a different 
paper size or orientation for the odd final page.

This setting is useful when printing layouts with an odd number of pages on A3 paper 
in landscape orientation. For example, if your layout contains five pages, the first four 
pages fit onto two sheets of A3, while the fifth page would occupy only the left-hand 
side of a third sheet of A3. This setting allows you to print the odd final page on A4 
paper in portrait orientation instead.

Fit to Paper
The whole page is scaled to fit the paper size selected. For example, if you select a 
layout with a page size of A4 and select a paper size of A3, pages in the layout are 
enlarged to fit the larger paper size.

Custom Scale
The page is scaled to the set percentage of its original size. For example, if you are 
printing a layout with a page size of A3, select a paper size of A4, and set Custom Scale 
to 100, the original page remains at its original size, exceeding the boundaries of the 
A4 paper.

RELATED LINKS
Page arrangements for printing/exporting on page 530
Changing the page size and/or orientation on page 368

Graphics file formats
Dorico SE supports multiple graphics file formats as which you can export your layouts.

PDF
Stands for Portable Document Format. Exporting layouts to PDF allows you to create 
a platform-independent document that contains a fixed version of each layout, for 
example, to send to someone who does not have access to Dorico SE.

PNG
Stands for Portable Network Graphics. PNG files are losslessly compressed, meaning 
they produce high-quality images.

SVG
Stands for Scalable Vector Graphics. Because SVG is an XML-based text format, it can 
be scaled to any size without any loss of quality. Dorico SE renders SVG graphics using 
drawing instructions rather than rasterizing them, resulting in better resolutions and 
smaller file sizes.

TIFF
Stands for Tagged Image File Format. TIFF files are not compressed, which means their 
file sizes can be larger than other formats and the quality of the image is not reduced.

RELATED LINKS
Exporting layouts as graphics files on page 525
Monochrome and color graphics processing on page 536
Embedding of fonts in PDF and SVG files on page 537
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Image resolution
Image resolution refers to the number of pixels contained in an image. The larger the number of 
pixels, the sharper and clearer the image appears.

In Dorico SE, you can export PNG and TIFF files with different image resolutions. The image 
resolution is measured in dots per inch, or “dpi”.

● 72

● 150

● 300

● 600

● 1200

NOTE

A resolution of 72 dpi is suitable for display on screen so that you can embed the graphic in an 
e-mail or on a web page. If you choose 300, 600, or 1200 dpi, a high-resolution image is saved 
that you can include as an illustration in a word processing or desktop publishing document.

RELATED LINKS
Exporting layouts as graphics files on page 525

Monochrome and color graphics processing
Dorico SE applies different settings when you export monochrome and color graphics. The most 
appropriate setting depends on your intended purpose for the graphics.

Most musical scores are monochrome, meaning they use only black ink and are normally 
printed on white/near-white paper. Some educational books occasionally use colors to highlight 
particular notations, for example, to identify clefs, or to color notes according to their pitch. If 
you export graphics files and print them with your own printer, you can leave Color selected in 
the Destination section.

However, if you export graphics files in PDF format for direct printing on a platesetter or for 
further production work in a page layout program, select Mono, unless your layout actually 
contains colored elements. If you select Mono, Dorico SE uses a different color space for the 
resulting PDF, ensuring that the printed image only uses black ink. If you choose Color, then 
the black items in your layout are exported as rich black, that is, black produced by combining 
multiple colored inks. This can cause problems in production when making color separations at 
the pre-press stage.

Dorico SE specifies colors using the RGB color model, rather than the CMYK color model that 
is used by platesetters and other professional printing machines. If you have colored objects in 
your layouts and your layouts are printed professionally, you must post-process the graphics files 
that are exported from Dorico SE in another graphics application to convert the colors from RGB 
to CMYK.
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Embedding of fonts in PDF and SVG files
How fonts are handled in PDF and SVG files mainly depends on the fonts that you use in the 
project.

PDF Files
The music and text fonts, and their sub-sets, that are supplied with Dorico SE are 
embedded in PDF files during the export. If you open the PDF files on a different 
computer, they look the same, even if that computer does not have the fonts installed 
that are used in the document. If you use different fonts, make sure that these permit 
embedding.

SVG Files
SVG (Scalable Vector Graphics) files do not embed fonts directly. Some font characters, 
such as note heads, articulations, and accidentals, are converted into outlines, so that 
they do not depend on the font from which they are taken. Other font characters, such 
as time signature and tuplet digits, are only encoded using references to the font from 
which they are taken. The latter also applies to regular text, such as staff labels, tempo 
instructions, and dynamics. This means that the SVG file looks incorrect if rendered by 
a web browser on a computer that does not have the fonts installed. The appearance 
of SVG files depends on the browser or the rendering software, and on the fonts that 
are installed on the computer.

To ensure that the SVG file appears correctly if embedded in a web page, you can open 
the SVG file in an illustration program and convert all font characters to outline paths, 
then re-export the SVG file and embed that file. Alternatively, you can use web fonts to 
ensure that the necessary fonts are available on the web server.

SVG graphics that are exported from Dorico SE conform to the SVG Tiny 1.1 
specification, which defines a subset of features in the full SVG specification.

For information about using web fonts with SVG, refer to the Help Center on the 
Steinberg website.

RELATED LINKS
Exporting layouts as graphics files on page 525
Graphics file formats on page 535
Image resolution on page 536
Monochrome and color graphics processing on page 536

Annotations
Annotations provide additional information for printed or exported documents, such as the 
date and time it was printed. Publishers and printing agencies can use these to identify and 
register printed images correctly or to embed exported graphics files into a desktop publishing 
application.

When printing/exporting your layouts for publication, you can include typical annotations. You 
can also allow Dorico SE to print or export any view options that you have activated in your 
project.

NOTE

Crop marks and the border can only be printed if the page size is smaller than the paper size.

The Annotations section of the Print Options panel contains the following options:

Print mode
Annotations 
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Crop marks
Adds short vertical and horizontal lines at each of the four corners of the page.

Border
Adds an outline around the edge of the page dimensions.

Date and time
Adds the date and time of printing at the bottom of each page.

Watermark
Adds large translucent text across the middle of each page. This is useful for indicating 
that this version is a draft, proof, or perusal score.

In the Watermark field at the bottom of the section, you can enter the text that you 
want to show on each page.

TIP

Watermarks are only included in layouts exported as Color graphics.

View options
Adds all active view options, such as signposts, comments, and note and rest colors, to 
the printout or exported graphic.

RELATED LINKS
Signposts on page 349
Comments on page 356
Printing layouts on page 522
Exporting layouts as graphics files on page 525
Hiding non-printing elements on page 345

Print mode
Annotations 
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Notation reference



Introduction

This notation reference contains information about the accepted conventions for presenting 
different notations and how to change their appearance and placement in Dorico SE, both for 
individual items and by changing default settings.

It also contains instructions for inputting more complex notations, such as cross-staff glissando 
lines, which are described in the corresponding chapter.

Tasks in the notation reference outline the default per-layout changes you can make in Setup > 
Layout Options, such as changing the frequency of bar numbers, and the individual changes 
you can make to items, which often involve using properties in the Properties panel.

More detailed default options, such as how notes should be beamed in different meters or 
spacing gaps between different items, are available in Dorico Pro.

You can find basic input methods for notations in the Write mode chapter.

RELATED LINKS
Write mode on page 143
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Accidentals

Accidentals are shown beside notes to indicate their pitch, both when notated on a staff and 
written out in text. In music based in Western tonality, they usually show that the pitch of a note 
has been altered so that it does not conform to the current prevailing key signature.

In Dorico SE, each note has its own fixed pitch that is independent of the prevailing key 
signature, and accidentals are automatically hidden and shown as appropriate. For example, 
if you input F♮s and then add a D major key signature before them, they do not turn into F♯s; they 
remain F♮s and show natural accidentals. However, if you input the D major key signature first, 
any Fs you then input without stating an accidental are input as F♯s.

There are different conventions for accidental duration rules, such as not repeating the same 
accidental on subsequent notes of the same pitch in the same bar. In music that has no key 
signatures, some or all notes might require accidentals, depending on the notation convention in 
use.

RELATED LINKS
Accidental duration rules on page 545
Inputting notes on page 161
Inputting accidentals on page 185

Deleting accidentals
You can delete accidentals according to their type and you can delete all accidentals from a 
selection of notes with different accidentals at the same time. This changes the pitch of the 
selected notes.

NOTE

These steps do not apply to cautionary accidentals, such as those shown on natural notes that 
follow the same notes with an accidental but in a different octave. In Dorico SE, you can only 
hide, show, or parenthesize cautionary accidentals individually.

PROCEDURE

1. In Write mode, select the notes whose accidentals you want to delete.

2. Delete accidentals in any of the following ways:

● Press 0  to delete naturals.

● Press -  to delete flats.

● Press =  to delete sharps.

● Click the button of the accidental in the Notes panel.

RESULT
The corresponding accidentals are deleted from the selected notes. This changes their pitch. For 
example, deleting the sharp from a G♯ turns it into G♮.
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NOTE

● Deleting accidentals causes accidentals to appear on any subsequent notes of the same 
pitch in the same bar. You can check the pitch of notes by selecting them and looking in the 
status bar.

● To delete accidentals from a selection of notes with different accidentals, we recommend 
that you revert them all to natural by pressing 0  or clicking Natural in the Notes panel. 
This is because re-inputting an accidental over a selection of notes with different accidentals 
adds that accidental to every note in the selection. For example, two G♯s followed by two G♭s 
become four G♯s if you re-input a sharp. If you click Sharp or press =  twice, all accidentals 
are deleted.

RELATED LINKS
Inputting accidentals on page 185
Changing the pitch of individual notes on page 199
Status bar on page 32

Hiding/Showing or parenthesizing accidentals
You can hide/show individual accidentals, or show them in round or square brackets, including 
cautionary accidentals shown by default. You can do this for the current layout and frame chain 
only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose accidentals you want to hide/show or parenthesize.

2. In the Properties panel, activate Accidental in the Notes and Rests group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

● Square brackets

RESULT
Accidentals on the selected notes are shown, hidden, or shown in round or square brackets. If 
the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● You can assign key commands for different accidental hiding, showing, and parenthesizing 
commands on the Key Commands page in Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on artificial harmonics shown using diamond 
noteheads, independently of the normal noteheads that indicate the stopped pitch.

Accidentals
Hiding/Showing or parenthesizing accidentals 
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RELATED LINKS
Preferences dialog on page 45
Hiding/Showing or parenthesizing harmonic accidentals on page 736
Deleting accidentals on page 541
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Stacking of accidentals
If multiple accidentals are required for a chord in a single voice, or for notes in multiple voices at 
the same rhythmic position, they are stacked to the left of the chord in columns.

For chords with multiple accidentals, accidentals are generally stacked as follows:

1. The highest accidental is inserted in the first column immediately to the left of the notes.

2. The lowest accidental is added to the same column, provided that it does not collide with the 
first accidental.

3. The remaining highest and lowest accidentals are alternated in successive columns located 
further left from the chord.

In Dorico SE, additional rules help to produce a stack of accidentals that uses as few columns as 
possible. The following list contains some of the rules that are applied:

● Columns closer to the notes contain more accidentals than columns further from the notes.

● Accidentals on notes that are an octave apart are stacked in the same column. This also 
applies to accidentals that are a sixth or more apart, depending on the combination of 
accidentals.

● Accidentals in the same column never collide. The minimum interval between accidentals 
that is required to prevent collisions depends on the types of accidentals.

● Accidentals that are a second apart are arranged in adjacent columns, with the higher 
accidental in the right-hand column.

These rules minimize the amount of extra space that is required between successive notes or 
chords and ensure that accidentals appear as close as possible to the noteheads to which they 
apply. At the same time, they produce a contour that resembles a C-curve on the left-hand side of 
the chord.

Accidental stacking rules for dense chords
Dorico SE uses special stacking calculations in dense chords with multiple accidentals to ensure 
legibility. Chords are considered dense when they have six or more accidentals within the span of 
an octave.

For dense chords, accidentals are stacked as follows:

1. The highest accidental is inserted in the first column to the left of the notes.

2. The next accidental on a note that is located at least a seventh below the highest note 
is stacked into the same column. This continues with the remaining notes until no more 
accidentals fit into the first column.

3. Steps 1 and 2 are repeated for the following columns until all accidentals are stacked.

4. The columns are grouped, interspersed, and re-stacked. This results in a stack with 
alternating accidentals, reminiscent of the way accidentals are arranged in a key signature.

Accidentals
Stacking of accidentals 
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NOTE

By default for dense chords, Dorico SE uses a lattice arrangement of accidentals rather than 
the usual zig-zag arrangement. In very dense chords, the lattice arrangement can be wider and 
require more columns.

Kerning of accidental columns
Dorico SE applies kerning to accidental columns to ensure that the columns to the left of a chord 
occupy as little horizontal space as possible.

In typography, kerning adjusts the space between individual characters to increase legibility. In 
Dorico SE, as well as in music engraving in general, kerning allows accidentals to interlock.

EXAMPLE
If a low note is followed by a high note with an accidental, the accidental can be tucked above the 
low note to prevent the note spacing from being distorted.

Similarly, in the case of multiple columns of accidentals on a chord, the overall width of the stack 
of accidentals is reduced if, for example, a flat in the second column is kerned underneath a 
sharp in the first column belonging to a note a third higher. This also reduces the need to distort 
note spacing to accommodate accidentals.

Altered unisons
Altered unisons occur when two or more notes of the same name in the same octave have 
different accidentals in the same chord, such as D♯ and D♭.
In Dorico SE, this is notated with a split stem by default. Split stems show the main body of a 
chord with a stem branch coming off the main stem that connects noteheads in altered unisons 
to the chord. This allows all notes to appear with their corresponding accidental directly beside 
them. A split stem is also known as a “cherry stalk” or a “tree”.

You can change individual altered unisons appear with a single stem, meaning noteheads appear 
directly beside each other, and the two accidentals are shown beside each other to the left of the 
chord.

NOTE

If a chord contains notes a second interval apart and one of those notes has an altered unison, it 
is always shown with a split stem, regardless of your setting. This is to ensure clarity in clusters.

EXAMPLE

A single stem altered unison A split stem altered unison

RELATED LINKS
Inputting chords on page 192

Accidentals
Altered unisons 
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Changing how altered unisons appear
You can change how individual altered unisons appear, including within chords containing other 
altered unisons. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the altered unison notes whose appearance you want to change.

2. In the Properties panel, activate Split stem in the Notes and Rests group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected altered unison notes are shown with split stems when the checkbox is activated, 
and with single stems when the checkbox is deactivated. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

Split stem applies to individual notes. You can have altered unisons appear differently within the 
same chord by setting their properties independently.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Microtonal accidentals
Microtonal accidentals indicate pitches beyond the standard accepted chromatic scale in Western 
tonality, such as a quarter sharp or quarter flat. Microtonal accidentals are only shown in Dorico 
SE if you open a project that already contains them. They are available for input only where the 
corresponding key signature and tonality system apply.

Accidental duration rules
Accidental duration rules determine how long accidentals apply, such as within a bar, at a 
different octave, or just for a single note. Dorico SE uses the common practice accidental 
duration rule.

Common practice

In common practice, an accidental affects all notes of the same pitch in the same octave within 
the same bar, unless it is cancelled by another accidental. If it is not cancelled, it is automatically 
cancelled in the following bar.

It is customary to show cautionary accidentals on subsequent notes in certain circumstances. For 
example, in the key of G major, an F♯ in a bar following an F♮ shows a cautionary sharp sign, 
even though the sharp is included in the key signature. Cautionary accidentals are also known as 
“courtesy accidentals”.

Accidentals
Microtonal accidentals 
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RELATED LINKS
Double accidental cancellation on page 546

Double accidental cancellation
There are two generally accepted practices for the cancellation of double accidentals, which are 
archaic and modern.

By default, Dorico SE uses modern cancellation. This means that if a double sharp is cancelled by 
a single sharp, or a double flat is cancelled by a single flat, then no natural sign is shown in front 
of the single sharp or single flat, as these accidentals are unambiguous.

Modern cancellation

RELATED LINKS
Accidental duration rules on page 545
Hiding/Showing or parenthesizing accidentals on page 542

Accidentals
Accidental duration rules 
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Articulations

Articulations are markings that are drawn above or below notes and chords. Articulations tell a 
performer how to attack a note or how long to play a note relative to its notated duration.

In Dorico SE, articulations are defined as something that alters the way a note is played, in a way 
that is consistent across all instruments. Because instructions like bowing directions, harmonics, 
or tonguing apply to different instrument groups, in Dorico SE such directions are defined as 
playing techniques.

Articulations are categorized into the following types:

Articulations of force
Indicate a stronger attack at the start of notes, and include articulations such as accent 
and marcato. Marcato is also sometimes known as a “strong accent”. Dorico SE shows 
these articulations at the start of a note or tie chain by default.

Articulations of duration
Indicate a shorter duration than notated, and include articulations such as 
staccatissimo, staccato, tenuto, and staccato-tenuto. Staccato-tenuto is also sometimes 
known as a “louré”. If a note includes ties, Dorico SE shows articulations of duration 
above the last note in the chain by default.

Articulations of stress
Indicate notes that should be emphasized or not emphasized where that contradicts 
the prevailing meter, using stressed and unstressed marks. Dorico SE shows these 
articulations at the start of a note or tie chain by default.

Dorico SE positions articulations automatically on the notehead or stem side of notes and chords, 
according to the musical context. A note or chord can display one of each type of articulation.

RELATED LINKS
Inputting articulations on page 209
Articulations in playback on page 551
Playback techniques on page 512

Copying articulations
Articulations are automatically included if you copy notes, but they cannot be copied and pasted 
independently of notes.

PROCEDURE

1. In Write mode, select the notes with articulations you want to copy.

2. Copy the notes in one of the following ways:

● Press R  to repeat the material directly after itself.

● Press Ctrl/Cmd-C , select the position where you want to copy the selected notes, then 
press Ctrl/Cmd-V .

● Alt/Opt -click the position where you want to copy the selected notes with articulations.
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AFTER COMPLETING THIS TASK
If you want the copied notes to have the same rhythm but different pitches, you can repitch the 
notes.

RELATED LINKS
Repitching notes without changing their rhythm on page 201

Changing articulations
You can change the articulations on notes after they have been input.

PROCEDURE

1. In Write mode, select the note whose articulation you want to change.

2. Change the articulation in any of the following ways:

● Press the key command of the articulation you want. For example, press ]  for staccato.

● Click the new articulation you want in the Notes panel.

RESULT
The new articulation is added. This replaces any existing articulation of the same type.

RELATED LINKS
Inputting articulations on page 209
Key commands for articulations on page 210

Deleting articulations
Individual articulation markings cannot be selected and deleted separately from their notehead 
in Write mode, so articulations must be deleted by selecting the note or notes to which they are 
attached, and deselecting the articulation.

PROCEDURE

1. In Write mode, select the notes whose articulations you want to delete.

2. Deselect the articulations in any of the following ways:

● Press the key commands of the articulations you want to delete.

● Click the articulations you want to delete in the Notes panel.

Positions of articulations
There are established conventions for the position and placement of articulations relative 
to notes, the staff, and staff lines, which ensure articulations are always clearly visible. For 
the smallest articulations, such as staccato marks, correct placement relative to staff lines in 
particular is vital.

Articulations are placed on the notehead side by default, with the following exceptions:

● In single-voice contexts, marcato is always placed above the staff, regardless of the stem 
direction of the note or chord on which it is used. In multiple-voice contexts, marcato can 
also be placed below the staff.

Articulations
Changing articulations 
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● If multiple voices are active, articulations are placed at the end of the stem side of a note 
or chord. This clarifies which articulations belong to the up-stemmed notes and which to the 
down-stemmed notes.

● If a note is placed on the middle staff line or on the space immediately on either side, 
articulations that are less than a space in height are centered in the next unoccupied space. 
This normally only applies to staccato and tenuto. If a note in the middle of the staff has a 
staccato-tenuto articulation, the component parts of the articulation are split up and placed 
in separate spaces.

● If an articulation cannot fit within a staff space, or if the note is placed high or low on the 
staff, the articulation is placed outside the staff.

● If a note or chord is tied and the tie is placed above or below the notehead, articulations that 
are placed on the notehead side of a note or chord are offset by an additional 1/4 space in 
order to avoid the end of the tie.

Articulations on the notehead side are always centered horizontally on the notehead. This 
also applies to articulations on the stem side, except if the only articulation is a staccato or 
staccatissimo. In this case, the articulation is centered on the stem.

RELATED LINKS
Changing the placement of articulations relative to notes on page 550
Changing the placement of articulations relative to slurs on page 551

Order of articulations
If there are multiple articulations on the same notes, their vertical position and proximity to 
noteheads/stems depends on their type.

Articulations are positioned in the following order:

1. Articulations of duration are positioned closest to notehead/stems.

2. Articulations of force are positioned outside articulations of duration.

3. Articulations of stress are positioned furthest from noteheads/stems.

Order of articulations in relation to slurs

Articulations of duration are positioned as follows:

● Inside slurs that start/end on a note or chord with an articulation.

● Inside the curvature of a slur.

● Inside tuplet brackets.

Articulations of force are positioned as follows:

● Outside slurs that start/end on a note or chord with an articulation, except if they can be 
positioned within the staff.

● Inside the curvature of a slur if they fit between the slur and the note or stem, to which they 
belong, without colliding.

● Outside tuplet brackets.

Articulations
Positions of articulations 
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Force and stress articulations outside the ends of the 
slur

Duration articulations inside the ends of the slur

Changing the positions of articulations on tie chains
You can change where in tie chains articulations appear individually. By default, articulations of 
force and stress are shown on the first note/chord in tie chains, while articulations of duration 
are shown on the last note/chord.

PROCEDURE

1. Select the tied notes/chords whose articulation position you want to change.

2. In the Articulations group of the Properties panel, activate Pos. in tie chain under the 
corresponding heading for the articulation whose position you want to change.

For example, activate Pos. in tie chain under the Articulations of force heading to change 
the position of accents.

3. Choose one of the following options:

● First note

● Last note

RESULT
The position of articulations in the selected tie chains is changed.

Changing the placement of articulations relative to notes
You can change whether individual articulations are placed on the notehead side or stem side of 
notes. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change.

2. In the Articulations group of the Properties panel, activate Placement under the 
corresponding heading for the articulations whose placement you want to change.

For example, activate Placement under the Articulations of force heading to change the 
placement of accents.

3. Select one of the following options from the menu:

● Notehead side

● Stem side

Articulations
Positions of articulations 

550
Dorico SE 3.5.12



RESULT
The articulation is placed on the selected side of the notes or chords. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain. If this 
creates a collision with other markings, such as playing techniques, Dorico SE automatically 
makes adjustments to make sure all markings are clear and legible.

Changing the placement of articulations relative to slurs
You can change whether individual articulations of duration are placed inside or outside slur 
endpoints. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

NOTE

These steps only apply to articulations of duration. They do not apply to articulations of force or 
stress.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change.

2. In the Properties panel, activate Inside slur endpoint in the Articulations group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Articulations of duration are placed inside slur endpoints when the checkbox is activated, and 
outside slur endpoints when the checkbox is deactivated.

RELATED LINKS
Slur endpoints relative to articulations on page 890

Articulations in playback
Articulations affect how notes sound in playback. Depending on whether your sound library 
has specific samples for different articulations, Dorico SE changes playback in different ways to 
reflect articulations.

● If your sound library includes samples for articulations, Dorico SE loads the required samples 
using playback techniques. Additionally, Dorico SE makes notes with staccatos sound shorter 
and notes with accents sound louder.

● If your sound library does not include samples for articulations, Dorico SE adjusts notes 
according to the articulation without loading different samples. For example, making notes 
with staccatos sound shorter and notes with accents sound louder.

Because articulations apply to whole notes, samples are triggered at the start of notes, including 
tie chains.

TIP

You can enable independent voice playback for individual instruments, for example, if you have 
slurs in one voice and staccatos in another voice.

Articulations
Articulations in playback 
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RELATED LINKS
Playback techniques on page 512
Enabling independent voice playback on page 460

Articulations
Articulations in playback 
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Bars

Bars indicate a usually regular segment of time according to the number of beats, which is 
usually determined by the prevailing time signature. Bars are separated from other bars to the 
left and the right by vertical barlines.

Each bar has a number, allowing players to keep track of their place in the music and aiding 
rehearsal. This is especially important in music for multiple players.

Dorico SE automatically numbers bars and shows barlines between bars as required for the 
current time signature.

RELATED LINKS
Barlines on page 558
Bar numbers on page 563
Time signatures on page 949
Pick-up bars on page 953
Input methods for bars, beats, and barlines on page 235
Input methods for time signatures and pick-up bars on page 220

Bar length
Bars usually last the same duration and start and end at the same positions for all players. 
However, some music involves bars of different lengths coinciding, and there are situations 
where some players may have no bars indicated at all.

You can change the duration of a bar by changing its time signature or, in music in open meter, 
by inputting barlines where required. You can hide time signatures you do not want to show in 
the music, for example, if you are writing music with an irregular meter and you require barlines 
only to group material together, but not to imply any sense of meter.

RELATED LINKS
Hiding/Showing time signatures on page 960

Deleting bars/beats
You can delete whole bars and specific beats from your project completely by using the bars and 
barlines popover, for example, to shorten the last bar in flows that start with pick-up bars.

PROCEDURE

1. In Write mode, select one of the following:

● The first bar you want to delete, or the first note or rest in that bar.

● An item at the rhythmic position from which you want to delete beats.

2. Press Shift-B  to open the bars and barlines popover.

3. Enter – (minus), followed by the number of bars or beats you want to delete into the 
popover.
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For example, enter –6 to delete six bars, meaning the bar you selected and the subsequent 
five bars, or -2q to delete two quarter note beats, starting from the selected rhythmic 
position.

4. Press Return  to close the popover.

RESULT
The number of bars or beats specified is deleted.

RELATED LINKS
Bars and barlines popover on page 235
Pick-up bars on page 953

Deleting bars/beats with the system track
You can delete whole bars and selected beats from your project completely using the system 
track, for example, if you want to delete the last beat in the final bar for flows that begin with a 
pick-up bar.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track in Write mode, select the region that you want to delete.

2. Click Delete in the system track. It can also appear above the system track if your selection is 
narrow.

Delete button in the system track The system track changes color when you hover 
over the Delete button.

RESULT
The selected region is deleted. Just as when Insert mode is active, music to the right of the 
selection moves up to fill in the gap.

NOTE

Any signposts in the selection are also deleted.

RELATED LINKS
System track on page 337
Hiding/Showing the system track on page 338

Deleting empty bars at the end of flows
You can trim flows by deleting any empty bars left at the end.

PROCEDURE

1. In Write mode, select an item in the flow you want to trim.

Bars
Deleting bars/beats 
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2. Press Shift-B  to open the bars and barlines popover.

3. Enter trim into the popover.

4. Press Return  to close the popover.

RESULT
Empty bars at the end of the selected flow are deleted.

RELATED LINKS
Bars and barlines popover on page 235
Splitting flows on page 355

Deleting the contents of bars
You can delete just the contents of bars without deleting barlines or the bars themselves.

PROCEDURE

1. In Write mode, select the bars whose contents you want to delete.

TIP

Notes, rests, and other objects are highlighted orange when selected.

2. Press Backspace or Delete .

RESULT
The contents of the selected bars are deleted.

RELATED LINKS
Large selections on page 336
Filters on page 340

Splits in bars
You can split bars rhythmically by changing the number of beats in each bar. You can split bars 
visually across system or frame breaks, which might be required in music with an irregular meter 
or in passages of polymeter.

Splitting bars by inputting new time signatures

You can split bars into two or more bars by changing the time signature at any rhythmic 
position. New time signatures apply until the next existing time signature or the end of the 
flow, whichever comes first.

NOTE

If you change the time signature in the middle of an existing bar, we recommend inputting 
another time signature at the start of the preceding bar reflecting its new rhythmic duration to 
avoid confusion.

Bars
Splits in bars 
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Splitting bars by inputting new barlines

You can also split bars by inputting new barlines that are not normal (single) barlines anywhere 
within a bar without affecting the time signature. However, inputting a normal (single) barline 
anywhere within an existing bar resets the prevailing time signature from that point onwards.

For example, selecting the third quarter note (crotchet) in a 4/4 bar and inserting a new barline 
causes a new 4/4 bar to start from the added barline. This leaves the equivalent of a 2/4 bar 
without a time signature to the left of the barline, but the bars to the right of the added 
barline are in 4/4 and continue to be in 4/4 until the next time signature or the end of the flow, 
whichever comes first.

Signposts are shown at the position of each barline that you add manually within bars.

Two 4/4 bars with quarter notes Adding a normal barline halfway through the first 
4/4 bar restarts the time signature from that point.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 220
Input methods for bars, beats, and barlines on page 235
Inserting system breaks on page 388
Inserting frame breaks on page 387
Inputting notes in Insert mode on page 178

Combining bars
You can combine two or more bars into one, longer bar by deleting the barline between them.

PROCEDURE

1. In Write mode, select the barline you want to delete.

2. Press Backspace or Delete .

RESULT
The bars on either side of the deleted barline combine into one bar. If required, the notes inside 
are automatically re-beamed appropriately.

NOTE

Deleting a barline does not automatically change the time signature. To avoid confusion, we 
recommend that you input a new time signature to reflect the new rhythmic duration of the bar.

RELATED LINKS
Deleting barlines on page 560
Input methods for time signatures and pick-up bars on page 220

Bars
Combining bars 
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Hiding/Showing multi-bar rests on page 885

Bars
Combining bars 
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Barlines

Barlines are vertical lines that cross staves in order to show how music is divided into bars, 
according to the time signature. The most commonly used barline is the single barline between 
adjacent bars, but there are different types, such as double or repeat barlines.

The final system in a piece in 12/8 containing, a key change with double barline, three normal barlines, and a 
final barline at the end

Dorico SE automatically shows barlines as required for the current time signature. For example, 
Dorico SE automatically shows dashed barlines between the different meters in aggregate time 
signatures. If you change the time signature, Dorico SE moves the barlines as required so that 
subsequent music is barred correctly.

Barlines automatically extend across staff groups that are joined by a bracket or brace.

RELATED LINKS
Types of barlines on page 558
Input methods for bars, beats, and barlines on page 235
Barlines across staff groups on page 560
Repeats in playback on page 464
Bar numbers on page 563
Time signatures on page 949
Types of time signatures on page 951
Input methods for time signatures and pick-up bars on page 220

Types of barlines
There are multiple types of barlines in Dorico SE, which can all be input, moved, and deleted in 
the same ways.

Normal (Single)
A standard single barline that spans the entire height of the staff. For single-line staves, 
the barline extends one space above and below the staff line by default.

Double
A double barline consists of two lines, both the width of a single barline, positioned half 
a space apart by default. It is often used to denote significant changes in the music, or 
to mark the placement of rehearsal marks, key signature changes, and tempo changes.
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Final
A final barline consists of two lines: one of normal width, the other thick. It marks 
where the music ends.

Start repeat
A start repeat line consists of a thick barline, followed by a normal barline, followed by 
one of the following arrangements of dots:

● Two dots, one each in the middle two spaces of a five-line staff

● Four dots, one each in all four spaces of a five-line staff

It shows the start of a repeated section. It is used alongside end repeat lines, which 
show the end of a repeated section.

End repeat
An end repeat line is the mirror of a start repeat line, so it consists of either two or 
four dots, followed by a normal barline, followed by a thick barline. It shows the end 
of a repeated section. It is used alongside start repeat lines, which show the start of a 
repeated section.

End/Start repeat
This line combines the start repeat and end repeat barlines, with either two single 
barlines with a single shared thick barline in the middle, or two thick barlines and no 
single barlines. On either side, there are either two or four repeat dots. It is used when 
a repeated section is immediately followed by another, separate repeated section.

RELATED LINKS
Input methods for bars, beats, and barlines on page 235
Repeats in playback on page 464
Changing the number of playthroughs at repeat barlines on page 464
Barlines across staff groups on page 560

Barlines
Types of barlines 
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Deleting barlines
You can delete barlines without affecting the rhythmic positions of notes. For example, you 
might delete existing barlines and input new ones if you want to change where a barline occurs.

PROCEDURE

1. In Write mode, select the barlines you want to delete.

NOTE

You must select barlines directly, not their signposts.

2. Press Backspace or Delete .

RESULT
The barline is deleted. The two bars either side of the barline combine into one bar, containing 
the same number of beats but without changing the time signature. This might cause note, rest, 
and beam groupings to change.

AFTER COMPLETING THIS TASK

● To avoid confusion, you can add a new time signature to reflect the new rhythmic duration of 
the bar.

● If you deleted barlines because you want to change where they occur, you can input new 
barlines at the new positions.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 220
Input methods for bars, beats, and barlines on page 235
Bars on page 553
Barlines on page 558
Note and rest grouping on page 590

Barlines across staff groups
In order to make it easier to find a particular instrument within a score, barlines can extend 
across instrumental and staff groups.

Barlines across default staff groups

When a barline only appears on individual staves, it is much harder to locate individual lines at 
a glance. However, when barlines continue across instrumental groups in the score, instrument 
families are shown as blocks, which makes finding an instrument much easier.

Barlines
Deleting barlines 
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Barlines on individual staves Barlines across instrumental groups

Barlines automatically extend across staff groups that are joined by a bracket or brace. Which 
staves are included in a bracket depends on the instrumentation and context, but usually staves 
for instruments from the same family, such as woodwind or strings, are bracketed together.

Dorico SE automatically brackets staves according to the ensemble type set for each layout.

Barlines across grand staff instruments

Dorico SE automatically joins barlines across grand staff instrument staves as they are braced. 
Because staves cannot be bracketed and braced simultaneously, grand staff instruments are 
excluded from brackets and therefore are not joined with barlines to any other staves.

Custom barline groups

You can create custom barline joins and bracket groups by manually arranging your players into 
groups. If one or more players included in your group were previously in another group, any 
remaining instruments in their previous group remain grouped.

You can put a single player in its own player group so they appear separately, for example, to 
separate the soloist from the remainder of the ensemble in a concerto.

RELATED LINKS
Brackets according to ensemble type on page 594
Adding player groups on page 120
Adding players to groups on page 121
Deleting player groups on page 120

Showing barlines across all staves at time signature changes
You can join all staves with a barline at time signature changes in individual layouts, regardless of 
your bracketing style.

PROCEDURE

1. Select the time signature changes where you want to join all staves with a barline.

Barlines
Barlines across staff groups 
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2. In the Properties panel, activate Barline joins all staves in the Time Signatures group.

RESULT
All staves in the layout currently open in the music area are joined by a barline at the selected 
time signature changes.

Barlines
Barlines across staff groups 
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Bar numbers

Bar numbers provide a crucial reference point for music that has multiple players, and make the 
chronological sequence of the music clear. They indicate where players are in the piece, which 
allows them to co-ordinate themselves easily in rehearsals and concerts.

Bar numbers can also be useful when preparing parts and scores, as you can use bar numbers 
and rehearsal marks to help you quickly compare a part to the score and check the music is 
correct.

In Dorico SE, bar numbers appear automatically, following the most common practice of showing 
a bar number at the start of each system in all layouts by default. You can hide and show bar 
numbers in each layout independently, including showing them at a specified regular interval or 
in every bar, which is frequently used in film music scores.

TIP

The majority of options relating to bar numbers are on the Bar Numbers page in Setup > 
Layout Options. This is because it is very common to display bar numbers differently in different 
layouts, such as in every bar in full score layouts but only at the start of each system in part 
layouts.

RELATED LINKS
Positions of bar numbers on page 567
Bar number changes on page 570
Layout Options dialog on page 90
Bars on page 553
Pick-up bars on page 953
Barlines on page 558
Event display on page 418

Hiding/Showing bar numbers
You can hide/show bar numbers in each layout independently, including showing them at 
different frequencies. For example, you can show bar numbers every bar in full score layouts 
but only at the start of each system in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar numbers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Frequency subsection, choose one of the following options for Show bar numbers:

● Every system

● Every n bars
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● Every bar

● None

5. Optional: If you chose Every n bars, set a custom frequency for bar numbers by changing 
the value for Interval.

6. Click Apply, then Close.

RESULT
Bar numbers are hidden in the selected layouts when you choose None, and shown at the 
corresponding frequency when you choose any other option.

Changing the Interval value changes how frequently bar numbers are shown. For example, 
setting an interval value of 10 means that bar numbers are shown every tenth bar.

TIP

You can also hide individual bar numbers in layouts where bar numbers are shown by selecting 
them and activating Hide bar number in the Time Signatures group of the Properties panel.

RELATED LINKS
Hiding/Showing bar number ranges on multi-bar rests on page 565
Showing bar numbers above specific staves on page 567
Hiding/Showing guide bar numbers on page 566
Positions of bar numbers on page 567

Hiding/Showing bar number enclosures
You can optionally show bar numbers in either a rectangular or circular enclosure in each layout 
independently, for example, if you want bar numbers to appear with rectangle enclosures in the 
full score layout so the conductor can easily see them but with no enclosures in part layouts, 
where pages tend to be less busy.

Bar numbers in enclosures automatically erase their backgrounds.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number enclosure 
type.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Appearance subsection, choose one of the following options for Enclosure type:

● None

● Rectangle

● Circle

5. Click Apply, then Close.

Bar numbers
Hiding/Showing bar number enclosures 
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RESULT
Bar numbers in the selected layouts are shown within your selected enclosure type. The size 
of the enclosure is relative to the font size of the bar numbers, but the size and shape of the 
enclosure are also determined by your padding values.

EXAMPLE

Bar number with no enclosure Bar number with a rectangle 
enclosure

Bar number with a circle enclosure

RELATED LINKS
Layout Options dialog on page 90

Hiding/Showing bar number ranges on multi-bar rests
You can hide/show bar number ranges on multi-bar rests, for example, so it is clear in part 
layouts which bars the player does not play. Multi-bar rests can include bar repeat regions, if you 
have chosen to consolidate bar repeat regions as well as empty bars into multi-bar rests.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar number ranges on 
multi-bar rests.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Showing and Hiding subsection, activate/deactivate Show ranges of bar numbers 
under multi-bar rests and consolidated bar repeats.

5. Click Apply, then Close.

RESULT
Bar number ranges are shown beneath multi-bar rests and consolidated bar repeats in the 
selected layouts when the option is activated, and hidden when it is deactivated.

RELATED LINKS
Hiding/Showing bar numbers on page 563
Hiding/Showing multi-bar rests on page 885

Bar numbers
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Hiding/Showing guide bar numbers
You can hide/show guide bar numbers on every bar and above every system in page view and 
galley view independently, for example, to make it easier to check the bar number in scores with 
many staves. Guide bar numbers are not printed.

PROCEDURE

● Hide/Show guide bar numbers in any of the following ways:

● To hide/show guide bar numbers in page view, choose View > Bar Numbers > Page 
View.

● To hide/show guide bar numbers in galley view, choose View > Bar Numbers > Galley 
View.

RESULT
Guide bar numbers are shown for every bar and above every staff in the corresponding view 
type when a tick appears beside the corresponding option in the menu, and hidden when no tick 
appears.

RELATED LINKS
Switching to galley/page view on page 42

Changing the bar number paragraph style used in layouts
You can choose which paragraph style is used for bar numbers in each layout independently. By 
default, full score layouts and part layouts use different paragraph styles for bar numbers.

PREREQUISITE
If you want to use a custom paragraph style for bar numbers in some layouts, you have created it 
in the Paragraph Styles dialog.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the paragraph style used 
for bar numbers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Appearance subsection, select a paragraph style from the Paragraph style menu.

5. Click Apply, then Close.

RESULT
The selected paragraph style is used for all bar numbers in the selected layouts.

Bar numbers
Hiding/Showing guide bar numbers 

566
Dorico SE 3.5.12



Positions of bar numbers
Bar numbers are typically shown at the start of each system, above the staff, and aligned with 
the initial barline.

You can change the default positions and frequency of bar numbers in each layout 
independently on the Bar Numbers page in Layout Options. For example, you might want 
to show bar numbers every bar in full score layouts but only at the start of each system in part 
layouts.

Changing the horizontal position of bar numbers
You can change the horizontal position of bar numbers in each layout independently. For 
example, you can have bar numbers centered in the middle of bars in full score layouts but 
centered on barlines in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the horizontal position of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Horizontal Position subsection, choose one of the following options for Horizontal 
position:

● Centered on barline

● Centered on bar

5. Click Apply, then Close.

RESULT
The horizontal position of bar numbers is changed in the selected layouts.

● Centered on barline shows bar numbers above barlines, at the top left of the bar.

● Centered on bar shows bar numbers above the staff, in the middle of the bar.

RELATED LINKS
Showing bar numbers above specific staves on page 567

Showing bar numbers above specific staves
You can change the staves above which bar numbers appear, which allows you to show bar 
numbers at multiple vertical positions in each system. For example, in large orchestral scores, 
you might show bar numbers both at the top of the system and above the string section.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical positions of 
bar numbers.

Bar numbers
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Placement subsection, activate the checkbox for each player in the Show above 
specific players list above whose top staff you want to show bar numbers.

5. Click Apply, then Close.

RESULT
The vertical positions of bar numbers are changed in the selected layouts. For players holding 
multiple instruments, bar numbers appear above their top instrument staff.

NOTE

You can change the distances between bar numbers and the staff/other objects and your vertical 
spacing settings for the gaps between staves in order to accommodate bar numbers shown 
between staves.

RELATED LINKS
Changing the default staff/system spacing on page 371
Per-layout vertical spacing options on page 408
Moving instruments on page 107

Changing the distance between bar numbers and the staff/other 
objects

You can change the minimum distance between bar numbers and the staff, and set a separate 
value for the distance between bar numbers and other objects, in each layout independently. For 
example, you can position bar numbers further from the staff/other objects in full score layouts 
than in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the minimum distance of 
bar numbers from the staff.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. Optional: In the Placement subsection, change the value for Minimum distance from staff.

The default value is 2 spaces.

5. Optional: In the Placement subsection, change the value for Minimum distance from 
other objects.

The default value is 3/4 of a space.

6. Click Apply, then Close.

Bar numbers
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RESULT
If you increase the values, bar numbers are positioned further away from the staff and/or other 
objects, either above or below the staff depending on your setting for Placement relative to 
staff. If you decrease the values, bar numbers are positioned closer to the staff and/or other 
objects.

NOTE

These options affect the minimum distance between bar numbers and the staff and other 
objects, so bar numbers might be positioned further away than this to avoid collisions.

Changing the system-relative placement of bar numbers
You can show bar numbers either above or below each system in each layout independently. For 
example, bar numbers can appear below the system in full score layouts but above the system in 
individual part layouts.

NOTE

This does not affect the placement of bar numbers shown above specific staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number 
placement.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Placement subsection, choose one of the following options for Placement relative to 
system:

● Show above top staff of system

● Show below bottom staff of system

5. Click Apply, then Close.

RESULT
The placement of bar numbers relative to the system is changed in the selected layouts.

Hiding bar numbers at time signatures shown at system object 
positions

You can choose to hide bar numbers at the same rhythmic position as time signatures shown at 
system object positions, as the resulting collision can be difficult to resolve in a visually clear way 
when bar numbers are centered on barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide bar numbers at time 
signatures shown at system object positions.

Bar numbers
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Bar Numbers in the category list.

4. In the Showing and Hiding subsection, activate/deactivate Show bar numbers at time 
signatures at system object positions.

5. Click Apply, then Close.

RESULT
Bar numbers are shown at time signatures shown at system object positions when the option is 
activated, and hidden when it is deactivated.

EXAMPLE

Bar numbers shown at time signatures at system 
object positions

Bar numbers hidden at time signatures at system 
object positions

RELATED LINKS
Time signatures on page 949
Large time signatures on page 954

Bar number changes
Bar numbers follow a continuous sequence, with each bar having a unique bar number that 
continues from the previous bar number. However, you can make manual changes to the bar 
number sequence, including changing to a subordinate sequence.

In Dorico SE, you can make the following types of changes to bar number sequences using the 
Insert Bar Number Change dialog:

Primary
Adds a change to the main bar number sequence, which the bars in your project follow 
in a continuous sequence in each flow separately by default.

Subordinate
Adds a secondary bar number sequence that uses letters rather than numbers to 
indicate the sequence. This can be useful in situations where a new version of a piece 
has been created with more bars inserted, but the original bar numbers are required.

Don’t Include
Excludes the selected bar from the current bar number sequence. If bar numbers are 
shown every bar, no bar number is shown in bars in which you have chosen Don’t 
Include.

Bar numbers
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Continue Primary
Returns the bar number sequence to the Primary sequence without counting 
intervening bars, for example, after a section of bars following the Subordinate bar 
number sequence.

RELATED LINKS
Subordinate bar numbers on page 572

Adding bar number changes
You can manually add bar number changes to bar number sequences, for example, if you want 
bar numbers in the second flow in your project to appear to continue the sequence from the first 
flow, rather than start again from bar one.

PROCEDURE

1. Select one of the following:

● An item in the bar from the beginning of which you want to change the bar number 
sequence.

● An existing bar number or barline from which you want to change the bar number 
sequence.

2. Choose Edit > Bar Numbers > Add Bar Number Change to open the Insert Bar Number 
Change dialog. You can also choose this option from the context menu.

3. Choose one of the following options for Type:

● Primary

● Subordinate

● Don’t Include

● Continue Primary

4. Optional: If you chose Primary or Subordinate, change the bar number where you want 
the bar number sequence change to start by changing the value in the corresponding value 
field.

5. Click OK to save your changes and close the dialog.

RESULT
The bar number sequence changes, starting from the beginning of the bar in which you selected 
an item, or from the position of a selected bar number or barline.

This affects the corresponding bar number sequence from the changed bar number until the 
next bar number change, or until the end of the flow.

Deleting bar number changes
You can delete any bar number changes you have added.

PROCEDURE

1. In Write mode, select the bar number changes you want to delete.

2. Press Backspace or Delete .

Bar numbers
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RESULT
The bar number changes are deleted. Subsequent bars follow the previous bar number 
sequence until the next bar number change, or until the end of the flow.

Subordinate bar numbers
Subordinate bar numbers are useful for numbering repeat endings, and for situations when the 
music is being altered, but the original bar numbers cannot be changed.

For example, you can use subordinate bar numbers to show where music has been added if a 
previous, shorter version has already been rehearsed. In this situation, players have likely started 
to associate certain parts of the piece with particular bar numbers, so if four bars need to be 
added after bar 10, they would be numbered 10a to 10d. The bar number of the following bar 
then continues from 11 exactly as it did before the new bars were added.

They might also be useful if you want different bar numbers for a repeat ending.

Subordinate bar numbers are shown with lowercase letters.

Lowercase subordinate bar number

Adding subordinate bar numbers
You can create a subordinate bar number sequence that is independent of your primary bar 
number sequence. This can be useful if you want to insert new bars without changing the bar 
numbers of existing subsequent bars.

PROCEDURE

1. Select one of the following:

● An item in the bar from the beginning of which you want subordinate bar numbers to 
start.

● An existing bar number or barline from which you want subordinate bar numbers to 
start.

2. Choose Edit > Bar Numbers > Add Bar Number Change to open the Insert Bar Number 
Change dialog. You can also choose this option from the context menu.

3. Choose Subordinate for Type to activate the Subordinate value field.

4. Change the first letter in the subordinate bar number sequence by changing the value in the 
Subordinate value field.

The corresponding alphabetical letter is shown to the right of the value field. For example, 
entering 1 into the value field is shown as a, 2 appears as b, and so on.

5. Click OK to save your changes and close the dialog.

RESULT
The subordinate bar number sequence starts from the bar in which you selected an item, or 
from the position of a selected bar number or barline. It has the same bar number as the bar 
immediately before, but with subordinate alphabetical letters.

Bar numbers
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For example, if you start a subordinate bar number sequence from what was originally bar 5, the 
sequence starts from 4a and continues until the next specified bar number change, or until the 
end of the flow.

Returning to the primary bar number sequence
You can specify the point where you want to return to the primary bar number sequence after a 
section of subordinate bar numbers.

PROCEDURE

1. Select one of the following:

● An item in the bar from the beginning of which you want to return to the primary bar 
number sequence.

● An existing bar number or barline from which you want to return to the primary bar 
number sequence.

2. Choose Edit > Bar Numbers > Add Bar Number Change to open the Insert Bar Number 
Change dialog. You can also choose this option from the context menu.

3. Choose Continue Primary for Type.

Text indicating the new bar number appears below the value fields for Primary and 
Subordinate. For example, Primary sequence will continue from bar 5.

4. Click OK to save your changes and close the dialog.

RESULT
The primary bar number sequence resumes from the bar in which you selected an item, or from 
the position of a selected bar number or barline.

TIP

You do not have to add subordinate bar number changes in chronological order. You can enter 
a return to the primary bar number sequence first, before adding the subordinate bar number 
sequence.

Bar numbers and repeats
By default in Dorico SE, repeats are not included in the bar number count. For example, if the 
first ending ends in bar 10, the second ending starts in bar 11, even though the first section is 
repeated and therefore more than ten bars have been played.

Including repeats in the bar number count, so that bar numbers reflect the total number of 
bars played rather than the number of bars written on the page, can make music with multiple 
playthroughs clearer, as you can refer to a specific bar number for each playthrough instead of, 
for example, “bar eight the third time round”.

Bar number for subsequent repeat shown in parentheses beside the initial bar number

Bar numbers
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In Dorico SE, you cannot automatically include repeats in the bar number count. However, you 
can add bar number changes manually if you want bar numbers to reflect the total number of 
bars played.

RELATED LINKS
Adding bar number changes on page 571

Bar numbers
Bar numbers and repeats 

574
Dorico SE 3.5.12



Beaming

A beam is a line that connects notes with tails to show rhythmic grouping, which varies according 
to the metrical structure of the current time signature.

This way of grouping notes helps performers calculate quickly exactly how to play their given 
rhythm and helps them follow both their part and, if applicable, the conductor.

If appropriate for the current meter and position in the bar, beams are automatically formed in 
Dorico SE when you input two or more adjacent notes or chords that are an eighth note (quaver) 
or shorter in duration.

Multiple beam groups in a 6/8 time signature

RELATED LINKS
Inputting notes on page 161

Beam groups
Notes are commonly beamed as regular groups to help reflect the meter. You can control how 
notes are beamed in multiple ways in Dorico SE.

● You can set beam groups by controlling subdivisions of time signatures.

● You can change beam groups individually using properties in the Properties panel, and by 
choosing Edit > Beaming and selecting one of the available options.

RELATED LINKS
Beam grouping according to meters on page 575
Beaming notes together manually on page 577
Secondary beams on page 586
Tuplets within beams on page 588

Beam grouping according to meters
According to accepted conventions, notes are beamed differently in different time signatures to 
make the meter clear and easily readable. In Dorico SE, default beam groupings are determined 
by time signatures.

Dorico SE has default beaming settings for common time signatures, based on general 
conventions. For example, although the time signatures of 3/4 and 6/8 contain the same number 
of beats, they imply different meters and so are beamed differently. In 3/4, phrases of eighth 
notes are beamed together within each bar and phrases of other durations are beamed in 
quarter notes (crotchets) by default, but in 6/8, phrases are beamed in dotted quarter notes.
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Default eighth note beam grouping in 3/4 Default eighth note beam grouping in 6/8

Dorico SE groups and beams notes in irregular time signatures, such as 5/8 or 7/8, according to 
the most common practices for those time signatures.

Default beam grouping in 5/8 Default beam grouping in 7/8

For situations where you want to control the beat grouping in more detail, you can input a 
custom time signature with an explicit rhythmic subdivision. Dorico SE then automatically beams 
phrases according to this subdivision. For example, entering [7]/8 into the time signatures 
popover means all seven eighth notes (quavers) are beamed together, whereas entering 
[2+2+3]/8 subdivides the seven eighth notes into two, then two, then three.

RELATED LINKS
Note and rest grouping on page 590
Creating custom beat groupings for meters on page 590

Splitting beam groups
You can split beams into two beam groups at specific rhythmic positions. You can also split 
secondary beams within beamed groups.

PROCEDURE

1. Select the noteheads to the right of where you want to split beams.

2. Split the beam or secondary beam in one of the following ways:

● Choose Edit > Beaming > Split Beam.

● Choose Edit > Beaming > Split Secondary Beam.

TIP

You can also choose these options from the context menu.

RESULT
Beams/Secondary beams are split to the left of each selected note, but the notes either side of 
the split remain grouped if there are at least two beamed notes on each side that can be in a 
beam group.

TIP

To unbeam the entire selection and give all notes in the group individual tails, you can make all 
notes unbeamed.

RELATED LINKS
Beam groups on page 575
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Beam grouping according to meters on page 575
Unbeaming notes on page 578

Resetting beam grouping
You can remove all changes made to the beam grouping of notes and chords. This can also be 
useful if, for example, MusicXML files you have imported have incorrect beaming.

PROCEDURE

1. Select the notes/chords whose beaming you want to reset.

2. Choose Edit > Beaming > Reset Beaming. You can also choose this option from the context 
menu.

RESULT
Beam grouping is reset to the default settings.

Beaming notes together manually
You can beam notes together manually, including notes across barlines as well as system/frame 
breaks, for example, if you want to beam a phrase differently to how it is usually beamed in the 
current time signature.

Beams by default stay within bars and systems, so to have beams cross barlines, system breaks, 
and frame breaks, you must force the phrase to beam together.

PROCEDURE

1. Select the notes you want to beam together.

2. Choose Edit > Beaming > Beam Together. You can also choose this option from the context 
menu.

RESULT
The selected notes are beamed together, even if they cross barlines or system/frame breaks.

If there are notes either side of the new beam group that were previously beamed to part or 
all of your selection, they either beam together as separate beams, or appear unbeamed. This 
depends on how many notes are left either side in the bar.

NOTE

Even if part of the beamed group previously had a centered beam, the new beam is not centered.

RELATED LINKS
Allowing/Disallowing tuplets to span barlines on page 970
Centered beams on page 581
Creating cross-staff beams on page 583
Beam grouping according to meters on page 575
Creating custom beat groupings for meters on page 590
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Unbeaming notes
You can separate all notes in a beamed group so that each note shows its own tail, for example, 
when fast rhythms have syllabic text settings.

PROCEDURE

1. Select the notes you want to make unbeamed.

2. Choose Edit > Beaming > Make Unbeamed. You can also choose this option from the 
context menu.

Changing the direction of partial beams
Dorico SE automatically inputs a partial beam if one is required. You can change on which side of 
stems individual partial beams appear.

PROCEDURE

1. Select the notes whose partial beam direction you want to change.

2. In the Properties panel, activate Partial beam direction in the Beaming group.

3. Choose one of the following options:

● Left

● Right

RESULT
The partial beam appears on the corresponding side of the stem.

EXAMPLE

Partial beam direction Left Partial beam direction Right

Beam placement relative to the staff
The default staff-relative placement of beams is determined by the staff positions of the notes 
within the beamed group and their resulting stem directions.

This means that the note furthest from the middle line of the staff determines the placement of 
the beam, although there are exceptions to this rule and other considerations that can influence 
the staff-relative placement of beams.

Changing the staff-relative placement of beams involves changing the direction of the stems in 
the beam. Therefore, Dorico SE categorizes changing the staff-relative placement of beams as a 
stem change.

RELATED LINKS
Beam slants on page 580
Centered beams on page 581
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Changing the staff-relative placement of beams
You can change the side of the staff on which beams appear by forcing the stem direction to 
change. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement you 
want to change.

2. Force the stem direction of notes in the selected beams in any of the following ways:

● Choose Edit > Stem > Force Stem Up.

● Choose Edit > Stem > Force Stem Down.

TIP

● You can also choose these options from the context menu.

● You can also change the staff-relative placement of selected beams by pressing F .

RESULT
The beam appears on the side of the staff that corresponds to its forced stem direction. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Removing beam placement changes
You can undo changes to the staff-relative placement of beams in order to remove the stem 
direction change. This reverts selected beams to their default placement.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement 
change you want to remove.

2. Choose Edit > Stem > Remove Forced Stem. You can also choose this option from the 
context menu.

RESULT
The selected beams revert to their default staff-relative placement.

Beaming
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Beam slants
The slant of a beam controls how steeply the beam deviates from horizontal, according to the 
pitches of the notes within the beamed group.

● When the last note of the phrase is higher than the first, the beam slants upwards.

● When the last note of the phrase is lower than the first, the beam slants downwards.

● If the group makes a concave shape, where inner notes are closer to the beam than the 
outer ones at either end of the beam, then the beaming is horizontal by default.

Beams are also horizontal if all the pitches are the same, or for certain patterns of repeated 
pitches.

When a beam is drawn inside the staff, each end of the beam, meaning the end of the stem of 
the note at either end of the beam, must be snapped to a staff line position. A beam line may 
sit on a staff line, be centered on a staff line, or hang from a staff line. Ted Ross describes these 
three positions as “sit”, “straddle”, and “hang” respectively in “Teach Yourself the Art and Practice 
of Music Engraving”.

A phrase containing multiple different beam slants and directions

The amount by which a beam slants is typically determined by the interval between the first and 
last note in the beamed group, provided the pattern of notes in the beam does not dictate a 
horizontal beam instead. Smaller intervals require a shallower slant and larger intervals require a 
steeper one.

However, the desired amount of slant is not the only factor that must be considered. The 
innermost beam line should not come too close to the innermost notehead, and the beam itself, 
if possible, should be positioned relative to the staff lines such that it does not form a wedge. A 
wedge is a tiny triangle formed by the horizontal staff line, the vertical stem, and the angled line 
of the slanted beam, which can be visually confusing.

Determination of the amount of slant for a beam is therefore a balancing act that must weigh up 
several factors: the desired amount of slant, valid snapping positions for each end of the beam, 
ensuring a minimum distance between the note closest to the beam and the innermost beam 
line, and avoiding wedges where possible.

In Dorico SE, you can change the beam slants of individual beams.

Changing beam slants
You can change the slants, or angles, of individual beams. You can do this for the current layout 
and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each beam group whose slant you want to change.
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2. In the Properties panel, activate Beam direction in the Beaming group.

3. Select one of the following options from the menu:

● Flat

● Up

● Down

RESULT
The slants of the selected beams are changed while retaining correct positions relative to staff 
lines. If the property scope was set to Locally, this change only takes effect in the current layout 
and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Centered beams
Centered beams are positioned between high and low notes within the same beamed group, 
typically drawn in the middle of the staff or between the staves of grand staff instruments.

Centered beams are also known as “kneed” or “elbowed” beams due to their often angular 
shape.

When a beamed phrase spans a large pitch range, normal beams are often positioned very close 
to some notes in the phrase but very far from other notes in the phrase, making some stems 
very long. Having a centered beam in a phrase that spans a large pitch range can reduce the 
maximum distance between noteheads and the beam, but can also place the beam within the 
staff, which can obscure staff lines.

A phrase with high and low notes with default 
beaming

The same phrase with high and low notes, but with a 
centered beam

RELATED LINKS
Changing the staff-relative placement of beams on page 579
Creating cross-staff beams on page 583
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Creating centered beams
You can make beams appear in the middle of staves, with high notes above the beam and lower 
notes below the beam. You can do this for the current layout and frame chain only or for all 
layouts and frame chains.

NOTE

As this action requires changing the direction of some stems in order to appear correctly, it is 
located in the Stem submenu rather than Beaming in the Edit menu.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beams you want to center.

2. Choose Edit > Stem > Force Centered Beam. You can also choose this option from the 
context menu.

RESULT
Beams are centered between the notes in the selected beam groups. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

If you select notes in multiple beams, each beam is centered separately. If you want to create a 
single centered beam, you can beam the notes in those beam groups together. You can do this 
both before and after centering the beams.

NOTE

● Dorico SE automatically angles the beam based on the shape of the phrase, but you can 
change the angles or slants of beams manually.

● You can assign a key command for Force Centered Beam on the Key Commands page in 
Preferences.

RELATED LINKS
Beaming notes together manually on page 577
Changing beam slants on page 580

Removing centered beams
You can remove centered beams and revert beams to their default placements either above or 
below the phrase.

PROCEDURE

1. Select at least one note in each centered beam that you want to revert to the default 
placement.

2. Choose Edit > Stem > Remove Centered Beam. You can also choose this option from the 
context menu.

RESULT
The centered beams are removed.
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TIP

You can assign a key command for Remove Centered Beam on the Key Commands page in 
Preferences.

Creating cross-staff beams
Cross-staff beams work in a similar way to normal beams, but allow a phrase that covers a wide 
pitch range to be shown on two staves. You can create cross-staff beams by inputting all notes in 
the phrase on one staff and crossing some notes to appear on another staff.

PREREQUISITE
You have input a phrase on one staff.

PROCEDURE

1. Select the notes you want to cross to another staff.

NOTE

You can only cross notes to other staves in multi-staff instruments.

2. Cross the notes to other staves in any of the following ways:

● To cross notes to the staff above, press N .

● To cross notes to the staff below, press M .

RESULT
The selected notes are shown on a different staff, with a cross-staff beam shown if the notes are 
part of a beam group. This does not change the staff to which the notes belong.

NOTE

● When crossing notes to a staff that already contains notes, the stem direction of the existing 
notes on the staff can change. This is due to how multiple voices at the same rhythmic 
position are handled. Therefore, you may have to change the stem direction of notes 
manually.

● You can reset notes to appear on their default staff by selecting them and choosing Edit > 
Cross Staff > Reset to Original Staff.

● If you want notes to belong to a different staff, you can move them to another staff.
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EXAMPLE

Notes shown on their original staves Cross-staff beams created by crossing some notes to 
the other staff

RELATED LINKS
Moving notes to other staves on page 353
Notes crossed to staves with existing notes in other voices on page 1001
Note positions in multiple-voice contexts on page 998
Changing the stem direction of notes on page 923

Changing to optical cross-staff beam spacing
You can make the stems in cross-staff beams, rather than the noteheads, evenly spaced in each 
layout independently. This can make it easier to perceive the evenness of rhythmic spacing in 
cross-staff beams than when noteheads are evenly spaced.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts that you want to change to optical cross-staff beam 
spacing.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Note Spacing in the category list.

4. Activate Use optical spacing for beams between staves.

5. Click Apply, then Close.

RESULT
Optical cross-staff beam spacing is enabled in the selected layouts.
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EXAMPLE

Default spacing: The distance between noteheads is 
even.

Optical spacing for cross-staff beaming: The distance 
between stems is even.

RELATED LINKS
Note spacing on page 406

Cross-staff beam placement in multiple staves
When instruments have three or more staves, cross-staff beams can be placed in multiple ways. 
For example, the beam can be placed between the top and the middle staves, and also between 
the middle and bottom staves.

If a beam only crosses two staves, the cross-staff beam goes between those two staves.

A cross-staff beam across the upper two staves on 
an instrument with three staves

A cross-staff beam across the lower two staves on an 
instrument with three staves

If a beam group contains notes on all three staves, the placement of the beam depends on the 
stem directions of the notes in each staff.
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1 If all notes in the beam group are stem-up, the beam is placed above the top staff.

2 If all notes in the beam group are stem-down, the beam is placed below the bottom staff.

3 If notes are stem-down on the top staff and stem-up on the bottom two staves, the beam is 
placed between the top and middle staves.

4 If notes are stem-down on the top two staves and stem-up on the bottom staff, the beam is 
placed between the bottom and middle staves.

NOTE

If you have not specified stem directions, Dorico SE might place the beam above/below the staff 
into which the notes were originally input, even if the stem directions mean it should be placed 
between other staves.

If you want the beam to be placed between specific staves, you can change the stem directions 
of notes in the beam group.

RELATED LINKS
Changing the stem direction of notes on page 923

Beam corners
Beam corners can occur when a change of stem direction within a beam is combined with a 
break in the secondary beam group. This can be at the end of a subdivision or at a change in 
rhythmic speed.

Beam corners do not follow accepted rules regarding the order and rhythmic meaning of 
secondary beams, and can be confusing for the reader.

Dorico SE avoids beam corners by analyzing the pitches and stems within a phrase, and 
implementing stem directions that avoid a beam corner.

Secondary beams
Secondary beams are the lines that are added between the primary beam and the notehead as 
the rhythmic division gets smaller.

The primary beam is the outermost beam line that joins all of the notes in the beamed group. 
Depending on the durations of the notes in the beamed group, the primary beam may in fact be 
two or more lines; that is, for notes of a 16th or shorter in duration.

Secondary beams are additional beam lines that join only some of the notes in the group, 
creating subdivisions of the beam in order to make the metrical groupings of the beam clearer.

Beaming
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A phrase of 64th notes, with secondary beams subdivided to show 16th and eighth note groups

Changing the number of beam lines in secondary beams
You can change the number of beam lines shown in secondary beams individually.

PROCEDURE

1. Select the notes to the right of where you want to change the number of secondary beaming 
lines.

2. Optional: If any of the notes you selected do not immediately follow existing splits in the 
secondary beam, split the secondary beams in any of the following ways:

● In the Properties panel, activate Split secondary beam in the Beaming group.

NOTE

The Beaming group is only shown in the Properties panel if your selection only contains 
notes.

● Choose Edit > Beaming > Split Secondary Beam. You can also choose this option from 
the context menu.

3. In the Properties panel, select the note value that corresponds to the number of beam lines 
you want shown from the Split secondary beam menu.

RESULT
The number of beam lines shown immediately to the left of each selected note is changed.

NOTE

The number of beam lines shown at a split in the secondary beam cannot be the same or greater 
than the number of beam lines in the secondary beam. For example, if you split a secondary 
beam containing 64th notes, the maximum number of beam lines shown at the split in that 
beam is three, the equivalent of 32nd notes.

Resetting changes to the number of secondary beam lines
You can reset any changes you have made to the number of beam lines shown in secondary 
beams and return them to their default appearance.

PROCEDURE

1. Select the notes to the right of where you want to reset the number of secondary beam lines.

2. Reset your changes to the number of secondary beam lines in any of the following ways:

● In the Properties panel, deactivate Split secondary beam in the Beaming group.

● Choose Edit > Beaming > Reset Beaming. You can also choose this option from the 
context menu.
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Tuplets within beams
Tuplets that contain notes that produce beams, such as eighth notes, are beamed together. 
However, special beam grouping rules apply to tuplets within beams that also contain non-tuplet 
notes.

The default setting for a tuplet in a beamed group with secondary beams is to split the secondary 
beam and to show the tuplet with a bracket. The primary beam is not split. If necessary, you can 
hide/show tuplet brackets individually.

The default setting for a tuplet in a beamed group with only a primary beam is to separate the 
tuplet entirely.

16th note triplet beamed together with non-tuplet 
16th notes

Eighth note (quaver) triplet beamed separately from 
non-tuplet eighth notes

RELATED LINKS
Tuplets on page 967
Tuplet brackets on page 973
Tuplet numbers/ratios on page 975
Hiding/Showing tuplet brackets on page 973

Stemlets
Stemlets are short stems that extend from beams to rests within beam groups. They can help 
make music easier to read, as they help to maintain a regular pattern of stems within beams.

In the examples, beaming all notes and rests together to show the boundaries of quarter note 
(crotchet) beats makes the syncopation of the notes easier to read. The stemlets on the rests 
help make clear where within the quarter note beats each note occurs.

A syncopated phrase without stemlets The same phrase with stemlets

In Dorico SE, you cannot add stemlets or change where they are shown. However, stemlets are 
shown if you import or open a project that contains them.

Fanned beams
Fanned beams show either an accelerando or rallentando by having multiple beam lines either 
converging on, or diverging from, a single beam line at the other end. Fanned beams are also 
known as “feathered beams”.

A single fanned beam can have multiple changes of direction within it.
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The grouping can use either two or three beams, with three beams indicating a greater change 
of speed than two beams. The slowest part of the phrase is where the beams converge, and the 
fastest is where the beams are the most spread out.

In Dorico SE, you cannot create fanned beams or change their direction. However, fanned beams 
are shown if you import or open a project that contains them.

EXAMPLE

Fanned beam accelerando with three lines

Fanned beam accelerando with two lines

Fanned beam rallentando with three lines

Fanned beam rallentando with two lines
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Note and rest grouping

There are generally accepted conventions for how notes and rests of different durations are 
notated and grouped in different contexts and meters. In Dorico SE, notes are automatically 
notated to fit within bars.

Depending on the prevailing time signature, there can be many different ways to beam notes 
together. For example, you might want to beam all notes in the bar together in time signatures 
that cannot be divided in half and are often not divided at all, such as 3/4.

A passage containing different meters. Notes are grouped and beamed differently in the different meters, 
and the durations of tied notes that cross the second barline are automatically correct.

There are also different conventions for how notes within tie chains should be divided to indicate 
significant beat boundaries within bars, and in which contexts they can cross beat boundaries.

Similar options apply to dotted notes, which are often notated as a single dotted note if they 
start at the beginning of bars, but as a tie chain that shows significant beat boundaries in the bar 
if they start part-way through bars.

RELATED LINKS
Beaming on page 575
Beam grouping according to meters on page 575
Forcing the duration of notes/rests on page 171

Creating custom beat groupings for meters
If your music requires a different beat grouping for a particular meter than the default setting 
for that time signature, you can specify your preferred beat grouping within the time signature. 
You can choose whether or not the time signature shows this custom beat grouping. You can 
also input time signatures only on single staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item at the rhythmic position where you want to input a time signature with 
custom beat grouping. If you want to input a time signature with custom beat grouping 
on a single staff, select an item that belongs to that staff only.

2. Optional: If you want to input a time signature with custom beat grouping onto multiple 
specific staves at once, extend the caret to those staves.

3. Optional: If you want Dorico SE to add beats at the end of the region affected by the new 
time signature if required, press I  to activate Insert mode.

4. Press Shift-M  to open the time signatures popover.

5. Enter the division you want in square brackets into the popover.

For example, to divide a 7/8 time signature into 2+3+2, enter [2+3+2]/8 into the popover. To 
divide a 5/4 time signature into 2+3 rather than 3+2, enter [2+3]/4 into the popover.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
The time signature specified is input and beam and beat grouping in subsequent bars follows the 
division you specified.

TIP

You can change the appearance of numerators in individual time signatures so that they show a 
single number or beat groups.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 220
Time signatures popover on page 220
Time signature styles on page 956
Changing the numerator style of time signatures on page 957
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Brackets and braces

Brackets and braces are thick straight and curved lines in the left-hand margin that show 
instrument groupings.

Brackets

A bracket is a thick black line, the width of a beam, that groups staves together, most commonly 
according to instrument family. It often has winged ends that point inwards towards the score.

It is always positioned directly to the left of a systemic barline. If secondary brackets are used 
in addition to a bracket, they are positioned further away from the start of the system to allow 
space for the bracket.

An example of a bracket, connecting instruments in the string family. A sub-bracket connects the two violin 
lines.

In Dorico SE, barlines join the same staves that are joined by brackets and braces, meaning that 
bracketed groups of staves and braced pairs of staves appear with barlines extending across the 
group.

Braces

A brace is a wavy or curly line that joins multiple staves belonging to the same instrument, 
usually a grand staff instrument such as the piano or harp. If necessary, a brace can extend to 
three or more staves, although two is most common.

The brace is also sometimes used instead of a sub-bracket to show groupings of identical 
instruments within a family whose staves are joined by a bracket.

It is positioned outside the systemic barline, and if used in place of a sub-bracket, outside of the 
bracket as well.
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A brace connecting two piano staves

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves are 
excluded from bracketed groups. They also cannot show sub-brackets or sub-sub-brackets.

● System objects are only shown above instrument families that are bracketed or braced 
together.

● Blank staves can only show brackets/braces when they are shown after final flows. You 
cannot show brackets/braces on blank staves in music frames.

RELATED LINKS
Barlines across staff groups on page 560
Player groups on page 119
Adding player groups on page 120
Brackets according to ensemble type on page 594
Changing bracket grouping according to ensemble type on page 593
System objects on page 913

Changing bracket grouping according to ensemble type
You can change which staves are included in brackets by changing the ensemble type for each 
layout independently, for example, if a part layout containing all percussion players requires 
different bracketing than used for percussion staves in the full score layout.

The default setting is Orchestral. We recommend that you change this setting for projects 
containing small ensembles.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the ensemble type for 
bracket grouping.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Brackets and Braces in the category list.

4. Choose one of the following options for Ensemble type:

● No brackets

● Orchestral

● Small ensemble

● Wind band

● Big band

Brackets and braces
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● British brass band

5. Click Apply, then Close.

RESULT
The default bracket grouping is changed in the selected layouts.

TIP

● There are further options for bracketing on the Brackets and Braces page, such as hiding/
showing brackets when there is only a single instrument in the bracket group and hiding/
showing braces when only a single staff is shown.

● You can also input custom bracket/brace grouping for specific staves, independently of the 
bracket grouping setting in the layout. However, you cannot change brackets/braces on 
blank staves.

RELATED LINKS
Barlines across staff groups on page 560
Hiding/Showing blank staves after final flows on page 375

Brackets according to ensemble type
In Dorico SE, default staff grouping is determined by the ensemble type chosen for each layout. 
This affects which staves are bracketed together and joined by barlines.

The following ensemble types are available on the Brackets and Braces page in Setup > Layout 
Options:

No brackets
All staves appear separately, with no brackets. Grand staff instruments are still shown 
with braces.

This is the default setting for full score layouts in projects started from Solo and small 
Jazz project templates.

Orchestral
Staves are bracketed according to their instrument family. For example, adjacent string 
instruments are bracketed together separately from adjacent woodwind instruments. 
However, vocal staves are not joined by barlines.

This is the default setting for all layouts in new projects and projects started from 
Orchestral, Choral and Vocal, and Concert band project templates, and for custom 
score and part layouts in projects started from all other project templates.

Small ensemble
All staves in the project are bracketed together, regardless of their instrument family, 
excluding braced staves.

This is the default setting for full score layouts in projects started from Chamber and 
Pit band project templates.

Wind band
Staves are bracketed according to their instrument type. For example, Flute 1 and Flute 
2 are bracketed together, but separately from the other woodwind instruments.

Big band
Staves are bracketed according to their instrument family, except for brass 
instruments, which are all bracketed according to their instrument type.
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Rhythm section instruments are bracketed together.

Percussion and timpani are bracketed together.

British brass band
Brass instruments are bracketed according to their instrument type, except for horns 
and trumpets, which are bracketed together.

Any other instruments in the score are bracketed according to their instrument family.

Percussion and timpani are bracketed separately.

This is the default setting for full score layouts in projects started from the Big band 
project template.

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves, such as 
the piano and other grand staff instruments, are excluded from brackets. They also split 
brackets if they are placed within a bracketed group.

● By default, there must be at least two adjacent instruments to show a bracket. You 
can choose to show brackets on single instruments in each layout independently on the 
Brackets and Braces page in Setup > Layout Options.

● Vocal staves are never joined by barlines, even when bracketed together.

● System objects are only shown above instrument families that are bracketed or braced 
together.

RELATED LINKS
Project template categories on page 55
System objects on page 913

Secondary brackets
Secondary brackets are a second level of staff grouping. They are positioned to the left of 
brackets and allow you to mark groups of staves within a bracketed group. In Dorico SE, 
secondary brackets can appear as a brace or as a sub-bracket.

By default, secondary brackets appear as sub-brackets: thin lines with square corners that extend 
beyond the bracket. You can change the appearance of secondary brackets and hide/show them 
for adjacent identical instruments in bracketed groups in each layout independently.

Secondary bracket as a sub-bracket Secondary bracket as a brace

Brackets and braces
Secondary brackets 
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NOTE

You cannot show sub-sub-brackets in addition to braces, you can only show sub-sub-brackets in 
addition to sub-brackets.

Hiding/Showing secondary brackets
You can hide/show secondary brackets for adjacent identical instruments in bracketed groups in 
each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show secondary brackets.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Brackets and Braces in the category list.

4. Choose one of the following options for Instruments of the same kind within a bracketed 
group:

● Use secondary brackets

● No secondary brackets

5. Click Apply, then Close.

RESULT
Secondary brackets are shown in the selected layouts when you choose Use secondary 
brackets, and hidden when you choose No secondary brackets.

Showing secondary brackets as sub-brackets/braces
Secondary brackets extend beyond brackets, allowing you to mark groups of staves within a 
bracketed group. You can show secondary brackets as either braces positioned outside the 
bracket or as sub-brackets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the appearance of 
secondary brackets.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Brackets and Braces in the category list.

4. Choose one of the following options for Secondary bracket appearance:

● Brace

● Sub-bracket

5. Click Apply, then Close.

Brackets and braces
Secondary brackets 
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RESULT
The appearance of all secondary brackets in the selected layouts is changed.

NOTE

Because you cannot show sub-sub-brackets in addition to braces, sub-sub-brackets are not 
shown in layouts where sub-brackets appear as braces.

Sub-sub-brackets
Sub-sub-brackets are a tertiary level of staff grouping with the same design as sub-brackets. They 
are positioned outside of both brackets and sub-brackets, allowing you to mark groups of staves 
within bracketed and sub-bracketed groups. Sub-sub-brackets can only appear as brackets in 
Dorico SE.

Sub-sub-brackets cannot extend beyond their sub-bracket and cannot be shown on staves with a 
brace as either the primary or secondary group.

Brackets and braces
Sub-sub-brackets 
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Chord symbols

Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

Chord symbols shown above slashes on the Clarinet and Piano staves to help the players improvise around 
the notated Cornet melody.

In Dorico SE, chord symbols exist globally at the corresponding rhythmic positions by default. 
This means that you only have to input chord symbols once, but they can appear above multiple 
or no staves as required. However, in some circumstances it is necessary to show different chord 
symbols for different players at the same rhythmic position. In such cases, you can input local 
chord symbols.

You can hide/show chord symbols project-wide above specific instrument staves, including if 
multiple instruments belong to the same player, and in different layouts. You can also show 
chord symbols only within chord symbol/slash regions and hide/show individual chord symbols.

If you have input chord symbols but no players in the current layout are set to show them, they 
are indicated by signposts.

Depending on the style of music, there are different conventions regarding how to present chord 
names.

Dorico SE provides a single default chord symbol appearance preset that applies to all chord 
symbols.

RELATED LINKS
Input methods for chord symbols on page 249
Hiding/Showing chord symbols on page 600
Chord diagrams on page 608
Hiding/Showing signposts on page 350
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Chord components
Chord symbols consist of a root and a quality, with intervals, alterations, and an altered bass note 
included if required.

Root
The root note of the chord, expressed either as a note name or as a specific degree of a 
scale.

Quality
Defines the type of chord, such as major, minor, diminished, augmented, half-
diminished, or with added note, such as six or nine.

Interval
Chord symbols can include one or more added intervals, such as a major seventh or 
ninth. Intervals in chord symbols are also known as “extensions”.

Alterations
Define notes in chords that are different to what is normally expected of that chord. 
For example, a sharpened fifth, flattened ninth, suspensions, or omissions.

Altered bass note
A chord symbol has an altered bass note if the lowest pitch of a chord is not its root 
note, such as Cm7♭5/E♭.

Transposing chord symbols
You can transpose chord symbols after you have input them, independently of any notes.

NOTE

Dorico SE automatically shows the appropriate chord symbols for transposing instruments in 
transposing layouts.

PROCEDURE

1. In Write mode, select the chord symbols you want to transpose.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings, for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Click OK to save your changes and close the dialog.

RESULT
The selected chord symbols are transposed.

RELATED LINKS
Transpose dialog on page 203

Chord symbols
Chord components 
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Concert vs. transposed pitch on page 127
Making layouts transposing/concert pitch on page 127
Respelling chord symbols on page 606

Hiding/Showing chord symbols
You can hide/show chord symbols above particular staves or only within chord symbol/slash 
regions project-wide on a per-player basis. By default, chord symbols appear above rhythm 
section instrument staves, such as keyboards, guitars, and bass guitars.

Any player on whose staff you input chord symbols is automatically set to show chord symbols 
for all instruments in the current layout.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show chord 
symbols.

2. Right-click the player and choose one of the following options from the context menu:

● To show chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Show for All Instruments.

● To show chord symbols only above rhythm section instrument staves held by the player, 
choose Chord Symbols > Show for Rhythm Section Instruments.

● To show chord symbols only in chord symbol/slash regions on instrument staves held by 
the player, choose Chord Symbols > Show in Chord Symbol and Slash Regions.

● To hide chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Hide for All Instruments.

RESULT
Chord symbols are hidden/shown above the corresponding instrument staves held by the 
selected player, depending on the layouts in which chord symbols are shown for that player 
in your project.

TIP

● You can choose to show chord symbols only once at the top of each system in each layout 
independently.

● You can also hide/show individual chord symbols in layouts where chord symbols are shown 
by selecting them and activating Hidden in the Chord Symbols group of the Properties 
panel. Signposts are shown at the position of each hidden chord symbol. However, signposts 
are not printed by default.

You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text objects, 
and time signatures.

RELATED LINKS
Inputting chord symbols on page 253
Chord symbol regions on page 601
Inputting chord symbol regions on page 256
Signposts on page 349
Hiding/Showing chord diagrams on page 609
Showing chord symbols above one/multiple staves on page 605

Chord symbols
Hiding/Showing chord symbols 
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Key Commands page in the Preferences dialog on page 47

Hiding/Showing chord symbols in layouts
You can hide/show chord symbols in different types of layouts. By default, chord symbols appear 
in all applicable layouts for rhythm section instruments.

NOTE

If chord symbols are hidden for all instruments in the current layout, signposts are shown above 
the top staff.

PROCEDURE

1. In Setup mode, select a player in the Players panel.

2. Right-click the player and choose one of the following options from the context menu:

● To show chord symbols for the selected player in all layouts, choose Chord Symbols > 
Show in Full Score and Parts.

● To show chord symbols for the selected player only in full score/custom score layouts 
and not in part layouts, choose Chord Symbols > Show in Full Score Only.

● To show chord symbols for the selected player only in part layouts and not in full score/
custom score layouts, choose Chord Symbols > Show in Parts Only

Hiding/Showing the root and quality of chord symbols
You can hide the root and quality of chord symbols if they follow another chord symbol with the 
same root and quality, but have a different altered bass note.

PROCEDURE

1. Select the chord symbols whose root and quality you want to hide.

2. In the Properties panel, activate Hide root and quality in the Chord Symbols group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The root and quality of the selected chord symbols are hidden when the checkbox is activated, 
and shown when the checkbox is deactivated.

Chord symbol regions
Chord symbol regions specify passages where you want to show chord symbols. They are 
particularly useful for players and layouts that do not need chord symbols for most of the project 
but have improvisation sections that require chord symbols to be shown.

Chord symbol regions allow you to show chord symbols only where players require them, instead 
of showing chord symbols throughout the project and manually hiding the ones you do not want 
to show.

When you input chord symbol regions in Dorico SE, the corresponding players are automatically 
set to show chord symbols in chord symbol/slash regions. This is because it is common to use 

Chord symbols
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both slashes and chord symbols to aid players in improvisation sections. Any chord symbols 
outside chord symbol/slash regions are automatically hidden and are indicated by signposts.

By default, chord symbol regions are highlighted with a solid colored line above the top staff line 
and a colored background. As you zoom out, the colored backgrounds become more opaque, 
which is especially useful when viewing full score layouts in galley view. These highlights are 
considered annotations, are not printed by default, and you can hide and show them.

Chord symbol region followed by chord symbol signposts after the end of the chord symbol region

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

Handles on a selected chord symbol region

RELATED LINKS
Inputting chord symbol regions on page 256
Hiding/Showing chord symbols on page 600
Slash regions on page 869
Hiding/Showing signposts on page 350
Annotations on page 537

Moving chord symbol regions
You can move chord symbol regions to different rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the chord symbol regions you want to move.

NOTE

When using the mouse, you can only move one chord symbol region at a time.

2. Move the chord symbol regions to the right/left in any of the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the chord symbol region to the right/left.

Chord symbols
Chord symbol regions 
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RESULT
The selected chord symbol regions are moved to new rhythmic positions according to the current 
rhythmic grid resolution.

NOTE

Only one chord symbol region can exist at each rhythmic position. If any part of a selected chord 
symbol region collides with any part of another chord symbol region as part of its move, the 
other chord symbol region is shortened to accommodate the one you moved.

You can undo this action and restore the previous length of the other chord symbol region. 
However, if you moved a chord symbol region using the mouse and it overwrote another chord 
symbol region completely, the other chord symbol region is permanently deleted.

Lengthening/Shortening chord symbol regions
You can lengthen/shorten chord symbol regions after they have been input.

PROCEDURE

1. In Write mode, select the chord symbol regions you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one chord symbol region at a time.

2. Lengthen/Shorten the chord symbol regions in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The selected chord symbol regions are lengthened/shortened.

NOTE

Only one chord symbol region can exist at each rhythmic position. If any part of a selected chord 
symbol region collides with any part of another chord symbol region when it is lengthened/
shortened, the other chord symbol region is shortened to accommodate this.

You can undo this action and restore the previous length of the other chord symbol region. 
However, if you lengthened/shortened a chord symbol region using the mouse and it overwrote 
another chord symbol region completely, the other chord symbol region is permanently deleted.

Chord symbols
Chord symbol regions 
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Hiding/Showing chord symbol region highlights
You can hide/show colored highlights for chord symbol regions at any time, for example, if you 
want to show the highlights when inputting music but hide them when engraving.

NOTE

This does not affect the solid line shown above the staff in chord symbol regions, which you 
cannot hide.

PROCEDURE

● Choose View > Highlight Chord Symbol Regions.

RESULT
Highlights in chord symbol regions are shown when a tick appears beside Highlight Chord 
Symbol Regions in the menu, and hidden when no tick appears.

Positions of chord symbols
In layouts where chord symbols are shown, they are positioned either above all instrument 
staves set to show chord symbols or only above the top staff in each system.

By default, chord symbols are centered horizontally on the middle of the front notehead in the 
first voice column at their rhythmic position.

NOTE

The front notehead is the notehead on the correct side of the stem at that rhythmic position.

Alignment of chord symbols relative to notes and chords

You can change whether chord symbol text is left-aligned above the notehead, center-aligned 
above the notehead, or right-aligned above the notehead, although right-aligned typically 
produces unclear results.

You can change the horizontal alignment of individual chord symbols by activating Alignment in 
the Chord Symbols group of the Properties panel and selecting an option from the menu.

Alignment of chord symbols across the system

Chord symbols are aligned at the same vertical position across the width of the system by 
default.

RELATED LINKS
Hiding/Showing chord symbols on page 600
Hiding/Showing chord symbols in layouts on page 601
Chord symbol regions on page 601

Chord symbols
Positions of chord symbols 

604
Dorico SE 3.5.12



Showing chord symbols above one/multiple staves
You can choose to show chord symbols above all instrument staves set to show chord symbols or 
only above the top staff in each system in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
chord symbols.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Chord Symbols and Diagrams in the category list.

4. In the Chord Symbols section, choose one of the following options for Show chord 
symbols:

● Above specific players’ staves

● Above top staff of system

5. Click Apply, then Close.

RESULT
The vertical position of chord symbols is changed in the selected layouts.

RELATED LINKS
Inputting chord symbols on page 253
Hiding/Showing chord symbols on page 600
Hiding/Showing chord symbols in layouts on page 601
Chord symbol regions on page 601

Moving chord symbols rhythmically
You can move chord symbols to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the chord symbols you want to move.

NOTE

When using the mouse, you can only move one chord symbol rhythmically at a time.

2. Move the chord symbols according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the chord symbol to the right/left.

RESULT
The selected chord symbols are moved to new rhythmic positions.

Chord symbols
Positions of chord symbols 
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NOTE

Only one chord symbol can exist at each rhythmic position. If a chord symbol passes over 
another chord symbol as part of its move, the existing chord symbol is deleted.

You can undo this action, but any chord symbols deleted in the process are only restored if you 
moved the chord symbol using the keyboard.

Respelling chord symbols
You can change the enharmonic spelling of chord symbols for transposing instruments, for 
example, to choose a simpler enharmonic equivalent spelling. This changes the enharmonic 
spelling of chord symbols in all transposing layouts and for all instruments with the same 
transposition.

PROCEDURE

1. In Write mode, open a layout with the transposition for which you want to respell chord 
symbols.

For example, to respell a chord symbol for all instruments in B♭, open the part layout for an 
instrument in B♭.

2. Select the chord symbol you want to respell.

3. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

4. Change the root name of the chord, but leave other details as they were, such as quality, 
interval, or alterations.

For example, change just the root of D♭maj13 from Db to C#.

RESULT
The spelling of the chord symbol is changed in transposing layouts for all instruments with the 
same transposition. For example, changing the spelling of a chord symbol for a Clarinet in B♭ also 
changes the spelling of that chord symbol in the part layout for a Trumpet in B♭.

RELATED LINKS
Chord symbols popover on page 249
Transposing chord symbols on page 599
Concert vs. transposed pitch on page 127
Making layouts transposing/concert pitch on page 127

Showing chord symbols as modes
You can show individual chord symbols as their modal equivalent if one exists for that chord 
symbol.

PROCEDURE

1. Select the chord symbols you want to show as a mode.

2. In the Properties panel, activate Show as mode in the Chord Symbols group.

3. Select the mode you want from the menu.

Chord symbols
Respelling chord symbols 
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RESULT
The selected chord symbols are respelled according to the selected mode. This does not affect 
the notes included in the chord symbols.

Resetting the enharmonic spelling of chord symbols
You can remove enharmonic spelling overrides for chord symbols you have respelled and 
return them to their default spelling. You can remove overrides for instruments with a single 
transposition only, such as instruments in B♭, or for all instrument transpositions.

PROCEDURE

1. In Write mode, select the chord symbol whose spelling you want to reset.

● If you want to reset the enharmonic spelling of the chord symbol for a single instrument 
transposition only, select the chord symbol on a staff belonging to an instrument with 
that transposition. For example, select it on the staff of any instrument in B♭ to reset the 
chord symbol for all instruments in B♭.

● If you want to reset the enharmonic spelling of the chord symbol for all instrument 
transpositions, select the chord symbol on any staff that belongs to a transposing 
instrument.

2. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

3. Reset the enharmonic spelling of the chord symbol in any of the following ways:

● To reset the enharmonic spelling of the chord symbol for instruments only with the 
selected transposition, enter Alt/Opt-S  into the chord symbols popover.

● To reset the enharmonic spelling of the chord symbol for all instrument transpositions, 
enter Shift-Alt/Opt-S  into the popover.

RESULT
The enharmonic spelling of the selected chord symbol in transposing layouts is reset, either just 
for instruments with the specified transposition or for all transposing instruments.

Chord symbols imported from MusicXML
Chord symbols are imported from MusicXML files. However, chords that specify Neapolitan, 
Italian, French, German, Pedal, Tristan, and Other values for the kind of element are ignored 
during import, as there is no information to specify what notes these chord symbols are meant 
to describe.

Chord symbols
Chord symbols imported from MusicXML 
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Chord diagrams

Chord diagrams represent the pattern of strings and frets on fretted instruments and use dots 
to indicate the stopped finger positions required to produce the corresponding chord. This 
demonstrates the specific shape of chords in a compact way and is useful if a particular voicing is 
required.

In Dorico SE, chord diagrams are part of chord symbols, meaning you can show them below 
chord symbols wherever they are shown. You can show chord diagram shapes for any fretted 
instrument, including different tunings and string arrangements, such as guitar DADGAD tuning. 
This can be different to the instrument above which they appear, for example, if you want to 
show chord diagram shapes for standard guitar tuning above the bass staff.

You can also show chord diagrams for all chord symbols used in a flow in a grid at the start of the 
flow, as is common in lead sheets for pop and rock music. You can show used chord diagrams 
grids independently of showing them alongside chord symbols in the music.

A sequence of chord symbols with chord diagrams for banjo

The positions of stopped frets relative to each other are known as “shapes” in Dorico SE. Any 
playable shape can be re-used for other chords whose pitches match the shape, including any 
new chord diagram shapes you have created. This includes shapes being available for other 
instruments, other tunings, and other positions along the fretboard, so long as any open strings 
included in the shape can be played with a barré at other fret positions.

A single chord can appear with different chord diagram shapes for different instruments and 
tunings, as their open string pitches and the number of strings they have varies.

RELATED LINKS
Chord symbols on page 598
Hiding/Showing chord diagrams on page 609
Hiding/Showing used chord diagrams grids on page 610
Creating new chord diagram shapes on page 613
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Chord diagram components
Chord diagrams use a combination of symbols, dots, and lines to convey the information about 
strings, fret positions, and finger positions that performers require to play the corresponding 
chord.

1 Omitted string

Indicates a string that must not sound.

2 Open string

Indicates a string that must sound but must be left open, that is, not stopped.

3 Dots

Indicate the fret positions where strings should be stopped, usually with left-hand fingers.

4 Barré

Indicates that multiple strings must be stopped with the same finger, usually pressed flat 
against the fretboard.

5 Starting fret number

Indicates the number of the highest fret in the chord diagram when this is not the first fret.

6 Nut

Represents the top of the fretboard, or “nut”, and appears in chord diagrams whose highest 
fret is the first fret.

RELATED LINKS
Changing the chord diagram shape on page 612

Hiding/Showing chord diagrams
You can hide/show chord diagrams for any type of fretted instrument alongside chord symbols. 
You can also change the fretted instrument or tuning for which chord diagrams are shown. 
However, you cannot show chord diagrams when chord symbols are hidden.

PREREQUISITE

● You have input the chord symbols for which you want to show chord diagrams.

● Chord symbols are shown above the staves where you want to show chord diagrams.

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

Chord diagrams
Chord diagram components 
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PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show chord 
diagrams.

2. Right-click the player and choose one of the following options from the context menu:

● To show chord diagrams, choose Chord Diagrams > [Fretted instrument and tuning]. 
For example, to show chord diagrams for a guitar in DADGAD tuning, choose Chord 
Diagrams > DADGAD guitar tuning.

● To hide chord diagrams, choose Chord Diagrams > No Chord Diagrams.

RESULT
Chord diagrams are shown alongside all chord symbols for the selected player, as appropriate 
for the selected fretted instrument and tuning. Dorico SE shows the simplest shape available for 
each chord, that is, shapes with the most open strings, easy barré positions, or finger positions 
closest to the nut.

If no chord diagram is available for a chord symbol, an empty chord diagram is shown.

TIP

You can edit empty chord diagrams to save a new chord diagram shape.

EXAMPLE

Chord symbols shown but chord diagrams hidden Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Inputting chord symbols on page 253
Hiding/Showing chord symbols on page 600
Edit Strings and Tuning dialog on page 116
Changing the open pitches of fretted instrument strings on page 118
Importing fretted instrument tunings on page 118

Hiding/Showing used chord diagrams grids
You can hide/show grids that contain all chord diagrams used in each flow in each layout 
independently. By default, used chord diagrams grids display standard guitar tuning chord 
diagrams but you can change this to show chord diagrams for any fretted instrument or tuning.

Used chord diagrams grids are commonly used in lead sheets for pop and rock music. They are 
typically shown instead of chord diagrams alongside chord symbols in the music to save vertical 
space and so they can appear at a larger scale size, making the details of each chord diagram 
easier to read.

Chord diagrams
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PREREQUISITE

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

● We recommend that you have input chord symbols and changed the shape of any chord 
symbols you want to appear with a specific voicing.

NOTE

It is customary not to show chord diagrams alongside chord symbols when showing a 
used chord diagrams grid, and you cannot change the chord diagram shape when chord 
diagrams are hidden.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show used chord diagrams 
grids at the start of flows.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Chord Symbols and Diagrams in the category list.

4. In the Chord Diagrams section, activate/deactivate Show chord diagrams used at start of 
flow.

5. Optional: Change the settings for used chord diagrams grids as required.

For example, you can change the fretted instrument tuning for chord diagrams in the grid, 
their scale size, and the distance between chord diagrams and/or rows of chord diagrams.

6. Click Apply, then Close.

RESULT
Chord diagrams for all chord symbols used in the flow are shown in a grid above the start of each 
flow in the selected layouts, and are positioned according to the settings for the selected layouts. 
If flow headings are shown, the used chord diagrams grid appears below them. The order of 
chord diagrams in the grid is determined by the order in which they first appear in the flow. Each 
different voicing appears as a separate chord diagram but each voicing appears only once in the 
grid.

If you input more chord symbols or change the voicing of existing chord diagrams, the used 
chord diagrams grids update automatically to include them.

NOTE

● Even if no chord symbols exist in a flow, vertical space for the used chord diagrams grid is 
added at the start of the flow.

● You cannot select or edit individual chord diagrams in used chord diagrams grids.

AFTER COMPLETING THIS TASK
You can change the margins of pages, music frames, and/or flow headings if required to 
accommodate used chord diagrams grids.

RELATED LINKS
Edit Strings and Tuning dialog on page 116
Changing the open pitches of fretted instrument strings on page 118

Chord diagrams
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Creating new chord diagram shapes on page 613
Changing page margins on page 369

Changing the chord diagram shape
You can change the chord diagram shape shown at individual rhythmic positions, for example, if 
you require a shape with a different voicing. Many chords have multiple playable shapes.

You can also apply your changes to all other instances of the same chord for instruments with 
compatible tunings.

PROCEDURE

1. Select the chord diagram whose shape you want to change.

NOTE

You can only change the shape of a single chord diagram at a time.

2. Change the shape in any of the following ways:

● To cycle through all the available shapes for the selected chord, press Alt/Opt-Q .

● To open the Choose Chord Diagram dialog and see all the available shapes for the 
selected chord at once, press Shift-Alt/Opt-Q .

3. Optional: In the Choose Chord Diagram dialog, select the shape you want to use.

TIP

If the shape you require is not available, you can click Edit, which allows you to create a new 
shape.

4. Click OK to save your changes and close the dialog.

5. Optional: To apply the new shape to other instances of the same chord for instruments 
with compatible tunings, choose Edit > Chord Diagrams > Copy Shape to Matching Chord 
Symbols. You can also choose this option from the context menu.

RESULT
The shape shown for the selected chord diagram is changed. This also updates all other chord 
diagrams using the same fretted instrument tuning at the same rhythmic position.

Choose Chord Diagram dialog
The Choose Chord Diagram dialog allows you to view all available chord diagram shapes for the 
selected chord and select the one you want to use.

● You can open the Choose Chord Diagram dialog in Write mode by selecting a chord 
diagram and pressing Shift-Alt/Opt-Q .

Chord diagrams
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The Choose Chord Diagram dialog comprises the following:

1 Available chord diagrams

Displays all the valid chord diagram shapes for the selected chord and allows you to select a 
different shape to show at the selected rhythmic position. Shapes you have created yourself 
appear in a different color.

2 Edit

Opens the Edit Chord Diagram dialog, which allows you to edit the shape of chord 
diagrams, including changing the number of frets shown, stopped fret positions, and the 
starting fret number.

Creating new chord diagram shapes
You can create new chord diagram shapes by editing an existing one, for example, if you want 
an alternative voicing for a chord or to show a barré. Your changes to existing chord diagram 
shapes are saved as a new shape, they do not overwrite the existing one.

NOTE

In Dorico SE, you cannot start new chord diagram shapes from scratch.

PROCEDURE

1. In Write mode, select the chord diagram whose shape you want to edit.

2. Press Shift-Alt/Opt-Q  to open the Choose Chord Diagram dialog.

3. Click Edit to open the Edit Chord Diagram dialog.

4. Edit the shape and settings of the chord diagram as required.

For example, you can change open strings to omitted strings or change the stopped fret 
position on strings to change the corresponding string pitch.

5. Optional: If you want the shape to be available for chords with different start fret positions, 
activate Chord may be moved along the neck.

6. Click Save, then Close.

Chord diagrams
Creating new chord diagram shapes 
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RESULT
The new shape is saved and is used for the selected chord diagram. The new shape also becomes 
available for any other chord for which it is valid.

Edit Chord Diagram dialog
The Edit Chord Diagram dialog allows you to edit the shape of individual chord diagrams, 
including changing the number of frets shown, stopped fret positions, and the starting fret 
number.

● You can open the Edit Chord Diagram dialog in Write mode by opening the Choose Chord 
Diagram dialog, selecting the chord diagram whose shape you want to edit, and clicking 
Edit.

The Edit Chord Diagram dialog contains the following options and sections:

1 Name

Displays the name of the chord whose chord diagram you are editing in the dialog. You 
cannot change this name.

2 Tuning

Displays the fretted instrument and tuning for the current chord diagram.

3 Chord may be moved along the neck

Allows you to specify whether or not the shape of the chord diagram can be reused at other 
fret positions, for example, by playing open strings with a barré at higher fret positions.

Chord diagrams
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4 Notes not in chord diagram

Displays any pitches that are part of the chord but not currently included in the chord 
diagram.

5 Open string pitch

Displays the open pitch of the corresponding string for reference.

6 Current string pitch

Displays the current pitch of the corresponding string if it is open or stopped. If the pitch of a 
string is not part of the chord, the string pitch appears red.

7 String status

Displays the current usage status of the corresponding string and allows you to switch the 
status of individual strings between open and omitted by clicking in this row.

● O: Open string

● X: Omitted string

● No symbol: Stopped string

8 Chord diagram shape editor

Displays the current arrangement of stopped frets using dots, and allows you to change 
the chord diagram shape and move the stopped fret positions by clicking at the required 
positions. Each string can only have a single stopped fret position.

If two or more strings are stopped at the same fret, you can hide/show a barré by clicking 
any of the dots at that fret position.

9 Action bar

Contains options that allow you to edit and change the number of frets.

● Starting fret: Changes the fret number of the highest fret in the chord diagram.

● Starting fret number offset: Changes the offset of the starting fret number, for 
example, if you want the starting fret label to appear beside the second fret down the 
chord diagram in order to include a barré.

● Add fret : Adds a fret to the bottom of the chord diagram.

● Remove fret : Removes a fret from the bottom of the chord diagram.

● Reset Chord Diagram : Removes your changes to the chord diagram and resets it to 
its default shape.

10 Save

Saves the chord diagram shape and updates the selected chord diagram in the music area. 
The shape also becomes available as an alternative shape for other compatible chords.

Chord diagrams
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Clefs

Clefs are the symbol at the start of every system that give the notes on the staff context; that is, 
the clef tells you which note of the scale applies to each line or space of the staff.

For example, the treble clef is also known as a “G clef”, because the spiral shape in the middle 
centers around G, normally the one above middle C.

The other common clefs are:

● The bass clef, or F clef, in which two dots are shown either side of the line corresponding to 
F, normally the F below middle C.

Middle C uses one ledger line below staves with treble clefs, and one ledger line above 
staves with bass clefs.

● The C clef, in which the center of the bracket to the right of the clef’s thick vertical line is 
positioned on the line that corresponds to C, normally middle C.

The C clef today is commonly used at two positions on the staff:

● On the middle line of the staff, commonly called the alto clef.

● On the line above the middle line of the staff, commonly called the tenor clef.

To minimize the number of ledger lines required, these clefs are used to match the register of 
the instrument for which they are used.

The E below middle C 
shown in a treble clef

The E below middle C 
shown in a bass clef

The E below middle C 
shown in a C (alto) clef

The E below middle C 
shown in a C (tenor) clef

RELATED LINKS
Input methods for clefs and octave lines on page 256
Clefs panel on page 258
Clefs with octave indicators on page 621
Hiding/Showing clefs according to layout transpositions on page 619
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General placement conventions for clefs
Clefs are placed at the start of every system, with a small gap between the start of the staff and 
the left edge of the clef. Their vertical placement must be precise, as this signifies which pitches 
are intended by the subsequent notes on the staff.

Clef changes that occur during a piece are usually smaller than the clefs shown at the start of 
each system. If clef changes occur at the start of a new system or page, a cautionary clef is 
shown at the end of the previous system to ensure the performer notices the change of clef.

Wherever possible, clef changes should not be positioned in the middle of tie chains. Changing 
the clef changes the position of the tied note on the staff, which could easily cause a performer 
to misread the tie as a slur and play two different notes. You can input clef changes in the middle 
of tie chains in Dorico SE, but we recommend that you position clef changes either before or 
after tie chains.

RELATED LINKS
Ties on page 938
Moving clefs rhythmically on page 617
Showing clefs after grace notes on page 618

Moving clefs rhythmically
You can move clefs to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the clefs you want to move.

NOTE

● You cannot select initial clefs at the start of flows or clefs shown automatically at the 
start of each system.

● When using the mouse, you can only move one clef rhythmically at a time.

2. Move the clefs according to the current rhythmic grid resolution in any of the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the clef to the right/left.

RESULT
The selected clefs are moved to new rhythmic positions. They take effect from their new 
positions until the next clef, or the end of the flow, whichever comes first.

NOTE

● You can only move clefs along staves. If you want to move a clef across staves, you must 
delete the clef and input a new clef on the other staff.

● Only one clef can exist at each rhythmic position, except for clefs that only apply to single 
staves. If a clef passes over another clef as part of its move, the existing clef is deleted.

You can undo this action, but any clefs deleted in the process are only restored if you moved 
the clef using the keyboard.

Clefs
General placement conventions for clefs 
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Showing clefs after grace notes
According to convention, clefs are positioned before grace notes so this is the default in Dorico 
SE. However, in some circumstances you might want to position clefs between grace notes and 
normal notes.

PROCEDURE

1. Select the clefs you want to show after grace notes.

2. Choose Edit > Clef Position > After Grace Notes. You can also choose this option from the 
context menu.

RESULT
The selected clefs are positioned between normal notes and grace notes.

NOTE

You can reset the position of clefs relative to grace notes by selecting the clefs whose position 
you want to reset and choosing Edit > Clef Position > Reset Clef Position. You can also choose 
this option from the context menu.

EXAMPLE

Treble clef before grace notes Treble clef after grace notes to align with bass clef

RELATED LINKS
General placement conventions for clefs on page 617

Deleting clefs
You can delete clefs without affecting the pitches of notes. Notes are automatically respelled 
according to the previous clef on the staff.

NOTE

You cannot delete initial clefs at the start of flows or clefs shown automatically at the start of 
each system. If you do not want any clef to appear on a staff, you can input an invisible clef.

PROCEDURE

1. In Write mode, select the clefs or signposts of clefs you want to delete.

2. Press Backspace or Delete .

Clefs
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RESULT
The selected clefs are deleted. Any music on the staff is respelled according to the previous clef, 
up until the next existing clef or the end of the flow.

RELATED LINKS
Input methods for clefs and octave lines on page 256

Setting different clefs for concert/transposed pitch
You can set clef changes to show a different clef in concert pitch layouts compared to transposed 
pitch layouts. For example, if you want a clef change on a Bass Clarinet staff to appear as a treble 
clef in the part layout but as a bass clef in the full score layout.

NOTE

● These steps only apply to clefs you have input, as you cannot select initial clefs or the clefs 
shown automatically at the start of each system.

● Many instruments in Dorico SE show different clefs in full score/custom score and part 
layouts by default. You can select the appropriate instrument type from the instrument 
picker when adding or changing instruments.

PROCEDURE

1. Select the clefs whose concert/transposed pitch versions you want to change.

2. Choose one of the following options:

● To change the concert pitch version of the selected clefs, choose Edit > Clef > Concert 
Pitch > [Clef].

● To change the transposed pitch version of the selected clefs, choose Edit > Clef > 
Transposed Pitch > [Clef].

TIP

You can also choose these options from the context menu.

RESULT
The clefs shown at the selected clef changes in layouts of the corresponding transposition are 
changed up to the next existing clef change or the end of the flow, whichever comes first.

AFTER COMPLETING THIS TASK
If you want to show the clefs in some layouts but hide them in others, you can hide/show clefs in 
layouts according to the layout transposition.

RELATED LINKS
Adding instruments to players on page 105
Changing instruments on page 107
Instrument picker on page 83
Changing the octave of clefs on page 620

Hiding/Showing clefs according to layout transpositions
You can show individual clefs only in layouts that are either concert or transposed pitch. For 
example, due to their transpositions, some instruments require clef changes in concert pitch 

Clefs
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scores to avoid excess ledger lines, but do not require those clef changes in their transposed 
pitch parts.

By default, all clefs appear in all layouts.

PROCEDURE

1. Select the clefs or signposts of clefs you want to hide/show according to the layout 
transposition.

2. In the Properties panel, activate Show for transposition in the Clefs group.

3. Choose one of the following options:

● Concert Pitch

● Transposing Pitch

RESULT
The selected clefs only appear in layouts with the corresponding transposition. In layouts where 
clefs are hidden, they are indicated by signposts.

Hidden clefs have no effect on note and staff spacing.

RELATED LINKS
Making layouts transposing/concert pitch on page 127
Signposts on page 349
Input methods for clefs and octave lines on page 256

Changing the octave of clefs
You can change the octave transposition of individual clefs, for example, to accommodate 
different horn and bass clarinet transposition conventions. You can change the octaves of clefs in 
concert pitch and transposed pitch layouts independently.

PREREQUISITE

● If you want to change the octave of initial clefs, you have input clefs at the start of each flow 
or overridden the default clefs in the required layouts.

● You have opened a layout with the required transposition in the music area. For example, 
if you want to change the octave of clefs in concert pitch, you have opened a concert pitch 
layout.

PROCEDURE

1. Select the clefs whose octave you want to change.

2. In the Properties panel, activate Octave shift in the Clefs group.

3. Change the value in the value field.

RESULT
The octave of the selected clefs is changed in all layouts with the same transposition. For 
example, 1 shifts clefs up one octave, and -1 shifts clefs down one octave.

The pitches of notes on the staves of the selected clefs are adjusted automatically. For example, 
if you shift a clef up one octave, notes after the clef appear an octave lower than they do without 
the octave shift.

Clefs
Changing the octave of clefs 

620
Dorico SE 3.5.12



RELATED LINKS
Concert vs. transposed pitch on page 127
Setting different clefs for concert/transposed pitch on page 619

Clefs with octave indicators
Clefs with octave indicators indicate that notes are played in a different register to the one 
notated. An octave indicator above the clef indicates that notes are played higher than notated, 
while an octave indicator below the clef indicates that notes are played lower than notated.

Of these clefs, only the treble clef 8 below is still commonly used for tenor vocal parts.

Traditionally, clef octave indicators were used as a reminder of transposing instruments; 
however, in more recent music, some composers use clef octave indicators as an alternative 
to octave lines for extended passages. Therefore, Dorico SE ignores clef octave indicators by 
default. However, transposing instruments are always transposed correctly automatically. For 
example, notes belonging to piccolo instruments are automatically notated an octave lower than 
their pitch in playback, regardless of whether they have a clef with an octave indicator.

RELATED LINKS
Transposing instruments on page 104
Concert vs. transposed pitch on page 127
Octave lines on page 622
Input methods for clefs and octave lines on page 256
Changing the octave of clefs on page 620

Clefs
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Octave lines

Octave lines indicate where notes are played higher/lower than they appear in the score or 
part. They are dashed or dotted horizontal lines with an italic numeral at the start. The numeral 
indicates the number of pitches by which the phrase is changed, such as 8 for one octave and 15 
for two octaves.

Octave lines that indicate notes are played higher than notated are placed above the staff, while 
octave lines that indicate notes are played lower than notated are placed below the staff.

A treble clef phrase notated at 
pitch

The treble clef phrase with an 
octave above line

The treble clef phrase with a two 
octaves above line

A bass clef phrase notated at pitch The bass clef phrase with an 
octave below line

The bass clef phrase with a two 
octaves below line

In Dorico SE, pitches are adjusted automatically when an octave line is present. You do not have 
to change the register of the notes within octave lines.

Octave lines should be horizontal, meaning they can take up significant vertical space, as octave 
lines are usually placed outside all other notations. However, they can be placed within slurs and 
tuplet brackets if the slur or tuplet bracket is longer than the octave line.

Octave lines can continue across system and page breaks. It is customary to show the numeral 
again at the start of each system as a reminder. Cautionary octave line numerals are usually 
parenthesized and the suffix is optional.

RELATED LINKS
Input methods for clefs and octave lines on page 256
Clefs with octave indicators on page 621
Lines on page 823
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Lengthening/Shortening octave lines
You can lengthen/shorten octave lines after they have been input.

PROCEDURE

1. In Write mode, select the octave lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one octave line at a time.

2. Lengthen/Shorten the selected octave lines in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To snap the end of a single octave line to the next notehead, press Ctrl/Cmd-Shift-Alt/
Opt-Right Arrow .

● To snap the end of a single octave line to the previous notehead, press Ctrl/Cmd-Shift-
Alt/Opt-Left Arrow .

NOTE

● You can only lengthen/shorten octave lines by the current rhythmic grid resolution 
when multiple octave lines are selected.

● When using the keyboard, lengthening/shortening octave lines only moves their 
end. You can move the start of octave lines by moving the whole line, or by clicking 
and dragging the start handle.

● Click and drag the circular handle at the start/end of a single octave line to noteheads to 
the right/left.

RESULT
Single octave lines are lengthened/shortened according to the current rhythmic grid resolution 
or to the next/previous notehead, whichever is closer.

Multiple octave lines are lengthened/shortened according to the current rhythmic grid 
resolution.

Positions of octave lines
By default, octave lines that indicate notes are played higher than written are placed above the 
staff, while octave lines that indicate notes are played lower than written are placed below the 
staff.

You can move octave lines to new rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Octave lines
Lengthening/Shortening octave lines 

623
Dorico SE 3.5.12



Moving octave lines rhythmically
You can move octave lines to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the octave lines you want to move.

NOTE

When using the mouse, you can only move one octave line rhythmically at a time.

2. Move the octave lines to the next or previous notehead on the staff, while maintaining their 
total durations, in any of the following ways:

● To move a single octave line to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single octave line to the previous notehead on the staff, press Alt/Opt-
Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple octave lines are selected, you can only move them according to the 
current rhythmic grid resolution.

● Click and drag the octave line to the right/left.

RESULT
The octave lines are moved to new rhythmic positions. The octave lines now apply to the notes at 
their new positions.

NOTE

● If a single octave line passes over another octave line as part of its move, the existing line 
is unaffected as multiple octave lines can exist at the same rhythmic position. However, 
if you move multiple octave lines together, existing octave lines are shortened or deleted 
according to where you move the selected ones.

● If you move octave lines to a rhythmic position that does not have a notehead, they do not 
appear in the music area. You must continue moving them to the right/left until you reach 
the next notehead for them to appear.

● Octave lines can only be moved along staves. If you want to move an octave line across 
staves, you must delete the octave line and input a new octave line on the other staff.

RELATED LINKS
Input methods for clefs and octave lines on page 256

Octave lines
Positions of octave lines 
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Changing the alignment of octave line numerals relative to notes
You can change whether the left edge, center, or right edge of individual octave line numerals 
is aligned with the first note to which each octave line applies. You can do this for the current 
layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to notes you want to change.

2. In the Properties panel, activate L alignment in the Octave Lines group.

3. Select one of the following options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you select 
Right, the right edge of the selected octave line numerals is aligned with the first noteheads to 
which the octave lines apply. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the position of octave line numerals relative to accidentals
You can change whether the numerals at the start of individual octave lines are positioned on 
noteheads or accidentals. You can do this for the current layout and frame chain only or for all 
layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to accidentals you want to change.

2. In the Properties panel, activate L position in the Octave Lines group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you 
choose Accidental, the octave line numerals are aligned with the accidental on the first 
noteheads to which the octave lines apply. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Octave lines
Positions of octave lines 
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Deleting octave lines
You can delete octave lines without deleting notes and other items.

PROCEDURE

1. In Write mode, select the octave lines you want to delete.

2. Press Backspace or Delete .

RESULT
The selected octave lines are deleted. Any notes to which the deleted octave lines previously 
applied are shown at either concert pitch or transposed pitch, depending on your current setting 
for the layout.

RELATED LINKS
Input methods for clefs and octave lines on page 256
Making layouts transposing/concert pitch on page 127

Octave lines
Deleting octave lines 
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Cues

Cues are passages of music shown in instrumental parts that are played by a different player, 
usually to help orientate players before entries or solos following a significant passage of rests.

Cues can also be used to assist with co-ordination or tuning between players, or to indicate 
material that the player might be asked to double.

A cue in a timpani part showing music from the bassoons

NOTE

In Dorico SE, you cannot input or edit cues. However, cues are shown if you import or open a 
project that contains them.
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Dynamics

Dynamics indicate the loudness of the music, and can be combined with other instructions to 
give the performer a detailed understanding of how to perform the music, while also leaving 
room for interpretation.

Dynamics can indicate an immediate change in volume or a gradual change over a specified 
duration. By default, they are placed below the staff for instruments and above the staff for 
voices.

A phrase with multiple different dynamics

You can add modifiers to dynamics that can give stylistic direction context alongside the 
volume level, such as  espressivo, which indicates that a passage is played loudly but also with 
expressive feeling.

While almost all expression text is written in italics, dynamics such as  and  use a bold italic 
font.

RELATED LINKS
Input methods for dynamics on page 243
Positions of dynamics on page 629
Gradual dynamics on page 641
Dynamic modifiers on page 639
Groups of dynamics on page 647
Linked dynamics on page 648
Dynamics lanes on page 429

Types of dynamics
Dorico SE categorizes dynamics into different groups according to their function.

Immediate dynamics
Immediate dynamics apply to the note to which they are attached until the next 
dynamic marking, and indicate an immediate change from any previous dynamic. 
Immediate dynamics include dynamic symbols, such as  or , and dynamic 
modifiers, such as subito or molto.

Gradual dynamics and hairpins
Gradual dynamics indicate a change in volume that happens incrementally over the 
specified duration. They usually appear either as hairpins or as text instructions, such 
as cresc. or dim..
Gradual dynamics can also have dynamic modifiers that qualify the change in volume, 
such as poco, molto, poco a poco, and niente.

628
Dorico SE 3.5.12



In Dorico SE, a hairpin can be shown as messa di voce, which shows a pair of hairpins. In 
some cases, this is easier than having separate lines for each half of the pair.

Force/Intensity of attack
These dynamics, such as  and , indicate that a note has a stronger attack than is 
usually expected for the dynamic, similar to an accent articulation.

Combined dynamics
Combined dynamics, such as  or –, specify a sudden change of dynamic.

You can create custom combined dynamics in Dorico SE, and control the intensity of 
each dynamic in the pair, in the Combined Dynamics section of the Dynamics panel. 
For example, you can make dynamics such as , –, and .

RELATED LINKS
Gradual dynamics on page 641
Niente hairpins on page 637
Dynamic modifiers on page 639
Hiding/Showing immediate dynamics on page 634
Changing the appearance/position of subito modifiers on page 640
Changing the appearance of sforzando/rinforzando dynamics on page 635
Hiding/Showing combined dynamic separators on page 634

Positions of dynamics
Dynamics are placed below the staff for instruments, where they can be read alongside the 
notes, and above the staff for voices. This way, they do not clash with lyrics placed below the 
staff, and are still close enough to the notes to be read simultaneously.

Immediate dynamics, such as  or , are centered on the notehead to which they apply. 
The beginnings of gradual dynamics are centered on the notehead from which they begin, or 
immediately after an immediate dynamic at the same position. The ends of gradual dynamics are 
centered on the notehead at which they end, or immediately before an immediate dynamic at 
the same position.

The staff-relative placement of dynamics varies, depending on their function and the type of 
player. For example, dynamics are placed below instrumental staves and above vocal staves by 
default. This ensures dynamics are kept as close to the staff as possible for legibility but are not 
placed between noteheads and lyrics on vocal staves. For grand staff instruments, such as piano 
or harp, dynamics are usually placed between the two staves, but can be placed both above and 
below when each staff requires separate dynamics.

In general, dynamics are not placed within the staff, as hairpins in particular become very hard 
to read. They are also not usually placed within tuplet brackets. Dynamics are placed outside of 
notations such as slurs, which must be kept close to noteheads, but inside pedal lines, which can 
be placed further from noteheads and still be clearly understood.

You can move dynamics to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

RELATED LINKS
Changing the staff-relative placement of items on page 343
Moving dynamics rhythmically on page 631

Dynamics
Positions of dynamics 
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Changing the horizontal beat-relative position of dynamics
You can position individual dynamics before or after the beat. You can do this for the current 
layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose position relative to the beat you want to change.

2. In the Properties panel, activate Beat-relative position in the Dynamics group.

3. Choose one of the following options:

● Before

● After

RESULT
The beat-relative position of the selected dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

A dynamic positioned before the beat A dynamic positioned after the beat

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the alignment of dynamics relative to noteheads
Immediate dynamics, such as  and , are usually horizontally aligned with the optical 
center of noteheads. However, you can change the horizontal alignment of immediate dynamics 
individually. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose alignment relative to noteheads you want to change.

2. In the Properties panel, activate Text alignment in the Dynamics group.

3. Choose one of the following options:

● Align optical center with notehead 

● Left-align with notehead 
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● Align optical center with left of notehead 

RESULT
The alignment of the selected immediate dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Moving dynamics rhythmically
You can move dynamics to new rhythmic positions after they have been input, including within 
tie chains.

NOTE

If you want to move a single dynamic within a group, you must click and drag it with the mouse. 
If you use the key commands, the whole group is moved.

PROCEDURE

1. In Write mode, select the dynamics you want to move.

NOTE

When using the mouse, you can only move one dynamic rhythmically at a time.

2. Move the dynamics in any of the following ways:

● To move a single dynamic to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single dynamic to the previous notehead on the staff, press Alt/Opt-
Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple dynamics are selected, you can only move them according to the current 
rhythmic grid resolution.

● Click and drag the dynamic to noteheads to the right/left.

RESULT
The selected dynamics are moved to new rhythmic positions.

NOTE

If a single dynamic passes over another dynamic as part of its move, the existing one is 
unaffected as multiple dynamics can exist at the same rhythmic position. However, if you move 
multiple dynamics together, any existing dynamics they pass over are deleted.

You can undo this action, but any dynamics deleted in the process are only restored if you moved 
dynamics using the keyboard.
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RELATED LINKS
Moving dynamic points on page 435
Lengthening/Shortening gradual dynamics and groups of dynamics on page 642

General placement conventions for hairpins relative to barlines
In Dorico SE, the ends of hairpins align with the left edge of the note to their right. This can 
include hairpins extending across barlines.

Hairpins that end on the first note of a bar extend across the preceding barline in the following 
cases:

● If there is no immediate dynamic on the first note in the next bar.

● If there is a time signature or key signature change at the barline that increases the gap 
between the end of the current bar and the first note in the new bar.

Dorico SE avoids hairpins overlapping barlines by a small amount, as this is less visually clear. 
However, this means that the same dynamic phrase on different staves can appear differently if 
one of the staves does not have a barline join extending below it.

The hairpin ends are not aligned because the barline does not extend beyond the bottom staff

You can allow/disallow hairpins across barlines if the hairpin ends on the first note in the next 
bar. Disallowing hairpins across barlines ensures hairpins appear the same length on all staves.

Allowing/Disallowing hairpins across barlines
You can allow/disallow hairpins across barlines when they end on the first note in the next bar, 
for example, so all hairpins appear the same length across multiple staves that do not all have 
barline joins. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins you want to allow/disallow across barlines.

2. In the Properties panel, activate Barline interaction in the Dynamics group.

3. Choose one of the following options:

● Stop before
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● Continue

RESULT
The selected hairpins are allowed across barlines when you choose Continue, and disallowed 
when you choose Stop before. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Showing dynamics in parentheses
You can show individual dynamics in parentheses, for example, to show editorial dynamics that 
were not in the original manuscript. You can do this for the current layout and frame chain only 
or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics you want to appear parenthesized.

2. In the Properties panel, activate Parenthesized in the Dynamics group.

RESULT
Each of the selected dynamics is shown in parentheses individually. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected dynamics.

Changing dynamic levels
You can change the levels of dynamics without reopening the dynamics popover and for multiple 
different dynamics simultaneously, for example, if you want to increase the dynamic level of all 
dynamics in a phrase.

PROCEDURE

1. In Write mode, select the dynamics whose dynamic level you want to change.

2. Change the dynamic level in one of the following ways:

● To increase the dynamic level, choose Edit > Dynamics > Increase Dynamic Intensity.

● To decrease the dynamic level, choose Edit > Dynamics > Decrease Dynamic Intensity.

TIP

You can also choose these options from the context menu.

RESULT
The dynamic level of the selected dynamics is increased/decreased. For example, increasing the 
dynamic level of a  dynamic changes it to .
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TIP

You can assign key commands for these options on the Key Commands page in Preferences.

RELATED LINKS
Input methods for dynamics on page 243
Moving dynamic points on page 435
Changing existing items on page 342
Dynamic modifiers on page 639
Key Commands page in the Preferences dialog on page 47

Hiding/Showing immediate dynamics
You can hide/show individual immediate dynamics such as  and , for example, if you 
only want to show the dynamic modifier, such as “sim.”, without its accompanying immediate 
dynamic. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the immediate dynamics you want to hide, or the signposts of immediate dynamics 
you want to show.

2. In the Properties panel, activate/deactivate Hide intensity marking in the Dynamics group.

RESULT
The selected immediate dynamics are hidden when Hide intensity marking is activated, and 
shown when it is deactivated. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

If no other dynamic exists at their rhythmic position, they are indicated by signposts. However, 
signposts are not printed by default.

RELATED LINKS
Dynamic modifiers on page 639
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Signposts on page 349
Annotations on page 537

Hiding/Showing combined dynamic separators
You can hide/show different separators in combined dynamics individually, independently of 
your project-wide setting. For example, if you want to separate some  dynamics with slashes. 
You can do this for the current layout and frame chain only or for all layouts and frame chains.

By default, only combined dynamics with at least one mezzo dynamic in the pair, such as -, 
show a separator.

PREREQUISITE
You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the combined dynamics whose separator you want to hide/show.

2. In the Properties panel, activate Separator shown in the Dynamics group.

3. Activate/Deactivate the corresponding checkbox.

4. Optional: If you showed separators, activate Separator and select one of the following 
options from the menu:

● Hyphen

● Colon

● Space

● Slash

RESULT
Separators are shown when the Separator shown checkbox is activated, and hidden when it is 
deactivated. The separator shown follows your selection for Separator. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of dynamics on page 628

Changing the appearance of sforzando/rinforzando 
dynamics

You can change the appearance of individual  and  dynamics. For example, if you want some 
 dynamics to appear as . You can do this for the current layout and frame chain only or for 
all layouts and frame chains.

NOTE

These steps do not apply to force/intensity of attack dynamics with other intensities, such as .

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the  and/or  dynamics whose appearance you want to change.

2. In the Properties panel, activate rfz/sfz style in the Dynamics group.

3. Choose one of the following options:

●  
●  

RESULT
The appearance of the selected  and/or  dynamics is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of dynamics on page 628
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Changing the appearance/position of subito modifiers on page 640

Copying dynamics
You can copy dynamics to other rhythmic positions after they have been input. You can select 
dynamics on a single staff to copy to another single staff, or you can select dynamics across 
multiple staves to copy across the same number of staves.

PROCEDURE

1. In Write mode, select the dynamics you want to copy.

TIP

If you want to copy many dynamics or, for example, just gradual dynamics, you can use a 
filter.

2. Press Ctrl/Cmd-C  to copy the dynamics.

3. Select the notehead at the rhythmic position to which you want to copy the dynamics.

4. Press Ctrl/Cmd-V  to paste the dynamics.

RESULT
The selected dynamics are pasted to new rhythmic positions. If you copied dynamics to other 
staves at the same rhythmic position as the original dynamics, the dynamics on all staves are 
automatically linked.

If you selected multiple dynamics at different rhythmic positions, their new positions reflect their 
original rhythmic spacing.

TIP

● You can also copy dynamics without adding them to your clipboard by selecting them and 
Alt/Opt -clicking each notehead to which you want to copy the selected dynamics.

● If you want to copy dynamic phrases immediately after where they were originally input, you 
can select them and press R . If you select a single immediate dynamic, it is copied to the 
same position.

RELATED LINKS
Linked dynamics on page 648
Filters on page 340

Deleting dynamics
You can delete dynamics from your project. If you delete some but not all dynamics from a group 
that is linked to dynamics on other staves, all equivalent linked dynamics are also deleted.

PROCEDURE

1. In Write mode, select the dynamics you want to delete.

2. Press Backspace or Delete .

Dynamics
Copying dynamics 

636
Dorico SE 3.5.12



RESULT
The selected dynamics are deleted. If you delete immediate dynamics immediately before/after 
hairpins, the length of hairpins can adjust automatically, depending on the context.

NOTE

Deleting dynamics that are linked to other staves can cause the selected dynamics to be deleted 
from all linked staves as well. If you do not select and delete all dynamics in the group, the 
selected dynamics are also deleted from all linked staves. However, if you select and delete the 
whole group of dynamics from a single staff, those dynamics are not deleted from other staves.

RELATED LINKS
Groups of dynamics on page 647
Linked dynamics on page 648

Voice-specific dynamics
Voice-specific dynamics only apply to a single voice on a staff, which allows you to specify 
different dynamics for each voice in multiple-voice contexts or for the separate staves of grand 
staff instruments. By default, dynamics apply to all voices on all staves belonging to a single 
instrument, including grand staff instruments.

Inputting voice-specific dynamics allows you to show different dynamics for multiple voices on a 
staff, or to highlight an inner melody voice in a piano part. Voice-specific dynamics change the 
dynamics of each voice in playback independently.

NOTE

● You can only input voice-specific dynamics when the caret is active, such as during note 
input. Voice-specific dynamics apply to the voice indicated by the quarter note symbol beside 
the caret.

● Voice-specific dynamics only affect playback automatically for sounds that use velocity to 
control dynamics. When using playback devices that control dynamics in other ways, such as 
with CC, you must enable independent voice playback to hear different dynamics in different 
voices for the same instrument.

RELATED LINKS
Input methods for dynamics on page 243
Enabling independent voice playback on page 460
Dynamics lanes on page 429
Extra staves on page 910

Niente hairpins
Niente markings at the start/end of gradual dynamics indicate that the dynamic either increases 
from, or decreases to, silence.

This effect works very well on strings and singers with vowels, but it cannot always be played 
literally. For example, singers with words beginning with consonants cannot begin from silence, 
nor can reed and brass instruments, as they have to achieve a certain air pressure before a note 
sounds.

Niente markings can be shown in two ways: as a circle at the end of a hairpin, and as text directly 
before or after a hairpin. You can input both types of niente markings in Dorico SE using the 
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dynamics popover and by clicking niente in the Gradual Dynamics section of the Dynamics 
panel.

TIP

You can turn existing hairpins into niente hairpins by selecting them and clicking niente in the 
Gradual Dynamics section of the Dynamics panel, or by activating Niente in the Dynamics 
group of the Properties panel.

EXAMPLE

A niente shown as Circle on hairpin A niente shown as Text

RELATED LINKS
Input methods for dynamics on page 243
Lengthening/Shortening gradual dynamics and groups of dynamics on page 642

Changing the appearance of niente hairpins
You can show niente hairpins in two ways in Dorico SE, and you can change how they appear 
individually. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose niente style you want to change.

2. In the Properties panel, activate Niente style in the Dynamics group.

3. Choose one of the following options:

● Circle on hairpin 

● Text 

RESULT
The niente style of the selected hairpins is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

EXAMPLE

A niente shown as Circle on hairpin A niente shown as Text

RELATED LINKS
Changing the property scope on page 149
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Copying property settings to other layouts/frame chains on page 395

Dynamic modifiers
Modifiers add further detail to dynamics than simply their volume level, and can help guide how 
a player performs a note or phrase. Modifiers include poco a poco, molto and subito. They are also 
known as “expressive text”.

In Dorico SE, modifiers must accompany a dynamic level, such as  or .

You can input dynamic modifiers by entering them into the dynamics popover alongside an 
immediate dynamic or by clicking available options in the Dynamics panel. You can also add 
dynamic modifiers to existing dynamics.

TIP

You can hide immediate dynamics if you only want to show the modifier.

RELATED LINKS
Input methods for dynamics on page 243
Hiding/Showing immediate dynamics on page 634
Adding poco a poco text to gradual dynamics on page 644
Changing the appearance/position of subito modifiers on page 640
Showing modifiers centered inside hairpins on page 640
Changing the appearance of sforzando/rinforzando dynamics on page 635

Adding modifiers to existing dynamics
You can add modifiers both before and after dynamics after they have been input, for example, if 
you want to add “sim.” instead of repeating dynamics across multiple phrases.

PROCEDURE

1. Select the dynamics to which you want to add modifiers.

2. In the Properties panel, activate the following properties, individually or together, in the 
Dynamics group:

● To add modifiers before dynamics, activate Prefix.

● To add modifiers after dynamics, activate Suffix.

3. Enter the text you want to add into the corresponding value field.

4. Press Return .

RESULT
The text you entered is added to the selected dynamics as a modifier. Text entered into the 
Prefix field appears before dynamics, while text entered into the Suffix field appears after 
dynamics. Modifiers appear below hairpins placed below the staff and above hairpins placed 
above the staff, and are aligned with the start of the hairpin.

Deactivating the properties removes the corresponding modifiers from the selected dynamics.

NOTE

Deactivating properties permanently deletes any custom text entered.
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AFTER COMPLETING THIS TASK
If you added modifiers to hairpins, you can show them centered inside the hairpins.

RELATED LINKS
Niente hairpins on page 637
Input methods for dynamics on page 243
Showing modifiers centered inside hairpins on page 640
Adding poco a poco text to gradual dynamics on page 644

Changing the appearance/position of subito modifiers
You can change the appearance and/or position of individual subito modifiers. For example, if 
you want to show subito modifiers as sub. on the left of dynamics or  sub. dynamics as . You 
can do this for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose subito modifier appearance and/or position you want to change.

2. In the Properties panel, activate Subito style in the Dynamics group and choose one of the 
following options:

● subito

● sub.

3. Optional: If you selected dynamics that include at least one , activate Subito forte style and 
choose one of the following options:

● sub. 
● 

4. Activate Subito position and choose one of the following options:

● Left

● Right

RESULT
The appearance and/or position of the selected subito modifiers is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the appearance of sforzando/rinforzando dynamics on page 635
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Showing modifiers centered inside hairpins
You can show modifiers you have added to hairpins, such as poco a poco or molto, centered both 
horizontally and vertically inside hairpins. You can do this for the current layout and frame chain 
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only or for all layouts and frame chains. By default, modifiers appear at the start of and either 
above or below hairpins.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose modifiers you want to show centered inside hairpins.

2. In the Properties panel, activate Modifier position in the Dynamics group.

3. Choose one of the following options:

● Above or Below

● Inside

RESULT
Modifiers on the selected hairpins appear centered inside the hairpins. They automatically erase 
their background so the text does not collide with the hairpin lines. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Modifier (molto) below a hairpin Modifier (molto) centered inside hairpin

RELATED LINKS
Adding modifiers to existing dynamics on page 639
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Gradual dynamics
Gradual dynamics indicate a change in volume that happens incrementally over the specified 
duration. They usually appear either as hairpins or as text instructions, such as cresc. or dim..

A pair of hairpins without an immediate dynamic in the middle is known as a messa di voce.

In Dorico SE, gradual dynamics appear as hairpins by default. You can change the appearance 
of individual gradual dynamics. For example, if you want to show a particularly long crescendo 
using cresc. text rather than a hairpin.

You can show gradual dynamic text in the following ways:

● cresc. or dim.: Abbreviated text with no continuation line

● cresc... or dim...: Abbreviated text with a dotted continuation line

● cre-scen-do or di-mi-nuen-do: The full word spread out across the duration of the gradual 
dynamic
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RELATED LINKS
Input methods for dynamics on page 243
Types of dynamics on page 628
Changing the appearance of gradual dynamics on page 643
General placement conventions for hairpins relative to barlines on page 632

Lengthening/Shortening gradual dynamics and groups of dynamics
You can change the length of gradual dynamics and groups of dynamics after they have been 
input.

NOTE

You can only lengthen/shorten one gradual dynamic or group of dynamics at a time.

PROCEDURE

1. In Write mode, select one of the following that you want to lengthen/shorten:

● A single gradual dynamic

● A single gradual dynamic in a group of dynamics

2. Lengthen/Shorten the gradual dynamic or groups of dynamics in any of the following ways:

● To lengthen them by the current rhythmic grid resolution or to the next notehead, 
whichever is closer, press Shift-Alt/Opt-Right Arrow .

● To shorten them by the current rhythmic grid resolution or to the previous notehead, 
whichever is closer, press Shift-Alt/Opt-Left Arrow .

● To lengthen them to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To shorten them to the previous notehead, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

When using the keyboard, lengthening/shortening dynamics only moves their end. You 
can move the start of dynamics by moving the whole dynamic, or by clicking and 
dragging the start handle.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Individual gradual dynamics are lengthened/shortened either according to the current rhythmic 
grid resolution or to next/previous noteheads.

Dynamic groups are lengthened/shortened proportionally by lengthening/shortening the 
gradual dynamics and moving any other type of dynamic in the group. This retains the relative 
durations of the gradual dynamics in the group.

In the example, the  at the end moves two quarter notes to the right, but the  in the middle 
only moves one quarter note to the right. This keeps the lengths of the gradual dynamics equal.
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EXAMPLE

Original dynamic phrase Lengthened dynamic phrase

RELATED LINKS
Groups of dynamics on page 647
Moving dynamics rhythmically on page 631
Ungrouping dynamics and removing dynamics from groups on page 648

Changing the appearance of gradual dynamics
You can change the appearance of individual gradual dynamics, for example, to change a 
crescendo hairpin to a messa di voce pair of hairpins with two directions or to show a particularly 
long crescendo using “cresc.” text rather than a hairpin. You can do this for the current layout 
and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the gradual dynamics whose appearance you want to change.

2. In the Properties panel, activate Gradual style in the Dynamics group.

3. Select one of the following options from the menu:

● Hairpin

● cresc./dim.

● cresc...

● cre - scen - do

4. Optional: Customize the appearance of the selected gradual dynamics in one of the following 
ways, depending on their Gradual style:

● If you selected Hairpin, activate Hairpin line style and choose one of the available 
options.

● If you selected cresc./dim., cresc..., or cre - scen - do, activate Diminuendo style and 
select one of the available options from the menu.

● If you selected cresc..., activate Continuation line style and choose one of the available 
options.

5. Optional: For hairpin gradual dynamics, choose one of the following options for Type:

● Cresc. or dim.

● Messa di voce

RESULT
The appearance of the selected gradual dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.
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EXAMPLE

Hairpin cresc./dim. cresc…. cre - scen - do

Hiding/Showing flared ends on hairpins
Flared ends are usually shown at the end of crescendo hairpins and indicate a sudden burst in 
volume at the end of the crescendo. You can hide/show flared ends on any hairpin.

NOTE

You can only show flared ends on hairpins with solid lines.

PROCEDURE

1. Select the hairpins on which you want to hide/show flared ends.

2. In the Properties panel, activate/deactivate Flared end in the Dynamics group.

RESULT
A flared end is shown on the selected dynamics when Flared end is activated, and hidden when 
it is deactivated.

EXAMPLE

Crescendo hairpin with flared end hidden Crescendo hairpin with flared end shown

Adding poco a poco text to gradual dynamics
You can add poco a poco text to individual gradual dynamics after they have been input.

PROCEDURE

1. Select the gradual dynamics to which you want to add poco a poco.

2. In the Properties panel, activate Poco a poco (little by little) in the Dynamics group.

RESULT
Poco a poco is shown immediately after gradual dynamic text, below hairpins placed below the 
staff, and above hairpins placed above the staff.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
dynamics.
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EXAMPLE

Text gradual dynamic with poco a poco Hairpin gradual dynamic with poco a poco

AFTER COMPLETING THIS TASK
You can show poco a poco text centered inside hairpins.

RELATED LINKS
Dynamic modifiers on page 639
Showing modifiers centered inside hairpins on page 640

Gradual dynamic spacing
Dorico SE ensures that hairpins can always be clearly distinguished by giving hairpins a minimum 
default length. However, this can affect note spacing.

The default minimum hairpin length is three spaces. When hairpins are shorter than this, they 
can sometimes be confused with the accent articulation mark. Therefore, if you add a hairpin 
to a note which would make the hairpin less than three spaces long, the spacing of the note is 
changed to ensure the hairpin meets the minimum length.

Gradual dynamics that start/end partway through notes
If the start/end of a gradual dynamic is not attached to a note, there are restrictions on how you 
can move the start/end position.

For example, if you enter two hairpins separated by a space into the dynamics popover, pair 
of hairpins that looks like a messa di voce is created but containing two separate hairpins, 
rather than the combined option. Neither of the open ends of the hairpins is attached to a 
specific notehead, and you cannot move the center of the pair of hairpins rhythmically. You can 
lengthen/shorten the two hairpins as a group but you cannot lengthen/shorten each hairpin 
individually.

However, if you enter two hairpins without a space between them into the dynamics popover, 
you can move the center of the pair of hairpins and each hairpin rhythmically, but only to 
noteheads. You can lengthen/shorten each hairpin separately according to the current rhythmic 
grid resolution.

RELATED LINKS
Lengthening/Shortening gradual dynamics and groups of dynamics on page 642
Note spacing on page 406
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Gradual dynamics truncated by immediate dynamics
A hairpin is automatically truncated if an immediate dynamic is positioned within its range, either 
before or after the hairpin is input.

The hairpin remains tied to its originally designated rhythmic positions, even if graphically it 
appears shorter. This means that if the immediate dynamic that truncated it is ever deleted, the 
hairpin extends up to its end or the next immediate dynamic within its range.

The examples demonstrate a crescendo hairpin that is truncated by two dynamics, but the 
hairpin extends to its total length as they are deleted. The dotted attachment line shows the link 
between the hairpin and the rhythmic position to which its end is attached.

A long hairpin truncated by a  After deleting the , the hairpin is 
now truncated by the 

Deleting both immediate 
dynamics allows the hairpin to 
extend to its full length

RELATED LINKS
Lengthening/Shortening gradual dynamics and groups of dynamics on page 642

Sustaining and non-sustaining instruments
The volume settings for sustaining instruments and non-sustaining instruments vary in terms of 
their control of gradual dynamics.

Sustaining instruments
Sustaining instruments include string, wind, and brass instruments, because they can 
hold a note while being in control of its volume throughout.

Dorico SE applies gradual dynamics to these instruments in playback. You can control 
settings for each software instrument in the Expression Maps dialog.

Non-sustaining instruments
Non-sustaining instruments, such as piano, harp, marimba, and most percussion 
instruments, have no further control of the dynamic of notes after they have been 
struck. For this reason, non-sustaining software instruments often use note velocity for 
dynamics, because this is set at the start of the note.

TIP

You can control settings for each software instrument in the Expression Maps dialog.

RELATED LINKS
Expression Maps dialog on page 489
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Groups of dynamics
Groups of dynamics are automatically aligned in a row and can be moved and edited as a group. 
When you move immediate dynamics within a group, the length of the hairpins on either side 
automatically adjust to compensate.

A group of dynamics The same group of dynamics adjusts to compensate 
when the middle dynamic moves rhythmically.

A single dynamic, either immediate or gradual, is considered a group on its own.

Two or more dynamics are automatically grouped together if they immediately follow each 
other horizontally on the staff, were input together or in sequence, and have gradual dynamics 
between the immediate dynamics.

All of the dynamics in a group are highlighted when any of the dynamics in the group are 
selected.

NOTE

● Groups of dynamics apply project-wide, meaning you cannot have dynamics grouped one 
way in some layouts but differently in other layouts.

● As well as horizontal groups of dynamics, you can also link groups of dynamics vertically if 
you want the same dynamics to appear on multiple staves. This can be useful when multiple 
instruments play the same dynamics simultaneously and you want to make the same change 
in all staves, for example, moving the peak of a crescendo to a later beat, or changing a  to 
a .

RELATED LINKS
Linked dynamics on page 648

Grouping dynamics together
You can manually group dynamics together that were not automatically grouped when they were 
input. Grouped dynamics are automatically aligned in a row and can be moved and edited as a 
group.

PROCEDURE

1. In Write mode, select the dynamics you want to group together.

2. Choose Edit > Dynamics > Group Dynamics. You can also choose this option from the 
context menu.
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RESULT
The selected dynamics are grouped together. If the first dynamic in the group is linked to other 
staves, all dynamics in the group are added to those staves. This applies to all layouts in which 
the dynamics appear.

RELATED LINKS
Linked dynamics on page 648

Ungrouping dynamics and removing dynamics from groups
You can ungroup dynamics so that all dynamics in the group become ungrouped. You can also 
remove only selected dynamics from groups while leaving other dynamics in the group.

This applies to all layouts in which the dynamics appear.

PROCEDURE

1. In Write mode, select the dynamics you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all dynamics in the selected groups, choose Edit > Dynamics > Ungroup 
Dynamics.

● To remove only the selected dynamics from their groups, choose Edit > Dynamics > 
Remove from Group.

TIP

You can also choose these options from the context menu.

Linked dynamics
Identical dynamics at the same rhythmic position on multiple staves can be linked together. This 
happens automatically when you copy and paste dynamics between staves.

If you select one dynamic in a linked group, all other dynamics in the linked group appear 
highlighted. If one linked dynamic is moved to a new rhythmic position, all linked dynamics 
move.

Two linked dynamics with only the top dynamic 
selected

Moving just the top dynamic of the linked group 
automatically moves the other to match its new 
position.

Similarly, if you change one linked dynamic, for example, from  to , all dynamics linked to the 
changed dynamic are also changed. If you group other dynamics to one of the linked dynamics, 
such as a hairpin, the hairpin is added at the same position in all linked staves.
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If one staff has another immediate dynamic before the end of a hairpin, the hairpin is truncated 
automatically. If you delete such a dynamic, the hairpin extends automatically up to the next 
immediate dynamic or to its full length, whichever comes first.

Two staves with linked dynamics, but the lower staff 
has another immediate dynamic that truncates the 
hairpin.

Deleting the mf at the end of the first bar in the 
second staff causes the hairpin to extend to match 
the range of the top staff.

NOTE

● If you delete only some dynamics from a group that is linked to other staves, those dynamics 
are also deleted from the linked staves. If you delete a whole dynamic group from one staff, 
this does not affect linked dynamics on other staves.

● As well as vertically linked dynamics, you can also group dynamics horizontally. This 
automatically aligns the dynamics in a row and allows them to be moved and edited as a 
group.

● Linking or unlinking dynamics applies project-wide, meaning you cannot have dynamics 
linked one way in some layouts but differently in other layouts.

RELATED LINKS
Groups of dynamics on page 647
Linked slurs on page 899
Disabling automatic linking of dynamics and slurs when pasting on page 342

Linking dynamics together
When you copy and paste identical dynamics to the same rhythmic position on other staves, 
those dynamics are linked together automatically. You can also manually link dynamics and 
groups of dynamics together that are not automatically linked to allow simultaneous editing.

NOTE

Groups of dynamics must be the same in order to link them together. For example, you can link 
two  dynamics together if neither is part of a group, but you cannot link them together if one is 
grouped with a hairpin.

PROCEDURE

1. In Write mode, select the dynamics you want to link together.

2. Choose Edit > Dynamics > Link. You can also choose this option from the context menu.

RESULT
The selected dynamics are linked together. If you later change one of the linked dynamics, all 
linked dynamics are changed to match. This applies to all layouts in which the dynamics appear.
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RELATED LINKS
Copying dynamics on page 636

Unlinking dynamics
You can unlink dynamics, including dynamics that were linked automatically.

PROCEDURE

1. In Write mode, select a dynamic in each linked group that you want to unlink.

2. Choose Edit > Dynamics > Unlink. You can also choose this option from the context menu.

RESULT
All dynamics in the linked groups are unlinked. This applies to all layouts in which the dynamics 
appear.

RELATED LINKS
Disabling automatic linking of dynamics and slurs when pasting on page 342

VST Expression Maps for volume types
If you are using a third-party sound library, you may need to change or edit the expression map 
to make instruments respond to gradual dynamics. Otherwise, the sound library uses velocity by 
default.

The setup of the expression map for dynamics depends on how the instrument is configured. 
Consult the documentation for the sound library for further information.

Dorico SE provides the following default expression maps:

● CC11 Dynamics for dynamics produced by changing MIDI channel expression

● Modulation Wheel Dynamics for dynamics produced by changing MIDI controller 1

TIP

You can edit expression maps in the Expression Maps dialog.

Dynamics
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Figured bass

Figured bass is a shorthand that uses figures to specify the harmony above the notated bass 
notes. It is particularly common in Baroque and early Classical music and in the parts of 
accompanying instruments, such as harpsichords and viols.

Figured bass informs performers about the intended harmony but allows room for 
interpretation, such as improvised arpeggiated phrases using notes from the chord.

Figures use a combination of Arabic numbers, accidentals, and horizontal hold lines to specify 
both the intervals above the bass note that make up the chord and its duration. For example, 
they show where suspensions resolve or when the bass note changes but the chord remains the 
same.

A basso continuo part with figured bass below the staff

In Dorico SE, figured bass exists globally at the corresponding rhythmic positions by default 
because most music that includes figured bass is tonal, meaning players perform notes from the 
same chord. Therefore, you only have to input figures once, but they can appear above multiple 
or no staves as required and the figures automatically update according to the notes on each 
staff. However, in some circumstances it is necessary to specify different chords for different 
players at the same rhythmic position. In such cases, you can input local figured bass.

Dorico SE calculates and saves the pitches implied by the figures you enter in relation to the 
lowest note at that rhythmic position. This semantic understanding of the harmony implied by 
figures allows Dorico SE to update the displayed figures on different staves and if you transpose 
or change the pitch of notes.

When you transpose music that includes figured bass, Dorico SE also transposes the figures 
accordingly.

Figured bass in Dorico SE uses a bold roman font by default.

You can hide or show figured bass in each layout independently and only above the staves of 
specific players. You can also change whether figured bass appears above or below staves by 
default in each layout independently. Figures appear as signposts if Dorico SE either does not 
normally show them, such as third intervals, or cannot identify the bass note for them, such as 
on a rest.

NOTE

Figured bass does not yet include notations commonly used for harmonic analysis, such as 
Roman numerals. This is planned for future versions.

RELATED LINKS
Inputting figured bass on page 313
Hiding/Showing figured bass in layouts on page 652
Showing figured bass on rests on page 653
Changing the staff-relative placement of figured bass on page 656
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Appearance of figured bass on page 657

Hiding/Showing figured bass in layouts
You can hide/show figured bass in each layout independently and only above the staves of 
specific players. For example, you can show figured bass in the full score and bass part layouts 
but hide figured bass in the other part layouts.

Any player on whose staff you input figured bass is automatically set to show figured bass in the 
current layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show figured bass.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Figured Bass section, activate/deactivate each player above/below which you want to 
show figured bass.

5. Click Apply, then Close.

RESULT
Figured bass is shown above/below all instruments belonging to the corresponding players in 
the selected layouts when their checkboxes are activated, and hidden when their checkboxes are 
deactivated. Figured bass is hidden completely when no checkboxes are activated.

AFTER COMPLETING THIS TASK

● You can change the staff-relative placement of figured bass.

● You can hide figured bass figures individually in layouts where figured bass is shown.

RELATED LINKS
Changing the staff-relative placement of figured bass on page 656
Hiding/Showing figured bass suspension hold lines on page 655
Showing figured bass on rests on page 653

Hiding/Showing figured bass figures individually
You can hide/show individual figured bass figures in layouts in which figured bass is shown. 
You can do this for the current layout and frame chain only or for all layouts and frame chains. 
However, you cannot show individual figures in layouts where figured bass is hidden.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the figured bass figures you want to hide, or the signposts of figures you want to 
show.

2. In the Properties panel, activate/deactivate Hidden in the Figured Bass group.

Figured bass
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RESULT
The selected figured bass figures are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden figure. However, signposts are not printed by 
default.

TIP

● If you do not want to show figured bass signposts, choose View > Signposts > Figured Bass. 
Figured bass signposts are shown when a tick appears beside Figured Bass in the menu, 
and hidden when no tick appears.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text objects, 
and time signatures.

RELATED LINKS
Signposts on page 349
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Key Commands page in the Preferences dialog on page 47
Annotations on page 537

Showing figured bass on rests
By default, figured bass is hidden on rests because figures typically indicate harmony in relation 
to a bass note. You can show figured bass on individual rests, for example, if the harmony 
changes while the bass is resting. You can do this for the current layout and frame chain only or 
for all layouts and frame chains.

PREREQUISITE

● You have input figured bass at the positions of the rests.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests on which you want to show figured bass.

2. In the Properties panel, activate Show figured bass in the Notes and Rests group.

RESULT
Figured bass is shown on the selected rests. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Deactivating Show figured bass hides figured bass on selected rests again.

RELATED LINKS
Inputting figured bass on page 313
Hiding/Showing figured bass in layouts on page 652
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Lengthening/Shortening figured bass figures
You can lengthen/shorten the duration of figured bass figures after they have been input. 
Lengthening a figure that was input without a specified duration gives it duration and shows 
a hold line.

Hold lines indicate that chords remain the same over changing notes in the bass.

PROCEDURE

1. In Write mode, select the figured bass figures you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one figured bass figure at a time and 
it must have duration already. When using the keyboard, you can lengthen/shorten multiple 
figures, but they must all have duration already and this only affects their overall duration, 
not their suspension duration.

2. Lengthen/Shorten the figures in any of the following ways:

● To lengthen their duration by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten their duration by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

NOTE

When using the keyboard, lengthening/shortening figures only moves their end. You can 
move the start of figures by moving them rhythmically, or by clicking and dragging the 
start handle once they have duration.

● Click and drag the circular handle at the start/end to the right/left.

You can click and drag the duration handle and/or the suspension resolution handle.

RESULT
The selected figured bass figures are lengthened/shortened according to the current rhythmic 
grid resolution. If they previously had no duration, they now have duration and show a hold line.

TIP

You can also use the Duration property in the Figured Bass group of the Properties panel 
to change the duration of figured bass figures. The left value field allows you to change the 
duration, and the right value field allows you to specify that the hold line ends at the position of a 
grace note.

For suspensions, you can use the Resolution pos. property to change the position of the 
resolution figure relative to the suspension figure.

Figured bass
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EXAMPLE

Figure (selected) with no duration Figure (selected) with duration and hold line

Hiding/Showing figured bass suspension hold lines
You can hide/show hold lines between the figures at the start and end of figured bass 
suspensions individually.

PROCEDURE

1. Select the figured bass suspensions whose hold lines you want to hide/show.

2. In the Properties panel, activate Line between susp. and resolution in the Figured Bass 
group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Hold lines are shown between figures in the selected figured bass suspensions when the 
checkbox is activated, and hidden when the checkbox is deactivated.

EXAMPLE

Suspension hold line hidden Suspension hold line shown

RELATED LINKS
Showing figured bass on rests on page 653

Positions of figured bass
Figured bass is automatically organized into rows according to the number of rows required in 
each system independently. By default, rows are aligned at the top when below the staff and at 
the bottom when above the staff to minimize the gap between figured bass and the staff.

The vertical position of figured bass is determined by the staves above which they are set to 
appear and your per-layout setting for their staff-relative placement.

You can move individual figured bass figures to different rhythmic positions in Write mode. They 
are automatically positioned to avoid collisions. This includes Dorico SE’s kerning, which applies 
across whole systems to ensure all figures and alterations are legible.

Figured bass
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RELATED LINKS
Hiding/Showing figured bass in layouts on page 652
Moving figured bass figures rhythmically on page 657

Changing the staff-relative placement of figured bass
You can change the default staff-relative placement of all figured bass figures in each layout 
independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-relative 
placement of figured bass.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Figured Bass section, choose one of the following options for Default placement:

● Above staff

● Below staff

5. Click Apply, then Close.

RESULT
The default staff-relative placement of all figured bass figures in the selected layouts is changed.

TIP

You can also change the staff-relative placement of individual figured bass figures by selecting 
them and pressing F . If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

EXAMPLE

Figured bass below the staff Figured bass above the staff

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Moving figured bass figures rhythmically
You can move figured bass figures to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the figured bass figures you want to move.

NOTE

When using the mouse, you can only move one figure rhythmically at a time.

2. Move the figures according to the current rhythmic grid resolution in any of the following 
ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the figure to the right/left.

RESULT
The selected figures are moved to new rhythmic positions.

NOTE

Only one figured bass figure can exist at each rhythmic position. If a figure passes over another 
figure as part of its move, the existing figure is deleted.

You can undo this action, but any figures deleted in the process are only restored if you moved 
the figure using the keyboard.

RELATED LINKS
Lengthening/Shortening figured bass figures on page 654

Appearance of figured bass
The appearance of individual figures is determined either by the default settings in Dorico SE or 
your popover entry, depending on whether you instructed Dorico SE to follow your entry literally 
when you input each figure.

When inputting figured bass, by default Dorico SE interprets your entries and applies its default 
settings for the appearance of figured bass to them. You can specify that you want Dorico SE to 
follow your entries exactly for individual figures, for example, if you are reproducing a piece of 
music and know in advance exactly how you want figures to appear.

You can reset individual figures that you input with the figured bass input setting Follow input 
literally so they follow the default settings, and you can fix the current appearance of individual 
figures.

Figured bass in Dorico SE uses a bold roman font by default.

Figures appear as signposts if Dorico SE either does not normally show them, such as third 
intervals, or cannot identify the bass note for them, such as on a rest.

RELATED LINKS
Inputting figured bass on page 313
Showing figured bass on rests on page 653
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Simplifying figured bass compound intervals on page 658
Fixing the current appearance of figured bass on page 658
Resetting figured bass on page 659

Simplifying figured bass compound intervals
You can simplify compound intervals in individual figured bass figures, that is, figures 9 and 
above. Some editions prefer to simplify compound intervals so figures reflect the first octave and 
appear out of order in the stack.

PROCEDURE

1. Select the compound figured bass figures you want to simplify.

2. In the Properties panel, activate Show compound intervals as simple in the Figured Bass 
group.

RESULT
The selected compound figures are simplified. Deactivating the property returns the selected 
figures to their default octave.

EXAMPLE

Figure with compound intervals Figure with simplified compound intervals

Fixing the current appearance of figured bass
You can fix the current appearance of individual figured bass figures, for example, if you 
input them with the input setting Follow Engraving Options but want to keep their current 
appearance, regardless of future changes you make to figured bass engraving options.

PROCEDURE

1. Select the figured bass figures whose current appearance you want to fix.

2. Choose Edit > Figured Bass > Force Current Appearance.

RESULT
The current appearance of the selected figures is fixed, meaning they are not affected by any 
future changes to figured bass engraving options.

NOTE

● You cannot access the Engraving Options dialog in Dorico SE, as is only available in Dorico 
Pro. However, fixing figures maintains their appearance if you share the project with other 
users who later change figured bass engraving options.
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● You can assign a key command for Force Current Appearance on the Key Commands page 
in Preferences.

Resetting figured bass
You can reset individual figured bass figures, for example, if they were input with the figured 
bass input setting Follow input literally. Reset figures follow the default settings in Dorico SE, 
which you cannot change in Dorico SE.

PROCEDURE

1. Select the figured bass figures you want to reset.

2. Choose Edit > Figured Bass > Reset Figured Bass.

RESULT
The selected figured bass figures are reset to follow the default settings. This can affect their 
appearance and suspension duration.

TIP

You can assign a key command for Reset Figured Bass on the Key Commands page in 
Preferences.

RELATED LINKS
Figured bass popover on page 315
Key Commands page in the Preferences dialog on page 47
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Fingering

Fingerings can be added to music to recommend which fingers players should use for notes. 
This can be useful for music aimed at players learning the instrument and for difficult musical 
passages where certain fingering patterns make the notes much easier to play.

Fingerings are often used in keyboard music, as players can use all ten fingers to play notes, and 
in guitar music, where fingerings are often used alongside fret positions. However, fingerings 
can also be useful for other instruments, for example, to indicate that string players should 
change the finger used to stop the string while holding the note, or to instruct wind players to 
use uncommon fingerings for particular notes in order to create a special sonic effect.

Piano music containing multiple fingerings, including a substitution fingering and alternative fingerings

Dorico SE also provides fingerings for brass and fretted instruments. For example, you can 
specify which valves players should depress for instruments such as trumpet and horn, and you 
can specify the horn branch you want players to use for double horns. For fretted instruments, 
you can input fingerings for both hands.

Fingerings in Dorico SE use a bold roman font by default, following accepted conventions for the 
appearance of fingerings.

RELATED LINKS
Inputting fingerings on page 212
Fingerings popover on page 214
Fingerings for fretted instruments on page 665
Fingerings for valved brass instruments on page 670
Fingering slides on page 669
Hiding/Showing fingering on page 664
String indicators on page 674
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General placement conventions for fingering
Fingerings are placed as close as possible to the notes to which they apply, so the performer can 
read them easily and clearly.

In music for grand staff instruments, such as the piano and harp, it is accepted to place 
fingerings for the right hand above the top staff, and fingerings for the left hand below the 
bottom staff. However, in dense contrapuntal music for these instruments, fingerings can be 
placed between the staves to follow the direction of the voices to which they apply.

Different conventions apply to fingerings for fretted instruments, as they require fingerings for 
both the right and left hands.

Right-hand fingering placement

By default, all right-hand fingerings are placed outside the staff and on the notehead side of 
notes, which can be above or below the staff depending on the stem direction. When shown 
beside notes inside the staff, Dorico SE automatically joins adjacent notes with the same right-
hand fingering with a bracket.

Left-hand fingering placement

Left-hand fingerings are usually positioned inside the staff and to the left of the notes to which 
they apply. However, they also must not collide with other items, such as accidentals and rhythm 
dots. Dorico SE automatically calculates the most appropriate positions for left-hand fingerings 
and erases their backgrounds by default, which improves their readability when placed on staff 
lines.

RELATED LINKS
Fingerings for fretted instruments on page 665
Changing the position of left-hand fingerings on page 668
Hiding/Showing brackets for right-hand fingerings on page 667

Changing fingerings to substitution fingerings
Substitution fingerings indicate where players should change the finger used for the note. You 
can change existing fingerings to substitution fingerings.

PROCEDURE

1. Select the fingerings you want to change to substitution fingerings.

2. In the Properties panel, activate Substitution in the Fingering and Positions group.

3. Enter the fingering you want for the substitution into the value field.

4. Press Return .

RESULT
The selected fingerings are now shown as substitution fingerings. The deferred position of the 
substitution is the same as the original fingering by default, but you can change the rhythmic 
position of substitution fingerings.

Fingering
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Changing the rhythmic position of substitution fingerings
Substitution fingerings are shown as immediate by default, meaning that the substitution 
takes place on the same note, but you can change the rhythmic position at which individual 
substitutions take place.

PROCEDURE

1. Select the substitution fingering whose deferred rhythmic position you want to change.

2. Change the rhythmic position of the substitution fingering in any of the following ways:

● Click and drag the circular handle to the right/left.

● Activate Substitution offset in the Fingering and Positions group of the Properties 
panel.

Change the rhythmic position of substitutions as fractions of a quarter note (crotchet) by 
entering a value into the left value field, or by clicking the arrows beside the value field. 
Increasing the value moves substitutions to later positions, decreasing the value moves 
them to earlier positions.

NOTE

The right value field is for the grace note position at which substitutions occur, if 
applicable.

RESULT
The rhythmic position of the substitution fingering is changed.

Dorico SE automatically arranges deferred substitutions so they are ordered appropriately 
alongside any fingerings that coincide with the substitution.

NOTE

You can only change the position of single substitution fingerings when dragging their handles 
with the mouse. However, you can change the positions of multiple substitution fingerings with 
Substitution offset in the Fingering and Positions group of the Properties panel.

Deferred substitutions are always shown with horizontal lines.

RELATED LINKS
Fingerings popover on page 214

Changing existing fingerings
You can change fingerings after you have input them, for example, if you decide a different 
fingering would be better.

PROCEDURE

1. Select the fingerings you want to change.

2. In the Properties panel, enter the new fingering you want into the Finger or position value 
field in the Fingering and Positions group.

3. Press Return .

Fingering
Changing existing fingerings 

662
Dorico SE 3.5.12



RESULT
The selected fingerings are changed.

TIP

You can also change existing fingerings in Write mode by opening the fingerings popover. Any 
existing fingerings on the selected note are shown in the popover.

RELATED LINKS
Inputting fingerings on page 212
Fingerings popover on page 214

Changing the staff-relative placement of fingerings
Dorico SE automatically follows conventions for fingering placement, but you can show individual 
fingerings belonging to non-fretted instruments either above or below the staff. You can do this 
for the current layout and frame chain only or for all layouts and frame chains.

According to convention, keyboard instrument fingering is positioned above the right-hand staff, 
and below the left-hand staff. String and brass instrument fingering is always positioned above 
the staff.

NOTE

These steps only apply to non-fretted instruments.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the fingerings whose staff-relative placement you want to change.

2. In the Properties panel, activate Staff-relative position in the Fingering and Positions 
group.

3. Choose one of the following options:

● Above

● Below

RESULT
The selected fingerings appear above/below the staff. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

RELATED LINKS
Fingerings for fretted instruments on page 665
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Showing fingerings inside the staff
You can show individual fingerings belonging to non-fretted instruments beside noteheads 
inside the staff.

NOTE

● These steps only apply to non-fretted instruments. Left-hand fingerings for fretted 
instruments are shown inside the staff by default.

● These steps do not apply to substitution fingerings.

PROCEDURE

1. Select the notes whose fingerings you want to show inside the staff.

2. In the Properties panel, activate Inside staff in the Fingering and Positions group.

RESULT
Fingerings belonging to the selected notes are shown inside the staff, directly beside the 
noteheads. By default, if they belong to a note on a staff line, they erase part of the staff line to 
ensure legibility.

EXAMPLE

Hiding/Showing fingering
You can hide/show fingering in each layout independently. For example, you can show fingering 
in part layouts but hide fingering in full score layouts as conductors rarely require fingering 
information.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingering.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Fingering section, activate/deactivate Show fingering.

5. Click Apply, then Close.

RESULT
All fingerings are shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.
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Deleting fingerings
You can remove fingerings from notes after you have input them. However, because fingerings 
are properties of notes rather than separate items in Dorico SE, you cannot select and delete 
them as you would for other items.

PROCEDURE

1. Select the notes from which you want to remove fingerings.

2. Choose Edit > Fingering > Reset Fingering.

RESULT
All fingerings are removed from the selected notes.

TIP

You can assign your own key command for this action.

RELATED LINKS
Large selections on page 336
Assigning key commands on page 50

Cautionary fingerings
Cautionary fingerings remind players that fingerings specified at previous rhythmic positions 
continue to apply to notes that are still sounding. Dorico SE automatically shows cautionary 
fingerings when you add other fingerings at rhythmic positions where notes with existing 
fingerings are still sounding.

By default, cautionary fingerings are shown enclosed in parentheses.

Cautionary fingering shown in parentheses (default)

RELATED LINKS
Inputting fingerings on page 212

Fingerings for fretted instruments
Fretted instruments, such as the classical guitar, require additional fingering instructions for 
both hands due to the complex nature of the music.

Fingerings for fretted instruments use the same fonts as normal fingerings.

Fingering
Deleting fingerings 
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A passage for guitar with right-hand and left-hand fingerings

Right-hand fingering
Right-hand fingerings tell the performer which finger to use to pluck the string, which 
is usually the right hand. By default, all right-hand fingerings are placed outside the 
staff, on the notehead side of notes, and follow the stem directions of voices in 
multiple-voice contexts. When the same finger plays multiple notes in a chord, you 
can show a single fingering with a bracket for the notes plucked by that finger.

Dorico SE shows “p” for right-hand thumb fingerings and “e” for right-hand fingerings 
for the pinky finger.

NOTE

In Dorico SE, we use “pinky” to refer to the smallest finger, but it can also be called 
“little” or “fifth digit”.

Left-hand fingering
Left-hand fingerings tell the performer which finger to use to stop the string, which is 
usually the left hand. In Dorico SE, left-hand fingerings are placed inside the staff and 
to the left of the notes to which they apply.

When shown inside the staff next to notes, left-hand fingering appears smaller than 
fingering shown outside the staff.

RELATED LINKS
Inputting fingerings on page 212
Fingerings popover on page 214
Adding fingerings to arpeggio signs on page 668
Fingering slides on page 669
String indicators on page 674
Tapping on page 779
Hammer-ons and pull-offs on page 780

Fingering
Fingerings for fretted instruments 
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Hiding/Showing brackets for right-hand fingerings
When multiple notes in the same chord are plucked by the same right-hand finger, you can show 
the same fingering multiple times, once for each note, or show a single fingering for all notes 
with a bracket spanning the notes plucked by that finger. When showing a separate fingering for 
each note, you can also choose to place each fingering either above or below the staff. You can 
do this for the current layout and frame chain only or for all layouts and frame chains.

NOTE

These steps only apply to right-hand fingerings belonging to fretted instruments.

PREREQUISITE

● You have input the fingerings for which you want to hide/show brackets or whose vertical 
position you want to change.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select all the notes for which you want to hide/show brackets for right-hand fingerings.

2. In the Properties panel, activate Vertical position in the Plucked Fingering group.

3. Select one of the following options from the menu:

● To hide brackets and show a separate fingering for each selected note, select Above 
staff or Below staff.

● To show brackets and a single fingering for all notes in each bracket, select Next to 
note.

RESULT
Brackets on the selected right-hand fingerings are hidden/shown. If you selected Above staff or 
Below staff, their staff-relative placement is changed accordingly. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Right-hand fingerings shown next 
to notes with a bracket

Right-hand fingerings shown 
above the staff

Right-hand fingerings shown 
below the staff

RELATED LINKS
Inputting fingerings on page 212
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Changing the position of left-hand fingerings
You can change the position of individual left-hand fingerings. You can do this for the current 
layout and frame chain only or for all layouts and frame chains. By default, they are positioned 
inside the staff and to the left of the notes to which they apply.

NOTE

These steps only apply to left-hand fingerings belonging to fretted instruments.

PREREQUISITE

● You have input the fingerings whose position you want to change.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the left-hand fingerings whose position you want to change.

2. In the Properties panel, activate Stopping finger position in the Fingering and Positions 
group.

3. Select one of the following options from the menu:

● Outside staff

● Left of note

● Right of note

EXAMPLE
The position of the selected left-hand fingerings is changed. When shown outside the staff, they 
are placed above the staff by default. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

Outside staff Left of note Right of note

RELATED LINKS
General placement conventions for fingering on page 661
Inputting fingerings on page 212
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Adding fingerings to arpeggio signs
You can add fingerings to arpeggio signs to indicate which right-hand finger should be used to 
strum a chord. By default, fingerings are placed at the bottom of arpeggio signs.

NOTE

These steps only apply to arpeggio signs belonging to fretted instruments.

Fingering
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PREREQUISITE
You have input the arpeggio signs to which you want to add fingerings.

PROCEDURE

1. Select the arpeggio signs belonging to fretted instruments to which you to add fingerings.

2. In the Properties panel, activate Finger in the Plucked Fingering group.

3. Enter the fingering you want into the value field.

For example, for the thumb, enter p.

RESULT
The specified fingering is added to the selected arpeggio signs. It is positioned at the bottom of 
the arpeggio signs by default.

EXAMPLE

Arpeggio signs played with the thumb

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266

Fingering slides
Fingering slides indicate that the performer should slide their finger up/down the neck of the 
instrument. They are notated as an angled line between fingerings.

The note at the start of a fingering slide is known as a source note. The note at the end of a 
fingering slide is known as the destination note.

A passage with fingering slides

When the source and destination notes are sufficiently close horizontally, fingering slides are 
shown between the fingerings, joining them directly in their existing positions without moving 
them. When the source and destination notes are far apart horizontally, fingering slides appear 
with a fixed length to the left of the destination note. You can change the length of individual 
fingering slides.

Fingering
Fingering slides 
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Fingering slides automatically avoid obstructions, such as noteheads, accidentals, and other 
fingerings.

NOTE

● Dorico SE automatically adjusts the length/angle of fingering slides when you move the 
fingerings at the start/end.

● In Dorico SE, you can only show fingering slides on staves belonging to fretted instruments. 
You can show string fingering shift indicators on staves belonging to other string 
instruments.

RELATED LINKS
Hiding/Showing fingering slides on page 670
Hiding/Showing string fingering shift indicators on page 671

Hiding/Showing fingering slides
You can hide/show slides between notes played by the same left-hand finger on the same string 
on fretted instruments.

NOTE

These steps only apply to fingerings belonging to fretted instruments.

PREREQUISITE

● You have input the same left-hand fingering for the notes at the start and end of the slides.

● You have specified the same string for the notes at the start and end of the slides.

PROCEDURE

1. Select the destination notes before which you want to hide/show fingering slides.

2. In the Properties panel, activate/deactivate Slide in in the Fingering and Positions group.

RESULT
Fingering slides are shown before the selected notes when Slide in is activated, and hidden 
when it is deactivated. If the gap between the source and destination notes is small enough, 
fingering slides appear as an angled line joining the fingerings. If the gap is large, fingering 
slides appear as a fixed length angled line to the left of the destination notes.

RELATED LINKS
Inputting fingerings on page 212
Changing existing fingerings on page 662
Specifying the string for individual notes on page 726

Fingerings for valved brass instruments
For instruments like trumpet and horn, fingering is used to show which valves must be 
depressed to produce a specific note.

You can enter fingerings for valved brass instruments into the fingerings popover as numbers 
without any separation. For example, enter 12 for a C♯ on a trumpet to indicate that the first two 
valves must be depressed.

Fingering
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By default, Dorico SE automatically stacks fingerings added to notes on brass instrument staves 
vertically. They are shown with no separator by default.

RELATED LINKS
Fingerings popover on page 214
Inputting fingerings on page 212

Showing horn branch indicators
You can indicate the branch on which notes are played for double horns and triple horns by 
adding branch indicators as prefixes to horn fingerings. Some publications simply indicate “T” for 
thumb, while others more explicitly indicate which branch is to be used by specifying its pitch.

NOTE

You can only add branch indicators to notes belonging to horns in F.

PROCEDURE

1. Select the horn fingerings to which you want to add branch indicators.

2. In the Properties panel, activate Horn branch in the Fingering and Positions group.

3. Select one of the following horn branches from the menu:

● F

● B flat

● F alto

● E flat alto

● Thumb trigger

RESULT
Branch indicators are added to the selected fingerings.

RELATED LINKS
Inputting fingerings on page 212

Hiding/Showing string fingering shift indicators
You can hide/show shift indicators after individual fingerings. You can do this for the current 
layout and frame chain only or for all layouts and frame chains.

Shift indicators are angled lines that indicate the direction of movement when string players 
must shift their finger position on the fingerboard to play a higher/lower note with the same 
finger as the previous note.

NOTE

These steps do not apply to fingerings belonging to fretted instruments, which can show 
fingering slides instead.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

Fingering
Hiding/Showing string fingering shift indicators 

671
Dorico SE 3.5.12



PROCEDURE

1. Select the notes on string instrument staves from which you want to indicate a fingering 
shift.

2. In the Properties panel, activate/deactivate Indicate shift to next note in the Fingering and 
Positions group.

RESULT
Shift indicators are shown when the property is activated, even if neither of the notes at each 
end have explicit fingerings, and hidden when the property is deactivated. They are positioned 
between the selected notes and the notes that immediately follow them. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

RELATED LINKS
Specifying the string for individual notes on page 726
Fingering slides on page 669
String indicators on page 674
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the direction of string fingering shift indicators
You can change the direction of individual string fingering shift indicators if they do not point in 
the direction required.

PROCEDURE

1. Select the shift indicators whose direction you want to change.

2. In the Properties panel, activate Shift direction in the Fingering and Positions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The selected shift indicators are angled up/down.

NOTE

You can also affect the direction of string shift indicators by specifying the strings on which notes 
are played.

RELATED LINKS
Specifying the string for individual notes on page 726

Fingering
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Fingerings imported from MusicXML files
Dorico SE imports fingerings that are specified using the fingering element in MusicXML files.

MusicXML files exported from Finale typically represent fingerings in the correct way. However, 
because Sibelius does not use the fingering element, Dorico SE cannot import fingerings from 
MusicXML files exported by Sibelius.

Fingering
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String indicators

String indicators are commonly used in guitar music to tell performers the string on which they 
should play a note, particularly for pitches that are possible on multiple strings.

String indicators show the string number inside a circle enclosure, optionally with a dashed line 
to indicate they apply to a range of notes. Open pitches commonly appear as a zero without an 
enclosure.

In Dorico SE, string indicators for stopped pitches appear in a plain font while string indicators 
for open strings use the fingering font.

A phrase with string indicators and left-hand fingerings

There are two types of string indicators in Dorico SE, which you input in different ways.

String indicators outside the staff
String indicators outside the staff always appear inside circle enclosures. They 
automatically show dashed duration lines when they have duration to indicate that 
multiple notes are played on that string.

In Dorico SE, string indicators outside the staff are considered playing techniques. You 
can select and delete them independently of the notes to which they apply.

String indicator outside the staff with duration line

String indicators inside the staff
String indicators inside the staff appear inside circle enclosures, except when they 
show open strings, which appear as a bold number zero without an enclosure. They 
automatically erase their backgrounds so they do not collide with staff lines. They 
appear to the left of noteheads by default but automatically appear to the right if 
left-hand fingerings are present.

The string number shown in string indicators inside the staff is calculated 
automatically, but you can also specify the string manually.

String indicators inside the staff for stopped pitches are scaled-down versions of string 
indicators outside the staff.

In Dorico SE, string indicators inside the staff are considered properties of the 
corresponding notes. You cannot select them independently of their corresponding 
notes.
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String indicators inside the staff, with the last one for an open string

RELATED LINKS
Fingerings for fretted instruments on page 665
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Playing techniques on page 813
Playing technique duration on page 819
Lengthening/Shortening string indicators on page 675
Specifying the string for individual notes on page 726
Deleting string indicators on page 676

Lengthening/Shortening string indicators
You can lengthen/shorten the duration of string indicators outside the staff after they have been 
input. Lengthening a string indicator outside the staff that was added to a single note gives it 
duration and shows a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, select the string indicators outside the staff you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one string indicator at a time and it 
must have duration already. When using the keyboard, you can lengthen/shorten multiple 
string indicators, but they must all have duration already.

2. Lengthen/Shorten the string indicators in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To snap the end of a single string indicator to the next notehead, press Ctrl/Cmd-Shift-
Alt/Opt-Right Arrow .

● To snap the end of a single string indicator to the previous notehead, press Ctrl/Cmd-
Shift-Alt/Opt-Left Arrow .

NOTE

● When multiple string indicators are selected, you can only lengthen/shorten them 
according to the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening string indicators with duration 
only moves their end. You can move the start of string indicators with duration by 
moving them rhythmically, or by clicking and dragging the start handle once they 
have duration.

String indicators
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● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single string indicators are lengthened/shortened according to the current rhythmic grid 
resolution or to the next/previous notehead, whichever is closer. If they previously had no 
duration, they now have duration and show a duration line.

Multiple string indicators are lengthened/shortened according to the current rhythmic grid 
resolution.

EXAMPLE

String indicator (selected) with no duration String indicator (selected) with duration and duration 
line

RELATED LINKS
Playing technique duration on page 819
Playing technique continuation lines on page 818
Hiding/Showing playing technique duration lines on page 820
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291

Deleting string indicators
You can remove string indicators inside the staff from notes after you have input them. You can 
do this for the current layout and frame chain only or for all layouts and frame chains. However, 
because string indicators inside the staff are properties of notes rather than separate items, you 
cannot select and delete them as you would for other items.

NOTE

These steps only apply to string indicators inside the staff. You can delete string indicators 
outside the staff in the same ways as for other items.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes from which you want to remove string indicators inside the staff.

2. In the Properties panel, deactivate Show in the String Indicators group.

RESULT
String indicators inside the staff are removed from the selected notes. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.
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RELATED LINKS
Large selections on page 336
Deleting notes and items on page 350
Inputting string indicators inside the staff on page 303
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Positions of string indicators
String indicators outside the staff are placed above it by default. In multiple-voice contexts, 
string indicators for the up-stem voices are placed above the staff and string indicators for the 
down-stem voices are placed below the staff.

String indicators inside the staff automatically erase their backgrounds so they do not collide 
with staff lines. They appear to the left of noteheads by default but automatically appear to the 
right if left-hand fingerings are present. You can change the notehead-relative position of string 
indicators individually.

You can move string indicators outside the staff to different rhythmic positions in Write mode. 
They are automatically positioned to avoid collisions. You can also change the staff-relative 
placement of string indicators outside the staff individually, in the same ways as for playing 
techniques.

RELATED LINKS
Changing the staff-relative placement of items on page 343

Moving string indicators rhythmically
You can move string indicators outside the staff to new rhythmic positions after they have been 
input.

PROCEDURE

1. In Write mode, select the string indicators outside the staff you want to move.

NOTE

When using the mouse, you can only move one string indicator rhythmically at a time.

2. Move the string indicators in any of the following ways:

● To move a single string indicator to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single string indicator to the previous notehead on the staff, press Alt/Opt-
Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple string indicators are selected, you can only move them according to the 
current rhythmic grid resolution.
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● Click and drag the string indicator to the right/left to the notehead you want.

RESULT
The selected string indicators are moved to new rhythmic positions.

NOTE

If a single string indicator outside the staff passes over another string indicator outside the staff 
as part of its move, the existing one is unaffected as multiple string indicators can exist at the 
same rhythmic position. However, if you move multiple string indicators together, any existing 
string indicators they pass over are shortened or deleted accordingly.

You can undo this action, but any string indicators shortened/deleted in the process are only 
restored if you moved string indicators using the keyboard.

RELATED LINKS
Lengthening/Shortening string indicators on page 675

Changing the notehead-relative position of string indicators
By default, string indicators inside the staff appear to the left of noteheads when there are no 
left-hand fingerings and to the right of noteheads when there are left-hand fingerings. You can 
change the side of noteheads on which string indicators inside the staff appear individually. You 
can do this for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the string indicators inside the staff whose notehead-relative position you want to 
change.

2. In the Properties panel, activate Notehead-relative pos. in the String Indicators group.

3. Choose one of the following options:

● Left

● Right

RESULT
The notehead-relative position of the selected string indicators is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

String indicators to the left of noteheads String indicators to the right of noteheads
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RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

String indicators
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Front matter

Front matter in Dorico SE is a broad term that covers all information included before the first bar 
of music in scores.

Front matter includes musical information often added on pages before the first pages of scores, 
such as:

● Performance instructions

● Contents

● Instrumentation list

Front matter also includes information above the music on the first page of scores and parts, 
such as:

● Dedications

● Titles

● Subtitles

● Composers

RELATED LINKS
Master pages on page 363
Frames on page 365
Page formatting on page 367

Project information used in default master pages
An efficient way of ensuring all text information in the different layouts in your project is 
consistent is to use tokens that link to information for the current project entered in the Project 
Info dialog.

Tokens are codes that refer to text elsewhere, meaning they are updated automatically if the 
source text is changed.

The default master pages in Dorico SE include tokens, so that any information you add about the 
project in the Project Info dialog is automatically shown. For example, the Default Full Score 
master page set includes tokens for the following information:

● Project title

● Project lyricist

● Project composer

NOTE

If you only enter information for individual flows in the Project Info dialog, that information 
does not automatically appear on the first page.

RELATED LINKS
Project Info dialog on page 88
Flow names and flow titles on page 135
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Text tokens on page 397
Hiding/Showing flow headings on page 379
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Grace notes

Grace notes are notes without a fixed duration, which are intended to be played quickly. They 
are scaled-down versions of normal notes, and are commonly shown with a slash through their 
stem.

Grace notes with slashed stems are known as acciaccaturas and are often played very fast. 
Grace notes without slashed stems are known as appoggiaturas and are often played slower 
than acciaccaturas. In Baroque music, appoggiaturas are often understood to last for a specific 
duration, based on the prevailing meter and the rhythmic value of the notehead to which they 
are attached. Therefore in Dorico SE, slashed and unslashed grace notes are handled differently 
in playback.

Grace notes do not take up space rhythmically, as they are intended to be fitted into the space 
before the notehead to which they are attached, which is the notehead immediately to their 
right.

There can be multiple grace notes before a notehead. If there are two or more grace notes 
attached to the same notehead, and they have a rhythmic value that shows a flag on the stem, 
such as eighth notes (quavers) and 16th notes (semiquavers), they are automatically beamed 
together.

Multiple grace notes before notes

In Dorico SE, grace notes are scaled to 3/5 the size of a normal notehead by default and are 
affected by your note spacing settings. There is a separate option specifically for grace note 
spacing.

You can add notations, such as slurs and articulations, to grace notes in the same ways as to 
normal notes, and you can transpose grace notes after they have been input.

RELATED LINKS
Inputting grace notes on page 190
Grace note slashes on page 684
Grace notes in playback on page 686
Slur placement relative to grace notes on page 889
Note spacing on page 406
Changing the pitch of individual notes on page 199
Inputting articulations on page 209
Inputting slurs on page 211

682
Dorico SE 3.5.12



General placement conventions for grace notes
Grace notes function like normal notes in many ways, but there are some specific conventions 
about their stem direction, position relative to noteheads, and the placement of stem slashes.

Grace notes appear stem up by default, except when there are multiple voices with grace notes 
in a single staff, in which case grace notes in the lower voices appear stem down. This affects the 
placement of slurs relative to grace notes.

Grace notes are always positioned before a notehead, even if they are intended to be played on 
the beat rather than before the beat. They are normally placed after a barline, so they can be 
positioned directly before the notehead to which they are attached. However, groups of three or 
more grace notes can be placed before the barline so that the note of the first beat in the bar is 
not pushed too far from the barline.

Grace note stem slashes appear at the beginning of a grace note beam if multiple grace notes 
can be joined by a single beam at the same rhythmic position. If there is a single grace note, the 
slash appears across the stem, and its flag if applicable, and extends either side of the stem.

Adding accidentals causes their spacing to readjust so that the accidentals are clearly legible, 
similar to normal notes.

Articulations can be added to grace notes wherever they are most clearly legible, which is most 
likely outside the staff. Dorico SE automatically places articulations on the stem-side of grace 
notes, and outside the staff if the stem or beam is within the staff.

Slurs relative to grace notes

By default, slurs starting on grace notes and ending on tie chains end on the first note of the 
tie chain. You can change the position of individual slurs relative to tie chains, including those 
starting from grace notes.

RELATED LINKS
Showing grace notes before/after barlines on page 684
Slur placement relative to grace notes on page 889
Slur position relative to tie chains on page 888
Changing the position of slurs relative to tie chains on page 888
Note spacing on page 406

Grace note placement in multiple-voice contexts
According to accepted notation convention, grace notes appear stem up by default when there is 
only one voice on a staff, even if the notehead to which they are attached is stem down.

However, when there are multiple voices on the staff, all notes in the upper voices appear stem 
up and all notes in the lower voices appear stem down, including all grace notes. This adjustment 
happens automatically in Dorico SE, but you can also override the stem direction of grace notes 
in multiple voices and change their directions individually if necessary.

Grace notes
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RELATED LINKS
Changing the stem direction of notes on page 923
Slur placement relative to grace notes on page 889

Showing grace notes before/after barlines
By default, grace notes are positioned after barlines and directly before the notehead to which 
they apply, including for the first note in a bar. You can position individual grace notes before 
barlines, for example, so the first normal note in the bar is not pushed too far from the barline, 
or to indicate that grace notes are played before the beat.

PROCEDURE

1. Select the grace notes whose position relative to barlines you want to change.

2. In the Properties panel, activate/deactivate Grace note before barline in the Grace Notes 
group.

RESULT
Grace notes at the selected rhythmic positions are positioned before barlines when the property 
is activated, and after barlines when the property is deactivated.

NOTE

This affects all grace notes at the selected rhythmic positions.

RELATED LINKS
Barlines on page 558
Inputting grace notes on page 190

Grace note size
Grace notes are smaller versions of normal notes, and are scaled down by a ratio that is set by 
default to 3/5 of a normal note.

You can change the size of grace notes individually in the same way as for normal notes.

RELATED LINKS
Changing the size of notes on page 724

Grace note slashes
Slashes shown diagonally across grace note stems are often used to distinguish different types 
of grace notes. Grace notes with slashed stems are known as acciaccaturas and are often played 
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very fast. Grace notes without slashed stems are known as appoggiaturas and are often played 
slower than acciaccaturas.

In Dorico SE, grace notes appear with slashed stems by default. You can change whether grace 
notes are slashed or unslashed during note input as well as by changing the type of existing 
grace notes.

Changing the type of grace notes
You can change the type of individual grace notes after they have been input. Grace notes have 
slashed stems by default, but you can change them to have unslashed stems.

PROCEDURE

1. Select the grace notes whose type you want to change.

2. In the Properties panel, choose one of the following options for Grace note type in the 
Grace Notes group:

● Slashed stem 

● Unslashed stem 

RESULT
The selected grace notes are shown with slashed/unslashed stems.

TIP

You can also change the grace note type during note input.

RELATED LINKS
Inputting grace notes on page 190

Grace note stems
Grace notes are scaled-down notes, so the length of grace note stems is determined by the 
default settings for the stem length of all notes.

Following accepted conventions, grace notes in Dorico SE are stem up by default in any clef, 
regardless of the stem direction of the note to which they apply. The stem directions of grace 
notes are changed automatically when there are multiple voices on a staff, but you can change 
the stem direction of individual grace notes manually. You can also lengthen/shorten grace note 
stems in the same ways as for normal stems.

RELATED LINKS
Stems on page 921
Grace note slashes on page 684
Changing the stem direction of notes on page 923

Grace notes
Grace note stems 
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Grace note beams
Dorico SE automatically beams multiple adjacent grace notes together if they are an eighth note 
(quaver) or shorter in duration.

Like all beams, grace note beams ideally follow the accepted standards for beam placement 
relative to staff lines, in order to avoid wedges. However, because grace notes are smaller than 
normal notes, this can lead to extreme slants in grace note beams.

You can adjust the slants of individual grace note beams in the same ways as for normal beams.

RELATED LINKS
Beaming on page 575
Beam groups on page 575

Grace notes in playback
Slashed and unslashed grace notes are handled differently in playback.

Slashed grace notes of any note duration, and unslashed grace notes a 16th note or shorter, play 
back before the beat with a single default sounding duration.

Unslashed grace notes an eighth note or longer play back on the beat. Their sounding duration 
is half the note duration of the note to which they are attached. For example, if an unslashed 
eighth note grace note is attached to a quarter note, both notes play back as if they were eighth 
notes.

RELATED LINKS
Inputting grace notes on page 190
Grace note slashes on page 684

Grace notes
Grace note beams 
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Holds and pauses

Different notations are used to show where the established rhythmic flow of the music is 
interrupted, either with a moment of repose or a short silence, before continuing. The most 
subtle effect is produced by a tenuto mark, with more significant effects denoted with holds and 
pauses.

The duration of the break in the music intended by the hold or pause does not need to be 
specified. This leaves significant room for interpretation, even though the different styles of 
holds and pauses normally indicate larger or smaller breaks.

NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

RELATED LINKS
Input methods for holds and pauses on page 262

Types of holds and pauses
There are three types of holds and pauses in Dorico SE, and they can all be input, moved, and 
deleted in the same ways.

Fermatas
Fermatas indicate that a note is held for longer than its notated length, which applies 
to the whole ensemble.

They are also known as “pauses” and informally sometimes called “birds’ eyes”.

Breath marks
Breath marks show suitable places for players to breathe, or suggest how the music is 
phrased to create a similar effect.

Caesuras
Caesuras indicate that a note is sustained for its full value and is followed by a break in 
sound before continuing.

Types of fermatas
There are different types of fermatas available in Dorico SE. Each fermata indicates a suggested 
pause duration whilst leaving room for interpretation.

Fermata Description

Very short fermata Indicates that a note is held only a fraction 
longer than the rhythm indicates.

Short fermata Indicates that a note is held a little bit longer 
than the rhythm indicates.
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Fermata Description

Short fermata (Henze) Indicates that a note is held a little bit longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Fermata Indicates that a note is held for longer than the 
rhythm indicates.

Long fermata Indicates that a note is held quite a lot longer 
than the rhythm indicates.

Long fermata (Henze) Indicates that a note is held quite a lot longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Very long fermata Indicates that a note is held for much longer 
than the rhythm indicates.

Curlew (Britten) Indicates that a note or rest is held until the 
next synchronization point in asynchronous 
music, as used by Benjamin Britten.

Fermatas can be divided into two styles. Because their meanings overlap, it can be confusing for 
players if both styles are used in a single project.

Style Very short 
fermata

Short 
fermata

Fermata Long fermata Very long 
fermata

Standard

Henze N/A N/A

RELATED LINKS
Holds and pauses popover on page 262
Changing existing items on page 342

Types of breath marks
There are different types of breath marks available in Dorico SE. Breath marks indicate a suitable 
place for a player to take a breath, or create a musical effect like a breath.

Comma-like Tick-like Upbow-like Salzedo

Holds and pauses
Types of holds and pauses 
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Types of caesuras
There are different types of caesuras available in Dorico SE. All caesuras indicate a break in 
sound, but different types are often needed for different styles of musical scores.

Caesura Thick caesura Short caesura Curved caesura

Two diagonal slashes Two thick diagonal 
slashes

Two straight, vertical 
slashes

Two curved diagonal 
slashes

If you intend to communicate a specific length of hold or gap with each type of caesura, we 
recommend that you consider adding a legend, as different players may interpret these symbols 
differently.

RELATED LINKS
Changing existing items on page 342

Positions of holds and pauses
Holds and pauses are placed above the staff by default in single-voice contexts, and are shown 
on all staves at the closest rhythmic position available, for example, if a single staff has a fermata 
on the last beat in the bar, it is shown above the bar rests on the other empty staves. For staves 
with multiple voices, fermatas are also shown inverted below the staff.

You can move holds and pauses to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

Fermatas

Fermatas are positioned horizontally so that they are centered on noteheads, regardless of the 
stem direction of notes.

Fermatas affect the overall tempo of the piece, so all players must be able to see where 
they occur. Therefore, fermatas are shown on all staves at the same rhythmic position, or the 
rhythmic position of the note, chord, or rest that corresponds with the end of the fermata, 
including over a bar rest if a staff has no notes in that bar.

Breath marks

Breath marks are placed above the top line of the staff by default, at the end of the note to which 
they apply; that is, they appear just before the following note.

Breath marks apply only to the staff to which they were added, as they do not affect the overall 
tempo, but instead only indicate to a single player or group of players a suitable place to break 
their line in order to breathe.

Holds and pauses
Positions of holds and pauses 
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Caesuras

Caesuras are positioned at the top of the staff, with the top staff line passing through the 
middle of the caesura and the bottom of the caesura resting on the second staff line. They are 
commonly placed at the end of a bar, before the barline.

Caesuras are automatically added to all staves at the same rhythmic position, immediately to the 
left of the notehead or barline to which they were input. They are not linked to noteheads, and 
adjust note spacing to create a clear gap.

Multiple holds and pauses at the same rhythmic position
Because fermatas apply to all staves, only one type of fermata can exist at the same rhythmic 
position. For example, you cannot have a short fermata on one staff and a long fermata at the 
same rhythmic position on another staff.

A Britten curlew can be used at the same rhythmic position as another kind of fermata, but it 
cannot exist simultaneously with any breath mark. This is the only exception in Dorico SE.

Caesuras can co-exist with any type of breath mark, but you cannot have a caesura and a fermata 
at the same rhythmic position.

Changes to fermatas on single staves
Changing the type of fermata or caesura on one staff automatically changes the type on all 
staves at that rhythmic position, as a pause at one particular rhythmic position can only be of 
one duration.

However, if you override a particular fermata on one staff, for example, by changing it to a 
Britten curlew or a breath mark, changing the existing fermata on another staff does not change 
the marking on the overridden staff. Deleting the marking on the overridden staff reverts that 
marking to match the fermata on the other staves.

For example, changing a fermata to a breath mark changes the marking for only that staff. That 
note is not affected when the type of fermata on the other staves at that rhythmic position is 
changed.

The bottom staff is overridden to 
show a breath mark instead of a 
fermata.

The fermata is changed to a 
very short fermata, but the 
bottom staff is exempt as it was 
overridden to show a breath mark.

Deleting the breath mark from the 
bottom staff returns it to showing 
the fermata currently chosen for 
that rhythmic position.

Holds and pauses
Positions of holds and pauses 
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Moving holds and pauses rhythmically
You can move holds and pauses to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the holds and pauses you want to move.

NOTE

When using the mouse, you can only move one hold or pause rhythmically at a time.

2. Move the holds and pauses according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the hold or pause to the right/left.

RESULT
The selected holds and pauses are moved to new rhythmic positions on each staff where they 
appear, even if their position does not appear to move. For example, if one staff has a bar rest, 
the rhythmic position of the hold or pause moves, but the hold or pause still appears above the 
rest.

NOTE

Only one type of hold or pause can exist at each rhythmic position. If a hold or pause passes over 
another hold or pause as part of its move, the existing hold or pause is deleted.

You can undo this action, but any holds and pauses deleted in the process are only restored if 
you moved the hold or pause using the keyboard.

Changing the number of fermatas per staff
You can change the maximum number of fermatas that appear on each staff at individual 
positions when there are multiple voices on a staff.

PROCEDURE

1. Select the fermatas whose maximum number per staff you want to change.

2. In the Properties panel, activate Max. fermatas per staff in the Holds and Pauses group.

3. Select one of the following options from the menu:

● One per voice

● One per each side of staff

● One per staff

RESULT
The number of fermatas shown at the selected positions is changed.

Holds and pauses
Positions of holds and pauses 
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Positioning fermatas on barlines
You can position individual fermatas over a barline instead of over a note to indicate a gap 
before the start of the following bar.

NOTE

Fermatas cannot be positioned on barlines if Max. fermatas per staff is also activated.

PROCEDURE

1. Select the fermatas you want to position over barlines.

2. In the Properties panel, activate Attach to barline in the Holds and Pauses group.

RESULT
The selected fermatas are positioned above the barline at the end of the bars they were in 
originally, appearing only above staves that are not joined by the barline. Depending on the 
instrumentation, this may mean they only appear at the top of the system.

Deactivating Attach to barline returns the selected fermatas to their default positions.

Holds and pauses
Positions of holds and pauses 

692
Dorico SE 3.5.12



Key signatures

Key signatures are the markings that show the current key of music by indicating which notes in 
the scale for that key are sharpened or flattened. They are shown at the start of each system on 
every applicable staff.

Traditionally, accidentals are organized following the pattern of the circle of fifths, which is 
different for sharp keys and flat keys.

Using key signatures saves space, as by indicating which notes are generally going to be sharp or 
flat in the music in one group at the start of each system, these notes do not need an accidental 
beside them every time they occur.

By default, key signatures apply to all staves. However, there are certain situations, such as in 
polytonal music, where some parts require their own key signature, independently of the rest of 
the ensemble. You can input key signatures that apply to all staves or only apply to single staves 
in Dorico SE. Once you have input a key signature, all notes you subsequently input follow the 
key signature, for example, if you input an F  after inputting a G major key signature, an F♯ is 
input automatically.

In Dorico SE, key signatures exist within the overarching tonality system for your project. The 
only tonality system in Dorico SE is 12-EDO.

RELATED LINKS
Tonality systems on page 700
Input methods for key signatures on page 216
Note input on page 157

Key signature arrangements
Dorico SE automatically follows conventions for the placement and appearance of key signatures, 
such as showing accidentals in the accepted circle of fifths order and positioning key signatures 
between clefs and time signatures.

The order in which accidentals are shown in key signatures is different for sharp keys and flat 
keys.

● For sharps: F♯, C♯, G♯, D♯, A♯, E♯, B♯
● For flats: B♭, E♭, A♭, D♭, G♭, C♭, F♭
Accidentals are arranged automatically in these orders in Dorico SE for all standard Western key 
signatures. There is an accepted pattern for the placement of accidentals in a key signature, so 
that they fit inside the staff according to the current clef. The pattern of accidentals is the same 
in all clefs, apart from the tenor clef, which requires sharp key signatures to follow a different, 
ascending pattern to ensure the accidentals fit on the staff.
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Clef Arrangement of sharps Arrangement of flats

Treble

Bass

Alto

Tenor

RELATED LINKS
Positions of key signatures on page 696

Types of key signatures
There are multiple types of key signatures in Dorico SE, which can all be input, moved, and 
deleted in the same ways.

Major and minor key signatures

The key signature for a major key appears the same as the key signature for its relative minor, 
and vice versa. For example, B♭ major has two flats in its key signature. This is the same number 
of flats as for G minor, which is the relative minor key to B♭ major. The difference is that music 
in G minor usually has sharpened Fs, as the seventh degree of the scale is raised in minor keys. 
Therefore, if you input an F♯/G♭ after a G minor key signature, Dorico SE prefers to spell it as F♯ in 
most cases, in order to follow the convention of harmonic minor keys.

A B flat major scale following a B flat major key 
signature

A G minor scale following a G minor key signature

Open key signature

Although open, or atonal, key signatures appear the same as C major or A minor key signatures 
because none shows any accidentals, open key signatures behave differently.

In an open key signature, the spelling of accidentals is based on the current direction of the 
music. If the music is rising, sharps are preferred, whereas if the music is falling, flats are 

Key signatures
Types of key signatures 
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preferred. There is no hierarchy of pitches in an open key signature, so the same pitch might be 
spelled differently each time it appears depending on its context, even within a few bars.

In a C major or A minor key signature, accidentals are spelled based on the context of the major 
or minor tonality implied. For example, in C major, sharps in general are preferred, whether the 
music is going up or going down. Similarly, in A minor, G♯ in particular is preferred, whether the 
music is going up or going down, as G♯ is the leading note in A minor.

No key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have added the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

Any pitch can be input into these instruments, and they show accidentals if needed.

RELATED LINKS
Adding instruments to players on page 105

Deleting key signatures
You can delete key signatures without affecting the pitches of notes. Where appropriate, pitches 
are shown with accidentals after you have deleted a key signature.

NOTE

● You cannot hide key signatures as they provide crucial information about the pitch of notes. 
If you do not want to see a key signature, you can input an open key signature or delete all 
key signatures from the flow or project.

● Instruments that do not usually have key signatures, such as timpani or horn, have a No key 
sig version in Dorico SE which never show key signatures. You can select the appropriate 
instrument type from the instrument picker when adding or changing instruments.

PROCEDURE

1. In Write mode, select the key signatures or signposts of key signatures you want to delete.

2. Press Backspace or Delete .

RESULT
The selected key signatures are deleted from the score. The pitches of notes in the bars following 
the deleted key signatures are not changed, but the notes are shown with accidentals if the 
deleted key signature indicated an accidental for them, up until the next existing key signature or 
the end of the flow.

NOTE

If you delete the only key signature in the flow, your music appears without a key signature, with 
accidentals shown as necessary. This is treated as if there were an open key signature rather 
than a key signature of A minor or C major.

RELATED LINKS
Input methods for key signatures on page 216

Key signatures
Deleting key signatures 
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Adding instruments to players on page 105
Changing instruments on page 107
Signposts on page 349

Multiple simultaneous key signatures
You can have multiple key signatures simultaneously by inputting each one onto a single staff.

NOTE

You do not have to input multiple simultaneous key signatures if you have transposing 
instruments in your score. Dorico SE handles instrument transpositions automatically.

You can check the transposition of transposing instruments by choosing Edit > Transposed Pitch 
to see the music in your layout at written pitch rather than concert pitch.

Alternatively, you can open the individual part layout of a transposing instrument and compare it 
to the full score.

RELATED LINKS
Input methods for key signatures on page 216

Positions of key signatures
Key signatures are positioned between clefs and time signatures by default, and are shown 
on every staff that requires a key signature. They are not shown on staves for unpitched 
instruments.

Key signatures are shown at the start of a piece and at the start of subsequent movements, 
even if the music carries straight on and in the same key. Unlike time signatures, key signatures 
appear at the start of every system, even if the key signature has not changed. They apply until 
the end of the flow or until the next key signature change, whichever comes first.

The correct position for key signatures is between clefs and time signatures.

If a key signature change occurs during a piece or movement, it should be placed immediately 
after a barline. It is customary to have a double barline where a key signature change takes 
place, which is the default setting in Dorico SE.

Examples of key signatures positioned after double barlines

You can move key signatures to new rhythmic positions in Write mode. They are automatically 
positioned correctly.

RELATED LINKS
Key signature arrangements on page 693
Moving key signatures rhythmically on page 697

Key signatures
Multiple simultaneous key signatures 
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Moving key signatures rhythmically
You can move key signatures to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the key signatures you want to move.

NOTE

When using the mouse, you can only move one key signature rhythmically at a time.

2. Move the selected key signatures according to the current rhythmic grid resolution in any of 
the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the key signature to the right/left.

RESULT
The key signatures are moved to new rhythmic positions. They take effect from their new 
positions until the next key signature, or the end of the flow, whichever comes first.

NOTE

● Key signatures can only be moved along the staff. If you want to move a key signature across 
staves, you must delete the key signature and input a new key signature on the other staff.

● Only one key signature can exist at each rhythmic position, except for key signatures that 
only apply to single staves. If a key signature passes over another key signature as part of its 
move, the existing key signature is deleted and replaced by the key signature being moved.

You can undo this action, but any key signatures deleted in the process are only restored if 
you moved the key signature using the keyboard.

RELATED LINKS
Input methods for key signatures on page 216

Transposing key signatures alongside selections
You can transpose key signatures at the same time as transposing notes, which transposes both 
key signatures and notes by the same degree.

NOTE

Dorico SE automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PROCEDURE

1. In Write mode, make a selection that includes both a key signature change and notes.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

Key signatures
Transposing key signatures alongside selections 

697
Dorico SE 3.5.12



TIP

● We recommend using the Calculate interval section to determine your required 
settings, for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Activate Transpose key signatures.

It is activated automatically if your selection includes a key signature.

5. Click OK to save your changes and close the dialog.

RESULT
All notes and key signatures within the selection are transposed by the degree you set in the 
dialog.

NOTE

If a key signature included in the transposed selection applies to all staves, then it is transposed 
on all staves in the layout, even if your selection did not include all staves.

Individual key signatures, that is, key signatures added only to single staves using the Alt  key, 
are transposed if included in a selection, but this does not affect any other staff in the layout.

RELATED LINKS
Transpose dialog on page 203
Concert vs. transposed pitch on page 127
Making layouts transposing/concert pitch on page 127
Selecting/Deselecting notes and items individually on page 334
Large selections on page 336

Enharmonic equivalent key signatures
Enharmonic equivalent key signatures are keys with different names that include the same 
pitches, such as C♯ major and D♭ major. Dorico SE follows the convention for transposing to keys 
with the same type of accidental as the previous key, except where the enharmonic equivalent 
key signature has fewer accidentals.

When transposing selections of notes, Dorico SE prefers keys with the same type of accidental as 
the previous key signature. When choosing key signatures for transposing instruments, Dorico 
SE prefers key signatures with the same type of accidental as the current concert pitch key.

However, there are some instances where you might prefer to transpose to a key with a different 
type of accidental as it has fewer accidentals than the enharmonic equivalent key. For example, 
C♯ major has seven sharps, whereas the enharmonic equivalent key of D♭ major only has five 
flats. This means the player has to remember the accidentals for fewer notes.

Transposing to an enharmonic equivalent key with fewer accidentals can have the added benefit 
of improving readability by avoiding double sharps or double flats. For example, transposing 
music from F♯ to G♯ requires the leading note to be spelled as an F, but transposing to A♭ instead 
means the leading note is G♮.

Key signatures
Enharmonic equivalent key signatures 
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G♯ major requires a double sharp leading note A♭ major, the enharmonic equivalent to G♯, does not 
require a double sharp leading note

By default, Dorico SE selects an enharmonic equivalent key signature if it has fewer accidentals.

How key signatures affect transposing instruments

If there is a key signature in the full score, it is transposed for a transposing instrument by the 
same degree as the transposing interval for the instrument. For example, in a project in E major, 
a B♭ clarinet part has a key of F♯ major, as a B♭ clarinet sounds a whole step (tone) below its 
notated pitch.

Instruments that do not show a key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have input the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

You can still transpose music in the staves of these instruments, but they show accidentals as 
necessary, instead of showing a key signature.

RELATED LINKS
Transpose dialog on page 203
Transposing selections on page 202
Respelling notes on page 200
Adding instruments to players on page 105

Cautionary key signatures
When a key signature change occurs at a system break, either in the score or in a part, the new 
key signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary key signature”, as players become used to seeing the 
key signature at the start of the system and therefore may miss a change of key signature if it is 
not conspicuously shown at the end of systems.

In Dorico SE, as key signature changes occur immediately after barlines, the key signature at the 
end of a system is the key signature itself, rather than a cautionary key signature.

If the music is separate enough that you do not want to see a key signature at the end of a 
system and you cannot change where the system break occurs, you can separate the music by 
creating a new flow at the point of the system break.

RELATED LINKS
Flows on page 122
Splitting flows on page 355
Inserting system breaks on page 388

Key signatures
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Tonality systems
The term “tonality system” is used in Dorico SE to encompass three crucial elements that 
together make up the concept of tonality.

The three elements that make up tonality systems are:

● A number of equal divisions of the octave, or EDO. For example, standard Western scales 
with half-step (semitone) steps have 12-EDO.

● A set of accidentals. This allows you to notate how much a note is raised or lowered.

● A key signature. In Dorico SE, you can use any traditional Western key signature.

RELATED LINKS
Custom tonality systems on page 700

Equal Division of the Octave (EDO)
EDO stands for Equal Division of the Octave: the number of equal pieces, or intervals, into which 
an octave is divided.

Traditional Western harmony is based on equal temperament, another method used to describe 
tonality systems, or 12-EDO, as the traditional scale from C-C is made up of twelve steps spread 
across the seven notes in the scale.

For example, between the notes A and B there are two steps, but between B and C there is one 
step. This is because in 12-EDO, each step represents a half-step (semitone), and there are two 
half-steps between A and B according to standard equal temperament, but only one half-step 
between B and C.

Other tonality systems can have different equal divisions of the octave, for example, in 24-EDO 
each octave division is a quarter tone. However, the only tonality system in Dorico SE is 12-EDO.

RELATED LINKS
Custom tonality systems on page 700

Custom tonality systems
Custom tonality systems allow you to specify a unique number of divisions of the octave for your 
project. This can be useful for music not based on traditional Western harmony. Custom tonality 
systems are only available in Dorico SE if you open a project that already contains them, and you 
cannot change where they apply.

Key signatures
Tonality systems 
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Lyrics

In Dorico SE, the term lyrics is used for all text that is sung by singers.

To differentiate sung text from any other forms of text that often appear in musical scores, other 
forms of text are referred to as performance instructions, tempos, dynamics, and so on.

Lyrics for a soprano duet with basso continuo accompaniment

In Dorico SE, lyrics were designed so that it is simple to make changes to existing lyrics without 
having to re-input new lyrics each time. For example, you can change the syllable type of lyrics so 
that they are either followed or not followed by a hyphen.

Lyrics are organized into lines to ensure consistent horizontal alignment and to make showing 
verse numbers simple and accurate. There are different types of lyric lines for lyrics with different 
purposes, and the appearance of lyrics changes depending on their line type. For example, lyrics 
in a chorus line are shown in an italic font.

When inputting lyrics, you can use key commands to switch between lyric lines, to change on 
which side of the staff lyrics are input, and to switch the lyric style between normal lyrics, chorus 
lyrics, and translation lyrics. You can also change the type of lyrics after they have been input.

You can input multiple lines of lyrics, chorus lyrics, and translations, both above or below staves. 
You can filter existing lyrics according to their type and lyric line.

RELATED LINKS
Types of lyrics on page 703
Lyric line numbers on page 712
Filters for lyrics on page 702
Inputting lyrics on page 310
Changing the syllable type of existing lyrics on page 705

General placement conventions for lyrics
Lyrics are generally placed below the staff to which they apply, and are positioned so that they 
align horizontally with their corresponding notehead.

A plain font is generally used for normal lyrics, and an italic font is generally used for chorus 
lyrics and translation lyrics in order to differentiate them.
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The horizontal spacing of lyrics must be wide enough so that words or syllables do not overlap 
with the words or syllables on either side. For this reason, note spacing must sometimes be 
adjusted to accommodate lyrics.

To reduce how severely the note spacing is changed to accommodate lyrics, which can distort 
the appearance of rhythms, Dorico SE allows the alignment of some lyrics to be adjusted relative 
to their corresponding notes. For example, if a long, single-syllable word on a long note follows 
another long, single-syllable word on a short note, the second word is moved a little to the right 
to give both words enough space.

A short note followed by a long note, where the horizontal position of the lyrics is automatically adjusted for 
legibility.

RELATED LINKS
Positions of lyrics on page 710

Filters for lyrics
In Dorico SE, lyrics filters allow you to select all lyrics of a specified type across your project or 
across a specific selection.

The following filters are available in the menu when you choose Edit > Filter > Lyrics:

All Lyrics
Selects all types of lyrics in the current selection, with any lyric line number and 
placement above/below the staff.

Line 1
Selects only Line 1 lyrics and translation lyrics for Line 1 in the current selection, 
including Line 1 below the staff and Line 1 above the staff.

Line 2
Selects only Line 2 lyrics and translation lyrics for Line 2 in the current selection, 
including Line 2 below the staff and Line 2 above the staff.

Line 3
Selects only Line 3 lyrics and translation lyrics for Line 3 in the current selection, 
including Line 3 below the staff and Line 3 above the staff.

Line 4
Selects only Line 4 lyrics and translation lyrics for Line 4 in the current selection, 
including Line 4 below the staff and Line 4 above the staff.

Line 5
Selects only Line 5 lyrics and translation lyrics for Line 5 in the current selection, 
including Line 5 below the staff and Line 5 above the staff.

Above Staff
Selects all lyrics above the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.
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Below Staff
Selects all lyrics below the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Chorus
Selects all chorus lyrics in the current selection.

Translations
Selects all translation lyrics in the current selection.

Selecting lyrics using filters
You can use lyric filters to select all lyrics of a specified type across your project or across a 
specific selection.

PREREQUISITE
You filter setting is set to Select Only. You can check this by choosing Edit > Filter > Select Only.

PROCEDURE

1. In the music area, make a selection that includes all the lyrics you want to select.

For example, press Ctrl/Cmd-A  to select the whole flow.

2. Choose Edit > Filter > Lyrics > [Lyrics type].

RESULT
All lyrics of the selected type in your selection are selected. For example, if you choose Edit > 
Filter > Lyrics > Chorus, all chorus lyrics in your selection are selected.

RELATED LINKS
Large selections on page 336

Types of lyrics
Lyrics are divided into different lyric types in Dorico SE.

Lyric lines
Lyric lines contain normal lyrics and can be shown with verse numbers. They can be 
both below and above the staff.

Chorus lines
Chorus lines contain lyrics in an italic font and are placed between lyric lines. For 
example, if there are two lyric lines, the chorus line appears between Line 1 and Line 2.

Chorus lines do not have verse numbers.

Lyric line translations
Lyric line translations show the text in lyric lines or chorus lines in different languages. 
They are placed directly below the lyric line or chorus line of which they are a 
translation. They are shown in an italic font.

Each lyric line can have its own lyric line translation, including chorus lines.

Lyric line translations do not have verse numbers, as they are part of the line of which 
they are a translation.
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You can input all types of lyrics using the lyrics popover. The icon shown on the left-hand side of 
the popover indicates the type of lyric currently being input.

RELATED LINKS
Lyric line numbers on page 712
Changing the line number and type of lyric lines on page 713
Lyrics popover on page 311

Changing the type of individual lyrics
You can change the type of individual lyrics after they have been input. For example, you can 
change lyrics into chorus lyrics or translation lyrics.

PROCEDURE

1. Select the individual lyrics whose type you want to change.

2. In the Properties panel, activate/deactivate the following properties, individually or together, 
in the Lyrics group:

● Chorus

● Is translation

RESULT

● Activating Chorus changes the selected individual lyrics to chorus lyrics.

● Activating Is translation changes the selected lyrics to translation lyrics of the same lyric line 
number. For example, selecting lyrics in Line 2 and activating Is translation turns them into 
translation lyrics for Line 2.

● Activating both properties changes the selected lyrics to translation lyrics of the chorus.

● Deactivating both properties changes the selected lyrics to normal lyrics. Their line number 
is indicated by the number in Line number in the Lyrics group of the Properties panel.

NOTE

If other chorus lines exist at the same position on the side of the staff where you want to change 
your current selection to chorus lines, the two lines collide. To avoid this, change the type of the 
whole lyric line, which automatically avoids collisions.

RELATED LINKS
Showing lyrics in italics on page 710

Types of syllables in lyrics
There are different types of syllables in lyrics, depending on their position in words. The key you 
press to advance the popover indicates the syllable type for each lyric.

Dorico SE defines lyrics as different syllables depending on how you advance the popover when 
inputting lyrics.

Whole word
Lyrics are considered a whole word if the lyric comes after a gap and is followed by a 
gap or a period.

No hyphens are shown either side of whole word lyrics. Extender lines can be shown 
after lyrics.
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Start
Lyrics are considered the start syllable in a multi-syllabic word if the lyric comes after a 
gap, but is followed by a hyphen.

Hyphens are shown after start lyrics, which can be continuation hyphens depending on 
the distance before the next lyric in the same lyric line.

Middle
Lyrics are considered the middle syllable in a multi-syllabic word if the lyric comes after 
a hyphen, and is followed by a hyphen.

Hyphens are shown after middle lyrics, which can be continuation hyphens depending 
on the distance before the next lyric in the same lyric line.

End
Lyrics are considered the end syllable in a multi-syllabic word if the lyric comes after a 
hyphen but is followed by a gap or a period.

Extender lines can be shown after end lyrics.

RELATED LINKS
Inputting lyrics on page 310

Changing the syllable type of existing lyrics
You can change the syllable type of lyrics after they have been input.

For example, if you advanced the lyrics popover to the next note by pressing Space  but you later 
want it to be followed by a hyphen, you can change its syllable type.

NOTE

Changing the syllable type changes whether a hyphen is shown after the selected lyrics, not 
before them. Therefore, if you want to show a hyphen before lyrics, you must change the syllable 
type of the lyrics immediately preceding them.

PROCEDURE

1. Select the lyrics whose syllable type you want to change.

2. In the Properties panel, select one of the following options from the Syllable type menu in 
the Lyrics group:

● Whole word

● Start

● Middle

● End

RESULT
Lyrics with a syllable type of Whole word or End are followed by a space.

Lyrics with a syllable type of Start or Middle are followed by a hyphen.

RELATED LINKS
Inputting lyrics on page 310
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Deleting lyric lines
You can delete whole lines of lyrics.

PROCEDURE

1. In Write mode, select the staves from which you want to delete a whole lyric line.

2. Select just the lyric line you want to delete by choosing Edit > Filter > Lyrics > [Lyrics type].

3. Press Backspace or Delete .

RESULT
All lyrics in the selected lyric line are deleted.

RELATED LINKS
Filters for lyrics on page 702
Selecting lyrics using filters on page 703
Large selections on page 336

Deleting lyrics individually
You can delete individually selected lyrics without deleting other lyrics in the same lyric line.

PROCEDURE

1. In Write mode, select the lyrics you want to delete.

2. Press Backspace or Delete .

RESULT
The selected lyrics are deleted.

Copying/Pasting lyrics
You can copy and paste lyrics from both existing lyric lines in Dorico SE and from external text 
editors, for example, if you want to copy a lyric line to a player who has different rhythms to the 
source but uses the same lyrics.

When copying text from outside Dorico SE, you must format the text so it is suitably separated 
into syllables, for example, by adding hyphens in multi-syllabic words. This ensures Dorico SE 
can correctly identify the characters required for each word/syllable and therefore format the 
resulting lyrics appropriately. There are automatic hyphenation tools that you can use, but 
results from these are not always reliable. Dorico SE checks text you have copied to your 
clipboard to make sure it contains only single spaces and single hyphens for correct syllable 
input.

NOTE

You cannot currently copy/paste lyrics containing Chinese, Japanese, or Korean characters. This is 
planned for future versions.

PROCEDURE

1. Select the lyrics/text you want to copy. You can do this within Dorico SE or externally.
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NOTE

● If you are copying existing lyrics/text in Dorico SE, you must be in Write mode.

● If you want to select many existing lyrics in Dorico SE, you can use filters for lyric lines or 
you can select a single lyric and press Ctrl/Cmd-Shift-A  multiple times to select the rest 
of the lyrics in the lyric line.

2. Press Ctrl/Cmd-C  to copy the selected lyrics/text.

3. In Write mode, select the first note in the voice to which you want to copy lyrics.

4. Press Shift-L  to open the lyrics popover.

By default, the lyrics popover opens with lyric line input selected.

5. Optional: Change the lyric type into which you will paste lyrics in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To change to a lyric line above the staff, press Shift - Up Arrow .

● To change to a chorus line, press Up Arrow .

● To change to a translation lyric line, press Alt/Opt - Down Arrow .

6. Press Ctrl/Cmd-V  to paste the first word/syllable of the copied lyrics/text.

The lyrics popover automatically advances to the next note in the selected voice according 
to the source text. For example, for syllables followed by hyphens in the source, the popover 
advances as if you had pressed -  (hyphen), which automatically shows hyphens after those 
syllables.

7. Optional: For words/syllables that you want to apply to two or more notes, you must advance 
the popover manually in one of the following ways:

● After complete words or the final syllable in multi-syllabic words, press Space .

● After syllables that are not the final syllable in multi-syllabic words, press -  (hyphen).

● After syllables that you do not want to be followed by an extension line or hyphen, press 
Right Arrow .

8. Continue pressing Ctrl/Cmd-V  for each word/syllable you want to paste.

RESULT
The selected lyrics/text is pasted into the selected lyric line belonging to the voice in which you 
selected a note.

NOTE

Words/syllables are removed from your clipboard as you paste them. If you want to paste the 
same lyrics/text into another lyric line or staff, you must copy the source again.

RELATED LINKS
Edit Lyrics dialog on page 708
Large selections on page 336
Selecting lyrics using filters on page 703
Selecting more items of the same type on page 334
Lyrics popover on page 311
Inputting lyrics on page 310
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Lyric text editing
Proofreading lyrics can be challenging, because lyrics are spaced more widely than regular text 
and individual words are often split up over large horizontal distances. In Dorico SE, you can 
change the text of individual words/syllables within the lyrics popover and also by viewing entire 
lyric lines in a single dialog.

Editing existing lyrics
You can change the text of lyrics after they have been input, for example, to correct misspellings.

NOTE

This resets any properties you had set on the affected lyrics.

PROCEDURE

1. In Write mode, select the lyric you want to change.

NOTE

You can only change one lyric at a time.

2. Press Return  or Shift-L  to open the lyrics popover.

3. Change the existing text in the lyrics popover.

4. Optional: If you want to change other existing lyrics, advance the popover in one of the 
following ways:

● To advance the popover to the next note if you entered a complete word, or the final 
syllable in a multi-syllabic word, press Space .

Existing lyrics are automatically selected in the popover when you press Space .

● To advance the popover to the next note if you entered one syllable of a multi-syllabic 
word, press - .

● To move the cursor one character to the right, press Right Arrow .

● To move the cursor one character to the left, press Left Arrow .

The cursor automatically moves to the next/previous lyric/note if you keep pressing the 
arrow keys.

5. Press Return  or Esc  to close the popover when you have finished changing lyrics.

The popover closes automatically when you reach the last note on the staff.

RELATED LINKS
Lyric line numbers on page 712
Inputting lyrics on page 310

Edit Lyrics dialog
The Edit Lyrics dialog allows you to view and edit entire lyric lines in one place and with the 
text displayed with consistent spacing. This is more convenient than changing each word/syllable 
individually alongside the music, where lyrics can be split up over large horizontal distances.

● You can open the Edit Lyrics dialog by making a selection that includes at least a single lyric 
and choosing Edit > Lyrics > Edit Line of Lyrics.
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The dialog shows all lyrics in the same lyric line as the selected lyric and allows you to edit the 
lyrics, such as fixing misspellings, adding commas, or changing where in a word the hyphen is 
placed. If you selected multiple lyrics to open the dialog, Dorico SE populates the dialog with the 
lyric line of the earliest lyric on the highest staff you selected.

The Edit Lyrics dialog comprises the following:

1 Text editor

Allows you to edit all the lyrics in the selected lyric line in the current flow, with hyphens and 
spaces as appropriate. For example, you can add a comma after the final syllable in a line for 
a poem setting or replace a hyphen with a space.

NOTE

You cannot add, delete, or change the duration/rhythmic position of lyrics, such as the 
number of notes to which each lyric applies.

2 Zoom controls

Allow you to increase/decrease the size of text in the dialog.

3 Current number of lyrics

Displays the number of lyrics currently shown in the text editor and the target number of 
lyrics in the lyric line. The target number is the number of lyrics that already exists in the 
selected lyric line in the flow.

The current number of lyrics updates automatically as you work in the dialog. Dorico SE 
requires the current number and target number of lyrics to match before you can confirm 
the dialog.

4 OK button

Allows you to confirm your changes and close the dialog. You can only confirm the dialog 
when the current number and target number of lyrics match.

NOTE

Any properties you had previously set on any lyrics in the line, such as making them italic, are 
reset when you confirm the dialog.
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Showing lyrics in italics
You can show individual lyrics in an italic font without changing their font style, lyric type, or 
staff-relative placement. You can do this for the current layout and frame chain only or for all 
layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics you want to show in an italic font.

2. In the Properties panel, activate Italic in the Lyrics group.

RESULT
The selected lyrics are shown in an italic font. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

If you want to show lyrics in an italic font because they are intended to be either chorus lyrics or 
translation lyrics, you can change their lyric type instead.

RELATED LINKS
Changing the line number and type of lyric lines on page 713
Changing the type of individual lyrics on page 704
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Positions of lyrics
Dorico SE automatically positions lyrics and makes adjustments to accommodate variations in 
the length of lyrics, including adjusting the horizontal alignment of lyrics in melismatic music.

NOTE

The horizontal position of lyrics is automatically adjusted in Dorico SE to minimize changes to the 
note spacing. Syllables are moved by small amounts either left or right to accommodate longer 
syllables without distorting the appearance of note rhythms.

You can prevent Dorico SE from considering lyrics in note spacing calculations using the Make 
space for lyrics option on the Note Spacing page in Setup > Layout Options; however, we 
recommend using this option with caution.

Positions of syllables

The number of notes sung on syllables or words determines how the lyrics are positioned:

● Single syllables, which are whole words or parts of longer words that are sung on only one 
note, are centered on their corresponding note.

● Melismata, which are syllables or words that are sung on more than one note, are left-
aligned with the left side of the first note to which they apply.
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Placement of lyric lines

Lyrics are placed relative to other lyric lines according to their line number. For example, lyrics in 
Line 1 are placed at the top, including when there are multiple lyric lines above the staff.

If a line of lyrics is missing across the width of a whole system, no additional gap is left between 
the remaining lines of lyrics.

EXAMPLE
You have three lines of lyrics, but one system does not have a second line of lyrics. On this 
system, the third line of lyrics is moved upwards, closer to the first line of lyrics.

If a subsequent system does not have a first line, but does have the second and third lines, then 
the second and third lines of lyrics are moved upwards. The second line of lyrics takes the place 
of the first line.

RELATED LINKS
Changing the staff-relative placement of lyric lines on page 714
Note Spacing page in Layout Options on page 407

Moving lyrics rhythmically
You can move lyrics to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the lyrics you want to move.

2. Move the lyrics according to the current rhythmic grid resolution in any of the following 
ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

NOTE

You cannot move lyrics rhythmically with the mouse, you can only move them using the 
keyboard.

RESULT
The selected lyrics are moved to new rhythmic positions.

Changing the alignment of lyrics relative to notes
By default, the center of lyrics is aligned horizontally with noteheads, but you can change the 
horizontal alignment of individual lyrics. You can do this for the current layout and frame chain 
only or for all layouts and frame chains.

There is no default setting for the alignment of lyrics relative to notes, as Dorico SE automatically 
adjusts the horizontal position of lyrics to minimize note spacing changes.

NOTE

Changing the alignment of lyrics manually overrides Dorico SE’s automatic spacing for the 
selected lyrics, meaning that note spacing at the affected rhythmic positions might change.
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PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics whose alignment you want to change.

2. In the Properties panel, activate Lyric text alignment in the Lyrics group.

3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the selected lyrics is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Lyric hyphens and lyric extender lines
Lyric hyphens indicate that individual lyrics are syllables within multi-syllabic words, for example, 
“Hal-le-lu-jah”. Lyric extender lines indicate that individual lyrics, either whole words or the last 
syllables in multi-syllabic words, extend across multiple notes.

A phrase containing hyphens and an extender line

Dorico SE automatically inputs and positions lyric hyphens when you advance the lyrics popover 
by pressing -  between syllables, and lyric extender lines when you advance the lyrics popover by 
pressing Space  multiple times after an entry.

Lyric line numbers
Lyric line numbers are used to organize lyrics when a single musical passage can have different 
lyrics sung to it, such as music that contains multiple verses. In Dorico SE, you can specify the line 
number of lyrics as you input them and by changing the line number of existing lyrics.

For example, if you input lyrics in Line 3 but later want to change those lyrics to Line 4 because 
you want to input different lyrics as Line 3, you can change your current Line 3 into Line 4, and 
then input a new line of lyrics as Line 3. The spacing is automatically adjusted to show lyric lines 
in the correct order.
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The start of a choral piece with three lyric lines for its three verses

In Dorico SE, you can have multiple lines of lyrics both above and below the same staff. Turning 
lyric lines into chorus lyric lines or lyric line translations changes both their placement and 
appearance as chorus lyrics generally use an italic font.

RELATED LINKS
Verse numbers on page 716
Filters for lyrics on page 702
Showing lyrics in italics on page 710

Changing the line number and type of lyric lines
You can change the lyric line number of whole lyric lines after they have been input. You can also 
change whole lyric lines to chorus lines and lyric line translations.

For example, you can change the existing Line 1 into a lyric translation of Line 4, or change Line 2 
into a chorus line.

TIP

To identify which line you are working on, select a syllable in the line of lyrics and check the 
number in the Line number value field in the Lyrics group of the Properties panel.

PROCEDURE

1. In Write mode, select a lyric in the line whose lyric line type you want to change. The lyric line 
can be above or below the staff.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers.

2. Change the line type of the selected lyric line in one of the following ways:

● Choose Edit > Lyrics > Line > [Line number].

● Choose Edit > Lyrics > Line > Chorus.

● Choose Edit > Lyrics > Translations > [Line number Translation].

● Choose Edit > Lyrics > Translations > Chorus Translation.
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TIP

You can also choose these options from the context menu.

RESULT
The line number or type of the whole lyric line of the selected lyric is changed.

NOTE

The position of the selected lyric line relative to other lyric lines at the same position might be 
changed. For example, if there were two lyric lines and you changed Line 1 to Line 3, it now 
appears below Line 2.

If a lyric line with the same number already exists at the same position on the same side of the 
staff, the two lines switch. For example, if there is already a Line 1 at the rhythmic position where 
you want to change Line 2 to Line 1, then the existing Line 1 becomes Line 2 to accommodate 
your most recent preference. The same applies to chorus lines and lyric line translations.

RELATED LINKS
Lyric line numbers on page 712
Types of lyrics on page 703
Filters for lyrics on page 702

Changing the line number of individual lyrics
You can change the lyric line number of individually selected lyrics after they have been input.

PROCEDURE

1. Select the individual lyrics whose line number you want to change.

2. In the Properties panel, change the value for Lyric number in the Lyrics group.

RESULT
The line number of the selected lyrics is changed to match the value in the value field.

NOTE

The position of the selected lyrics relative to other lyric lines might be changed. For example, if 
there were two lyric lines and you changed lyrics in Line 1 to Line 3, they now appear below Line 
2.

Changing the staff-relative placement of lyric lines
You can change the staff-relative placement of whole lyric lines after they have been input.

PROCEDURE

1. In Write mode, select a lyric in each line whose staff-relative placement you want to change.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers and staff-relative placement.
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2. Select the staff-relative placement you want in one of the following ways:

● Choose Edit > Lyrics > Placement > Above.

● Choose Edit > Lyrics > Placement > Below.

TIP

You can also choose these options from the context menu.

RESULT
The staff-relative placement of the whole lyric lines in which you selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number exist at the same position on the side of 
the staff to which you want to change your current selection, the two lines switch sides. For 
example, if there is already a Line 2 above the staff at the position where you want to change the 
placement of Line 2 below the staff, then the existing Line 2 above the staff is placed below the 
staff to accommodate your most recent preference.

RELATED LINKS
Lyric line numbers on page 712
Filters for lyrics on page 702
Changing the line number and type of lyric lines on page 713

Changing the staff-relative placement of individual lyrics
You can change the staff-relative placement of individual lyrics within lyric lines.

PROCEDURE

1. Select the lyrics whose staff-relative placement you want to change.

2. In the Properties panel, choose one of the following options for Line placement in the 
Lyrics group:

● Above

● Below

RESULT
The staff-relative placement of the selected individual lyrics is changed.

NOTE

If other lyric lines with the same lyric line number already exist at the same position on the same 
side of the staff, the two lines collide. To avoid this, change the lyric line number of one of the 
lyric lines, or change their staff-relative placement by choosing Edit > Lyrics > Placement and 
selecting an option from the menu, which avoids collisions.
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Verse numbers
Verse numbers indicate the order in which lyrics are sung when multiple lines of lyrics share the 
same musical passage. They are commonly used in hymns and song sheets.

Depending on the type of music you are writing, verse numbers might not be appropriate. 
Therefore, hiding/showing verse numbers in Dorico SE is optional. By default, verse numbers are 
not shown. You can hide/show verse numbers on individually selected lyrics.

NOTE

Lyric line translations are part of the lyric line of which they are a translation so do not have their 
own verse number.

Hiding/Showing verse numbers on individual lyrics
You can hide/show verse numbers on individual lyrics, for example, if you want to show the verse 
number at the start of every system.

PROCEDURE

1. Select the lyrics before which you want to hide/show verse numbers.

2. In the Properties panel, activate/deactivate Show verse number in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Verse numbers are shown before the selected lyrics when the checkbox is activated, and hidden 
when the checkbox is deactivated.

East Asian elision slurs
East Asian elision slurs are used to show that two or more characters in East Asian languages are 
part of the same lyric.

A phrase containing an East Asian elision slur

You can hide/show East Asian elision slurs on individual lyrics.

Hiding/Showing East Asian elision slurs
You can hide/show East Asian elision slurs for individual lyrics. You can do this for the current 
layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics on which you want to show East Asian elision slurs.
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2. In the Properties panel, activate/deactivate Show East Asian elision slur in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
East Asian elision slurs are shown on the selected lyrics when the checkbox is activated, and 
hidden when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Notes

Notes are shapes that are positioned on staves to indicate musical pitches. Notes are most 
commonly shown with oval-shaped, round noteheads that are either filled or void depending on 
their duration, but there are many different designs of noteheads that you can use.

Depending on their duration, notes can have stems that help indicate their duration.

In Dorico SE, a sequence of adjacent notes joined with ties is considered a single note of the total 
duration of the tie chain, rather than separate notes. Note grouping is automatically adjusted 
according to the prevailing beat grouping, which is normally set by the time signature.

RELATED LINKS
Inputting notes on page 161
Note spacing on page 406
Stems on page 921
Changing the notehead design of individual noteheads on page 723
Add intervals popover on page 198
Adding notes above/below existing notes on page 197
Bracketed noteheads on page 728
Ties on page 938
Note and rest grouping on page 590
Beam grouping according to meters on page 575

Notehead sets
A notehead set is a collection of related noteheads that together allow you to represent all the 
different noteheads required for the different durations used in music notation.

A typical notehead set contains at least four noteheads:

● A black notehead for quarter notes (crotchets) and shorter

● A white notehead for half notes (minims)

● A wider white notehead for whole notes (semibreves)

● A wider white notehead with one or two vertical strokes on either side, or a square white 
notehead, for double whole notes (breves)

Pitch-dependent notehead sets contain noteheads that vary according to the pitch of notes 
rather than their duration.

● In pitched notehead sets, there are different noteheads for different pitches.

For example, the Pitch Names notehead set shows the letter name and any applicable 
accidental of each note within its notehead.

● In scale degree notehead sets, there is a different notehead for each scale degree, relative to 
the current key signature.

For example, the Aikin 7-shape notehead set uses a different notehead shape for each pitch.
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NOTE

● A single notehead can appear in multiple notehead sets. If you edit a notehead within one 
notehead set, your changes affect the appearance of that notehead in all notehead sets that 
contain it.

● Notehead sets can only contain noteheads of the same type. For example, you cannot use a 
normal notehead in a pitched notehead set.

● You cannot change the type of an existing notehead set or an existing notehead.

RELATED LINKS
Pitch-dependent notehead set designs on page 722

Notehead set designs
There are a number of different notehead set designs that you can use for individual noteheads 
in Dorico SE.

● You can find the available notehead designs by choosing Edit > Notehead > [Notehead 
type] > [Notehead design].

NOTE

Dorico SE does not offer stemless noteheads.

General noteheads

Notehead set design Notehead set name

Larger Noteheads

Default Noteheads

Large Circled Noteheads

Circled Noteheads

Slashed Noteheads (Bottom Left to Top Right)

Notes
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Notehead set design Notehead set name

Slashed Noteheads (Top Left to Bottom Right)

Cross noteheads

Notehead set design Notehead set name

Circle X Noteheads

Large X and Diamond Noteheads

Ornate X Noteheads

Plus Noteheads

With X Noteheads

X Noteheads

X and Circle X Noteheads

X and Diamond Noteheads

Notes
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Triangular noteheads

Notehead set design Notehead set name

Large Arrow Down Noteheads

Large Arrow Up Noteheads

Triangle Down Noteheads

Triangle Left Noteheads

Triangle Right Noteheads

Triangle Up Noteheads

Diamond noteheads

Notehead set design Notehead set name

Diamond Noteheads

Old-Style Diamond Noteheads

White Diamond Noteheads

Wide Diamond Noteheads

Notes
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Slash noteheads

Notehead set design Notehead set name

Muted Slash Noteheads

Oversized Slash Noteheads

Slash Noteheads

Small Slash Noteheads

Round and square noteheads

Notehead set design Notehead set name

Moon Noteheads

Rectangular Noteheads

Round White with Dot Noteheads

RELATED LINKS
Changing the notehead design of individual noteheads on page 723

Pitch-dependent notehead set designs
Pitch-dependent notehead sets use different notehead designs or different notehead colors 
depending on the pitch of notes. There are a number of different pitch-dependent notehead sets 
available in Dorico SE.

● You can find the available notehead designs by choosing Edit > Notehead > [Notehead 
type] > [Notehead design].

Notes
Notehead sets 
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Scale degree noteheads

Notehead set design Notehead set name

Aikin 7-shape Noteheads

Funk 7-shape Noteheads

Walker 4-shape Noteheads

Walker 7-shape Noteheads

Pitched noteheads

Notehead set design Notehead set name

Figurenotes© Noteheads

Pitch Name Noteheads

RELATED LINKS
Notehead sets on page 718
Changing the notehead design of individual noteheads on page 723

Changing the notehead design of individual noteheads
You can change the notehead design of individual noteheads, including trill auxiliary notes. For 
example, cross noteheads might be used to indicate where players should produce pitchless 
sounds, such as air sounds on wind instruments.

NOTE

● These steps do not apply to notes in slash voices.

● If you want to change the notehead design to represent different playing techniques for 
notes belonging to unpitched percussion instruments, you can instead change their playing 
technique.

● If you want to change the notehead design to represent harmonics or rhythm slashes, you 
can instead turn notes into harmonics or change them to a slash voice. You can also input 
slash regions.

Notes
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PROCEDURE

1. Select the noteheads whose design you want to change.

2. Choose Edit > Notehead > [Notehead type] > [Notehead design]. You can also choose 
these options from the context menu.

For example, to change the notehead design of the selected notes to X noteheads, choose 
Edit > Notehead > Crosses > X Noteheads.

RESULT
The notehead design of the selected notes is changed.

TIP

You can assign a key command for each factory default notehead design on the Key Commands 
page in Preferences.

RELATED LINKS
Rhythm slashes on page 869
Slash voices on page 1001
Slash regions on page 869
Changing the voice of existing notes on page 353
Harmonics on page 733
Turning notes into harmonics on page 734
Playing techniques for unpitched percussion instruments on page 985
Changing the playing techniques of unpitched percussion notes on page 988
Key Commands page in the Preferences dialog on page 47

Changing the size of notes
You can change the size of notes individually using the default scale sizes for notes in cues or 
grace notes, or you can use a custom scale size. You can do this for the current layout and frame 
chain only or for all layouts and frame chains.

TIP

If you want to change the size of notes because you want them to be grace notes or cues, you 
can input them as either grace notes or cues instead.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose size you want to change.

2. In the Properties panel, activate any of the following properties in the Common group:

● If you want to use a default scale size, activate Scale.

● If you want to use a custom scale size, activate Custom scale.

● If you want to use a custom scale size based on a default scale size, activate both Scale 
and Custom scale.

3. Optional: If you activated Scale, select one of the following options from the menu:

● Normal

Notes
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● Grace

● Cue

● Cue grace

4. Optional: If you activated Custom scale, change the value in the value field.

RESULT
The size of the selected notes is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

● If you activated Scale, the selected notes are changed to the selected default scale size.

● If you activated Custom Scale, the selected notes are changed to the custom percentage 
scale size you set.

● If you activated both Scale and Custom Scale, the selected notes are changed to the custom 
percentage scale size of the selected default scale size. For example, if you selected Grace 
for Scale then set Custom Scale to 50, the size of the selected notes is half the size of grace 
notes.

RELATED LINKS
Inputting grace notes on page 190
Notehead set designs on page 719
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Moving notes rhythmically
You can move notes, including grace notes, to different rhythmic positions along staves after 
they have been input.

NOTE

Although these steps can apply to tuplet notes, their behavior depends on whether or not 
you have selected their tuplet brackets or tuplet numbers/ratios. We recommend following the 
dedicated steps for moving tuplets.

PROCEDURE

1. In Write mode, select the notes you want to move.

2. Move the selected notes according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

RESULT
The selected notes are moved to new rhythmic positions. If you selected multiple notes, they are 
moved together as a block.

Notes are automatically positioned according to their rhythmic duration and position relative to 
other notes.

Notes
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NOTE

If Chords is not activated and any of your selected notes collide with other notes in the same 
staff and at the same rhythmic position that are in the same voice as your selected notes, the 
existing notes are deleted and replaced with your selected notes.

You can undo moving notes immediately, which restores any notes deleted in the process.

RELATED LINKS
Moving tuplets rhythmically on page 971
Rhythmic grid on page 155
Inputting chords on page 192
Notes toolbox on page 144
Note spacing on page 406
Creating cross-staff beams on page 583
Moving notes to other staves on page 353

Specifying the string for individual notes
You can specify on which string individually selected notes are played for notes belonging to 
string instruments, such as violin, cello, or guitar, for example, to allow you to specify the correct 
harmonic. Many notes can be played on multiple strings, depending on where along its length 
the string is stopped.

Specifying the string can be useful for notes that also have glissando lines or fingering shifts, as 
the string and finger position required to play the note affects the direction of these changes. 
However, the string number is not shown in the music. You can instead input fingerings, which 
can help string players understand the string on which they should play.

NOTE

You can only specify strings on notes belonging to string instruments.

PROCEDURE

1. Select the notes whose assigned string you want to change.

NOTE

If selecting multiple notes at once, select notes only in staves of the same instrument type. 
For example, select multiple Cs in Violin 1 and Violin 2 staves.

2. In the Properties panel, activate String in the Notes and Rests group.

3. Select your preferred string from the menu.

The string number for the instrument is shown, followed by the fundamental pitch and 
the octave number of that string in parentheses. For example, the lowest cello string is 
expressed as 4 (C2).

NOTE

The options available in the menu depend on the selected pitches and the instrument type.

RESULT
The string on which the selected notes are played is changed.
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NOTE

If you subsequently change the pitches of notes, String is automatically deactivated for all notes 
that can no longer be played on their specified string.

RELATED LINKS
Glissando lines on page 763
Changing the direction of string fingering shift indicators on page 672
String indicators on page 674
Inputting string indicators inside the staff on page 303
Turning notes into harmonics on page 734
Changing the harmonic partial on page 735

Hiding/Showing colors for notes out of range
You can show colors for notes that are considered out of range, such as notes too high/low for 
the instrument to play or the voice type to sing, or pitches that do not fit with the current harp 
pedal settings. When colors for notes out of range are hidden, all notes appear black by default.

Colors for notes out of range are considered annotations and are not printed by default.

PROCEDURE

● Choose View > Note And Rest Colors > Notes Out Of Range.

RESULT
Notes out of range appear red when a tick appears beside Notes Out Of Range in the menu, 
and black when no tick appears.

Notes that are considered challenging are shown in a darker red, while notes that are impossible 
or virtually impossible are shown in a bright red.

NOTE

Notes out of the fret range of the corresponding string on tablature are always shown as 
question marks, even if you do not show colors for notes out of range.

EXAMPLE

Colors for notes out of range shown. Three notes in the middle of the phrase are bright red, while the rest 
are the darker red.

AFTER COMPLETING THIS TASK
If showing colors for notes out of range reveals some notes do not fit with the current harp pedal 
settings, you can input a new pedal diagram for that passage or calculate a suitable harp pedal 
diagram.

RELATED LINKS
Inputting harp pedal diagrams on page 300

Notes
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Calculating harp pedal diagrams based on existing music on page 301
Annotations on page 537

Bracketed noteheads
Bracketed noteheads are often used to indicate that notes are optional, editorial, not played in all 
playthroughs in music with repeats, or pressed down but not fully struck on the piano. In Dorico 
SE, you can show brackets on any notehead.

Notehead brackets extend slightly above and below noteheads so it is clear which notes are 
included in each bracket.

A phrase containing round and square notehead brackets

You can also show brackets on noteheads on notation staves and tablature independently of 
each other.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

The following types of notehead brackets are available in Dorico SE:

Round notehead brackets
Round notehead brackets have a similar appearance to slurs, but vertical.

NOTE

On tablature, round brackets are automatically shown around the second note/chord 
and all subsequent notes/chords in tie chains. If you show brackets around all 
noteheads in tie chains on tablature, these automatic notehead brackets are included.

Round brackets on 
single noteheads on 
a notation staff

Round bracket on a 
chord on a notation 
staff Round brackets on 

single noteheads on 
tablature

Round bracket on a 
chord on tablature

Square notehead brackets
Square notehead brackets comprise a straight vertical line with horizontal hooks at 
the top and bottom. Dorico SE automatically adjusts the length of square brackets to 
ensure they do not end on staff lines and their hooks remain visible.

Notes
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Square brackets on 
single noteheads on 
a notation staff

Square bracket on a 
chord on a notation 
staff Square brackets on 

single noteheads on 
tablature

Square bracket on a 
chord on tablature

RELATED LINKS
Showing brackets around one/all noteheads in tie chains on page 730
Showing notes as dead notes on page 782
Inputting notes on page 161
Ties on page 938
Guitar bends on page 768
Guitar pre-bends and pre-dives on page 771
Vibrato bar dives and returns on page 773

Showing brackets on noteheads
You can show round or square brackets on individual noteheads, on single notes within chords, 
and on whole chords. For example, if you want to indicate that specific notes are optional or 
an editorial change, or to show notes belonging to unpitched percussion instruments as ghost 
notes.

NOTE

If you want to show brackets on noteheads to represent dead notes, you can instead show notes 
belonging to fretted instruments as dead notes.

PROCEDURE

1. Select the noteheads on which you want to show brackets.

NOTE

● If you want to show brackets on whole chords, you must select all notes in those chords.

● If you want to show brackets on both notation staves and tablature, you must select 
notes on both.

2. In the Properties panel, activate Bracket style in the Bracketed Noteheads group.

3. Choose one of the following options:

● Round

● Square

RESULT
The corresponding type of notehead brackets is shown on the selected notes. If you only 
selected notes on tablature, brackets are not shown on the corresponding notes on the notation 
staff, and vice versa.

If you selected notes in tie chains, only the first noteheads in the tie chains are bracketed.
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Bracketed noteheads 

729
Dorico SE 3.5.12



If you selected all notes in chords, Dorico SE shows a single bracket for each chord unless they 
contain very large gaps, in which case Dorico SE automatically splits brackets. If you selected 
individual notes within chords, they are each shown with separate brackets.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

TIP

● Deactivating Bracket style hides brackets on the selected notes.

● You can also hide/show brackets on noteheads by choosing Edit > Notehead > Toggle 
Round Brackets or Edit > Notehead > Toggle Square Brackets. You can also choose these 
options from the context menu.

You can assign key commands for these options on the Key Commands page in 
Preferences.

EXAMPLE

Round brackets on single 
noteheads on a notation staff

Round bracket on a chord on a 
notation staff

Split round bracket on a chord on 
a notation staff

Round brackets on single 
noteheads on tablature

Round bracket on a chord on 
tablature

Split round bracket on a chord on 
tablature

RELATED LINKS
Showing notes as dead notes on page 782
Inputting notes on page 161
Velocity lanes on page 437

Showing brackets around one/all noteheads in tie chains
You can change whether brackets appear only on the first notehead in tie chains or span the 
entire duration of the tie chain, that is, with the left bracket on the first notehead and the 
right bracket on the last notehead in the tie chain. By default, brackets appear only on the first 
notehead in tie chains.

PREREQUISITE
You have shown brackets on the required notes.

PROCEDURE

1. Select the notes whose notehead bracket positions relative to tie chains you want to change.
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2. In the Properties panel, activate/deactivate Bracket until end of tie chain in the Bracketed 
Noteheads group.

RESULT
Brackets appear at the start and end of the selected tie chains when Bracket until end of tie 
chain is activated, and only around the first note/chord when it is deactivated.

If you activated Bracket until end of tie chain for a single note in a bracketed chord, the bracket 
on the first chord is not split but an additional bracket appears at the end of the tie chain for 
the selected note only. If you deactivated Bracket until end of tie chain for a single note in a 
bracketed chord whose other notes are bracketed to the end of the tie chain, the bracket at the 
end of the tie chain is split.

If you selected notes on tablature, the automatic brackets shown around the second note/chord 
and all subsequent notes/chords in tie chains are updated to follow your property setting.

EXAMPLE

Brackets around only the first chords in tie chains on 
a notation staff

Brackets at the start and end of whole tie chains on a 
notation staff

Brackets around only the first chord in a tie chain, 
with automatic brackets shown on the second chord 
on tablature

Brackets around the start and end of the whole tie 
chain on tablature

RELATED LINKS
Ties on page 938

Splitting brackets on chords
You can split brackets on any notehead within a chord. By default, Dorico SE automatically shows 
a single bracket for all notes in a chord unless it contains very large gaps, in which case Dorico SE 
automatically splits brackets.

PROCEDURE

1. Select the individual notes in chords immediately above where you want to split brackets.
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2. In the Properties panel, activate Break bracket in the Bracketed Noteheads group.

RESULT
Brackets are split immediately below the selected notes.

EXAMPLE

Chord with single round bracket Chord with split round bracket

RELATED LINKS
Inputting chords on page 192
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Harmonics

Harmonics are pitches produced by touching resonating strings at specific positions along their 
length, allowing the corresponding harmonic partial to sound. Harmonics often have a high pitch 
with a glassy, purer sound than stopped pitches. There are two different types of harmonics: 
natural and artificial.

Harmonic partials are numbered according to their order in the harmonic series, which also 
correlates to the node on the string which produces them. For example, the second partial in the 
harmonic series is produced by the node halfway along a string, that is, the node that divides the 
string into two equal parts. The third partial is produced by the node that divides the string into 
thirds, and so on.

Natural harmonics
Natural harmonics are produced by touching an open string at one of its nodes and 
then bowing or plucking the string. The sounding pitch of the resulting harmonic 
varies according to the node and its corresponding partial in the harmonic series. For 
example, touching the node halfway along a string produces the second partial, which 
sounds an octave above the open string pitch.

Artificial harmonics
Artificial harmonics are produced by stopping a string fully (as if playing a normal note) 
and then touching the string at one of the nodes of its stopped length. The sounding 
pitch of the resulting harmonic varies according to the node and its corresponding 
partial in the harmonic series. For example, touching the node that is the equivalent of 
a fourth higher than the stopped pitch produces the fourth partial, which sounds two 
octaves above the stopped pitch.

To produce artificial harmonics, players must both fully stop the string and touch 
the string at the correct node. This can be more difficult to produce than natural 
harmonics.

A passage for violin alternating between artificial 
and natural harmonics on the A string

The sounding pitches of the same passage

Dorico SE supports multiple conventions for the notation of harmonics on stringed and fretted 
instruments, including for both natural and artificial harmonics. For artificial harmonics shown 
using two noteheads, one normal and one diamond, Dorico SE automatically calculates the 
correct pitch for the touched pitch diamond notehead for the second to sixth harmonic 
partials. These pitches are reflected in playback, using dedicated sounds for harmonics if the 
corresponding playback device includes them.

RELATED LINKS
Appearances/Styles of harmonics on page 737
Changing the harmonic partial on page 735
Hiding/Showing or parenthesizing harmonic accidentals on page 736
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Turning notes into harmonics
You can turn existing notes into artificial and natural harmonics. Harmonics can represent the 
sounding, touched, or stopped pitch.

PREREQUISITE
You have input the notes you want to turn into harmonics. However, the pitch you should input 
depends on the style/appearance you want to use.

● For natural harmonics, we recommend that you input the desired sounding pitch.

● For artificial harmonics, we recommend that you input the stopped pitch.

PROCEDURE

1. Select the notes you want to turn into harmonics.

2. In the Properties panel, activate Type in the Harmonics group.

3. Choose one of the following options:

● Artificial

● Natural

RESULT
The selected notes are turned into harmonics of the corresponding type. If the corresponding 
playback device has dedicated sounds for harmonics, the selected notes automatically use those 
sounds. The sounding pitch of artificial harmonics in playback is also changed accordingly.

● Artificial harmonics represent the second partial by default. They are shown with a diamond 
notehead indicating the touched pitch an octave above the selected notes. On tablature, the 
stopped fret is shown on the left and the touched fret is shown on the right in parentheses.

● Natural harmonics represent the sounding pitch by default. They are shown with a circle 
symbol above the selected notes. On fretted instrument notation staves, natural harmonics 
appear as black diamond noteheads. On tablature, the fret of the touched pitch is shown, 
if it can be calculated; if it cannot be calculated, a pink question mark is shown above the 
tablature.

EXAMPLE
The following examples show the default appearances of natural and artificial harmonics on 
different staves.

Artificial 
harmonic on 
notation staff 
(any instrument)

Artificial 
harmonic on 
tablature

Natural 
harmonic on 
non-fretted 
instrument staff

Natural 
harmonic on 
fretted 
instrument 
notation staff

Natural 
harmonic on 
tablature

Natural 
harmonic on 
tablature that 
cannot be 
calculated

Harmonics
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AFTER COMPLETING THIS TASK
You can change the partial for harmonics. You can also change the appearance of natural 
harmonics and the type of artificial harmonics.

If you want to turn harmonics back into normal notes, deactivate Type in the Harmonics group.

RELATED LINKS
Inputting notes on page 161
Appearances/Styles of harmonics on page 737
Specifying the string for individual notes on page 726
Tablature on page 917

Changing the harmonic partial
By default, harmonics indicate the second partial in the harmonic series, which is an octave 
above the fundamental. You can change the partial for individual harmonics, for example, if you 
want a higher partial instead.

NOTE

Dorico SE can only correctly calculate artificial harmonic partials for nodes two to six.

PROCEDURE

1. Select the harmonics whose partial you want to change.

2. In the Properties panel, activate Partial in the Harmonics group.

3. Change the value in the value field to the node at which the string should be touched to 
produce the partial you want.

RESULT
The partial of the selected harmonics is changed. For artificial harmonics using the Normal type, 
the pitch of the white diamond notehead/parenthesized fret number is updated automatically. 
The sounding pitch of artificial harmonics in playback is also changed accordingly.

EXAMPLE

Artificial harmonic with default partial 
(notation and tablature)

Partial changed to the fifth (notation and 
tablature)

Harmonics
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RELATED LINKS
Tablature on page 917
Specifying the string for individual notes on page 726

Hiding/Showing or parenthesizing harmonic accidentals
You can hide/show individual harmonic accidentals, or show them in round or square brackets, 
independently of hiding/showing or parenthesizing accidentals of stopped pitch notes. You can 
do this for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harmonics whose accidentals you want to hide/show or parenthesize.

2. In the Properties panel, activate Accidental in the Harmonics group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

● Square brackets

RESULT
Accidentals on the selected harmonics are shown, hidden, or shown in round or square brackets. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● If you are hiding/showing many accidentals, we recommend that you consider changing the 
accidental duration rule.

● You can assign key commands for different accidental hiding, showing, and parenthesizing 
commands on the Key Commands page in Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on the normal noteheads that indicate the 
stopped pitch for artificial harmonics shown using diamond noteheads.

RELATED LINKS
Hiding/Showing or parenthesizing accidentals on page 542
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Appearances/Styles of harmonics
Both artificial and natural harmonics can be notated in different ways. In Dorico SE, it is possible 
to indicate the desired sounding pitch, either the stopped or touched pitch, or both stopped and 
touched pitches for individual harmonics.

In this documentation we refer to “styles” of artificial harmonics, because one artificial harmonic 
style indicates the use of a different performance technique, and “appearances” of natural 
harmonics, as their different appearances do not indicate different performance techniques.

Natural harmonics

Circle above
Shows a harmonic circle symbol on the notehead side of notes. Usually indicates the 
desired sounding pitch of the harmonic. Used for natural harmonics on staves that do 
not belong to fretted instruments by default, such as violin.

Diamond notehead
Changes the notehead of notes to a diamond notehead. The diamond notehead 
appears black/filled when the note is a quarter note or shorter, and white/unfilled 
when the note is a half note or longer. Usually indicates the touched pitch required. 
Used for natural harmonics on fretted instrument notation staves by default.

White diamond notehead
Changes the notehead of notes to a diamond notehead that is always unfilled, 
regardless of the duration of notes. Usually indicates the touched pitch required.

On tablature, the touched fret is always shown for natural harmonics, regardless of the selected 
appearance. If the touched fret cannot be calculated, a pink question mark is shown.

Harmonics
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Artificial harmonics

Normal
Shows two noteheads: one indicating the stopped pitch, the other the touched pitch. 
The touched pitch is automatically calculated based on the partial; the default partial is 
the second partial. On tablature, the stopped fret is shown on the left and the touched 
fret is shown on the right in parentheses. This is the default appearance of artificial 
harmonics on all staves.

Normal artificial harmonic on notation staff Normal artificial harmonic on tablature

Pinch
Shows two noteheads: one indicating the stopped pitch, the other the sounding pitch. 
The sounding pitch is automatically calculated based on the partial; the default partial 
is the second partial. On tablature, only the stopped fret is shown.

NOTE

Intended for fretted instruments only. A pinch is produced by the performer catching 
a resonating string at a node near the pick-ups, producing a high-pitched squeal. Also 
known as a “false harmonic” or “squeal”.

Pinch harmonic on notation staff Pinch harmonic on tablature

Single notehead (sounding)
Shows a single notehead indicating the sounding pitch. On tablature, the stopped fret 
is shown on the left and the sounding pitch is shown on the right in parentheses.

Single notehead (sounding) artificial 
harmonic on notation staff

Single notehead (sounding) artificial 
harmonic on tablature

Single notehead (stopped)
Shows a single notehead indicating the stopped pitch. On tablature, the stopped fret is 
shown on the left and the touched fret is shown on the right in parentheses.

Harmonics
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Single notehead (stopped) artificial 
harmonic on notation staff

Single notehead (stopped) artificial 
harmonic on tablature

RELATED LINKS
Tablature on page 917

Changing the appearance of natural harmonics
By default, natural harmonics appear as normal noteheads with a circle shown above, which 
indicates the desired sounding pitch. You can change the appearance of natural harmonics 
individually, for example, to show them as a white diamond notehead to indicate the touched 
pitch.

NOTE

These steps only apply to harmonics with the Natural type.

PROCEDURE

1. Select the natural harmonics whose appearance you want to change.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Circle above

● Diamond notehead

● White diamond notehead

RESULT
The appearance of the selected natural harmonics is changed, including on fretted instrument 
notation staves. The touched pitch shown on tablature is not changed automatically.

NOTE

● Changing the appearance of natural harmonics does not automatically change their notated 
pitch. For example, if you want to change a sounding pitch Circle above harmonic to a 
touched pitch White diamond notehead harmonic, you must also change the pitch of the 
note.

● Dorico SE automatically assigns natural harmonics with the White diamond notehead style 
to the lowest possible string for that harmonic. You can specify different strings if necessary.

● You can change the staff-relative placement of harmonic circle symbols by activating 
Placement in the Harmonics group of the Properties panel and choosing the option you 
want.

RELATED LINKS
Changing the pitch of individual notes on page 199
Specifying the string for individual notes on page 726

Harmonics
Appearances/Styles of harmonics 

739
Dorico SE 3.5.12



Changing the style of artificial harmonics
By default, artificial harmonics appear as two noteheads: one normal, which indicates the 
stopped pitch, and one diamond, which indicates the touched pitch. You can change the style 
of artificial harmonics individually, for example, to indicate pinch harmonics.

NOTE

These steps only apply to harmonics with the Artificial type.

PROCEDURE

1. Select the artificial harmonics whose style you want to change.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Normal

● Pinch

● Single notehead (sounding)

● Single notehead (stopped)

RESULT
The style of the selected artificial harmonics is changed.

NOTE

Pinch indicates the use of a different technique to produce the harmonic.

Harmonics
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Ornaments

Ornaments are markings that indicate multiple notes are played in addition to the notated pitch. 
They are used to decorate music, such as in Baroque music, which is highly decorated with trills 
and other ornaments.

Over time, specific ways of notating how performers should play notes have developed 
and different ornament symbols indicate different patterns of decorative notes. Nonetheless, 
ornaments give some freedom to performers to embellish music in their own way.

Dorico SE offers a range of ornament symbols to allow you to notate different styles of 
ornaments.

The term “ornaments” covers a wide range of decorative notes, including:

● Mordents

● Trills

● Turns

● Grace notes

● Acciaccaturas

● Appoggiaturas

In Dorico SE, the term “ornaments” refers to ornament symbols and trill marks that are input 
above notes.

A phrase containing a turn, short trills, and a trill with extension line

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Grace notes on page 682
Positions of ornaments on page 742

Changing ornament intervals
You can change the intervals of ornaments, both above and below the notated pitch, to 
indicate which pitches are played in the ornament. The intervals of ornaments are indicated 
by accidentals.

For some ornaments, you can only change the interval in one direction. For example, you can 
only change the interval above short trills and below mordents.

NOTE

These steps do not apply to trills.

741
Dorico SE 3.5.12



PROCEDURE

1. Select the ornaments whose interval you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Ornaments group, as appropriate for the selected ornaments:

● Interval above

● Interval below

3. Change the values in the value fields to the intervals you want.

● 0 or 4 and above shows no accidental.

● 1 shows a flat.

● 2 shows a natural.

● 3 shows a sharp.

RESULT
The intervals of the selected ornaments are changed.

NOTE

Some ornaments do not show accidentals either above or below, depending on their type.

EXAMPLE

No accidentals Flats above and below Naturals above and 
below

Sharps above and below

RELATED LINKS
Trill intervals on page 748
Changing trill intervals on page 749
Changing trill intervals partway through trills on page 750
Changing vibrato bar dip intervals on page 782

Positions of ornaments
Ornaments, including trills, are placed above the notes to which they apply. They are only placed 
below the staff for down-stem voices in multiple-voice contexts.

Ornaments and trills are positioned outside of slurs by default. Similarly, they are positioned 
further from noteheads than articulations.

The center of ornaments aligns with the center of the notehead to which they apply. Trills are 
aligned differently, as the left side of trill marks aligns with the left edge of the notehead to which 
the trill applies.

Dorico SE automatically positions ornaments correctly according to their type, and attaches them 
to their notehead.

Ornaments
Positions of ornaments 
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You can move ornaments to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Moving ornaments rhythmically
You can move ornaments to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the ornaments you want to move.

NOTE

When using the mouse, you can only move one ornament at a time.

2. Move the ornaments in any of the following ways:

● To move a single ornament to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single ornament to the previous notehead on the staff, press Alt/Opt-
Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple ornaments are selected, you can only move them according to the 
current rhythmic grid resolution.

● Click and drag the ornament to the right/left to snap it to different rhythmic positions.

RESULT
The selected ornaments are moved to new rhythmic positions.

NOTE

Only one ornament can exist at each rhythmic position. If an ornament passes over another 
ornament as part of its move, the existing ornament is deleted.

Trills can overlap with other trills and ornaments. However, if the start of a trill passes over the 
start of another trill as part of its move, the existing trill is deleted.

You can undo these actions, but any ornaments/trills deleted in the process are only restored if 
you moved items using the keyboard.

Changing the start position of trills
You can change whether the start position of individual trills is aligned with the notehead or with 
its accidental. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

Ornaments
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PROCEDURE

1. Select the trills whose start position you want to change.

2. In the Properties panel, activate Start position in the Trills group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The start position of the selected trills is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Trills
Trills are fast alternations between two notes, similar to a tremolo, that were a common 
decoration in Baroque, Classical, and Romantic music. Trill marks are usually added to a single 
note, to indicate the performed notes are the notated pitch and the note either a half-step or 
whole step above, and can have extension lines to show the duration of the trill.

A phrase containing multiple trills with extension lines

Because of their legacy as an ornament, many performers interpret trills differently to tremolos: 
some players add more emphasis to the notated pitch in a trill and less on the trilled-to note but 
play both notes equally in tremolos.

The most common trills are to notes a major or minor second above, but it is also possible to 
specify other trill intervals.

In Dorico SE, you can specify any trill interval, change their appearance on notation staves, and 
hear them in playback.

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

Trills on a notation staff and tablature

Ornaments
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RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Trill intervals on page 748
Trills in playback on page 754
Tablature on page 917

Hiding/Showing trill marks
You can hide/show trill marks at the start of individual trills. This also hides/shows trill marks on 
all systems on which the trills extend.

PROCEDURE

1. Select the trills whose trill marks you want to hide/show.

2. In the Properties panel, activate Show trill mark in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Trill marks are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated.

When the property is deactivated, trill marks are shown by default.

RELATED LINKS
Trill interval appearance on page 752
Hiding/Showing trill interval accidentals on page 749
Hiding/Showing speed changes in trill extension lines on page 746
Hiding/Showing trill extension lines on page 746

Changing the speed of trills
You can indicate different speeds for trills, including indicating a change of speed within a single 
trill, by changing the height and frequency of wiggles in their extension lines.

PROCEDURE

1. Select the trills whose speed you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Trills group:

● Start speed

● End speed

3. Select one of the following options from each property menu:

● Slow

● Normal

● Fast

RESULT
The speed of the selected trills is changed. This affects both the frequency of wiggles in their 
extension lines and their playback speed.

If only Start speed is activated, the speed of the whole trill extension line is changed. If only End 
speed is activated, the speed of the end half of the trill extension line is changed.
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EXAMPLE

A trill extension line starting slow and ending fast

AFTER COMPLETING THIS TASK
You can customize the playback speed of trills individually.

RELATED LINKS
Changing the playback speeds of trills on page 755

Hiding/Showing speed changes in trill extension lines
You can hide/show speed changes in the extension lines for individual trills, for example, if you 
want to hear different speeds in playback but show extension lines with consistent wiggles.

PROCEDURE

1. Select the trills whose speed changes you want to hide/show.

2. In the Properties panel, activate/deactivate Suppress drawing speed changes in the Trills 
group.

RESULT
Speed changes are hidden when the property is activated, and shown when it is deactivated.

EXAMPLE

Trill speed changes shown Trill speed changes hidden

Hiding/Showing trill extension lines
You can hide/show the extension lines of individual trills. You can do this for the current layout 
and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose extension lines you want to hide/show.

2. In the Properties panel, activate/deactivate Has trill line in the Trills group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Trill extension lines are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

When the property is deactivated, trill extension lines are only shown on tied notes by default.

RELATED LINKS
Changing the speed of trills on page 745
Changing the playback speeds of trills on page 755
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Lengthening/Shortening trills rhythmically
You can lengthen/shorten trills after they have been input. Trills can overlap with other trills and 
ornaments, so you can also lengthen/shorten trills to noteheads that already have ornaments.

PROCEDURE

1. In Write mode, select the trills you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one trill at a time.

2. Lengthen/Shorten the trills in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To lengthen a single trill to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To shorten a single trill to the previous notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Left Arrow .

NOTE

● You can only lengthen/shorten trills by the current rhythmic grid resolution when 
multiple trills are selected.

● Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end of the trill to noteheads to the right/
left.

RESULT
Single trills are lengthened/shortened according to the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer.

Multiple trills are lengthened/shortened according to the current rhythmic grid resolution.

RELATED LINKS
Positions of ornaments on page 742
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Trill intervals
Trill intervals tell performers which notes to play and also affect the pitches used in playback in 
Dorico SE. For example, a trill with a sharp accidental on an E indicates that the performer trills 
between E and F♯, rather than between E and F.

The different accidentals on these trills indicate changes in the trilled-to note.

If you do not specify an interval when inputting a trill, Dorico SE calculates an appropriate 
interval based on the top note in the voice to which the trill belongs, the current key signature, 
and any accidentals earlier in the bar. For example, inputting a trill on an E♮ in C major produces 
a half-step/minor second trill interval to F♮. If there were a sharp accidental on the F earlier in the 
bar, the trill interval produced is a whole step/major second between the E♮ and F♯.
In open/atonal key signatures, Dorico SE produces whole step/major second trill intervals by 
default.

You can specify trill intervals when inputting them with the popover, including at different 
noteheads in the same trill, and you can change individual trill intervals after they have been 
input.

When trill intervals do not require a trill interval indicator, they are indicated by signposts. 
However, trill interval signposts are hidden by default.

Trills and accidentals

If required, Dorico SE shows accidentals to clarify trill intervals. Dorico SE also automatically 
shows accidentals on other notes in the bar if they have different accidentals to any upper notes 
of trills.

By default, trill marks themselves show intervals, unless the upper note is modified by an 
accidental in the key signature. If the upper note has been modified by an accidental earlier in 
the bar, trills always show the interval. If trills modify pitches modified by an accidental in the key 
signature, any subsequent notes of that pitch show the appropriate accidental automatically. Any 
cautionary accidentals required in the current and following bars are also shown automatically.

Microtonal trill intervals

When using other tonality systems than 12-EDO, you can specify trill intervals based on diatonic 
steps and the total number of divisions from the written note. In 24-EDO, you can describe 
trill intervals based on their quality, such as major or minor. In tonality systems with a greater 
number of divisions or an unequal number of divisions between each diatonic step, you must 
specify trill intervals based on their octave divisions, as specifying only the interval quality is 
insufficient in such cases.

RELATED LINKS
Trill interval appearance on page 752
Inputting ornaments/trills with the popover on page 271
Ornaments popover on page 266
Signposts on page 349
Changing ornament intervals on page 741
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Changing vibrato bar dip intervals on page 782

Hiding/Showing trill interval accidentals
You can hide/show accidentals for individual trill intervals, for example, if you want to show the 
accidental for the first note of a trill but hide the accidentals for subsequent notes. You can do 
this for the current layout and frame chain only or for all layouts and frame chains.

NOTE

These steps only hide the accidentals shown in trill intervals, they do not hide auxiliary notes or 
Hollywood-style markings.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trill intervals, or trill interval signposts whose accidentals you want to hide/show.

NOTE

For trills that span multiple notes and have multiple trill interval accidentals, you must select 
each accidental or signpost individually. If you select the whole trill, only the first trill interval 
accidental is changed.

2. In the Properties panel, activate Accidental in the Trills group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals in the selected trill intervals are hidden when you choose Hide, and shown when 
you choose Show. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

Signposts are shown at the position of each hidden trill interval accidental. However, trill interval 
signposts are hidden by default.

RELATED LINKS
Changing the appearance of trill intervals on page 753
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Annotations on page 537
Hiding/Showing signposts on page 350

Changing trill intervals
The default trill interval is a second, either major or minor depending on the context. In addition 
to specifying the interval when inputting trills with the ornaments popover, you can change the 
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intervals of trills and existing trill intervals within their duration individually after they have been 
input.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to change.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to change individually. If you select the trill mark/extension line, only 
the first trill interval is changed.

2. In the Properties panel, activate Interval in the Trills group.

The existing interval of the trill is shown as a number and quality.

3. Change the interval by changing the value in the value field.

4. Select one of the following interval qualities from the menu:

● Diminished

● Minor

● Major

● Augmented

RESULT
The interval of the selected trill intervals is changed. This applies from the selected trill intervals 
until the next interval change in the trill or the end of the trill, whichever comes first. For 
example, if you selected a trill with no interval changes within its duration, the interval is 
changed for the whole trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Resetting trill intervals on page 751
Ornaments popover on page 266

Changing trill intervals partway through trills
You can change the intervals of existing trills at any notehead within their duration, for example, 
if you want a trill to change seamlessly from a minor second in one bar to a major second in the 
next.

PROCEDURE

1. In Write mode, select one of the following:

● The note whose trill interval you want to change.

● An item or rest on the staff where you want to specify trill intervals.

2. Press Shift-N  to start note input.

3. Press Right Arrow / Left Arrow  to move the caret according to the current rhythmic grid 
resolution to the notehead where you want to change the trill interval.
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NOTE

You can only change trill intervals at noteheads.

4. Press Shift-O  to open the ornaments popover.

5. Enter the trill interval you want into the popover. For example, enter m3 for a minor third.

6. Press Return  to close the popover.

7. Optional: Repeat steps 3 to 6 to change the trill interval at other noteheads in the trill.

8. Press Esc  or Return  to stop note input.

RESULT
The trill interval is changed at the corresponding noteheads. By default, all trill intervals in the 
trill appear as accidentals when the intervals are all seconds and as auxiliary notes when the trill 
contains at least one trill interval with a different interval.

Signposts are shown at the position of each trill interval that does not require an accidental or 
auxiliary note. However, trill interval signposts are hidden by default.

EXAMPLE

Trill with interval changes shown as accidentals Trill with interval changes shown as auxiliary notes

RELATED LINKS
Changing the appearance of trill intervals on page 753
Ornaments popover on page 266
Signposts on page 349
Hiding/Showing signposts on page 350

Resetting trill intervals
You can reset trill intervals to the default trill interval of a second, either major or minor 
depending on the context, including resetting individual trill intervals within a single trill 
independently.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to reset.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to reset individually. If you select the trill mark/extension line, only the 
first trill interval change is reset.

2. In the Properties panel, deactivate Interval in the Trills group.
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RESULT
The interval of the selected trill intervals is reset. This applies from the selected trill intervals until 
the next interval change in the trill or the end of the trill, whichever comes first. For example, if 
you selected a trill with no interval changes within its duration, the interval is reset for the whole 
trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Properties panel (Write mode) on page 147
Signposts on page 349
Hiding/Showing signposts on page 350

Trill interval appearance
There are different accepted ways to present trill intervals on notation staves, including 
accidental symbols and the Hollywood convention of showing “H.T.” for a half-step (semitone) 
and “W.T.” for a whole step (tone).

In Dorico SE, trill intervals can appear in the following ways on notation staves:

Accidental
Indicates the trill interval using accidentals positioned above, below, or beside the 
tr mark. This is the default trill interval appearance in Dorico SE for major or minor 
second trills.

Hollywood-style
Indicates the trill interval using text.

● H.T. for half-step/minor second trills

● W.T. for whole step/major second trills

Auxiliary note
Indicates the trill interval using a small, parenthesized, stemless notehead shown in 
the staff immediately to the right of the first note to which the trill applies, and at the 
correct staff position for the trilled-to pitch. Auxiliary notes are used for all trill intervals 
that are not a major or minor second, but are automatically hidden for unison trills if 
the notehead design of the auxiliary note has not been overridden.
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NOTE

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

Changing the appearance of trill intervals
You can change the appearance of trills with a second interval on notation staves individually, for 
example, if you want to show auxiliary notes on some trills to clarify a change in the trilled-to 
pitch.

NOTE

You can only change the trill interval appearance of trills with a major/minor second interval.

PROCEDURE

1. Select the trills whose trill interval appearance you want to change.

2. In the Properties panel, activate Appearance in the Trills group.

3. Select one of the following options from the menu:

● Accidental

● Hollywood style

● Auxiliary note

RESULT
The appearance of the selected trill intervals on notation staves is changed. This does not affect 
their appearance on tablature.

AFTER COMPLETING THIS TASK
You can change the notehead design of individual auxiliary notes, for example, to show that the 
trilled-to note is a harmonic.

RELATED LINKS
Changing the notehead design of individual noteheads on page 723

Changing the position of trill interval indicators
You can change where trill interval indicators, such as an accidental or W.T. marking, are 
positioned relative to individual trill marks. You can do this for the current layout and frame 
chain only or for all layouts and frame chains.

NOTE

This does not affect the position of trill interval accidentals on subsequent notes over which trills 
extend.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose interval indicator position you want to change.

2. In the Properties panel, activate Interval position in the Trills group.
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3. Select one of the following options from the menu:

● Above

● Below

● On the right

● Superscript

RESULT
The position of interval indicators relative to the selected trill marks is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

Trills in playback
Dorico SE plays back trills by using a combination of sampled trills, when available, and 
triggering multiple notes.

Dorico SE can play back sampled half-step (semitone) and whole step (tone) trills automatically if 
these playing techniques are defined in the VST expression map, which is the case for a number 
of instruments in HALion Symphonic Orchestra. For sound libraries that do not provide sampled 
trills, or for intervals beyond a whole step, Dorico SE generates trills.

When playing generated trills, Dorico SE incorporates grace notes immediately before and after 
trills. A single unslashed grace note on the initial trill note produces an appoggiatura, while 
multiple grace notes on the initial trill note are included in the trill pattern. Grace notes on the 
note immediately following a trill are also included in the trill pattern.

A trill with grace notes at both the start and end

Variable speeds within trills are included in playback, and you can change the playback speed 
of individual trills. Additionally, you can hide trill speed changes in trill extension lines whilst 
retaining the speed changes in playback.
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In contemporary performance practice, trills are usually performed starting on the written note, 
while in the historical performance practice of the Baroque and Classical eras, trills are usually 
performed starting on the upper (trilled-to) note. You can change the default starting pitch for 
trills individually.

RELATED LINKS
Changing the speed of trills on page 745
Hiding/Showing speed changes in trill extension lines on page 746
Changing the starting pitch of trills on page 756
Playback techniques on page 512

Sampled vs. generated trills
Sampled trills are recorded, looped samples, whereas generated trills are produced by manually 
triggering separate notes.

Because they use fixed sounds, sampled trills typically offer no parameters that allow any kind 
of variation in the trill interpretation, such as different trill speeds or incorporating grace notes 
and termination notes into the pattern of trilled notes. By contrast, generated trills can provide 
greater flexibility but produce a less natural and realistic sound.

Changing the playback speeds of trills
In addition to changing the speed of trills, which changes both the frequency of wiggles in their 
extension lines and their playback speed, you can also change the playback speed of each speed 
variant in individual trills, for example, if you want to make the fastest part of an individual trill 
faster than your default setting.

PROCEDURE

1. Select the trills whose playback speeds you want to change.

2. In the Properties panel, activate any of the following properties, as appropriate for your 
selected trills:

● Slow trill speed

● Normal trill speed

● Fast trill speed

3. Change the values in the value fields.

RESULT
The playback speed of the selected trills is changed. The values in the value fields correspond to 
the number of notes sounding per second.

RELATED LINKS
Changing the speed of trills on page 745
Hiding/Showing speed changes in trill extension lines on page 746
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Changing the starting pitch of trills
By default in Dorico SE, trills start on the lower note, which is usually the written note. However, 
the accepted practice in Baroque and Classical music is to start trills on the upper note. You can 
change the starting pitch of trills individually.

PROCEDURE

1. Select the trills whose starting note you want to change.

2. In the Properties panel, activate Start on upper note in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected trills start on the upper note when the checkbox is activated, and on the lower note 
when the checkbox is deactivated.
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Arpeggio signs

Arpeggio signs are vertical lines that indicate chords are to be played arpeggiated, or “spread”, 
so that the notes in the chord are played very quickly one after another. Arpeggio signs are 
normally shown as vertical wavy lines.

Arpeggiated chords can be played in two directions:

● Upwards, starting from the bottom note in the chord.

● Downwards, starting from the top note in the chord.

It is most common for up arpeggio signs to have nothing at the top end, because chords are 
usually arpeggiated upwards, and for down arpeggio signs to have an arrow at the bottom, so 
these are the defaults in Dorico SE. However, it is also accepted practice to show up arpeggio 
signs with an arrow at the top if down arpeggio signs are also used in the same piece of music.

Arpeggio signs in Dorico SE automatically span the range of all notes in the voices/staves to 
which they apply.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Lines on page 823

Types of arpeggio signs
There are different types of arpeggio signs to convey the different arpeggiation directions and 
techniques.

Up arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the bottom note 
upwards.

Down arpeggio
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A vertical wavy line that indicates chords are to be arpeggiated from the top note 
downwards.

Non arpeggio

A bracket with straight lines that indicates all notes in the chord are to be played 
together, not arpeggiated.

Curved arpeggio

A curved line, similar to a slur but vertical, that some composers use to indicate gentle 
or partial arpeggiation.

You can show both up and down arpeggio signs with one of the following ends in Dorico SE:

● Nothing

● Arrow

● Swash

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Changing the type of arpeggio signs
You can change the type of arpeggio signs after they have been input.

PROCEDURE

1. Select the arpeggio signs whose type you want to change.

2. In the Properties panel, select one of the following options from the Arpeggio type menu in 
the Arpeggios group:

● Non arpeggio

● Up arpeggio

● Down arpeggio

● Up arpeggio (curve)

RESULT
The type of the selected arpeggio signs is changed.

Arpeggio signs
Types of arpeggio signs 
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TIP

You can also change the arpeggio type by opening the ornaments popover and changing the 
entry.

RELATED LINKS
Ornaments popover on page 266
Changing existing items on page 342

Changing the end appearance of arpeggio signs
Down arpeggio signs have an arrowhead at the bottom of the line by default, but up arpeggio 
signs have no arrowhead by default. You can change the appearance of the ends of arpeggio 
signs individually.

NOTE

These steps only apply to up and down arpeggio signs. They do not apply to curved or non 
arpeggio signs.

PROCEDURE

1. Select the arpeggio signs of any direction whose ends you want to change.

2. In the Properties panel, activate Sign end in the Arpeggios group.

3. Select the end you want from the menu:

● Nothing

● Arrow

● Swash

RESULT
The appearance of the ends of the selected arpeggio signs is changed.

EXAMPLE

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Arpeggio signs
Types of arpeggio signs 
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Length of arpeggio signs
The length of arpeggio signs is determined by the pitch range of notes in the voices/staves to 
which the arpeggio sign applies.

Dorico SE automatically adjusts the length of arpeggio signs if the pitches of the notes in the 
voices/staves to which the sign applies change, or you add notes to, or delete notes from, the 
chords.

General placement conventions for arpeggio signs
Arpeggio signs are positioned to the left of the notes, including any applicable accidentals, to 
which they apply, but are positioned between grace notes and normal notes. They should appear 
within the same bar as the notes to which they apply, and not on the other side of the barline.

Dorico SE makes automatic adjustments to note spacing and staff spacing to accommodate 
arpeggio signs and ensure they are positioned correctly.

Arpeggio signs should cover the whole vertical range of all notes in the chord to which they 
apply, and protrude slightly at each end. However, they do not need to cover the stems of notes. 
Dorico SE automatically creates the lengths of arpeggio signs to cover the notes in chords, and 
adjusts their lengths if the notes in chords change or are deleted.

If an arpeggiated chord spans two staves, such as in a piano part, its arpeggio sign can extend 
across both staves.

You can move arpeggio signs to different rhythmic positions in Write mode.

RELATED LINKS
Length of arpeggio signs on page 760

Moving arpeggio signs rhythmically
You can move arpeggio signs to new rhythmic positions after they have been input.

NOTE

● You cannot move arpeggio signs over rests, you can only move them to adjacent notes/
chords in the same voice. If you want to move arpeggio signs along a phrase containing 
rests, we recommend deleting them and inputting new arpeggio signs at the new positions 
instead.

● You cannot move arpeggio signs rhythmically with the mouse.

PROCEDURE

1. In Write mode, select the arpeggio signs you want to move.

2. Move the arpeggio signs in any of the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

RESULT
Arpeggio signs are moved to the right/left, according to the current rhythmic grid resolution.

Arpeggio signs
Length of arpeggio signs 
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If no notes exist at the next rhythmic position according to the rhythmic grid, the arpeggio sign is 
not shown. If you continue moving it to the right/left, it is shown again beside the next note at a 
rhythmic position that can be reached according to the current rhythmic grid resolution.

You can change the rhythmic grid resolution if you want to move arpeggio signs to notes at 
other rhythmic positions.

NOTE

● If you move arpeggio signs to the rhythmic position of a rest, they are deleted.

● Only one arpeggio sign can exist at each rhythmic position. If an arpeggio sign in your 
selection passes over another arpeggio sign as part of its move, the existing arpeggio sign is 
deleted.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266

Showing arpeggio signs before/after grace notes
You can show arpeggio signs before/after grace notes individually. You can do this for the 
current layout and frame chain only or for all layouts and frame chains. By default, arpeggio 
signs are positioned immediately to the left of the notes to which they apply, and so are 
positioned between normal notes and grace notes.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the arpeggio signs you want to show before grace notes.

2. In the Properties panel, activate/deactivate Arpeggio before grace notes in the Arpeggios 
group.

RESULT
The selected arpeggio signs are shown before grace notes when the property is activated, and 
after grace notes when the property is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing arpeggio playback relative to the beat
You can change whether individual arpeggios are played before their notated position or after 
their notated position.

PROCEDURE

1. Select the arpeggio signs whose playback relative to the beat you want to change.

2. In the Properties panel, activate Playback position in the Arpeggios Playback group.

3. Choose one of the following options:

● Start on beat

Arpeggio signs
Changing arpeggio playback relative to the beat 
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● End on beat

RESULT
The beat-relative position of the selected arpeggios in playback is changed.

EXAMPLE

Arpeggio starting on the beat Arpeggio ending on the beat

Changing the playback duration of arpeggios
You can change the duration of individual arpeggios in playback.

The duration of arpeggios is expressed as a fraction of the notated rhythm of chords. For 
example, an arpeggio on a quarter note (crotchet) chord with a note offset value of 1/2 lasts an 
eighth note (quaver), whereas with a note offset value of 1/8 it lasts a 32nd note.

PROCEDURE

1. Select the arpeggio signs whose playback duration you want to change.

2. In the Properties panel, activate Note offset in the Arpeggios Playback group.

3. Change the playback duration of the selected arpeggio signs by changing the value in the 
value field.

4. Press Return .

RESULT
The playback duration of the selected arpeggios is changed.

EXAMPLE

Arpeggiated chord with a note offset value of 1/8 Arpeggiated chord with a note offset value of 1/2

Arpeggio signs
Changing the playback duration of arpeggios 

762
Dorico SE 3.5.12



Glissando lines

Glissando lines indicate a continuous transition between two notes, which can be smooth or 
in chromatic steps. They can have straight lines or wiggly lines, and can be shown with a text 
indication or as a line without text.

There are different conventions regarding the playing techniques for glissando and portamento. 
Some people understand glissando lines to indicate a chromatic scale between the two notes, 
either rising or falling in a series of half-steps (semitones), and portamento lines to indicate a 
smooth, continuous glide between the two notes. However, the terms glissando and portamento 
can be used interchangeably in other cases.

You can input both glissando lines and portamento lines in Dorico SE, and you can easily change 
their style after they have been input.

Glissando lines in Dorico SE automatically follow the notes at each end, meaning if you change 
the pitch of either note, the glissando line end positions move accordingly.

An example glissando line with text shown and a 
wiggly line

An example portamento line with text shown and a 
straight line

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Changing the style of glissando lines on page 764
Lines on page 823
Playing technique continuation lines on page 818
Changing the pitch of individual notes on page 199

General placement conventions for glissando lines
Glissando lines are positioned between noteheads and the steepness of their angle should 
reflect the interval between the notes: the steeper the angle, the greater the interval. The 
endpoints of glissando lines must be directly beside noteheads but not directly touching them.

Glissando lines must not collide with accidentals, and instead must stop short so the accidental 
can be clearly read. Dorico SE automatically positions glissando lines so they do not collide with 
accidentals.

Usually, glissando lines join two adjacent noteheads because they indicate a gradual but 
constant change in pitch between those two notes, but they can also cross multiple notes.

Glissando lines can cross system breaks and page breaks. If text is shown for glissando lines that 
span system or page breaks, then that text is shown on every glissando line segment. By default, 
the start and end positions of each segment matches the original start and end points of the 
whole glissando line.
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Glissando lines across empty bars
In Dorico SE, you can input glissando lines between any two notes, even if there are rests 
or other notes between them, and including between notes in different voices and notes on 
different staves.

For very long glissando lines that extend across multiple bars, you might not want to show 
pitches at the start of each bar, for example, to indicate that performers do not emphasize 
pitches during the course of the glissando, or that performers can play the glissando at their own 
speed. By default, Dorico SE shows notes or rests in every bar.

Once you have input a glissando line between the selected notes, you can delete any rests 
between them.

EXAMPLE

A glissando line across multiple bars with no rests shown between the two notes

RELATED LINKS
Inputting glissando lines with the popover on page 274
Inputting glissando lines with the panel on page 275
Hiding/Showing bar rests in empty bars on page 884
Deleting rests on page 883
Turning explicit rests into implicit rests on page 882

Changing the style of glissando lines
Glissando lines can be shown as straight lines or wiggly lines. You can change the glissando line 
style of glissando lines individually.

PROCEDURE

1. Select the glissando lines whose style you want to change.

2. In the Properties panel, activate Glissando style in the Glissando Lines group.

3. Choose one of the following options:

● Straight line 

● Wiggly line 

RESULT
The glissando line style is changed for the selected glissando lines.

TIP

● Deactivating Glissando style returns the selected glissando lines to the default style.

● You can also change the glissando style by opening the ornaments popover and changing 
the entry.

RELATED LINKS
Ornaments popover on page 266
Changing existing items on page 342

Glissando lines
Glissando lines across empty bars 
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Changing glissando line text
You can show individual glissando lines with “gliss.” text, “port.” text, or without text. You can do 
this for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose text you want to change.

2. In the Properties panel, activate Glissando text in the Glissando Lines group.

3. Select one of the following options from the menu:

● Gliss.

● Port.

● No text

RESULT
The text shown on the selected glissando lines is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing when glissando line text is shown
By default, glissando text is not shown when glissando lines are too short to accommodate the 
text. You can choose to show text on individual glissando lines always, or only if there is sufficient 
space. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose setting for when text is shown you want to change.

2. In the Properties panel, activate Glissando text shown in the Glissando Lines group.

3. Choose one of the following options:

● Show if sufficient space

● Always show

Glissando lines
Changing glissando line text 
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RESULT
If Show if sufficient space is chosen, glissando line text is not shown if the glissando line is too 
short.

If Always show is chosen, glissando line text is always shown, even if the glissando line is short. 
However, this can cause the glissando line text to collide with other items, such as noteheads and 
stems.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can increase the default gaps between noteheads by changing the default note spacing.

RELATED LINKS
Note spacing on page 406
Changing the default note spacing on page 406

Glissando lines in playback
Glissando lines are reflected in playback using a sequence of notes, all a small interval apart, 
between the start and end notes for each glissando.

Glissandos belonging to harps consider the current harp pedaling when determining the pitches 
to use in playback. Glissandos for all other instruments use the 12-EDO chromatic scale, 
regardless of the current tonality system.

When glissando lines start or end on tie chains, their playback starts on the last note in tie chains 
and ends on the first note in tie chains.

By default in playback, glissandos sound across their full duration, but you can delay the start of 
glissandos in playback individually.

NOTE

Playing back glissando lines as a continuous, smooth slide is not yet supported. This is planned 
for future versions.

RELATED LINKS
Harp pedaling on page 794

Delaying the start of glissandos in playback
You can delay the start of glissandos in playback so that they start partway through their 
duration. By default, glissandos sound for their full duration in playback.

PROCEDURE

1. Select the glissando lines whose playback start you want to delay.

2. In the Properties panel, activate Delayed start in the Glissando Lines group.

3. Optional: If you want to specify exactly how far through the glissando lines playback starts, 
activate Delay and change the value in the value field.

The value represents fractions of a quarter note. For example, 1/2 delays the start of 
glissandos by an eighth note.

Glissando lines
Glissando lines in playback 
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RESULT
If you activated Delayed start only, the playback of the selected glissando lines is starts halfway 
through their duration.

If you also activated Delay, playback of the selected glissando lines follows your set value.

Glissando lines
Glissando lines in playback 

767
Dorico SE 3.5.12



Guitar bends

The guitar bend is a technique commonly performed on electric guitars, where the performer 
pushes strings out of their normal alignment after notes start to sound. Bending strings tightens 
them, which produces the characteristic pitch fluctuation.

Performing a guitar bend often also involves sustaining the bent pitch before allowing the string 
to return to its natural position and un-bent pitch. In Dorico SE, these actions are called a “guitar 
bend hold” and “release” respectively.

A phrase containing guitar bends, a guitar bend hold, guitar pre-bends, and releases, shown on both a 
notation staff and tablature

Guitar bends and releases with bend intervals of up to a whole step (tone) are reflected in 
playback.

Guitar bends
Guitar bends indicate that the performer should bend the string after playing a note, 
so that the pitch increases while the note sounds. In Dorico SE, each guitar bend joins 
two notes: the start pitch and the pitch at the peak of the bend.

On notation staves, guitar bends are notated using an angled line between the 
noteheads at the start and end. On tablature, guitar bends are notated using an 
upwards-pointing curved line with an arrowhead at the top and a bend interval above 
the arrowhead. The fret number of the end note is hidden automatically.

Guitar bend on notation staff Guitar bend on tablature

If you input guitar bends on multiple notes in chords, their arrowheads are 
automatically aligned on tablature.
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Guitar bends on chord on notation staff
Guitar bends on chord on tablature

Sequences of consecutive guitar bends are notated as bend runs on tablature.

Guitar bend runs on tablature

Guitar bend holds
Guitar bend holds indicate that the performer should maintain the pitch at the peak of 
a guitar bend. They are usually shown on tied notes.

On tablature, guitar bend holds are notated using a horizontal line. They are not 
notated on notation staves.

Guitar bend hold on tablature

Releases
Releases indicate that the performer should allow a bent string to return to its natural 
position, which decreases the pitch. In Dorico SE, each release joins two notes: the 
pitch at the peak of the bend and the end pitch.

On notation staves, releases are notated using an angled line between the noteheads 
at the start and end. On tablature, releases are notated using a downwards-pointing 
curved line with an arrowhead at the bottom and parenthesized fret numbers below 
the arrowhead to indicate the end pitches. The fret number of the start note is hidden 
automatically.

Guitar bends
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Release on notation staff Release on tablature

If you input releases on multiple notes in chords, they are notated with a single 
downwards-pointing curved line on tablature. If the bend intervals are the same for 
all notes, the end pitches are parenthesized together.

Releases on chord on notation staff
Releases on chord on tablature

NOTE

● In addition to guitar bends, Dorico SE supports guitar pre-bends/pre-dives, guitar post-
bends, vibrato bar dives and returns, and other guitar techniques.

● Because you input releases in the same way as you input guitar bends, in this 
documentation, “guitar bends” refers to both guitar bend and release items in projects.

● Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Guitar post-bends on page 772
Vibrato bar dives and returns on page 773
Bend intervals on page 774
Guitar techniques on page 778
Input methods for guitar bends and guitar techniques on page 278
Tablature on page 917
Hiding/Showing notation staves and tablature on page 918
Bracketed noteheads on page 728
String indicators on page 674
Lines on page 823

Guitar bends
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Guitar pre-bends and pre-dives
Guitar pre-bends and pre-dives are techniques commonly performed on electric guitars, where 
the performer changes the initial sounding pitch of strings before playing notes, either by 
bending strings to tighten them or using the vibrato bar to loosen them.

A phrase containing a guitar pre-bend with release and multiple guitar pre-dives with release

In Dorico SE, guitar pre-bends and pre-dives are properties of notes belonging to fretted 
instruments, meaning they only apply to single notes.

Guitar pre-bends
Guitar pre-bends indicate that the performer should bend the string before playing the 
note to raise the pitch, for example, to repeat a note that was at the end of a previous 
guitar bend. The pitch can then be lowered after starting to sound.

On notation staves, guitar pre-bends are notated using an angled line between the 
noteheads at the start and end. However, unlike guitar bends, the parenthesized 
auxiliary notehead at the start is shown automatically as part of the pre-bend. On 
tablature, guitar pre-bends are notated using a solid vertical line with an arrowhead at 
the top, a bend interval above the arrowhead, and a small fret number below the line 
to indicate the start pitch.

Guitar pre-bend on notation staff Guitar pre-bend on tablature

Guitar pre-dives
Guitar pre-dives indicate that the performer should use the vibrato bar to lower the 
pitch before playing the note. The pitch can then be raised after starting to sound.

On notation staves, guitar pre-dives appear the same as guitar pre-bends. On 
tablature, guitar pre-dives are notated using a dashed vertical line with an arrowhead 
at the top, a bend interval above the arrowhead, and a small fret number below the 
line to indicate the start pitch.

Guitar bends
Guitar pre-bends and pre-dives 
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Guitar pre-dive on notation staff Guitar pre-dive on tablature

NOTE

Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 280
Vibrato bar dives and returns on page 773
Bend intervals on page 774
Tablature on page 917

Guitar post-bends
The guitar post-bend is a technique commonly performed on electric guitars, where the 
performer pushes strings out of their normal alignment after notes start to sound. Bending 
strings tightens them, which produces the characteristic pitch fluctuation. Microtonal post-bends 
are particularly idiomatic in Blues music.

In Dorico SE, guitar post-bends are properties of notes belonging to fretted instruments, 
meaning they only apply to single notes. They are notated the same on notation staves and 
tablature, using an upwards-pointing curved line with an arrowhead at the top and a bend 
interval above the arrowhead.

Guitar post-bend on notation staff

Guitar post-bend on tablature

Microtonal post-bend on notation staff

Microtonal post-bend on tablature

Guitar bends
Guitar post-bends 
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If you input guitar post-bends on multiple notes in chords, their arrowheads are automatically 
aligned. On notation staves, the appropriate number of curved lines is shown according to the 
staff positions of notes in chords.

Guitar post-bends on chord on notation staff

Guitar post-bends on chord on tablature

NOTE

Guitar post-bends are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Inputting guitar post-bends on page 281
Bend intervals on page 774
Tablature on page 917

Vibrato bar dives and returns
The vibrato bar dive and return is a technique performed on electric guitars with a vibrato bar, 
where the performer uses the vibrato bar to loosen then tighten strings after notes start to 
sound. This produces the characteristic downwards-then-upwards pitch fluctuation.

In Dorico SE, each vibrato bar dive and return comprises two vibrato bar bend items, where the 
first vibrato bar bend ends on the same note that the second vibrato bar bend starts on. Vibrato 
bar bends each join two notes.

Vibrato bar dives and returns with bend intervals of up to a whole step (tone) are reflected in 
playback.

On notation staves, vibrato bar dives and returns are notated using an angled line between the 
noteheads at the start and end, meaning they appear the same as guitar bends. On tablature, 
vibrato bar dives and returns are notated using two straight lines that form a V and a bend 
interval shown at the point. The fret number of the middle note is hidden and the fret number of 
the end note is parenthesized automatically.

Vibrato bar dive and return on notation staff

Vibrato bar dive and return on tablature

Sequences of consecutive vibrato bar bends on notes with the same pitch direction, such as 
E-D-C, are notated on tablature with an additional line protrusion beyond the staff and bend 
interval for each vibrato bar bend.

Guitar bends
Vibrato bar dives and returns 
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Consecutive vibrato bar bends on notation staff

Consecutive vibrato bar bends on tablature

If you input vibrato bar dives and returns on multiple notes in chords, a single V appears on 
tablature as long as the bend intervals are the same for all notes.

Vibrato bar dive and return on chords on notation 
staff Vibrato bar dive and return on chords on tablature

RELATED LINKS
Inputting vibrato bar dives and returns with the popover on page 282
Inputting vibrato bar dives and returns with the panel on page 283
Vibrato bar techniques on page 778
Bracketed noteheads on page 728
Tablature on page 917

Bend intervals
Bend intervals indicate the amount guitar bends, pre-bends, pre-dives, post-dives, and dives and 
returns change the pitch, expressed in relation to whole steps using text or numbers/fractions. 
Bend intervals appear only on tablature for most types of bends, except for guitar post-bends, 
whose bend intervals also appear on notation staves.

For example, full indicates a whole step guitar bend, pre-bend, or post-bend, 1/2 a half-step, and 
1 1/2 a minor third.

Bend intervals for guitar pre-dives and vibrato bar dives and returns always appear as numbers/
fractions, such as 1 for a whole step vibrato bar dive and return.

Microtonal bend intervals appear as fractions according to the prevailing tonality system, such as 
3/4. Bend intervals for microtonal post-bends appear as 1/4.

Guitar bends
Bend intervals 
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EXAMPLE

Guitar bend with whole step 
interval, displayed as full

Guitar pre-bend with 
minor third interval, 
displayed as 1 1/2

Vibrato bar dive and return 
with whole step interval, 
displayed as -1

Guitar post-bend with 
microtonal interval, 
displayed as 1/4

Bend intervals for guitar bends, pre-bends, pre-dives, and post-dives are positioned above the 
arrowhead/line for the corresponding notation. For dives and returns, bend intervals appear at 
the point of the V, either above or below the staff according to the pitch direction of notes in the 
dive and return.

Bend intervals appear only on tablature for guitar bends, pre-bends, pre-dives, and dives and 
returns. They appear on both notation staves and tablature for guitar post-bends.

RELATED LINKS
Guitar bends on page 768
Guitar pre-bends and pre-dives on page 771
Guitar post-bends on page 772
Vibrato bar dives and returns on page 773
Tablature on page 917
Changing vibrato bar dip intervals on page 782
Input methods for guitar bends and guitar techniques on page 278

Hiding/Showing guitar bend hold lines
Guitar bend hold lines indicate that the bend should be held for the duration of the note, which is 
usually a tied note. You can hide/show hold lines on guitar bends on tablature.

NOTE

These steps only apply to guitar bends. You cannot show hold lines on pre-bends or releases.

PROCEDURE

1. Select the guitar bends on which you want to hide/show hold lines. You can do this on 
notation staves and tablature.

2. In the Properties panel, activate/deactivate Show hold in the Guitar Bends group.

RESULT
Hold lines are shown on the selected bends on tablature when Show hold is activated, and 
hidden when it is deactivated.

Guitar bends
Hiding/Showing guitar bend hold lines 
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EXAMPLE

Hold line hidden Hold line shown

Changing the direction of guitar pre-bends/pre-dives
You can change the direction of guitar pre-bends/pre-dives individually. You can do this for 
the current layout and frame chain only or for all layouts and frame chains. By default, guitar 
pre-bends/pre-dives are positioned on the notehead-side of notes in single-voice contexts. In 
multiple-voice contexts, they are positioned on the stem-side of notes.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the guitar pre-bends/pre-dives whose direction you want to change.

2. In the Properties panel, activate Pre-bend direction in the Guitar Pre-bends group.

3. Choose one of the following options:

● Up

● Down

RESULT
The direction of the selected guitar pre-bends/pre-dives is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the direction of guitar bends on notation staves by selecting them and pressing 
F . However, you cannot use this key command for guitar pre-bends/pre-dives.

RELATED LINKS
Changing the staff-relative placement of items on page 343
Changing vibrato bar dip intervals on page 782
Changing the staff-relative placement of guitar techniques on page 783
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Guitar bends
Changing the direction of guitar pre-bends/pre-dives 
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Hiding/Showing accidentals on guitar pre-bends/pre-dives
You can hide/show accidentals on guitar pre-bends/pre-dives individually, for example, to save 
horizontal space in a layout that also shows the interval clearly on tablature. You can do this for 
the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the guitar pre-bends/pre-dives whose accidentals you want to hide/show.

2. In the Properties panel, activate Pre-bend accidental in the Guitar Pre-bends group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals on the selected guitar pre-bends are hidden when you choose Hide, and shown 
when you choose Show. This does not affect the interval shown for the selected guitar pre-bends 
on tablature. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Deleting guitar pre-bends, pre-dives, and post-bends
You can remove guitar pre-bends, pre-dives, and post-bends from notes after you have input 
them. However, because guitar pre-bends, pre-dives, and post-bends are properties of notes 
rather than separate items in Dorico SE, you must select and delete them differently from other 
items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar pre-bends, pre-dives, 
and/or post-bends.

2. Do one of the following:

● To remove guitar pre-bends/pre-dives, deactivate Pre-bend interval in the Guitar Pre-
bends group of the Properties panel.

● To remove guitar post-bends, deactivate Post-bend interval in the Guitar Post-bends 
group of the Properties panel.

RESULT
Guitar pre-bends, pre-dives, and/or post-bends are removed from the selected notes.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 280
Inputting guitar post-bends on page 281

Guitar bends
Hiding/Showing accidentals on guitar pre-bends/pre-dives 
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Guitar techniques

The term “guitar techniques” covers a range of techniques typically associated with guitar music, 
such as hammer-ons, pull-offs, and pitch alterations that use the vibrato bar on electric guitars.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 278
Tapping on page 779
Hammer-ons and pull-offs on page 780
Guitar bends on page 768
Guitar pre-bends and pre-dives on page 771
Guitar post-bends on page 772
Vibrato bar dives and returns on page 773
Bend intervals on page 774

Vibrato bar techniques
There are a number of different techniques that can be performed using the vibrato bar on 
electric fretted instruments, typically guitars. In Dorico SE, the available vibrato bar techniques 
are categorized differently.

Vibrato bar dives
Vibrato bar dives indicate that the performer should use the vibrato bar to lower 
the pitch after playing the note, so that the pitch falls after starting to sound. This 
technique is also known as a “dive bomb”.

In Dorico SE, you can notate vibrato bar dives using jazz articulations to show falling 
lines to the right of noteheads in combination with a vibrato bar indication.

Vibrato bar scoops
Vibrato bar scoops indicate that the performer should depress the vibrato bar just 
before playing the note and then release the vibrato bar quickly, so that the pitch rises 
after starting to sound.

In Dorico SE, vibrato bar scoops are properties of notes, meaning they only apply to 
single notes. By default, vibrato bar scoops only appear on notation staves and are 
placed to the left of noteheads on the staff.

Vibrato bar dips
Vibrato bar dips indicate that the performer should use the vibrato bar to lower and 
then raise the pitch by the specified interval after playing the note.
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In Dorico SE, vibrato bar dips are considered ornaments. You can select and delete 
them independently of the notes to which they apply. Vibrato bar dips appear on both 
notation staves and tablature and are placed above the staff. You can change the 
staff-relative placement of individual vibrato bar dips.

Vibrato bar indications/lines
Vibrato bar indications are text instructions that indicate that the performer should use 
the vibrato bar. When they apply to a range of notes, they typically show dashed lines.

In Dorico SE, vibrato bar indications/lines are considered playing techniques. They 
show lines when they have duration. You can select and delete them independently of 
the notes to which they apply.

NOTE

Vibrato bar techniques are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 278
Inputting guitar pre-bends/pre-dives on page 280
Guitar pre-bends and pre-dives on page 771
Vibrato bar dives and returns on page 773
Jazz articulations on page 786
Ornaments on page 741
Playing techniques on page 813
Playing technique continuation lines on page 818
Playing technique duration on page 819
Changing the staff-relative placement of items on page 343
Changing the staff-relative placement of guitar techniques on page 783

Tapping
Tapping involves performers pressing the strings of fretted instruments strongly enough that the 
corresponding pitch sounds without additional striking. Tapping indications can specify whether 
the performer should use their right or left hand for individual notes. They typically appear as the 
letter T, a plus sign, or a dot.

According to convention, tapping indications for the same hand and for consecutive notes on the 
same string with different pitches are notated alongside slurs that span the tapped phrase. This 
is similar to hammer-ons and pull-offs, except tapping indications appear on every note whereas 
hammer-on and pull-off indications typically appear centered on slurs.

Guitar techniques
Tapping 
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A phrase containing right-hand and left-hand tapping

By default, tapping indications only appear on notation staves and are placed above the staff. 
You can change the staff-relative placement of individual tapping indications.

In Dorico SE, tapping indications are considered properties of notes. There are the following 
types of tapping indications:

Right-hand tapping
Right-hand tapping indications specify that the performer should tap the string at 
the specified pitch with their right hand. In Dorico SE, right-hand tapping indications 
appear as the letter T.

Right-hand tapping on notation staff

Left-hand tapping
Left-hand tapping indications specify that the performer should tap the string at the 
specified pitch with their left hand. In Dorico SE, left-hand tapping indications appear 
as a dot.

Left-hand tapping on notation staff

RELATED LINKS
Inputting tapping on page 290
Changing the staff-relative placement of guitar techniques on page 783
Fingerings for fretted instruments on page 665

Hammer-ons and pull-offs
Hammer-ons and pull-offs involve performers tapping or plucking the strings of fretted 
instruments with their left hand strongly enough that the corresponding pitch sounds without 
additional striking, producing a legato effect. Ligados are a combination of at least one hammer-
on and one pull-off in a single phrase.

Hammer-ons and pull-offs are notated as the letters H or P respectively combined with a 
slur spanning the corresponding notes. Dorico SE automatically centers hammer-on/pull-off 
indications on slurs. For ligados, each hammer-on/pull-off indication is centered over the range 
of notes in the corresponding direction.

Guitar techniques
Hammer-ons and pull-offs 
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A phrase containing hammer-ons, a pull-off, and a ligado

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff. You can change the staff-relative placement of individual hammer-on/pull-off 
indications.

In Dorico SE, hammer-on/pull-off indications are considered properties of notes.

Hammer-ons
Hammer-ons specify that the performer should tap the string at the specified pitch 
with their left hand without restriking the string. Hammer-ons require at least two 
notes on the same string with an ascending pitch direction, such as C-D. In Dorico SE, 
hammer-ons appear as a letter H.

Hammer-ons on notation staff

Pull-offs
Pull-offs specify that the performer should pluck the string at the specified pitch with 
their left hand without restriking the string. Pull-offs require at least two notes on 
the same string with a descending pitch direction, such as D-C. In Dorico SE, pull-offs 
appear as a letter P.

Pull-off on notation staff

Ligados
Ligados specify that the performer should both hammer on and pull off notes within a 
single phrase. Ligados require at least three notes on the same string with alternating 
pitch directions, such as C-D-C. In Dorico SE, ligados comprise at least one hammer-on 
and pull-off.

Ligado on notation staff

Guitar techniques
Hammer-ons and pull-offs 
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RELATED LINKS
Inputting hammer-ons/pull-offs on page 288
Changing the staff-relative placement of guitar techniques on page 783
Fingerings for fretted instruments on page 665

Showing notes as dead notes
You can show individual notes belonging to fretted instruments as dead notes. Dead notes are 
notated with cross noteheads on notation staves and with an X on tablature.

PROCEDURE

1. Select the notes belonging to fretted instruments that you want to show as dead notes.

2. In the Properties panel, activate Dead note in the Notes and Rests group.

RESULT
The selected notes are shown as dead notes.

NOTE

This does not currently affect their sound in playback; this is planned for future versions.

EXAMPLE

Normal notes Dead notes

RELATED LINKS
Inputting notes on tablature on page 184
Bracketed noteheads on page 728
Tablature on page 917

Changing vibrato bar dip intervals
You can change the intervals of individual vibrato bar dips. By default, vibrato bar dips have half 
step intervals.

PROCEDURE

1. Select the vibrato bar dips whose interval you want to change.

2. In the Properties panel, change the value for Interval above in the Ornaments group.

For example, enter 1 for a half step interval, 2 for a whole step interval, or 3 for a minor third 
interval.

Guitar techniques
Showing notes as dead notes 
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RESULT
The interval of the selected vibrato bar dips is changed.

EXAMPLE

Vibrato bar dip with half step 
interval

Vibrato bar dip with whole step 
interval

Vibrato bar dip with minor third 
interval

RELATED LINKS
Inputting vibrato bar dips with the popover on page 286
Inputting vibrato bar dips with the panel on page 286
Changing ornament intervals on page 741
Trill intervals on page 748

Changing the staff-relative placement of guitar techniques
You can show individual tapping, hammer-on, and pull-off indications either above or below the 
staff. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose guitar technique staff-relative placement you want to change.

2. In the Properties panel, activate Technique placement in the Guitar Techniques group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of tapping, hammer-on, and pull-off indications on the selected 
notes is changed. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

TIP

You can change the staff-relative placement of vibrato bar dips and lines by selecting them and 
pressing F .

RELATED LINKS
Changing the direction of guitar pre-bends/pre-dives on page 776
Changing the staff-relative placement of items on page 343
Changing the property scope on page 149

Guitar techniques
Changing the staff-relative placement of guitar techniques 
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Copying property settings to other layouts/frame chains on page 395

Lengthening/Shortening vibrato bar indications/lines
You can lengthen/shorten the duration of vibrato bar indications/lines after they have been 
input. Lengthening a vibrato bar indication gives it duration and shows a duration line, which is 
dashed by default.

PROCEDURE

1. In Write mode, select the vibrato bar indications/lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one vibrato bar line at a time and it 
must have duration already. When using the keyboard, you can lengthen/shorten multiple 
string indicators, but they must all have duration already.

2. Lengthen/Shorten the vibrato bar indications/lines in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To snap the end of a single vibrato bar indication/line to the next notehead, press Ctrl/
Cmd-Shift-Alt/Opt-Right Arrow .

● To snap the end of a single vibrato bar indication/line to the previous notehead, press 
Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

● When multiple vibrato bar indications/lines are selected, you can only lengthen/
shorten them according to the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening vibrato bar lines only moves 
their end. You can move the start of vibrato bar lines by moving them rhythmically, 
or by clicking and dragging the start handle once they have duration.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single vibrato bar indications/lines are lengthened/shortened according to the current rhythmic 
grid resolution or to the next/previous notehead, whichever is closer. If they previously had no 
duration, they now have duration and show a duration line.

Multiple vibrato bar indications/lines are lengthened/shortened according to the current 
rhythmic grid resolution.

Guitar techniques
Lengthening/Shortening vibrato bar indications/lines 
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EXAMPLE

Vibrato bar indication (selected) with no duration Vibrato bar indication (selected) with duration and 
duration line

RELATED LINKS
Vibrato bar techniques on page 778
Playing technique duration on page 819
Playing technique continuation lines on page 818
Input methods for guitar bends and guitar techniques on page 278

Deleting guitar techniques
You can remove vibrato bar scoops and tapping, hammer-on, and pull-off indications from notes 
after you have input them. However, because these guitar techniques are properties of notes 
rather than separate items in Dorico SE, you must select and delete them differently from other 
items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar techniques.

2. Remove guitar techniques in any of the following ways:

● To remove tapping, hammer-on, and pull-off indications, deactivate Technique in the 
Guitar Techniques group of the Properties panel.

● To remove guitar vibrato bar scoops, deactivate Vibrato bar scoop in the Guitar 
Techniques group of the Properties panel.

RESULT
Tapping, hammer-on, and pull-off indications and/or vibrato bar scoops are removed from the 
selected notes.

Guitar techniques
Deleting guitar techniques 
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Jazz articulations

Jazz articulations in Dorico SE cover a range of note ornamentations that are idiomatic to jazz 
music, and brass instruments in particular.

Although they are often known as jazz “articulations”, these techniques function more like 
ornaments than articulations because they change the pitch rather than the duration or attack 
of notes. For this reason, they are considered ornaments in Dorico SE. They are found in the 
Ornaments panel, and you can also input them using the ornaments popover.

Jazz articulations can be shown as a curved line similar to a slur, which is called a “bend” in 
Dorico SE, and as a straight line, which can be solid, dashed, or wiggly, which is called “smooth” 
in Dorico SE.

Each note can have a single jazz articulation on each side of it, one before the note and one after. 
Jazz articulations after notes can have different lengths.

The following jazz articulations can be shown before notes:

Plop
An approach into the note from above.

Plop (bend) Plop (smooth)

Scoop/Lift
An approach into the note from below. A bend approach is a scoop, a smooth approach 
is a lift.

Scoop Lift (straight)

The following jazz articulations can be shown after notes:

Doit
A rise in pitch after the note.

Doit (bend) Doit (smooth)

Fall
A lowering of pitch after the note.
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Fall (bend) Fall (smooth)

Additionally, there are other jazz ornaments commonly used by brass instruments that you can 
add to notes in the same ways as inputting jazz articulations.

If your sound library includes samples for jazz articulations, Dorico SE loads the required samples 
using playback techniques.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Ornaments popover on page 266
Playback techniques on page 512

Jazz ornaments
Jazz ornaments are notations that are commonly used in jazz music and by brass instruments, 
such as flips and smears, that are positioned outside of the staff rather than beside noteheads 
like jazz articulations.

Jazz ornaments behave more like other ornaments than jazz articulations, in that they are items 
separate from notes, and so can be selected independently of notes in Write mode and added 
to notes in addition to jazz articulations. Because they are so commonly used alongside jazz 
articulations, in Dorico SE they are also included in the Jazz section in the Ornaments panel.

You can input jazz ornaments in the same ways as inputting other ornaments rather than jazz 
articulations.

The following ornaments are considered jazz ornaments in Dorico SE:

Flip

Smear

Jazz turn/Shake

Bend

NOTE

Jazz articulations are not currently reflected in playback.

RELATED LINKS
Ornaments on page 741
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266
Ornaments popover on page 266

Jazz articulations
Jazz ornaments 
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Positions of jazz articulations
In Dorico SE, jazz articulations are automatically positioned relative to the noteheads to which 
they apply, with any other notations on those notes, such as rhythm dots, accidentals, and back 
notes, automatically considered.

When multiple notes in a chord have a jazz articulation, Dorico SE considers the best way to 
align them based on how close to the noteheads they can be positioned and how many jazz 
articulations to show in total. Dorico SE allows a maximum of one jazz articulation per space, 
meaning fewer jazz articulations than noteheads are sometimes shown on cluster chords.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266

Changing the type/length of existing jazz articulations
You can change the type and length of jazz articulations after you have input them, for example, 
if you want to change a smooth doit to a long bend doit. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.

PROCEDURE

1. In Write mode, select the notes whose jazz articulation you want to change.

2. In the Ornaments panel, click the jazz articulation you want in the Jazz section.

RESULT
The jazz articulation shown on the selected notes is changed.

TIP

You can also change the type/duration of jazz articulations using the In and Out properties in the 
Jazz Articulations group of the Properties panel.

EXAMPLE

Short bend doit Medium bend doit Long bend doit

Changing the line style of smooth jazz articulations
You can change the line style of smooth jazz articulations individually. For example, if you want 
selected smooth falls to have straight lines instead of wavy lines.

PROCEDURE

1. Select the notes with smooth jazz articulations whose line style you want to change.

Jazz articulations
Positions of jazz articulations 
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NOTE

You must select notes with smooth jazz articulations on the same side, for example, only 
select notes with smooth jazz articulations before them.

2. In the Properties panel, select one of the following line styles from the In line style menu 
and/or Out line style menu in the Jazz Articulations group:

● Straight

● Wavy

● Dashed

NOTE

In line style is available when you select notes with smooth jazz articulations before them, 
and Out line style is available when you select notes with smooth jazz articulations after 
them. Both are available when you select notes with smooth jazz articulations on both sides.

RESULT
The line style of the selected smooth jazz articulations is changed.

TIP

You can reset jazz articulations back to their default line style by selecting them and choosing 
Edit > Reset Appearance.

EXAMPLE

Doit smooth with straight line Doit smooth with wavy line Doit smooth with dashed line

Deleting jazz articulations
You can remove jazz articulations from notes after you have input them. However, because jazz 
articulations are properties of notes rather than separate items in Dorico SE, you must select and 
delete them differently from other items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove jazz articulations.

2. In the Ornaments panel, click Remove in the Jazz section.

RESULT
All jazz articulations are removed from the selected notes.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 266

Jazz articulations
Deleting jazz articulations 
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Inputting vibrato bar dives on page 281

Jazz articulations
Deleting jazz articulations 
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Page numbers

Page numbers are used to give each page a unique number, and indicate its position relative to 
other pages. Just as in newspapers and books, musical scores and parts use page numbers to 
make sure the music stays in the correct order.

Because you can have multiple flows in a single project in Dorico SE, you do not need to change 
page numbers manually in most cases. However, if you have separate files that together make 
up a single piece, page number changes are necessary to make sure the page numbers continue 
seamlessly from movement to movement.

In such cases, you can change the default page numbers. For example, if you want to have four 
pages of front matter before the first page of music in the score, but you want the first page of 
music in the score to be shown as page 1, you can insert a page number change on the first page 
of music.

Page numbers are layout-specific in Dorico SE, meaning you can change the page numbers in 
each layout independently. For example, you can change the page numbers in the score but 
show the default page numbers in the parts.

Page numbers in Dorico SE use a text token to ensure the number is correct.

NOTE

You must have a text frame containing the page number token on every page on which you want 
page numbers to be shown.

The default master pages contain text frames with page number tokens. You can change the 
position of page number text frames in the master page editor, which changes the position of 
page numbers on all pages that use that master page. You can also move page number text 
frames on individual pages.

You can also change the type of number used to show page numbers in each layout. For 
example, if you want the front matter to use Roman numerals but the music pages to use Arabic 
numerals, you can change the type of number together with the page number.

RELATED LINKS
Text tokens on page 397

Changing the page number numeral style
Page numbers can appear as Arabic or Roman numerals. You can change the numeral style of 
page numbers in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page number numeral style you want to change.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.
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3. Click Page Setup in the category list.

4. In the Page Numbers section, select one of the following options from the Use menu:

● Number

● Roman numeral

5. Click Apply, then Close.

RESULT
The page number numeral style is changed in the selected layouts.

Hiding/Showing page numbers
You can hide/show page numbers in each layout independently, including specifying whether to 
hide/show a page number on the first page. For example, you can show page numbers on every 
page in the score but hide page numbers on the first page in the parts.

NOTE

To show page numbers, there must be a text frame containing the page number token on the 
page. The default master page formats for first pages do not contain text frames containing 
page number tokens, so you must add these if you want to show page numbers on first pages in 
your project that use the default master page formats.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show page numbers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Page Setup in the category list.

4. In the Page Numbers section, select one of the following options from the Visibility menu:

● Always shown

● Always hidden

● Not on first page

5. Click Apply, then Close.

RESULT

● If you select Always shown, page numbers are shown on all pages that have a text frame 
containing the page number token in the selected layouts.

● If you select Always hidden, page numbers are hidden on all pages in the selected layouts, 
including on pages that have a text frame containing the page number token.

● If you select Not on first page, page numbers are hidden on the first page in the selected 
layouts, but shown on all other pages that have a text frame containing the page number 
token.

Page numbers
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NOTE

Your per-layout setting for whether page numbers are hidden/shown above flow headings 
affects whether page numbers are shown on pages where they are higher on the page than 
flow headings.

RELATED LINKS
Flow headings on page 364
Hiding/Showing information in running headers above flow headings on page 380

Page numbers
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Harp pedaling

Harp pedaling is a broad term that covers the specific requirements for notating music for harps. 
This primarily involves harp pedal diagrams, which are often necessary due to the way in which 
modern concert harps change their tuning.

A passage with a full harp pedal diagram at the start and two subsequent partial pedal changes

Harps have seven strings in each octave, one for each diatonic pitch C-B, unlike pianos, which 
have twelve keys in each octave, one for each half-step (semitone) degree between C-B. 
Therefore, harps have a mechanical action to change their tuning that includes seven pedals, 
with each pedal controlling the pitch of the corresponding note in all octaves. These pedals are 
organized into two groups, one for each foot: three pedals for the left foot and four pedals for 
the right foot.

Each harp pedal has three possible positions:

1. Flat or highest position: lowers the pitch of the corresponding note by a half-step

2. Natural or middle position

3. Sharp or lowest position: raises the pitch of the corresponding note by a half-step

NOTE

The lowest two harp strings, C and D, are not affected by the C and D pedal positions.

There are different ways to notate the pedal settings required for a piece of music or a passage 
within a piece. In Dorico SE, you can show harp pedaling in the following ways:

Diagram

Indicates the physical positions of the seven pedals. The vertical line represents the 
split between left-foot and right-foot pedals and the horizontal line represents the 
natural position.

● Pedals below the horizontal line indicate sharpened notes.

● Pedals above the horizontal line indicate flattened notes.
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Note Names

Indicates the required accidentals for the seven diatonic pitches, arranged in two lines. 
Right-foot pedals are shown on top and left-foot pedals are shown below.

Any pitches that you input that do not fit with the current harp pedal diagram are considered out 
of range, and appear red when colors are shown for notes that are out of range. If you do not 
input any harp pedaling, Dorico SE assumes all harp pedals are in their natural setting, as they 
would be for C major.

In Dorico SE, you can input harp pedal diagrams using the playing techniques popover and 
you can automatically generate accurate harp pedal diagrams based on an entire flow or a 
specific passage of music. However, you can only input and show harp pedal diagrams on staves 
belonging to harp instruments; if you copy material from harp staves to other instruments, harp 
pedaling is automatically removed.

By default, harp pedaling is hidden in full score/custom score layouts and shown in part layouts. 
In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts. 
You can hide/show harp pedaling in each layout independently and hide individual harp pedal 
diagrams in layouts where harp pedaling is shown. You can also determine when to show partial 
harp pedaling, such as when only a single pedal must be changed at one time.

Harp pedal diagrams in Dorico SE affect the pitches played back in glissando lines.

RELATED LINKS
Partial harp pedaling on page 799
Inputting harp pedal diagrams on page 300
Hiding/Showing harp pedaling in layouts on page 796
Calculating harp pedal diagrams based on existing music on page 301
Hiding/Showing colors for notes out of range on page 727
Glissando lines in playback on page 766

Changing the appearance of harp pedal diagrams
Harp pedaling can be shown as a diagram or using note names. You can change the appearance 
of harp pedal diagrams individually. You can do this for the current layout and frame chain only 
or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harp pedal diagrams whose appearance you want to change.

2. In the Properties panel, activate Appearance in the Harp Pedals group.

3. Choose one of the following options:

● Diagram

● Note Names
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RESULT
The appearance of the selected harp pedal diagrams is changed in the current layout. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default appearance of harp pedaling in each layout independently in the 
Harp Pedaling section of the Players page in Setup > Layout Options.

EXAMPLE

Harp pedaling shown as a diagram

Harp pedaling shown using note names

RELATED LINKS
Partial harp pedaling on page 799
Inputting harp pedal diagrams on page 300
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Hiding/Showing harp pedaling in layouts
You can input and calculate harp pedaling in any layout, but by default harp pedaling is not 
shown in full score layouts, as they are usually only useful for the performer. You can hide/show 
harp pedaling in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show harp pedaling.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Harp Pedaling section, activate/deactivate Show harp pedaling.

5. Click Apply, then Close.

RESULT
Harp pedaling is shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts.

NOTE

● You can hide individual harp pedal diagrams in layouts where harp pedaling is shown, but 
you cannot show individual harp pedal diagrams in layouts where harp pedaling is hidden.
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● You can hide/show harp pedaling signposts by choosing View > Signposts > Harp Pedals. 
Harp pedaling signposts are shown when a tick appears beside Harp Pedals in the menu, 
and hidden when no tick appears.

Hiding/Showing harp pedal diagrams individually
You can hide/show individual harp pedal diagrams in layouts in which harp pedaling is shown. 
You can do this for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to hide/show individual harp pedal 
diagrams.

2. Select the harp pedal diagrams you want to hide, or the signposts of harp pedal diagrams 
you want to show.

3. In the Properties panel, activate/deactivate Hide in the Harp Pedals group.

RESULT
The selected harp pedal diagrams are hidden when Hide is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden harp pedal diagram. However, signposts are 
not printed by default.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Signposts on page 349
Annotations on page 537

Hiding/Showing borders on harp pedal diagrams
You can hide/show borders on individual note name harp pedal diagrams. For example, on 
systems with very tight vertical spacing, hiding borders on harp pedal diagrams can give you a 
little extra space.

NOTE

These steps only apply to harp pedal diagrams using note names.

PREREQUISITE
Harp pedaling is shown in the current layout.

PROCEDURE

1. Select the note name harp pedal diagrams on which you want to hide/show borders.

2. In the Properties panel, activate Border in the Harp Pedals group.
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3. Activate/Deactivate the corresponding checkbox.

RESULT
Borders are shown on the selected note name harp pedal diagrams when the checkbox is 
activated, and hidden when the checkbox is deactivated.

EXAMPLE

Note name harp pedal diagram with border hidden Note name harp pedal diagram with border shown

Positions of harp pedal diagrams
By default, harp pedal diagrams are centered vertically between the two staves usually shown for 
harps.

You can move harp pedal diagrams to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

Moving harp pedal diagrams rhythmically
You can move harp pedal diagrams to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the harp pedal diagrams or the signposts of harp pedal diagrams that 
you want to move.

NOTE

When using the mouse, you can only move one harp pedal diagram rhythmically at a time.

2. Move the harp pedal diagrams according to the current rhythmic grid resolution in any of 
the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the harp pedal diagram to the right/left.

RESULT
The selected harp pedal diagrams are moved to new rhythmic positions.
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NOTE

If moving harp pedal diagrams means some notes no longer fit with the current harp pedal 
diagram and colors are shown for notes out of range, these notes appear red.

RELATED LINKS
Hiding/Showing colors for notes out of range on page 727

Partial harp pedaling
Partial harp pedal diagrams only show the notes whose pedal setting must change at that 
position, rather than showing the required settings for all pedals. This can make those changes 
immediately clear to the performer, as they have fewer pedals to read.

Partial pedal diagrams for a sequence containing several quick pedal changes

You can allow partial harp pedaling for individual harp pedal diagrams and you can set a 
maximum threshold of pedal changes at a single position, above which all harp pedal diagrams 
must show all pedals. This is because performers are used to the pattern of note names in 
complete harp pedal diagrams, and if there are many changes in a partial harp pedal diagram, 
this can be harder to read than a complete one.

By default, Dorico SE shows notes in partial harp pedal diagrams on two lines with right-foot 
pedals on top and left-foot pedals below.

NOTE

Only harp pedal diagrams using note names can be shown as partial.

Allowing/Disallowing partial harp pedaling
You can allow/disallow partial harp pedaling for individual note name harp pedal diagrams. The 
default setting in Dorico SE is to allow partial harp pedaling for up to three pedal changes. You 
can do this for the current layout and frame chain only or for all layouts and frame chains.

NOTE

● These steps only apply to harp pedal diagrams using note names.

● Harp pedal diagrams positioned at the very beginning of a flow can only appear as full harp 
pedal diagrams.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the note name harp pedal diagrams for which you want to allow/disallow partial harp 
pedaling.

2. In the Properties panel, activate Partial pedaling in the Harp Pedals group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Partial harp pedaling is allowed for the selected note name harp pedal diagrams when the 
checkbox is activated, and disallowed when the checkbox is deactivated. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Harp pedal diagram showing all pedals Partial harp pedal diagram

RELATED LINKS
Hiding/Showing harp pedaling in layouts on page 796
Inputting harp pedal diagrams on page 300
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Pedal lines

Pedal lines indicate to performers which piano pedals to use, and can also give performance 
instructions, such as how far down to depress the pedals and when to lift the pedal to clear the 
resonance.

Most pianos have either two or three pedals. These pedals are:

Sustain pedal
The sustain pedal controls the dampers on the piano strings, which is why it is also 
known as the “damper pedal”. It is also the most commonly used pedal. Depressing the 
sustain pedal removes the dampers, allowing the strings to resonate longer. Sustain 
pedals are usually on the right.

An example sustain pedal line

Sostenuto pedal
The sostenuto pedal only allows the strings of the notes currently depressed on the 
keyboard to resonate. It is also known as the “middle pedal” as it is usually in the 
middle of the other pedals.

An example sostenuto pedal line

Una corda pedal
The una corda pedal shifts the action inside the piano so that the hammers hit fewer 
strings than normal. Historically, this caused hammers only to hit one string, not the 
usual three, which is where the name comes from. Because this reduces the volume 
and impact of the sound, it is also known as the “soft pedal”.

An example una corda pedal line

Dorico SE offers comprehensive notational and playback support for piano pedal lines. You 
can create pedaling for the sustain, sostenuto, and una corda pedals, with support for modern 
sustain pedaling techniques, including changing the pedal level over the course of a single pedal 
instruction.

In Dorico SE, pedal lines are considered playing techniques because they alter the sound 
produced by the instrument. Therefore, pedal lines are included in the Playing Techniques panel 
in Write mode and you can input them using the playing techniques popover. However, pedal 
lines have additional, unique requirements that do not apply to other playing techniques, such as 
retakes, pedal level changes, start signs, end signs, and continuation lines.
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RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Pedal lines in playback on page 812
Pedal line start signs, hooks, and continuation lines on page 808
Text pedal line signs on page 810
Lines on page 823
Playing technique continuation lines on page 818

Sustain pedal retakes and pedal level changes
Pedal retakes indicate where a player should lift the sustain pedal, which dampens the piano’s 
strings and clears the resonance, before depressing the pedal again. Pedal level changes indicate 
a change to how far the pedal is depressed.

Dorico SE provides clear representations of pedal retakes and level changes.

NOTE

● In Dorico SE, you cannot input pedal level changes. However, pedal level changes are shown 
if you import or open a project that contains them, and you can remove them in the same 
way as removing retakes.

● You can only add pedal retakes to sustain pedal lines.

EXAMPLE

Example pedal line with retake and level changes

1 Ped. glyph

2 Retake

3 One quarter depressed

4 Half depressed

5 Three quarters depressed

6 Fully depressed

7 Line end hook

RELATED LINKS
Removing retakes and pedal level changes on page 803
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Positions of pedal lines on page 803
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Removing retakes and pedal level changes
You can remove pedal retakes and level changes without deleting the sustain pedal line or 
changing its rhythmic position.

PROCEDURE

1. In Write mode, select the note on the staff and at the rhythmic position of the retake or 
pedal level change you want to remove.

NOTE

You can only remove one retake or pedal level change at a time.

2. Remove the retake or pedal level change in any of the following ways:

● Open the playing techniques popover, enter nonotch into the popover, then press 
Return .

NOTE

nonotch must be spelled as one word, without a space.

● Choose Edit > Pedal Lines > Remove Retake. You can also choose this option from the 
context menu.

RESULT
The selected retake or pedal level change is removed, and the pedal line returns to its previous 
level as set by either the start of the pedal line, or the retake or pedal level change immediately 
preceding the one you removed.

RELATED LINKS
Playing techniques popover on page 291

Positions of pedal lines
The default placement of pedal lines is below the bottom staff, even if there are only notes in the 
upper staff for the right hand. They are placed outside all other notations, including octave lines, 
slurs, and articulations.

If one pedal is used, it is placed as close to the bottom of the staff as possible, while remaining 
outside of all other notations.

If multiple pedals are used simultaneously, they are organized below the bottom of the staff as 
follows:

1. Sustain pedal: closest to the staff

2. Sostenuto pedal: below the sustain pedal line

3. Una corda pedal: furthest from the staff

The beginning of the glyph/text that indicates the start position of pedal lines aligns with the 
note to which it applies. If you are using a line end hook to indicate the end of pedal lines, the 
hook aligns with the note or rhythmic position to which it applies.

You can move pedal lines to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.
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NOTE

You cannot move retakes rhythmically. You must remove them and input a new retake at the 
position you want.

RELATED LINKS
Text pedal line signs on page 810
Pedal line start signs, hooks, and continuation lines on page 808
Lengthening/Shortening pedal lines on page 805
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291

Moving pedal lines rhythmically
You can move pedal lines to new rhythmic positions after they have been input. Any retakes or 
pedal level changes on the pedal lines are also moved.

NOTE

If you want to move retakes independently of the pedal line, you must first remove them from 
their original positions and input new retakes at the new positions.

PROCEDURE

1. In Write mode, select the pedal lines you want to move.

NOTE

When using the mouse, you can only move one pedal line rhythmically at a time.

2. Move the pedal lines in any of the following ways:

● To move a single pedal line to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single pedal line to the previous notehead on the staff, press Alt/Opt-
Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple pedal lines are selected, you can only move them according to the 
current rhythmic grid resolution.

● Click and drag the pedal line to the right/left.

RESULT
The selected pedal lines are moved to new rhythmic positions.
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NOTE

Pedal lines can only be moved along staves. If you want to move a pedal line across staves, you 
must delete the pedal line and input a new pedal line on the other staff.

RELATED LINKS
Lengthening/Shortening pedal lines on page 805
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291

Changing the position of pedal lines relative to grace notes
You can change the start/end positions of individual pedal lines relative to grace notes.

PROCEDURE

1. Select the pedal lines whose position relative to grace notes you want to change.

2. In the Properties panel, activate any of the following properties in the Pedal Lines group:

● Starts before grace notes

● Ends before grace notes

3. Activate/Deactivate the corresponding checkboxes.

RESULT
When the checkboxes are activated, the corresponding parts of the selected pedal lines are 
positioned before grace notes.

When the checkboxes are deactivated, the corresponding parts of the selected pedal lines are 
positioned after grace notes.

EXAMPLE

Pedal line starting/ending before grace notes Pedal line starting/ending after grace notes

Lengthening/Shortening pedal lines
You can lengthen/shorten pedal lines rhythmically after they have been input.

PROCEDURE

1. In Write mode, select the pedal lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one pedal line at a time.

2. Lengthen/Shorten the pedal lines in any of the following ways:
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● To snap the end of a single pedal line to the next notehead, press Ctrl/Cmd-Shift-Alt/
Opt-Right Arrow .

● To snap the end of a single pedal line to the previous notehead, press Ctrl/Cmd-Shift-
Alt/Opt-Left Arrow .

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

NOTE

● When multiple pedal lines are selected, you can only lengthen/shorten them 
according to the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening pedal lines only moves their end. 
You can move the start of pedal lines by moving the whole line, or by clicking and 
dragging the start handle.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single pedal lines are lengthened/shortened according to the current rhythmic grid resolution or 
to the next/previous notehead, whichever is closer.

Multiple pedal lines are lengthened/shortened according to the current rhythmic grid resolution.

RELATED LINKS
Positions of pedal lines on page 803
Moving pedal lines rhythmically on page 804

Splitting pedal lines
You can split sustain pedal lines at any rhythmic position with an existing item along their length 
into two separate pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to split the sustain 
pedal line.

NOTE

You can only split one pedal line at a time.

2. Choose Edit > Pedal Lines > Split Pedal Line. You can also choose this option from the 
context menu.

RESULT
The pedal line on the selected staff is split at the selected rhythmic position.

AFTER COMPLETING THIS TASK
You can move, lengthen/shorten, and edit both pedal lines independently.
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RELATED LINKS
Moving pedal lines rhythmically on page 804
Pedal line start signs, hooks, and continuation lines on page 808
Text pedal line signs on page 810

Merging pedal lines
You can merge existing sustain pedal lines together, for example, if you want to fill in a gap 
between two sustain pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PROCEDURE

1. Select the sustain pedal lines on the same staff that you want to merge together.

NOTE

You can only merge pedal lines on one staff at a time.

2. Choose Edit > Pedal Lines > Merge Pedal Lines. You can also choose this option from the 
context menu.

RESULT
The selected pedal lines are merged together into a single pedal line. If there were gaps between 
them, a continuation line is automatically shown across them.

EXAMPLE

Two separate pedal lines Two pedal lines merged into one

AFTER COMPLETING THIS TASK
You can input retakes and pedal level changes, for example, if you want to show a retake at the 
position where previously one of the pedal lines started.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
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Pedal line start signs, hooks, and continuation lines
Pedal lines normally comprise a start sign, a continuation line, and an end hook. This indicates 
clearly to performers where to depress each type of pedal, how long to keep it depressed, and 
where to lift it.

In Dorico SE, you can change the appearance of each part of pedal lines individually, for example, 
if you want the start sign of an individual pedal line to show text instead of a glyph.

You can select whole pedal lines in Write mode and change most aspects of their appearance 
according to the type of pedal line, such as their continuation line or start sign.

Changing the start sign appearance of pedal lines
You can change the appearance of the start of pedal lines individually. Pedal line start signs can 
be shown as variations of the traditional pedal line glyph, other symbols, or text.

PROCEDURE

1. Select the pedal lines whose start sign appearance you want to change.

NOTE

The pedal lines you select must be the same type, for example, only sustain pedal lines.

2. In the Properties panel, activate Sign appearance in the Pedal Lines group.

3. Select one of the options from the menu.

The options are different according to the type of pedal line selected.

RESULT
The start sign appearance of the selected pedal lines is changed.

TIP

Deactivating Sign appearance returns the selected pedal lines to your default setting for start 
sign appearance.

AFTER COMPLETING THIS TASK
If you selected a text sign appearance, you can edit the text shown.

RELATED LINKS
Editing pedal line start text on page 810

Changing the type of hook at the start/end of pedal lines
You can change the type of hook shown at the start/end of pedal lines individually.

NOTE

You can only change the start hook type of pedal lines that have a hook as their start sign, and 
you can only change the end hook type of pedal lines that have a continuation line.

PROCEDURE

1. Select the pedal lines whose hook type you want to change.
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2. In the Properties panel, activate the following properties, individually or together, in the 
Pedal Lines group:

● Line start hook

● Line end hook

3. Select one of the following options from each menu:

● No Hook

● Vertical Hook

● Slant Hook

● Inverse Hook

RESULT
The hook type at the start/end of the selected pedal lines is changed.

Changing the continuation line type of pedal lines
You can change the type of continuation line used for the different types of pedal lines 
individually.

PROCEDURE

1. Select the pedal lines whose continuation line type you want to change.

2. In the Properties panel, activate Continuation type in the Pedal Lines group.

3. Select one of the following continuation types from the menu:

● Line

● Sign at End

● Sign at End and Dashed Line

● None

RESULT
The continuation line type of the selected pedal lines is changed.

Parenthesizing pedal line continuation signs
You can show individual pedal line continuation signs with/without parentheses. You can do 
this for the current layout and frame chain only or for all layouts and frame chains. Pedal line 
continuation signs are shown by default at the start of new systems when pedal lines continue 
across system/frame breaks.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the pedal lines whose continuation sign appearance you want to change.

2. In the Properties panel, activate Show continuation sign in parentheses in the Pedal Lines 
group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Continuation signs are shown with parentheses when the checkbox is activated, and without 
parentheses when the checkbox is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Text pedal line signs
All types of pedal lines can have text as their start signs, instead of glyphs or hooks. You can 
override the text shown at the start of pedal lines that have text start signs, you can change the 
continuation text shown at the start of new systems, and you can override the restorative text 
shown at the end of una corda pedal lines.

Pedal lines that use a text indication rather than a symbol

For pedal lines such as una corda or sustain that have text for their start sign, such as Ped. Text, 
rather than the more ornate symbol, you can override the text shown at the start of the pedal 
line and replace it with your preferred performance direction.

Continuation sign/text

When pedal lines continue onto subsequent systems, a continuation sign/text is shown in 
parentheses by default. If the pedal line is using text for their start sign, such as Ped. Text, 
rather than a symbol, you can change the text shown at the start of a new system and replace it 
with your preferred performance direction.

Una corda pedal lines

The equivalent to the final pedal lift for the una corda pedal marking is the indication to return to 
tre corde. You can override the tre corde text shown at the end of the pedal line and replace it with 
your preferred performance direction.

RELATED LINKS
Changing the start sign appearance of pedal lines on page 808

Editing pedal line start text
You can change the text shown at the start of individual pedal lines that use text as their start 
sign.

PROCEDURE

1. Select the pedal lines whose start text you want to edit.

2. In the Properties panel, activate Text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown at the start of the selected pedal lines is changed.

Deactivating Text restores the default start text for the selected pedal lines.
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NOTE

Deactivating properties permanently deletes any custom text entered.

RELATED LINKS
Changing the start sign appearance of pedal lines on page 808

Editing pedal line continuation text
You can change the text shown at the start of subsequent systems when pedal lines continue 
across system/frame breaks.

NOTE

These steps only apply to pedal lines that use text as their start sign.

PROCEDURE

1. Select the pedal lines whose continuation text you want to edit.

2. In the Properties panel, activate Continuation text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The continuation text shown at the start of subsequent systems for the selected pedal lines is 
changed.

Deactivating Continuation text restores the default continuation text for the selected pedal 
lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Editing una corda pedal line restorative text
The equivalent to the final pedal lift for una corda pedal lines is the indication to return to tre 
corde. You can change the tre corde text shown at the end of individual una corda pedal lines.

NOTE

These steps only apply to una corda pedal lines that use text as their start sign.

PROCEDURE

1. Select the una corda pedal lines whose restorative text you want to edit.

2. In the Properties panel, activate Restorative text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .
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RESULT
The restorative text shown at the ends of the selected una corda pedal lines is changed.

Deactivating Restorative text restores the default restorative text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Pedal lines in playback
Pedal lines are automatically played back in Dorico SE.

The three piano pedals send MIDI controllers as follows:

● Sustain pedal lines send MIDI controller 64 (Sustain).

● Sostenuto pedal lines send MIDI controller 66 (Sostenuto).

● Una corda pedal lines send MIDI controller 67 (Soft Pedal).

Some piano VST instruments, such as Pianoteq and Garritan CFX Concert Grand, support 
partial depression of the sustain pedal. Consult the manufacturer’s documentation for more 
information.

Pedal lines imported from MusicXML files
Sustain pedal lines can be imported from MusicXML files. MusicXML can only describe the sustain 
pedal, and it cannot describe changes in pedal depression level.

Pedal lines
Pedal lines in playback 

812
Dorico SE 3.5.12



Playing techniques

The term “playing techniques” covers a wide range of instructions intended to tell performers to 
modify the sound of the notes they are playing, for example, by changing their embouchure or 
changing the position of their bow, or by modifying their instrument, such as adding a mute or 
depressing a pedal.

In Dorico SE, there are the following types of playing techniques:

Glyph playing techniques
Playing techniques that display symbols, such as up bow  or down bow  markings.

Text playing techniques
Playing techniques that display text, such as pizz. or con sordino.

You can find all available playing techniques in the Playing Techniques panel in Write mode, 
organized by instrument family. For example, you can find pedal lines in the Keyboard section of 
the Playing Techniques panel.

NOTE

Because pedal lines have additional, unique requirements that do not apply to other playing 
techniques, such as retakes, start signs, and continuation lines, they are documented separately. 
Pedal lines also have their own group of the Properties panel that is separate from the Playing 
Techniques group.

Playing techniques can change how instruments play back. For example, inputting a pizz. playing 
technique on a violin staff activates a key switch that changes the sound produced by the VST 
instrument. Dorico SE uses playback techniques to produce the required sounds in playback 
for the playing techniques you input, provided your sound library includes the corresponding 
samples.

Many playing techniques that only appear once in the music nonetheless imply that the playing 
technique continues. For example, pizzicato usually appears once but applies until the next 
playing technique, such as arco. In Dorico SE, you can show continuation lines after and between 
playing techniques to convey clearly to performers the notes to which you want them to apply. 
You can also group multiple playing techniques together.

Playing technique texts use a plain font, neither bold nor italic, so they are not confused with 
dynamics and expressive text.

NOTE

Pedal lines use a separate font style to other playing techniques.

Some of the playing techniques in Dorico SE
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RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Playback techniques on page 512
Pedal lines on page 801
String indicators on page 674
Playing technique continuation lines on page 818
Groups of playing techniques on page 821

Adding text to playing techniques
You can add text to playing techniques after they have been input, for example, to clarify the 
intention of the playing technique. You can do this for the current layout and frame chain only or 
for all layouts and frame chains.

NOTE

These steps do not apply to pedal lines.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques to which you want to add text.

2. In the Properties panel, activate Suffix in the Playing Techniques group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered is added to the selected playing techniques and appears after them. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

EXAMPLE

Playing techniques without suffixes Suffixes added to playing techniques

RELATED LINKS
Text pedal line signs on page 810
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Playing techniques
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Hiding/Showing playing techniques
You can hide/show playing techniques individually, for example, if your expression map requires 
you to input a playing technique to trigger the correct playback but you do not want that 
technique to appear in the music. You can do this for the current layout and frame chain only or 
for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques you want to hide, or the signposts of playing techniques you 
want to show.

2. In the Properties panel, activate/deactivate Hidden in the Playing Techniques group.

RESULT
The selected playing techniques are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden playing technique. However, signposts are 
not printed by default.

TIP

● If you do not want to show playing technique signposts, choose View > Signposts > Playing 
Techniques. Playing technique signposts are shown when a tick appears beside Playing 
Techniques in the menu, and hidden when no tick appears.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text objects, 
and time signatures.

RELATED LINKS
Expression maps on page 488
Signposts on page 349
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
Key Commands page in the Preferences dialog on page 47
Annotations on page 537

Positions of playing techniques
Playing techniques, both as text and symbols, are placed above the staff by default. On vocal 
staves, they are placed above the staff and below dynamics. In multiple-voice contexts, playing 
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techniques for the up-stem voices are placed above the staff and playing techniques for the 
down-stem voices are automatically placed below the staff.

Placement of playing techniques with two voices on the same staff

You can move playing techniques to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

RELATED LINKS
Text pedal line signs on page 810
Changing the staff-relative placement of items on page 343

Moving playing techniques rhythmically
You can move playing techniques to new rhythmic positions after they have been input, including 
individual playing techniques within a group.

PROCEDURE

1. In Write mode, select the playing techniques you want to move.

NOTE

● When using the mouse, you can only move one playing technique rhythmically at a time.

● Moving multiple playing techniques in the same group at the same time ungroups them.

2. Move the playing techniques in any of the following ways:

● To move a single playing technique to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single playing technique to the previous notehead on the staff, press Alt/
Opt-Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple playing techniques are selected, you can only move them according to 
the current rhythmic grid resolution.

● Click and drag the playing technique to the right/left to the notehead you want.

RESULT
The selected playing techniques are moved to new rhythmic positions.

Playing techniques
Positions of playing techniques 
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NOTE

If a single playing technique passes over another playing technique as part of its move, the 
existing one is unaffected as multiple playing techniques can exist at the same rhythmic position. 
However, if you move multiple playing techniques together, any existing playing techniques they 
pass over are shortened or deleted accordingly.

You can undo this action, but any playing techniques shortened/deleted in the process are only 
restored if you moved playing techniques using the keyboard.

RELATED LINKS
Moving pedal lines rhythmically on page 804
Groups of playing techniques on page 821

Lengthening/Shortening playing techniques
You can lengthen/shorten the duration of playing techniques after they have been input. 
Lengthening a playing technique that was added to a single note gives it duration.

NOTE

● You can only lengthen/shorten non-grouped playing techniques or the last playing 
technique in a group.

● Lengthening/Shortening playing techniques does not affect playback. The sounds produced 
in playback rely on the playback technique associated with the playing technique, the 
expression map settings, and sound libraries loaded in the project.

PROCEDURE

1. In Write mode, select the playing techniques you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one playing technique at a time and 
it must have duration already. When using the keyboard, you can lengthen/shorten multiple 
playing techniques, but they must all have duration already.

2. Lengthen/Shorten the playing techniques in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To snap the end of a single playing technique to the next notehead, press Ctrl/Cmd-
Shift-Alt/Opt-Right Arrow .

● To snap the end of a single playing technique to the previous notehead, press Ctrl/
Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

● When multiple playing techniques are selected, you can only lengthen/shorten them 
according to the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening playing techniques with duration 
only moves their end. You can move the start of playing techniques with duration 
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by moving them rhythmically, or by clicking and dragging the start handle once they 
have duration.

● Click and drag the circular handle at the start/end to the right/left.

NOTE

Playing technique groups only have a single handle at their start and end, not individual 
handles for each playing technique within the group.

RESULT
Single playing techniques are lengthened/shortened according to the current rhythmic grid 
resolution or to the next/previous notehead, whichever is closer.

Multiple playing techniques are lengthened/shortened according to the current rhythmic grid 
resolution.

RELATED LINKS
Playing technique duration on page 819
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291

Playing technique continuation lines
Playing technique continuation lines convey exactly the notes to which playing techniques apply, 
and can also indicate a gradual transition between playing techniques.

A phrase with multiple playing technique continuation lines

In Dorico SE, there are the following types of playing technique continuation lines:

Duration line

Indicates a specific duration to which the playing technique applies. The duration line 
for most playing techniques is a solid line with a hook cap at the end.

Playing techniques show duration lines when the following conditions are met:

● The playing technique has duration.

● The continuation type for the playing technique is set to show lines.

● The playing technique is ungrouped or is the final playing technique in a group.

Transition line

Playing techniques
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Indicates that the playing technique at the start must gradually turn into the playing 
technique at the end over the duration specified by the line. The transition line for 
most playing techniques is a solid line with an arrow cap at the end.

Transition lines are automatically shown between playing techniques in groups.

NOTE

Playing technique continuation lines do not affect playback. The sounds produced in playback 
rely on the playback technique associated with the playing technique, the expression map 
settings, and the sound libraries loaded in the project.

RELATED LINKS
Groups of playing techniques on page 821
Lines on page 823
Line components on page 825

Playing technique duration
In Dorico SE, playing techniques have an explicit duration when they apply to a specific range, 
rather than from a single rhythmic position onwards. Playing techniques with duration can show 
continuation lines.

You can give duration to any playing technique in any of the following ways:

● Group playing techniques together

● Input playing techniques with an open end during note input and extend them

● Add playing techniques to a range of notes

● Lengthen playing techniques

In Write mode, playing techniques with duration have start and end handles that show their 
duration.

Start and end handles on a playing technique with duration

NOTE

Playing technique duration does not affect playback. The sounds produced in playback rely on 
the playback technique associated with the playing technique, the expression map settings, and 
the sound libraries loaded in the project.

RELATED LINKS
Hiding/Showing playing technique duration lines on page 820
Grouping playing techniques together on page 821
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Lengthening/Shortening playing techniques on page 817
Lengthening/Shortening string indicators on page 675
Vibrato bar techniques on page 778

Playing techniques
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Hiding/Showing playing technique duration lines
You can hide/show duration lines for individual playing techniques. When hiding duration lines, 
you can show nothing or sim.. When showing duration lines, you can show a line or repeat the 
signs of glyph playing techniques. You can do this for the current layout and frame chain only or 
for all layouts and frame chains.

NOTE

These steps only apply to playing technique duration lines. They do not apply to playing 
technique transition lines.

PREREQUISITE

● The playing techniques whose duration lines you want to hide/show have duration.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Write mode, select the playing techniques whose duration lines you want to hide/show.

2. In the Properties panel, activate Continuation type in the Playing Techniques group.

3. Select one of the following options from the menu:

● None

● sim.

● Line

● Repeat the signs (glyph playing techniques only)

RESULT
Duration lines are hidden after the selected playing techniques when you select None. When 
you select sim., duration lines are hidden and sim. is shown once after each selected playing 
technique.

Duration lines are shown after the selected playing techniques when you select Line.

For glyph playing techniques, the playing technique is repeated for each note within the duration 
automatically when you select Repeat the signs.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Duration line shown Duration line hidden Duration line hidden but 
sim. shown

Signs repeated on each 
note

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Playing techniques
Playing technique continuation lines 
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Groups of playing techniques
Groups of playing techniques are automatically aligned in a row and can be moved and edited 
as a group. When you move individual playing techniques within a group, the lengths of any 
continuation lines on either side automatically adjust to compensate.

A group of playing techniques The same group of playing techniques with adjusted 
transition lines after the middle playing technique 
moved rhythmically

Two or more playing techniques are automatically grouped together if they are adjoining with 
duration between them and were added to existing notes together or input in sequence during 
note input.

Transition lines are automatically shown between playing techniques in groups. The final playing 
technique in playing technique groups can show a duration line if it has duration.

All of the playing techniques in a group are highlighted when any of the playing techniques in 
the group are selected.

NOTE

● You cannot group a playing technique group to another playing technique group, you can 
only group single playing techniques together or single playing techniques to an existing 
group.

● Groups of playing techniques apply project-wide, meaning you cannot have playing 
techniques grouped one way in some layouts but differently in other layouts.

RELATED LINKS
Playing technique continuation lines on page 818
Moving playing techniques rhythmically on page 816
Playing technique duration on page 819

Grouping playing techniques together
You can manually group playing techniques together that were not automatically grouped when 
they were input. Grouped playing techniques are automatically aligned in a row, show transition 
lines between them, and can be moved and edited as a group.

NOTE

You cannot group a playing technique group to another playing technique group. You can only 
group single playing techniques together or single playing techniques to an existing group.

Playing techniques
Groups of playing techniques 
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If you want to group a playing technique group to another playing technique group, you must 
first ungroup them.

PROCEDURE

1. In Write mode, select the playing techniques you want to group together.

2. Choose Edit > Playing Techniques > Group Playing Techniques. You can also choose this 
option from the context menu.

RESULT
The selected playing techniques are grouped together. Their durations are extended to reach the 
next playing technique in the group, and transition lines are shown between playing techniques 
in the group.

RELATED LINKS
Playing technique continuation lines on page 818

Ungrouping playing techniques and removing playing techniques 
from groups

You can ungroup playing techniques so that all playing techniques in the group become 
ungrouped. You can also remove only selected playing techniques from groups while leaving 
other playing techniques in the group.

This applies to all layouts in which the playing techniques appear.

PROCEDURE

1. In Write mode, select the playing techniques you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all playing techniques in the selected groups, choose Edit > Playing 
Techniques > Ungroup Playing Techniques.

● To remove only the selected playing techniques from their groups, choose Edit > 
Playing Techniques > Remove Playing Technique from Group.

TIP

You can also choose these options from the context menu.

RESULT
The selected playing techniques or all playing techniques are removed from the selected groups. 
Playing techniques that previously had transition lines now appear with duration lines

Playing techniques
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Lines

Lines can convey a variety of meanings in music, such as indicating which hand to use in piano 
music or a gradual change in bow pressure. In Dorico SE, lines can be vertical, horizontal, or 
angled between notes and have different styles and appearances.

A phrase containing horizontal and vertical lines that convey a range of meanings

NOTE

Due to their generic designs, such as a dashed line with arrow end cap, lines in Dorico SE have 
no definitive musical meaning and function primarily graphically, meaning they do not affect 
playback. Dorico SE includes dedicated features for specific notations that affect playback if 
applicable, such as dynamics, arpeggios, glissandi, and trills.

The following types of lines are available in Dorico SE:

Horizontal lines
Horizontal lines span a specified duration, that is, they start at one rhythmic position 
and end at a later rhythmic position. They might indicate a change over time, such 
as a wedge that represents bow pressure, or suggest a link between notes, such as a 
bracket spanning the theme in a fugue or a straight line between notes showing where 
a melody moves to a different staff.

Attachment types control the positions of horizontal lines and certain aspects of their 
functionality. Horizontal lines can have different attachment types at their start and 
end.

NOTE

You cannot change the attachment type of horizontal lines after they have been input.

In Dorico SE, each end of horizontal lines can have the following attachment types:

● Notehead-attached

Attached to an individual note independently of its rhythmic position, meaning 
that the ends of notehead-attached lines move with notes if you change their 
pitch or move them rhythmically. Notehead-attached lines can be both angled 
or horizontal, as their end positions and resulting angles are determined by the 
interval between the start and end notes.
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A phrase containing two notehead-attached lines, showing where the melody moves 
between piano staves

● Barline-attached

Attached to a rhythmic position and aligned with barlines, if their rhythmic 
positions coincide with barline positions. Barline-attached lines are always 
horizontal.

A barline-attached line spanning two full bars

● Rhythmic position-attached

Attached to a rhythmic position and positioned relative to notes, chords, or rests at 
those rhythmic positions.

Rhythmic position-attached lines are horizontal and placed above the staff by 
default. Their endpoints start to the left and end to the right of notes, chords, 
or rests at the corresponding rhythmic positions.

A rhythmic position-attached line spanning two full bars

Vertical lines
Vertical lines exist at a single rhythmic position and are positioned relative to notes, 
chords or rests at that position. They might convey details about a specific moment, 
such as indicating which hand to use for specific notes in piano music.

Vertical lines indicating which notes to play with the right hand

RELATED LINKS
Input methods for lines on page 304

Lines
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Lines panel on page 305
Adding text to lines on page 835
Changing the placement of horizontal lines on page 828
Arpeggio signs on page 757
Glissando lines on page 763
Octave lines on page 622
Trills on page 744
Playing technique continuation lines on page 818
Pedal lines on page 801
Repeat endings on page 853
Guitar bends on page 768
Tuplet brackets on page 973

Line components
In Dorico SE, lines consist of multiple components that together function as a single item.

1 Start cap

Symbol shown at the start of lines. Caps can be arrowheads, hooks, or terminal lines.

2 Line body

Horizontal or vertical line, repeating symbols, dash/dot pattern, or wedge that makes up the 
main part of a line and extends across its entire length or height.

3 Text

Text shown in addition to caps, either centered in the middle of each line segment or only at 
the start or end of lines. On vertical lines, text reads upwards by default.

4 Continuation end cap

Symbol shown at the end of segments of lines that continue across multiple systems. Caps 
can be arrowheads, hooks, or terminal lines.

5 Continuation cap

Symbol shown at the start of subsequent segments of lines that continue across multiple 
systems. Caps can be arrowheads, hooks, or terminal lines.

6 End cap

Symbol shown at the end of lines. Caps can be arrowheads, hooks, or terminal lines.

Lines
Line components 
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NOTE

Dorico Pro provides further options for customizing lines and line components, such as using 
text for caps and music symbols for annotations in the center of lines. You might encounter lines 
with different components than are available in Dorico SE if you import or open a project that 
contains them.

RELATED LINKS
Changing the body style of lines on page 833
Changing the caps of lines on page 834
Adding text to lines on page 835
Changing the position of text relative to horizontal lines on page 836
Changing the position of text relative to vertical lines on page 837
Playing technique continuation lines on page 818

Positions of lines
The position of lines relative to notes and staves depends on the line type and, for horizontal 
lines, their attachment type.

Notehead-attached horizontal lines
Notehead-attached lines are positioned in relation to the corresponding noteheads, 
that is, starting to the right of the start note and ending to the left of the end note. 
They automatically follow the notes at each end, meaning if you change the pitch 
of either note or move them rhythmically, the line end positions move accordingly. 
Because their positions depend on the pitches of notes, they can appear both inside 
and outside the staff. If they are only attached to noteheads at one end, they remain 
horizontal but follow the staff position of the note to which they are attached.

Barline-attached horizontal lines
Barline-attached horizontal lines are placed above the staff by default. Their endpoints 
align with barlines if their duration coincides with barline positions. If their endpoints 
do not coincide with barlines, they are positioned like rhythmic position-attached lines.

Rhythmic position-attached horizontal lines
Rhythmic position-attached lines are placed above the staff by default. Their endpoints 
start to the left and end to the right of notes, chords, or rests at the corresponding 
rhythmic positions.

Vertical lines
Vertical lines are positioned to the left of the notes to which they apply, including 
any applicable accidentals, but are positioned between grace notes and normal notes. 
If multiple vertical lines exist at the same rhythmic position, the most recent line is 
positioned furthest to the right, that is, directly to the left of notes, chords or rests.

You can change the position/placement of lines in a variety of ways, such as showing vertical 
lines on the right of notes or changing the placement of horizontal lines to show them inside the 
staff.

RELATED LINKS
Changing the horizontal order of vertical lines on page 827
Showing vertical lines before grace notes on page 828
Changing the placement of horizontal lines on page 828

Lines
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Showing vertical lines on the right/left of notes
You can change the side of notes on which vertical lines appear, for example, to show selected 
vertical lines on the right side of notes.

PROCEDURE

1. Select the vertical lines whose horizontal position you want to change.

2. In the Properties panel, activate Side in the Vertical Lines group.

3. Choose one of the following options:

● Left

● Right

RESULT
The selected lines appear on the corresponding side of notes.

EXAMPLE

Vertical line on the left of notes Vertical line on the right of notes

AFTER COMPLETING THIS TASK
You can change the order of vertical lines when multiple vertical lines exist at the same rhythmic 
position and on the same side of notes.

Changing the horizontal order of vertical lines
You can change the horizontal order of vertical lines when multiple vertical lines exist at the 
same rhythmic position and on the same side of notes.

PROCEDURE

1. Select the vertical lines whose order you want to change.

2. In the Properties panel, activate Column in the Vertical Lines group.

3. Change the value in the value field.

RESULT
The order of the selected vertical lines relative to any other vertical lines at the same rhythmic 
positions is changed. Lines with higher Column values are placed further to the left, while lines 
with lower values are placed further to the right.

Lines
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Showing vertical lines before grace notes
You can position individual vertical lines so they appear to the left of grace notes. By default, 
vertical lines are positioned after grace notes, that is, between grace notes and normal notes.

PROCEDURE

1. Select the vertical lines you want to show before grace notes.

2. In the Properties panel, activate Line before grace notes in the Vertical Lines group.

RESULT
The selected vertical lines are positioned before grace notes.

Deactivating Line before grace notes shows the selected vertical lines after grace notes again.

EXAMPLE

Vertical line after grace notes Vertical line before grace notes

Changing the placement of horizontal lines
You can show individual horizontal lines above, below, or inside the staff. By default, horizontal 
lines are placed above the staff.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines.

PROCEDURE

1. Select the horizontal lines whose placement you want to change.

2. In the Properties panel, activate Placement in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Below

● Inside staff

RESULT
The placement of the selected horizontal lines is changed. Horizontal lines inside the staff are 
centered on the middle staff line by default.

Lines
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TIP

You can also cycle through the different placement options for selected horizontal lines by 
pressing F .

AFTER COMPLETING THIS TASK

● You can change the staff position of lines shown inside the staff.

● You can erase the background of text on lines shown inside the staff.

RELATED LINKS
Changing the staff-relative placement of items on page 343

Changing the staff position of horizontal lines inside the staff
You can change the staff position of horizontal lines shown inside the staff, including changing 
the staff position of the start/end of lines independently of each other, for example, if you want 
lines to appear angled.

PREREQUISITE
The horizontal lines whose staff position you want to change are placed inside the staff and have 
at least one barline-/rhythmic position-attached end.

PROCEDURE

1. Select the horizontal lines placed inside the staff whose staff position you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Horizontal Lines group:

● Start position

● End position

3. Change the values in the value fields.

RESULT
The staff positions of the corresponding ends of the selected lines are changed according to the 
new values. For example, 0 is the middle line of the staff, 4 is the top line of the staff, and -4 is the 
bottom line of the staff.

EXAMPLE

Horizontal lines inside the staff with different staff positions at their start/end

Lines
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Moving horizontal lines rhythmically
You can move barline-/rhythmic position-attached horizontal lines to new rhythmic positions 
after they have been input.

NOTE

● You cannot move notehead-attached starts/ends of horizontal lines rhythmically, except by 
moving the notes to which they are attached.

● Although you can use these key commands for vertical lines, you cannot move vertical lines 
over rests, you can only move them to adjacent notes/chords in the same voice. If you want 
to move vertical lines along a phrase containing rests, we recommend deleting them and 
inputting new vertical lines at the new positions instead.

PROCEDURE

1. In Write mode, select the lines you want to move.

NOTE

When using the mouse, you can only move one horizontal line rhythmically at a time.

2. Move the lines in any of the following ways:

● To move a single horizontal line to the next notehead on the staff, press Alt/Opt-
Right Arrow .

● To move a single horizontal line to the previous notehead on the staff, press Alt/Opt-
Left Arrow .

● To move them to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move them to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple horizontal lines are selected, you can only move them according to the 
current rhythmic grid resolution.

● Click and drag the line to the right/left to the notehead you want.

NOTE

You cannot move vertical lines rhythmically with the mouse.

RESULT
The selected lines are moved to new rhythmic positions.

NOTE

If a single horizontal line passes over another line as part of its move, the existing one is 
unaffected as multiple lines can exist at the same rhythmic position. However, if you move 
multiple horizontal lines together or a single vertical line, any existing lines of the same type that 
they pass over are shortened or deleted accordingly.

Lines
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You can undo this action, but any lines shortened/deleted in the process are only restored if you 
moved lines using the keyboard.

Length of lines
Dorico SE automatically calculates the appropriate length for both horizontal and vertical lines.

● The length of horizontal lines is determined by the rhythmic duration of the line. Horizontal 
lines with different attachment types are positioned differently, which can affect their 
graphical length. For example, barline-attached lines can appear longer than rhythmic 
position-attached lines with the same duration.

● The length of vertical lines is determined by the pitch range of notes in the voices/staves 
to which the line applies. Dorico SE automatically adjusts the length of vertical lines if the 
pitches of notes in the voices/staves to which the lines apply change, or you add notes to, or 
delete notes from, chords.

You can lengthen/shorten both horizontal and vertical lines, for example, if you want an 
individual vertical line to extend above the top note in a chord.

Lengthening/Shortening horizontal lines
You can lengthen/shorten horizontal lines rhythmically after they have been input.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines. You cannot 
lengthen/shorten notehead-attached horizontal lines, except by lengthening/shortening the 
notes to which they are attached.

PROCEDURE

1. In Write mode, select the horizontal lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one line at a time.

2. Lengthen/Shorten the lines in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To snap the end of a single line to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To snap the end of a single line to the previous notehead, press Ctrl/Cmd-Shift-Alt/
Opt-Left Arrow .

NOTE

● When multiple lines are selected, you can only lengthen/shorten them according to 
the current rhythmic grid resolution.

Lines
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● When using the keyboard, lengthening/shortening lines only moves their end. You 
can move the start of lines by moving lines rhythmically, or by clicking and dragging 
the start handle of a single line.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single lines are lengthened/shortened according to the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer.

Multiple lines are lengthened/shortened according to the current rhythmic grid resolution.

RELATED LINKS
Inputting horizontal lines on page 305
Moving horizontal lines rhythmically on page 830

Lengthening/Shortening vertical lines
You can lengthen/shorten individual vertical lines to different staff positions. You can do this for 
the current layout and frame chain only or for all layouts and frame chains. By default, vertical 
lines span the range of all notes in the same voice at the same rhythmic position.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the vertical lines you want to lengthen/shorten.

2. In the Properties panel, activate the following properties, individually or together, in the 
Vertical Lines group:

● Top position

● Bottom position

3. Change the values in the value fields.

RESULT
The vertical length of the selected lines is changed. Increasing the values moves the 
corresponding end up by staff positions, decreasing the values moves the corresponding end 
down by staff positions. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

RELATED LINKS
Inputting vertical lines on page 306
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the start/end positions of horizontal lines
By default, rhythmic position-attached horizontal lines start before notes/accidentals and end 
immediately after the last note, chord, or rest at their end rhythmic position. You can change the 
start and end positions of individual rhythmic position-attached horizontal lines independently, 
for example, if you want them to start before noteheads rather than accidentals and end 
immediately before the following note, chord, or rest.

Lines
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NOTE

These steps only apply to rhythmic position-attached horizontal lines.

PROCEDURE

1. Select the rhythmic position-attached horizontal lines whose start and/or end position you 
want to change.

2. In the Properties panel, activate Horizontal start position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Notehead

● Notehead center

● Accidental

4. Activate Horizontal end position in the Horizontal Lines group.

5. Select one of the following options from the menu:

● End at right-hand side of final note

● End on center of final note

● End immediately before following note

RESULT
The start and/or end position of the selected rhythmic position-attached horizontal lines is 
changed.

EXAMPLE

Horizontal line starting before the 
notehead

Horizontal line starting centered 
on the notehead

Horizontal line starting before the 
accidental

Horizontal line ending after final 
note

Horizontal line ending centered on 
the final notehead

Horizontal line ending before 
following note

Changing the body style of lines
You can change the body style of individual lines without changing their caps.

PROCEDURE

1. Select the lines whose body style you want to change.

Lines
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NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Line body style in either the Horizontal Lines or Vertical 
Lines group.

3. Select the style you want from the menu.

RESULT
The body style of the selected lines is changed.

NOTE

This does not affect the caps of the selected lines.

RELATED LINKS
Line components on page 825
Lines panel on page 305

Changing the caps of lines
You can change the caps of individual lines without changing their body style.

PROCEDURE

1. Select the lines whose caps you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate the following properties, individually or together, in either 
the Horizontal Lines or Vertical Lines group:

● To change the cap at the start/bottom of the selected lines, activate Start cap.

● To change the cap at the end/top of the selected lines, activate End cap.

● To change the segment start cap of the selected horizontal lines on subsequent systems, 
activate Continuation cap.

● To change the segment end cap of the selected horizontal lines on previous systems to 
where the lines end, activate Continuation end cap.

3. Select the style you want from each menu.

RESULT
The corresponding caps of the selected lines are changed.

NOTE

This does not affect the body style of the selected lines.

Lines
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Changing the direction of lines
You can change the direction of both horizontal and vertical lines, for example, to make a 
horizontal line with an arrow end cap point to the left, or to make a vertical line with text appear 
upside-down with its text reading downwards.

PROCEDURE

1. Select the lines whose direction you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Reverse in either the Horizontal Lines or Vertical Lines 
group.

RESULT
The direction of the selected lines is change. Text on vertical lines now reads downwards.

Deactivating Reverse returns the selected lines to their default direction.

EXAMPLE

Horizontal and vertical lines with default directions Reversed horizontal and vertical lines

Adding text to lines
You can add text to both horizontal and vertical lines, for example, to clarify the intention of the 
line.

PROCEDURE

1. Select the lines to which you want to add text.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text in either the Horizontal Lines or Vertical Lines group.

3. Enter the text you want into the value field.

4. Press Return .

Lines
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RESULT
The text you entered into the value field is shown centered in the middle of the selected lines. On 
vertical lines, it reads upwards.

EXAMPLE

Text on a horizontal line

Text on a vertical line

AFTER COMPLETING THIS TASK

● If you want text on vertical lines to read downwards, you can reverse the lines.

● You can erase the backgrounds of text on lines.

RELATED LINKS
Line components on page 825
Input methods for lines on page 304

Changing the position of text relative to horizontal lines
You can change the position of text relative to horizontal lines individually, for example, to show 
text above horizontal lines. By default, text is centered on horizontal lines.

PROCEDURE

1. Select the horizontal lines whose text position you want to change.

2. In the Properties panel, activate Text position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Centered

● Below

● Inside

● Outside

RESULT
The position of text relative to the selected horizontal lines is changed. When annotations are 
positioned Inside or Outside, their position relative to the line changes according to the staff-
relative placement of the line.

Lines
Adding text to lines 
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EXAMPLE

Text Above Text Centered Text Below

RELATED LINKS
Changing the placement of text relative to lines on page 838

Changing the position of text relative to vertical lines
You can change the position of text relative to vertical lines individually, for example, to show text 
on the left of vertical lines. By default, text is centered on vertical lines.

PROCEDURE

1. Select the vertical lines whose text position you want to change.

2. In the Properties panel, activate Text position in the Vertical Lines group.

3. Select one of the following options from the menu:

● Left

● Centered

● Right

RESULT
The position of text relative to the selected vertical lines is changed.

EXAMPLE

Text Left Text Centered Text Right

Lines
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Changing the placement of text relative to lines
You can change the placement of text relative to lines individually, for example, to show text at 
the start of horizontal lines or the top of vertical lines. By default, text appears in the center of 
lines.

PROCEDURE

1. Select the lines whose text placement you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text placement in either the Horizontal Lines or Vertical 
Lines group.

3. Select one of the following options from the menu:

● Start

● Center

● End

4. Optional: If you chose Start or End and want to change the offset from the corresponding 
end of the line, activate Start/end gap in either the Horizontal Lines or Vertical Lines 
group and change the value in the value field.

RESULT
The placement of text relative to the selected lines is changed. For vertical lines, Start places text 
at the bottom of the line, End places text at the top.

If you also activated Start/end gap, the gap between text on the selected lines and the 
corresponding end is changed.

RELATED LINKS
Changing the direction of lines on page 835

Forcing line text to be horizontal
You can force the text of individual lines always to appear horizontal, for example, to make text 
on vertical lines easier to read.

PROCEDURE

1. Select the lines whose text you want to keep horizontal.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Keep text horizontal in either the Horizontal Lines or 
Vertical Lines group.

RESULT
Text on the selected lines always appears horizontal, even if the line is angled or vertical.

Lines
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Rehearsal marks

Rehearsal marks are an ordered sequence of letters or numbers, which along with bar numbers, 
provide a reference point for music that has multiple players, and make the chronological 
sequence of the music clear.

They tell performers where they are in the piece, and allow performers to orient and co-ordinate 
themselves easily in rehearsals and concerts. Rehearsal marks can also be used to indicate 
significant changes in the music, and you can freely decide their positions.

In Dorico SE, rehearsal marks follow an automatic sequence where each rehearsal mark has a 
unique index, ensuring there are never duplicate rehearsal marks.

A rehearsal mark, showing the letter G

By default, rehearsal marks in Dorico SE appear as letters, but you can change the sequence 
type to show letters, numbers, or bar numbers. You can use all three available rehearsal mark 
sequences simultaneously.

In order to ensure they are easily noticeable, and cannot be confused with bar numbers when 
using numbers for rehearsal marks, rehearsal marks are shown in a rectangular enclosure.

In Dorico SE, rehearsal marks are categorized as system objects. Therefore, rehearsal marks 
follow your per-layout settings for the visibility and positioning of system objects, which you can 
change on the Staves and Systems page in Setup > Layout Options.

RELATED LINKS
Inputting rehearsal marks on page 317
Changing the index of rehearsal marks on page 841
Changing the rehearsal mark sequence type on page 842
System objects on page 913
Changing the positions of system objects on page 913
Tempo marks on page 926

Positions of rehearsal marks
Rehearsal marks are placed outside the music, above the staff, and at the same positions as 
other system objects so they can be seen easily.

By default, rehearsal marks are positioned above barlines and to the right of clefs or key 
signatures at the start of systems. Although you can input rehearsal marks at rhythmic positions 
within a bar in Dorico SE, this is not common practice.
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When rehearsal marks coincide with tempo changes, Dorico SE automatically positions tempo 
marks to the right of rehearsal marks. Dorico SE automatically adjusts staff spacing to ensure 
rehearsal marks are correctly positioned.

You can move rehearsal marks to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

The vertical spacing between the top two staves is increased to allow room for the rehearsal mark and the 
tempo marks.

Rehearsal marks are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently, for example, if you want rehearsal marks to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Inputting rehearsal marks on page 317
Input methods for bars, beats, and barlines on page 235
Changing the positions of system objects on page 913

Moving rehearsal marks rhythmically
You can move rehearsal marks to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the rehearsal marks you want to move.

NOTE

When using the mouse, you can only move one rehearsal mark rhythmically at a time, and 
you can only drag it to existing barlines.

2. Move the rehearsal marks in any of the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the rehearsal mark to barlines to the right/left.

RESULT
A single rehearsal mark is moved to existing barlines to the right/left.

Multiple rehearsal marks are moved according to the current rhythmic grid resolution.

Rehearsal marks
Positions of rehearsal marks 
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NOTE

Only one rehearsal mark can exist at each rhythmic position. If a rehearsal mark passes over 
another rehearsal mark as part of its move, the existing rehearsal mark is deleted and replaced 
by the rehearsal mark being moved.

You can undo this action, but any rehearsal marks deleted in the process are only restored if you 
moved the rehearsal mark using the keyboard.

Deleting rehearsal marks
You can delete rehearsal marks. Deleting a rehearsal mark in any layout deletes the rehearsal 
mark from all layouts.

PROCEDURE

1. In Write mode, select the rehearsal marks you want to delete.

2. Press Backspace or Delete .

RESULT
The selected rehearsal marks are deleted. Any subsequent rehearsal marks are adjusted until the 
next change in the sequence or the end of the flow. For example, if you delete the first rehearsal 
mark, the second rehearsal mark shows either the letter A, the number 1, or the bar number, 
depending on your choice of sequence type.

Changing the index of rehearsal marks
By default, the rehearsal mark sequence resets at the start of each flow. If you want the 
rehearsal mark sequence to continue across flows, for example, to avoid having multiple 
rehearsal marks with the same letter in the same project, you can change the index position 
of individual rehearsal marks.

Changing the index position changes the shown number or letter. For example, index position 1 
appears as rehearsal mark A or 1, position 2 appears as B or 2, and so on.

You can also change the index position of a rehearsal mark to avoid showing a letter that could 
easily be confused with another letter or another number, such as I or O.

PROCEDURE

1. Select the rehearsal mark whose index position you want to change.

2. In the Properties panel, activate Index in the Rehearsal Marks group.

3. Change the value in the value field.

RESULT
The selected rehearsal mark changes according to the Index value and its sequence type.

Any subsequent rehearsal marks without index changes in the same sequence follow the new 
index automatically. For example, if you changed a rehearsal mark from A to P, the next 
rehearsal mark changes from B to Q.

Rehearsal marks
Deleting rehearsal marks 
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TIP

You can also change the sequence type of rehearsal marks, for example, if you want rehearsal 
mark C to appear as rehearsal mark 3.

Changing the rehearsal mark sequence type
Rehearsal marks can be letters, numbers, or bar numbers. You can change the sequence type of 
individual rehearsal marks, and create secondary rehearsal mark sequences.

In Dorico SE, you can use all three available rehearsal mark sequences simultaneously. For 
example, you can have the main sequence of rehearsal marks showing letters, but also have a 
secondary sequence of numbers to mark different moments, perhaps entry points for a solo line, 
and also highlight prominent bar numbers within those sections.

PROCEDURE

1. Select the rehearsal mark whose sequence type you want to change.

2. In the Properties panel, activate Sequence type in the Rehearsal Marks group.

3. Select one of the following options from the menu:

● Letters

● Numbers

● Bar numbers

RESULT
The selected rehearsal mark now displays a letter, a number, or the current bar number.

If it is the first rehearsal mark in either the letters sequence or the numbers sequence in the flow, 
it shows either A or 1. If there are already rehearsal marks in either the letters sequence or the 
numbers sequence in the flow, it shows the next letter or number according to the index.

NOTE

You can change the index of a rehearsal mark sequence independently of other rehearsal mark 
sequences. However, you cannot change the bar number sequence using this method.

RELATED LINKS
Inputting rehearsal marks on page 317
Adding bar number changes on page 571

Adding prefixes/suffixes to rehearsal marks
You can add both prefixes and suffixes to individual rehearsal marks.

PROCEDURE

1. Select the rehearsal marks to which you want to add a prefix or suffix.

2. In the Properties panel, activate one of the following properties in the Rehearsal Marks 
group:

● Prefix

● Suffix

Rehearsal marks
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3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered into the value field is added to the selected rehearsal marks as a prefix or a 
suffix.

Rehearsal marks
Adding prefixes/suffixes to rehearsal marks 
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Markers

Markers are labels locked to a particular position in time, most commonly in relation to a video. 
They typically indicate an important moment that requires musical prominence, and composers 
often use them to help shape the writing process.

Markers on a timecode staff showing custom text and timecodes

By default, markers in Dorico SE show the default text “Marker” and also include the timecode of 
their fixed position in time.

In Dorico SE, you can use markers in any project. However, because they are most commonly 
used in conjunction with video, markers are included in the Video panel in Write mode. There is 
also a Markers track in Play mode that displays markers, and allows you to input new ones.

You can use markers to help find suitable tempos for your project, as Dorico SE can calculate 
possible tempos between important markers so that the markers occur on strong beats in the 
time signature.

You can show markers above/below the start of each system or below the timecode staff, if there 
is one, in each layout independently.

Any markers you input are automatically included when you export MIDI.

RELATED LINKS
Inputting markers/timecodes on page 318
Editing marker text on page 846
Markers section of the Video panel on page 319
Defining markers as important on page 847
Timecodes on page 849
Markers track on page 454

Hiding/Showing markers
By default, markers are shown in full score layouts and hidden in part layouts. You can hide 
and show markers in each layout independently, for example, if markers are helpful for the 
conductor to see but not for the players.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show markers.
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Markers and Timecode in the category list.

4. Activate/Deactivate Show markers.

5. Click Apply, then Close.

RESULT
Markers are hidden/shown in the selected layouts.

Changing the vertical position of markers
You can show markers above the system, below the system, or on a separate single-line 
timecode staff above a selected bracketed instrument family group, which can make them 
clearer in the score. When markers are shown on a timecode staff, timecodes are also 
automatically shown below the timecode staff.

NOTE

You cannot show multiple timecode staves in a system.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
markers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Markers and Timecode in the category list.

4. In the Markers subsection, choose one of the following options for Vertical position:

● Above system

● Below system

● Timecode staff

5. Optional: If you chose Timecode staff, select the bracketed instrument family above which 
you want to show the timecode staff from the Position timecode staff above bracket 
menu.

6. Click Apply, then Close.

RESULT
The vertical position of markers is changed in the selected layouts.

NOTE

● If you show markers on a timecode staff, timecodes are also shown on the staff by default. 
If you only want to show markers on a separate staff and exclude timecodes, you must then 
change Timecode frequency on timecode staff to Never.

You can also change the vertical position of timecodes so they appear above/below the start 
of systems rather than on the timecode staff.

Markers
Changing the vertical position of markers 
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● You can change the default distance between the timecode staff and other staves on the 
Vertical Spacing page in Setup > Layout Options.

AFTER COMPLETING THIS TASK
You can change the frequency of timecodes on the timecode staff.

RELATED LINKS
Changing the vertical position of timecodes on page 850
Changing the timecode frequency on page 851

Editing marker text
The default text shown in new markers is “Marker”. You can change the text shown in each 
marker individually.

PROCEDURE

1. Select the markers whose text you want to change.

2. In the Properties panel, activate Marker text in the Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected markers is changed. It uses the Marker Text Font font style.

TIP

You can also enter custom text for markers when inputting them using the Add Marker dialog, 
and change marker text in the Markers section of the Video panel in Write mode.

RELATED LINKS
Add Marker dialog on page 318

Changing the timecodes of markers
You can change the timecode of markers, for example, if the video is edited and the marker now 
occurs ten seconds later.

NOTE

Because this changes where markers occur in the project, this also moves markers relative to the 
notated music.

PROCEDURE

1. In Write mode, click Video in the Notations toolbox to show the Video panel.

2. In the Markers section, double-click the timecode you want to change.

3. Enter the new timecode you want into the value field.

4. Press Return .

Markers
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RESULT
The timecode of the marker is changed. The marker automatically moves relative to the music to 
reflect its new time position.

RELATED LINKS
Markers section of the Video panel on page 319

Moving markers rhythmically
You can move markers to new rhythmic positions. However, as markers have a fixed position in 
time, moving markers relative to the notated music automatically changes the tempo on either 
side of the marker.

TIP

If you want to move a marker to a new time position, for example, if you want to move it from 25 
seconds to 28 seconds, you must change the timecode of the marker.

PROCEDURE

1. In Write mode, select the marker you want to move.

NOTE

You can only move one marker at a time.

2. Move the marker according to the current rhythmic grid resolution in any of the following 
ways:

● Press Alt/Opt-Right Arrow  to move it to the right.

● Press Alt/Opt-Left Arrow  to move it to the left.

● Click and drag it to the right/left.

RESULT
The selected marker is moved to a new rhythmic position. However, its fixed position in time is 
not changed. Therefore, the tempo immediately preceding the marker automatically updates so 
that the marker occurs at the correct time. For example, moving a marker to the right increases 
the preceding tempo.

Any gradual tempo changes between the preceding tempo change or the start of the flow and 
the marker are removed.

NOTE

The tempo change affects the positions of all other markers in the flow relative to the notated 
music.

Defining markers as important
You can define individual markers as important, which allows them to be considered when 
finding suitable tempos in the Find Tempo dialog.

PROCEDURE

1. In Write mode, click Video in the Notations toolbox to show the Video panel.

Markers
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2. In the Markers section, activate the checkbox in the Imp. column for each marker you want 
to define as important.

RESULT
Markers with activated checkboxes are defined as important. The Find Tempo button at the 
bottom of the Markers section becomes available.

RELATED LINKS
Find Tempo dialog on page 320

Markers
Defining markers as important 
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Timecodes

Timecodes indicate an exact position in time, usually in the context of a video. They allow precise 
synchronization between multiple elements, such as music and moving images, and can be used 
as a reference tool.

Timecodes are displayed in the format hh:mm:ss:ff, which is two-digit hours, minutes, seconds, 
and frames.

A timecode on a timecode staff

In Dorico SE, you can specify the type of timecode from the following types:

Non-drop frame timecodes
Each frame is numbered sequentially from the preceding one without skipping any 
frame numbers.

Non-drop frame timecodes are shown with the suffix fps and use a colon separator 
between seconds and frames, for example, 00:00:01:05.

Drop frame timecodes
Some frame numbers are skipped in order to accommodate the difference in frame 
rate between 29.97 fps and 30 fps. In every minute except every tenth minute, two 
timecode numbers are dropped from the frame count.

Drop frame timecodes are shown with the suffix dfps and use a semicolon separator 
between the seconds and frames, for example, 00:00:01;05.

Timecodes in Dorico SE are flow-specific, meaning you can set timecodes for each flow that are 
completely independent of the timecodes for other flows. You can set timecodes in the Video 
Properties dialog, including for flows without a video.

NOTE

The timecodes shown in flow cards in the Flows panel in Setup mode reflect the timecode at the 
start of the flow, which can be different to the timecode you set in the Video Properties dialog. 
For example, if you set the Timecode start to 02:00:00:00 but also set the Flow attachment 
position to 8 quarter note beats, and the tempo is 60 bpm, the timecode shown in the flow card 
is 01:59:52:00.

By default, timecodes appear in markers. You can show markers above/below the start of each 
system or below the timecode staff, if there is one, in each layout independently.

Additionally, you can change the time displayed in the Transport window to be the timecode 
rather than elapsed time, which is shown by default.
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RELATED LINKS
Frame rates on page 141
Video Properties dialog on page 137
Changing the timecode frequency on page 851
Changing the content shown in the transport display on page 473
Markers on page 844
Hiding/Showing markers on page 844
Changing the vertical position of markers on page 845
Changing the vertical position of timecodes on page 850

Changing the initial timecode value
You can change the timecode at which each flow in your project starts, for example, if you are 
using a separate project for the second reel of a film. You can also change the initial timecode in 
projects without videos.

PROCEDURE

1. In Write mode, select an item in the flow whose initial timecode value you want to change.

2. In the Notations toolbox, click Video  to show the Video panel.

3. In the Video panel, click Properties to open the Video Properties dialog.

4. Change the value for Timecode start.

5. Click OK to save your changes and close the dialog.

RESULT
The initial timecode for the flow in which you selected an item is changed.

RELATED LINKS
Timecodes on page 849
Changing the start position of videos on page 139

Changing the vertical position of timecodes
You can show timecodes either above/below the start of systems or on a separate single-line 
staff, for example, if you might want to show timecodes above the start of systems in part 
layouts without showing markers or a separate timecode staff.

NOTE

You cannot show timecodes on multiple staves in a system.

PREREQUISITE
If you want to show timecodes on a separate staff, you have changed the vertical position of 
markers so they appear on a separate staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
timecodes.

Timecodes
Changing the initial timecode value 
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Markers and Timecode in the category list.

4. In the Timecode subsection, choose one of the following options for Show timecode:

● Above or below start of system

● Below timecode staff

5. If you chose Above or below start of system, choose one of the following options for 
Timecode position relative to system:

● Above system

● Below system

6. Optional: If you chose Above or below start of system, change the gap between timecodes 
and the staff by changing the values in the Offset at start of system value fields.

7. Click Apply, then Close.

RESULT
The vertical position of timecodes is changed in the selected layouts.

NOTE

Your setting for Timecode frequency on timecode staff also applies when timecodes are shown 
above/below the start of systems.

RELATED LINKS
Changing the vertical position of markers on page 845
Changing the timecode frequency on page 851

Changing the timecode frequency
You can show timecodes at different intervals in layouts in which timecodes are shown on a 
separate staff. For example, you can show timecodes every bar in full score layouts but only at 
the start of each system in part layouts.

NOTE

We do not recommend that you show timecodes every bar in layouts with multi-bar rests, as 
the result is illegible overlapping timecodes. If you want to show timecodes in part layouts with 
multi-bar rests, we recommend either showing timecodes only at the start of each system or not 
showing multi-bar rests in the layout.

PREREQUISITE
Markers are shown in the selected layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the timecode frequency.

Timecodes
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Markers and Timecode in the category list.

4. Optional: If the selected layouts do not show timecodes on a separate staff, choose 
Timecode staff for Vertical position.

5. Choose one of the following options for Timecode frequency on timecode staff:

● Start of system

● Every bar

● Never

6. Click Apply, then Close.

RELATED LINKS
Hiding/Showing markers on page 844
Hiding/Showing multi-bar rests on page 885

Timecodes
Changing the timecode frequency 
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Repeat endings

For music with repeated passages, repeat endings show which bars are played at the end of each 
repetition, with different endings each time if required. They are also known as “volta lines”, or as 
“first and second endings”, but in this documentation, we refer to them as “repeat endings”.

Repeat endings comprise two or more segments, where each segment contains a different 
possible ending. When you input repeat endings, Dorico SE automatically inputs an end repeat 
barline at the end of the first segment. Segments in repeat endings are clearly marked with solid 
lines above and number that indicate the playthroughs in which the segment is used.

A repeat ending with three playthroughs divided across two endings

Dorico SE allows you to create repeat endings containing any number of segments. However, 
you cannot change how playthroughs are divided across repeat ending segments.

In Dorico SE, repeat endings are categorized as system objects. Therefore, repeat endings follow 
your per-layout settings for the visibility and positioning of system objects, which you can change 
on the Staves and Systems page in Setup > Layout Options.

RELATED LINKS
Input methods for repeats and tremolos on page 321
System objects on page 913
Changing the positions of system objects on page 913
Repeats in playback on page 464
Types of barlines on page 558
Lines on page 823

Changing the total number of playthroughs in repeat 
endings

By default, each segment in repeat endings is played once, so each segment shows a single 
digit that indicates the playthrough for which it is used. You can increase the total number of 
playthroughs for repeat endings individually so that segments are played more than once.

PROCEDURE

1. Select the repeat endings whose total number of playthroughs you want to change.

2. In the Properties panel, activate No. times played in the Repeat Endings group.

3. Change the value in the value field.
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NOTE

You cannot have fewer playthroughs than the number of segments.

RESULT
The total number of playthroughs in the selected repeat endings is changed. Dorico SE adds 
additional playthroughs to the last closed segment in the repeat ending.

NOTE

You cannot change how playthroughs are divided across repeat ending segments in Dorico SE.

RELATED LINKS
Repeats in playback on page 464

Lengthening/Shortening segments in repeat endings
You can increase/decrease the number of bars included in each segment of repeat endings by 
lengthening/shortening each segment independently.

PROCEDURE

1. In Write mode, select the repeat ending you want to lengthen/shorten.

NOTE

You can only lengthen/shorten one repeat ending segment at a time.

2. Select the circular handle at the end of the segment you want to lengthen/shorten.

The selected handle in the middle has a thicker line.

3. Click and drag the handle to the right/left to snap it to the next/previous barline.

NOTE

Segments must contain at least one bar.

4. Optional: Repeat steps 1 to 3 for each segment in the repeat ending.

RESULT
The selected segment is lengthened/shortened.

NOTE

● This does not automatically input or reposition repeat barlines. You must input repeat 
barlines as appropriate manually.

● You can also lengthen/shorten the final segment in a single repeat ending by selecting the 
repeat ending and using the following key commands:

● Press Shift-Alt/Opt-Right Arrow  to lengthen the final segment.

Repeat endings
Lengthening/Shortening segments in repeat endings 
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● Press Shift-Alt/Opt-Left Arrow  to shorten the final segment.

Positions of repeat endings
Repeat endings are placed above the staff at the same positions as other system objects, and 
their hooks align with barlines. They are commonly positioned outside of other notations, but 
some long items, such as gradual tempo changes, can be placed above repeat endings.

You can move repeat endings to different rhythmic positions in Write mode.

Repeat endings are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently, for example, if you want repeat endings to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
System objects on page 913
Changing the positions of system objects on page 913

Moving repeat endings rhythmically
You can move repeat endings to different rhythmic positions after they have been input so they 
apply to different bars.

PROCEDURE

1. In Write mode, select the repeat ending you want to move.

NOTE

You can only move one repeat ending rhythmically at a time.

2. Move the repeat ending to the next/previous bar in any of the following ways:

● Press Alt/Opt-Right Arrow  to move it to the right.

● Press Alt/Opt-Left Arrow  to move it to the left.

● Click and drag it to the right/left.

RESULT
The selected repeat ending is moved to the next/previous bar.

NOTE

● This does not automatically input or reposition repeat barlines. You must input repeat 
barlines manually as appropriate.

● Only one repeat ending can exist at each rhythmic position. If any part of a selected repeat 
ending collides with any part of another repeat ending as part of its move, the other repeat 
ending is deleted. However, its repeat barlines are not deleted.

You can undo this action, but any repeat endings deleted in the process are only restored if 
you moved the repeat ending using the keyboard.

Repeat endings
Positions of repeat endings 
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Changing the appearance of individual final repeat ending 
segments

You can change the appearance of the line ends in the final segments of individual repeat 
endings.

PROCEDURE

1. Select the repeat endings whose final segment appearance you want to change.

2. In the Properties panel, activate End of line in the Repeat Endings group.

3. Select one of the following options from the menu:

● Open, short

● Open, full length

● Closed

RESULT
The end of the line of the final segment in the selected repeat endings is changed.

Repeat endings in MusicXML files
All aspects of repeat endings can be imported from and exported in MusicXML files.

However, while MusicXML can represent this, segments in the middle of sets of endings cannot 
have an open right-hand end in Dorico SE.

Repeat endings
Changing the appearance of individual final repeat ending segments 
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Repeat markers

Repeat markers show that musical material is to be repeated, but unlike repeat endings, repeat 
markers often involve jumping to different positions and sections in the music instead of moving 
through the music consecutively.

In Dorico SE, repeat markers are divided into the following types:

Repeat jumps
Specify the position from which players or playback must jump, such as D.C. al Coda. 
You can qualify the conditions under which repeat jumps are used, such as “second 
time only”.

Repeat jumps are right-aligned with their rhythmic position, meaning their text or 
symbol ends at that rhythmic position and extends to the left.

Repeat sections
Specify the destinations for jumps, such as segno or coda, or where the music should 
end, such as Fine. In Dorico SE, coda sections that start mid-system are automatically 
separated from the preceding music with a gap.

Repeat markers are left-aligned with their rhythmic position, meaning their text or 
symbol starts at that rhythmic position and extends to the right.

By default, repeat markers are shown on a single line.

RELATED LINKS
Input methods for repeats and tremolos on page 321
Repeats in playback on page 464
Types of barlines on page 558
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Changing the index for repeat markers
You can change the index of individual repeat markers, for example, if a flow requires two 
different codas with different symbols so players can tell them apart.

By default, all repeat markers of the same type have the same appearance, even when there are 
multiple repeat markers in the flow.

NOTE

You cannot change the index of Fine or D.C. repeat markers.

PROCEDURE

1. Select the repeat marker whose index you want to change.

2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Repeat Markers section:

● Marker index

● ‘Jump to’ index

3. Change the values in the value fields.

NOTE

You can only enter values between 1 and 3.

RESULT
Marker index changes the order of the selected repeat marker relative to other repeat markers 
of the same type.

‘Jump to’ index changes the destination of the selected repeat marker.

EXAMPLE
If you have two codas in a flow with two different D.S. al Coda markers, you might set Marker 
index to 1 for the first coda and 2 for the second, then set ‘Jump to’ index to 1 for the first D.S. al 
Coda marker and 2 for the second.

D.S. al Coda marker with default indexes D.S. al Coda marker with both indexes set to 2

RELATED LINKS
Repeats in playback on page 464

Editing repeat marker text
You can change the text shown in individual repeat markers, for example, if you are typesetting a 
score with an unusual repeat marker instruction.

PROCEDURE

1. Select the repeat markers whose text you want to change.

Repeat markers
Changing the index for repeat markers 
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2. In the Properties panel, activate Custom text in the Repeat Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected repeat markers is changed. This replaces the text in the selected 
repeat markers without removing any symbols.

Positions of repeat markers
Repeat markers are placed above the staff by default, and at the same positions as other system 
objects. Coda sections are separated from the preceding music by a gap in the system.

You can move repeat markers to different rhythmic positions in Write mode.

You can change the default staff-relative placement of repeat markers in each layout 
independently in the Repeat Markers section of the Staves and Systems page in Setup > 
Layout Options.

Repeat markers are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently, for example, if you want repeat markers to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Changing the staff-relative placement of repeat markers on page 860
Changing the positions of system objects on page 913
Repeats in playback on page 464

Moving repeat markers rhythmically
You can move repeat markers to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the repeat markers you want to move.

NOTE

When using the mouse, you can only move one repeat marker rhythmically at a time.

2. Move the selected repeat markers according to the current rhythmic grid resolution in any of 
the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the repeat marker to the right/left.

RESULT
The selected repeat markers are moved to new rhythmic positions.

Repeat markers
Positions of repeat markers 
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Changing the staff-relative placement of repeat markers
You can show repeat markers either above, below, or both above and below the staff in each 
layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-placement of 
repeat markers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Repeat Markers section, choose one of the following options for Default placement 
for repeat jumps and ‘Fine’:

● Above staff

● Below staff

● Above and below bottom staff

5. Click Apply, then Close.

RESULT
The staff-relative placement of all repeat markers is changed in the selected layouts.

Repeat markers
Positions of repeat markers 
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Bar repeats

Bar repeats indicate that the musical material in preceding bars must be repeated exactly, but 
without notating that material again. Bar repeats can comprise groups of one, two, or four bars.

For example, a one-bar repeat indicates that the material in one bar is repeated, meaning every 
bar in the region repeats the same material. A four-bar repeat indicates that the material in the 
previous four bars is repeated.

One-bar repeat region Two-bar repeat region

Four-bar repeat region

This notation short-hand can make repetitive music easier to read, as performers must only read 
the repeated phrase once and then simply count how many times they repeat it. Bar repeats can 
also save horizontal space, as bar repeat symbols are usually narrower than the equivalent fully 
written-out bars.

In Dorico SE, bar repeat regions are used to display bar repeats, meaning as many bar repeat 
symbols as necessary to fill the region are shown automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, bar repeat regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide and show them.

You can also show adjacent bar repeat regions, for example, if you want to use a two-bar repeat 
in the first iteration of a phrase, and then a four-bar repeat to indicate the whole phrase is 
repeated. When two different bar repeat regions are adjacent, they alternate highlight colors to 
ensure the separate regions are always identifiable.

Phrase containing two adjacent bar repeat regions

RELATED LINKS
Inputting bar repeats on page 333
Repeats popover on page 322
Bar repeat counts on page 864
Bar repeat grouping on page 867
Hiding/Showing bar repeat region highlights on page 864
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Moving bar repeat regions on page 862
Lengthening/Shortening bar repeat regions on page 863
Hiding/Showing multi-bar rests on page 885
Types of barlines on page 558
Annotations on page 537

Changing the length of the repeated phrase in bar repeat 
regions

You can change the number of bars that make up the repeated phrase in individual bar repeats 
after you have input them, for example, if you want the region to repeat the previous two bars 
rather than the previous four bars.

NOTE

You cannot repeat more bars than exist before the bar repeat region. For example, if a bar 
repeat region follows the first notated bar in a flow, you cannot increase the number of bars in 
the repeated phrase.

PROCEDURE

1. Select the bar repeat regions whose phrase length you want to change.

2. In the Properties panel, select one of the following options from the No. bars menu in the 
Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

RESULT
The number of bars that make up the repeated phrase in the selected bar repeat regions is 
changed. This is also reflected in playback.

TIP

● Any dynamics you add within bar repeat regions affect the playback of the repeated music.

● You can also change the length of the repeated phrase by opening the repeats popover and 
changing the entry.

RELATED LINKS
Bar repeat grouping on page 867
Inputting bar repeats on page 333
Repeats popover on page 322
Changing existing items on page 342

Moving bar repeat regions
You can move bar repeat regions to different rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the bar repeat region you want to move.

Bar repeats
Changing the length of the repeated phrase in bar repeat regions 
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NOTE

You can only move one bar repeat region at a time.

2. Move the bar repeat region to other bars in any of the following ways:

● Press Alt/Opt-Right Arrow  to move it to the right.

● Press Alt/Opt-Left Arrow  to move it to the left.

● Click and drag it to the right/left.

RESULT
The selected bar repeat region is moved to bars to the right/left.

When you move bar repeat regions using the keyboard, they are moved to the right by the 
duration of their grouping, for example, two-bar repeats are moved two bars to the right. 
However, when you move them to the left, they are always moved to the next bar, regardless of 
their grouping.

When you move bar repeat regions using the mouse, they are always moved to the next/
previous bar.

NOTE

Only one bar repeat region can exist at each rhythmic position. If any part of a selected bar 
repeat region collides with any part of another bar repeat region as part of its move, the other 
bar repeat region is shortened to accommodate the one you moved. In some cases, this means 
the grouping of the other bar repeat region is changed or it is deleted entirely.

You can undo this action and restore the previous length of the other bar repeat region.

Lengthening/Shortening bar repeat regions
You can lengthen/shorten bar repeat regions after they have been input.

PROCEDURE

1. In Write mode, select the bar repeat region you want to lengthen/shorten.

NOTE

You can only lengthen/shorten one bar repeat region at a time.

2. Lengthen/Shorten the bar repeat region in any of the following ways:

● To lengthen it by the duration of its grouping, press Shift-Alt/Opt-Right Arrow .

● To shorten it by the duration of its grouping, press Shift-Alt/Opt-Left Arrow .

NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the start/end handle to the next/previous bar.

RESULT
The selected bar repeat region is lengthened/shortened.

Bar repeats
Lengthening/Shortening bar repeat regions 
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NOTE

● The minimum length of a bar repeat region is one bar. If you shorten regions with longer 
groupings, such as every four bars, the length of the region is halved until a one-bar repeat 
region remains.

● Only one bar repeat region can exist at each rhythmic position. If any part of a selected 
bar repeat region collides with any part of another bar repeat region when it is lengthened/
shortened, the other bar repeat region is shortened to accommodate this. In some cases, 
this means the grouping of the other bar repeat region is changed or it is deleted entirely.

You can undo this action and restore the previous lengths of all bar repeat regions involved.

RELATED LINKS
Bar repeats on page 861
Bar repeat grouping on page 867
Hiding/Showing multi-bar rests on page 885

Hiding/Showing bar repeat region highlights
You can hide/show colored highlights for bar repeat regions at any time, for example, if you want 
to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Bar Repeat Regions.

RESULT
Highlights on bar repeat regions are shown when a tick appears beside Highlight Bar Repeat 
Regions in the menu, and hidden when no tick appears.

Bar repeat counts
Bar repeat counts are numbers shown at regular intervals either above or below bar repeats, to 
help players keep track of how many bars have passed. The intervals are usually based on typical 
musical phrases, such as every four or eight bars.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

Because bar repeats must start with a fully notated phrase of at least one bar, the bar repeat 
count starts from the notated bar rather than the first bar in the bar repeat region. For example, 
the third bar in a bar repeat region shows the count number 4, as that bar is the fourth time the 
original notated bar is played. Each bar repeat region has its own separate count.

Bar repeat region with counts shown every four bars

In Dorico SE, you can change the start count of each bar repeat region, how frequently bar 
repeat counts are shown, and whether they are parenthesized.

Bar repeats
Hiding/Showing bar repeat region highlights 
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RELATED LINKS
Changing the bar repeat count appearance on page 866
Changing the bar repeat count frequency on page 865
Repeats popover on page 322
Inputting bar repeats on page 333
Hiding/Showing bar number ranges on multi-bar rests on page 565

Changing the start count of bar repeats
You can change the number from which individual bar repeats start, for example, if you want to 
notate the first bar in a repeated phrase at the start of each system but show a continuous count 
across multiple bar repeats.

NOTE

● The start count applies to the first bar in the bar repeat, which is the notated bar. For 
example, changing the start count of a one-bar repeat region lasting three bars to 5, with 
bar repeat counts shown every four bars, causes the count at the end of the bar repeat 
region to show the number 8.

● Bar repeat counts are only shown on one-bar repeat regions.

PROCEDURE

1. Select the one-bar repeat regions whose start count you want to change.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The number and position of bar repeat counts on the selected bar repeats is changed. For 
example, changing the start count from 1 to 2, with counts shown every four bars, causes the 
count to appear on the second bar in the bar repeat region instead of the third.

EXAMPLE

Separate bar repeats on multiple systems in the 
same part layout with the default count

Separate bar repeats on multiple systems in the 
same part layout with their counts changed to imply 
a continuous region

Changing the bar repeat count frequency
You can change how often counts are shown on individual one-bar repeat regions, for example, if 
you want to show the count after eight bars on a single bar repeat region.

Bar repeats
Bar repeat counts 
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NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PROCEDURE

1. Select the one-bar repeats whose count frequency you want to change.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected bar repeat regions.

RELATED LINKS
Bar repeat counts on page 864
Hiding/Showing bar number ranges on multi-bar rests on page 565

Changing the bar repeat count appearance
You can show individual bar repeat counts with or without parentheses, or not show any repeat 
count at all. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the one-bar repeats whose count appearance you want to change.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● Parenthesized

● No parentheses

● Don’t show

RESULT
The appearance of counts on the selected bar repeat regions is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the bar repeat count frequency on page 865
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Bar repeats
Bar repeat counts 
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Bar repeat grouping
Bar repeat grouping allows you to condense longer bar repeat regions, which can be helpful in 
very regular music as it can simplify the overall phrasing.

The symbols shown on the staff are different for the different groupings, and two-bar and 
four-bar repeats also show a number to indicate how many bars are included in the group.

One-bar repeat symbol Two-bar repeat symbol Three-bar repeat symbol Four-bar repeat symbol

You can specify the grouping when inputting bar repeats, and you can change the grouping 
of bar repeats after they have been input. Depending on where the bar repeat region starts 
and ends relative to the written material, Dorico SE automatically adjusts the displayed symbols 
to achieve an accurate result. For example, an eight-bar phrase containing a single notated 
bar followed by seven one-bar repeats grouped every four bars is automatically shown with a 
one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Eight-bar phrase with seven one-bar repeats grouped every four bars

RELATED LINKS
Repeats popover on page 322
Inputting bar repeats on page 333

Changing bar repeat grouping
You can change how bar repeats are grouped after they have been input, for example, if you 
want to group a region of one-bar repeats every two bars.

PROCEDURE

1. Select the bar repeat regions whose grouping you want to change.

2. In the Properties panel, select one of the following options from the Group every menu in 
the Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

NOTE

The options available depend on the minimum length of the selected bar repeat regions. For 
example, if you select bar repeat regions that last three bars, only One bar and Two bars are 
available in the menu.

Bar repeats
Bar repeat grouping 
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RESULT
The grouping in the selected bar repeat regions is changed. Dorico SE automatically calculates 
the clearest way to group the region. For example, an eight-bar phrase containing a single 
notated bar followed by seven one-bar repeats grouped every four bars is automatically shown 
with a one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Bar repeats
Bar repeat grouping 
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Rhythm slashes

Rhythm slashes are diagonal lines positioned on staves that are used to indicate that performers 
should play something, but without specifying the exact rhythms and pitches. They are often 
accompanied by chord symbols to indicate the set of notes the performer should use.

There are two different types of rhythm slashes:

Slashes with stems

Slashes with stems usually indicate the rhythm to be played, but not the pitches. Also 
known as “rhythmic notation”.

Slashes without stems

Slashes without stems do not usually indicate either rhythms or pitches. Also known as 
“slash notation”

In Dorico SE, you can present both types of rhythm slashes simultaneously by using a 
combination of slash regions and slash voices.

RELATED LINKS
Slash voices on page 1001
Inputting slash regions on page 332
Inputting notes into slash voices on page 175
Chord symbols on page 598
Hiding/Showing chord symbols on page 600

Slash regions
Slash regions automatically display rhythm slashes as appropriate for the meter throughout their 
duration, for example, they show four slashes per bar in 4/4 and two slashes per bar in 6/8. A 
single slash region can extend across multiple different meters.

A single slash region covering multiple different meters

Multiple slash regions can exist at the same rhythmic position. When slash regions overlap, 
Dorico SE treats this as a multiple-voice context and changes the staff position of slashes 
automatically.

By default, slash regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide and show them.
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In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

When two different slash regions are adjacent, they alternate highlight colors to ensure the 
separate regions are always identifiable.

Two adjacent slash regions with different highlight colors

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions, for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

TIP

Because rhythm slashes are often accompanied by chord symbols to indicate the set of notes 
the performer should use, you can hide/show chord symbols in slash/chord symbol regions on 
instrument staves where chord symbols are hidden.

RELATED LINKS
Inputting slash regions on page 332
Slash voices on page 1001
Slash region counts on page 876
Slashes in multiple-voice contexts on page 871
Moving slash regions on page 874
Lengthening/Shortening slash regions on page 875
Hiding/Showing notes alongside slash regions on page 872
Hiding/Showing chord symbols on page 600
Chord symbol regions on page 601
Bar repeats on page 861
Annotations on page 537

Hiding/Showing slash region highlights
You can hide/show the colored highlights for slash regions at any time, for example, if you want 
to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Slash Regions.

RESULT
Highlights on slash regions are shown when a tick appears beside Highlight Slash Regions in 
the menu, and hidden when no tick appears.

RELATED LINKS
Slash voices on page 1001

Rhythm slashes
Slash regions 
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Slashes in multiple-voice contexts
Multiple slash regions and slash voices can exist at the same rhythmic positions. In multiple-voice 
contexts for slash voices and when slash regions overlap, Dorico SE automatically changes their 
staff position and offset to accommodate all slashes as legibly as possible.

Single slash region Two slash regions, one up-stem and one down-stem

You can also control the positions of rhythm slashes relative to each other manually by changing 
their stem/voice direction and by changing their staff position.

RELATED LINKS
Note positions in multiple-voice contexts on page 998
Changing the voice of existing notes on page 353
Changing the staff position of rhythm slashes on page 872

Changing the voice direction of slash regions
You can change the voice direction of slash regions individually. When multiple slash regions 
overlap, this affects their stem directions.

PROCEDURE

1. Select any part of each slash region whose voice direction you want to change.

2. In the Properties panel, activate Voice direction in the Slash Regions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The voice direction, and therefore stem direction, of the selected slash regions is changed.

NOTE

This only affects the direction of stems in slash regions on the middle line of the staff and when 
multiple slash regions exist at the same rhythmic position. For example, if you change the voice 
direction of a slash region on the bottom line of the staff to Down, its stem direction does not 
change if it does not overlap with another slash region.

RELATED LINKS
Stem direction on page 921

Rhythm slashes
Slashes in multiple-voice contexts 
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Changing the staff position of rhythm slashes
You can change the staff position of rhythm slashes in both slash voices and slash regions, for 
example, to accommodate other notes at the same rhythmic positions better. By default, rhythm 
slashes are positioned on the middle line of the staff.

PROCEDURE

1. Select the rhythm slashes whose staff position you want to change.

● For notes in slash voices, you must select every note whose staff position you want to 
change.

● For slash regions, you can select any part of each region whose staff position you want 
to change.

2. In the Properties panel, activate Slash pos. in the corresponding group for the type of 
rhythm slash whose staff position you want to change:

● Notes and Rests for notes in slash voices

● Slash Regions for slash regions

3. Change the value in the value field.

RESULT
The staff position of the selected rhythm slashes is changed. For example, changing the Slash 
pos. value to 4 positions rhythm slashes on the top line of a five-line staff, while -4 positions them 
on the bottom line.

If any of the rhythm slashes have stems, their stem direction is adjusted automatically.

RELATED LINKS
Stem direction on page 921

Hiding/Showing notes alongside slash regions
You can hide/show notes at the same rhythmic positions as slash regions, for example, if you 
want to input notes to hear in playback but only want to show the slash region, or if you want to 
notate suggested notes in addition to the slash region.

PROCEDURE

1. Select any part of each slash region alongside which you want to hide/show other notes.

2. In the Properties panel, activate/deactivate Show other voices in the Slash Regions group.

RESULT
All notes in other voices present alongside the selected slash regions are shown when Show 
other voices is activated, and hidden when it is deactivated.

Rhythm slashes
Slashes in multiple-voice contexts 
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EXAMPLE

Notes hidden alongside a slash region Notes shown alongside a slash region

RELATED LINKS
Slash regions on page 869
Slash voices on page 1001
Hiding/Showing slash region highlights on page 870
Inputting slash regions on page 332

Hiding/Showing padding rests before/after slash regions
You can hide/show padding rests before/after slash regions that start partway through bars 
individually, for example, if you have other notes at those positions and the rests would be 
misleading. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

By default, Dorico SE automatically shows implicit padding rests around slash regions that 
start/end partway through bars, so that the full duration of each bar is clear.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose padding rests you want to hide/show.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slash Regions group:

● Hide rests before start

● Hide rests after end

RESULT
Padding rests are hidden on the corresponding side of the selected slash regions. For example, 
activating both properties hides padding rests both before and after the selected slash regions. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Implicit vs. explicit rests on page 880
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Rhythm slashes
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Splitting slash regions
You can split slash regions after they have been input, for example, if you later want to input 
more precise notation in the middle of an existing slash region.

PROCEDURE

1. In Write mode, select a slash in each slash region you want to split, immediately to the right 
of where you want to split them.

2. Press U .

RESULT
The slash regions are split immediately to the left of the selected slashes. Each part now has its 
own start/end handles, which you can use to lengthen/shorten each part independently.

RELATED LINKS
Changing the slash region count frequency on page 876
Lengthening/Shortening slash regions on page 875

Moving slash regions
You can move slash regions to different rhythmic positions after they have been input. Because 
multiple slash regions can exist at the same rhythmic position, you can also move slash regions 
so they overlap with other slash regions.

PROCEDURE

1. In Write mode, select any part of each slash region you want to move.

2. Move the selected slash regions according to the current rhythmic grid resolution in any of 
the following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

NOTE

You cannot move slash regions rhythmically with the mouse.

RESULT
The selected slash regions are moved to new rhythmic positions.

NOTE

If a single slash region passes over another slash region as part of its move, the existing one is 
unaffected as multiple slash regions can exist at the same rhythmic position. Where slash regions 
overlap, the staff positions of slashes are automatically adjusted.

However, when you move multiple slash regions together, any existing slash regions they pass 
over are shortened or deleted accordingly.

You can undo this action, but any slash regions shortened/deleted in the process are only 
restored if you moved slash regions using the keyboard.

Rhythm slashes
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RELATED LINKS
Slashes in multiple-voice contexts on page 871
Changing the voice direction of slash regions on page 871

Lengthening/Shortening slash regions
You can lengthen/shorten slash regions after they have been input. Because multiple slash 
regions can exist at the same rhythmic position, you can also lengthen/shorten slash regions so 
they overlap with other slash regions.

PROCEDURE

1. In Write mode, select any part of each slash region you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one slash region at a time.

2. Lengthen/Shorten the selected slash regions in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The selected slash regions are lengthened/shortened according to the current rhythmic grid 
resolution. If any part of them overlap rhythmic positions with other slash regions, the staff 
positions of slashes are automatically adjusted to accommodate multiple slash regions at the 
same positions.

RELATED LINKS
Slashes in multiple-voice contexts on page 871
Changing the voice direction of slash regions on page 871

Hiding/Showing stems in slash regions
You can hide/show stems on slashes in individual slash regions. By default, slashes in slash 
regions are shown without stems.

PROCEDURE

1. Select any part of each slash region in which you want to hide/show stems.

2. In the Properties panel, activate Slash type in the Slash Regions group.

3. Choose one of the following options:

● With stems

● Without stems

RESULT
Stems are hidden in the selected slash regions when you choose Without stems, and shown 
when you choose With stems.

Rhythm slashes
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Slash region counts
Slash region counts are numbers shown at regular intervals, either above or below slash regions, 
to help players keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

By default, slash region counts are shown every four bars and are placed below the staff. Each 
slash region has its own separate count.

Slash region with counts shown every two bars

In Dorico SE, you can change the start count of each slash region, how frequently slash region 
counts are shown, their staff-relative placement, and whether they are parenthesized.

RELATED LINKS
Slash regions on page 869

Changing the start count of slash regions
You can change the number from which individual slash region counts start, for example, if you 
want to input more precise notation between two slash regions but want the count to appear to 
continue across the regions.

PROCEDURE

1. Select any part of each slash region whose start count you want to change.

2. In the Properties panel, activate Count from in the Slash Regions group.

3. Change the value in the value field.

RESULT
The number and position of counts on the selected slash regions is changed. For example, 
changing the start count from 1 to 2, with counts shown every four bars, causes the count to 
appear on the third bar in the slash region instead of the fourth.

EXAMPLE

Two separate slash regions, where the start count on the second region has been changed so it appears to 
continue on from the first region.

Changing the slash region count frequency
You can change how frequently counts are shown on slash regions individually, for example, if 
you want to show the count after eight bars on a single slash region. By default, slash region 
counts are shown every four bars.

Rhythm slashes
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PROCEDURE

1. Select any part of each slash region whose count frequency you want to change.

2. In the Properties panel, activate Count frequency in the Slash Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected slash regions.

RELATED LINKS
Splitting slash regions on page 874

Changing the slash region count appearance
You can show individual slash region counts with or without parentheses, or not show any count 
at all. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose count appearance you want to change.

2. In the Properties panel, activate Count appearance in the Slash Regions group.

3. Select one of the following options from the menu:

● Parenthesized

● No parentheses

● Don’t show

RESULT
The appearance of counts on the selected slash regions is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the staff-relative placement of slash region counts
You can show the counts on individual slash regions either above or below the staff. You can do 
this for the current layout and frame chain only or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of slash region counts affects all counts on the region. You 
cannot change the placement of a single count independently of other counts on the same slash 
region.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

Rhythm slashes
Slash region counts 

877
Dorico SE 3.5.12



PROCEDURE

1. Select any part of each slash region whose count staff-relative placement you want to 
change.

2. In the Properties panel, activate Count position in the Slash Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts on the selected slash regions is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Rhythm slashes
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Rests

Rests are markings with a rhythmic value that indicate no note is played for that duration. Each 
note duration has an equivalent rest, for example, a quarter note rest is different to a sixteenth 
note rest.

All notes and rests within a bar must add up to the duration of the bar, according to the 
prevailing time signature.

The table shows some examples of notes and the rests with the equivalent rhythmic value.

Duration Note Rest

Half

Quarter

Eighth

Sixteenth

During note input, Dorico SE automatically fills the gaps between notes with implicit rests of the 
appropriate duration. Therefore, it is usually not necessary to input rests in Dorico SE.

RELATED LINKS
Inputting rests on page 187
Deleting rests on page 883
Inputting notes on page 161
Note and rest grouping on page 590
Implicit rests in multiple-voice contexts on page 881
Showing figured bass on rests on page 653

General placement conventions for rests
Rests are positioned at the rhythmic position at the start of their duration, and not in the middle 
of beats as this can cause confusion over when the rest begins and ends. Rests are aligned with 
other items at the same rhythmic position.

The only exception is whole bar rests, which are positioned at the visual center of bars. This way, 
they are clearly distinguishable from half note and whole note rests that are followed by notes in 
the same bar.
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Rests stay within the staff wherever possible. They do not move above or below the staff when 
the notes around them are very high or very low.

However, on staves with multiple voices, rests are placed higher on the staff, or above the staff, 
for up-stem voices and lower on the staff, or below the staff, for down-stem voices.

Example rest positions in a multiple-voice context

Rests in multiple voices must not overlap. You can consolidate rests so that only one is shown 
when multiple voices have a rest of the same duration at the same rhythmic position.

The precise vertical positioning of rests is limited, as their detailed shapes require specific 
positions relative to staff lines and staff spaces.

RELATED LINKS
Voices on page 997
Inputting notes into multiple voices on page 174
Creating cross-staff beams on page 583

Implicit vs. explicit rests
Implicit rests are automatically shown between the notes you input, and their duration 
automatically follows the time signature and their position in the bar. Explicit rests are rests that 
are explicitly entered during note input by forcing their duration, or rests that were imported 
from a MusicXML file.

Dorico SE notates implicit rests according to the current time signature, for example, different 
implicit rests are shown in 6/8 compared to 4/4. This also applies if you later change the time 
signature for existing notes and rests.

Therefore, it is not necessary to input rests in Dorico SE, as implicit rests are automatically shown 
around the notes that you input. You can turn implicit rests into explicit rests by forcing their 
duration to be fixed.

A quarter note input at the fourth eighth note of 
the bar in a 6/8 time signature has a dotted quarter 
implicit rest at the start of the bar.

A quarter note input at the fourth eighth note of the 
bar in a 4/4 time signature has two implicit rests, a 
quarter and an eighth, at the start of the bar.

Explicit rests cannot be suppressed when using the Starts voice and Ends voice properties to 
hide rests before the first note in voices and after the last note in voices.

You can show rest colors to see which rests are implicit and which are explicit in your project.

Rests
Implicit vs. explicit rests 

880
Dorico SE 3.5.12



RELATED LINKS
Inputting rests on page 187
Inputting notes on page 161
Deleting rests on page 883
Forcing the duration of notes/rests on page 171
Turning explicit rests into implicit rests on page 882
Hiding/Showing rest colors on page 882

Implicit rests in multiple-voice contexts
In Dorico SE, implicit rests are shown automatically to fill in rhythmic positions around notes, 
including when there are multiple voices on the staff. However, in these contexts you might want 
more control over when and where rests are shown.

Usually, rests or notes are shown for whole bars when voices contain at least one note in the bar. 
This helps make the rhythmic position of every note in all voices in the bar immediately clear.

When there are multiple voices on a staff, implicit rests are shown in every bar in which there are 
notes of any duration in more than one voice. However, there might be circumstances in which 
you do not want to show rests either before the first note in a voice or after the last note in a 
voice when there are multiple voices on the staff. For example, it can be useful to hide rests when 
a voice is being used to show passing notes within a bar that otherwise contains a single melodic 
line.

A second voice used to notate passing notes

TIP

By default, Dorico SE consolidates rests when multiple voices have rests of the same duration at 
the same rhythmic position.

You can show multiple rests at individual rhythmic positions by changing the vertical position of 
rests.

You can hide rests before the first note in voices and after the last note in voices individually 
by activating properties in the Properties panel. You can show rests that you have hidden by 
deactivating the corresponding property. You can also delete rests from selected passages.

A phrase with multiple voices showing implicit rests. The same phrase without implicit rests.
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RELATED LINKS
Moving rests vertically on page 886

Turning explicit rests into implicit rests
Implicit rests and explicit rests behave differently. For example, you can hide implicit rests using 
the Properties panel, but you cannot hide explicit rests or rests with forced durations.

NOTE

You can only hide implicit rests using Starts voice and Ends voice in the Notes and Rests group 
of the Properties panel.

PROCEDURE

1. In Write mode, select the explicit rests you want to turn into implicit rests.

2. Press Backspace or Delete .

RESULT
The selected explicit rests are now implicit rests. You can check this by showing rest colors.

RELATED LINKS
Hiding/Showing rest colors on page 882
Deleting rests on page 883

Hiding/Showing rest colors
You can hide/show rest colors, which causes implicit rests and explicit rests to appear with 
different colors.

When rest colors are shown, rests in your project appear gray if they are implicit, and black if 
they are explicit. For example, this can be useful to help diagnose why rests do not disappear 
when you activate Starts voice and Ends voice, as these properties only hide implicit rests.

PROCEDURE

● Choose View > Note And Rest Colors > Implicit Rests.

RESULT
Rest colors are shown when a tick appears beside Implicit Rests in the menu, and hidden when 
no tick appears.

EXAMPLE

Rests colored black, as they appear without implicit 
rests shown

Rests colored gray to indicate implicit rests
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AFTER COMPLETING THIS TASK
You can delete rests that you have identified as explicit rests. The implicit rests that replace them 
now respect the Starts voice and Ends voice properties.

Deleting rests
You can delete both implicit rests and explicit rests, for example, if you want to hide rests before/
after notes in another voice used to show passing notes.

NOTE

You cannot delete rests from unpitched percussion instruments.

PROCEDURE

1. In Write mode, select the rests you want to delete.

TIP

You can select rests individually, or make a larger selection that contains the rests you want 
to delete.

2. Choose Edit > Remove Rests.

RESULT
All rests in the selection are deleted. This is done by automatically activating Starts voice and 
Ends voice in the Notes and Rests group of the Properties panel so that no rests are shown in 
the selected regions.

TIP

You can show rests again later by selecting the notes or rests immediately to the right/left of 
deleted rests and deactivating the corresponding Starts voice or Ends voice properties in the 
Notes and Rests group of the Properties panel.

EXAMPLE

A phrase with multiple voices showing implicit rests. The same phrase after deleting the rests.

RELATED LINKS
Implicit vs. explicit rests on page 880
Large selections on page 336
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Hiding/Showing bar rests in empty bars
You can hide/show bar rests in empty bars in each layout independently. For example, you can 
hide bar rests in full score layouts but show bar rests in part layouts.

Bar rests are usually shown in empty bars in music to indicate to performers that they have 
nothing to play. However, there are contexts in which it is preferable to hide bar rests in empty 
bars, and instead leave the bar completely empty.

For example, hiding bar rests in empty bars is sometimes the preferred visual aesthetic in large 
scores, so that it is quicker to identify bars containing music. You can also hide bar rests in 
layouts where you want to include other instructions, such as verbal indications for performers 
to do something other than play notated pitches.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar rests in empty 
bars.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Bar Rests and Multi-bar Rests section, activate/deactivate Show bar rests in empty 
bars.

5. Click Apply, then Close.

RESULT
All bar rests in empty bars in the selected layouts are shown when the checkbox is activated, and 
hidden when the checkbox is deactivated.

RELATED LINKS
Hiding/Showing multi-bar rests on page 885

Multi-bar rests
Multi-bar rests group two or more consecutive empty bars together into a single unit, commonly 
shown with a thick horizontal line positioned on the middle staff line, known as an “H-bar”. They 
can reduce the horizontal space required by multiple empty bars and make it easier for players 
to find their place in the music.

A multi-bar rest representing four empty bars

NOTE

Multi-bar rests are automatically split by items positioned within their range, such as system text, 
rehearsal marks, and holds and pauses. This includes when the items are invisible, except for 
hidden tempo marks, such as those input in the Time track in Play mode. However, if items are 
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positioned at the start of the first bar in a multi-bar rest, that bar remains part of the subsequent 
multi-bar rest.

You can hide/show multi-bar rests in each layout independently in Dorico SE, and you can hide/
show bar number ranges below them.

By default, the multi-bar rest bar counts only appear once between the staves of grand staff 
instruments.

RELATED LINKS
Hiding/Showing bar number ranges on multi-bar rests on page 565
Time track on page 447

Hiding/Showing multi-bar rests
You can hide/show multi-bar rests in each layout independently, and choose whether bar repeats 
are consolidated into multi-bar rests. For example, you can hide multi-bar rests in full score 
layouts but show multi-bar rests in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show multi-bar rests.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Bar Rests and Multi-bar rests section, choose one of the following options for 
Consolidate:

● None

● Multi-bar Rests

● Multi-bar Rests and Bar Repeats

5. Click Apply, then Close.

RESULT

● When you choose None, no multi-bar rests are shown in the selected layouts. Each empty 
bar is shown separately.

● When you choose Multi-bar Rests, any adjacent empty bars are consolidated into multi-bar 
rests in the selected layouts. However, bar repeats prevent the consolidation of multi-bar 
rests, even if there are no other notes in those bars.

● When you choose Multi-bar Rests and Bar Repeats, any adjacent empty bars or bars 
that only contain bar repeats are consolidated into multi-bar rests in the selected layouts. 
Multi-bar rest counts are also shown above consolidated bar repeats.

RELATED LINKS
Bar repeats on page 861
Hiding/Showing bar number ranges on multi-bar rests on page 565
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Moving rests vertically
You can change the vertical position of rests individually, for example, if you want to change 
the staff line from which a whole bar rest hangs, or you want to show rests for all voices at a 
particular rhythmic position. You can do this for the current layout and frame chain only or for all 
layouts and frame chains.

Moving rests vertically shows multiple rests at that rhythmic position if more than one voice 
on the staff has a rest of the same duration. By default, Dorico SE consolidates rests in multiple-
voice contexts and automatically positions rests in multiple-voice contexts to avoid collisions.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests whose vertical positions you want to change, or rests at the rhythmic 
positions where you want to see rests for every voice.

2. In the Properties panel, activate Rest pos. in the Notes and Rests group.

3. Change the value in the value field.

RESULT
Increasing the value moves rests upwards, decreasing the value moves rests downwards. 
Position 0 is the middle line of the staff. If there are multiple voices on the staff with rests of 
the same duration, multiple rests are now shown.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Deactivating Rest pos. returns the selected rests to their default positions.

RELATED LINKS
Note spacing on page 406
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395
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Slurs

Slurs are tapered, curved lines that join notes to indicate legato articulation and phrasing.

Depending on the context and the instrument to which they apply, slurs can have additional 
meanings to simply marking phrases. For example, for wind players, a slur indicates that all the 
notes in the phrase are played in the same breath and without re-tonguing or re-articulating any 
notes. For string players, a slur indicates that all the notes in the phrase are played legato and 
under one bow. For singers, slurs indicate that more than one note is sung to the same syllable.

Slurs both above and below the staff, including a cross-staff slur

Dorico SE automatically determines the appropriate endpoint position and curvature direction 
for slurs based on the notes within their ranges, but you can change this manually. You can also 
input any number of nested slurs.

NOTE

Slurs must not be confused with ties, which look superficially similar, but instead join notes of 
the same pitch to indicate that they are played as a single note. In that sense, ties are part of 
rhythmic notation, while slurs are considered articulation.

RELATED LINKS
Inputting slurs on page 211
Inputting nested slurs on page 896
Ties vs. slurs on page 940
Cross-staff and cross-voice slurs on page 895
Slur endpoint positions on page 889
Slur curvature direction on page 893
Changing the position of slurs relative to tie chains on page 888

General placement conventions for slurs
There are different conventions for the placement, endpoint position, shape, and curvature 
direction of slurs in various contexts.

RELATED LINKS
Slur placement relative to grace notes on page 889
Slur position relative to staff lines on page 889
Slur endpoint positions on page 889
Slurs over system and frame breaks on page 890
Slur curvature direction on page 893

887
Dorico SE 3.5.12



Slur position relative to tie chains
There are different conventions for the position of slurs relative to tie chains in music for modern 
use and historical editions.

Modern practice is for slurs to start on the first note in tie chains, and end on the last note in tie 
chains. This makes the full length of the phrase visually clear to the performer, which helps their 
performance, and is the default in Dorico SE.

Slur ending on the last note in a tie chain Slur starting from the first note in a tie chain

However, in historical editions, slurs might end on the first note in a tie chain, and start on the 
last note in a tie chain. Both of these changes save vertical space, as shorter slurs do not extend 
as far above or below a staff.

Slur ending on the first note in a tie chain Slur starting on the last note in a tie chain

You can change the position of slurs relative to tie chains.

RELATED LINKS
Slur endpoint positions on page 889

Changing the position of slurs relative to tie chains
You can change the position of individual slurs relative to tie chains, including slurs starting on 
grace notes, for example, to save vertical space.

PROCEDURE

1. Select the slurs whose position relative to tie chains you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slurs group:

● Start pos. in tie chain

● End pos. in tie chain

3. Choose one of the following options for each property:

● First note

● Last note

RESULT
The position of the selected slurs relative to tie chains is changed.

Slurs
General placement conventions for slurs 
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Slur placement relative to grace notes
There are specific placement rules that affect slurs when they start from a grace note and end on 
a normal note immediately following the grace note.

These rules are:

● Slurs connect noteheads rather than stems.

● Slurs are scaled to match the proportions of grace notes.

● Slurs must not obscure ledger lines.

● Slurs are placed above notes if they would collide with the accidental of a standard note 
when placed below the notes.

Due to the general placement conventions of grace notes, slurs in Dorico SE appear below grace 
notes and curve downwards by default. Slurs starting from grace notes only appear above notes 
and curve upwards in up-stem voices in multiple-voice contexts.

Slur curvature direction on grace notes in a single-
voice context

Slur curvature direction on grace notes in a multiple-
voice context

RELATED LINKS
Changing the curvature direction of slurs on page 894
Changing the stem direction of notes on page 923
General placement conventions for grace notes on page 683

Slur position relative to staff lines
Slur endpoints must not touch staff lines, and the high point of the arcs of slurs should not stop 
on staff lines.

This is the convention because a slur whose arc peaks on a staff line can create the appearance 
of a triangular wedge between the staff line and the curve of the slur. If a slur peaks on a staff 
line, you can adjust its height so that it peaks either above/below the staff.

NOTE

Although Dorico SE automatically ensures slur endpoints do not touch staff lines, manual 
adjustments might be necessary to position the arcs of slurs correctly.

Slur endpoint positions
In order to avoid collisions, the default positions of slur endpoints vary depending on whether 
slurs are placed on the notehead side or stem side of notes, their position relative to staff lines, 
and whether articulations, ties, and other slurs exist at the same rhythmic position.

Slur endpoints relative to noteheads and stems

The default position of slur endpoints relative to noteheads is 1/2 space above a notehead in a 
space on the staff, and 1/4 space above a notehead on a line on the staff.

Slurs
General placement conventions for slurs 
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Slurs appear between the stems of unbeamed notes when placed on their stem side, and the 
default setting is for their endpoints to attach a short distance from the end of the stem.

Slurs between the stems of unbeamed notes

Slur endpoints relative to notes with different stem directions

For slurs between notes with different stem directions, Dorico SE positions their endpoints close 
to the notehead by default so that the shape and curvature direction of slurs reflects the rising or 
descending pitch contour of phrases, including when they span multiple staves.

Slur endpoints near noteheads Slur endpoints near stem ends

Slur endpoints relative to articulations

By default, articulations of force and stress are placed outside slur endpoints, and articulations of 
duration are placed inside slur endpoints, which automatically raises the endpoints. For example, 
accents and stress marks are placed outside the ends of slurs but staccato and tenuto marks are 
placed inside the ends of slurs.

Slurs are placed outside articulations on notes in the middle of slurs.

Slur endpoints relative to ties and other slurs

The default position of slur endpoints is 1/4 space above an existing slur that starts/ends on the 
same note.

RELATED LINKS
Cross-staff and cross-voice slurs on page 895
Stem direction on page 921
Articulations on page 547
Changing the placement of articulations relative to slurs on page 551

Slurs over system and frame breaks
Slurs automatically cross system breaks and frame breaks, appearing in two parts on either side 
of the break.

By default, the endpoints of slurs that cross system/frame breaks are positioned at least 1/2 
space outside the outer staff line and at a suitable position based on the pitch contour of the 
phrase before/after the break, that is, indicating whether the phrase rises or falls after the break.

If multiple slurs cross the same system break or frame break, such as if a phrase split by a break 
contains nested slurs, the ends of the slurs are stacked automatically and spaced a minimum of 
1/2 space apart vertically.

Slurs
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The end of a system showing the first slur part; the 
end on the right indicates a continuation to the next 
system.

The start of the next system showing the second 
slur part; the end on the left indicates a continuation 
from the previous system.

RELATED LINKS
Nested slurs on page 895

Slur collision avoidance
By default, Dorico SE automatically adjusts the shape and position of slurs to avoid collisions with 
items under their arc.

This means that if a notehead under a slur is either higher than the others under a slur curving 
upwards, or lower than the others under a slur curving downwards, the curvature of the slur is 
adjusted to avoid the collision and keep the notehead under the slur.

Slur with collision avoidance activated (default) Slur with collision avoidance deactivated

RELATED LINKS
Cross-staff and cross-voice slurs on page 895
Accidentals on page 541

Slur styles
There are different styles of slurs available in Dorico SE, which indicate different meanings and 
have different use cases.

The following options for slur style are available when you activate Style in the Slurs group of the 
Properties panel:

Solid
This is the default style for slurs. Slurs appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Slurs appear as tapered dashed lines. Can be used to indicate an optional slur, for 
example, to recommend breathing/bowing patterns.
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Dotted
Slurs appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the slur.

Half-dashed start
The first halves of slurs appear as dashed lines, the second halves as solid lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Half-dashed end
The first halves of slurs appear as solid lines, the second halves as dashed lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Editorial
Slurs appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length, perpendicular to the curve of the slur. Used to show 
that a slur was added by the editor and was not present in the original source.

Changing the style of slurs
You can change the style of individual slurs after they have been input. You can do this for the 
current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose style you want to change.

2. In the Properties panel, activate Style in the Slurs group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected slurs is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
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Copying property settings to other layouts/frame chains on page 395

Changing individual slurs to flat slurs
Although they are not often used as standard, some publishers use flat slurs in order to reduce 
the vertical space occupied by slurs. You can change individual slurs to flat slurs. You can do this 
for the current layout and frame chain only or for all layouts and frame chains.

NOTE

Not all slurs look good as flat slurs, but it would also be unusual only to use flat slurs once or 
twice in a project. Therefore, we recommend that you avoid changing the curvature style for only 
one or two slurs in a project.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature style you want to change.

2. In the Properties panel, activate Curvature style in the Slurs group.

3. Choose one of the following options:

● Normal (curved)

● Flat

RESULT
The curvature style of the selected slurs is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Slur curvature direction
Slurs can curve upwards, downwards, or have a multi-segment S-shape. Dorico SE automatically 
determines the appropriate curvature direction for slurs based on the notes within their ranges, 
but you can change the curvature direction of slurs manually.

A slur on a single staff always curves upwards and is placed above the notes, unless all of the 
notes under the slur are up-stem, in which case it curves downwards and is placed below the 
notes. If a slur applies to a mixture of up-stem and down-stem notes, it is placed above the staff 
and curves upwards.

Examples of the slur direction changing according to the stem direction

The following options for slur curvature direction are available when you activate Direction in 
the Slurs group of the Properties panel:
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Up

Forces slurs to curve upwards, and appear above notes.

Down

Forces slurs to curve downwards, and appear below notes.

Up/Down

Forces slurs to comprise two segments: the first curves upwards, the second curves 
downwards to create a mirrored S-shape. It is typically used when phrases start in the 
lower staff and end in the upper staff, for example, in piano parts.

Down/Up

Forces slurs to comprise two segments: the first curves downwards, the second curves 
upwards to create an S-shape. It is typically used when phrases start in the upper staff 
and end in the lower staff, for example, in piano parts.

TIP

In jazz scores, slurs are sometimes treated as an articulation and so positioning all slurs above 
the staff is preferred.

RELATED LINKS
Slurs over system and frame breaks on page 890
Cross-staff and cross-voice slurs on page 895

Changing the curvature direction of slurs
You can change the curvature direction of individual slurs so that they curve upwards, 
downwards, or have a multi-segment S-shape. You can do this for the current layout and frame 
chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature direction you want to change.

2. In the Properties panel, activate Direction in the Slurs group.

3. Choose one of the following options:

● Up 

● Down 

● Up/Down  (mirrored S-shape)

● Down/Up  (S-shape)
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RESULT
The curvature direction of the selected slurs is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Cross-staff and cross-voice slurs
Cross-staff slurs start on one staff and end on another staff, and cross-voice slurs start in one 
voice and end in another voice.

Cross-staff slurs between two piano staves

Dorico SE positions cross-staff and cross-voice slurs in the same way as it positions standard 
slurs. You can move and lengthen/shorten cross-staff and cross-voice slurs in the same ways as 
standard slurs; however, they do not behave in the same way. For example, you cannot move 
cross-voice slurs to notes on the same staff in other voices, and you cannot lengthen cross-voice 
slurs to notes on the same staff in other voices. You also cannot lengthen/shorten cross-voice 
slurs to notes in different voices to those in which the slur started/ended.

You can only move and lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint. For example, if a cross-staff slur covers a phrase that starts on the 
bottom staff and ends on the upper staff, you can only shorten the cross-staff slur to the first 
note on the upper staff, you cannot shorten it to any notes on the bottom staff.

The different voices can be on the same staff, or on different staves.

RELATED LINKS
Inputting slurs on page 211
Lengthening/Shortening slurs on page 898
Moving slurs rhythmically on page 897
Slur collision avoidance on page 891
Slur endpoint positions on page 889

Nested slurs
Nested slurs are two or more slurs used simultaneously, where the overarching slur shows the 
structure of the phrase and the inner slurs show the articulation within the phrase. They are also 
known as “slurs within slurs”.

Depending on the stem directions within the overarching outer slur, inner slurs may appear on 
the opposite side of the staff to the outer slur.
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A phrase with nested slurs

You can input nested slurs in the same ways as inputting standard slurs. By default, Dorico SE 
makes automatic adjustments to their positioning to avoid collisions.

RELATED LINKS
Slur collision avoidance on page 891

Inputting nested slurs
You can input nested slurs, both during note input and by adding them to existing notes. You 
can also add nested slurs to existing notes on multiple staves at the same time and to notes 
in different voices or on different staves belonging to the same instrument, for example, when 
phrases span both staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes you want to include in the outer slur.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes, for example, by selecting the first note then Ctrl/Cmd -clicking 
the second.

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff slurs. However, you cannot create 
cross-staff slurs between different instruments.

● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input slurs onto multiple staves at once, extend the caret to those 
staves.

3. Press S  to input or start the outer slur.

4. Input the inner slur in one of the following ways:

● When adding nested slurs to existing notes: Select the notes within the outer slur that 
you want to place under an inner slur and press S .

● To start the inner slur on the same note as the outer slur during note input, press S .

● To start the inner slur on a later note during note input, input notes or advance the caret 
manually to where you want the inner slur to start, then press S .
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NOTE

If you added nested slurs to existing notes, stop here.

5. During note input, input the notes you want to include in the inner slur.

The slurs extend automatically as you continue inputting notes, even if there are rests 
between the notes you input.

6. Press Shift-S  once to end the inner slur on the currently selected note.

7. Continue inputting notes.

8. Optional: Start/End other inner slurs.

9. Press Shift-S  again to end the outer slur on the currently selected note.

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection. Inner slurs can have different curvature directions to outer slurs.

NOTE

● You can input the outer slur and inner slurs in any order as Dorico SE automatically adjusts 
slurs so that shorter slurs are positioned within longer slurs, and ensures they do not collide.

● Slur collisions are not automatically avoided if you activate Disable auto curve adjustment 
in the Slurs group of the Properties panel for individual slurs.

RELATED LINKS
Inputting slurs on page 211
Changing the curvature direction of slurs on page 894
Slur collision avoidance on page 891

Moving slurs rhythmically
You can move slurs to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the slur you want to move.

NOTE

You can only move one slur rhythmically at a time.

2. Move the slur to other noteheads on the staff in any of the following ways:

● Press Alt/Opt-Right Arrow  to move it to the next notehead on the staff.

● Press Alt/Opt-Left Arrow  to move it to the previous notehead on the staff.
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● Click and drag it to the right/left.

RESULT
The slur is moved to other noteheads on the staff.

NOTE

The rhythmic duration of the slur is usually maintained. However, depending on the rhythms it 
crosses as it moves, the slur may cover longer/shorter durations than before it was moved.

Lengthening/Shortening slurs
You can change the length of slurs rhythmically after they have been input.

NOTE

You can only lengthen/shorten cross-staff slurs to notes on the same staff as the corresponding 
endpoint, and you can only lengthen/shorten cross-voice slurs to notes in the same voice as the 
corresponding endpoint.

PROCEDURE

1. In Write mode, select the slurs you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one slur at a time.

2. Lengthen/Shorten the slurs in any of the following ways:

● Press Shift-Alt/Opt-Right Arrow  to lengthen the slur to the next notehead.

● Press Shift-Alt/Opt-Left Arrow  to shorten the slur to the previous notehead.

NOTE

Key commands lengthen/shorten items by moving their end only. You can move the 
start of slurs by moving the whole slur, or by clicking and dragging the start handle.

● Click and drag the start/end of the slur to the next/previous notehead.

RESULT
The selected slurs are lengthened/shortened.

RELATED LINKS
Moving slurs rhythmically on page 897
Cross-staff and cross-voice slurs on page 895
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Linked slurs
Slurs of the same duration at the same rhythmic position on multiple staves can be linked 
together. This happens automatically when you copy and paste slurs or material including slurs 
between staves, or enter them simultaneously.

If slurs are linked, moving one slur in the linked group moves any slurs linked to it in the same 
way. Similarly, lengthening or shortening a slur in a linked group lengthens or shortens any slurs 
linked to it in the same way. However, deleting one slur in a linked group only deletes the slur 
selected, not the whole group.

Linked slurs appear highlighted when any slur in the linked group is selected.

Linked slurs with the top slurs selected

You can also manually link and unlink slurs.

RELATED LINKS
Inputting slurs on page 211
Unlinking slurs on page 900
Linked dynamics on page 648
Disabling automatic linking of dynamics and slurs when pasting on page 342

Linking slurs together
Dorico SE automatically links slurs of the same duration at the same rhythmic positions together 
when you copy and paste slurs or material including slurs between staves, or enter them 
simultaneously. However, you can also link slurs together manually.

PROCEDURE

1. In Write mode, select the slurs you want to link together.

NOTE

Only slurs that have the same duration and start at the same position can be linked together.

2. Choose Edit > Slurs > Link. You can also choose this option from the context menu.

RESULT
The selected slurs are linked together.
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Unlinking slurs
You can unlink slurs manually that were automatically linked together, for example, if you want 
to lengthen/shorten them independently of each other.

PROCEDURE

1. In Write mode, select a slur from each linked group you no longer want to be linked.

2. Choose Edit > Slurs > Unlink. You can also choose this option from the context menu.

RESULT
All slurs linked to the selected slurs are unlinked.

NOTE

You cannot only unlink a single slur from the group.

Slurs in playback
Slurs trigger the legato playing technique in playback. By default, this increases the length of the 
MIDI notes without affecting the notation of the music.

Slurred notes sound for 105% of the length indicated by their notated rhythm, as opposed to 
non-slurred notes which sound for 95% of their notated rhythm.

The final note of a slur sounds for 95% of its notated rhythm, as there is no slur after it and the 
legato technique is no longer required.

TIP

You can enable independent voice playback for individual instruments, for example, if you have 
slurs in one voice and staccatos in another voice.

The example shows how MIDI note length, indicated by the filled, light-colored rectangles, is 
increased when slurs are used. The thin, darker rod shows the notated duration of each note. 
The first three notes are non-slurred, so the MIDI length rectangle is shorter than the line of the 
notated rhythm. The last four notes are slurred together, so the MIDI length is longer than the 
notated length in order to create the legato, slurred sound. However, the last note of the slurred 
group is not longer, as the last note of a slurred phrase is treated like a normal, non-slurred note.

A phrase in an instrument staff The same phrase in the piano roll in Play mode

RELATED LINKS
Played vs. notated note durations on page 515
Enabling independent voice playback on page 460
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Staff labels

Staff labels are used to identify staves in music containing multiple players, and are positioned to 
the left of systems, before the initial barline of each system. Staff labels indicate the instrument 
or instruments currently playing the music on the staff or staves to which they apply.

It is usual to show instrument names in full in the staff labels for the first systems in each flow, 
and abbreviated instrument names in the staff labels of subsequent systems. Using abbreviated 
instrument names saves horizontal space, allowing you to include more music in each system.

Examples of staff labels on the first system in a flow

In Dorico SE, staff labels use the instrument names set for each instrument in the Edit 
Instrument Names dialog. In the dialog, you can specify singular and plural names for each 
instrument, and singular and plural abbreviations for each instrument.

TIP

You do not need to number instruments in staff labels manually, as Dorico SE automatically 
numbers instruments when there are multiple players of the same type playing instruments of 
the same type.

Part layouts by default do not show staff labels, as most parts only contain a single staff whose 
identity is clear from the context and the layout name. The layout name is shown at the top left 
of the first page in part layouts by default.

NOTE

Layout names are different to the instrument names used for staff labels.

For players holding multiple instruments, the staff label shows the instrument they are currently 
playing. If the player changes instrument partway through a system, the name of the new 
instrument is shown above the staff at its first note and the staff label is updated at the start of 
the next system.
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NOTE

Staff labels do not show all instruments held by players, for example, in the staff label for the first 
system. You should include a comprehensive instrumentation list that shows any doubling at the 
front of your score.

Dorico SE includes the instrument transposition, or instrument pitch, in staff labels for 
transposing instruments by default. Transposing instruments are instruments whose sounding 
pitch is different to the notated pitch.

You can change when instrument transpositions, or instrument pitches, are shown in staff 
labels. You can also change whether the instrument transposition is shown before or after the 
instrument name in staff labels.

Staff labels imported from MusicXML files

When exporting MusicXML files from Cubase and importing them into Dorico SE, you can 
improve the accuracy of the automatic instrument selection by changing the instrument names 
in the Cubase Score Editor to the same English instrument names that Dorico SE uses before 
exporting the file.

RELATED LINKS
Player, layout, and instrument names on page 129
Instrument numbering on page 101
Edit Instrument Names dialog on page 132
Changing instrument names on page 131

Instrument names in staff labels
Staff labels use the instrument names set for each instrument. Staff labels can show full or short 
instrument names.

On the Staves and Systems page in Setup > Layout Options, you can choose whether you want 
to show full, short, or no instrument names in staff labels in each layout independently.

● Full staff labels use full instrument names.

● Abbreviated staff labels use short instrument names.

● None shows no staff labels.

Instrument numbers are automatically shown in both full and abbreviated staff labels.

NOTE

● You can change the full and short instrument names for each instrument in the Edit 
Instrument Names dialog in Setup mode.

● Changing instrument names does not change the name shown at the top of each part 
layout, as that uses the layout name. You can rename layouts in Setup mode.

RELATED LINKS
Player, layout, and instrument names on page 129
Instrument numbering on page 101
Hiding/Showing staff labels on page 903
Edit Instrument Names dialog on page 132
Changing instrument names on page 131
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Renaming layouts on page 131

Hiding/Showing staff labels
You can show full or abbreviated instrument names in staff labels, or hide all staff labels entirely, 
in each layout independently. The first system in each flow and all subsequent systems can have 
different staff label lengths.

By default, full staff labels are shown on the first system of each flow and abbreviated staff labels 
are shown on subsequent systems in full score layouts. In part layouts, staff labels are not shown 
on any systems.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show staff labels.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Staff Labels section, select one of the following options from the Staff labels on first 
system menu:

● Full

● Abbreviated

● None

5. Select one of the following options from the Staff labels on subsequent systems menu:

● Full

● Abbreviated

● None

6. Click Apply, then Close.

RESULT
Staff labels are hidden/shown on the corresponding staves in the selected layouts.

● None hides staff labels.

● Full and Abbreviated show staff labels using the corresponding instrument name length.

TIP

● These settings apply to each flow in the layout, not the project as a whole. If, for example, 
you want to show full staff labels on the first system in the first flow in your project, but want 
to show abbreviated staff labels on the first systems of all subsequent flows, we recommend 
choosing the setting appropriate for the most flows in the layout, then changing the length 
of staff labels at other positions as required.

● You can change both full and short instrument names in the Edit Instrument Names dialog.

RELATED LINKS
Instrument names in staff labels on page 902
Changing instrument names on page 131
Edit Instrument Names dialog on page 132
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Staff labels on condensed staves on page 908
Staff labels for percussion kits on page 907

Changing the minimum indent for systems with staff labels
You can change the minimum indent for all systems that show staff labels to optimize horizontal 
space in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose minimum indent for systems with staff labels 
you want to change.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Staff Labels section, change the value for Minimum indent for systems with staff 
labels.

5. Click Apply, then Close.

RESULT
The minimum indent on all systems that show staff labels is changed in the selected layouts.

RELATED LINKS
System indents on page 914
Changing the first system indent on page 915

Instrument transpositions in staff labels
Instrument transpositions indicate the interval between the note an instrument plays and the 
sounding note produced. Transposing instruments, such as Horn in F and Clarinet in B♭, are 
commonly shown with their transposition, also known as their “instrument pitch”, as part of their 
instrument name or layout name.

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

Dorico SE sets common transposing instruments, such as Clarinet in B♭ and Trumpet in B♭, to 
follow your per-layout settings for hiding/showing instrument transpositions in staff labels.

To reduce the risk of confusion, uncommon transposing instruments, such as Clarinet in A or 
Trumpet in E, are set to show their transposition in staff labels always, even if you have hidden 
instrument transpositions in the layout.

RELATED LINKS
Edit Instrument Names dialog on page 132
Transposing instruments on page 104
Changing instrument names on page 131
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Hiding/Showing instrument transpositions in staff labels
You can hide/show instrument transpositions in staff labels in each layout independently. For 
example, you can hide instrument transpositions in staff labels in full score layouts but show 
them in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument 
transpositions in staff labels.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Staff Labels section, activate/deactivate the following options for Instrument pitch 
or transposition:

● Show in full staff labels

● Show in abbreviated staff labels

5. Optional: Repeat steps 2 to 4 for other layouts.

6. Click Apply, then Close.

RESULT
Instrument transpositions are shown in staff labels of the corresponding length in the selected 
layouts when the corresponding checkbox is activated, and hidden when the corresponding 
checkbox is deactivated.

NOTE

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

RELATED LINKS
Changing instrument names on page 131

Changing the position of instrument transpositions in full staff 
labels

You can show instrument transpositions before/after instrument names in staff labels in each 
layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose instrument transposition position you want to 
change.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.
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4. In the Staff Labels section, choose one of the following options for Position of instrument 
pitch in full staff labels:

● Start

● End

5. Click Apply, then Close.

RESULT
The position of instrument transpositions relative to instrument names in staff labels is changed 
in the selected layouts.

Hiding/Showing instrument change labels at the start of 
flows

You can hide/show instrument change labels at the start of each flow in each layout 
independently. These labels can be useful for players holding multiple instruments as a way of 
clarifying the instrument required in their part layouts, which do not normally show staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument change 
labels at the start of flows.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Instrument Changes section, activate/deactivate Show instrument change label at 
start of flow.

5. Click Apply, then Close.

RESULT
Instrument change labels are shown in the first bar of each flow in the selected layouts when 
Show instrument change label at start of flow is activated, and hidden when it is deactivated.

RELATED LINKS
Instrument changes on page 102
Editing the default instrument change label text on page 103
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Staff labels for percussion kits
The staff labels shown for percussion kit staves depend on how kits are presented in your 
project. Kits can be presented as five-line staves, grids, and as single-line instruments.

Percussion kit presentation 
type

Staff label Example

5-line staff Single instrument name using 
the instrument name of the 
percussion kit.

Grid Multiple instrument names: 
one for each kit instrument, 
positioned at the staff 
position of the corresponding 
instrument.

Staff labels for grids use a 
smaller font and a different 
paragraph style than used 
for standard instrument staff 
labels.

Single-line instruments Multiple instrument names: 
one for each kit instrument, 
positioned beside the 
corresponding single-line 
staff.

Staff labels for single-line 
instruments use the same font 
and paragraph style as used 
for standard instrument staff 
labels.

You can change the player names, layout names, and instrument names of percussion kits in 
the same ways as for other players and instruments. However, to change the staff labels for 
percussion kits, you must change kit instrument names in different ways for percussion kits, 
depending on your percussion kit presentation type:

● 5-line staff: Open the Edit Instrument Names dialog from the Players panel in Setup mode, 
or use the Name field in the Edit Percussion Kit dialog, to change the name of the kit.

● Grid/Single-line instruments: Open the Edit Instrument Names dialog from inside the Edit 
Percussion Kit dialog in Setup mode to change the names of individual instruments.

The same instrument name fields and options are available for kit instruments as for standard 
pitched instruments.

RELATED LINKS
Edit Instrument Names dialog on page 132
Player, layout, and instrument names on page 129

Staff labels
Staff labels for percussion kits 

907
Dorico SE 3.5.12



Edit Percussion Kit dialog on page 109
Unpitched percussion on page 978
Changing the percussion kit presentation type on page 984

Staff labels on condensed staves
Staff labels on condensed staves must reflect all the players included on the staff. Dorico SE 
automatically consolidates similar instrument names in staff labels on condensed staves but 
always shows all the required player numbers.

On condensed staves containing different types of instruments, all required instrument names 
are shown.

Staff labels on condensed brass staves

Because condensing can change frequently, staff labels on condensed staves can vary from one 
system to another. The staff labels for condensed divisi staves reflect the divisions at the start of 
the system and show instrument names.

Dorico SE also shows player labels above/below condensed staves to identify the players to 
which notes on condensed staves belong, as condensing can change within a single system. For 
condensed divisi staves, Dorico SE shows the player labels “div.”, with any required qualifications, 
and your set unison indication where each division starts and ends respectively.

RELATED LINKS
Condensing on page 392

Staff labels
Staff labels on condensed staves 
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Staves

A staff is a line or group of lines on which musical notes are notated to indicate the pitch 
and rhythm of music. Pitched instruments use the traditional five-line staff and unpitched 
instruments often use a single-line staff.

Notes are positioned on the lines and in the spaces on five-line staves, and can also use ledger 
lines above/below the staff to represent pitches that cannot fit on the staff.

A phrase on a five-line staff The same phrase on a single-line staff

The pitch and register of notes on five-line staves are determined by clefs, which can also be 
combined with octave lines to indicate what pitches performers play.

On five-line staves for unpitched percussion instruments, the different staff positions correspond 
to different percussion instruments.

Because it is often necessary to have different staff sizes in different layouts depending on their 
type, such as having smaller staves in full score layouts than in part layouts, in Dorico SE you can 
change various aspects of staves in Setup > Layout Options.

RELATED LINKS
Page formatting on page 367
Clefs on page 616
Octave lines on page 622
Percussion kit presentation types on page 983
Hiding/Showing empty staves on page 373
Hiding/Showing blank staves after final flows on page 375
System dividers on page 911
System objects on page 913
System indents on page 914

Per-layout options for staves
You can change settings that affect the staves in each layout independently.

You can change the size of staves in each layout in the Space Size section of the Page Setup 
page in Setup > Layout Options.

You can change other aspects of staves on the Staves and Systems page in Layout Options. 
For example, you can change which staff labels are shown on systems, indent the first system of 
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each flow, and fix the number of bars included in each system. You can also select above which 
staves system objects appear, according to their instrument families.

NOTE

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

● System objects are only shown above bracketed groups in your project. If you have no 
brackets, system objects only appear at the top of systems.

You can show system dividers between systems when systems contain a minimum number of 
players. You can also change the appearance of system dividers.

RELATED LINKS
Page formatting on page 367
Staff size on page 382
System objects on page 913
Hiding/Showing empty staves on page 373
Brackets and braces on page 592

Extra staves
It is sometimes necessary to add extra staves to instruments, for example, to make complex 
contrapuntal music easier to read because it is spread out across more staves than usual for that 
instrument.

In Dorico SE, you cannot add extra staves. However, extra staves are shown if you import or open 
a project that contains them.

An extract of Debussy's piano prelude "Feuilles mortes" with three staves

RELATED LINKS
Ossia staves on page 911
Divisi on page 916
Voice-specific dynamics on page 637
Hiding/Showing empty staves on page 373

Staves
Extra staves 
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Ossia staves
Ossia staves are smaller staves shown above/below the main staff of an instrument. They are 
used to show alternative phrases that can be played instead of the original phrase, such as 
suggestions for ornaments, alternative notations from other sources, or an easier version.

In Dorico SE, you cannot add ossia staves. However, ossia staves are shown if you import or open 
a project that contains them.

An ossia staff below the left-hand piano staff shows an easier alternative

RELATED LINKS
Extra staves on page 910

System dividers
System dividers are used to clarify the separation of different systems when they appear on the 
same page. They are usually shown as two thick, parallel angled lines positioned to the left of 
initial barlines.

In Dorico SE, the outer edges of system dividers are aligned with the corresponding edges of 
music frames.

A system divider between two systems in a string quartet score

You can show system dividers in different circumstances and change their appearance in each 
layout independently.

Staves
Ossia staves 
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Hiding/Showing system dividers
You can change the circumstances in which system dividers are shown, including specifying the 
minimum number of players required to show them, in each layout independently. For example, 
if you only want to show system dividers between systems that contain different numbers of 
staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to show system dividers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the System Dividers section, choose one of the following options for Show system 
dividers:

● When number of staves differs

● When minimum number of players present

5. Optional: If you selected When minimum number of players present, change the value for 
Minimum number of players.

6. Click Apply, then Close.

RESULT
System dividers are shown between systems in all flows in the selected layouts that either 
contain the minimum number of players you set or contain different numbers of staves.

RELATED LINKS
Hiding/Showing empty staves on page 373

Changing the length of system dividers
You can change the length of system dividers in each layout independently, for example, if you 
want to show longer system dividers in layouts that show full staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to show system dividers.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the System Dividers section, choose one of the following options for Appearance:

● Default

● Long

● Extra long

5. Click Apply, then Close.

Staves
System dividers 
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System objects
System objects are items that apply to all staves in the system and appear in all layouts, but 
are not necessary to show on every staff in full score layouts. For example, tempo marks and 
rehearsal marks are important for all players to see in their parts, but would cause an orchestral 
full score to appear very cluttered if they were shown on every staff.

In Dorico SE, the following items are considered system objects:

● Rehearsal marks

● Repeat endings

● Repeat markers

● System text

● Tempo marks

● Time signatures shown above the staff

● Horizontal lines that apply to all staves

System objects automatically appear at least once in all layouts. You can show system objects 
at multiple positions in each system by showing them above multiple instrument families. For 
example, you might show them above the woodwind, brass, percussion, and string families. In 
an orchestral full score, this would ensure system objects are spread out evenly across the page, 
meaning no staff is very far from these important markings. You can also show rehearsal marks 
and repeat endings additionally below the bottom staff.

NOTE

● System objects are only shown above instrument families that are bracketed or braced 
together. You can change bracket grouping in each layout independently.

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

RELATED LINKS
Changing bracket grouping according to ensemble type on page 593
Brackets and braces on page 592
Rehearsal marks on page 839
Tempo marks on page 926
Repeat endings on page 853
Large time signatures on page 954
Inputting text on page 307

Changing the positions of system objects
You can show system objects above different instrument families in each layout independently. 
Multiple items are categorized as system objects, including system text, rehearsal marks, tempo 
marks, repeat markers, and repeat endings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the instrument families 
above which system objects appear.

Staves
System objects 
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By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the System Objects section, activate the checkboxes for the instrument families above 
which you want system objects to appear.

5. Activate/Deactivate the following options for Also show below bottom staff:

● Repeat endings

● Rehearsal marks

6. Click Apply, then Close.

RESULT
System objects appear above the top staff in each bracketed group you select, provided a 
bracketed group for that instrument family is included in the selected layouts. If you activated 
options for Also show below bottom staff, the corresponding notations additionally appear 
below the bottom staff.

NOTE

System objects are only shown above instrument families that are bracketed or braced together. 
You can change bracket grouping in each layout independently.

RELATED LINKS
System objects on page 913

System indents
System indents control the distance between the left page margin and the start of systems of 
music. According to tradition, the first system in part layouts is indented, but in modern use this 
is not always necessary.

According to convention, coda sections at the start of new systems are also indented. Dorico SE 
uses the same gap size before the start of codas whether they occur partway through systems or 
at the start of a new system.

A violin part with the first system indented

In Dorico SE, system indents automatically adjust to accommodate staff labels. For example, if a 
system contains a staff label that is significantly longer than the minimum system indent, Dorico 
SE increases the indent on that system to ensure the staff label remains legible and is not cut off 
on the left edge or collides with the music.

Staves
System indents 
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You can change both the minimum indent on systems with staff labels and the first system 
indent in each layout independently. You can also adjust the system indent at both the start and 
end of individual systems, independently of your per-layout settings.

RELATED LINKS
Changing the minimum indent for systems with staff labels on page 904
Changing the horizontal justification of final systems on page 382

Changing the first system indent
By default in Dorico SE, the first system of each flow is indented in part layouts. You can change 
the indent for the first system of each in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose first system indent you want to change.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Staves and Systems in the category list.

4. In the Staff Labels section, change the value for Indent first system of flow by.

5. Click Apply, then Close.

RESULT
The indent of the first system of all flows is changed in the selected layouts.

Staves
System indents 
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Divisi

Divisi is when players split, or “divide”, in order to play multiple lines of music, commonly for a 
limited passage, before returning to play together, or “tutti”. Divisi passages can be notated with 
all lines on a single staff or across multiple staves.

Divisi is a technique most commonly used in orchestral string writing, as the string section 
typically contains a large number of players compared to the number of staves. For example, 
large orchestras commonly have twelve first violins all playing the same part most of the time. 
Dividing those players into multiple parts allows composers to write more complex contrapuntal 
music.

An example divisi change in a Violin I part, splitting it into two sections and a solo line

If the division is relatively simple, it is possible to write all parts on the same staff and label the 
section, with an indication of how many players are required for each line if necessary. If the 
parts have different rhythms at times, you can input them into separate voices on the same staff.

However, when a section is divided into multiple parts that are too different to be clearly written 
on a single staff, it is necessary to divide them onto multiple staves. In Dorico SE, divisi changes 
allow you not only to divide sections into any number of parts with any number of staves, but 
also to include solo lines and group staves as required.

In Dorico SE, you cannot input divisi changes. However, divisi changes are shown if you import or 
open a project that contains them.

RELATED LINKS
Extra staves on page 910
Inputting notes into multiple voices on page 174
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Tablature

Tablature is an alternative notation to the five-line staff, and is used for fretted instruments. On 
tablature, pitches are indicated by fret numbers positioned on lines, each of which represents a 
string on the instrument. As tablature is commonly used for guitars, it usually shows six lines.

An extract of guitar music shown on both a notation staff and tablature

In Dorico SE, you can show music for fretted instruments, such as the guitar or bass, on a regular 
notation staff and tablature together or only show one or the other. Notes and notations are 
linked between both presentations, meaning any changes you make to one, including inputting 
notes, automatically updates the other.

On tablature, ties are automatically notated as round brackets around the second note/chord 
and all subsequent notes/chords in tie chains.

Any notes beyond the range of the instrument or impossible to calculate, such as below the nut 
on the lowest string or a natural harmonic without a suitable node, are shown on tablature as 
pink question marks. If two notes are allocated to the same string at the same rhythmic position, 
both notes appear beside each other and are colored green.

Note on tablature that cannot be calculated

The appropriate tablature is automatically shown for instruments according to their strings and 
tuning settings. There are default tunings stored for each instrument type in Dorico SE, which 
you can customize in the Edit Strings and Tuning dialog.

RELATED LINKS
Hiding/Showing notation staves and tablature on page 918
Fretted instrument tuning on page 104
Edit Strings and Tuning dialog on page 116
Inputting notes on tablature on page 184
Harmonics on page 733
Guitar bends on page 768
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Guitar techniques on page 778
Ties on page 938
Trills on page 744

Rhythms on tablature
When notation staves and tablature are both shown, it is customary only to notate rhythms on 
the notation staff. However, when only tablature is shown, it is necessary to show rhythms on 
tablature.

The following items are shown to indicate rhythms on tablature:

● Time signatures

● Stems, stem flags, and beaming

● Rhythm dots

Rhythms shown on tablature

NOTE

Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Inputting notes on tablature on page 184

Hiding/Showing notation staves and tablature
You can show notation staves only, tablature only, or both in each layout independently and for 
each player holding at least one fretted instrument independently. For example, you can show 
only notation staves in the full score layout but the notation staff and tablature in a guitar part 
layout.

When tablature is shown, it can appear with or without rhythms.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tablature.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Fretted Instruments section, choose one of the following options for each player 
holding at least one fretted instrument in your project:

Tablature
Rhythms on tablature 
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● To show only notation staves and hide tablature, choose Notation only.

● To show both notation staves and tablature, choose Notation and tablature.

● To show only tablature and hide notation staves, choose Tablature only.

5. Optional: If you chose Notation and tablature or Tablature only, activate/deactivate Show 
rhythms in tablature.

6. Click Apply, then Close.

RESULT
Notation staves and tablature are hidden/shown for the corresponding players in the selected 
layouts.

If tablature is shown, it appears with rhythms when Show rhythms in tablature is activated, and 
without rhythms when it is deactivated.

EXAMPLE

Notation only Notation and 
tablature with 
rhythms

Notation and 
tablature without 
rhythms

Tablature only with 
rhythms

Tablature only 
without rhythms

RELATED LINKS
Players on page 94
Fretted instrument tuning on page 104
Inputting notes on tablature on page 184
Guitar bends on page 768
Guitar techniques on page 778

Changing the allocated string for notes on tablature
You can change the string to which individual notes are allocated on tablature manually, for 
example, if you input the notes on the notation staff and want to change their default string 
allocation.

NOTE

You cannot allocate notes to a string on which they are impossible, such as if the note is lower 
than the open pitch of the string.

PROCEDURE

1. On tablature, select the fret numbers of notes whose allocated string you want to change.

Tablature
Changing the allocated string for notes on tablature 
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NOTE

You must select fret numbers on tablature, you cannot select the notes on notation staves.

2. Change their allocated string in any of the following ways:

● To move them up a string, press N .

● To move them down a string, press M .

● In the Properties panel, select a string from the String menu in the Notes and Rests 
group.

RESULT
The string to which the selected notes are allocated is changed. Using the key commands 
changes the string of the selected notes proportionally, whereas selecting a string from the 
String menu allocates all selected notes to the selected string.

NOTE

● If they are now allocated to the same string as another note at that rhythmic position, both 
notes appear beside each other and are colored green.

● Deactivating the property resets the selected notes to their default string.

EXAMPLE

Default string allocation After changing the strings for some notes to reduce 
the distance between frets

RELATED LINKS
Inputting notes on tablature on page 184

Tablature
Changing the allocated string for notes on tablature 
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Stems

Stems are vertical lines that extend from noteheads that are a half note or shorter in duration. In 
combination with notehead design, they allow the duration of each note to be clearly identified.

For example, quarter notes (crotchets) and eighth notes (quavers) both have solid black 
noteheads and stems, but eighth notes also have flags on their stems. 16th notes have two 
flags, 32nd notes have three flags, and so on. The length of stems is determined by default in 
Dorico SE, so stems automatically adjust their length to accommodate more/fewer flags.

Notes with stems, ranging from a half note (minim) on the left to a 128th note on the right

The stems of notes and chords can point upwards/downwards, depending on the conventions of 
music engraving and the context of the music. For example, in choral music on two staves, stems 
in the soprano and tenor lines point up, and stems in the alto and bass lines point down.

RELATED LINKS
Stem length on page 925
Altered unisons on page 544

Stem direction
In Dorico SE, the stem direction of notes and chords follows rules that are based on the 
conventions of music engraving.

Stem direction is determined automatically, but you can manually change the stem direction of 
individual notes, chords, or of an entire voice. The rules that are applied depend on the following:

● How many voices are active on the staff.

● Whether notes, chords, or beamed groups of notes are affected.

● Whether notes in the same chord or notes in the same beamed group are split between 
staves.

Single notes in single voices

On a five-line staff with only a single voice active, the default stem direction of a single note is 
determined by its staff position.

● If the note is above the middle line, its stem points downwards.

● If the note is below the middle line, its stem points upwards.

● If the note is on the middle line of the staff, its stem direction is determined by the stem 
directions of any adjacent notes, beam groups, or chords. If they both have the same 
stem direction, the note matches them. If the adjacent notes, beam groups, or chords have 
different stem directions, or if there are no adjacent notes, beam groups, or chords, the note 
follows the default stem direction.
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The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

Notes on the middle line are stem up because the 
fourth note is stem up

Notes on the middle line are stem down because the 
fourth note is stem down

By default, notes are first input into an up-stem voice, and Dorico SE treats notes as the only 
voice on the staff until you input more voices.

Single notes in multiple voices

When there are multiple voices on a staff and all voices contain notes, the stem direction of notes 
is determined by the stem direction of their voice. Notes in up-stem voices have up stems, and 
notes in down-stem voices have down stems. This applies even when the stems of notes would 
normally point in the other direction, based on their position on the staff.

NOTE

The order in which notes appear between different up-stem voices and different down-stem 
voices depends on their pitch. You can also change the voice column index of notes individually.

When there are only notes in one voice for at least a whole bar, Dorico SE automatically changes 
the directions of stems so they point in the default direction for their pitch. For example, if a 
staff contains a single up-stem voice and a single down-stem voice but only the down-stem voice 
contains notes or rests, then the stems of notes in the down-stem voice may point upwards, 
depending on the position of the notes on the staff. However, showing rests or implicit rests in 
empty voices forces the stem direction of notes to follow the stem direction of their voice.

Notes in an up-stem voice shown 
in blue.

Notes in a down-stem voice 
shown in purple. The stems point 
upwards despite being in a down-
stem voice because there are no 
other voices.

When notes in up-stem and down-
stem voices are in the same bar, 
the stem direction is automatically 
changed.

Chords in single voices

The stem direction for a chord in a single voice is determined by the balance of notes above/
below the middle line of the staff.

● If the note furthest from the middle line is above the middle line, the stem of the chord 
points downwards.

● If the note furthest from the middle line is below the middle line, the stem of the chord 
points upwards.

● If the chord is equally balanced on either side of the middle line of the staff, the stem 
direction is determined by the stem directions of any adjacent notes, beam groups, or 

Stems
Stem direction 
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chords. If they both have the same stem direction, the chord matches them. If the adjacent 
notes, beam groups, or chords have different stem directions, equally balanced chords 
follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

Beam groups in single voices

The stem direction within beam groups is determined by the balance of notes within the beam 
group that are above/below the middle line of the staff.

● If the majority of notes in the beam group are above the middle line, stems in the beam 
group point downwards.

● If the majority of notes in the beam group are below the middle line, stems in the beam 
group point upwards.

● If the beam group contains an equal number of notes either side of the middle line of the 
staff, the stem direction is determined by the stem directions of any adjacent notes, beam 
groups, or chords. If they both have the same stem direction, the beam group matches 
them. If the adjacent notes, beam groups, or chords have different stem directions, equally 
balanced beam groups follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

RELATED LINKS
Voice column index on page 999
Implicit rests in multiple-voice contexts on page 881
Note positions in multiple-voice contexts on page 998
Changing the default stem direction of voices on page 924
Removing stem direction changes on page 925
Altered unisons on page 544

Changing the stem direction of notes
You can manually change the stem direction of any note. You can do this for the current layout 
and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose stem direction you want to change.

NOTE

You can only select whole tie chains, and changing the stem direction only affects the first 
note in the tie chain.

2. Change the stem direction in one of the following ways:

● Choose Edit > Stem > Force Stem Up.

● Choose Edit > Stem > Force Stem Down.

Stems
Stem direction 

923
Dorico SE 3.5.12



TIP

You can also choose these options from the context menu.

RESULT
The stem direction of the selected notes is changed. The selected notes follow this stem 
direction, even if you later change their pitch to one that usually requires a different stem 
direction. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

NOTE

● This does not change the voice to which notes belong.

● You can also change the stem direction of notes by selecting them and pressing F .

EXAMPLE

Stems pointing in the same direction but in different 
voices

Stems in the same direction and in the same voice

RELATED LINKS
Changing the voice of existing notes on page 353
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the default stem direction of voices
You can change the default stem direction of voices after they have been input, including slash 
voices.

NOTE

This changes the implicit stem direction of the voice, but may not change the stem direction of all 
notes in single-voice contexts. Stem directions are automatically changed in Dorico SE when only 
one voice contains notes.

PROCEDURE

1. Select a note or chord in the voice whose stem direction you want to change.

2. Change the default stem direction of the selected voice in one of the following ways:

● Choose Edit > Voices > Default Stems Down.

● Choose Edit > Voices > Default Stems Up.

Stems
Stem direction 
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TIP

You can also choose these options from the context menu.

RELATED LINKS
Stem direction on page 921

Removing stem direction changes
You can remove changes to the directions of stems and revert stems to their default directions.

PROCEDURE

1. Select the notes whose stem direction changes you want to remove.

2. Choose Edit > Stem > Remove Forced Stem. You can also choose this option from the 
context menu.

RESULT
All stem direction changes are removed from the selected notes. The stems of the selected notes 
revert to their default directions.

NOTE

Alternatively, you can change the stem direction to the opposite direction. However, notes with 
forced stems do not change automatically if, for example, you later change their pitch.

RELATED LINKS
Changing the stem direction of notes on page 923

Stem length
The length of stems is determined by default in Dorico SE, according to accepted standards for 
the appearance of stems of notes at different positions on staves.

Stems
Stem length 
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Tempo marks

Tempo marks indicate how fast music is played, often with a combination of text instructions and 
metronome marks. They are also known as “tempo changes”, “tempo indications”, and “tempo 
markings”.

A tempo mark can show text instructions, a metronome mark, or a combination of the two.

Tempo mark containing text instruction in French and metronome mark

Text instructions are traditionally expressed in Italian, such as largo or allegretto, but other 
languages, such as English, French, and German, have become widely accepted. The text 
instruction can express simply how fast the music is played, but can also suggest its character. 
For example, grave means slow but also solemn and sad, and vivo means fast but also lively and 
sprightly.

Metronome marks show the speed of the music, indicated in beats per minute, or “bpm”. 
Metronome marks can show a fixed bpm or indicate a range of possible or acceptable values.

Gradual tempo changes indicate a change in tempo over a defined period of time. They can 
appear differently, for example, with/without a continuation line or with the text split into 
syllables and spread across their duration.

Tempo marks use a bold font with a large point size, so they are clearly noticeable on the page. 
They do not usually use an italic font.

In Dorico SE, tempo marks are categorized as system objects. Therefore, tempo marks follow 
your per-layout settings for the visibility and positioning of system objects, which you can change 
on the Staves and Systems page in Setup > Layout Options.

By default, the tempo marks you input set the tempo for playback and MIDI recording, but 
you can change the tempo mode if, for example, you want to use a single fixed tempo when 
recording MIDI. Gradual tempo changes also affect the playback tempo, and you can change the 
final tempo at the end of gradual tempo changes, for example, if you want to reach a specific 
bpm at the end. If you do not input any tempo marks into your project, the default playback 
tempo is 120 bpm.

RELATED LINKS
Metronome marks on page 932
Gradual tempo changes on page 935
Tempo mark components on page 927
Time track on page 447
Input methods for tempo marks on page 228
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Positions of tempo marks on page 929
System objects on page 913
Changing the positions of system objects on page 913
Changing the tempo mode on page 463

Types of tempo marks
Dorico SE groups tempo marks into different types according to their function and effect on the 
music.

The following tempo changes are available in the Tempo panel in Write mode, but you can also 
input all types of tempo changes using the tempo popover.

Absolute Tempo Change
Indicates a defined change in tempo, and is often shown with a metronome mark.

Gradual Tempo Change
Indicates a change in tempo over a defined period of time, such as rallentando (slowing 
down) or accelerando (speeding up).

Relative Tempo Change
Indicates a change in tempo that is relative to the previous tempo, such as mosso 
(movement).

Relative tempo changes often include modifiers that qualify the change, such as poco 
meno mosso (a little less movement), and are not defined by a metronome mark. You 
can, however, set a relative metronome mark change as a percentage of the previous 
metronome mark.

Reset Tempo
Returns the tempo to the previous tempo, such as A tempo, or a previously defined 
tempo, such as Tempo primo (return to the first tempo of the piece).

Tempo Equation
Indicates a change in the beat unit on which metronome marks are based. For 
example, if the time signature changes from 3/4 to 6/8, a tempo equation of = 
indicates the same metronome mark value that applied to the quarter note beat unit in 
3/4 now applies to the dotted quarter note beat unit in 6/8.

RELATED LINKS
Metronome marks on page 932
Gradual tempo changes on page 935
Tempo equations on page 937
Input methods for tempo marks on page 228
Tempo panel on page 231
Tempo popover on page 229

Tempo mark components
Tempo mark components include text, metronome marks, parentheses, and approximate 
indications. Tempo marks can include different components in different combinations, 
depending on your preference or the requirements for different projects.

You can activate properties that correspond to the different components in the Tempo group of 
the Properties panel. You can activate one or more of the following tempo mark properties in any 
combination for individual absolute tempo changes:

Tempo marks
Types of tempo marks 

927
Dorico SE 3.5.12



Text shown
Shows text when activated, and no text when deactivated.

Metronome mark shown
Shows metronome marks when activated, and no metronome marks when 
deactivated.

Parenthesized
Shows metronome marks in parentheses when activated, and without parentheses 
when deactivated. This also applies to approximate metronome marks.

Is approximate
Shows metronome marks as approximate when activated, and absolute when 
deactivated.

Approximate appearance
Allows you to choose how approximate metronome marks appear, for example, c. or 
circa.

NOTE

This property applies specifically to approximate tempo marks, and is only available 
when Is approximate is activated.

Show equals sign
An equals sign is shown when the property and its corresponding checkbox are both 
activated. No equals sign is shown when the checkbox is deactivated.

NOTE

This property applies specifically to approximate tempo marks, and is only available 
when Is approximate is activated.

Components for gradual tempo changes

The following components only apply to gradual tempo changes, such as rallentando:

Poco a poco
Poco a poco text is shown immediately after gradual tempo change text when the 
checkbox beside the property is activated.

RELATED LINKS
Changing tempo text on page 931
Hiding/Showing tempo marks on page 932
Time track on page 447

Changing the type and appearance of absolute tempo changes
You can change which components are included in individual absolute tempo changes, and how 
they appear.

PROCEDURE

1. Select the absolute tempo marks whose components you want to change.

2. In the Properties panel, activate any of the following properties in the Tempo group:

● Text shown

Tempo marks
Tempo mark components 
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● Metronome mark shown

● Parenthesized

● Is approximate

● Approximate appearance (only available if Is approximate is activated)

● Show equals sign (only available if Is approximate is activated)

RESULT
The selected tempo marks are changed to include the corresponding components.

NOTE

If you have activated none of these properties, no tempo mark is shown in the music. Instead, a 
signpost indicates the position of the tempo mark.

Adding poco a poco text to gradual tempo changes
You can add poco a poco text immediately after individual gradual tempo changes.

NOTE

You can also enter poco a poco directly into the tempo popover. However, this means the entry 
is treated as a tempo mark rather than a gradual tempo change, which changes the properties 
you can use on it.

PROCEDURE

1. Select the gradual tempo changes to which you want to add poco a poco text.

2. In the Properties panel, activate Poco a poco in the Tempo group.

RESULT
Poco a poco text is shown immediately after the text in the selected gradual tempo changes.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
tempo changes.

EXAMPLE

Rallentando with poco a poco text

Positions of tempo marks
Tempo marks are placed above the staff and at the same positions as other system objects, 
because they usually apply to all staves. They are placed above notations such as slurs, ties, and 
octave lines, and are often aligned with rehearsal marks to ensure clear readability.

Tempo marks should be aligned with either a time signature or the notehead/rest at the 
rhythmic position to which they apply. For example, if there is a notehead with an accidental 

Tempo marks
Positions of tempo marks 
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at the rhythmic position of a tempo mark, it is convention to align the tempo mark with the 
accidental.

If a repeat mark occurs mid-system and is not treated as a barline, tempo marks are aligned with 
the repeat mark.

When a tempo mark includes both text and a metronome mark, the text appears first, followed 
by the metronome mark. When horizontal space is tight, the metronome mark can be positioned 
below the tempo mark text.

You can move tempo marks to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Tempo marks are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently, for example, if you want tempo marks to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
System objects on page 913
Changing the positions of system objects on page 913

Moving tempo marks rhythmically
You can move tempo marks to new rhythmic positions after they have been input.

PROCEDURE

1. In Write mode, select the tempo marks you want to move.

NOTE

When using the mouse, you can only move one tempo mark at a time.

2. Move the tempo marks according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

● Click and drag the tempo mark to the right/left.

RESULT
The selected tempo marks are moved to new rhythmic positions.

NOTE

Only one tempo mark can exist at each rhythmic position. If a tempo mark in your selection 
passes over another tempo mark as part of its move, the existing tempo mark is deleted.

You can undo this action, but any tempo marks deleted in the process are only restored if you 
moved the tempo mark using the keyboard.

RELATED LINKS
Lengthening/Shortening gradual tempo changes on page 935

Tempo marks
Positions of tempo marks 
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Changing tempo text
You can change the text of existing tempo marks individually.

PROCEDURE

1. Select the tempo marks whose tempo text you want to change.

2. In the Properties panel, enter the tempo text you want into the Text field in the Tempo 
group.

3. Press Return .

RESULT
The tempo text for the selected tempo marks is changed.

TIP

You can also change the tempo text by opening the tempo popover and changing the entry.

RELATED LINKS
Tempo popover on page 229
Changing existing items on page 342
Tempo mark components on page 927

Showing abbreviated tempo text
You can show individual tempo marks with custom abbreviated text in some layouts, for 
example, if a long tempo mark extends beyond the page boundary in some part layouts but 
the abbreviated version fits within the boundary.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to show abbreviated tempo text.

2. Select the tempo marks you want to show with abbreviated text.

3. In the Properties panel, activate Abbreviation in the Tempo group.

4. Enter the text you want into the value field.

5. Activate Abbreviate in the Tempo group.

6. Activate the corresponding checkbox.

RESULT
The selected tempo marks appear with abbreviated text when Abbreviation is activated and 
Abbreviate is deactivated, or when Abbreviation and both Abbreviate and its corresponding 
checkbox are all activated. This allows you to switch between showing abbreviated/full text in 
different layouts without deleting your abbreviated text from the Abbreviation value field.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Tempo marks
Changing tempo text 
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Hiding/Showing tempo marks
You can hide/show the different components in individual tempo marks without changing the 
speed of playback. This affects their appearance in all layouts.

PROCEDURE

1. Select the tempo marks you want to hide, or the signposts of tempo marks you want to 
show.

2. In the Properties panel, activate/deactivate the following properties in the Tempo group:

● Text shown

● Metronome mark shown

RESULT
When at least one of the properties is activated, the selected tempo marks are shown. They 
display components according to the properties that are activated.

When neither property is activated, the selected tempo marks are hidden. Signposts are shown 
at the position of each hidden tempo mark as they still affect the speed of playback.

RELATED LINKS
Changing the type and appearance of absolute tempo changes on page 928
Signposts on page 349

Deleting tempo marks
You can delete tempo marks, which resets the tempo for playback to the previous tempo mark or 
the default tempo if there is no previous tempo mark.

PROCEDURE

1. In Write mode, select the tempo marks or the signposts of tempo marks you want to delete.

2. Press Backspace or Delete .

RESULT
The selected tempo marks are deleted and no longer appear in the music area or in the Time 
track in Play mode. The tempo in playback follows the previous tempo mark, or the default 
tempo of 120 bpm if there is no previous tempo mark.

If you delete a tempo mark that truncated the line of a gradual tempo change, the line of the 
gradual tempo change automatically extends to its full length or until the next existing tempo 
mark.

Metronome marks
Tempo marks often include a metronome mark value. Metronome marks show the speed of the 
music, indicated in beats per minute, or “bpm”. For example, a bpm of 60 means one beat per 
second. The more beats per minute, the faster the music.

A metronome mark shown as a range

Tempo marks
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Metronome marks can be precise, such as  = 176, or can indicate an acceptable range, such as 
 = 152-176. They can also be shown in parentheses, which is useful if the metronome mark is 
intended as a guide rather than a fixed value.

By default, metronome marks appear as integers and do not show decimal places. If you input 
a metronome mark with a decimal place, it is rounded to the nearest integer. Metronome marks 
that you input in the Time track in Play mode appear as signposts by default.

The beat unit used in metronome marks commonly relates to the meter, for example, the 
metronome mark beat unit is often a quarter note in 4/4 but a dotted quarter note in 6/8.

In Dorico SE, metronome marks can appear as an individual value or as a range. Depending on 
the type and appearance of metronome marks, the bpm value can indicate a fixed tempo or an 
approximate tempo.

RELATED LINKS
Input methods for tempo marks on page 228
Changing the type and appearance of absolute tempo changes on page 928
Tempo mark components on page 927
Time track on page 447

Changing the metronome mark value
You can change the metronome mark value of individual absolute tempo marks after they have 
been input, including changing the beat unit.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to change.

2. In the Properties panel, change the value for Tempo (bpm) in the Tempo group.

3. Press Return .

4. Choose the appropriate note duration and rhythm dot, if applicable, for Beat unit.

RESULT
The metronome mark value and beat unit is changed for the selected absolute tempo marks. 
This affects the tempo of playback, even if no metronome mark component is shown for those 
tempo marks.

NOTE

● By default, any decimals you enter are hidden and the displayed metronome mark value 
appears as the nearest integer. However, metronome marks always reflect their exact values 
in playback.

● You can also change the metronome mark value by opening the tempo popover and 
changing the entry.

RELATED LINKS
Tempo popover on page 229
Changing existing items on page 342

Tempo marks
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Showing the metronome mark value as a range
You can show the metronome mark value of individual absolute tempo marks as a range. 
For example, you can use this to indicate that any speed within the given range is musically 
appropriate for the piece.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to show as a 
range.

2. In the Properties panel, activate Tempo range (bpm) in the Tempo group.

3. Change the value in the value field.

RESULT
The tempo range, expressed as beats per minute, is changed for the selected tempo marks. By 
default, metronome mark ranges use a dash separator.

NOTE

Depending on the values set for each property, both Tempo (bpm) and Tempo range (bpm) can 
be the minimum/maximum tempo in the range, as Dorico SE automatically arranges metronome 
mark ranges with the lower value first. However, the metronome mark used for playback is 
always Tempo (bpm), regardless of whether that is the higher/lower value in the range.

Changing the relative tempo mark value
You can change the tempo of individual relative tempo marks, expressed as a percentage of the 
previous tempo mark.

PROCEDURE

1. Select the relative tempo marks whose value you want to change.

2. In the Properties panel, change the value for Relative % in the Tempo group.

3. Press Return .

RESULT
The tempo at the relative tempo mark is changed. For example, if the previous tempo was 
100 bpm, and you change a relative tempo mark to 90, the new tempo is 90% of 100 bpm, which 
is 90 bpm.

Changing the final tempo at the end of gradual tempo changes
You can change how significantly gradual tempo changes affect the tempo in playback, 
expressed as a percentage of the tempo at the start of the gradual tempo change.

PROCEDURE

1. Select the gradual tempo changes whose final tempo you want to change.

2. In the Properties panel, change the value for Final tempo % in the Tempo group.

Tempo marks
Metronome marks 

934
Dorico SE 3.5.12



3. Press Return .

RESULT
The final tempo at the end of the selected gradual tempo changes is changed.

For example, if you change the value to 20 on a gradual tempo change that started at 100 bpm, 
the final tempo is 20% of 100 bpm, which is 20 bpm. If you change the value to 120 on a gradual 
tempo change that started at 100 bpm, the final tempo is 120% of 100 bpm, which is 120 bpm.

Gradual tempo changes
Gradual tempo changes indicate a change in tempo over a defined period of time, such as 
rallentando, which indicates slowing down, and accelerando, which indicates speeding up.

Rallentando with dashed line

Gradual tempo changes are considered a type of tempo mark in Dorico SE, meaning you can 
input them in the same ways as for tempo marks.

Because gradual tempo changes have a different metronome mark value at the start/end, you 
can change the final tempo at the end of individual gradual tempo changes.

In Dorico SE, you can show gradual tempo changes with different styles, such as with a 
continuation line or with syllables spread across their duration. You can also show gradual tempo 
changes with different line styles, such as dotted or dashed.

RELATED LINKS
Input methods for tempo marks on page 228
Changing the line style of gradual tempo changes on page 937
Changing the final tempo at the end of gradual tempo changes on page 934

Lengthening/Shortening gradual tempo changes
You can lengthen/shorten gradual tempo changes rhythmically after they have been input.

PROCEDURE

1. In Write mode, select the gradual tempo changes you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one gradual tempo change at a time.

2. Lengthen/Shorten the gradual tempo changes in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

Tempo marks
Gradual tempo changes 
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NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The selected gradual tempo changes are lengthened/shortened according to the current 
rhythmic grid resolution.

Changing the style of gradual tempo changes
You can change the style of individual gradual tempo changes. Gradual tempo changes can 
appear as text only with no continuation line, text with a continuation line, or with the word 
spread across their duration.

PROCEDURE

1. Select the gradual tempo changes whose style you want to change.

2. In the Properties panel, activate Gradual style in the Tempo group.

3. Select one of the following options from the menu:

● rit.

● rit...

● rit-e-nu-to

RESULT
The style of the selected gradual tempo changes is changed.

NOTE

Only gradual tempo changes with valid full text appear separated into syllables, for example, 
ritenuto or accelerando. Gradual tempo changes automatically have valid full text when you input 
them using the panel or select a suggested entry from the menu when using the popover. You 
can also change the text of existing gradual tempo changes, including adding hyphens manually 
to control how they are separated into syllables.

EXAMPLE

rit.: Text only rit...: Text with a continuation line rit-e-nu-to: Syllables in the text 
spread across the duration of the 
gradual tempo change

RELATED LINKS
Input methods for tempo marks on page 228
Changing tempo text on page 931

Tempo marks
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Changing the line style of gradual tempo changes
You can change the line style of individual gradual tempo changes whose style includes a 
continuation line.

NOTE

This does not affect the appearance of gradual tempo changes with the text-only style.

PROCEDURE

1. Select the gradual tempo changes whose line style you want to change.

2. In the Properties panel, activate Line style in the Tempo group.

3. Select one of the following options from the menu:

● Solid

● Dotted

● Dashed

RESULT
The line style of the selected gradual tempo changes is changed.

Tempo equations
Tempo equations indicate a change in the beat unit on which metronome marks are based. They 
are often used to maintain a consistent pulse across multiple different meters.

For example, if the time signature changes from 6/8 to 3/4, a tempo equation of  = indicates the 
same metronome mark value that applied to the dotted quarter note beat unit in 6/8 now applies 
to the quarter note beat unit in 3/4.

RELATED LINKS
Input methods for tempo marks on page 228

Tempo marks
Tempo equations 
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Ties

A tie is a curved line that joins two notes of the same pitch. When notes are longer than the 
maximum duration of a bar in the prevailing time signature, they automatically appear in Dorico 
SE as tie chains, that is, a sequence of adjacent notes joined with ties.

Each sequence of ties, whether they join two notes or ten notes together, represents a single 
note with the duration of all the tied notes combined. A performer plays the notes as one note, 
without re-striking, re-blowing, or re-bowing the note at any point within the rhythmic duration 
of the tie chain.

A tie chain across several bars on the bottom piano staff

On tablature, ties are automatically notated as round brackets around notes/chords in 
subsequent bars. When tablature is shown with rhythms, ties within the same bar are indicated 
with stems rather than bracketed noteheads.

A phrase on tablature with some ties within bars and 
a chord tied across two bars

The same phrase on a notation staff

In Dorico SE, most ties are created automatically. Rhythms are notated according to the 
prevailing beat grouping, which is normally set by the time signature. Therefore, notes that 
cannot be notated using a single duration are automatically drawn as tie chains. For example, 
if you input a dotted whole note at the start of a bar in a 4/4 time signature, it is automatically 
notated as a whole note tied to a half note in the next bar. If the time signature changes, tie 
chains are automatically adjusted to remain correct in the new meter.

NOTE

● In Write mode, you can only select whole tie chains because Dorico SE considers each tie 
chain to be a single note. Any edits you make to tie chains in Write mode affect all notes in 
them, such as changing the pitch, but only affect the first tie in the chain, such as changing 
the tie style to dashed. However, you can still input notations, such as dynamics, in the 
middle of tie chains by activating the caret and moving it to the required rhythmic position 
within the tie chain.

● When you tie existing notes together, they might be consolidated into fewer or more notes 
within a tie chain, depending on the musical context, the time signature, and the position of 
the start of the note in the bar.
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● Articulations can only appear once on each tie chain, either at the start or the end, 
depending on the type of articulation. For example, staccato marks appear at the end 
whereas accents appear at the start. You can change the positions of articulations relative to 
individual tie chains.

RELATED LINKS
Note and rest grouping on page 590
Beam grouping according to meters on page 575
Inputting notes on page 161
Forcing the duration of notes/rests on page 171
Inputting ties on page 189
Splitting tie chains on page 947
Time signatures on page 949
Input methods for time signatures and pick-up bars on page 220
Notes on page 718
Positions of articulations on page 548
Changing the positions of articulations on tie chains on page 550
Bracketed noteheads on page 728
Tablature on page 917
Hiding/Showing notation staves and tablature on page 918
Caret on page 157
Moving the caret manually on page 161

General placement conventions for ties
Ties join two noteheads together, meaning the ends of ties are positioned close to the noteheads 
to which they are attached.

Ties are curved lines, and the direction of the curve usually follows the stem direction of the 
notes. If notes are stem-up, ties curve downwards, and if notes are stem-down, ties curve 
upwards.

NOTE

If there are multiple voices on the staff, all ties in up-stem voices curve upwards and all ties in 
down-stem voices curve downwards.

There are two main conventions for the placement of the ends of ties relative to noteheads. One 
convention is to place the ends of ties outside noteheads, meaning above or below them, ideally 
positioned at the horizontal center of noteheads. The other convention is to place the ends of 
ties between noteheads, ideally positioned at the vertical center of noteheads.

A tie outside noteheads A tie between noteheads

For both conventions, Dorico SE automatically positions the ends of ties as close as possible to 
the notes that they join while avoiding collisions with other notations.

Ties
General placement conventions for ties 
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The vertical placement of ties is also automatically adjusted in Dorico SE so that neither of the 
end points of ties, nor the apex of tie curves, starts or ends on a staff line. If this happens, it can 
cause the shape of ties to appear distorted, which makes the music harder to read.

To avoid this, Dorico SE changes the vertical position of ties slightly, and makes small changes 
to the curvature of ties. These changes are small, but the placement of ties is subtly different 
depending on the position of notes relative to staff lines.

A tie outside noteheads When transposed one note down, the tie appears 
with a steeper curve to avoid reaching its apex on 
the staff line.

A tie between noteheads, with the ends slightly 
above the vertical center of the noteheads to avoid 
the tie appearing too close to the staff line at its 
ends or apex.

When transposed up, the ends of the tie are now 
positioned at the vertical center of the notehead, as 
there is no staff line with which it could collide.

Wherever possible, clef changes should not be positioned in the middle of tie chains. Changing 
the clef changes the position of the tied note on the staff, which could easily cause a performer 
to misread the tie as a slur and play two different notes.

Ties can look distorted when they are very short, and can be overlooked.

NOTE

Slurs must not be confused with ties, which look superficially similar, but instead join notes of 
the same pitch to indicate that they are played as a single note. In that sense, ties are part of 
rhythmic notation, while slurs are considered articulation.

RELATED LINKS
Ties vs. slurs on page 940
Inputting ties on page 189
General placement conventions for clefs on page 617

Ties vs. slurs
Ties and slurs look superficially similar but differ in meaning.

Ties indicate that a note should not be re-struck. They are used to join notes of the same pitch 
together. For example, ties can be used to extend notes across multiple bars. Although multiple 
notes can be included in a single tie chain, each tie in the chain only joins one notehead to the 
next notehead on the staff.

Articulations on tied notes only affect the attack at the start of the tie chain and the release at the 
end of the tie chain.

Ties
Ties vs. slurs 
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Two long notes tied together Two phrases with slurs

Slurs indicate articulation, such as bowing or breathing, and normally group notes of different 
pitches together. Slurs can join two noteheads together with any number of pitches in between. 
They often indicate the shaping of phrases.

Slurs can also be used in conjunction with articulation. Unlike ties, articulation within slurs can 
affect the sound throughout the phrase. For example, staccato articulations on repeated notes of 
the same pitch within a slur indicate that notes should be played on a stringed instrument using 
the same bow direction, but stopping the bow between each note.

RELATED LINKS
Slurs on page 887
Inputting ties on page 189
Inputting slurs on page 211

Tie styles
There are different styles of ties available in Dorico SE, which you can use to indicate different 
meanings.

Solid
This is the default style for ties. Ties appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Ties appear as tapered dashed lines. Can be used to denote optional or suggested ties, 
for example, in vocal music where some verses have more syllables than others and 
therefore require more notes.

Dotted
Ties appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the tie. Can also be used to denote optional or suggested ties.

Half-dashed start
The first halves of ties appear as dashed lines, the second halves as solid lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Half-dashed end
The first halves of ties appear as solid lines, the second halves as dashed lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Ties
Tie styles 
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Editorial
Ties appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length. Used to show that ties were added by the editor and 
were not present in the source.

Changing the style of ties
You can change the style of individual ties. You can do this for the current layout and frame chain 
only or for all layouts and frame chains. By default, all ties are solid.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose style you want to change.

NOTE

You can only select whole tie chains, and any changes to tie chains only affect the first tie in 
the chain.

2. In the Properties panel, activate Style in the Ties group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected ties is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the size of dashes/dots in ties
You can change the size of the dashes/dots in dashed/dotted ties individually. You can do this for 
the current layout and frame chain only or for all layouts and frame chains.

NOTE

These steps only apply to dashed/dotted ties.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

Ties
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PROCEDURE

1. Select the dashed/dotted ties whose dash/dot size you want to change.

NOTE

You can only select whole tie chains, and any changes to tie chains only affect the first tie in 
the chain.

2. In the Properties panel, activate Dash/dot in the Ties group.

3. Change the value in the value field.

RESULT
Increasing the value makes dashes/dots bigger, decreasing the value makes dashes/dots 
smaller. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Tie curvature direction
The direction of tie curvatures is determined by the stem direction of the notes/chords at each 
end of the tie, the number of notes in chords at each end, and the number of voices on the staff.

Tied single notes in single-voice contexts

If a single voice is active and a tie joins two single notes, tie curvature direction is determined by 
the stem directions of the notes at either end of the tie.

● If the stem directions match, the tie curves away from the notes and is positioned on the 
notehead side.

● If the stem directions differ, the tie curves upwards by default.

Tied chords in single-voice contexts

If a tie joins two chords, the direction of the ties is determined by the number of tied notes in the 
chords.

● For an even number, the ties are equally split between curving towards the notehead end 
and curving towards the stem end.

● For an uneven number, the majority of ties curve towards the notehead end.

Tied notes in multiple-voice contexts

Ties are positioned on the stem side and are curved as follows:

● For up-stem voices, ties curve upwards.

● For down-stem voices, ties curve downwards.

● For overlapping/interlocking pitches in multiple voices, the rules for tied chords in single-
voice contexts apply. All notes in all voices are treated as if they belong to a single voice.

Ties
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Changing the curvature direction of ties
You can change the curvature direction of ties individually, including individual ties within tie 
chains. You can do this for the current layout and frame chain only or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose curvature direction you want to change.

NOTE

You can only select whole tie chains, and any changes to tie chains only affect the first tie in 
the chain.

2. In the Properties panel, activate Direction in the Ties group.

3. Choose one of the following options:

● Up 

● Down 

RESULT
The curvature direction of the selected ties is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Non-standard ties
Usually, ties join two notes of the same pitch in the same staff. However, ties can also cross 
system breaks and frame breaks, clef changes, or time signature changes. These types of ties are 
all positioned automatically in Dorico SE.

Ties can also join non-adjacent notes, notes in different voices, or notes in different staves 
together. In Dorico SE, you must input these types of ties manually.

Ties across system breaks and page breaks

The ends of ties that cross system breaks are automatically positioned in Dorico SE.

Their vertical position remains the same, as both ends are centered on the noteheads to which 
they are attached. Their behavior also remains the same, as selecting one note in a tie chain that 
crosses a system or frame break in Write mode selects all notes in the tie chain.

The horizontal space for the parts of ties shown to the left of notes at the start of new systems/
frames may not be sufficient to show an ideal tie curve.

Ties
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The start of a tie chain before a system break The end of the same tie chain after a system break

Tied notes with accidentals across system breaks and page breaks

The ends of ties for tied notes with accidentals across system breaks and page breaks are also 
automatically positioned.

As tied notes in Dorico SE are treated as one note notated to fit in time signatures, cautionary 
accidentals at the start of new systems/frames are not shown by default. If you choose to show 
accidentals beside notes in tie chains at the start of new systems/frames, the position of the 
notes is changed to accommodate accidentals. However, this automatic position might not leave 
sufficient room for the part of the tie to the left of the notes to be shown with an ideal curve.

The start of a tie chain before a system break The end of the same tie chain, with a cautionary 
accidental in parentheses

Ties across time signature changes

Ties are automatically positioned between notes that span a time signature change. If ties 
crossing a time signature change are joining notes in the middle of a staff, the top or bottom of 
time signature changes are partially obscured by the ties. However, as ties are curved, the time 
signature is unlikely to be completely obscured.

Ties across clef changes

Ties are automatically positioned between notes that span a change of clef. Ties across clef 
changes are not horizontal, as the same pitch is positioned differently in each clef.

The result of cross-clef ties is likely to be visually and musically confusing, as they can be misread 
as slurs. In this case, consider moving the change of clef to before/after the tied note.

Ties between non-adjacent notes

You can input ties between notes of the same pitch that are not directly beside each other and 
between grace notes and normal notes. This can be useful when inputting ties between multiple 
notes before a chord, for example.

Notes leading into a chord notated 
as a series of tied chords

Notes leading into a chord notated 
as tied non-adjacent notes

Multiple grace notes before a 
chord with ties between non-
adjacent notes
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Ties between different voices

You can input ties between notes of the same pitch in different voices belonging to the same 
instrument.

Ties between notes on different staves

You can input ties between notes of the same pitch in different staves belonging to the same 
instrument, such as the two staves of a piano.

Laissez vibrer ties

Laissez vibrer ties are short ties that indicate a note should be left to ring, and should not be 
stopped. They extend a small amount to the right of the note to which they apply, but do not 
connect to another note.

You can add laissez vibrer ties to any note.

RELATED LINKS
Inputting ties on page 189
Hiding/Showing or parenthesizing accidentals on page 542
Note spacing on page 406

Hiding/Showing laissez vibrer ties
You can add laissez vibrer ties to any note, for example, to specify which notes must not be 
stopped after being played but instead left to ring.

PROCEDURE

1. Select the notes on which you want to add a laissez vibrer tie.

2. In the Properties panel, activate/deactivate Laissez vibrer tie in the Notes and Rests group.

RESULT
Laissez vibrer ties are added to the selected notes when the property is activated, and are 
removed when the property is deactivated. Laissez vibrer ties are positioned automatically.

TIP

You can assign a key command for Toggle Laissez Vibrer Tie on the Key Commands page in 
Preferences.

EXAMPLE

Phrase without laissez vibrer ties Phrase with laissez vibrer ties
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Deleting ties
You can delete ties without deleting the notes to which they are attached.

NOTE

Deleting ties from tie chains removes all ties in the tie chain. If you want to remove single ties 
from longer tie chains, you can split the tie chain.

PROCEDURE

1. In Write mode, select the tie chains from which you want to delete all ties.

2. Press U .

RESULT
All ties in the selected tie chains are deleted. Notes previously in the tie chain remain at their 
rhythmic positions.

RELATED LINKS
Changing the duration of notes on page 170

Splitting tie chains
You can split tie chains at specified positions, for example, if you want to change the pitch 
halfway through a tie chain or delete individual ties within tie chains. This does not remove any 
other ties in the tie chain.

NOTE

If you want to split ties because Dorico SE notated notes differently than you expected, you can 
set custom beat groupings for individual time signatures.

PROCEDURE

1. In Write mode, double-click the staff where you want to split a tie chain to start note input at 
that position.

2. Optional: Move the caret to where you want to split the tie chain.

● To move the caret according to the current rhythmic grid resolution, Press 
Right Arrow / Left Arrow .

● To advance the caret to the next rhythmic position according to the note value currently 
selected, press Space .

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

3. Split the tie chain in any of the following ways:

● Press U

● In the Notes toolbox, click Scissors .

4. Optional: If you want to split the same tie chain in multiple places, move the caret to the next 
rhythmic position where you want to split the tie chain and repeat step 3.

5. Press Esc  or Return  to stop note input.
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RESULT
The tie chain is split at the caret position.

RELATED LINKS
Note and rest grouping on page 590
Beam grouping according to meters on page 575
Creating custom beat groupings for meters on page 590
Notes toolbox on page 144
Caret on page 157
Moving the caret manually on page 161
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Time signatures

Time signatures indicate the meter of music, and apply to all bars from where they first appear 
until a subsequent change of time signature. Meter describes the rhythmic pulse of music, and 
its division into beats and bars.

A time signature is made up of two parts: numerator on top, and denominator underneath. 
These are the same mathematical terms as are used for fractions due to their similar 
arrangement.

1 Numerator

Specifies the number of beats in each bar for the time signature. The duration of beats is 
specified by the denominator.

2 Denominator

Specifies the beat duration for the time signature. The denominator doubles for every 
halving of the beat duration: 1 is a whole note (breve), 2 is a half note (minim), 4 is a quarter 
note (crotchet) and so on.

For example, a 4/4 time signature tells you the bar is made up of four beats, and each of those 
beats is a quarter note in length. A time signature of 4/2 contains four half notes in each bar, and 
4/8 contains four eighth notes (quavers) in each bar. Both 3/4 and 6/8 contain six eighth notes, 
but it is understood that a 3/4 bar contains three quarter note beats, whereas a 6/8 bar contains 
two dotted quarter note beats.

Bars are rhythmic groups, divided according to the time signature, and they make following the 
music much more practical and easier to read. Notes are beamed differently in different time 
signatures for the same reasons.

By default, time signatures apply to all staves. However, there are certain situations, such as in 
polymetric music, where some parts require their own time signature, independently of the rest 
of the ensemble. You can input time signatures that apply to all staves or only apply to single 
staves in Dorico SE.

Time signatures apply until the next time signature change or the end of the flow, whichever 
comes first.

NOTE

● Beat lengths are fixed across all staves in your project, regardless of the time signature. For 
example, if you have a 2/4 time signature on one staff and a 6/8 time signature on another 
staff, then one quarter note in the 2/4 time signature equals one quarter note in the 6/8 time 
signature, meaning their barlines do not match.

● Dorico SE does not automatically add beats to fill bars when you input time signatures unless 
Insert mode is activated.
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A 5/8 time signature input before an existing 4/4 time signature without Insert mode activated, leaving 
only three eighth note beats in the second 5/8 bar.

RELATED LINKS
Time signature styles on page 956
Pick-up bars on page 953
Input methods for time signatures and pick-up bars on page 220
Beam grouping according to meters on page 575
Time Signatures (Meter) panel on page 222
Creating custom beat groupings for meters on page 590
Bars on page 553

General conventions for time signatures
Over time, the placement and appearance of time signatures has developed conventions 
to ensure that their notation is always understood. Dorico SE follows these conventions 
automatically.

Appearance conventions

Time signatures should fill the height of the staff. There is a risk they may not be noticed if they 
are smaller. The size of time signatures on staves with fewer than five lines should be the same 
as that of a time signature on an equivalent five-line staff.

Time signature on a five-line staff Time signature on a single-line staff

Time signatures use a unique, heavy font that ensures they stand out against staff lines, and are 
instantly recognizable.

For some types of music, particularly film music, it is typical to use large time signatures that 
span several staves.

Placement conventions

Time signatures should be shown at the start of a piece and at the start of subsequent 
movements, if applicable, even if the music carries straight on. They should be placed after clefs 
and key signatures.

If time signature changes occur during a piece or movement, it should be placed immediately 
after a barline to avoid causing the duration of the previous bar to be different than the previous 
time signature implies.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 220
Inputting notes in Insert mode on page 178
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Large time signatures on page 954
Changing the size and position of time signatures on page 955

Types of time signatures
There are different types of time signatures, which can indicate various and complex meters.

NOTE

Dorico SE uses the definitions for meters commonly used in American English. These definitions, 
such as which meters are considered simple and compound, might be different in other 
languages.

Simple
In simple time signatures, each beat is divided by two into equal groups of notes. 
Simple time signatures can be simple duple, such as 2/4, simple triple, such as 3/4, or 
simple quadruple, such as 4/4.

Compound
In compound time signatures, each beat is divided by three into equal groups of 
dotted notes, such as 6/8, which contains two dotted quarter note beats, or 9/4, which 
contains three dotted half note beats.

Irregular
Irregular time signatures, such as 5/4 or 7/8, cannot be subdivided into equal beat 
groups. Because the numerator is odd, these time signatures must be divided into 
unequal beat groups. For example, 5/4 usually contains a half note beat and a dotted 
half note beat.

Additive
Additive time signatures show how bars are subdivided into beat groups. You can show 
beat group numerators for any type of time signature. For example, instead of 7/8, you 
could show an additive time signature of 2+3+2/8.

Alternating
An alternating time signature indicates a regular pattern that switches every bar 
between two or more time signatures, in the indicated order. For example, for a phrase 
with twelve eighth notes that needs to be emphasized 3+3+2+2+2, an alternating time 
signature of 6/8+3/4 might allow the two meters to be read more clearly.

Time signatures
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Interchangeable
An interchangeable time signature indicates a set of time signatures at the start of 
the piece that can be used during the piece, such as 3/4–2/4. Unlike alternating time 
signatures, interchangeable time signatures do not require a fixed pattern; any bar in 
the piece can follow any of the time signatures in the set without having to restate the 
time signature.

NOTE

You must manually input the appropriate time signatures where you want them, 
as unlike alternating time signatures, there is no fixed pattern for them. Any time 
signatures you input that are specified in the interchangeable time signature are 
hidden automatically.

They can have different separator styles in Dorico SE, which you can change for 
individual time signatures.

Aggregate
An aggregate time signature shows two or more meters within the same bar, such as 
2/4+3/8+5/4. Dorico SE automatically shows dashed barlines to indicate the divisions 
between the different meters, but you can also specify that you do not want to show 
dashed barlines when you input aggregate time signatures with the popover.

Open
An open time signature has no restrictions on meter, beaming, or beats. Any number 
of notes can be added, with any beaming. For example, open time signatures might be 
used for cadenza passages.

Non-power of two
A non-power of two time signature is one such as 5/6, which indicates five sextuplet 
quarter notes (crotchets) where the sextuplet overall equals a whole note (semibreve). 
Examples of time signatures like this can be found in the music of Adès.

Some composers, such as Boulez, have written fractional time signatures. Dorico SE does not 
currently support these.

RELATED LINKS
Time signature styles on page 956
Large time signatures on page 954
Input methods for time signatures and pick-up bars on page 220
Time signatures popover on page 220
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Pick-up bars
Pick-up bars allow you to include music before the first full bar. They are also known as “upbeats” 
or an “anacrusis”. Often, pick-up bars only comprise a few beats whose main purpose is to lead in 
to the start of the piece.

Pick-up bar of a single quarter note beat at the start of Chopin's Mazurka Op. 30 No. 2

Pieces that start with a pick-up bar have time signatures that are positioned at the start of the 
system as normal. However, the first full bar of the time signature occurs after the first barline 
and not before. Therefore, pick-up bars do not contribute to the bar number count. Bar numbers 
are counted from the first full bar in the flow.

Because pick-up bars are linked to the number of notes/rests in the music, in Dorico SE they 
are linked to time signatures and so you must input pick-up bars as part of time signatures. 
However, you can hide time signatures you do not want to show in the music.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 220
Hiding/Showing time signatures on page 960
Bars on page 553
Bar numbers on page 563
Event display on page 418

Defining partial bars as pick-up bars or irregular bars
You can change whether explicit irregular bars at the start of time signatures are defined as 
pick-up bars. This affects how notes in the bars are beamed and grouped.

Notes in irregular bars defined as pick-up bars are beamed/grouped backwards from the end of 
the bar, while notes in irregular bars not defined as pick-up bars are beamed/grouped forwards 
from the start of the bar.

NOTE

You must input explicit irregular bars and pick-up bars as part of a time signature, such as by 
entering 4/4,1.5 into the time signatures popover to input a 4/4 time signature with a pick-up bar 
containing 1.5 quarter note beats, or three eighth notes.

PROCEDURE

1. Select the time signatures or the signposts of time signatures starting with an explicit 
irregular bar whose pick-up definition you want to change.

2. In the Properties panel, activate Group first bar as pick-up in the Time Signatures group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Irregular bars at the start of the selected time signatures are defined as pick-up bars when 
Group first bar as pick-up and its corresponding checkbox are both activated, and defined as 
normal irregular bars when the corresponding checkbox is deactivated.

When the property is deactivated, Dorico SE uses internal heuristics to define them as either 
pick-up bars or normal irregular bars automatically.

EXAMPLE

Irregular bar defined as pick-up into common time Irregular bar defined as normal irregular bar, not a 
pick-up

Large time signatures
Large time signatures are scaled-up time signatures that appear much larger than normal 
relative to the staff size. They can be helpful in orchestral scores, as the smaller staff size in 
such scores means standard time signatures are small and harder for conductors to read.

Large time signatures are also very commonly used in film scores, as conductors rarely have 
much time to prepare the scores before recording sessions. Having large time signatures makes 
changes in meter more visually clear on the page, especially when music contains multiple 
changes in meter.

In Dorico SE, you can show large time signatures at the following positions:

● Once per bracketed group

● Above the staff and at system object positions

Time signatures shown once per bracketed group

Instead of showing a time signature on every staff that is the same height as the staff, you can 
instead show a single large time signature on each bracketed group of staves. When shown once 
per bracketed group, time signatures are scaled up in size according to the number of staves in 
the bracketed group. The largest time signatures are shown on bracketed groups containing four 
or more staves. When shown on single staves, they extend a small amount above and below the 
staff, which is commonly used for parts for film music recording sessions.

Narrow, serif time signatures shown once per bracketed group

Time signatures
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Large time signatures shown on bracketed groups occupy horizontal space, which can be a 
significant amount when they are especially large and use the standard time signature design. 
Therefore, we recommend that you use one of the narrow designs in layouts that show large 
time signatures on bracketed groups.

Time signatures shown at system object positions

Similar to showing large time signatures once per bracketed group, you can also show time 
signatures only at system object positions and above the staff. Therefore, its positions in each 
system are controlled by the same options that control the positions of other system objects, 
such as rehearsal marks and tempo marks.

Normal time signatures shown at system object positions

Time signatures shown at system object positions do not occupy horizontal space, meaning it 
is less important to use a narrow font style. This also reduces the horizontal distance between 
notes either side of time signatures. Because of this reduced disruption to note spacing, this 
placement of time signatures has become popular in contemporary art music since the 20th 
Century.

When using the note denominator style for time signatures shown at system object positions, 
the note is shown to the right of the numerator rather than below.

By default, time signatures at system object positions are twice the size of normal time 
signatures and force other items at the same position to appear to the right.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 220
Changing the design of time signatures on page 961
System objects on page 913
Changing the positions of system objects on page 913
Hiding bar numbers at time signatures shown at system object positions on page 569

Changing the size and position of time signatures
You can change the size of time signatures in each layout independently, including changing 
their vertical position. For example, you can show large time signatures centered on each bracket 
in full score layouts but standard-sized time signatures on each staff in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the size of time 
signatures.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Time Signatures in the category list.

4. Choose one of the following options for Time signature position and size:
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● Show on every staff

● Show once per bracket

● Show at system object positions

5. Click Apply, then Close.

RESULT
The size and position of time signatures in the selected layouts is changed.

Showing large time signatures above the staff at system object positions means they do not 
occupy any rhythmic or horizontal space, whereas the other options do cause time signatures to 
occupy horizontal space.

RELATED LINKS
Large time signatures on page 954
Positions of time signatures on page 959
Hiding bar numbers at time signatures shown at system object positions on page 569

Time signature styles
Dorico SE allows you to show time signatures in a variety of styles. For example, you can show 
denominators as a number or as a note value.

Numerator styles
The numerator is always one or more numbers, and can either show the total number 
of beats in the bar as a single number, or show how the total duration of the bar is 
subdivided into beat groups.

Number numerator Beat group numerator

Denominator styles
The denominator can appear as a number, as a note indicating the equivalent 
duration, or not appear at all.

Number denominator Note denominator None denominator

Open meter styles
Open time signatures can be shown as an X, Penderecki’s symbol, or be hidden with no 
symbol. No symbol open time signatures are indicated by signposts.

Time signatures
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X open style Penderecki’s symbol open 
style

No symbol open style

Interchangeable time signature separator styles
Interchangeable time signatures can have different separator styles. You can specify 
the separator style when inputting interchangeable time signatures using the popover 
and for individual interchangeable time signatures after they have been input.

Parentheses separator Brackets separator Equals sign separator

Slash separator Space separator Hyphen separator

RELATED LINKS
Types of time signatures on page 951
Inputting time signatures with the popover on page 224
Time signatures popover on page 220
Changing the design of time signatures on page 961
Changing the open meter style of time signatures on page 958
Changing the separator style of interchangeable time signatures on page 958
Signposts on page 349

Changing the numerator style of time signatures
You can choose whether the numerators of individual time signatures show the total number of 
beats in each bar, or the subdivision of beats in each bar.

PROCEDURE

1. Select the time signatures whose numerator style you want to change.

2. In the Properties panel, activate Numerator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Beat group

RESULT
The numerator style of the selected time signatures is changed.

Changing the denominator style of time signatures
You can change the denominator style of individual time signatures, for example, if you want to 
show the denominator as a note instead of a number.
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PROCEDURE

1. Select the time signatures whose denominator style you want to change.

2. In the Properties panel, activate Denominator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Note

● None

RESULT
The denominator style of the selected time signatures is changed.

Changing the open meter style of time signatures
You can change the open meter style of individual time signatures.

PROCEDURE

1. Select the open meter time signatures whose style you want to change.

NOTE

In the Properties panel, Open style in the Time Signatures group is automatically activated 
for open meter time signatures.

2. In the Properties panel, choose one of the following options for Open style in the Time 
Signatures group:

● No symbol 

● X 

● Penderecki’s symbol 

RESULT
The open meter style of the selected time signatures is changed. No symbol open time 
signatures are indicated by signposts.

RELATED LINKS
Time signature styles on page 956
Signposts on page 349

Changing the separator style of interchangeable time signatures
You can change the separator shown in interchangeable time signatures individually.

PROCEDURE

1. Select the interchangeable time signatures whose separator you want to change.

NOTE

In the Properties panel, Separator in the Time Signatures group is automatically activated 
for interchangeable time signatures.

2. Select one of the following options from the Separator menu:
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● Parentheses 

● Brackets 

● Equals sign 

● Slash 

● Space 

● Hyphen 

RESULT
The separator style of the selected interchangeable time signatures is changed.

TIP

● You can specify the separator style when inputting interchangeable time signatures using 
the popover.

● Although they might look similar to interchangeable time signatures, aggregate time 
signatures behave differently. Aggregate time signatures are separated by a + sign, whereas 
interchangeable time signatures can be shown with six different separators but not a + sign.

Therefore, although you can activate Separator and choose from the available options for 
aggregate time signatures, the property only affects the appearance of interchangeable time 
signature separators.

RELATED LINKS
Time signature styles on page 956
Inputting time signatures with the popover on page 224
Time signatures popover on page 220

Positions of time signatures
Standard time signatures are positioned on staves with the middle staff line, or only staff line for 
single-line staves, passing through their center. Large time signatures can be positioned in the 
middle or at the top of bracket groups, or above staves at system object positions.

You can move time signatures to different rhythmic positions in Write mode. They move 
according to the current rhythmic grid resolution and are positioned automatically to avoid 
collisions.

You can also change the position of time signatures in each layout independently, for example, if 
you want to show time signatures above the staff and at system object positions in some layouts 
but only once per bracket in other layouts.

RELATED LINKS
System objects on page 913
Changing the positions of system objects on page 913
Changing the size and position of time signatures on page 955

Moving time signatures rhythmically
You can move time signatures to new rhythmic positions after they have been input.

NOTE

● You can only move time signatures rhythmically using the keyboard.

Time signatures
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● Time signatures can only be moved along staves. If you want to move a time signature 
across staves, you must delete the time signature and input a new time signature on the 
other staff.

PROCEDURE

1. In Write mode, select the time signatures you want to move.

2. Move the time signatures according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

RESULT
The time signature takes effect from its new rhythmic position until the next existing time 
signature, or the end of the flow. Barlines are automatically updated either side of the time 
signature up to the previous/next existing time signature, or the start/end of the flow.

NOTE

Only one time signature can exist at each rhythmic position, except for time signatures that only 
apply to single staves. If a time signature moves to the exact rhythmic position of another time 
signature as part of its move, the existing time signature is deleted.

You can undo this action which restores any time signatures deleted in the process.

Hiding/Showing time signatures
You can hide/show time signatures without deleting them from your project. This hides/shows 
them in all layouts, not just the one currently open in the music area.

PROCEDURE

1. Select the time signatures you want to hide, or the signposts of time signatures you want to 
show.

2. In the Properties panel, activate/deactivate Hide time signature in the Time Signatures 
group.

RESULT
The selected time signatures are hidden in all layouts when Hide time signature is activated, 
and shown when it is deactivated.

Signposts are shown at the position of each hidden time signature. However, signposts are not 
printed by default.

NOTE

● Hidden time signatures do not take up any horizontal space, so hiding/showing time 
signatures affects note spacing.

● You can hide/show time signature signposts by choosing View > Signposts > Time 
Signatures. Time signature signposts are shown when a tick appears beside Time 
Signatures in the menu, and hidden when no tick appears.

Time signatures
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You can choose to print time signature signposts if you activate View options in the 
Annotations section of the Print Options panel on the right of the window in Print mode.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text objects, 
and time signatures.

RELATED LINKS
Note spacing on page 406
Signposts on page 349
Input methods for time signatures and pick-up bars on page 220

Changing the design of time signatures
You can change the design of time signatures in each layout independently, including changing 
the font style used for them, for example, if you want to use a plain font for time signatures in 
full score layouts but the standard time signature font in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the design of time 
signatures.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Time Signatures in the category list.

4. Choose one of the following options for Time signature design:

● Normal

● Narrow, serif

● Narrow, sans serif

● Plain font

5. Click Apply, then Close.

RESULT
The design of time signatures in the selected layouts is changed. If you choose Plain font, time 
signatures use a different font style than the one used for the other options.

Deleting time signatures
You can delete time signatures without affecting the relative rhythmic positions of notes.

PROCEDURE

1. In Write mode, select one of the following:

● The time signatures you want to delete.

● The signposts of hidden time signatures you want to delete.

2. Press Backspace or Delete .

Time signatures
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RESULT
The time signatures are deleted from the score. Bars after their previous positions are re-barred 
according to the previous time signature in the score, up until the next time signature or the end 
of the flow.

If you delete the only time signature in the flow, your music appears in an open meter, but with 
all the same rhythmic values.

RELATED LINKS
Types of time signatures on page 951

Time signatures
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Tremolos

Tremolos are thick, slanted lines that cross individual stems or are positioned between multiple 
stems. They are used to indicate that notes are repeated, either individually or in sequences of 
multiple notes.

Using tremolo strokes instead of notating each notehead can save horizontal space and make 
fast passages easier to read.

The number of tremolo strokes indicates both how many times notes are repeated and how fast 
they are. In measured tremolos, for example, one tremolo stroke on the stem of a quarter note 
(crotchet) indicates two eighth notes (quavers) are played, whereas three tremolo strokes on the 
stem of a quarter note indicates eight 32nd notes are played.

Quarter note with a one-stroke single-note tremolo 
and its equivalent notation

Quarter note with a three-stroke single-note tremolo 
and its equivalent notation

There are different types of tremolos:

Single-note tremolos
Individual notes are repeated.

Multi-note tremolos
Multiple notes, usually two, are played in sequence, similar to a trill. However, trills 
usually indicate a fast alternation between two adjacent notes, such as G and A, 
whereas multi-note tremolos can be between any notes, limited only by the capabilities 
of the instrument.

Tuplet tremolos
Multiple notes in tuplets are repeat in the notated sequence.

Depending on the musical context, tremolos can be either measured or unmeasured. There is 
no visual difference between measured/unmeasured tremolos, so composers/arrangers often 
specify how they want tremolos to be played, such as an indication in the front matter of the 
score or as a text instruction in the score.
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Measured tremolos
The number of tremolo strokes corresponds to a precise rhythm in the prevailing 
tempo and meter.

Unmeasured tremolos
There is no link between the number of strokes and rhythm. Instead, unmeasured 
tremolos are played as fast as possible, whatever the tempo.

Unmeasured tremolos often use three or more tremolo strokes, and can also be 
accompanied by a “trem.” text indication.

RELATED LINKS
Input methods for repeats and tremolos on page 321

General placement conventions for tremolos
Single-note tremolos are positioned on note stems, whereas multi-note tremolos are positioned 
between the stems of two or more notes. When multi-note tremolos cross three or more notes, 
the tremolo strokes are positioned between all the notes.

Tremolo strokes are slightly thinner than beams, so that the gaps between strokes are large 
enough and the number of strokes can be instantly recognized.

Tremolo strokes should not collide with ledger lines or stem flags. Dorico SE automatically 
positions tremolo strokes to ensure such collisions are avoided.

Tremolo strokes within the staff are positioned so that they are at least one staff space clear of 
noteheads, and at valid positions relative to staff lines and staff spaces. This means that tremolo 
strokes might not move every time you change the pitch of notes.

The positions of the tremolo strokes on the first two notes and the last two notes are the same, although the 
pitches are all different.

In Dorico SE, the angle of single-note tremolo strokes is always the same, no matter the direction 
of the phrase. The angles of multi-note tremolo strokes are determined by the height of the 
stems to which the multi-note tremolos apply.

Tremolos in tie chains
By default, all notes in tie chains are shown with tremolo strokes when single-note tremolos are 
added to tie chains. Deleting tremolo strokes from tied notes removes tremolo strokes from all 
notes in tie chains.

In Dorico SE, tremolos are considered measured by default, so the number of tremolo strokes 
shown is automatically adjusted on subsequent notes in tie chains as required. For example, if 
an eighth note with two tremolo strokes is tied to a quarter note, the quarter note has three 
tremolo strokes. This is because tremolo strokes function like beams, so two tremolo strokes and 
an eighth note stem flag is the equivalent of three tremolo strokes.

Tremolos
General placement conventions for tremolos 
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Changing the speed of tremolos
You can change the speed of tremolos after they have been input by changing the number of 
strokes.

PROCEDURE

1. In Write mode, select the notes with tremolos whose speed you want to change.

The buttons with the number of tremolo strokes corresponding to your selection are 
highlighted in the Tremolos section of the Repeat Structures panel.

NOTE

Select single-note tremolos and multi-note tremolos separately.

2. Click the button with the number of tremolo strokes you want in the Tremolos section of the 
Repeat Structures panel.

For example, click Two Strokes Single-note Tremolo  to input single-note tremolos with 
two strokes, or click Three Strokes Multi-note Tremolo  to input multi-note tremolos with 
three strokes.

RESULT
The number of tremolo strokes on the selected notes is changed, which changes the speed of 
the tremolos.

Deleting tremolos
You can remove single-note tremolos and multi-note tremolos from notes separately without 
affecting the notes to which they applied.

PROCEDURE

1. In Write mode, select the notes whose tremolo strokes you want to delete.

2. Click the appropriate buttons in the Tremolos section of the Repeat Structures panel for the 
types of tremolos selected:

● Remove Single-note tremolo 

● Remove Multi-note tremolo 

RESULT
The corresponding types of tremolo strokes are deleted.

EXAMPLE

Notes with single-note tremolos 
and multi-note tremolo

Notes with multi-note tremolo 
deleted but single-note tremolos 
remain

Notes with both multi-note 
tremolo and single-note tremolos 
deleted

Tremolos
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Rhythmic positions of notes with tremolos
You can move notes with single-note tremolos and multi-note tremolos to new rhythmic 
positions in the same ways as normal notes. However, if you move multi-note tremolos across 
barlines, the tremolo strokes are deleted automatically.

You can move single-note tremolos to new rhythmic positions and across barlines without 
affecting their tremolo strokes. The notes are automatically respelled as tie chains if required 
by their new rhythmic positions and time signature, in the same ways as normal notes.

NOTE

If tie chains with single-note tremolos contain notes of different durations, the number of 
tremolo strokes on each note in the tie chain is different.

RELATED LINKS
Moving notes rhythmically on page 725

Tremolos
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Tuplets

Tuplets indicate where a beat is divided into a different number of subdivisions than is usually 
expected according to the current meter. They can be used to fit more notes or fewer notes in a 
beat than usually exist in a beat, according to the usual pattern of subdivision.

A 4/4 bar with the standard subdivision of four 
quarter notes

A 4/4 bar with a subdivision of six triplet quarter 
notes in the space of four regular quarter notes

A 6/8 bar with the standard subdivision of six eighth 
notes

A 6/8 bar with a subdivision of four duplet eighth 
notes in the space of six regular eighth notes

Because these subdivisions are not standard but tuplet notes use the same rhythmic notation as 
normal notes, tuplets must be clearly marked to show that their rhythmic duration is different.

In the examples, the triplet quarter notes are shown under a bracket with the number 3. The 
duplet eighth notes do not need a bracket as they are joined by a beam, which has a number 2 
above it.

Tuplets in Dorico SE can be shown with just a tuplet bracket, with a tuplet bracket and a tuplet 
number/ratio, or with a tuplet bracket, a tuplet number/ratio, and a note indicating the note 
value of the tuplet.

RELATED LINKS
Inputting tuplets on page 194
Tuplet brackets on page 973
Tuplet numbers/ratios on page 975

General placement conventions for tuplets
Tuplet brackets and tuplet numbers/ratios are generally placed on the stem side of notes. When 
tuplets are shown with a tuplet beam, a tuplet bracket is not always necessary but can be shown 
in addition to a tuplet number/ratio.

According to convention, tuplet brackets and tuplet numbers/ratios are always placed above the 
staff for vocal staves, so they do not come between notes and lyrics.

Tuplet brackets should be placed as close to notes as possible without colliding with other 
notation, such as slurs or articulation. Slurs are usually placed inside tuplet brackets if the slur is 
shorter than the tuplet bracket. If a slur is longer than a tuplet bracket, the slur can be placed 
outside the tuplet bracket.
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The horizontal position of tuplet brackets should allow it to be immediately obvious which notes 
are included in the bracket. They should not extend so far that notes following the tuplet appear 
to be included.

A tuplet clearly showing the three quarter notes 
included in the triplet.

With an extended tuplet bracket, the duration of the 
triplet is now unclear.

Nested tuplets
Nested tuplets are tuplets within larger tuplets that are often used to create complex rhythms. In 
Dorico SE, there is no limit to the number of levels you can have in nested tuplets.

EXAMPLE

Nested tuplets

Inputting nested tuplets
You can input nested tuplets in new, empty staves and you can select existing tuplets and input 
nested tuplets within them.

PROCEDURE

1. In Write mode, start note input.

2. Press ;  to open the tuplets popover.

3. Optional: If inputting nested tuplets in an empty staff, enter the ratio for the outer tuplet 
into the popover. For example, enter 3:2.

4. Optional: Press Return  to close the popover and enter the outer tuplet.

NOTE

You can skip steps 3 and 4 if you are inputting nested tuplets into existing tuplets.

5. Press ;  to open the tuplets popover again.

6. Enter the ratio for the inner tuplet into the popover. For example, enter 5:4.

7. Press Return  to close the popover and enter the inner tuplet.

8. Enter or play in the pitches you want.

9. Stop inputting nested tuplets in one of the following ways:

● Press :  once to stop the inner tuplet and continue inputting the outer tuplet.

● Press :  twice to stop both tuplets and return to inputting normal notes.

● Press Esc  to stop note input completely.

Tuplets
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● Move the caret with the arrow keys to return to inputting normal notes.

RESULT
The pitches you enter or play in are input as nested tuplets, starting from the caret position.

If multiples of the inner tuplet fit exactly inside the outer tuplet, you can continue inputting notes 
as the specified nested tuplet until you stop the tuplets manually.

If multiples of the inner tuplet do not fit exactly inside the outer tuplet, the inner tuplet stops 
automatically at the end of the last tuplet that fits in the outer tuplet. After that, the outer tuplet 
continues until you stop it manually.

NOTE

You can also input nested triplets by clicking Tuplets  in the Notes toolbox when the caret is 
within an existing tuplet. However, you can only input one nested triplet at a time this way.

Turning existing notes into tuplets
You can turn any existing notes into tuplets, for example, if you need to fit extra notes into an 
existing duration.

PROCEDURE

1. In Write mode, select the notes on a single staff that you want to turn into tuplets.

2. Press ;  to open the tuplets popover.

The popover is automatically populated with a suggested ratio based on your selection.

3. Optional: Change the ratio in the popover. For example, enter 3:2 to input triplets.

4. Press Return  to close the popover.

RESULT
The selected notes are turned into tuplets according to the ratio in the popover. For example, 
if you select five eighth notes and enter 5:4 into the popover, the selected notes become 
quintuplet eighth notes.

If the selected notes fit into a single tuplet of the specified ratio, only a single tuplet is created. 
If the selected notes do not fit into a single tuplet, as many tuplets as required are created 
automatically.

RELATED LINKS
Tuplets popover on page 195
Inputting tuplets on page 194

Turning tuplets into normal notes
You can turn any existing tuplets notes into normal notes, for example, if you want to turn tuplet 
eighth notes into standard eighth notes.

PROCEDURE

1. In Write mode, select just the brackets, numbers/ratios, or signposts of the tuplets you want 
to turn into normal notes.

Tuplets
Turning existing notes into tuplets 
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NOTE

You must not select any of the noteheads in the tuplets.

2. Optional: If you want to retain all notes in the selected tuplets, press I  to activate Insert 
mode.

3. Press Backspace or Delete .

RESULT
All notes in the selected tuplets are unscaled and appear as normal notes with the same notated 
duration, for example, a tuplet quarter note becomes a standard quarter note.

When Insert mode is activated, all notes in the tuplets are retained and any subsequent existing 
notes are pushed to later rhythmic positions to accommodate the extra rhythmic durations 
required. When Insert mode is deactivated, the earliest selected tuplets expand and overwrite 
subsequent notes and tuplets.

RELATED LINKS
Tuplet numbers/ratios on page 975
Tuplet brackets on page 973

Allowing/Disallowing tuplets to span barlines
You can allow tuplets to span barlines, for example, in Renaissance music, you might want 
tuplets to span tick barlines without affecting their notation. By default, Dorico SE automatically 
splits tuplets over barlines so that both the durations of bars and the divisions in tuplets are 
clear.

PROCEDURE

1. Select the tuplet brackets or tuplet numbers/ratios of the tuplets you want to allow/disallow 
to span barlines.

2. In the Properties panel, activate/deactivate Spans barline in the Tuplets group.

RESULT
The selected tuplets span barlines when Spans barline is activated, and are automatically split at 
barlines when it is deactivated.

EXAMPLE

A 16th note sextuplet across a barline, notated as 
two triplets

The same sextuplet allowed to span the barline and 
beamed together

AFTER COMPLETING THIS TASK
You can beam notes in the selected tuplets together.

Tuplets
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RELATED LINKS
Barlines on page 558
Beaming notes together manually on page 577
Tuplet brackets on page 973
Tuplet numbers/ratios on page 975

Moving tuplets rhythmically
You can move tuplets to different rhythmic positions after they have been input, including 
independently of tuplet brackets and tuplet numbers/ratios. Moving notes beyond the 
boundaries of a tuplet turns them back into normal notes.

PROCEDURE

1. In Write mode, select the tuplets you want to move.

NOTE

You must also select their tuplet numbers/ratios, brackets, or tuplet signposts in the 
selection if you want the notes to remain tuplets. If a tuplet number/ratio or tuplet bracket is 
not selected, the notes become normal notes of their rhythmic value when you move them 
beyond the boundaries of tuplets.

2. Move the selected tuplets according to the current rhythmic grid resolution in any of the 
following ways:

● Press Alt/Opt-Right Arrow  to move them to the right.

● Press Alt/Opt-Left Arrow  to move them to the left.

NOTE

You cannot move tuplets rhythmically using the mouse.

RESULT
The selected tuplets are moved to new rhythmic positions.

If a tuplet number/ratio or tuplet bracket is included in the selection, the whole tuplet is moved 
along the staff. If it crosses a barline, the tuplet is automatically adjusted to compensate.

NOTE

● If Chords is not activated and any of your selected notes collide with other notes in the same 
staff and at the same rhythmic position that are in the same voice as your selected notes, the 
existing notes are deleted and replaced with your selected notes.

You can undo moving notes immediately, which restores any notes deleted in the process.

● Tuplets are not automatically adjusted at the mid-point of bars, where it is convention to 
split tuplets to show the beat division. You must enter two tuplets manually to show the beat 
division at the mid-point of bars.

Tuplets
Moving tuplets rhythmically 
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EXAMPLE

An eighth note triplet in the last beat of a bar The same triplet moved one eighth note to the right, 
crossing the barline

Deleting tuplets
You can delete tuplets, including all the tuplet notes, but you can also delete tuplet brackets and 
numbers/ratios without deleting the corresponding notes.

PROCEDURE

1. In Write mode, select the tuplets you want to delete.

TIP

To delete an entire tuplet and all the notes within it, select all the noteheads and the 
corresponding tuplet bracket or tuplet number/ratio.

2. Press Backspace or Delete .

RESULT
The selected tuplets are deleted.

● Selecting just the notes deletes the notes, but does not delete the tuplet.

● Selecting just the tuplet bracket or tuplet number/ratio deletes the tuplet, and the notes that 
were previously within the tuplet are retained with the same notated duration. For example, 
deleting the bracket from triplet quarter notes leaves the notes previously in the triplet as 
three quarter notes.

NOTE

This overrides existing notes immediately after the tuplet. However, if Insert mode is activated, 
any subsequent existing notes are pushed to later rhythmic positions to accommodate the extra 
rhythmic durations required.

RELATED LINKS
Turning tuplets into normal notes on page 969

Tuplet beams
Tuplet beams join notes in tuplets that can be joined with beams just like non-tuplet beams. You 
can make the same changes to tuplet beams that you can make to any other beam.

RELATED LINKS
Beaming on page 575
Tuplets within beams on page 588
Beaming notes together manually on page 577
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Unbeaming notes on page 578
Splitting beam groups on page 576
Changing the direction of partial beams on page 578
Changing beam slants on page 580

Tuplet brackets
Tuplet brackets show the duration of tuplets that are not joined by beams, such as triplet quarter 
notes, by showing the notes within the tuplet under a bracket.

Tuplet bracket with tuplet number shown

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
brackets; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and 
the tuplet number/ratio or bracket.

RELATED LINKS
Lines on page 823

Hiding/Showing tuplet brackets
You can hide/show tuplet brackets independently of tuplet numbers/ratios. You can do this for 
the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets you want to hide, or the signposts of tuplets whose brackets you 
want to show.

2. In the Properties panel, activate Bracket in the Tuplets group.

3. Choose one of the following options:

● Hidden 

● Shown 

RESULT
Brackets on the selected tuplets are hidden/shown. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain. Signposts are shown at the 
position of each hidden tuplet, that is, tuplets with no numbers/ratios or brackets shown.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet 
numbers/ratios.

Tuplets
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RELATED LINKS
Signposts on page 349
Hiding/Showing tuplet numbers/ratios on page 976
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the staff-relative placement of tuplet brackets
You can show individual tuplet brackets and tuplet numbers/ratios above or below the staff or 
between staves. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets and tuplet numbers/ratios whose staff-relative placement you 
want to change.

2. In the Properties panel, activate Placement in the Tuplets group.

3. Choose one of the following options:

● Above 

● Below 

● Cross-staff above 

● Cross-staff below 

RESULT
The placement of the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

● Deactivating Placement returns the selected tuplets to their default placement.

● You can also switch selected tuplets between being above/below the staff or cross-staff 
above/cross-staff below by pressing F .

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the rhythmic end position of tuplet brackets
You can change the rhythmic end position of tuplet brackets relative to individual notes 
individually. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose end position you want to change.

Tuplets
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2. In the Properties panel, activate End position in the Tuplets group.

3. Choose one of the following options:

● End at right-hand side of final note 

● End immediately before following note 

● End at position of final tuplet division 

RESULT
The end position for the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating the property returns the selected tuplets to your default settings.

RELATED LINKS
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Forcing tuplet brackets to be horizontal
You can change the angle of individual tuplet brackets so that they appear horizontal. You can do 
this for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose angle you want to change.

2. In the Properties panel, activate Force horizontal in the Tuplets group.

RESULT
The selected tuplet brackets appear horizontal when the property is activated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

Tuplet numbers/ratios
Tuplet numbers and ratios are very similar: both indicate the number of equal notes included in 
the tuplet, such as 3 for triplets, but tuplet ratios also include the number of normal notes into 
whose duration the tuplet fits, such as 3:2 for triplets.

Additionally, tuplet ratios can include a note that indicates the duration of notes in the tuplet.

A triplet with a ratio and note value indication

Tuplet numbers/ratios help performers quickly identify the type of tuplet and how they must fit 
the number of notes indicated into the prevailing tempo and meter.

Tuplets
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NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
numbers/ratios; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and the 
tuplet number/ratio or bracket.

Hiding/Showing tuplet numbers/ratios
You can hide/show tuplet numbers/ratios individually. You can do this for the current layout and 
frame chain only or for all layouts and frame chains. When showing tuplet numbers/ratios, you 
can choose a different type for each tuplet individually.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose numbers/ratios you want to hide/change, or the signposts 
of tuplets whose numbers/ratios you want to show.

2. In the Properties panel, activate Number in the Tuplets group.

3. Choose one of the following options:

● None 

● Number 

● Ratio 

● Ratio+note 

RESULT
The tuplet number/ratio shown for the selected tuplets is changed. If you selected None, the 
tuplet numbers/ratios for the selected tuplets are hidden. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain. Signposts are shown 
at the position of each hidden tuplet, that is, tuplets with no numbers/ratios or brackets shown.

Deactivating Number returns the selected tuplets to the default setting.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet brackets.

RELATED LINKS
Hiding/Showing tuplet brackets on page 973
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Changing the position of tuplet numbers/ratios
You can change the horizontal positions of tuplet numbers and ratios in individual tuplet 
brackets. You can do this for the current layout and frame chain only or for all layouts and 
frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the tuplet brackets whose tuplet number/ratio positions you want to change.

2. In the Properties panel, activate Center in the Tuplets group.

3. Choose one of the following options:

● Visual

● Rhythmic

RESULT
The horizontal position of tuplet numbers/ratios on the selected tuplets is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

● Visual positions tuplet numbers/ratios at the visual center of the tuplet beam or tuplet 
bracket.

● Rhythmic positions tuplet numbers/ratios at the rhythmic center of the tuplet beam or 
tuplet bracket, which might be visually off-center.

RELATED LINKS
Tuplet brackets on page 973
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Unpitched percussion

The term “unpitched percussion” covers all percussion instruments that are not tuned to specific 
pitches. This includes instruments such as bass drum, guiro, maracas, cymbals, and shakers.

Dorico SE provides comprehensive support for unpitched percussion notation, with flexible 
options for combining music for multiple instruments into percussion kits that can then be 
displayed differently in different layouts. You can also define percussion kits as drum sets, which 
changes the default stem directions of notes.

The different percussion kit presentation types in Dorico SE are layout-specific, meaning you can 
present percussion kits in different ways in different layouts. For example, you could present a 
percussion kit as a five-line staff in the full score layout but with single-line instruments in the 
percussion part layout.

You can also customize and create new playing technique-specific noteheads for unpitched 
percussion. This allows you to indicate how notes are played by using different noteheads for 
different playing techniques on each instrument in percussion kits.

RELATED LINKS
Percussion kits and drum sets on page 979
Percussion kit presentation types on page 983
Staff labels for percussion kits on page 907
Defining percussion kits as drum sets on page 112
Inputting notes for unpitched percussion on page 180
Playing techniques for unpitched percussion instruments on page 985
Showing brackets on noteheads on page 729

Percussion kits vs. individual percussion instruments
Percussion kits allow you to show multiple unpitched percussion instruments held by a single 
player at the same time in different ways. Multiple percussion instruments not combined into kits 
are shown on a single line that only shows the instrument currently being played by default.

One common type of percussion kit is a drum set. A drum set consists of a number of separate 
instruments mounted together on a frame, and is typically written on a regular five-line staff. 
Each instrument has its own position on the staff, and sometimes its own notehead type. 
Similarly, a pair of bongos is a percussion kit by default in Dorico SE, consisting of the two bongo 
drums, typically written on a grid with two lines: the smaller drum shown on the top line, and the 
larger drum shown on the bottom line.

Showing individual percussion instruments separately can be appropriate if a player only has one 
or two percussion instruments. However, combining percussion instruments into a kit gives you 
more flexibility over the presentation of music, which you can vary in each layout independently. 
Kits also give you greater control over the labeling of instruments.

If instrument changes are enabled on the Players page in Setup > Layout Options, Dorico SE 
changes from one instrument to the next, just as it does for pitched instruments.
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NOTE

Kit instruments in player cards in the Players panel in Setup mode are colored green, whereas 
individual percussion instruments not part of percussion kits are colored the same light blue as 
all other instruments.

Percussion kits and drum sets
A percussion kit is a collection of unpitched percussion instruments that are played by a single 
player. Drum sets are a particular type of percussion kit that are often used in pop and rock 
music.

NOTE

In this documentation, we use “percussion kit” to refer to both percussion kits and drum sets.

In Dorico SE, you can present percussion kits in different ways, including as a five-line staff and 
as a grid. If you want percussion kits to behave as drum sets, you can define them as drum sets.

You can create percussion kits in Setup mode. You can combine existing unpitched percussion 
instruments into kits and add empty kits to players, to which you can then add unpitched 
percussion instruments. You can also import existing kits you have previously exported and 
saved.

You can move percussion instruments between players without affecting any music already 
added to that instrument.

NOTE

If the instrument you want to move is combined into a percussion kit, you must first remove the 
instrument from the kit before you can move it to another player.

You can change individual percussion instruments like any other instrument. However, you can 
only change unpitched percussion instruments to other unpitched percussion instruments, and 
you can only change the percussion instruments in kits within the Edit Percussion Kit dialog.

RELATED LINKS
Note input setup for percussion kits on page 182
Percussion kit presentation types on page 983
Staff labels for percussion kits on page 907
Universal Indian Drum Notation on page 996
Edit Percussion Kit dialog on page 109
Combining individual percussion instruments into kits on page 106
Defining percussion kits as drum sets on page 112
Adding instruments to percussion kits on page 111
Removing individual instruments from percussion kits on page 115
Moving instruments on page 107
Inputting notes for unpitched percussion on page 180
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Exporting percussion kits
You can export percussion kits as .doricolib files. This allows you to use kits again without 
having to create them from scratch.

PROCEDURE

1. In the Players panel in Setup mode, expand the card of the player whose percussion kit you 
want to export.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Click Export Kit at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The kit is exported and saved as a .doricolib file.

TIP

You can later import the .doricolib file into other projects to reuse the percussion kit.

Importing percussion kits
You can import .doricolib files containing percussion kits, which allows you to use kits again 
without having to create them from scratch.

PREREQUISITE
You have added a new solo player in the Players panel in Setup mode.

PROCEDURE

1. In Setup mode, open the instrument picker for your empty solo player in any of the following 
ways:

● Select the empty player and press Shift-I .

● Click the plus symbol  in the empty player card.

● Right-click the empty player and choose Add Instrument to Player from the context 
menu.

2. Click Import Kit in the instrument picker to open the File Explorer/macOS Finder.

3. Locate and select the percussion kit .doricolib file you want to import.

4. Click Open.

RESULT
The selected .doricolib file is imported as a percussion kit. It is assigned to the player from 
whose card you opened the instrument picker.
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Moving notes to different instruments in percussion kits
You can move notes to different instruments in the same percussion kit after they have been 
input, except in layouts using the single-line instruments kit presentation type.

In layouts using the single-line instruments kit presentation type, you can instead cross notes to 
other staves to create cross-staff beams.

PROCEDURE

1. In Write mode, select the notes you want to move to a different instrument in the percussion 
kit.

2. Move the notes to another instrument in any of the following ways:

● Press Alt/Opt-Up Arrow  to move them to the instrument above.

● Press Alt/Opt-Down Arrow  to move them to the instrument below.

RESULT
The notes are moved to another instrument in the kit.

AFTER COMPLETING THIS TASK
You can change the position of each instrument in the kit.

RELATED LINKS
Edit Percussion Kit dialog on page 109
Changing the positions of instruments within percussion kits on page 114
Changing the playing techniques of unpitched percussion notes on page 988
Percussion kit presentation types on page 983
Changing the percussion kit presentation type on page 984
Creating cross-staff beams on page 583

Notations on notes in percussion kits
You can add notations to notes and use different rhythms in percussion kits in the same ways as 
for normal notes; however, they can behave differently.

Articulations

You can add articulations to percussion instruments in all kit presentation types in the same ways 
as for other instruments.

However, in grid and five-line staff presentations, any articulations you add apply to all 
instruments in the same voice that have notes at that rhythmic position. For example, if both 
a snare drum and tom-tom note are at the same rhythmic position, and you add an accent, the 
accent is added to both instruments because they are both shown in the same down-stem voice 
by default.

You can see the accent applied to each note if you switch to the single-line instruments 
presentation type.

Tuplets

When working in the grid and five-line staff kit presentation types, tuplets are added to all 
instruments in the same voice.
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You can switch to the single-line instruments presentation type to input cross-rhythms on each 
instrument separately. When you switch back to the grid or five-line staff kit presentation types, 
Dorico SE attempts to resolve the rhythmic conflicts.

● Conflicting tuplets: One tuplet is moved into an extra voice for the duration of the conflict.

● Tuplet notes in one instrument and non-tuplet notes in another instrument starting at the 
same rhythmic position: The non-tuplet note is displayed as if it were part of the tuplet. This 
is because the note onset is at the same position as the start of the tuplet, so it sounds the 
same as the original notation.

● Tuplet notes in one instrument and non-tuplet notes in another instrument that do not start 
at the same rhythmic position, or other non-tuplet notes that start part-way through the 
tuplet: Non-tuplet notes are moved into an extra voice for the duration of the conflict.

NOTE

Deleting a tuplet from grid and five-line staff kit presentation types deletes the tuplet from 
all instruments whose notes contribute to the same shared voice.

Playing techniques

You can input playing techniques, such as + for closed and o for open hi-hat, during note input 
and add them later to existing notes in the same ways as for other instruments. You can use 
the playing techniques popover or click any of the playing techniques in the Playing Techniques 
panel in Write mode.

Playing techniques are only added to the instrument to which the note you select belongs, even 
if there are other instruments in the same voice.

Percussion stickings

Dorico SE does not yet have a dedicated feature for percussion stickings. However, you can use 
lyrics to represent percussion stickings in all kit presentation types:

● Grid/Five-line staff presentation types: Select a note in the instrument in which you want to 
show stickings.

● Single-line instruments presentation type: Input lyrics directly into instruments in which you 
want to show stickings.

RELATED LINKS
Inputting articulations on page 209
Inputting tuplets on page 194
Changing the pitch of individual notes on page 199
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Inputting lyrics on page 310

Dynamics in percussion kits
Unlike other items, dynamics are not shared between the grid/five-line staff presentation types 
and the single-line instruments presentation type. Any dynamics added to instruments in the 
single-line instruments presentation type do not appear when you switch to grid/five-line 
presentations.

This is due to the complexity of combining a large number of different dynamics at the same 
rhythmic position, as allowed in the single-line instruments presentation, into the single position 
required for both the grid and five-line staff presentations. Therefore, you can add dynamics 
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in the grid and five-line staff presentation types independently of the single-line instruments 
presentation type.

RELATED LINKS
Input methods for dynamics on page 243

Percussion kit presentation types
You can show percussion kits in three different presentation types, which can be different in each 
layout in your project.

NOTE

Dynamics are not shared between the grid/five-line staff presentation types and the single-
line instruments presentation type. Any dynamics added to instruments in the single-line 
instruments presentation type do not appear when you switch to grid/five-line presentations.

You can edit the appearance/structure of each presentation type independently in the Edit 
Percussion Kit dialog. For example, changing the order of instruments in the five-line staff 
presentation does not affect the order of instruments in the grid presentation of the same 
percussion kit.

5-line staff
Kit instruments are shown on a five-line staff. You can determine which instruments 
are shown on each line and in each space of the staff. A single staff label containing the 
name of the kit is shown.

The numbers down the left-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to staff positions. For example, position 0 is the middle line of the 
five-line staff, position 1 is the space immediately above the middle staff line, position 
-2 is the line below the middle staff line, and so on.

Bold black lines show the five staff lines, while gray lines above and below the staff 
show nominal staff line positions. Each instrument is shown on its staff position.

5-line staff presentation

Grid
Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize the size of the gaps between each line. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

The numbers down the right-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to the number of staff spaces between each instrument line. By 
default, all instruments in a grid are two spaces apart.

The order in which the instruments are listed matches the order in which they appear 
in the score.

Each instrument in a grid shows its own staff label by default, aligned vertically with its 
own line, but you can group adjacent instruments together and show a single label for 
each group.

Grid presentation
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Single-line instruments
Kit instruments are shown as individual instruments with their own lines. Normal-sized 
staff labels are shown for each instrument.

The editing area in the Edit Percussion Kit dialog lists all of the instruments in the 
order in which they appear in the score.

Single-line instruments presentation

Multiple instruments held by the same player are vertically spaced according to the ideal gaps 
defined on the Vertical Spacing page in Setup > Layout Options.

RELATED LINKS
Percussion kits and drum sets on page 979
Edit Percussion Kit dialog on page 109
Staff labels for percussion kits on page 907
Overriding the appearance of playing technique-specific noteheads on page 990
Override Percussion Noteheads dialog on page 987

Changing the percussion kit presentation type
You can change the presentation type of percussion kits in each layout independently and 
independently of each other. For example, you can use a five-line staff in the full score layout 
but a grid in the percussion part layout, and have two percussion kits with different presentation 
types in the same full score layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the percussion kit 
presentation type.

By default, the layout currently open in the music area is selected when you open the dialog. 
You can select other layouts by using the selection options in the action bar, Shift -clicking 
adjacent layouts, and Ctrl/Cmd -clicking individual layouts.

3. Click Players in the category list.

4. In the Percussion section, choose one of the following options for each percussion kit in 
your project:

● 5-line Staff

● Grid

● Single-line Instruments

5. Click Apply, then Close.

RESULT
The presentation type is changed for the selected percussion kits in the selected layouts.
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RELATED LINKS
Percussion kit presentation types on page 983

Playing techniques for unpitched percussion instruments
As well as using normal playing techniques, you can also use the design and position of 
noteheads to indicate different playing techniques for unpitched percussion instruments and 
percussion kits.

You can indicate playing techniques for unpitched percussion instruments in any of the following 
ways:

● Use playing technique-specific noteheads

● Position notes in spaces directly above/below the line on which notes are normally written

● Add articulations or single-note tremolos

● Add playing techniques in the same ways as for pitched instruments

For example, you can add open and closed techniques for hi-hats using the playing techniques 
popover, or by clicking the playing techniques you want in the Playing Techniques panel.

You can edit the set of playing technique-specific noteheads and staff positions defined for each 
unpitched percussion instrument in the Percussion Instrument Playing Techniques dialog. 
You can then select different playing techniques for each instrument when inputting notes in 
percussion kits.

RELATED LINKS
Edit Percussion Kit dialog on page 109
Changing the playing techniques of unpitched percussion notes on page 988
Defining how combinations of articulations and single-note tremolos sound in playback on page 
511
Exporting percussion kits on page 980
Importing percussion kits on page 980
Playing techniques on page 813
Inputting notes for unpitched percussion on page 180
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291

Percussion Instrument Playing Techniques dialog
The Percussion Instrument Playing Techniques dialog allows you to edit the set of playing 
technique-specific noteheads defined for each unpitched percussion instrument.

You can open the Percussion Instrument Playing Techniques dialog in Setup mode in the 
following ways:

● For an individual percussion instrument: In the Players panel, expand the card of the 
player holding the instrument, click the arrow  in the instrument label, and choose Edit 
Percussion Playing Techniques from the menu.

● For percussion instruments that are part of percussion kits: In the Players panel, click the 
arrow  in the kit instrument label, and choose Edit Percussion Kit to open the Edit 
Percussion Kit dialog, select the instrument whose playing techniques you want to edit in 
the main editing area, and click Edit Percussion Playing Techniques.
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1 Playing technique-specific noteheads list

Contains the main playing technique-specific noteheads currently defined for the selected 
percussion instrument, showing the notehead set and the staff position corresponding to 
the playing technique as applicable.

You can add new playing technique-specific noteheads for unpitched percussion 
instruments. Normally, percussion instruments define at least the Natural playing 
technique, which is usually shown using the default notehead set.

2 Playback of Articulations and Tremolos

Allows you to define how combinations of articulations and tremolo strokes affect or 
override the playback of playing techniques.

For example, you can define an entirely different playing technique for a playing technique-
specific notehead for when an accent is added to it.

3 Overrides of articulations and tremolos list

Displays any overrides of articulations and tremolos you define.

EXAMPLE

Three different snare drum playing technique-specific noteheads followed by two clash cymbal playing 
technique-specific noteheads

All of these settings are saved in the percussion instrument within your project, and you can 
export them from one project and import them into others.
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NOTE

Overrides for articulations and tremolos are not currently reflected in playback, but this is 
planned for future versions.

RELATED LINKS
Changing the playing techniques of unpitched percussion notes on page 988
Creating new playing technique-specific noteheads for unpitched percussion instruments on 
page 989
Overriding the appearance of playing technique-specific noteheads on page 990
Defining how combinations of articulations and single-note tremolos sound in playback on page 
511
Inputting notes for unpitched percussion on page 180
Exporting percussion kits on page 980
Importing percussion kits on page 980

Override Percussion Noteheads dialog
The Override Percussion Noteheads dialog lists the playing technique-specific noteheads 
defined for the selected instrument in the Percussion Instrument Playing Techniques dialog, 
shows the notehead type mapped for each technique, and allows you to override those 
noteheads for five-line staff kit presentations only.

For example, the same notehead can indicate different playing techniques for different 
instruments. When those instruments are presented on the same five-line staff, this can cause 
confusion, so you can use the Override Percussion Noteheads dialog to disambiguate the 
notes for one instrument from another in five-line staff kit presentations only.

● You can open the Override Percussion Noteheads dialog by selecting an instrument in the 
Edit Percussion Kit dialog and clicking Edit Noteheads.

The Override Percussion Noteheads dialog comprises the following:

1 Instrument name

Displays the name of the percussion instrument whose noteheads are listed in the dialog.

2 Playing techniques table

Contains the noteheads for the selected percussion instrument, arranged into the following 
columns:

● Playing Technique: Displays the playing technique associated with the notehead in the 
corresponding row of the table.
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● Default Notehead: Displays the notehead used by default for the playing technique in 
the corresponding row of the table.

● Notehead Override: Displays the notehead override used in five-line staff presentations 
for the playing technique in the corresponding row of the table. You can change the 
notehead override by clicking it and selecting another notehead from the menu.

RELATED LINKS
Overriding the appearance of playing technique-specific noteheads on page 990
Changing the playing techniques of unpitched percussion notes on page 988
Inputting notes for unpitched percussion on page 180
Percussion kit presentation types on page 983

Changing the playing techniques of unpitched percussion notes
You can change the playing techniques of notes belonging to unpitched percussion instruments 
after they have been input, for example, to switch selected notes to the side stick technique and 
playing technique-specific notehead.

NOTE

These steps only apply to changing playing technique-specific noteheads for unpitched 
percussion instruments.

PREREQUISITE
The unpitched percussion instruments whose playing techniques you want to change have at 
least two playing technique-specific noteheads defined in the Percussion Instrument Playing 
Techniques dialog.

PROCEDURE

1. In Write mode, select the notes whose playing technique-specific notehead you want to 
change.

NOTE

If you select a single note in percussion kits, the current playing technique is shown above 
the rhythmic grid. It is not shown if you select multiple notes.

2. Cycle through the available playing techniques for the selected unpitched percussion 
instruments in any of the following ways:

● Press Shift-Alt/Opt-Up Arrow  to cycle upwards.

● Press Shift-Alt/Opt-Down Arrow  to cycle downwards.

RESULT
The playing techniques of the selected unpitched percussion notes are changed. Their notehead 
design and/or staff position might be changed.

RELATED LINKS
Playing techniques for unpitched percussion instruments on page 985
Percussion Instrument Playing Techniques dialog on page 985
Inputting notes for unpitched percussion on page 180
Moving notes to different instruments in percussion kits on page 981
Defining how combinations of articulations and single-note tremolos sound in playback on page 
511

Unpitched percussion
Playing techniques for unpitched percussion instruments 

988
Dorico SE 3.5.12



Playing techniques on page 813
Showing brackets on noteheads on page 729
Changing the notehead design of individual noteheads on page 723

Creating new playing technique-specific noteheads for unpitched 
percussion instruments

You can define new playing technique-specific noteheads for unpitched percussion instruments 
individually, which are saved for that type of percussion instrument in your project. You can 
also export playing technique-specific noteheads from your project and import them into other 
projects.

PROCEDURE

1. In Setup mode, open the Percussion Instrument Playing Techniques dialog in one of the 
following ways:

● For an individual percussion instrument: In the Players panel, expand the card of the 
player holding the instrument, click the arrow  in the instrument label, and choose 
Edit Percussion Playing Techniques from the menu.

● For percussion instruments that are part of percussion kits: In the Players panel, click 
the arrow  in the kit instrument label, and choose Edit Percussion Kit to open the Edit 
Percussion Kit dialog, select the instrument whose playing techniques you want to edit 
in the main editing area, and click Edit Percussion Playing Techniques.

2. Click Add Playing Technique .

3. Select the playing technique you want to create in the dialog that opens.

4. Click OK to add the selected playing technique to the playing technique-specific noteheads 
list.

5. Select the notehead you want for the playing technique from the Notehead set menu.

NOTE

Leave Notehead set as (Unset) to use the default notehead set.

6. Choose one of the following options for Staff position:

● Below

● Line

● Above

RESULT
A new playing technique-specific notehead is added to the selected unpitched percussion 
instrument.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 291
Defining how combinations of articulations and single-note tremolos sound in playback on page 
511

Unpitched percussion
Playing techniques for unpitched percussion instruments 

989
Dorico SE 3.5.12



Overriding the appearance of playing technique-specific noteheads
It might be necessary to override the appearance of playing technique-specific noteheads in 
order to disambiguate the notes for one instrument from another if they share a staff position in 
five-line staff kit presentations.

PROCEDURE

1. In the Players panel in Setup mode, expand the card of the player holding the kit whose 
playing technique-specific noteheads you want to override.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. Select the instrument whose noteheads you want to override in the main editing area of the 
dialog.

4. Click Edit Noteheads to open the Override Percussion Noteheads dialog.

5. Click in the Notehead Override column for the appropriate playing technique and select a 
new notehead type from the menu to override its notehead.

6. Click OK to save your changes and close the dialog.

RESULT
The playing technique-specific notehead is overridden for the selected instrument in five-line 
staff kit presentations.

NOTE

This does not affect the appearance of playing technique-specific noteheads in grid and single-
line instrument kit presentation types.

RELATED LINKS
Override Percussion Noteheads dialog on page 987

Percussion legends
Percussion legends list the percussion instruments in use when using the five-line presentation 
type. Percussion legends can include all instruments that are represented on the staff, or only 
show sounding instruments in a set range to remind players which instruments to play at certain 
points.

Two sounding instrument percussion legends

By default, percussion legends appear above the staff. You can change the staff-relative 
placement of percussion legends individually.
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Percussion legends appear as signposts if there are no instruments sounding at their position, 
or when the layout uses the grid presentation type. Percussion legends do not appear at all in 
layouts using the single-line instrument presentation type.

NOTE

● Percussion legends only appear in the layout in which they were added. If you want to show 
percussion legends in multiple layouts, you must add them in each layout.

● You can hide/show percussion legend signposts by choosing View > Signposts > Percussion 
Legends. Percussion legend signposts are shown when a tick is shown beside Percussion 
Legends in the menu, and hidden when no tick is shown.

RELATED LINKS
Changing the staff-relative placement of items on page 343
Edit Percussion Kit dialog on page 109
Percussion kit presentation types on page 983
Staff labels for percussion kits on page 907

Adding percussion legends to five-line staff kit presentations
You can add percussion legends at specific rhythmic positions to indicate the instruments in the 
kit. Percussion legends can show all instruments in the kit or only instruments sounding within 
the specified range.

NOTE

Percussion legends only appear when kits use the five-line staff percussion kit presentation type 
and in the layout in which they were added. If you want to show percussion legends in multiple 
layouts, you must add them in each layout.

PROCEDURE

1. In Write mode, select one of the following:

● An item on the staff at the rhythmic position where you want to add a percussion legend 
for all instruments.

● The range of notes/items for which you want to show a percussion legend for sounding 
instruments.

2. Add a percussion legend in one of the following ways:

● Choose Edit > Percussion > Legend for All Instruments.

● Choose Edit > Percussion > Legend for Sounding Instruments.

TIP

You can also choose these options from the context menu.

RESULT
A percussion legend is added to the kit. It appears above the staff when the kit uses the five-line 
staff presentation. It lists instruments, either all instruments or just instruments with notes 
within the selected range, in the order in which they appear in the five-line staff, from highest 
down to lowest.
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Changing the sounding instrument percussion legend range
You can change the rhythmic range of sounding instrument percussion legends to include more/
fewer instruments in the legend, as they only show the instruments playing at the rhythmic 
positions included in the range.

PROCEDURE

1. In Write mode, select the sounding instrument percussion legend whose range you want to 
change.

2. Change the range in any of the following ways, according to the current rhythmic grid 
resolution:

● To move the whole range to the right, press Alt/Opt-Right Arrow .

● To move the whole range to the left, press Alt/Opt-Left Arrow .

● To lengthen the range, press Shift-Alt/Opt-Right Arrow .

● To shorten the range, press Shift-Alt/Opt-Left Arrow .

NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The rhythmic range covered by the selected sounding instrument percussion legend is changed 
according to the current rhythmic grid resolution.

The instruments included in the percussion legend are automatically updated to reflect the 
instruments playing within the range.

Changing the percussion legend type
You can change the type of percussion legends so they show all instruments or only sounding 
instruments in five-line staff presentations.

PROCEDURE

1. Select the percussion legends whose type you want to change.

2. In the Properties panel, activate Legend type in the Percussion Legends group.

NOTE

The property is already activated for sounding instrument percussion legends.

3. Choose one of the following options:

● Legend

● Sounding instruments

RESULT
The legend type of the selected legends is changed.

RELATED LINKS
Percussion legends on page 990
Percussion kit presentation types on page 983

Unpitched percussion
Percussion legends 
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Adding percussion legends to five-line staff kit presentations on page 991

Showing short instrument names in percussion legends
Percussion legends use full instrument names by default, but you can choose to use short names 
to save space.

PROCEDURE

1. Select the percussion legends whose instrument name lengths you want to change.

2. In the Properties panel, activate Use short names in the Percussion Legends group.

RESULT
Short instrument names are shown in the selected percussion legends.

Deactivating Use short names returns the selected percussion legends to showing full 
instrument names.

RELATED LINKS
Staff labels for percussion kits on page 907
Percussion legends on page 990
Percussion kit presentation types on page 983
Adding percussion legends to five-line staff kit presentations on page 991

Voices in percussion kits
Dorico SE automatically combines music into a smaller number of voices when multiple 
percussion instruments are presented in a five-line staff or as a grid, even if they contain 
different rhythms. By default, music is combined into one up-stem voice and one down-stem 
voice.

You can override this option for individual percussion kits, and for individual notes in percussion 
kits.

Notes in the same voice cannot be notated using different durations and are notated using ties 
by default instead.

If one of the instruments in a percussion kit has a tuplet rhythm, other instruments can share the 
voice if their notation is compatible, such as if the tuplet structure is the same, or if they have a 
single note that coincides with the start of the tuplet. In this case, the single non-tuplet note is 
notated as the same duration of the first note of the tuplet.

If the music of the different instruments in the same voice is incompatible, Dorico SE dynamically 
creates another voice and notates the remaining music in that voice until the music is compatible 
again.

RELATED LINKS
Notations on notes in percussion kits on page 981
Defining percussion kits as drum sets on page 112
Adding slash voices to percussion kits on page 1003

Unpitched percussion
Voices in percussion kits 
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Changing the voice of individual notes in percussion kits
You can override the default voice for individual notes in percussion kits, including drum sets.

PROCEDURE

1. Select the notes whose voice you want to override.

2. Choose Edit > Percussion > Change Voice > [Voice].

For example, to change notes to the second down-stem voice, choose Edit > Percussion > 
Change Voice > Down-stem Voice 2. You can also choose this option from the context 
menu.

RESULT
The voice of the selected notes is changed, independently of the default voice for their 
instrument and independently of your setting for voices in drum sets.

TIP

You can reset the voice of individual notes by selecting them and choosing Edit > Percussion > 
Change Voice > Reset Note Destination Voice. You can also choose this option from the 
context menu.

Specifying the stem direction/voice of instruments in percussion kits
You can specify the stem direction for each instrument in individual percussion kits. You can also 
set which voice they are in, allowing you to control which instruments share voices in percussion 
kits.

PROCEDURE

1. In the Players panel in Setup mode, expand the card of the player holding the kit whose 
instrument stem directions and voices you want to specify.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. In the dialog, select an instrument whose stem direction and voice you want to specify.

4. Choose one of the following stem directions for Stem direction and voice:

● Up-stem 

● Down-stem 

5. Specify a voice by changing the value for Stem direction and voice.

NOTE

You do not have to change the voice number if you are switching between up- and down-
stem voices as the number corresponds to the voice number for each stem direction.

6. Click Apply, then Close.

RESULT
The default stem direction and voice of the selected instrument is changed.

Unpitched percussion
Voices in percussion kits 

994
Dorico SE 3.5.12



Unpitched percussion in Play mode
Unpitched percussion instruments are handled differently in Play mode than pitched 
instruments. Instead of showing the usual piano roll view, the onset of each note on each 
percussion instrument is shown in the drum editor.

You can expand each instrument in a kit at the left end of the track header in order to assign that 
particular instrument to another playback endpoint. For example, you can assign instruments to 
another channel on the same VST instrument or MIDI output device, or to a different device.

NOTE

The endpoint must have an appropriate selected percussion map.

Notes can be moved in Play mode by dragging them to the rhythmic position you want. However, 
like other instruments, you cannot move notes between percussion instruments, even if they are 
in the same percussion kit.

NOTE

You cannot change the duration of unpitched percussion notes within Play mode. This is planned 
for future versions.

RELATED LINKS
Percussion maps on page 506
Drum editor on page 420
Inputting notes in the event display on page 421
Moving notes in the event display on page 422

Unpitched percussion imported from MIDI files
When importing MIDI files, Dorico SE optionally interprets music for tracks set to use channel 
10 as drum sets if Interpret channel 10 as General MIDI percussion is activated in the MIDI 
Import Options dialog.

NOTE

The MIDI Import Options dialog opens automatically when you open MIDI files in Dorico SE.

This is the only condition under which Dorico SE interprets any music in MIDI files as percussion.

Unpitched percussion imported from MusicXML files
Unpitched percussion music can be expressed in a number of ways in MusicXML. Scoring 
applications take different approaches to what data is exported and how it is encoded. Therefore, 
the results of importing MusicXML into Dorico SE vary considerably.

Dorico SE identifies each instrument in kits explicitly and then combines them dynamically onto 
five-line staves. Other scoring applications and MusicXML have a different approach to how 
unpitched percussion music is represented. For example, a drum set may be effectively notated 
as pitched notes on a five-line staff and annotated with additional information to help identify 
which instrument corresponds to each staff position.

Because of these different approaches, mapping information between the MusicXML 
representation and the Dorico SE representation can be challenging, so Dorico SE employs 
heuristics to improve the quality of results.

Unpitched percussion
Unpitched percussion in Play mode 
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Typically, drum set instruments in MusicXML files exported from both Sibelius and Finale are 
imported quite cleanly into Dorico SE.

Results are particularly good, and more likely to be imported correctly, if the voicing of the drum 
set is consistent, such as consistently notating the snare drum in a down-stem voice. If the 
voicing changes from bar to bar, it is possible that some notes are either identified correctly or 
not imported at all.

Other kinds of percussion that are notated on five-line staves produce more variable results. 
In most cases, Finale includes information about which percussion instrument maps onto each 
staff position, but Sibelius does not. As a result, you might find that Dorico SE chooses different 
instruments than you expected, but you can change instruments using the Edit Percussion Kit 
dialog.

RELATED LINKS
Edit Percussion Kit dialog on page 109
Changing instruments in percussion kits on page 111
Adding instruments to percussion kits on page 111

Universal Indian Drum Notation
Dorico SE supports the Universal Indian Drum Notation system developed by Keda Music Ltd.

Universal Indian Drum Notation has been designed primarily for tabla, but can also be applied to 
other Indian drums with two heads, such as nagara, dhol, dholak, mridangam, and pakhawaj.

Indian drum clefs are automatically shown on the staves of tabla instruments and tabla 
percussion kits, but you can also input Indian drum clefs manually.

RELATED LINKS
Adding solo/section players on page 95
Adding instruments to players on page 105
Inputting clefs with the panel on page 259
Percussion kits and drum sets on page 979
Percussion maps on page 506

Unpitched percussion
Universal Indian Drum Notation 
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Voices

For many instruments, such as flute or trombone, each staff usually contains a single musical line 
in a single voice that is read from left to right along the staff. When multiple, independent lines 
must be shown in a single staff, each line can be a separate voice.

The most common use for showing multiple voices in a single staff is in vocal music, when the 
soprano and alto lines share a single staff and the tenor and bass lines share another staff. 
Showing each vocal line in its own voice helps to separate the lines, making the music easier to 
read and making the shape of each melodic line clear.

In Dorico SE, you can create as many voices as you like on each staff. Each voice has its own 
color, which you can see if you show voice colors. This can help you to keep track of which notes 
are in which voices if there are multiple overlapping musical lines in your project.

Voices in Dorico SE are divided into up-stem voices and down-stem voices. Stems of notes in 
up-stem voices point upwards, while stems of notes in down-stem voices point downwards. 
However, in bars where only one voice contains notes, stem directions are automatically changed 
to the directions they would have if there were only one voice on the staff. By default, the first 
voice on the staff is up-stem.

Following most notation conventions, rests are shown in bars for all voices that have notes in 
the bar. If two or more voices have a rest of the same rhythmic duration at the same rhythmic 
position, that rest is consolidated: instead of showing two identical rests, only one is shown.

RELATED LINKS
Inputting notes into multiple voices on page 174
Adding notes above/below existing notes on page 197
Stem direction on page 921
Voice column index on page 999
Implicit rests in multiple-voice contexts on page 881
Moving rests vertically on page 886

Hiding/Showing voice colors
You can show notes in different colors according to their voice, for example, to check which notes 
are in which voice. When voice colors are hidden, all notes appear black by default.

Voice colors are randomly assigned, meaning colors do not refer to specific voices. Voice colors 
are considered annotations and are not printed by default.

PROCEDURE

● Choose View > Note And Rest Colors > Voice Colors.

RESULT
Voice colors are shown when a tick appears beside Voice Colors in the menu, and hidden when 
no tick appears.
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TIP

You can also identify voices by selecting individual notes and looking at the display in the status 
bar.

EXAMPLE

Voice colors shown

AFTER COMPLETING THIS TASK
If showing voice colors reveals some notes are not in the voice you want, you can change their 
voice.

RELATED LINKS
Changing the voice of existing notes on page 353
Swapping the contents of voices on page 354
Stem direction on page 921
Annotations on page 537
Status bar on page 32

Note positions in multiple-voice contexts
Notes are usually placed directly above each other and at the same horizontal position, so that 
it is immediately clear which notes are played together. However, the horizontal alignment of 
notes can be different in multiple-voice contexts.

There are circumstances when some notes must be positioned slightly to one side in a different 
voice column to ensure the division of notes across the voices is clear. For example, when there 
are three or more voices in a single staff or when notes in two voices are a second interval apart.

A phrase with multiple voice columns for some beats on the top staff

Interlocking notes in different voices can be positioned in two ways:

1. Notehead to notehead, which allows noteheads to overlap partially. This voice order often 
takes up less horizontal space than positioning notes stem to stem, as notes can overlap.

Voices
Note positions in multiple-voice contexts 

998
Dorico SE 3.5.12



2. Stem to stem, which does not allow noteheads to overlap. This voice order keeps notes in 
different voices separate.

Dorico SE positions notes by default with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and to maintain the clarity of the rhythm. The order 
and position of notes in different voices is also automatically adjusted so that each rhythmic 
position uses as little horizontal space as possible, while remaining clear and legible.

You can manually swap the order in which opposing voices are positioned horizontally.

RELATED LINKS
Stem direction on page 921
Slashes in multiple-voice contexts on page 871
Implicit rests in multiple-voice contexts on page 881
Note spacing on page 406

Voice column index
The voice column index is used to determine the positions of notes when multiple columns are 
needed, for example, when notes in two voices are a second interval apart and therefore cannot 
be placed directly above each other vertically, instead they must partially overlap.

Dorico SE automatically changes the voice column of voices according to the number of active 
voices and the pitch of notes. Dorico SE prefers showing voices with the widest pitch range 
between them on the left of the rhythmic position and voices with narrower pitch ranges to the 
right, as this produces the most balanced result, especially when there are multiple accidentals.

One voice Two voices vertically 
aligned in the same 
voice column

Three voices all still 
vertically aligned

Four voices with 
two voice columns

Five voices with two 
voice columns

Swapping the order of voices
Dorico SE automatically positions notes with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and maintain the clarity of the rhythm. You can 

Voices
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manually swap the order in which opposing voices are positioned horizontally. You can do this 
for the current layout and frame chain only or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose order you want to change.

2. Choose Edit > Voices > Swap Voice Order. You can also choose this option from the context 
menu.

RESULT
The voice order of the selected notes is changed by changing their voice column index. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

EXAMPLE

Interlocking notes in opposing voices positioned 
notehead to notehead.

Interlocking notes in opposing voices positioned 
stem to stem.

RELATED LINKS
Stem direction on page 921
Implicit rests in multiple-voice contexts on page 881
Changing the property scope on page 149
Copying property settings to other layouts/frame chains on page 395

Unused voices
An unused voice is one that contains no notes anywhere in the project. Any unused voices are 
automatically deleted when you close a project, but you cannot manually delete voices once they 
have been created. You can create as many voices as you want in each staff.

NOTE

Deleting all notes in a voice does not delete the voice immediately.

If you later want to input notes in a voice that was automatically deleted when you last closed the 
project, you can create a new voice at any rhythmic position.

RELATED LINKS
Inputting notes into multiple voices on page 174

Voices
Unused voices 
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Notes crossed to staves with existing notes in other voices
When you create cross-staff beams by crossing notes to staves that already contain notes, the 
stem direction of the existing notes may change. This is due to how multiple voices at the same 
rhythmic position are handled in Dorico SE.

For example, if a piano part contains notes in up-stem voices on both staves, the stem direction 
of notes in both voices can change if notes from the upper staff are crossed to the lower staff. 
In this situation, the notes from the two staves are not combined, but are instead treated as two 
up-stem voices in a multiple-voice context.

Two piano staves, each with notes in a single up-
stem voice.

When the notes in the upper staff are crossed to the 
lower staff, the stem direction of the notes already in 
the lower staff changes so they point upwards.

You can change the stem direction of the notes originally in the lower staff in any of the following 
ways:

● Select the notes originally in the lower staff and change their voice to another voice, such as 
a down-stem voice.

● Select the notes originally in the lower staff and change their stem direction.

Alternatively, you can move the notes in the upper staff permanently to the lower staff.

RELATED LINKS
Creating cross-staff beams on page 583
Moving notes to other staves on page 353
Changing the voice of existing notes on page 353
Stem direction on page 921

Slash voices
Slash voices allow you to notate specific rhythms for rhythm slashes. They behave similarly to 
normal voices as you must input notes and rhythms manually, but all notes in slash voices are 
positioned by default on the middle line of the staff, regardless of the pitches you input.

If you later change the time signature, such as from 3/4 to 6/8, Dorico SE only changes the note 
grouping to fit the meter just like for other notes; it does not change the presentation of rhythm 
in slash voices like it does for slash regions.

NOTE

● Because you can change notes in slash voices to normal voices and vice versa, the pitches 
you input are retained.

● Notes in slash voices are not played back.

Voices
Notes crossed to staves with existing notes in other voices 
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You can have multiple slash voices active at the same time. To accommodate all slash voices in 
multiple-voice contexts, Dorico SE changes their staff position automatically. However, you can 
also change the staff position of rhythm slashes manually.

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions, for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

RELATED LINKS
Rhythm slashes on page 869
Slash regions on page 869
Slashes in multiple-voice contexts on page 871
Changing the voice of existing notes on page 353

Changing the slash voice type
You can change the voice type of slash voices, for example, if you want to change a slash voice 
from having stems to being stemless. You can also change the type to normal notes, which 
restores the original pitches you input, and change normal notes to rhythm slashes.

NOTE

This affects all notes in the same voice. If you only want to change the slash voice type of some 
notes, you must change the voice of those notes instead.

PROCEDURE

1. Select a note in the voice whose slash type you want to change.

2. Choose Edit > Voices > Rhythmic Slashes > [Voice type].

For example, to change a whole normal voice to a stemless slash voice, choose Edit > 
Voices > Rhythmic Slashes > Slashes without Stems.

TIP

You can also choose these options from the context menu.

RESULT
The slash voice type of all notes in the same voice and flow as the selected note is changed.

If you change normal notes to a slash voice, they are all automatically positioned on a single staff 
line. By default in single-voice contexts, this is the middle line of the staff.

If you change rhythm slashes to normal notes, their original pitches are restored, meaning their 
staff positions reflect their pitches.

RELATED LINKS
Changing the voice of existing notes on page 353

Voices
Slash voices 
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Adding slash voices to percussion kits
You can add slash voices to percussion kits, for example, to show the desired rhythm for a 
passage without specifying the instruments to be played. You can add multiple slash voices to 
the same kit, including slash voices with and without stems.

NOTE

Rhythm slashes in percussion kits only appear when the five-line staff presentation is used. They 
do not appear in grid or single-line instrument presentations.

PROCEDURE

1. In the Players panel in Setup mode, expand the card of the player holding the percussion kit 
to which you want to add slash voices.

2. Click the arrow  that appears in the kit instrument label when you hover over it and choose 
Edit Percussion Kit to open the Edit Percussion Kit dialog.

3. In the action bar below the five-line staff editor, click the button that corresponds to the type 
of slash voice you want to add.

● Slashes with stems 

● Slashes without stems 

4. Optional: Repeat step 3 as many times as required for the number of slash voices you want 
to add.

RESULT
The slash voices are added to the kit. They are positioned on the middle line of the staff by 
default.

In note input, you can move the caret to slash voices just like moving it to other instruments in 
the kit, and input notes into slash voices just like inputting notes in percussion kit instruments.

AFTER COMPLETING THIS TASK
You can change the staff position of the slash voices you added to the kit.

RELATED LINKS
Percussion kit presentation types on page 983
Voices in percussion kits on page 993
Edit Percussion Kit dialog on page 109
Inputting notes for unpitched percussion on page 180
Changing the positions of instruments within percussion kits on page 114

Voices
Slash voices 
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Glossary

A
action
The mechanism inside pianos that allows the hammers to strike the strings with different forces, 
depending on the strength with which the player depresses the corresponding key. It allows 
pianos to use a greater dynamic range, hence their full name “pianoforte”.

anacrusis
See pick-up bar.

articulation
(1) In music notation, symbols that indicate how a note should be played, typically affecting their 
onset (attack), release, or duration. (2) In sound libraries, a term that refers to playing techniques 
generally.

attachment
The rhythmic position at which an item occurs, or to which an item applies, in the music.

B
bar
A span of music comprising a specific number of beats, as defined by the prevailing time 
signature, whose boundaries are indicated by bar lines. Also known as a “measure”, but this 
documentation uses “bar”.

C
cancellation natural
A natural accidental positioned on the staff immediately before a change in key signature or 
a single note. It indicates that the previous accidental no longer applies and can be followed 
immediately by a new accidental if applicable. Showing cancellation naturals before single 
accidentals that follow double accidentals is also known as “archaic cancellation”. Cancellation 
naturals before a change in key signature are known as “traditional” when positioned after the 
barline and “Russian” when positioned before the barline.

caret
Shown during note input, the caret is the vertical line that extends above and below the staff 
and indicates the rhythmic position at which items are input. Also known as an “insertion point”. 
In Dorico SE, the caret, cursor, and pointer are related but serve different purposes. See also 
rhythmic grid, note input.

casting off
The act of fixing the layout of pages of music, such as defining a set number of systems per page 
or the number of bars per system.

cautionary accidental
A restatement of an earlier accidental to eliminate ambiguities, such as when a tied note with an 
accidental continues onto another page. Also known as “courtesy accidentals”.

CC
Short for “continuous controller” or “control change”, it is a MIDI message that combines a 
controller number and a value. The value for an individual controller can change over time, 
allowing incremental manipulation of the corresponding sound or effect, such as increasing/
decreasing the string vibrato intensity. You can specify the sound or effect that each CC switches 
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to and controls in each sound library using expression maps. In Dorico SE, each instrument track 
has 127 available MIDI CCs, each with a value range from 0 to 127. Because MIDI CC does not 
use notes on a MIDI keyboard, it allows you to use the full range of MIDI keyboard notes for note 
input. However, it is therefore harder to trigger MIDI CC whilst recording notes. See also MIDI, 
PC.

channel
In MIDI, a channel determines which note, controller, or other data is played by which sound 
on which device. In Dorico SE, notes on a single staff may be played by different channels, 
depending on which playing techniques are provided by the patch assigned to each channel. See 
also MIDI, patch.

chord
Two or more notes of the same duration that start at the same rhythmic position and share a 
stem.

chord input
A variation of note input where notes are stacked on top of each other to create chords rather 
than being input after the previous note in sequence. Notes are input at the caret position, which 
does not advance automatically. See also caret, note input, Insert mode.

collision avoidance
Automatic adjustments made by Dorico SE to ensure multiple items at the same position do not 
overlap and that all remain clearly legible. Includes changing the shape of items, such as slurs, 
and changing the vertical and/or horizontal position of items, such as accidentals in chords.

column
A vertical line representing the same horizontal position across all staves in the system. Used 
to determine the position of notes and chords for the purposes of spacing music accurately. 
Multiple columns can be used for the same rhythmic position to accommodate multiple voices, 
with notes or chords in some voices being offset horizontally from notes or chords in other 
voices.

concert pitch
All notes are written as they sound. Full scores are often notated in concert pitch, so that 
harmonies and themes are easier to identify. Also known as “sounding pitch”. See also 
transposed pitch, instrument transposition.

condensing
The process of showing the music for multiple players on fewer staves than is normal, usually 
by allowing multiple instruments of the same type to share a staff, such as Flutes 1-2 or Horns 
1-4. Most commonly used for large orchestral scores, as when there are fewer staves on a page 
it is possible to use a larger staff size, which is easier for conductors to read. See also divisi, pitch 
crossing.

constant point
A change in value in a track or lane in Play mode that sets a fixed value until the next point in the 
track or lane. See also linear point, value line.

context menu
A menu that you can access by right-clicking on a mouse or double-tapping on a touchpad. Its 
options vary by the location of the mouse pointer when you access it, but it most commonly 
contains options also found on the Edit menu.

cursor
The vertical blinking line that appears when entering or editing text. See also caret.

D
dead note
A note played on a fretted instrument whose sound is muted to produce a sound that is more 
percussive than pitched. Usually produced by gently resting one hand on the string. Also known 
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as a “muted”, “muffled”, “ghost”, or “silenced” note. In Dorico SE, only notes belonging to fretted 
instruments, such as the guitar or banjo, can be dead notes.

disclosure arrow
A small arrow that is shown on all edges of the main window in Dorico SE. It allows you to 
hide/show the toolbar and panels individually.

divisi
Italian for “divide” or “divided”, divisi is when players split in order to play multiple lines of music. 
This commonly involves a section, such as Violin I, dividing and using two staves rather than one 
for a limited passage. Divisi passages can be notated all on the same staff, using multiple voices 
if required, or across multiple staves. See also tutti, condensing.

drum set
A particular type of percussion kit that is often used in pop and rock music. Drum sets often 
use a different arrangement of voices than percussion kits. In this documentation, references to 
“percussion kits” also apply to drum sets, as drum sets are a type of percussion kit.

E
EDO
An abbreviation for Equal Division of the Octave, it is a unit used to describe how an octave 
can be divided into equal parts, often for the purpose of defining a microtonal scale or tonality 
system. Traditional Western European music uses 12-EDO, that is, each octave is divided into 12 
equal half-steps (semitones). Music that uses equal quarter tones uses 24-EDO.

endpoint
The unique combination of inputs and outputs that together allow the correct sounds to be 
played for each instrument.

Engrave mode
A mode in Dorico Pro where you can manipulate and modify every item in your project, but 
without deleting them, moving them rhythmically, or changing the pitch of notes. You can also 
determine how the pages in each layout of your project are formatted for printing or exporting. 
See also modes.

enharmonic equivalent
An alternative spelling of a note that uses a different scale degree and accidental but produces 
the same sounding pitch, such as G♯ and A♭.
ensemble
A predefined collection of players, each holding instruments that are often used together, such 
as string quartet, wind quintet, brass quintet, string ensemble, and double woodwinds.

envelope
A change in sound over time that comprises multiple stages, such as attack, sustain, and decay. 
In dynamics lanes in Play mode, envelopes are represented by multiple separate points, each 
controlling a different parameter of the overall envelope. See also constant point, linear point, 
value line.

explicit rest
A rest that was deliberately input during rest input or imported from a MusicXML file. Explicit 
rests cannot be suppressed between notes in a particular voice. See also implicit rest.

exploding
The process of assigning music to more instruments than it was written for originally. Exploding 
music is often a key step in arranging and orchestrating music, such as when a piano piece is 
arranged for string quartet. See also reducing.
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F
family
Instruments of a similar kind that are typically bracketed together in a score, such as woodwind, 
brass, percussion, and strings.

fermata
A notation that indicates all notes at that position are held for longer than their notated length. 
It is most commonly shown as a curved line with a dot under the curve, but it can also be shown 
with a pointed arch or square shape. Also known as a “pause” or a “birds’ eye”.

flow
A self-contained span of music of any scope, such as a movement in a symphony, a song in 
an album, a number in a musical, or a short exercise in a music theory worksheet. A flow can 
contain the same players as other flows in the project or separate players just for that flow. See 
also player.

formatting
The act of determining the number of bars in a system, the number of systems on a page, and 
the distances between staves and systems.

fps
A unit of measurement, short for “frames per second”, that refers to the number of video frames 
occurring each second.

fragment
Part of a notation item. For example, fragments of a note include its notehead, rhythm dots, 
accidentals, the tip of its stem, and beam. In Write mode, selecting any part of an item also 
selects all of its fragments, so any changes you make affect the whole item. See also item, 
segment.

frame
A rectangular container for music, text, or graphics on a page.

fretted instrument
A type of instrument that in most cases has multiple strings, a neck with marked frets, and 
is played by stopping the strings at fret positions on the neck with one hand, usually the left, 
and plucking the corresponding strings with the other hand, usually the right. Common fretted 
instruments include the guitar, ukulele, and banjo.

full score
A score comprising all of the music for all of the players and their instruments, typically laid 
out in a specific order. The order used varies according to the ensemble for which the music 
is written. In full scores for orchestra, the players are typically ordered from the highest wind 
instrument at the top of the page, for example, piccolo, to the lowest string instrument at the 
bottom of the page, for example, contrabass, with brass, keyboards, voices, and percussion in 
between.

G
galley view
A viewing option that shows music laid out as a single, infinitely wide system.

grace note
A small note, often used to show an ornament or embellishment, that is not counted towards 
the number of beats in the bar; instead, it steals from the duration of either the preceding or 
the following rhythmic notes. Also known as an “arhythmic note”. In common practice, a grace 
note with a slashed stem is an acciaccatura, which is to be played as quickly as possible, either 
immediately before or at the rhythmic position of the note or chord that follows it. A grace note 
with an unslashed stem is an appoggiatura, which is played as half of the written duration of the 
note or chord that follows it.
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group
A collection of players that comprises either a subset of the main ensemble, for example, a 
choir within an orchestra, or a separate group, for example, an off-stage brass group or second 
orchestra. Each group of players is labeled separately in the full score and is grouped and 
numbered together in the instrument order. See also player.

H
hairpin
A notation for dynamics that uses a pair of angled lines, diverging from or converging on a 
single point, to show a gradual increase or reduction in the dynamic level, that is, a crescendo or 
diminuendo.

half-bar
The rhythmic position that divides bars into two equal sections when the prevailing time 
signatures can be divided into four equal beats. In Dorico SE, specific beam grouping and note 
grouping settings apply to bars with a half-bar. Time signatures that have a half-bar include 4/4 
and 12/8.

handle
A selectable item that marks the ends of lines, the corners of frames, and other moveable 
positions, such as pedal line retakes and slur control points. In Write mode, handles are circular 
and mark rhythmic positions.

harmonic series
A naturally-occurring set of frequencies that are all related to a single pitch, known as the 
“fundamental”. When a fundamental pitch is played, the note produced contains many different 
notes within the harmonic series. These additional notes are known as “partials” or “overtones”. 
It is also possible to bring out the sound of individual partials by playing them as harmonics. 
There is a consistent pattern of intervals between partials within the harmonic series, and 
these intervals become progressively smaller the further up the harmonic series they occur. 
For example, the interval between the first and second partials is an octave whereas the interval 
between the seventh and eighth partials is only approximately a major second. At the top end of 
the harmonic series, most partials are microtones. See also partial.

hook
A short line that extends from other lines, most commonly at a right angle, that helps to clarify 
the end position of lines. In Dorico SE, hooks can be used at the end of pedal lines, octave lines, 
repeat endings, and tuplet brackets.

horizontal justification
The alignment of musical content to the left and right edges of the frame. To ensure that all 
staves in a system occupy the same width, any remaining space that is left over after the music 
is spaced is distributed evenly between all of the columns in the system. Sometimes the final 
system of a flow is not fully justified and is allowed to end partway across the width of the frame. 
See also frame, justification.

I
implicit rest
A rest that is automatically shown around the notes you input. Its notated duration automatically 
adjusts according to the time signature and its position in the bar. Implicit rests can be 
suppressed between notes in a particular voice, which hides them. See also explicit rest.

Insert mode
A way of changing how notes are input. When Insert mode is activated, new notes push all 
subsequent notes in the same voice along by the input duration instead of overwriting existing 
notes. Similarly, reducing the duration of notes with Insert mode activated pulls them closer 
together without leaving rests between the notes. This also affects edits you make outside of 
note input, such as deleting notes, changing the duration of notes, or inputting time signatures. 
See also note input, chord input.

Glossary
 

1008
Dorico SE 3.5.12



instrument
Anything that requires at least one staff to represent the sounds or music it produces. Common 
instruments include the violin, flute, tuba, and bass drum. However, human voices, computer 
triggering samples, and tape recordings can also be instruments.

instrument transposition
The interval difference between the pitch the instrument plays and the resulting sounding pitch, 
often included as part of the instrument name. For example, when a Clarinet in B♭ plays a C, the 
pitch produced is a concert B♭. Instrument transposition is also known as “instrument pitch”. See 
also concert pitch, transposed pitch.

item
Generic term for any note, rest, chord, notation, or other selectable object that appears in the 
score in Dorico SE. See also fragment, segment.

J
justification
The alignment of musical content to the edges of the frame, both horizontally and vertically. See 
also frame, horizontal justification, vertical justification.

K
key command
A set of keys that perform a defined task when pressed together. Also known as a “keyboard 
shortcut” or “hotkey”.

L
layout
A page-based presentation of the music for one or more players in one or more flows, for 
example, a full score that contains all players or an instrumental part that contains only a single 
player. See also flow, player.

layout options
Options that affect the setup of an individual layout, such as page and staff size. These options 
can be set in each layout independently in the Layout Options dialog. See also layout.

linear point
A change in value in a track or lane in Play mode that acts as a point on a curve, setting a value 
for its position only and allowing for a smooth change in value from that position until the next 
point in the track or lane. See also constant point, value line.

lock duration
Functionality that allows you to change the pitches of existing music while retaining existing 
rhythms.

lyric
Any text that is intended to be sung or spoken by an individual singer or group of singers. A lyric 
can be a whole word or an individual syllable in a multi-syllabic word. Lyrics are shown at each 
rhythmic position where a new word or syllable begins. Typically, lyrics are found below the staff, 
but are sometimes placed above the staff, for example, in the case of a short score.

M
measure
See bar.
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MIDI
An abbreviation for Musical Instrument Digital Interface, a standard for how electronic musical 
instruments, computers, and virtual instruments can connect to and communicate with each 
other. In Dorico SE, MIDI data can be sent to one of 16 channels, which allow either a specific 
instrument, or a specific patch on a specific instrument, to receive and respond to the data. See 
also channel, patch, CC, PC.

minor key
A key signature based on a minor scale, which has a different pattern of intervals to a major 
scale. See also minor scale.

minor scale
A sequence of notes containing the pitches of a minor key. There are three types of minor scales: 
natural, harmonic, and melodic. Natural minor scales follow the interval pattern of the Aeolian 
mode, which on a keyboard is all the white notes from A-A. Harmonic minor scales also follow 
the Aeolian mode interval pattern but the seventh degree of the scale is sharpened, for example, 
G♯ in A harmonic minor. Melodic minor scales follow different interval patterns when they are 
rising/falling: when rising, melodic minor scales have sharpened sixth and seventh degrees, but 
when falling, the sixth and seventh degrees are both natural. See also minor key.

modes
Selectable workspaces in the project window that represent different phases in the workflow of 
preparing a score.

multi-bar rest
A consolidation of multiple adjacent empty bars into a smaller unit, typically shown as a single 
bar with the total number of bars' rest written above the staff. A multi-bar rest normally shows 
an H-bar symbol, which is a thick horizontal line with vertical lines at each end. In some older 
published scores, a multi-bar rest of up to nine bars in length is shown using a combination of 
double whole and whole rests. Also known as a “multirest”.

music area
The main part of the window in Setup mode and Write mode where you input and edit your 
music.

MusicXML
A file format designed to allow the interchange and archiving of music notation data in an open 
and non-proprietary way. It is useful for exchanging scores between different music applications.

N
node
A position along the length of a string that marks an equal division of the string, such as a 
quarter of the way along a string. Touching, but not fully stopping, a string at a node produces a 
harmonic partial. See also partial, harmonic series.

note input
The standard method of adding notes to staves in sequence that is possible when the caret is 
active. The caret automatically advances to the next rhythmic position after each note is input. 
During note input, it is also possible to input other items at the caret position. Also known as 
“step input” because notes are input step-by-step. See also caret, chord input, Insert mode.

O
overtone
See partial. See also harmonic series, node.
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P
padding
The minimum distance/gap between two items, such as text and its enclosure. Padding values 
can be independent of other set values, such as minimum height or width.

padding rest
A rest that fills the extra rhythmic space before or after cues that start or end partway through 
bars. This shows clearly how the rhythm of the cue fits within the current time signature and how 
it relates to the player’s existing material.

page break
The forced termination of a page of music at a particular rhythmic position, typically at a barline. 
Often used to ensure a convenient page turn in a part. In Dorico SE, page breaks can be achieved 
using frame breaks, which are indicated using signposts.

page view
A viewing option that shows music laid out on a page with a fixed width and height, as it appears 
when printed. See also galley view.

panel
Wide palettes of tools on the left, right, and bottom edges of the program window that are 
available in all modes, but their content varies in each mode.

part
The music belonging to the instruments played by one or more players, shown on its own rather 
than in a full score. Performers who do not need to see the music belonging to the whole 
ensemble play from parts so they only have to read the music they play themselves. See also full 
score, layout.

partial
A single pitch or frequency in the harmonic series, which varies in pitch according to the pitch 
of the fundamental but is always a consistent interval above the fundamental according to 
its number in the harmonic series. For example, the second partial is an octave above the 
fundamental, the third partial is an octave and a fifth above the fundamental, and the fourth 
partial is two octaves above the fundamental. Also known as simply a “harmonic” or “overtone”, 
although when described as an overtone it has a different number, as the first overtone is the 
same as the second partial. See also harmonic series.

patch
An older term for a discrete sound on a MIDI device or virtual instrument. See also channel, 
MIDI, PC.

PC
Short for “program change” or “patch change”, it is a MIDI message that allows you to access 
different sounds by switching to the corresponding programs. Because programs can also 
include effects presets, they allow you to change to specific sounds quickly, which is particularly 
useful in live performances. You can specify the programs that each PC switches to in each sound 
library using expression maps. See also MIDI, CC, patch.

pedal level change
A change to how far a piano sustain pedal is depressed, between 1 (fully depressed) and 0 (not 
depressed). It is notated as a change to the height of a pedal line. Also known as a “pedal lift”.

pick-up bar
A note or notes played before the first full bar of a piece. Also known as an “upbeat” or 
“anacrusis”. Pick-up bars often only comprise one or two beats whose main purpose is to lead in 
to the start of the piece.

pitch crossing
A possible situation on staves containing multiple voices or parts, such as condensed staves, 
where notes in down-stem voices have higher pitches than notes in up-stem voices. See also 
condensing.
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player
A musician who plays one or more instruments. Players are defined as either solo players or 
section players and are assigned to flows and layouts. See also solo player, section player, flow, 
layout.

playhead
A vertical line that moves alongside music during playback and when recording, showing the 
current rhythmic position. Also known as a “playback line”.

Play mode
A mode in Dorico SE where you can change how your music sounds in playback, including by 
changing the playback template and assigning VST instruments, inputting automation, adjusting 
the mix, and changing the sounding duration of notes in playback without affecting their notated 
duration. See also modes.

playthrough
A single time playing from the beginning of the piece to the end. Music that contains multiple 
possible endings, such as music with repeat endings or codas, requires multiple playthroughs.

plug-in
A software program that can operate within another software program. Dorico SE supports VST 
instruments and effects and script plug-ins written in Lua.

pointer
The symbol on the computer screen that follows movements made by the user with a mouse or 
on a touchpad. It is most commonly an arrow pointing towards the top left corner of the screen.

polymeter
Music containing multiple simultaneous meters, for example, one instrument in the ensemble 
plays in 6/8 and another plays in 7/4.

popover
A temporary value field that is evoked using a key command and allows you to input items using 
text entries. You can open popovers in Write mode during note input or when items are selected 
in the music area. There are dedicated popovers for different types of items.

preamble
The notations typically drawn before the first note or rest on each system of music. The preamble 
usually includes clefs, key signatures, and time signatures. In Dorico SE, the preamble is drawn 
automatically and so you cannot select any items included in it.

Print mode
A mode in Dorico SE that allows you to print and export the layouts in your project. See also 
modes.

print preview area
The main part of the window in Print mode where you can see a preview of what is going to be 
printed or exported as a graphic. See also Print mode.

project
A Dorico SE file that can contain multiple flows and layouts. See also flow and layout.

properties
The characteristics of individual items and fragments of items in your project that can be edited 
via the Properties panel. There are two types of properties: local and global. Local properties are 
layout- and frame chain-specific, meaning that by default, changing local properties for an item 
in one layout does not affect the same item in other layouts or other frame chains.

Q
quantization
In music, the act of adjusting the positions and durations of notes so they align with the nearest 
defined beat. This process eliminates small variations in rhythm and duration produced naturally 
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by live performers, and can be useful when importing/exporting MIDI data as quantized music 
produces neater notation.

R
rastral size
The size of a full five-line staff, measured from the bottom line to the top line. The term comes 
from the rastra engravers historically used to draw five-line staves on blank paper. Because the 
rastrum is a fixed object, people became used to their set sizes and Dorico SE continues this 
tradition by offering users a selection of rastral staff sizes.

reducing
The process of taking music for more than one instrument and assigning it to fewer instruments, 
such as a keyboard reduction of a choral piece. A piece of music that has been reduced is known 
as a “reduction”. See also exploding.

rhythmic grid
A unit of rhythmic duration whose value affects certain aspects of inputting and editing, such as 
the amount by which items move. Its current value is shown by the note value in the status bar, 
and by ruler markings indicating beat divisions and subdivisions above the staff on which the 
caret is active. See also caret.

S
score
See full score, part, project.

section player
Multiple musicians who all play the same instrument and read from the same part layout, for 
example, Violin I. Section players may not play multiple different instruments, but can divide. See 
also player.

segment
Part of a notation item that functions autonomously in Engrave mode. Segments can exist 
regardless of their position, such as individual ending brackets within a repeat ending, or only 
when a single item is split across a system or frame break, such as glissando lines. See also item, 
fragment.

Setup mode
A mode in Dorico SE where you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how they 
interact with each other, for example, by changing the players assigned to layouts. See also 
modes.

SMuFL
Short for “Standard Music Font Layout”, it is a font specification that maps all the different 
symbols required for music notation onto a standard layout. Dorico SE requires SMuFL-compliant 
fonts for certain areas of the program, such as clefs and dynamic glyphs, to ensure it can locate 
the correct symbol. SMuFL-compliant fonts include Bravura, Petaluma, and November 2.0.

solo player
An individual musician who can play one or more instruments, for example, a flute doubling 
piccolo. See also player.

space
A unit of measurement in music engraving based on the distance between the center of two 
adjacent staff lines. Practically all notation items are scaled in proportion to the size of a space, 
for example, a notehead is normally one space tall.

spacing
The act of determining the horizontal distance between successive columns in order to format 
the music. Horizontal spacing in Dorico SE considers the graphical shape and size of notes and 
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other items, such as rhythm dots and accidentals, and the note spacing values set. Full systems 
are automatically horizontally justified.

spelling
The way in which a note of a given pitch is specified by a letter name plus an accidental. For 
example, assuming the conventional 12-EDO pitch system, MIDI note 61 can be spelled as C♯, D♭, 
and B. The same pitch is normally spelled a certain way in a given key, for example, MIDI note 61 
is normally spelled as C♯ in D major, but is spelled as D♭ in A♭ major. See also EDO, MIDI.

split stem
A way of presenting altered unisons that keeps each accidental directly beside the notehead to 
which it applies. Also known as a “cherry stalk” or “tree”.

staff-relative placement
The vertical position of items relative to musical staves, that is, either above or below.

string shift indicator
An angled line that indicates the direction of movement when string players have to shift 
position on the fingerboard to play a higher/lower note with the same finger as the previous 
note.

stroke
The short line that bisects editorial slurs and ties. Also known as a “notch”.

SVG
SVG stands for Scalable Vector Graphics, which is an XML-based way of displaying and modifying 
graphics. Due to the way it is coded, it allows you to modify graphics very flexibly compared to 
other formats.

system
A horizontal span of music that is played together. Most printed music displays systems 
spanning the full width of pages. A system can contain any number of staves. For example, 
in orchestral full scores, systems typically contain staves for all instruments in the orchestra, 
meaning a single system often occupies the full height of the page. In part layouts, each system 
only contains the staves required for that player, which is often a single staff and means multiple 
systems can fit on each page. See also system break, page break, casting off.

system break
The forced termination of a system of music at a particular rhythmic position, typically at a 
barline. Indicated in Dorico SE with signposts.

system formatting
The distribution of bars into systems and systems into frames. When copying part formatting 
between layouts, Dorico SE considers the positions of system breaks, frame breaks, and note 
spacing changes to be aspects of system formatting.

system object
An item that applies to all staves in the system, but is not necessary to show on every staff, such 
as tempo marks and rehearsal marks. In Dorico SE, you can show system objects at multiple 
positions in each system by showing them above multiple instrument families.

T
tempo track
The timing-related information included in MIDI data that affects tempo, SMPTE offsets, time 
signatures, timecodes, and markers, which can be imported independently of the rest of the data 
in MIDI files.

token
A code used in a text string that is automatically replaced by a piece of information from 
elsewhere in the project, such as the title of the current flow, the name of the player, or the 
page number. Also known as a “wildcard” or “text code”.
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touchpad
Any flat device with a tactile sensor that functions as an alternative to the traditional computer 
mouse. Commonly built into laptop computers but can also be separate appliances connected 
wirelessly or via a cable.

transport
Encompasses all options related to playback and recording.

transposed pitch
In transposed pitch, the pitches notated are the pitches that the instrument plays, rather than 
the desired sounding pitch. Instrumental parts are always in transposed pitch so that players can 
simply play the written notes, which is especially important for transposing instruments. See also 
concert pitch, instrument transposition.

tuplet
A rhythm that is performed at a fraction of its normal written duration. For example, a triplet is 
three notes of a given note value played in the time it would normally take to play two notes of 
that note value. Also known as an “irrational rhythm” or a “countermetric rhythm”.

tutti
Italian for “everyone”, tutti indicates that a passage of music is to be played by all players reading 
from that part or staff. It is most commonly used to indicate the end of a divisi passage, or for 
clarification when a staff can indicate both solos and tutti passages at different times. See also 
divisi.

U
upbeat
See pick-up bar.

V
value line
A visual representation of value over time in tracks or lanes in Play mode. Fully horizontal value 
lines indicate a constant value, while angled value lines indicate a smooth change in value within 
a given duration, usually between two points. See also constant point, linear point.

vertical justification
The spreading out of staves and systems across the full height of frames with as even a 
distribution of space as possible. If the music in the frame requires less vertical space than 
is available, the remaining space is distributed evenly between the systems, and between the 
staves of the systems. See also frame, justification.

vibrato bar
A device on electric fretted instruments, typically guitars, that allows the performer to add 
vibrato to notes and to adjust the pitch of notes, similar to a guitar bend. Also known as a 
“whammy bar”, “tremolo bar”, “tremolo arm”, or “vibrato arm”.

voice
In Dorico SE, a series of notes, chords, rests, and other notations that make up a single musical 
line and are normally played by the same instrument. Assigning notes and items to different 
voices allows multiple lines of music to be presented on the same staff as clearly as possible, 
such as in vocal music where the soprano line uses an up-stem voice and the alto line uses a 
down-stem voice. Dorico SE allows as many voices as are needed to be input onto a single staff, 
and lays them out and spaces them automatically.

VST instrument
Short for “Virtual Studio Technology instrument”, it is a digital plug-in that converts MIDI data 
into audio output. It can emulate an existing piece of studio hardware or can be an entirely new 
creation.
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W
Write mode
A mode in Dorico SE where you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. See also modes.
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Index

A
abbreviated

dates 401
dynamics 628, 640
staff labels 109, 902, 903
tempo text 931

absolute channel change actions 501
absolute tempo changes 927

components 927
Academico font 396
accelerando. See gradual tempo changes. See also trills
accents. See articulations
acciaccaturas. See grace notes
accidental duration rules 545

common practice 545
accidental spelling 187

changing 200
accidentals 541

altered unisons. See altered unisons
appearance 542
brackets 542, 736
cancellation 545, 546
cautionary 545
changing 185
chord symbols 606, 607
chords 543
collision avoidance 543
deleting 541
duration rules. See accidental duration rules
enharmonic equivalents 200
figured bass 316
guitar pre-bends 777
harmonics 736
harp pedaling. See harp pedaling
hiding 541, 542, 736, 749
inputting 168, 185
kerning 544
key signatures 541, 693, 698
layout names 131
lines 832
microtonal 545
MIDI input 187
none 216, 542, 694, 695, 736
octave divisions 700
ornaments 741, 753
panel 146, 219
parentheses 542, 736
part names 131
pitch before duration 168
quarter tones 545
respelling 200
restating 545
showing 541, 542, 736, 749
signposts 349
spacing 544

accidentals (continued)
stacking order 543
ties across breaks 542, 945
titles 399
tokens 399
tonality systems 700
transposing 203
trills 748, 749, 752, 753

actions 494, 501
activating 160

caret 160
chord input 144, 192
dotted notes 144
force duration 144
grace note input 144
independent voice playback 460
Insert mode 144, 178
lock to duration 144
mouse input 144, 169
note input 160, 161, 165
pitch before duration 144
plug-ins 418
rest input 144
scissors 144
system track 338
tuplet input 144
VST instruments 418

adagio. See tempo marks
add intervals popover 198

adding notes 197
transposing notes 201

Add Marker dialog 318
add-on switches 492, 500
added notes

chord symbols 251
adding. See inputting
additional

endings 326, 327, 853
voices 174, 997

additive time signatures. See time signatures
advanced options

hiding 35
showing 35

advancing
caret 161
chord symbols popover 252
lyrics popover 313

aeolian chord symbols 251, 606
aggregate time signatures 220, 951

dashed barlines 220, 951
inputting 220, 222, 224, 225

aikin noteheads 722, 723
alignment

arpeggio signs 760
chord symbols 604
dynamics 630, 647, 648
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alignment (continued)
gradual dynamics 632
instrument names 132
lines 826, 832
lyrics 701, 711
notes 998, 999. See also voice column index
octave line numerals 625
ornaments 742
pedal lines 803
playing techniques 821
repeat endings 855
rests 879
staff labels 132
tempo marks 929
text 308, 404
trills 743
voices 998, 999. See also voice column index

allegretto. See tempo marks
allowing. See activating. See also enabling
alterations

chord symbols 251, 599
jazz ornaments 270

altered bass notes 251, 256, 599
inputting 251, 256

altered unisons 544
appearance 545
formatting 545
split stems 544

alternating time signatures. See time signatures
alto clef. See clefs
anacrusis. See pick-up bars
angles

beams 580, 588
fanned beams 588
fingering slides 669
glissando lines 763
lines 305, 823, 829
slurs 890
string shift indicators 671
tremolos 964

annotations 356, 537
comments 356
highlights 601, 604, 861, 864, 869, 870
lines 825
note/rest colors 727, 882, 997
signposts 349
voice colors 997

appearance
default settings 90
resetting 344

appending
subito 640

appoggiaturas. See grace notes
Arabic numerals

page numbers 791
arco. See playing techniques
areas

editing 109, 983
music 28
print preview 30
project start 28

arms
vibrato. See vibrato bar

arpeggio signs 757, 760, 823
alignment 760
appearance 757–759
beat-relative playback 761
brackets 757
changing 342
cross-staff 273, 274
curved 268
deleting 350
direction 757
duration 762
ends 759
filter 340
fingerings 668
formatting 758, 759
grace notes 761
inputting 266, 268, 273, 274
length 273, 274, 760
moving 760
muting in playback 462
panel 270, 274
playback 761, 762
popover 268, 273
position 760, 761
spacing 760
swash 757
types 268, 758
voices 273, 274

arrangements
accidentals in key signatures 693
flows 122
movements 122

arranger 88, 399
arranging 350, 351

changing instruments 107
condensing. See condensing
copying 351, 352
filters 340, 341
pasting 352
reducing 392. See also condensing
swapping staves 353
voices 353, 354

arrows 823
arpeggio signs 757
caps 834
disclosure 35
lines 825
noteheads 721, 723

articulations 547
changing 548
collision avoidance 550
copying 547
deleting 548
duration 547, 551
inputting 168, 209, 210
inverting 550
jazz. See jazz articulations
key commands 210
kits 981
moving 550, 551
notes 549
order 549
overlapping 550
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articulations (continued)
panel 146
percussion 511, 981, 985
pitch before duration 168
placement 549–551
playback 460, 489, 511–513, 551
playing technique-specific noteheads 511
position 548–550
slurs 549, 551, 890
stems 549
ties 550, 551, 938
tremolos 511
tuplets 209
types 547

artificial harmonics 733
accidentals 736
changing 740
hiding 734
partials 735
pitch 735
playback 733–735
showing 734
styles 737, 740

assigning
expression maps to endpoints 488
flows to layouts 93, 126
instruments to endpoints 487
key commands 50
master pages 370
MIDI commands 50
percussion maps to endpoints 488
players to flows 93, 123
players to layouts 93, 125
voices to endpoints 487

atonal key signatures 694
attachment lines 20

caesuras 265
dynamics 646
hiding 345
playing techniques 819
text 397

attachment points
lines 305, 306, 823, 826

attack
articulations 547
dynamics 628
playback 488

attribute playback techniques 513
audio

buffer size 207, 208
device setup 45
dialog 74
exporting 73, 74
mixer 469
outputs in mixer 482
playback 473, 479
repeats 464
videos 141
volume 141, 469
warning 32

auditioning
chords 342
MIDI devices 204
notes 204, 341, 342

augmented 198
accidentals 545
chord symbols 250, 599
intervals 198, 267, 545, 749, 750
trills 267, 749, 750

author name 356
changing 361

auto-save 76, 77
date and time 77
deleting projects 76
disabling 78
interval 78
recovering projects 77

automation lanes 439
constant points 442
copying points 443
deleting points 445
dynamics. See dynamics lanes
editing 444
hiding 441
inputting data 441
linear points 442
moving points 444
showing 441
tempo 447, 449
velocity. See velocity lanes

auxiliary notes 752
notehead design 723
position 753
showing 753

B
backgrounds 43

colors 44
erasing 674
gradients 44
pages 44

backups 78
auto-save. See auto-save
location 79
number 78

balalaika. See fretted instruments
bands

staff grouping 55, 594
templates 55

banjo. See fretted instruments
bar counts

multi-bar rests 565
bar numbers 563

alternative 573
appearance 563
changing 571
comments 356–358
default settings 563
deleting 571
enclosures 564
erased backgrounds 564
font 566
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bar numbers (continued)
frequency 563
galley view 34
guide 566
hiding 563, 566, 569
layout options 563
moving 567, 568
multi-bar rests 565
multiple positions 567
paragraph styles 566
pick-up bars 953
position 567, 568
ranges 565
rehearsal marks 842
repeat sections 573
returning to primary sequence 573
sequence changes 570
showing 563, 566
signposts 349
staff-relative placement 567
subordinate 572
subsequent repeats 573
system-relative placement 569
time signatures 569

bar repeats 861
bar numbers 565
casting off 385
changing 342, 862
changing number 865
consolidating 885
counts 864, 865
deleting 350
dynamics 862
filter 340
font style 864
frame breaks 387
frequency 865
grouping 867
handles 863
hiding counts 866
highlights 861, 864
inputting 324, 325, 333
length 863
moving 862
multi-bar rests 885
panel 325
parentheses 866
phrase length 342, 862
playback 342, 862
popover 324
regions 861
symbols 867
system breaks 388
types 324
viewing options 864

bar rests 884
counts 885
deleting 883
hiding 884
inputting 188, 236
moving 886
multi-bar rests 885
showing 884

barline joins 560, 561, 594
barline-attached lines. See lines
barlines 558

across staves 560, 561
caesuras 265
changing 240, 242
copying 123
custom joins. See barline joins
dashed 558
deleting 560
double 558
dynamics 630, 632
fermatas 692
final 558
grace notes 684
grand staff instruments 560
hiding 220, 951
inputting 235, 237, 238, 240, 242, 555
joins. See barline joins
key signatures 696
moving 560
none 220, 951
panel 238, 242
popover 235, 237, 240, 242
rehearsal marks 839
repeat 464, 558
scale size 558
short 558
signposts 349, 560
single 558
staff grouping 561, 594
staves 560, 561
thickness 558
tick 558
time signatures 561
triple 237
tuplets 970
types 237, 558

Baroque
appoggiaturas 682, 686
figured bass. See figured bass
ornaments 270, 741
trills 754, 756

barré 813
adding 613
chord diagrams 609, 614
hiding 815
inputting 291, 295, 297

bars 11, 553
bar rests. See bar rests
beam grouping 20, 590
chord symbols 601
combining 556
deleting 236, 553, 554
deleting contents 555
display 472, 473
divisions 555
duration 553
fixing number 385, 386
glissando lines 764
going to 347
grouping 867
inputting 235, 236, 238–240
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bars (continued)
length 553
moving 387
multi-bar rests 884, 885
navigation 347
note grouping 20, 590
numbers 563
panel 238, 239
pick-up bars 953
popover 235, 236, 238
repeat 853, 857, 861
rests. See bar rests
selecting 338
splitting 555
timecodes 851
tuplets 970
upbeats. See pick-up bars
vibrato. See vibrato bar. See also guitar
width 382

Bars and Barlines panel 238, 239, 242
Bartók pizzicato. See playing techniques
base switches 492, 500
baseline

text 308
bass clef. See clefs
bass guitar. See fretted instruments
bass notes

altered 256
figured bass. See figured bass

beam corners 586
beam groups 19, 575, 590

creating 577
defining 590
pick-up bars 953
resetting 577
stem directions 923
time signatures 575

beam lines
number 587

beam slants 580
changing 580
grace notes 686

beaming 575, 577, 588
centered beams 581, 582
corners 586
cross-staff 583, 585
direction 578–580
fanned 588
grace notes 685, 686
grouping 575, 577, 590. See also beat groups
half-bar 590
handles 580
inverting 578, 579
large pitch ranges 686
meter 590
multiple staves 585
notes 577
optical cross-staff spacing 584
partial 578
placement 578, 583
primary beams 586
resetting 577, 579, 582
rests 577, 588

beaming (continued)
secondary beams 586, 587
slants 580, 686
spacing 584
splitting 576
staff-relative placement 578, 579
stem direction 578, 585
stemlets. See stemlets
tablature 918
ties 189
time signatures 575, 590
tuplets 588
unbeaming 578

beat groups 19, 575, 590
defining 590
numerators 956
specifying 220
ties 938
time signatures 956, 957

beat units 932
deleting beats 236
inputting beats 236
metronome marks 342, 933
setting 231
tempo marks 230
tuplets 197

beats
deleting 236, 553
display 472, 473
inputting 236, 238, 240
per minute 932
pick-up. See pick-up bars
popover 236
recording latency 207
relative position 344
selecting 339

bend intervals 774
microtonal 774

bends
guitar. See guitar bends. See also dives
jazz. See jazz articulations. See also jazz ornaments
vibrato. See vibrato bar

bindings. See ties. See also laissez vibrer ties
birds eyes. See fermatas
black noteheads 718, 719
blank staves

after flows 375
blue selections 648, 899
Blues guitar post-bends 772
body

changing 833
lines 823, 825, 833

bold text 308
bomb

dive. See dives
booklets 532

duplex printing 532
printing 530, 532

borders 404, 537
exporting 525
harp pedaling 797
printing 522
text 404
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bottom panel 31
bowing. See playing techniques
boxes. See borders. See also frames
bpm 932

changing 450, 933
braces 592

hiding 596
secondary brackets 595, 596
showing 596
signposts 349
staff spacing 371, 372, 408

bracketed noteheads 728, 729, 782
changing type 729
chords 728, 729, 731
ghost notes 729
guitar bends 768, 771
hiding 729
inputting 729
percussion 729
playback 729
showing 729
splitting 731
tablature 728, 729, 768, 773
tie chains 730
ties on tablature 730, 938
vibrato bar dives and returns 773

brackets 592
arpeggio signs 757
barlines 560
ensemble types 55, 594
fingerings 667
grouping 119, 593
hiding 596
horizontal. See lines
layouts 593
noteheads. See bracketed noteheads
player groups 119, 561
project templates 55
secondary 595, 596
showing 596
signposts 349
staff spacing 371, 408
sub-brackets 595, 596
sub-sub-brackets 597
templates 55
time signatures 954, 955
tuplets 973

brass instruments
fingerings 660, 670
horn branch indicators 671
playing techniques 294
transposition 104

Bravura music font 396
breaking

multi-bar rests 884
tie chains 947

breaks
frame 387
page 387
system 388

breath marks 687, 688
appearance 342
deleting 350

breath marks (continued)
inputting 262–264
moving 691
multiple at same position 690
placement 689
position 689
types 342, 688

breves. See double whole notes
Britten fermata 687
buffer

audio 207, 208

C
C clef. See clefs
cadenza 220, 553, 951
caesuras 687, 689

appearance 342
deleting 350
inputting 262–265
moving 691
multiple at same position 690
placement 690
position 265, 690
types 342, 689

cancellation
accidentals 545, 546
double accidentals 546

candidate menus
playing techniques popover 291
tempo popover 229

caps 818, 825
arrows 834
changing 834
continuation 825
lines 825

cards
disclosure arrows 35
flows 87
layouts 85
players 81
timecodes 87

caret 157
activating 160
advancing 161
chords 157, 192
deactivating 160
extending 161, 177
grace notes 157, 190
inputting vs. editing 153
Insert mode 157, 178
lock to duration 157
moving 155, 161, 968
multiple staves 161, 177
percussion kits 180
rhythmic grid 155, 156
slash voices 157
slashes 175
tablature 157
types 157
voice indicator 157, 174, 637
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casting off 385
bars per system 385
copying to other layouts 393, 394
staff spacing 408
systems per frame 386

categories
templates 55, 594

cautionary accidentals 545
hiding 542, 736
parentheses 545
showing 542, 736
tie chains 542, 736, 945
trills 748

cautionary fingering 665
cautionary key signatures 699
CC64

pedal lines 66, 208
centered beams 581

creating 582
removing 582

centered text
hairpins 640

centimeters
unit of measurement 45

chains
frames 366
ties 938

change labels
instruments 102, 103

channel change actions 482, 488, 501
channels 469

changing 487
controls 469, 471
endpoints 481
expression maps 482, 488, 501. See also channel 
change actions
instruments 487
meter 469
MIDI 469
mixer 469, 471
percussion maps 482, 488
playback 481
plug-ins 482
setup 482
strips 471

character styles
missing fonts 58

cherry stalks. See split stems
choir templates 55

staff grouping 55, 594
Choose Chord Diagram dialog 612
choral

lyrics 701
playing techniques 294
verse numbers 716

chord brackets. See bracketed noteheads
chord diagrams 598, 608

barré 609, 614
changing 612
colors 612, 614
components 609
copying shapes 612
custom 613

chord diagrams (continued)
dots 613, 614
editing 613
formatting 613, 614
fret numbers 613, 614
gaps 610
grid 610
hiding 609, 610
nut 609
omitted strings 609, 614
open strings 609, 614
resetting 614
rows 610
shapes 612–614
showing 609, 610
symbols. See chord symbols
tuning 116, 118, 610, 612

chord input 194
activating 144, 192
arpeggio signs 273
caret 157
exploding 177
multiple staves 177
register selection 164
tablature 184, 192

chord symbol components 599
inputting 249
popover 249
types 599

chord symbol regions 601
handles 603
hiding 600, 605
highlights 604
inputting 256
length 603
moving 602
showing 600, 605

chord symbols 598
added notes 251
alignment 604
altered bass notes 256
changing 342
components. See chord symbol components
deleting 350
diagrams. See chord diagrams
enharmonic spelling 606, 607
figured bass 313, 315
filter 340
global. See global chord symbols
hiding 600, 601, 605
highlights 604
inputting 249, 252, 253, 255, 256
instruments 253, 600, 605
intervals 250
inversions 255
layouts 601
local. See local chord symbols
MIDI input 249
MIDI navigation 50
modal 251, 606
moving 605
MusicXML import 607
navigation during input 252
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chord symbols (continued)
no chord 251
omissions 251
pitch 127
playback 452, 453
players 253, 600, 605
polychords 251, 255
popover 249
position 604
quality 255, 601
regions. See chord symbol regions
root 255, 601
roots 250
selecting 334, 337–339
showing 253, 256, 600, 601, 605
signposts 349, 598, 601
slash regions 600, 601, 869
staves 253, 600, 605
suspensions 251
systems 605
track. See chords track
transposing 127, 202, 203, 599
transposing instruments 127, 606, 607
types 249, 599
viewing options 604

chords
accidentals 543
arpeggio signs 760
auditioning 342
bracketed noteheads 728, 729, 731
caret 157, 161, 192
collision avoidance 543
dense 543
figured bass 313, 315, 651, 658
fingerings 668
guitar bends 768, 772
inputting 144, 177, 192
post-bends 772
register selection 164
rolled. See arpeggio signs
stacking accidentals 543
stem directions 922
tablature 165, 184
ties 943
track. See chords track
velocity 438. See also velocity lanes
vibrato bar dives and returns 773

chords track 452
chorus lyrics 703

changing lines to 713
changing lyrics to 704
popover 311

chromatic glissando 763
playback 766

circle
bar number enclosures 564
harmonics 737, 739
noteheads 719, 723, 985
string indicators 674
tapping 779

Classical
ornaments 270
trills 754, 756

classical guitar. See fretted instruments
clefs 616

deleting 618
filter 340
grace notes 618
hiding 258, 259, 619
Indian drum 259, 996
inputting 256–259
instruments 83
key signatures 696
layouts 619
moving 617, 618
octave indicators 620, 621
panel 259
placement 617
popover 257, 258
position 617, 618
showing 619
signposts 349, 619
tie chains 617
ties 945
tokens 399
transposing instruments 83
transposition 619–621
types 257

Clefs panel 258, 259
click 472

count-in 204
disabling 458
enabling 458
MIDI recording 204
mixer 469
playback 447, 458
sound 447

closing tabs 39
coda 857

gap 859, 914
indent 859, 914
inputting 329
mid-system gap 857, 859
multiple 858
sections 857

codec 137
codes 397

time 849
col legno. See playing techniques
collapsing. See expanding
collision avoidance

articulations 550
dynamics 630
galley view 410
slurs 891, 895
staves 371, 372, 408, 410
ties 939

colon
dynamics 634
tuplets 975

colored regions 427, 604, 864, 870
dynamics lane 429
exporting 537
hiding 345
printing 537
time track 447, 449
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colors
background 44
bar repeats 864
chord diagrams 612, 614
chord symbol regions 604
dark theme 43
graphics 536
light theme 43
monochrome 536
note ranges 727
noteheads 722
pages 44
resetting 44
rests 882
slash regions 870
tablature 727, 917, 919
text 308
voices 997
windows 43

columns
accidentals 543
figured bass 651
lines 827
voices 998, 999

combinations
playback techniques 499, 503, 511
tremolos 511

combined dynamics. See dynamics
combining. See consolidation
comma

breath marks 688
commands

key commands 47, 50
MIDI 47, 50

Comment dialog 357
comments 356

adding 357, 360
authors 356, 361
bar numbers 357, 358
changing 360
deleting 350, 358
dialog 357
exporting 358, 361, 525, 537
hiding 361
initials 356, 361
instruments 358
list 358
panel 358
printing 361, 522, 537
replying 360
showing 361

common practice accidental duration rule 545
common time 693, 951
components

articulations 548
chord diagrams 609
chord symbols 249, 599
lines 825
tempo marks 927

composer 88
default master pages 680
text tokens 397

compound figured bass intervals 313, 315, 658

compound time signatures 951
inputting 220, 222, 224, 225

compressed MusicXML 63, 64
con sordino. See playing techniques
concert pitch 127

clefs 619, 620
input pitch 167
instrument transpositions 904
layouts 124, 127
staff labels 901, 904
status display 32
viewing 127

condensing 371–373, 382, 392
divisi 908
extra staves 910
ossia staves 911
paragraph styles 908
signposts 349
staff labels 908

conditions
expression maps 495, 503

conductor score. See condensing. See also layouts
configurations

endpoints 482, 484–486
consolidation 556

bar repeats 885
bars 556
players 120
rests 881, 884, 885
staff labels 908
staves. See condensing

constant points 433, 442
inputting 432, 441

contents
bars 555
front matter 680
table 680

continuation caps 825
continuation lines 818, 823

duration 819
dynamics 628, 641
gradual dynamics 643
hairpins 632, 643
inputting 291, 295, 297
pedal lines 801, 808, 809
playing techniques 818, 820, 821
slurs across breaks 890
tempo marks 935–937

continuation signs 810
lines 825
parentheses 809
text 811

continuous controller 501
contrapuntal. See counterpoint
control change actions 501
control changes 494
controllers

automation 439
expression maps 488
MIDI. See MIDI controllers

conventions
arpeggio signs 760
breath marks 689
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conventions (continued)
caesuras 690
dynamics 629
fermatas 689
fingerings 661
glissando lines 763
grace notes 683
harp pedaling 798
key signatures 693, 696
lyrics 701
ornaments 742
pauses 689
pedal lines 803
playing techniques 815
rehearsal marks 839
rests 879
tempo marks 929
ties 939
time signatures 950
tremolos 964
trills 742
tuplets 967
voices 998

converting
layouts to graphics files 525
notes into tuplets 969
PDF 525
tuplets into normal notes 969

copies
printing multiple 522

copying 350–352
articulations 547
automation 443
barlines 123
chord diagram shapes 612
Chord mode 194
dynamics 342, 434, 636
flows 59, 123
Insert mode 179
instruments 97
lyrics 706
notes 547
page formatting 393
part formatting 394
players 97
playing techniques 820
properties 395
slurs 342

copyright 88, 399
corners

beaming 586
crop marks 537

count-in
duration 204
metronome click 204

counterpoint 188
bar rests 188
voices 174, 997

counts
bar numbers 573, 953
bar repeats 864–866
frames 849
lyrics 708

counts (continued)
multi-bar rests 885
page numbers 401
pick-up bars 953
placement 877
repeat endings 853
repeat sections 573
rhythm slashes 876, 877
staff-relative placement 877
timecodes 849

cowbell. See unpitched percussion. See also playing 
technique-specific noteheads
creating. See inputting
crescendo. See gradual dynamics
crop marks 537

exporting 525
printing 522

cross noteheads 720, 723
dead notes 782
percussion 985

cross stick. See unpitched percussion. See also playing 
technique-specific noteheads
cross-staff beams 583

placement 585
spacing 584

cross-staff slurs 211, 895
length 895, 898
moving 895, 897

cross-staff ties 189, 946
cross-voice slurs 211, 895

length 895, 898
moving 895, 897

cross-voice ties 189, 946
crotchets. See quarter notes
Cubase

expression maps 488, 505
instrument names 902
staff labels 902

cue labels
staff-relative placement 343

cues 627
signposts 349
spacing 406
staves 383

curlew fermata 687
cursor

caret 157
chord symbols 252
fingerings 212
lyrics 313, 708
text 397

curvature direction
grace notes 889
guitar bends 343
guitar pre-bends 776
slurs 889, 893, 894
ties 939, 943, 944

curved arpeggio signs 757
duration 762
inputting 268
playback 761, 762
popover 268
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custom
barline joins 561
chord diagrams 613
endpoint configurations 484
layouts 93
markers 318, 846
note sizes 724
page size 533
paper size 533
playback templates 473, 476, 479
player order 98
repeat markers 858
score layouts. See layouts
staff order 98
staff size 384
tonality systems. See custom tonality systems
trill speeds 755
tuning 116, 118, 119, 609, 610

custom playing techniques
playback 512

custom score layouts. See layouts
Custom Staff Size dialog 384
custom tonality systems 700

creating 700
editing 700

cut common time 693, 951
cutting

slash regions 874
tie chains 947

D
da capo

al coda 857
al fine 857
al segno 857
inputting 329

dal segno 857
damping. See playing techniques
dark theme 43
dashed

barlines 220, 951. See also aggregate time 
signatures
guitar bend hold lines 775
hairpins 643
jazz articulations 788
lines 305, 823
octave lines 622
slurs 891
string indicator lines 674, 675
tempo marks 937
ties 941, 942
vibrato bar lines 287, 288, 784

data
expression maps 489

date and time 
annotations 537
auto-saved projects 77
comments 356
exporting 525
printing 522
tokens 401

deactivating
caret 160
chord input 192
Insert mode 178
mouse input 169
mute states 462
muted tracks 469
note input 161, 165
solo states 462
soloed tracks 469

dead notes 782
hiding 782
playback 782
showing 782

decimal places
metronome marks 233, 234, 933

decorations. See ornaments
decrescendo. See gradual dynamics
dedications 88, 680

text tokens 397
default flow headings 364
default master pages 364

composer 680
lyricist 680
title 680
tokens 680

default playback templates 474
default settings 45, 90

accidentals 168
articulations 168
beam grouping 577
dynamics 342
file names 528
flow headings 364
hand tool 33
instrument names 131, 132, 134
key commands 13, 47, 50
layouts 129
marquee tool 33
mouse input 154, 155
note input options 168
note spacing 406, 407
playback template 479
playing techniques 818
rhythm dots 168
selection tools 33
slurs 342
staff grouping 594
staff labels 131, 132, 134
staff spacing 371, 408
tablature strings 161, 165

delay
glissando line playback 766

deleting 350, 363
accidentals 541
arpeggio signs 350
articulations 548
auto-saved projects 76, 77
automation 445
bar number changes 571
bar repeats 350
barlines 560
bars 236, 553–555
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deleting (continued)
beams 578
beats 236, 553
breath marks 350
caesuras 350
centered beams 582
clefs 618
comments 350, 358
dynamics 436, 636
empty pages 21
endpoints 484, 486
fermatas 350
figured bass 350
fingerings 665
flow headings 379
flows 124, 126
frame breaks 388
frames 379
gaps between notes 170
glissando lines 350
grace notes 350
groups from percussion kits 114
guitar bends 350
guitar post-bends 777
guitar pre-bends 777
guitar techniques 785
Insert mode 179
instrument transpositions 132, 905
instruments 98, 108, 115
jazz articulations 789
key commands 51
key signatures 695
layouts 128
lines 350
lyrics 706
markers 350
notes 350, 425, 553
octave lines 626
ornaments 350
overlapping notes 170
pauses 350
pedal lines 350
playback overrides 516
playback techniques 504, 513
players 98, 120, 121, 123, 125
playing techniques 350
rehearsal marks 841
repeat endings 350
repeat markers 350
rests 170, 883
rhythm slashes 350
rhythmic feel change 468
scoops 785
slurs 350
stem direction changes 925
string indicators 676
strings 116
system breaks 389
tapping 785
tempo marks 451, 932
ties 947
time signatures 961
titles 379

deleting (continued)
tremolos 965
trill intervals 751
trills 350
tuplets 969, 972
velocity changes 439
vibrato bar 350
videos 141
voices 1000

denominators
styles 956, 957
time signatures 949

dense chords 543
accidental stacking 543

depth
nested tuplets 968

deselecting. See selecting
design

arrows 823, 834
grace note slashes 684
lines 823, 833, 834
noteheads 719, 722, 723
slurs 891, 893
time signatures 961

designation
strings. See string indicators

destination
exporting files 527
instruments 627
notes 669

devices
audio 45

diagonal
accidental stacking 543

diagrams
chords. See chord diagrams
harp pedaling 794, 795

diamond noteheads 720, 721, 723
accidentals 736
harmonics 734, 737, 739, 740
percussion 985

dimensions
page size 533
paper size 533

diminished. See augmented
diminuendo. See gradual dynamics
dips 778

inputting 286
intervals 782
popover 268

direction
arpeggio signs 757, 758
beams 578, 579
fanned beams 588
glissando lines 726
gradual dynamics 641
guitar bends 343
guitar pre-bends 776
hairpins 641
lines 835
paper orientation 534
partial beams 578
rhythm slashes 871
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direction (continued)
slur curvature 893, 894
stems 921, 923–925
string shift indicators 672, 726
tie curvature 939, 943, 944
transposing 202, 203

direction playback techniques 513
disabling. See enabling. See also deactivating
disclosure arrows 35

Expression Maps dialog 489
Properties panel 32
tracks 427

display options 23, 34
drum editor 420
frames 366, 367
image resolution 536
layouts 27
music area 28, 35
pages 367
panels 31, 37
piano roll editor 420
playback 473
print preview 30
project window 27
tabs 38
time 25, 473
transport 25

distance
bar numbers 568
braces 595
brackets 595, 597
chord diagrams 610
noteheads 584
stems 584
system indents 915

distribution
bars per system 385
staves per frame 372
systems per frame 386

dives 768, 773, 778
inputting 280–283
popover 268
pre-dives. See guitar pre-bends
vibrato bar. See vibrato bar. See also guitar bends

dividers. See system dividers
divisi 392, 916

condensing 392, 908, 916
hiding empty staves 373–375
hiding staff labels 903
playback 460, 487
signposts 349
staff labels 903, 908
staff spacing 372
staves 373–375

doits. See jazz articulations
dolce. See dynamic modifiers
dorian chord symbols 251, 606
DoricoBeep 447
dots

chord diagrams 608, 609, 613, 614
guitar tapping 779
rhythm. See rhythm dots. See also dotted notes

dotted
beat units 231
dynamics 628
hairpins 643
noteheads 722
notes. See dotted notes
octave lines 622
rests 144
slurs 891
tempo marks 937
ties 941, 942

dotted notes 172, 590
double 172
forcing 171
inputting 144, 172
note grouping 590
swing playback 466
tempo equations 937
triple 172

double 150
accidentals 200, 203, 546
barlines 237, 240, 242, 558
dotted notes 172
note durations 170
octaves 198
stems 544, 997. See also voices
values 150
whole notes 11, 146

doubling instruments 94
adding 105
inputting notes 161, 165
instrument changes 102, 103
labels 906
showing staves 42

down arpeggio signs. See arpeggio signs
down-stem voices. See voices
downloads

accessing 53
dpi 536
dragging 33, 348. See also drawing
drawing 33, 348, 413

automation 441
dynamics 432
notes 421. See also note input
tempo 447
velocity 438

drop frame timecodes 849
drops. See jazz articulations
drum editor 420, 995

deleting notes 425
event display. See event display
inputting notes 421
moving notes 422
selecting notes 413
tracks 426
zoom 426

drum kits. See percussion kits
drum rolls. See tremolos
drum sets 109, 978, 979

caret 180
defining kits as 112
exporting 980
filtering instruments 109

Index
 

1029
Dorico SE 3.5.12



drum sets (continued)
importing 980
inputting notes 180
naming 109
note input 182
setting up 109, 182
stem direction 112
voices 112, 993

duplets. See tuplets
duplex printing 522, 532

booklets 532
duplicating

expression maps 502
flows 123
items 351, 352
notes 352
percussion maps 509
playback templates 479
players 97
playing techniques 820
switches 503

duration 819
accidentals 545
arpeggio signs 762
articulations 547, 551
bars 20, 553
fermatas 342
figured bass 654
flows 400
forcing 171
grace notes 686
horizontal lines 831
jazz articulations 788
lines. See duration lines
locking 201
notated 515
notes 20, 146, 169, 170, 423, 515
pedal lines 812
played 515
playing techniques 291, 295, 297, 817, 819, 821
rests 169
slurs 900
string indicators 675
terminology 11
vibrato bar lines 784

duration before pitch note input 161
duration lines 818, 823

figured bass. See hold lines
handles 819
hiding 675, 784, 820
inputting 291, 295, 297
playing techniques 819, 821
showing 675, 784, 820
string indicators 301, 302, 674, 675
vibrato bar lines 784

dynamic glyphs 628
dynamic levels 243, 245, 247, 633

changing 435, 633
decreasing 633
increasing 633
playback 429

dynamic modifiers 628, 639, 926
appearance 640
centered 640
hairpins 640
inputting 243, 245, 247, 639
poco a poco 644
showing 634
subito 640

dynamics 628
alignment 630, 632, 647, 648
appearance 635
bar repeats 862
barlines 630, 632
changing 342, 435, 633
combined 628
continuation lines 628, 641
conventions 629
copying 636
crescendo. See gradual dynamics
deleting 636
diminuendo. See gradual dynamics
editing 435, 633
endpoint positions 632
expression maps 496
expressive text. See dynamic modifiers
filters 340, 636
flared hairpins 644
force 628
gradual. See gradual dynamics
grand staff instruments 245, 247, 637
grouping 647, 648
hairpins. See hairpins
handles 641, 642
hiding 634, 635, 640
humanize 429
hyphens 634, 643
immediate 628
inputting 243, 245, 247
intensity 342, 435, 633
lanes. See dynamics lanes. See also velocity lanes
length 435, 642
levels. See dynamic levels
linking 342, 648–650
modifiers. See dynamic modifiers
moving 435, 631, 640
muting in playback 341, 462
niente hairpins. See niente hairpins
non-sustaining instruments 646
panel 247
parentheses 633
percussion kits 982
placement 629
playback 341, 429, 439, 460, 464, 496, 512, 513, 
637
poco a poco 640, 644
popover 243, 245
position 629, 630
repeats 464
rfz 635
selecting 334
separators 634
sfz 635
signposts 349, 634
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dynamics (continued)
spacing 645
staff-relative placement 343
subito 640
sustaining instruments 646
text 643
types 243, 628
ungrouping 648
unlinking 342, 650
velocity 437, 438, 633
voice-specific 245, 247, 429, 432, 637
volume 633

dynamics lanes 243, 429, 628
constant points 433
copying points 434
deleting points 436
editing 435
hiding 431
inputting points 432
linear points 433
moving points 435
showing 431

Dynamics panel 245, 247

E
East Asian elision slurs 716

hiding 716
showing 716

Edit Chord Diagram dialog 614
Edit Endpoint Configurations dialog 486
Edit Instrument Names dialog 132
Edit Percussion Kit dialog 109
Edit Playback Techniques dialog 513
editing 153, 342

area 109, 983
inputting vs. editing 153
items 147, 342
lyric text 708
methods 334
mouse input 154, 155
notes 144
tools 334

editorial
notes 728, 729
slurs 891
ties 941

editors
drum 420
piano roll 420
text 308

EDO 700
effects channels 471

mixer 469
eighth notes 11, 146

beaming 575
beats 236
metronome marks 230
swing playback 231, 466
tempo equations 937
tuplets 197

elbowed beams. See centered beams
electric guitar. See fretted instruments

empty bars
deleting 554
inputting 238, 239
multi-bar rests 884
rests. See bar rests

empty pages
deleting 21, 397

empty staves 373
after flows 375
hiding 373–375, 408
showing 373–375, 408
tacets 389

empty voices 1000
enabling 160

auto-save 78
chord symbol playback 452, 453
click during playback 458
dynamics linking 342
independent voice playback 460
instrument changes 102
MIDI devices 209
partial harp pedaling 799
plug-ins 418
slurs linking 342
swing playback 231, 467, 468
system track 338
VST instruments 418

enclosures
bar numbers 564
rehearsal marks 839
text 404

end repeat barlines 237, 558
inputting 240, 242
playthroughs 464
repeat endings 853

endings
additional 326, 327
playthroughs 853
repeat. See repeat endings

endpoint positions
arpeggio signs 760
dynamics 632
lines 826, 831, 832
octave lines 625
pedal lines 805
repeat endings 856
slurs 551, 888–890
staff lines 889
ties 939
trills 743
tuplet brackets 974

Endpoint Setup dialog 482
endpoints 481

changing 487, 488
configurations 484
custom 485, 486
deleting 486
expression maps 482, 488
glissando lines 763
instruments 487
percussion maps 482, 488
plug-ins 473
renaming 486
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endpoints (continued)
saving 485
setup 482
voices 487

Engrave mode 363
engraving options

percussion 990
enharmonic spelling

accidentals 187, 200
chord symbols 606, 607
key signatures 698
MIDI 65, 204
modes 606
notes 187, 200
respelling 200

ensembles 81, 99
adding 83, 99, 121
brackets 55, 593, 594
divisi 916
groups 119, 121
staff grouping 55, 594
templates 55

envelopes
dynamics 429, 435

equal division of the octave 700
equalization 471
equations

tempo marks 231, 937
erased backgrounds

bar numbers 564
staff lines 664
string indicators 674

espressivo. See dynamic modifiers
even staff spacing 372
event display 418

automation lanes. See automation lanes
chords track 452
dynamics lanes. See dynamics lanes
inputting notes 421
instrument tracks 427
markers track 454
playing techniques lanes 445
time track 447
velocity lanes. See velocity lanes
video track 455
zoom 426

events
automation 439, 441
dynamics 429, 432, 434
markers 454
notes 421
tempo changes 447, 449
velocity 438

excluding 93
flows from layouts 93, 126
playback 462
players 123
players from flows 93
players from layouts 93, 125

exclusion groups
expression maps 489

exercises. See flows

expanding 334, 455
caret 161, 177
menus 35
notes 170
options 35
selections 334, 336
tracks 455

explicit rests 879, 880
colors 882
deleting 883
hiding 883
implicit rests 882
showing 883

exploding 161, 177
note input 161, 177

exponential hairpins. See flared hairpins
Export Audio dialog 74
Export File Names dialog 528
Export Flows dialog 61
Export MIDI dialog 69
Export MusicXML dialog 64
Export Tempo Track dialog 72
exporting 59

annotations 537
arrangements 530
audio 73, 74
borders 537
color graphics 536
comments 358, 361, 537
crop marks 537
date 537
expression maps 505
file names 528
flows 61
fretted instrument tunings 119
key commands 47
layouts 525
MIDI 69
monochrome graphics 536
MP3 files 73, 74
MusicXML files 63, 64, 856
note colors 537
options 520
output format 525
page ranges 524, 530
path 527
PDF 525, 527
percussion kits 980
percussion maps 511
playback templates 481
PNG 525, 527
repeats 464
signposts 537
stems 73, 74
SVG 525, 527
tempo tracks 72
TIFF 525, 527
time 537
voice colors 537
watermarks 537
WAV files 73, 74
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expression maps 488, 489
actions 494, 503
conditions 495, 503
creating 502–504
dialog 489, 499
dynamics 496
endpoints 481, 484, 488
exporting 505
file format 488, 505
filters 489
hiding playing techniques 815
importing 505
MIDI 650
mutual exclusion groups 497, 502, 504
order 489
pitch 489, 502
playback techniques 489, 499, 503
playing techniques 512, 815
resetting 498
switches 492, 500, 503
transpose 490, 492, 496
trills 754
volume 650

Expression Maps dialog 489
expressive text. See dynamic modifiers
extending. See expanding
extension lines

lyrics 313, 704, 712
trills 744–746

extra staves 910
condensing 910
divisi. See divisi
hiding 373–375
ossia staves. See ossia staves
showing 373–375
signposts 349, 910
ties 189

extracts. See flows

F
F clef. See clefs
factory default playback templates 474
fader 469
fallback

playback techniques 513
playback templates 476

falls. See jazz articulations
families

fonts 58
instruments 83, 476, 813

fanned beams 588
direction 588

fast-forwarding 457, 472
feathered beams. See fanned beams
feedback

comments. See comments
fermatas 687

appearance 342
barlines 692
changing 690
deleting 350
duration 342

fermatas (continued)
inputting 262–264
moving 691
multiple at same position 690
number per staff 691
placement 689
position 689
single staves 690
types 342, 687, 690
voices 691

figured bass 651, 655
accidentals 316
appearance 657–659
deleting 350
duration 654
fixing 658
font 657
global 313
handles 654
hiding 652
hold lines 655
input options 658, 659
inputting 313, 315
instruments 313
inverting 656
length 654
local 313, 651
moving 657
octaves 658
pitches 199
placement 655, 656
players 313, 652
popover 315
position 655
resetting 659
rests 313, 651, 653, 657
rows 655
showing 313, 652
signposts 313, 349, 651, 652, 657
simplifying 658
slashes 315
staff-relative placement 656
staves 313
suspensions 315, 655
transposing 201, 202
vertical position 652

file formats 535
audio 73
backups 78
expression maps 488, 505
graphics files 535
MIDI 65
MusicXML 63
percussion maps 511
playback templates 473
tonality systems 700
videos 137

file names 528
ingredients 528
recipes 528
setting 528
tokens 398
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files 59
different Dorico versions 57
exporting 59, 525, 527
importing 59
missing fonts 58
opening 56
videos 139

filled noteheads 719
films. See videos
filters 340

deselect 341
drums 109
dynamics 340, 636
ensembles 83
expression maps 489
harp pedaling 340
instruments 83
lyrics 340, 702, 703
notes 340
options 90
percussion 109
percussion maps 506
pitch 340
properties 147
select 341
stem direction 340
tempo marks 340
voices 340

final barlines 237, 558
inputting 240, 242
number of times played 464

final tempo 934
Find Tempo dialog 320

important markers 847
finding. See searching
fine

d.c. al 857
inputting 329
sections 857

finger tapping. See tapping
fingering 660

appearance 665
arpeggio signs 668
brackets 667
cautionary 665
changing 662
chord diagrams 608
deleting 665
font styles 665
fretted instruments 665. See also tapping
hammer-ons. See hammer-ons
handles 662
hiding 664
horn branch indicators 671
inputting 212, 214
inside the staff 664
inverting 663
MusicXML import 673
parentheses 212, 214, 665
placement 661, 664, 667, 668
popover 212, 214
position 661
pull-offs. See hammer-ons

fingering (continued)
separators 670
showing 664
slides. See fingering slides
staff-relative placement 663
string shift indicators 671, 672
strings 726
substitution 661, 662
tapping. See tapping
types 214, 670
valved brass instruments 670

fingering slides 669
handles 669
hiding 670
showing 670

first and second endings. See repeat endings
first pages

formatting 378
master pages 378
page numbers 792

first steps
starting new projects 54, 55

first systems
indents 915

fit to paper 534. See also staff size
five-line staff 909

noteheads 987, 990
percussion kits 983, 984
percussion legends 991

fixed tempo mode 463
fixing

bars 385
figured bass 658
note durations 171, 189
pages 386
systems 386

flags
above staves. See signposts
notes 921
stems 921

flared hairpins 644
flat slurs 893
flats. See accidentals
flipping 343, 894
flips. See jazz ornaments
flow headings 88, 364

default 364
flow titles 380
frames 364
gaps 379, 610
hiding 379
margins 379, 610
master pages 378
moving 379
page numbers 380, 792
showing 379
titles 380

Flow Import Options dialog 60
flows 17, 93, 122

accidental duration rules 545
adding 122
adding players 123
adding to layouts 126
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flows (continued)
audio 73
cards 87
copying 59, 123
deleting 124
deleting empty bars 554
duplicating 123
duration 400
exporting 61
going to 346
headings. See flow headings
hiding 126
importing 59, 60, 63, 65
instrument change labels 906
justification 382
layouts 93
master pages 378
multiple on pages 377
MusicXML files 64
names 135
navigation 346
numbers 400
page numbers 380, 400, 401
panel 87
playback 487
players 93, 123
removing from layouts 126
removing players 123
selecting 336
showing 126
splitting 355
staff labels 903
staff size 383
systems 382
tacets 389, 390
tempo tracks 70
timecodes 87
titles 135, 136, 380
tokens 399, 400
trimming 236, 554
videos 87, 136, 139
voices 487

Flows panel 80, 87
hiding 87
showing 87

flutter-tongue. See playing techniques
flz. See playing techniques
folders

backups 78, 79
export path 527

follow tempo mode 463
font styles

bar repeats 864, 866
figured bass 657
glyphs 396
lyrics 703, 710
missing fonts 58
music 396
notations 396
notes 396
PDF files 537
playing techniques 815
rhythm slashes 876, 877

font styles (continued)
SVG files 537
time signatures 950, 961

force
articulations 547
dynamics 628
figured bass appearance 658, 659
horizontal 838, 975

force duration 144, 171
activating 144
inputting notes with 171
inputting rests with 171

formats. See file formats
formatting 363

altered unisons 545
arpeggio signs 758, 759
bar numbers 563, 567
caps 834
chord diagrams 613
dynamics 643
file names 528
frames 393
front matter 680
glissando lines 764
gradual dynamics 643
hairpins 643
instrument change labels 103
layouts 370, 393, 394
lines 833, 834
markers 318, 846
master pages 363
niente hairpins 638
noteheads 723
page formatting 364, 385
pages 367, 393, 394, 680
pedal lines 808, 809
slurs 892, 893
systems 393
tacets 389, 391
tempo marks 936, 937
text 308, 310, 397, 405
ties 942
tuplets 969, 976

forte. See dynamics
forum

accessing 53
fps 141
frame breaks 367, 387

bar repeats 387
copying to other layouts 393, 394
deleting 388
divisi 916
hiding staves 374
inserting 387
signposts 349, 388
slurs 890
staff spacing 371
staff visibility 374
ties 944

frame chains
music. See music frame chains
properties 147, 149, 395
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frame rates 141
changing 137, 142
dialog 137
drop frame timecodes 849
non-drop frame timecodes 849
transport window 472, 473

frames 365, 404
breaks 367, 387
dashed 364
flow headings 364, 379, 380
hiding 345
music 381
padding 367
running headers 380
staves 372, 382
systems 372, 382, 386
text 397
tokens 397

frequency
auto-save 78
bar numbers 563
bar repeat counts 865
harmonics 733
slash region counts 876
timecodes 851
trills 745

frets 104
adding 116, 184, 614
brackets. See bracketed noteheads
changing 919
chord diagrams. See chord diagrams
deleting 116, 614
intervals 116
note input 184
notes out of range 919
parentheses. See bracketed noteheads
position 116
spacing 116
starting number 609, 613, 614

fretted instruments 104
adding 83, 105
arpeggio fingering 668
changing tuning 83, 107, 116, 118
chord diagrams 608, 609
exporting tunings 119
fingerings 212, 665
frets 116
guitar bends 768
guitar techniques. See guitar techniques
harmonics 733–735, 737
importing tunings 118
open pitches 118
pinch harmonics 740
popover 215
slides 669, 670
string indicators. See string indicators
strings 118, 726
tablature. See tablature
tuning 104, 107, 116

front matter 680
player list 397
project information 680

full score layouts. See layouts

full screen mode 41
full stop. See period
fullness

pages 370, 372, 382
fullness threshold

horizontal justification 382
vertical justification 372, 408

functions
key commands 49
removing key commands 51

fundamental
harmonics 733
string pitches 116

funk noteheads 722, 723
FX channels 471

G
G clef. See clefs
galley view 34, 42

bar numbers 34, 566
changing to 42
dragging pages 348
flows 355
instrument changes 102
instrument labels 42
staff labels 34
staff spacing 408, 410

gaps
chord diagrams 610
codas 859, 914
dynamics 629, 634
fingering slides 669
flow headings 379
galley view 410
lines 838
notes. See note spacing
ossia staves 371, 408
pedal lines 806, 807
quantization 68
removing 170
slurs 889, 890
staves 371, 408, 857
stems 584
system indents 914
systems 857
tacets 392
text 838

General MIDI 66, 488, 501
generated trills 754, 755
ghost notes 728, 729

guitar. See dead notes. See also bracketed 
noteheads

gli altri. See divisi
glissando lines 763, 823

angles 763
changing 342
deleting 350
direction 726
endpoints 763
filter 340
formatting 764
guitar bends. See guitar bends
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glissando lines (continued)
harp pedaling 766, 794
hiding 765
inputting 266, 268, 274, 275, 764
line styles 764
panel 270, 275
placement 763
playback 766, 794
popover 268, 274
position 763
showing 765
styles 764
text 765
tie chains 766
types 268

global
chord symbols 253, 598
figured bass 313, 651
properties 147, 149, 395

glyphs
accidentals 200
fonts 396
pedal lines 808
playing techniques 813
trills 741, 742

go to. See navigation
Go To Bar dialog 347
Go To Page dialog 347
grace notes 682

appearance 685
arpeggio signs 761
barlines 684
beams 686
caret 157, 190
clefs 618
default settings 683
deleting 350
duration 190, 686
glissando lines 274, 275
guitar bends 279
inputting 144, 190
inverting 683
lines 828
moving 684, 725
pedal lines 805
pitch 199
placement 683
playback 686
position 683, 684
register 199
size 684, 724
slashes 683, 684
slurs 211, 683, 888, 889
spacing 406
speed 686
stems 683, 685
ties 189, 945
transposing 202
trills 754
types 685
voices 683

gradient background 44

gradual dynamics 628, 641
alignment 632
appearance 643
barlines 632
centered text 640
continuation lines 643
dashed 643
dotted 643
end position 632, 645
flared hairpins 644
handles 642
hyphens 643
inputting 243, 245, 247
length 642
line style 643
messa di voce 643
moving 645
niente. See niente hairpins
poco a poco 640, 644
position 646
spacing 645
start position 645
syllables 643
truncated 646

gradual tempo changes 754, 927, 935
components 928
continuation lines 935, 937
drawing 447
editing 447
final tempo 934
formatting 936, 937
hyphens 936
inputting 229, 231, 233, 234, 449
length 935
Play mode 447
popover 229
style 936
syllables 936
time track 447

grand staff instruments
barlines 560
braces 592
brackets 55, 594
centered beams 581
cross-staff beams 583
dynamics 245, 247, 629, 637
hiding staves 373–375, 408
MIDI recording 204
multi-bar rests 884
slurs 211
staff grouping 55, 594
staves 560
swing playback 467
ties 189
vertical justification 408

graphics
files. See graphics files

graphics files 525, 535
colors 536
exporting 525, 527
file names 528
fonts 537
formats 535
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graphics files (continued)
image resolution 536
monochrome 536

green notes
tablature 919

grids
chord diagrams 610
gaps 115
instrument groups 112
naming groups 113
percussion kits 983, 984
rhythmic 155, 156
staff labels 903
staves 907, 983

groups
bar repeats 867
beams. See beam groups
braces 592
brackets 592
dynamics 647, 648
guitar bends 768
instruments. See instrument groups
notes. See note grouping
percussion kits 109, 112–114
players. See player groups
playing techniques 818, 819, 821
rests. See note grouping
staff labels 908
staff spacing 371, 408
staves 560
tabs 40

guide bar numbers 42, 566
hiding 345

guide instrument labels 42, 130
guitar 778

bends. See guitar bends
changing string for notes 919
chord diagrams. See chord diagrams
chord symbols. See chord symbols
dead notes 782
dips 286, 778
dives 281–283, 773, 778
fingerings 665
hammer-ons 288, 780
harmonics 733, 735, 737
lines 287, 288, 768, 773, 778
note input 184
notes out of range 727
open pitches 118
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
pull-offs 288, 780
scoops 284, 285, 778
slides 669
string indicators. See string indicators
strings 118
strumming 668
tablature. See tablature
tapping 290, 779
techniques. See guitar techniques
tuning 83, 104, 116, 118
vibrato bar. See vibrato bar

guitar bends 768, 773
chords 768, 772
deleting 350
direction 343
dives 773
groups 768
hold lines 775
holds 768, 775
inputting 268, 278, 279
intervals. See bend intervals
microtonal 281, 772, 774
parentheses 768
playback 768
popover 268, 279
post-bends 281, 772
pre-bends 771
releases 768
runs 768
tablature 918

guitar post-bends 772
bend intervals 774
chords 772
deleting 777
inputting 281
microtonal 281, 772

guitar pre-bends 771
accidentals 777
bend intervals 774
deleting 777
direction 776
inputting 280

guitar pre-dives. See guitar pre-bends
guitar techniques 778–780

dead notes 782
deleting 785
inputting 268, 278, 281–288, 290
intervals 782
moving 783
panel 270
popover 268
staff-relative placement 783

H
H-bars 884

hiding 885
showing 885
width 884

hairpins. See gradual dynamics
half notes 11, 146

beats 236
metronome marks 230
tempo equations 937
tuplets 197

half step trills
inputting 271

half-bar
beam grouping 590

half-step trills 748, 754
appearance 752
hiding 745, 749
inputting 267, 271, 272
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half-step trills (continued)
position 753
showing 745, 749

half-steps 11, 541
accidentals 185, 541
bend intervals 774, 782
figured bass 316
glissando lines 763
harp pedaling 794
pitch bend 439
string pitches 116
tonality systems 700
trills. See half-step trills

HALion Sonic SE
endpoints 487
independent voice playback 460
playback template 473, 474

HALion Symphonic Orchestra
endpoints 487
independent voice playback 460
playback template 473, 474

halving. See double
hammer-ons 780

deleting 785
inputting 288
moving 783
popover 268
slurs 780
staff-relative placement 783

hand tool 33
dragging pages 348

handles 788
bar repeats 863
beams 580
chord symbol regions 603
dynamics 641, 642
figured bass 654
fingerings 662
octave lines 623
percussion legends 992
playing techniques 819
repeat endings 854
slash regions 875
tempo marks 935
trills 747
tuplet brackets 973

harmonic analysis. See figured bass
harmonics 733

accidentals 736
appearance 737, 739, 740
artificial 733
hiding 734
inputting 734
natural 733
noteheads 723
partials 735
pitch 735
playback 733–735
question marks 734
showing 734
specifying strings 726
styles 737, 740
tablature 734, 737

harp pedal diagrams 794, 795
placement 798
position 798
showing 795

harp pedaling 794
appearance 794, 795
borders 797
calculating 301
diagrams. See harp pedal diagrams
filter 340
glissando lines 766, 794
hiding 796, 797
inputting 294, 300, 301
moving 798
note names 795
notes out of range 727
partial. See partial harp pedaling
playback 794
popover 294
showing 796
signposts 349, 794, 796, 797

headers
chords track 452
flows 364
instrument tracks 427

heavy swing. See swing playback
height

lines 832
staves 370–372, 381, 382, 408
systems 371, 372, 408
time signatures 950
tracks 455, 456

hemiola
forcing note durations 171
independent time signatures 224–227

Henze fermatas 687
inputting 262–264

hiding 25, 350
accidentals 541, 542, 736, 749, 777
audio outputs in mixer 482
automation lanes 441
bar numbers 563, 565, 566, 569
bar repeat counts 866
bar rests 884
barlines 220, 951
borders 345, 404, 797
braces 596
brackets 596
brackets on noteheads 729
caret 160
cautionary accidentals 542, 736
chord diagrams 609, 610
chord symbols 600, 601, 605
clefs 258, 259, 619
colors 727, 864, 870, 882, 997
comments 361
condensing colors 345
continuation lines 820
dead notes 782
divisi colors 345
divisi staff labels 903
divisi staves 373–375
dynamics 634, 635, 640
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hiding (continued)
dynamics lanes 431
East Asian elision slurs 716
empty staves 373
figured bass 315, 652, 653, 655
fingering slides 670
fingerings 664
flared hairpins 644
flow headings 379
flow page numbers 380
flow titles 380
flows 126, 389
Flows panel 87
glissando line text 765
guitar bend hold lines 775
guitar pre-bend accidentals 777
harmonics 734
harp pedaling 796, 797, 799
highlights 345
hold lines 654, 655, 775
hyphens 634
initial page numbers 792
instrument change labels 906
instrument changes 102
instrument names 903
instrument transpositions 132, 905
interchangeable time signatures 951
key signatures 83, 216, 218, 219, 694, 695
laissez vibrer ties 946
lines 345, 820
margins 345
markers 844
mixer 469, 471
multi-bar rests 885
note colors 345, 537, 727
notes 872
padding rests 873
page numbers 380, 792
panels 25, 32, 35, 37, 81, 85
partial harp pedaling 799
percussion legend signposts 990
players 123, 125
playhead 458
playing techniques 815, 820
playing techniques lanes 446
quality in chord symbols 601
rest colors 882
rests 883–885
root in chord symbols 601
running headers 380
separators 634
signposts 345, 350, 388, 389
slash region counts 877
staff labels 903
staves 93, 123, 125, 126, 373–375, 918
stems 875
string indicator lines 675
string indicators 303
system dividers 912
system track 338, 345
tablature 918
tabs 25
tacets 390

hiding (continued)
tempo marks 932
text 405
text borders 404
text on lines 835
time signatures 960
timecodes 851
toolbar 24
tracks 455, 456
transport window 472
trill extension lines 746
trill intervals 749
trill marks 745
tuplets 973, 976
velocity lanes 438
verse numbers 716
vibrato bar lines 784
video window 140
voice colors 345, 537, 997
VST instruments 415

highlights
automation 439
bar repeats 861, 864
chord symbol regions 601, 604
comments 361
dynamics 429
exporting 537
flags. See signposts
hiding 345
printing 537
search matches 45, 90
slash regions 869, 870
tempo changes 447, 449
tracks 418, 429, 439, 447

hold lines 654, 768, 775
figured bass 654, 655
hiding 654, 655, 775
showing 654, 655, 775

holds. See pauses
Holds and Pauses panel 264
Hollywood-style trills 752

intervals 753
position 753
showing 753

hooks
pedal lines 802, 808
playing techniques 818, 820
tuplets 973

horizontal alignment
ornaments 742
staves 382
systems 382
text 404

horizontal lines. See lines. See also glissando lines
horizontal position

arpeggio signs 760
bar numbers 567
chord symbols 604
clefs 618
dynamics 629, 630, 640
lines 827, 828, 830, 832
lyrics 701, 711
modifiers 640
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horizontal position (continued)
notes 406, 998, 999
ornaments 742
poco a poco 640
rehearsal marks 839
rests 879
staves 382
string indicators 678
systems 382
tempo marks 929
text 404
ties 939
time signatures 950
trills 742
tuplet brackets 974
tuplets 967, 976

horns
branch indicators 671
clefs 83, 620
fingerings 670
key signatures 83

hotkeys. See key commands
HTML files

comments 361
Hub 53

opening projects 56, 57
humanize

dynamics 429
hyphens

dynamics 634
lyrics 313, 704, 712
tempo marks 936
time signatures 956, 958

I
illustrations

exporting 525, 527
image resolution 536

changing 525, 527
images

exporting 525, 527
videos 136

immediate dynamics. See dynamics
implicit rests 19, 879, 880

colors 882
deleting 883
explicit rests 882
hiding 881, 883
showing 883
voices 881

Import Tempo Track dialog 71
important markers 320, 847
importing 59

Cubase data 488, 505
expression maps 488, 505
flows 59, 60
fretted instrument tunings 118
MIDI files 65, 66, 995
MusicXML files 63, 856, 995
pedal lines 65, 66
percussion kits 980
percussion maps 511

importing (continued)
playback templates 480
tempo tracks 70, 71
unpitched percussion 995

inches
unit of measurement 45

including. See excluding
indents 914

changing 915
codas 859, 914
first systems 915
last systems 382
staff labels 904
systems 382

independent voice playback 460
changing endpoints 487
inputting notes 421
piano roll editor 420
playing techniques 295, 297

index
rehearsal marks 841

Indian drum notation 996
indicators

audio engine 32
caret 637
clefs 621
fingerings 214, 671
horn branches 671
MIDI input 32
octaves 621
string fingerings 671, 672, 726
tempo. See tempo marks
thumbs 214
trill intervals 748, 753
voices 637

information. See project information
ingredients 528
init switches 492, 500
initial pages

left-hand page 377
page numbers 377, 792

initial trill notes 754
initials

comments 356, 361
input pitch

changing 167
inputting 153

accidentals 168, 185, 541
additional repeat endings 326, 327
altered bass note chord symbols 256
arpeggio signs 266, 268, 273
articulations 168, 209, 210
automation 441
bar number changes 571
bar repeats 324, 325, 333
bar rests 188, 236
barlines 235, 237, 238, 240, 242
bars 235, 236, 238–240
beams 161, 577
beats 236, 238, 240
bracketed noteheads 729
breath marks 262–264
caesuras 262–264
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inputting (continued)
caret 157, 160
centered beams 582
chord diagram shapes 613
chord symbols 249, 252, 253, 256
chords 144, 192
clefs 256–259
comments 357, 360
dips 286
dives 280–283
dynamic modifiers 243, 245, 247, 639
dynamics 243, 245, 247, 432, 639
ensembles 83, 99
expression maps 502–504
fermatas 262–264
figured bass 313, 315
figured bass hold lines 313, 315, 654
fingerings 212
flows 122
frame breaks 387
glissando lines 266, 268, 274, 275, 764
grace notes 190
gradual tempo changes 229, 231, 233, 234
guitar bend hold lines 775
guitar bends 268, 278, 279
guitar dips 268, 286
guitar dives 268, 281–283
guitar lines 268, 287, 288
guitar post-bends 281
guitar pre-bends 280
guitar pre-dives 280
guitar scoops 268, 284, 285
guitar tapping 268, 290
hammer-ons 268, 288
harmonics 734
harp pedaling 294, 300, 301
hold lines 654
inputting vs. editing 153
Insert mode 178
instrument changes 161, 165
instruments 83, 95, 105
instruments in percussion kits 111
jazz articulations 266, 267, 276, 277
jazz ornaments 267, 271, 272
key signatures 216–219, 541
layouts 125
left-hand fingerings 215
line text 835
lines 291, 295, 297, 304–306
lyrics 310, 313
markers 318, 454
metronome marks 228, 233, 234
MIDI 204, 209, 441
mouse input 154, 155, 169
mutual exclusion groups 504
nested slurs 896
nested tuplets 968
notehead brackets 729
notes 157, 161, 165, 168, 171, 178, 204, 421
notes in multiple voices 174
notes in percussion kits 180, 182
octave lines 256, 258, 260, 261
ornaments 266, 271, 272

inputting (continued)
pauses 262–264
pedal lines 291, 293, 298, 299
percussion kits 106
pick-up bars 220, 222, 226, 227
playback techniques 503, 513
playback templates 479, 480
player groups 120
players 95
playing techniques 291, 295, 297
popovers 18
position 153
post-bends 281
pull-offs 268, 288
register selection 164
rehearsal marks 317
repeat endings 322, 325–327
repeat markers 322, 325, 329
rests 144, 171, 187
rhythm dots 161, 165, 168, 172
rhythm slashes 324, 325, 332
rhythmic feel changes 229, 467
rhythmic grid 155, 156
right-hand fingerings 215
scoops 284, 285
settings 155, 168
slash regions 324, 332
slash voices 175, 1003
slurs 211, 288, 896
stem direction 183
string indicator lines 675
string indicators 294, 301–303
strings 116
swing playback 231
switches 503
system breaks 388
system text 307
tablature 184, 918
tapping 268, 290
tempo equations 229
tempo marks 228, 229, 231, 233, 234, 449
text 307, 835
ties 144, 189
time signatures 220, 224, 225
timecodes 318, 845, 850
tokens 397
tremolos 323, 325, 330, 331
trill intervals 750
trills 267, 271, 272
tuplets 194, 968, 969
unpitched percussion 421
upbeats. See pick-up bars
velocity 438
vibrato bar 278, 280, 281
vibrato bar dips 286
vibrato bar dives 282, 283
vibrato bar lines 287, 288, 784
vibrato bar scoops 284, 285
videos 139
voices 174, 175

Insert mode 144, 179
activating 144
caret 157, 178
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Insert mode (continued)
inputting notes 178
time signatures 224–227, 949
tuplets 972

insertion point 157
inserts 471
instances

adding 417
plug-ins 415

instrument change labels 100, 906
hiding 906
showing 906

instrument changes 102
allowing 102
disallowing 102
inputting 105, 161, 165
labels 103, 906
language 103, 131, 132

instrument groups 112, 119
deleting 114
naming 113
percussion kits 112

instrument labels
percussion kits 113

instrument names 129, 901
alignment 132
changing 131
Endpoint Setup dialog 482
hiding 903
length 132, 903
mixer 469
numbering 101, 902
Play mode 427, 469, 482
resetting 132, 134
saving as default 132
showing 903
staff labels 132, 398, 902, 903
tokens 398
tracks 427. See also instrument tracks

instrument picker 83
instrument pitches. See instrument transpositions
instrument tracks 426, 427

automation. See automation lanes
collapsing 455
colored regions 427
controls 427
dynamics. See dynamics lanes
expanding 455
headers 427
piano roll editor 420
playing techniques. See playing techniques lanes
velocity. See velocity lanes

instrument transpositions 104, 904
changing 83, 107
clefs 619
hiding 132, 905
layout names 131
layouts 131
showing 132, 905
staff labels 132, 904, 905

instrumental parts. See layouts
instrumentation lists 397, 680

instruments 18, 100
adding 83, 99, 105
adding to flows 123
adding to parts 125
adding to percussion kits 111
arranging tools 350
assigning to endpoints 487
automatic numbering 101
brackets 55, 593, 594
changes. See instrument changes
changing existing 107, 111
changing transposition 107
chord symbols 253, 600
clefs 83, 107, 619
combining into kits 106
comments 356, 358
copying 97
deleting 98, 108
divisi 916
doubling 42, 105
dynamics 429, 637, 646. See also dynamics lanes
empty staves 373
endpoints 481, 482, 487
ensembles 99
expression maps 482, 489
figured bass 313
fretted 104
fretted fingerings 665
groups. See instrument groups
hiding 123, 125
inputting notes 161, 165
key signatures 694, 695, 698, 699
labels 42, 102, 103, 130
language 134
loading 417
MIDI 416, 417
MIDI recording 204
moving 107
moving between players 107
muting 461, 462
names. See instrument names
non-sustaining 646
numbering 101
order 97, 98, 107, 119
order in percussion kits 114
part layouts. See layouts
percussion 506, 983
percussion legends 990, 992
percussion maps 482
Play mode 427
playback 460, 473, 474, 476, 479, 481, 487, 488, 
506
players 94
Players panel 81
plucked fingerings 665
ranges 727
removing from kits 115
removing from parts 123, 125
searching 83
showing 123, 125
showing staves 42
soloing 461, 462
staff grouping 55, 594
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instruments (continued)
staff labels 132, 902, 905
staff size 383
staves 42, 374, 375, 637, 910, 983
strings 104
sustaining 646
swing playback 467
tablature 917, 918
templates 55
tracks. See instrument tracks
transposing 104, 127. See also instrument 
transpositions
tuning 83, 104
velocity 437. See also velocity lanes
VST 415, 417

intensity
dynamics 245, 247, 342, 429, 633

interactive key commands map 48
interchangeable time signatures 951

inputting 220, 222, 224, 225
specifying for individual bars 951

interface 23
interspersion

accidentals 543
intervals

add intervals popover 198
auto-save 78
chord symbols 250, 599
dips 782
figured bass 658
fretted instruments 116
guitar bends. See bend intervals
harmonics 733–735, 737, 740
octave divisions 700
ornaments 741
simplifying 658
transposing 198, 202, 203
trills 267, 271, 748–750, 753
vibrato bar dives and returns 773

inversions
chord symbols 255
figured bass 313, 315, 651

inverting 894
articulations 550
beaming 578, 579
figured bass 656
fingerings 663
grace note stems 683
slurs 889, 893, 894
ties 944
tuplets 974

ionian chord symbols 251, 606
irregular

bars as pick-up bars 953
time signatures 951

italics
dynamics 628
lyrics 710
text 308

items 153, 334
behind other items 334
changing 342
copying 351

items (continued)
deselecting 341
editing 147
resetting 344
selecting 153, 334–336, 341, 345

J
jazz

articulations. See jazz articulations
band templates 55
glyphs 396
music font 396
staff grouping 55, 594

jazz articulations 786, 787
appearance 788
bend 786
changing 788
deleting 789
duration 788
inputting 266, 267, 276, 277
length 788
line styles 788
moving 788
ornaments. See jazz ornaments
panel 270, 277
playback 512, 513, 786
popover 267, 276
position 788
smooth 786
types 267, 786, 788

jazz ornaments 786, 787
inputting 267, 271, 272
popover 267
types 267

job types 520, 530
page ranges 524
printing 530
selecting 530

joins
barlines 560, 594
beams 583
pedal lines 807
staves with barlines 561
stems 583

jumps
inputting 329
playback 465
repeat 857

justification
staves 372, 382, 408
systems 372, 382, 408
vertical 372, 408

K
kerning

accidentals 544
figured bass 655

key clicks. See playing techniques
key commands 13, 47

articulations 210
assigning 50

Index
 

1044
Dorico SE 3.5.12



key commands (continued)
defining 45
finding 49
galley view 42
keyboard layouts 51
languages 51
maps 48
MIDI 50
mouse input 144
muting 461, 462
navigation 30, 346, 347
notehead sets 723
page view 42
playback 458
removing 51
resetting 51
searching 48, 49
soloing 461, 462
text formatting 308

key signatures 693
accidentals 541, 693
atonal 694
barlines 696
cautionary 699
changes 693, 696
changing 342
clefs 696
custom 700
deleting 695
enharmonic equivalent 698
filter 340
hiding 83, 216, 218, 219, 694, 695
inputting 216–219
instruments without 695, 699
major 694
minor 694
moving 697
multiple 696
none 695
octave divisions 700
open 694
panel 217, 219
placement 696
polytonality 218, 219, 693
popover 216, 218
position 218, 696
scales 694
selecting 334, 337–339
signposts 349, 695
tonality systems 700
transposing 202, 203, 697
transposing instruments 127, 699
types 216, 694

Key Signatures, Tonality Systems, and Accidentals 
panel 217, 219
key switches 501

expression maps 488, 494
percussion maps 506

keyboard shortcuts. See key commands
keyboards

inputting notes 157
key command maps 48
layouts 51

keys
major 694
minor 694
signatures. See key signatures
transposing 202, 203

kits. See percussion kits
kneed beams. See centered beams

L
l.v. ties. See laissez vibrer ties
labels

instrument changes 102, 103
instruments 132, 901
markers 844
percussion kits 907, 983
staves. See staff labels

laissez vibrer ties 813, 938, 946
landscape orientation 534
lanes

automation. See automation lanes
dynamics. See velocity lanes
playing techniques. See playing techniques lanes
velocity. See velocity lanes

languages
instruments 103, 131, 132, 134
key commands 48, 51

large
noteheads 722
selections 336
time signatures. See large time signatures

large time signatures 954, 955
bar numbers 569

largo. See tempo marks
latency

changing value 207
MIDI recording 204, 207

lattice arrangement
accidentals 543

layers. See voices
layout cards 85

disclosure arrows 35
numbers 85. See also layout numbers
opening 85

layout names 129, 131
accidentals 131
changing 131
resetting 131
text tokens 397

layout numbers 85
order 128
renumbering 128

layout options 90
bar numbers 563–565, 567
copying to other layouts 393, 394
dialog 90
saving as default 90
searching 90

Layout Options dialog 90
layout selector 25

order of layouts 128
switching layouts 36
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layouts 21, 85, 93, 124, 392
accidentals 200
adding flows 126
adding players 125
bar numbers 563, 565, 566
blank staves 375
braces 55, 593, 594, 596. See also staff grouping
brackets 55, 593, 594, 596. See also staff grouping
cards. See layout cards
casting off 385
chord symbols 601
clefs 619, 620
color mode 527
comparing 40
concert pitch 127
condensing 392
copies 522
copying formatting 393, 394
copying properties 395
creating 125
cues. See cues
custom scores 124
deleting 128
divisi 916
empty staves 373, 375
enharmonic spelling 200
exporting 525, 530
exporting audio 73
exporting MIDI 69
figured bass 652
file names 528
fingering 664
fit to paper 534
flow headings 364, 379, 380
flows 93, 126, 377, 378
formatting 363, 393, 394
frame breaks 387
frame chains. See music frame chains
front matter 680
full scores 124
graphics files 525, 535
harp pedaling 796
hiding staves 373–375
image resolution 527
indents 914, 915
instrument change labels 906
instrumental order 119
justification 372, 382, 408
keyboard 48, 51
large time signatures 954, 955
Layouts panel 85
left pages 377
margins 369, 381
markers 844, 845
master page sets 364, 370
master pages. See master pages
multi-bar rests 565, 885
multiple windows 41
MusicXML files 64
naming 131. See also layout names
note spacing 406
numbers. See layout numbers
opening 27, 36

layouts (continued)
opening multiple 38, 40
orchestral order 97, 98
order 128
orientation 368, 534
page numbers 791
page ranges 522, 530
page size 533
page turns 387
panel in Print mode 519
panel in Setup mode 85, 124
paper sizes 533
parts 124, 393
percussion kit presentation 984
percussion legends 990
player order 97, 98
players 93, 125
printing 522, 530, 534
propagating layouts 394
propagating parts 393
properties 147, 149, 395
removing flows 126
removing players 125
renumbering 128
restoring 129
running headers 380
scale size 534
selecting 25
settings 90
sorting 128
staff labels 398, 903
staff size 370
staff spacing 371, 372, 408
staves 373–375
switching 36
system dividers 911
system formatting 371, 382, 388, 393, 408
system objects 913
tabs 27, 38
tacets 389–392
text 405
time signatures 954, 955, 961
timecodes 845, 850, 851
titles 363, 364
tokens 398
transposing 104, 124, 127
vertical justification 372
view types 34

Layouts panel 31
hiding 85
Print mode 518, 519
Setup mode 80, 85
showing 85

lead sheets
chord diagrams grid 610

left hand hooks. See lines
left pages

starting from 377
left panel 31
left-foot pedals. See harp pedaling
left-hand fingering 665

hammer-ons. See hammer-ons
inputting 212, 215
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left-hand fingering (continued)
placement 661
popover 215
position 668
pull-offs. See hammer-ons
size 665
slides 669, 670
tapping. See tapping

left-hand guitar tapping. See tapping
legato

note durations 170
playing technique. See playing techniques. See also 
playback techniques

legends
percussion. See percussion legends

length
arpeggio signs 273, 274, 760
bar repeat phrases 342, 862
bar repeats 863
bars 553
chord symbol regions 603
dynamics 435, 642
figured bass 654
hairpins 632
hold lines 654
instrument names 103, 131, 903
jazz articulations 788
lines 817–819, 831, 832
notated duration of notes 515
notes 170, 423, 515, 516
octave lines 623
pedal lines 805, 807
percussion legends 992, 993
played duration of notes 515, 516
playing techniques 817
repeat endings 854
slash regions 875
slurs 895, 898
staff labels 903
stems 925
string indicator lines 675
system dividers 912
tempo marks 935
trills 747
vibrato bar lines 784

lento. See tempo marks
letter paper sizes 533
letters

rehearsal marks 842
level changes for pedal lines 802
levels

channels 469
dynamics. See dynamic levels
nested tuplets 968

libraries
fretted instrument tunings 118, 119
percussion 506
sound 415, 418, 473, 488, 489, 506

lifts
jazz articulations. See jazz articulations
pedal lines. See pedal retakes

ligado. See hammer-ons
light swing. See swing playback

light theme 43
line spacing. See staff size. See also staff spacing
linear points 433, 442

inputting 432, 441
lines 763, 818, 823, 825

accidentals 832
alignment 832
angled 305, 823, 829
annotations 825
appearance 833, 834
arpeggio signs. See arpeggio signs
attachment types 826
attachments 305, 823
automation 439, 441
barlines. See barlines
beams. See beaming
caps 825, 834
changing 833, 834
columns 827
components 825
cross-staff 306
deleting 350
drawing 449
duration 831, 832
dynamics 429, 432
end position 832
ends 825
figured bass. See figured bass
fingerings 671
glissando. See glissando lines
grace note slashes 684
grace notes 828
guitar bends. See guitar bends. See also vibrato bar
harp pedaling 794, 799
hiding 820
holds. See hold lines
horizontal 823, 826
horizontal position 827
horizontal text 838
inputting 304–306
jazz articulations 786, 788
joining notes. See beams
length 831, 832
lyric extender 712
lyrics 701, 712
moving 827, 828, 830
noteheads 832
notes. See stems. See also beaming
octave lines. See octave lines
order 827
pedal. See pedal lines
placement 827–829
playback. See playhead
playing techniques. See playing technique lines
position 826
repeat endings. See repeat endings
reversing 835
secondary beams 587
size 831
staff-relative placement 828, 829
start position 832
staves 909
string indicators 301, 302, 675
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lines (continued)
string shift indicators 672
system breaks 825
system dividers. See system dividers
tablature 917
tempo marks 447, 937
text 404, 825, 835–838
ties 941, 942
trills 745, 746
tuplet brackets. See tuplet brackets
types 823, 826
velocity 438
vertical 823, 826
vertical position 826, 828
vibrato bar. See vibrato bar
wiggly 745, 757

linking
dynamics 342, 648–650
flow names 135
flow titles 135
groups of dynamics 647
percussion maps to VST/MIDI 488
slurs 342, 899, 900

lists
comments 358
players 397

little finger. See pinky finger
loading

MIDI instruments 417
playback templates 479
sounds 417, 479
video files 139
VST instruments 417

local
chord symbols 253, 598
figured bass 313, 651
properties 147, 149, 395

locations
backups folder 79

lock
duration. See lock to duration

lock to duration 144, 201
activating 144

loco. See octave lines
locrian chord symbols 251, 606
lower case

flow titles 400
Roman numerals 400

lower notes
trills 756

lute. See fretted instruments
lv ties. See laissez vibrer ties
lydian chord symbols 251, 606
lyric extender lines 704, 712

handles 712
inputting 310, 313

lyric hyphens 704, 712
handles 712
inputting 310

lyric lines 311, 701, 703
changing 704, 713, 714
copying 706
deleting 706

lyric lines (continued)
numbers 712, 713
placement 711
position 711

lyricist 88, 399
default master pages 680
text tokens 397

lyrics 701
alignment 701, 711
changing 704, 708, 713
chorus 311, 703, 704, 713
copying 706
counts 708
deleting 706
East Asian elision slurs 716
editing 708
extender lines. See lyric extender lines
filters 340, 702, 703
handles 712
hyphens. See lyric hyphens
inputting 310, 313
italics 710
line numbers 712–714
lines. See lyric lines
melismatic 310, 313, 710, 712
moving 711, 713–715
note spacing 407, 701
placement 701, 710
popover 310, 311, 313
position 701, 710
selecting 334, 703
spacing 407, 710, 711
staff-relative placement 714, 715
syllable types 313, 704, 705
text 708
translations 311, 703, 704, 713
types 311, 703, 704
verse numbers 716
vertical position 703, 704, 712–715
zoom 708

M
macOS

printing 525
major

chord symbols 250
keys 694
scales 694

mandolin. See fretted instruments
manual staff visibility 374, 375
manuscript paper 375
maps

expression 488
key commands 48
percussion 506

marcato. See articulations
margins

changing 369
chord diagrams 610
flow headings 379
hiding 345
music frames 381
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margins (continued)
MusicXML files 63
pages 367, 369
staves 381
tacets 392

mark-up. See comments. See also annotations
markers 844

comments. See comments
deleting 350
dialog 318
filter 340
hiding 844
important 320, 847
inputting 318, 454
moving 846, 847
panel 319
repeats 322, 857
showing 844
staff 845
staff spacing 371, 408
text 318, 319, 846
timecodes 318, 846
track 454
vertical position 371, 408, 845

marks
rehearsal. See rehearsal marks
tempo. See tempo marks
trills 741, 742, 744, 745, 753

marquee tool 33
using 335

master output volume 469
master page overrides 397
master page sets 364

applying 370
flow headings 364
layouts 370

master pages 21, 363
assigning to pages 378
page numbers 791
sets. See master page sets

matches
options search 45, 90

measured tremolos. See tremolos
measurement

units 45
measures. See bars
medium swing. See swing playback
melismatic lyrics 313, 710, 712
meno. See tempo marks. See also dynamic modifiers
merging

pedal lines 807
players 59, 60, 63, 65

messa di voce 641
moving 645
showing 643

meter 949
beam grouping 575, 590
changing 342
channel levels 469
irregular 553, 555
note grouping 575, 590
open 951, 956, 958
rest grouping 575, 590

meter (continued)
time signatures. See time signatures
tremolos 963
tuplets 967

metric modulation
tuplets 969

metronome marks 926, 932
appearance 927, 928
beat units 230, 342, 932, 933
changing 342, 450, 933
components 927, 928
decimal places 233, 234, 933
equations 231, 937
hiding 932
inputting 228, 233, 234
multiple positions 913
parentheses 927
playback 472, 934
popover 229
range 934
selecting 334
showing 932
values 342, 450, 933
vertical positions 913

mezzo
dynamics. See dynamics

microtones 545, 700
custom tonality systems 700
EDO 700
guitar bends 281, 772, 774
transposing 198
trills 748

mid-system gaps
codas 857, 859

middle C
clefs 616
expression maps 494
fretted instruments 116
percussion maps 506
playback 494, 506

middle line
stem direction 921

MIDI
accidental spelling 187
automation 439, 441, 444
channels 469, 482
commands 47, 50
controllers. See MIDI controllers
deleting 445
devices. See MIDI devices
dialog 66, 68, 69
editing 444
endpoints 481, 484, 487
exporting 72
expression maps 488, 489, 502, 503
fader 469
files. See MIDI files
inputting 441
instruments 416, 427. See also MIDI instruments
lanes 439
loading instruments 417
markers 454
navigation 50
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MIDI (continued)
note input 157, 177, 187
note range 100
order 494
overlapping notes 170
pan 469
percussion maps 488, 506, 509
piano roll editor 420
pitch bend 439
playback 427, 481, 506
ports 482
quantization 68
range 100
recording. See MIDI recording
slurs 900
tempo 447, 463
tempo tracks 70–72
thru 204
time track 447
volume 650

MIDI controllers 439, 650
automation 439, 441
dynamics 650
pedal lines 812

MIDI devices 209
activity 32
chord symbols 249, 253, 255, 256, 452, 453
disabling 209
enabling 209
expression maps 488, 502, 503
note input setup 182
percussion kits 182
percussion maps 506, 509
playback templates 473, 474
polychords 255
warning 32

MIDI files 65
dialog 66, 69
exporting 69
importing 65, 66, 995
opening 56
pedal lines 65, 66, 208
playback overrides 516
quantization 65, 68
repeats 464
requantizing 206
sustain pedal controllers 208
unpitched percussion 995

MIDI Import Options dialog 66
MIDI Input Devices dialog 209
MIDI instruments 416

endpoints 484
instances 416
loading 417
numbering 416

MIDI Quantize Options dialog 68
MIDI recording 204

audio buffer size 207, 208
devices 209. See also MIDI devices
dialog 68
input pitch 167
latency 207
optimization 207

MIDI recording (continued)
pedal lines 208
pitch 167
quantization 68, 204
repeats 206
requantizing 206
retrospective recording 206
setup 207
starting 204
stopping 204
sustain pedal controllers 208
tempo mode 463
time signatures 204
transport window 472

MIDI thru 204
millimeters

unit of measurement 45
mini transport 24, 25
minims. See half notes
minor

chord symbols 250
keys 694
scales 694

Missing Fonts dialog 58
missing sounds

loading 479
mixer 469

channel strips 471
hiding 469, 471
hiding audio outputs 482
mute states 462, 469
muting tracks 461
ports 469
resetting 462
showing 469, 471
solo states 462, 469
soloing tracks 461
soundtracks 141
videos 141
volume 462

mixolydian chord symbols 251, 606
mock-ups

exporting 73
modal chord symbols 251, 606
moderato. See tempo marks
modes 16

chords 157, 606
Engrave 363
full screen 41
Insert 157, 178, 179, 194
Play 412
Print 518
Setup 80
tempo 463
Write 143

modifier keys
key commands 48
searching 48

modifiers. See dynamic modifiers
modulation wheel dynamics 650
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molto
centered 640
dynamics 243, 245, 639, 640
tempo marks 228, 229, 231

monochrome graphics 536
moon noteheads 722, 723
mordents 741

intervals 741
mosso. See tempo marks
motors. See playing techniques
mouse input 153

activating 144, 169
deactivating 144, 169
settings 154, 155

movements 17, 122
adding 122
exporting 61
flow headings 364
importing 59, 60
multiple on pages 377
splitting 355
tacets 389

movies. See videos
moving

arpeggio signs 760
articulations 550, 551
automation points 444
bar numbers 567, 568
bar repeats 862
bar rests 886
barlines 560
bars 387
breath marks 689, 691
caesuras 690, 691
caret 161, 194
chord symbols 602, 605
clefs 617, 618
cursor 212, 252, 313
dynamics 435, 631, 640, 645
fermatas 689, 691, 692
figured bass 657
flow headings 379
grace notes 684, 725
hammer-ons 783
harp pedal diagrams 798
instruments 107, 121
jazz articulations 788
key signatures 697
lines 827, 828, 830
lyrics 711, 713–715
markers 846, 847
MIDI data 444
navigating. See navigation
notes 199, 353, 406, 422, 725
notes to other staves 353, 583, 981
octave lines 624
ornaments 742, 743
pages 348
pauses 691
pedal lines 804
players 97, 98, 121
playhead 347, 457
playing techniques 816

moving (continued)
pull-offs 783
rehearsal marks 840
repeat endings 855
repeat markers 859
rests 406, 886
rhythm slashes 872
selection. See navigation
slash regions 874
slurs 895, 897
staves 97, 98, 371, 381
string indicators 677, 678
subito 640
tabs 40, 41
tapping 783
tempo marks 450, 930
text 404
text on lines 836–838
time signatures 959
tremolos 966
tuplets 353, 971, 976
view 346–348

mp. See dynamics
MP3 files

exporting 73, 74
muffed notes. See dead notes
multi-bar rests 884, 885

bar numbers 565
hiding 885
showing 885
signposts 349
single bars 885
tacets 389, 390

multi-note tremolos. See tremolos
multi-pasting 352
multi-rests. See multi-bar rests
multi-staff instruments 910

cross-staff beams 583
hiding staves 373–375, 408
slurs 211

multiple
bar numbers per system 567
codas 858
flows on pages 377
movements 122
segnos 858
staff input 161, 177

multiple-voice contexts 997
articulations 548
dynamics 343, 637
fermatas 689, 691
grace notes 683, 889
guitar pre-bends 776
inputting notes 174
note alignment 998
notes 1001
ornaments 343, 742
rests 879, 881
slashes 871, 872
slurs 889
stem direction 683, 922, 1001
ties 943
voice column index 999
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music
arranging. See arranging
condensing. See condensing
editing 153

music area 28
event display. See event display
making selections 336
moving music 346–348
multiple windows 41
opening layouts 27, 36
page arrangements 35
panels 37
selecting views 42
zoom options 35, 348

Music Fonts dialog 396
music frame chains 366

propagating part formatting 393, 394
music frames 365

frame chains. See music frame chains
margins 381
padding 381
vertical justification 408

music symbols
tokens 399

musical extracts. See flows
MusicXML

chord symbols 607
dialog 64
exporting 63, 64
importing 63
opening 56
pedal lines 812
percussion 995
repeat endings 856
resetting beaming 577
staff labels 902

muted
notes. See dead notes

muted noteheads 722
mutes. See playing techniques
muting

deactivating 462, 469
instruments 461
items 462
notes 341, 462
slash notes 353, 1001
tracks 461, 469

mutual exclusion groups 497
editing 504

N
names

drum sets 109
flows 135
groups 113
instruments. See instrument names
layouts 129, 131
percussion kits 109, 113
player groups 119, 120
players 129, 130
staff labels. See staff labels. See also instrument 
names

naming schemes
file names 528

narrow time signatures 961
Nashville

chord symbols 250
numbers 249

natural harmonics 733
appearance 737, 739
hiding 734
showing 734

naturale. See playing techniques
naturals

hiding 542, 736
inputting 185
parentheses 542, 736
showing 542, 736

navigation 345
bars 347
caret 161
chord symbols popover 252
fingerings popover 212
flows 346
items 345
lyrics popover 313
music area 345
note input 161, 164, 165, 184
notes 345
pages 347
print preview area 30, 518
rhythmic grid 155
Write mode 345

nested
slurs 890, 895, 896
tuplets 968

new projects
starting 54
templates 53, 55

niente hairpins 637
changing 638
circle 637
inputting 243, 245, 247
styles 638
text 637

no chord symbols 251
nodes 733

changing 735
non-arpeggio signs. See arpeggio signs
non-drop frame timecodes 849
non-power of two time signatures. See time signatures
non-sustaining instruments 646

velocity 437. See also velocity lanes
non-transposing layouts 127
nontuplets. See tuplets
notated duration 515, 516

played duration 515
requantizing 206
tool 413

notation reference 540
notation staves 917

hiding 918
showing 918
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notations
appearance 147
changing 342
copying 351, 352
editing 147
inputting 18, 209
percussion kits 981
popovers 18
position 147
properties 147
selecting 334, 335
settings 90
zoom options 35, 348

Notations panel 143, 153
Notations toolbox 151
notches

pedal lines. See pedal retakes
slurs 891
ties 941

note and rest colors 727, 882
exporting 525, 537
hiding 345, 727, 997
notes out of range 727, 917
printing 522, 537
rests 882
tablature 917
voices 997

note brackets. See bracketed noteheads
note durations 146, 515, 516

changing 170
expression maps 489, 503
forcing 171
hiding 146
inputting 161, 165, 169–171
inputting beats 236
metronome marks 230
quantization 68
selecting 169
showing 146
tempo equations 230
tuplets 197

note event actions. See key switches
note grouping 19, 590

changing 171
hemiola 171
meter 575, 590
note input 19, 20
pick-up bars 953
rests 19
ties 189
time signatures 20

note input 157, 161, 165, 421
adding notes 197
caret 157, 161
chord input 157
chords 192
grace notes 190
input pitch 167
inputting vs. editing 153
Insert mode 157
lock to duration 201
MIDI 204, 206, 207
mouse input 169

note input (continued)
multiple staves 161, 177
muting notes 341
percussion kits 180, 182, 183
pitch 167
playing notes back 341
register selection 164
repitching notes 201
rests 880
retrospective recording 206
rhythmic grid 156
starting 160
stem direction 183
tablature 165, 184
ties 189
tuplets 194
voices 174

note spacing 406, 407, 515, 584
changing 406
copying to other layouts 394
cross-staff beams 584
default 406
galley view 34
grace notes 683
layout options 90, 407
lyrics 407, 701
signposts 349
stems 584

note spelling 200
note values. See note durations
note velocities

MIDI import 66
notehead sets 718, 719, 722

designs 719, 722
pitch-dependent 722
scale degree 722
types 718

notehead-attached lines. See lines
noteheads 719

aikin 722
arrows 721
articulations 550, 551
brackets. See bracketed noteheads
changing 723
circular 719
crosses 720
designs 719, 722, 723. See also notehead sets
diamond 720, 721
dotted 722
five-line staff 987
funk 722
large 722
lines 832
moon 722
muted 722
parentheses. See bracketed noteheads
percussion 180, 985, 987, 990
pitch-dependent 722
playing techniques 985, 987, 989
rectangular 722
sets. See notehead sets
shapes 719, 722. See also notehead sets
size 719
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noteheads (continued)
slashes 722, 869, 1001
square 722
time signatures 957
triangular 721
types 719
unpitched percussion 985, 987
walker 722
wedges 721

notes 19, 718
accidentals 146, 185
add intervals popover 198
adding to existing notes 197
alignment 630
appearance 147
arpeggio signs. See arpeggio signs
articulations 146, 547, 549, 550
auditioning 341, 342
auxiliary 752
beaming 575, 577
brackets. See bracketed noteheads
brass fingerings 670
changing pitch 199, 201
chords 192, 194
colors 727, 997
condensing. See condensing
copying 351, 352, 547
crossing to other staves 353, 583
custom scale size 724
dead notes 782
deleting 350, 425, 553, 965
deselecting 341
dotted 172, 575, 590
drum editor 422
durations 146, 169, 170, 423, 515
dynamics 243, 429, 628. See also dynamics lanes
dynamics alignment 630
editing 144, 147
editorial 728, 729
enharmonic spelling 200
filters 340
fixing duration 171
fonts 396
ghost notes 729
glissando lines. See glissando lines
grace notes 190, 682
grouping 575, 590
guitar bends 279, 768
guitar post-bends 281, 772
guitar pre-bends 280, 771
harmonics. See harmonics
harp pedaling 794, 795
hiding 872
horizontal spacing. See note spacing
horn branch indicators 671
inputting 157, 161, 165, 168, 171, 172, 178, 180, 
192, 421
Insert mode 178, 179
jazz articulations. See jazz articulations
laissez vibrer ties 946
length 170, 423
lines. See lines. See also glissando lines
lock to duration 201

notes (continued)
lyric alignment 711
moving graphically. See note spacing
moving rhythmically 422, 725, 971
moving to other instruments 981
moving to other staves 353, 583
multiple-voice contexts 1001
muting 461, 462, 782, 813
navigation 345
notated duration 20, 515
note spacing 406
notehead designs 719
notehead sets 718
order 999
out of range 727, 919
overlapping 170, 999
overrides 516
parentheses 728, 729
partials 733
pedal lines 803
percussion kits 180, 994
percussion maps 506
piano roll editor 420–424
pitch 199, 201
pitch-dependent noteheads 722
Play mode 421
playback 488
played duration 515, 516
properties 147
ranges 727
register 164, 199, 201
removing stem direction changes 925
repitching 201
requantizing 206
resetting 516
rests 880
retakes 803
rhythm dots 172
rhythm slashes 1002
rhythmic grid 155
rolls. See tremolos
scale size 724
secondary beams 586
selecting 334, 335, 341, 345
showing 872
size 724
slash regions 872
slashes 869, 1001
slurs 146, 889
spacing. See note spacing
speed 169, 588, 926
spelling 200
staff spacing 371
stem direction 353, 921, 923, 924, 994
stem length 925
stemlets 588
string fingerings 671, 672, 726
string indicators. See string indicators
swapping 353
tablature 919
terminology 11
ties 20, 189, 550, 945
time signatures 957
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notes (continued)
transposing 198, 199, 201–203, 424, 697
tremolos. See tremolos
trill intervals 749, 750
trills 744
tuplets 967, 969
types 146
unbeaming 578
undamped 946
unscaling 969
velocity 437. See also velocity lanes
voices 174, 353, 354

Notes panel 143, 146
showing more note durations 146

Notes toolbox 144
scissors 947

November music font 396
numbers

backups 78
bar repeats 864, 865
bars 563, 570
beam lines 587
figured bass. See figured bass
instruments 101
layouts 128
lyric lines 712–714
pages 791
plug-in instances 415, 416
rehearsal marks 842
rhythm slashes 876
slash region counts 876
staff labels 908
staff lines 375, 983, 984
staves 373, 910, 911
strings. See string indicators
time signatures 957
tuplets 975
value fields 150
verses 716

numerators
styles 956, 957
time signatures 949

numeric value fields 150
nut

chord diagrams 609
fretted instruments 116

O
octatonic chord symbols 251
octave divisions 700

EDO 700
tonality systems 700
transposing 202, 203

octave lines 622
alignment 625
deleting 626
filter 340
handles 623
inputting 256, 258, 260, 261
length 623
moving 624
panel 261

octave lines (continued)
popover 257, 258, 260
position 623, 625
selecting 334
staff-relative placement 343
types 258, 622

octave transpositions 199, 202, 203
clefs 257, 620, 621
figured bass 658
octave lines 258, 622

octuplets. See tuplets
odd-numbered layouts

booklets 532
printing 522, 532

offsets
fret numbers 613, 614
resetting 344
timecodes 137, 850
videos 137
voice columns 999

omissions
chord diagrams 609, 614
chord symbols 251

open
key signatures 694
meter 956, 958
strings. See open strings
style 956, 958
time signatures 220, 951

open strings 733
chord diagrams 609, 614
harmonics 733
pitches 116, 118

opening
auto-saved files 77
files 56, 77
layouts 36
MIDI files 56
mixer 469, 471
MusicXML files 56
projects 54–57, 77
tabs 38
templates 55
tracks 455
transport window 472
video tutorials 53
video window 140
windows 41

optical spacing
cross-staff beams 584

optimized staves 371–373. See also condensing
optional notes. See bracketed noteheads
options

layout 90
page sizes 534
preferences 45
searching 45, 90
text formatting 308
toolbar 24
transport 24, 25
workspaces 24, 25
zoom 32, 35, 348
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orchestral
cues. See cues
order 97, 98, 107, 119, 128
staff grouping 55, 594
templates 55

orchestrating. See arranging
order

accidentals 543, 693
actions 494
articulations 549
expression maps 489
frame chains 366
instrument numbering 101
instruments 107
instruments in percussion kits 114
key signatures 693
layouts 128
lines 827
MIDI messages 494
notes 999
orchestral 97, 98, 107, 119
players 97, 98, 119
rehearsal marks 841
repeat markers 858
score 97, 98, 119
tabs 40
voices 999

orientation
changing 368
exporting 534
landscape 534
portrait 534
printing 522, 534

ornaments 741
acciaccaturas. See grace notes
accidentals 741, 753
alignment 742
appoggiaturas. See grace notes
changing 342
deleting 350
filter 340
inputting 266, 271, 272
interval 741
jazz 787. See also jazz articulations
length 747
moving 742, 743
panel 270, 272
placement 742
popover 266, 271
position 742
selecting 334
staff-relative placement 343
trills. See trills
types 266

Ornaments panel 272, 274, 275
ossia staves 911

condensing 911
playback 911
signposts 349, 911
staff spacing 371, 408
vertical spacing 371, 408

outputs
audio export 45
channel in the mixer 469
mixer 482
plug-ins 482

overdubbing
MIDI recording 206

overlapping
accidentals 543
articulations 550
notes 170, 999
slash regions 871
slurs 891
staves 368, 370, 371, 382
ties 939
voices 999

overline text 308
Override Percussion Noteheads dialog 987
overrides

clefs 619, 620
endpoints 484
flow headings 364
note duration 516
playback templates 473, 474, 476, 479, 484
removing 516
transposition 619, 620

overtones. See partials

P
padding

chord diagrams 610
frames 367
music frames 381
rests. See padding rests

padding rests 879
hiding 873
slash regions 873

page arrangements 34, 35
page breaks. See frame breaks
page formatting 367

bars per system 385
blank staves 375
casting off 385
divisi 916
empty staves 373, 375
fixing 385, 386, 393–395
flow headings 364, 367
formatting 364
left pages 377
master pages 363, 364, 370
multiple flows 377
page size 368
staff size 382
staff spacing 371, 408
staves 374, 375
systems 371, 386
tacets 390
text 396
titles 363, 364

page margins 367
changing 369, 381
hiding 345
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page numbers 791
count 401
flow headings 380, 792
flows 400
hiding 380, 792
initial 377, 792
numeral style 791
showing 380
tokens 400, 401
total 401

page ranges
exporting 524
printing 524
selecting 530

page size 533, 534
changing 368
layout options 90
MusicXML files 63

page turns
first page on the left 377

page view 34
arrangements 35
changing to 42
flows 355

pages
arrangements 35
background color 44
breaks. See frame breaks
changing view 42
color 44
dragging 348
exporting 524, 525, 530
formatting 680
frames. See frames
fullness 370, 372, 382
going to 347
hiding empty staves 374
layouts 363, 367, 385, 386
margins 367, 369, 381
master pages 363, 367
multiple flows 377
navigation 347
numbers. See page numbers
orientation 368
printing 530, 534
ranges 530
rectangles. See frames
setup 534
size. See page size
templates 363
text tokens 397
total number 401
turns. See frame breaks
view options 32

pan 469
panels 31

accidentals 219
arpeggio signs 270, 274
bar repeats 325
barlines 238, 242
bars 238, 239
clefs 258, 259, 261
dynamics 245, 247

panels (continued)
flows 80, 87
glissando lines 270, 275
guitar techniques 270, 279, 283, 285, 286, 288
hiding 25, 35, 37
holds 264
jazz articulations 270, 277
key signatures 217, 219
layouts 80, 85, 519
MIDI instruments 416
notations 153
notes 146
octave lines 261
ornaments 270, 272, 274, 275, 277
pauses 264
pedal lines 294, 299
Play mode 412
players 80, 81
playing techniques 294, 297, 299
Print mode 518
print options 520
properties 147
repeat endings 325
repeat markers 325
rhythm slashes 325
Setup mode 80
showing 25, 35, 37
tempo 231, 234
time signatures 222, 225, 227
tonality systems 219
tremolos 325, 331
VST and MIDI Instruments 415
VST instruments 415
Write mode 143, 146, 147, 153

paper
color 44
duplex printing 532
orientation 534
size 368, 533, 534

paragraph styles
bar numbers 566
inputting text 307
missing fonts 58
tacets 389

parentheses
accidentals 542, 736
bar repeat counts 864, 866
dynamics 633
fingerings 212, 214, 665
fret numbers 768, 773
ghost notes. See bracketed noteheads
guitar bends 768, 771
harmonics 736
metronome marks 927, 928
noteheads. See bracketed noteheads
octave line numerals 622
pedal continuation signs 809, 810
percussion notes. See bracketed noteheads
slash region counts 877
string shift indicators 726
tempo marks 927, 928
time signatures 220, 224, 956, 958
vibrato bar dives and returns 773
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part formatting 393, 394
system formatting 393

part layouts. See layouts
part names 129

changing 131
partial beams 578
partial harp pedaling 799

hiding 799
showing 799

partials 733
changing 735

parts. See layouts
pasting. See copying
patches

endpoints 481
playback 481, 488, 506

path
export 61, 63, 69, 72, 73, 527

patterns
chord diagrams 608, 612–614

pauses 687
appearance 342
barlines 692
breath marks. See breath marks
caesuras. See caesuras
changing 690
default settings 689
deleting 350
duration 342
fermatas 687, 691
filter 340
inputting 262–264
linked 690
moving 691
multiple at same position 690
panel 264
playback 687
popover 262, 264
position 689
selecting 334
single staves 690
staff-relative placement 689
types 262, 687

PDF files 535
color 536
exporting 525, 527
fonts 537
key commands 47
layout numbers 128
layouts 525, 527

pedal level changes 802
removing 803

pedal lines 801
alignment 803
appearance 808–811
changing 342
continuation lines 801, 808, 809
deleting 350
duration 812
filter 340
formatting 808, 809
grace notes 805
harp pedaling. See harp pedaling

pedal lines (continued)
hooks 808
inputting 291, 293, 298, 299
length 805, 807
levels. See pedal level changes
lifts 802
merging 807
MIDI import 65, 66, 208
MIDI recording 208
moving 804
MusicXML import 812
muting in playback 462
notes 803
order 803
panel 294, 299
parentheses 809
percussion 813
playback 812
popover 293, 298
position 803, 805
releases 808
removing retakes 803
retakes. See pedal retakes
signposts 349
splitting 806
staff-relative placement 803
start signs 808, 810
text 810, 811
types 293, 801

pedal retakes 802
adding 293, 298–300
notes 803
removing 803

pedals
harp pedaling. See harp pedaling
piano. See pedal lines

percussion 978
drum sets. See drum sets
kits. See percussion kits
legends 990, 991
note input 421
noteheads 985, 987–989
playing techniques 511
tremolos 511

Percussion Instrument Playing Techniques dialog 985
percussion kits 978, 979

adding instruments 111
caret 180
changing instruments 111
creating 106, 111
drum sets. See drum sets
dynamics 982
editing area 109, 983
exporting 980
filtering instruments 109
five-line staff 909, 983
gap sizes 115
grids 112–115, 983
groups 112–114
importing 980
individual instruments vs. kits 978
inputting notes 180
instrument order 114
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percussion kits (continued)
legends 990
moving notes 981
naming 109, 113
notations 981
note input 182, 183, 421
noteheads 985, 987
playing techniques 985, 988
presentation types 109, 978, 983, 984
removing instruments 115
rhythm slashes 1003
setting up 109, 182
single-line instruments 983
spacing 115
staff labels 109, 903, 907, 983
staff position 114, 182, 985
staff-relative legend placement 343
staves 109, 978, 983, 984
stem direction 109, 183, 993, 994
stickings 982
voices 109, 993, 994

percussion legends 990
adding 991
changing 992
handles 992
instrument names 993
layouts 990
length 992, 993
position 990
ranges 990, 992
signposts 349, 990
sounding instruments 992
staff-relative placement 343
types 990, 992

percussion maps 506
creating 509
custom 509
dialog 506
endpoints 481, 488
exporting 511
file format 511
filters 506
importing 511
linking 488
note input 182
playback techniques 506
resetting 506

Percussion Maps dialog 506
percussion stickings 982
performance instructions 680
period 11

dynamics 640
lyrics 704
rhythm dots 144, 172
subito 640

Petaluma music font 396
phrases

bar repeats 342, 862
chord symbol regions 601

phrygian chord symbols 251, 606
piano

depressed notes. See bracketed noteheads
dynamics. See dynamics

piano (continued)
hand marks. See lines
level changes 802, 803
pedal lines. See pedal lines
playback 812
retakes 802, 803
slurs 211
substitution fingering 661

piano roll editor 420
changing note durations 516
deleting notes 425
event display. See event display
independent voice playback 420
inputting notes 421
instrument tracks 427
moving notes 422
note length 423
played vs. notated durations 515
selecting notes 413
slurred notes 900
tracks 426
transposing notes 424
zoom 426

pick-up bars 951, 953
deleting beats 236, 553, 554
inputting 220, 222, 226, 227
turning bars into 953

pictures
videos 136

pinch harmonics 737
showing 740

pinky finger 665
inputting 215
popover 215

pitch
accidentals 185, 541
add intervals popover 198
bends. See pitch bends
changing 118, 199, 201, 203
changing string 919
chord diagrams 613, 614
clefs 258, 259, 616
concert 127
dips 782
expression maps 489, 502
filters 340
fretted instrument strings 118
guitar strings 118
guitar techniques 782
harmonics 733–735
input 167
instruments 104, 107
jazz articulations 786
key signatures 693
microtonal 545, 700
note input 164, 185
noteheads 718, 722
notes 201
octave lines 260, 261, 622
open strings 116, 118
ornaments 741
partials 733, 735
ranges 727
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pitch (continued)
strings 116, 118, 613, 614
transposed 104, 127
trills 748–750, 753, 754, 756

pitch before duration 165
accidentals 168
activating 144
articulations 168
rhythm dots 168

pitch bends 441, 763, 768
guitar. See guitar bends
MIDI controllers 439, 441

più. See tempo marks. See also dynamic modifiers
pizzicato. See playing techniques
placement

articulations 550, 551
breath marks 689
caesuras 690
changing 343
clefs 617
dynamics 629
fermatas 689
fingerings 661, 664
glissando lines 763
grace notes 683
harp pedal diagrams 798
lines 827–829
lyrics 701, 710
ornaments 742
pauses 689
pedal lines 803
playing techniques 343, 815
rehearsal marks 839
rests 879
slurs 887, 889, 893
tempo marks 929
ties 939
time signatures 950
tremolos 964
tuplets 967
voices 998

plain font
playing techniques 813
string indicators 674
time signatures 961

Play mode 16, 412
channel strips 471
deleting notes 425
drum editor 420
Endpoint Setup dialog 482
event display 418
exporting expression maps 505
expression maps 488, 499
inputting notes 421
loading sounds 417, 418
MIDI instruments 416, 417
mixer 469, 471
moving notes 422
note durations 423, 515, 516
overrides 516
panels 31, 412, 415
percussion maps 506
piano roll editor 420

Play mode (continued)
playback 458
playhead. See playhead
switching 412
toolboxes 412, 413
tracks 426, 455
transport 25, 472
unpitched percussion 995
VST instruments 415, 417, 418
window elements 412
zooming 426

Play toolbox 413
playback 458, 512

arpeggio signs 761, 762
articulations 460, 489, 551
audio buffer size 207, 208
automation 439
bar repeats 862
bracketed noteheads 729
changing sound libraries 479
channel strips 471
chord symbols 452, 453
chords 342
click 447, 458, 472
dead notes 782
default settings 479
default tempo 926, 932
dynamics 341, 429, 460, 496, 637
elapsed time 472, 473
endpoints 481, 482, 484, 487, 488
excluding items 462
exporting audio 73, 74
expression maps 488, 489
fader 469
fast-forwarding 457
fixed tempo 463
flows 487
follow tempo 463
ghost notes 729
glissando lines 766, 794
grace notes 686
guitar bends 768
harmonics 733–735
hiding notes 872
instruments 460, 488, 506
jazz articulations 512, 786
line 457
metronome 472
mixer 469, 471
multiple windows 41
muting 461, 462
mutual exclusion groups 504
note durations 515
note velocity 437
notes 341, 342, 460
number of times played 464
ossia staves 911
overrides 516
patches 481
pauses 687
pedal lines 812
percussion 488, 506, 985, 987, 988
playhead. See playhead
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playback (continued)
playing techniques 460, 503, 512, 513
playthroughs 464
plug-ins 469
preferences 45
recording notes 206
repeats 464, 465
resetting volume 462
rewinding 457
selections 458
silence playback template 473, 474
slashes 353, 872, 1001
slurs 211, 460, 900
soloing 461, 462
starting 458
swing 466–468
templates. See playback templates
tempo 447, 472, 933, 934
tempo equations 937
timecode 472, 473
transport 472, 473
tremolos 460, 511
trills 754, 755
velocity 437
vibrato bar dives and returns 773
voices 460, 487
volume 341, 462, 469

playback techniques 481, 503, 512, 513, 547, 813
attribute 513
combinations 499, 503
creating 513
deleting 504, 513
direction 513
editing 513
endpoints 481
expression maps 488, 489
fallback 513
mutual exclusion groups 504
percussion 511
percussion maps 506
playback templates 473
resetting 513

playback templates 473, 474
changing 479
creating 479
custom 473, 476, 479
dialog 474, 476
endpoint configurations 415, 482, 484
exporting 481
factory default 474
fallback 476
file format 473
importing 480
overriding 473
resetting 479

played duration 515
changing 516
notated duration 515
overrides 516
resetting 516
slurs 900
tool 413

player cards 81
disclosure arrows 35

player groups 81, 119
adding players 121
bracket grouping 561
creating 120
deleting 120
moving players 121
naming 120
removing players 121

player labels
staff labels 908

player names 129
changing 130
instrument tracks 427
resetting 130
text tokens 397

players 17, 93, 94
adding 99, 105, 121
adding to flows 123
cards 81
changing transposition 107
chord symbols 253, 600
clefs 619
condensing 392
copying 97
deleting 98, 108, 120
divisi 916
duplicating 97
empty staves 373
ensembles 81, 99
exporting audio 73
exporting MIDI 69
extra staves 910
figured bass 313, 652
flows 93, 123
groups. See player groups
hiding 123, 125
importing 59, 60
instrument change labels 906
instrument order 107
instruments 18, 42, 100, 105, 107
layouts 93, 125, 131
lists 397
maximum number 94
merging 59, 60, 63, 65
moving 97, 98
moving between groups 121
moving instruments between 107
multiple instruments 42, 105, 130
muting 461, 462
naming 129–131
numbering instruments 101
ossia staves 911
panel 80, 81
part layouts. See layouts
percussion kits 106
pitch 104
player names 130
position in score 97, 98
removing from flows 123
removing from groups 121
section players 81, 94, 95
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players (continued)
showing 123, 125
solo players 81, 94, 95
soloing 461, 462
staff labels 902
staff size 383
staves 374, 375
swing playback 467, 468
tablature 917, 918
text tokens 397
transposition 104

Players panel 80, 81
hiding 81
showing 81

playhead 457
fast-forwarding 457
hiding 458
moving 347, 457
playback 458
position 458
repeats 464
rewinding 457
showing 458
transport 472, 473
zooming 426

Playing Technique Combinations dialog 499
playing technique lines 818, 821

appearance 820
changing 822
default settings 818
duration 817, 819, 820
hiding 820
showing 820, 821

playing technique-specific noteheads 813, 985, 987
appearance 990
articulations 511
creating 989
playback 511

playing techniques 813
adding text 814
changing 342, 988
combinations 499, 503, 511
continuation lines 818, 821
creating 989
deleting 350
dialog 513
divisi 916
duplicating 820
duration 817, 819–821
endpoint configurations 484
expression maps 488, 489, 512
filter 340
font 813
grouping 818, 821
guitar. See guitar techniques. See also vibrato bar
handles 819
harmonics. See harmonics
hiding 815
inputting 291, 295, 297
lanes. See playing techniques lanes
length 817
lines. See playing technique lines
moving 816

playing techniques (continued)
muting 462
noteheads 511, 985, 987, 989, 990
panel 294, 297
percussion 511, 982, 985, 987
placement 815
playback 460, 488, 489, 512, 513
popover 291, 295
position 815
repeating 820
selecting 334
showing 815
signposts 349, 815
staff-relative placement 343
text 813, 814
tracks. See playing techniques lanes
types 291, 813
ungrouping 822
voices 295, 297, 460

playing techniques lanes 445
hiding 446
showing 446

Playing Techniques panel 297, 299
playthroughs 853

bar numbers 573
changing 464
MIDI recording 206
optional notes. See bracketed noteheads
repeats 464, 465
total number 853

plops. See jazz articulations
plucked instruments

arpeggio fingering 668
fingerings 212, 665
popover 215
slides 669, 670
string indicators. See string indicators
strings 726
tablature. See tablature
tuning 104

plug-ins 473
allowing 418
blocking 418
changing 473
configurations 476, 482, 484–487
endpoints 473, 481, 487, 488
expression maps 488, 489
instances 415
loading 417
mixer 482
percussion maps 488
playback 469
saving 484, 485

plus sign
caret 157
mutes. See playing techniques
rim shots. See playing techniques. See also playing 
technique-specific noteheads
tapping 779
time signatures 220, 951

PNG files 535
color 536
exporting 525, 527
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PNG files (continued)
layout numbers 128
layouts 525, 527
resolution 536

poco a poco
centered 640
dynamics 243, 245, 639, 640, 644
tempo marks 927, 929

points
automation 439, 441–444
constant 433, 442
dynamics 429, 432, 433, 435, 436
linear 433, 442
tempo changes 447
unit of measurement 45

polychord chord symbols 251, 598
inputting 255

polymeter 224, 225, 949
polytonality 218, 219, 693
popovers 18

add intervals 197, 198, 201
arpeggio signs 268, 273
bar repeats 324, 333
barlines 235, 237, 238, 240, 242
bars 235, 236, 238
beats 236
changing items 342
chord symbols 249, 252
clefs 257, 258
dynamics 243, 245
figured bass 315
fingerings 212, 214
glissando lines 268, 274
guitar techniques 268, 279, 281, 282, 284, 286–
288, 290
harp pedaling 294
holds 262, 264
instruments. See instrument picker
jazz articulations 267, 276
key signatures 216, 218
lyrics 310, 311, 313
metronome marks 229
octave lines 257, 258, 260
ornaments 266, 271, 273, 274, 276
pauses 262, 264
pedal lines 293, 298
playing techniques 291, 295, 298
repeat endings 322
repeat markers 322
repeats 322, 330, 333
rhythm slashes 324
string indicators 294
tempo 229, 233
time signatures 220, 224, 226
tremolos 323, 330
trills 267, 750
tuplets 194, 195

portamento. See glissando lines
portrait orientation 534
ports 427, 447, 452, 482

changing 487
chords track 452
expression maps 482, 488

ports (continued)
instrument tracks 427
instruments 487
mixer 469
percussion maps 482, 488
setup 482
time track 447

position
arpeggio signs 760, 761
articulations 550
dynamics 629
figured bass 655
fingerings 661
glissando lines 763
grace notes 683
gradual dynamics 646
hairpins 646
inputting 153
instruments in percussion kits 114
items 344
jazz articulations 788
key signatures 696
lines 826
new items 153
notes in multiple-voice contexts 998
octave lines 625
pauses 689
pedal lines 805
resetting 344
slurs 887, 889, 893
string indicators 677
time signatures 950
trill intervals 753
videos 139

possibile. See dynamic modifiers
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
preamble 680
preferences

key commands 47, 50
MIDI 208
missing fonts 58
mouse input 154, 155
note input 165, 167, 168
pedal lines 208
selection tools 33
sustain pedal controllers 208
theme 43

Preferences dialog 45
prefixes

dynamics 639
fingerings 671
instrument change labels 103
rehearsal marks 842

presentation types 109
changing 984
dynamics 982
editing area 109, 983
percussion kits 978, 983

presto. See tempo marks
previous versions 57
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primary bar number sequence
changing 571
returning to 573

primary beams 586
Print mode 16, 518

landscape orientation 530
page setup 534
panels 31, 518–520
portrait orientation 530
printers 530
switching 518
toolboxes 518

Print Options panel 518, 520
print preview area 30

navigation 30, 518
printers 530

selecting 522
printing 518, 522

annotations 537
arrangements 530
booklets 532
borders 537
comments 361, 537
copies 522
crop marks 537
date 537
duplex 522, 532
job types 530
key commands 47
landscape 530, 534
layouts 522
macOS options 525
note colors 537
options 520
orientation 534
page sizes 533, 534
paper sizes 533
PDF files 525
portrait 530, 534
preview 30, 345
ranges 522, 524
scale size 522
signposts 537
spreads 530
time 537
voice colors 537
watermarks 537

program change actions 501
program changes 488, 494
Project Info dialog 88
project information 88

flow titles 135
master pages 680
tokens 88, 135, 399

project window 23
dark 43
light 43
opening multiple 41
Play mode 412
Print mode 518
Setup mode 80
splitting 40

project window (continued)
theme 43
Write mode 143

projects 16, 59
auto-save 76, 77
backup location 79
backups 78
different Dorico versions 57
exporting 63, 64, 69, 72
exporting flows 61
flows 59–61, 122, 136, 355
frame rates 142
full screen mode 41
importing flows 59, 60, 63
layouts. See layouts
MIDI files 69
missing fonts 58
movements 122
multiple windows 41
MusicXML files 63, 64
opening 41, 56, 57, 77
recent 57
recovering 77
splitting flows 355
start area 28
starting 54, 55
Steinberg Hub 53
tabs 40
templates 53, 55
titles 136
tokens 399
videos 136, 139
window 23
workspaces 36

Propagate Part Formatting dialog 393
propagating

part formatting 393, 394
properties 395

properties 147
copying to other layouts 395
global 149
local 149
scope 147, 149
searching 147
selected items 147
values 150
videos 137

Properties panel 31, 147
disclosure arrow 32
hiding 32
showing 32
Write mode 143

pulgar. See thumbs
pull-offs. See hammer-ons
punctuation

timecodes 849

Q
qualifiers 243, 245
quality

chord symbols 250, 255, 599, 601
transposing 202, 203
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quantization
changing 206
dialog 68
importing MIDI 65
MIDI recording 204
requantizing 206
tuplets 68

quarter notes 11, 146
beats 236
metronome marks 230
swing playback 466
tempo equations 937
tuplets 197

quarter tones 545, 700
accidentals 545
guitar bends 281, 772, 774
transposing 198

quartet templates 55
staff grouping 55, 594

quavers. See eighth notes
question marks

harmonics 734
tablature 199, 917

quintet templates 55
staff grouping 55, 594

quintuplets. See tuplets

R
rallentando. See gradual tempo changes. See also 
tempo marks
ranges

arpeggio signs 273, 274, 760
bar numbers 565
colors 727
copying notes 352
instruments 100
lines 306, 760, 831
metronome marks 932, 934
notes 727
pages 522, 524
percussion legends 992
selecting 336
swapping 353

rasterizing. See staff size
rastral size 382
rates

frames 141
ratios

grace notes 684
note spacing 407
swing playback 466
tuplets 975, 976

re-strikes. See guitar pre-bends
read-only mode 56, 94
recent projects 57
recipes 528
recording

input pitch 167
MIDI 204, 207, 463, 472
retrospective recording 206, 472
tempo 463

Recover Auto-saved Projects dialog 77

recovering 206
backups 78
files 76–78
notes 206

rectangle
above systems. See system track
bar number enclosures 564
colored. See signposts
music. See music frames. See also frames
noteheads 722
text enclosures 404

reducing 382, 392. See also condensing
reduction 124
regions

bar repeats 861
chord symbols 601
counts 876
dynamics 429
Play mode. See colored regions
slashes 869, 874

register
changing 199, 201, 203
clefs 258, 259, 616, 621
note input 164
octave lines 260, 261, 622
plug-ins 418
transposing 201, 621

rehearsal marks 839
barlines 839
deleting 841
enclosures 839
filter 340
index 841
inputting 317
moving 840
multiple positions 839, 913
order 841
placement 839
position 839
prefixes 842
selecting 334, 337–339
sequences 841, 842
staff-relative placement 839
suffixes 842
tempo marks 839
types 842
vertical positions 913

relative channel change actions 501
relative tempo changes 927

values 934
releases

guitar bends 768
reloading

video files 139
removing. See deleting
renaming

drum sets 109
endpoints 486
flows 135
groups 113
instruments 131
layouts 131
percussion kits 109, 113
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renaming (continued)
player groups 120
players 130
titles 135

renumbering
layouts 128

repeat barlines 558
exporting 464
inputting 237, 240, 242
MIDI recording 206
number of times played 464
playback 464
playthroughs 464
popover 237, 240, 242

repeat endings 853
additional endings 326, 327
alignment 855
appearance 856
bar numbers 573
deleting 350
exporting 464
final segments 856
handles 854
inputting 322, 325–327
length 854
MIDI recording 206
moving 855
multiple positions 855, 913
MusicXML files 856
number of playthroughs 853
optional notes. See bracketed noteheads
panel 325, 327
playback 464
playthroughs 853
popover 322, 325, 326
position 855
segments 853, 855
selecting 334, 337–339
types 322
vertical positions 913

repeat jumps. See repeat markers
repeat markers 857

bar numbers 573
changing 342
deleting 350
exporting 464
index 858
inputting 322, 325, 329
MIDI recording 206
moving 859
multiple 858
multiple positions 859, 913
number of times played 464
optional notes. See bracketed noteheads
order 858
panel 325, 329
playback 464, 465
popover 322, 329
position 859
staff-relative placement 860
text 858
types 322
vertical positions 913

repeat sections. See repeat markers
Repeat Structures panel 325
repeating. See copying. See also repeats
repeats

barlines. See repeat barlines
bars 861
counts 864
dynamics 464
endings. See repeat endings
export 464
frequency 865
grouping 867
length 342, 862
markers. See repeat markers
optional notes. See bracketed noteheads
playback 464, 465
playing techniques 820
tempo marks 464

repeats popover 322
repitching notes 201
replacing

fonts 58
replying

comments 356, 358, 360
requantizing notes 206
resetting 350

accidentals 541
appearance 344
background color 44
bar numbers 571, 573
beaming 577, 579, 582
beams 587
chord diagrams 614
chord symbols 607
dynamics 436
expression maps 498
figured bass 659
fingerings 668
instrument names 132, 134
items 344
key commands 51
layout names 131
layouts 129
mute states 462
note velocity 439
page color 44
part layouts 129
percussion maps 506
playback overrides 516
playback techniques 513
playback templates 479
player names 130
position 344
secondary beams 587
solo states 462
staff labels 134
staves 374, 375
stems 925
tempo 927
trill intervals 751
velocity 439
volume 462
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resolution
changing 527
images 536
rhythmic grid 32, 156

respelling
accidentals 200
chord symbols 606, 607
notes 200

rest grouping. See note grouping
restating

accidentals 545
restorative text 811
restoring. See resetting. See also hiding
rests 19, 879

alignment 879
bar rests. See bar rests
beaming 577, 588
changing type 882
colors 882. See also note and rest colors
consolidation 881, 884, 885
deleting 170, 883
durations 169
empty bars 884
explicit 879, 880, 882
figured bass 313, 651, 653, 657
filling in 170
forcing duration 171
grouping. See note grouping
hiding 873, 883–885
implicit 879, 880, 882
inputting 144, 171, 187, 188
moving 406, 886
multi-bar rests 884, 885
padding 873
placement 879
position 879
restoring 883
showing 883–885
voices 879, 881, 886

retakes. See pedal retakes
retrieving. See recovering. See also retrospective 
recording
retrospective recording 206, 472
reverb channels 471

mixer 469
reverse

lines 835
printing 532

reverting. See resetting
reviewing

comments 356
rewinding 457, 472
rfz. See dynamics
rhythm

locking 201
requantizing 206
slashes. See rhythm slashes
tablature 918

rhythm dots 172
Chord mode 194
inputting 161, 165, 168, 169, 172
Insert mode 179

rhythm dots (continued)
number 169, 172
pitch before duration 168

rhythm section
brackets 594
chord symbols 600, 601
staff grouping 594

rhythm slashes 869, 1001
appearance 871
caret 157, 175
changing number 876
counts 876, 877
deleting 350
filter 340
font style 864, 876
frequency 876
hiding counts 877
hiding rests 873
highlights 870
inputting 175, 325, 332
moving 872, 874
panel 325
parentheses 877
percussion kits 109, 114, 180, 1003
placement 877
popover 324, 332
regions 869, 876
rests 873
splitting 874
staff position 114, 872
staff-relative placement 877
stem direction 871, 924
stemless 157, 175
stems 875
type 1002
vertical position 872
viewing options 870
voices 175, 353, 871, 1001, 1002

rhythmic feel
changing 467
default settings 466
deleting changes 468
popover 231
signposts 349, 467, 468

rhythmic grid 32, 155
changing 156
key commands 47, 50
resolution 32, 156
selecting music 339

rhythmic notation 20, 869
rhythmic position 20

playback 457
rhythmic position-attached lines. See lines
ride bell. See unpitched percussion. See also playing 
technique-specific noteheads
right hand hooks. See lines
right panel 31
right-foot pedals. See harp pedaling
right-hand fingering 665

arpeggio signs 668
brackets 667
inputting 212
placement 661
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right-hand fingering (continued)
popover 215
tapping. See tapping

right-hand guitar tapping. See tapping
rim shots. See playing techniques. See also playing 
technique-specific noteheads
rips. See jazz articulations
ritardando. See gradual tempo changes. See also 
tempo marks
ritenuto. See gradual tempo changes. See also tempo 
marks
rolled chords. See arpeggio signs
rolls. See tremolos
Roman numerals

flow numbers 400
harmonic analysis 651
page numbers 791
tokens 400

roots
chord symbols 250, 255, 599, 601

round notehead brackets 728
hiding 729
showing 729

rows
chord diagrams 610
figured bass 655

rulers
Play mode 418
rhythmic grid 155

running headers
flow headings 380
hiding 380

runs
guitar bends 768

S
salzedo breath marks 688
sample libraries. See sound libraries
sampled trills 754, 755
Save Endpoint Configuration dialog 485
saving 53, 76

audio 69, 73
auto-save. See auto-save
backups 78
chord diagram shapes 613
comments 361
endpoint configurations 484
endpoints 485
expression maps 505
folder location 79
graphics files 525, 527
instrument names as default 132
layout options as default 90
MIDI files 69
MusicXML files 63
percussion kits 980
percussion maps 511
playback templates 480, 481
played notes 206
plug-in instances 484

scale degrees
chord symbols 249
Nashville numbers 250
noteheads 722

scale size
barlines 558
chord diagrams 610
cues 406, 407
fingerings 665
grace notes 406, 407, 682, 684
note spacing 406, 407
notes 724
printing 522, 533, 534
staves 382–384, 408

scales 700
degrees 599, 722
EDO 700
key signatures 693, 694
major 694
minor 694
octave divisions 700

scissors 144
activating 144
slashes 874
ties 947

scoops
deleting 785
inputting 276, 277, 284, 285
jazz. See jazz articulations
popover 267, 268
vibrato bar 778

scope
properties 149

scordatura 116, 118
scores. See layouts
scrapes. See playing techniques
scroll view. See galley view
searching 45

ensembles 83
instruments 83
key commands 47–49
layout options 90
preferences 45
properties 147

second voices
adding 174
bar rests 188

secondary beams 586
changing 587
lines 587
resetting 587
splitting 576

secondary brackets 595
braces 596
hiding 596
showing 596
sub-brackets 596. See also sub-brackets
sub-sub-brackets 597

section players 94
adding 95
divisi 916
empty staves 373
ossia staves 911
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section players (continued)
staff labels 901
staves 374, 375

sections
coda 857
fine 857
hiding 35
repeat 857
showing 35

segments
caps 834
final 856
repeat endings 326, 327, 854
tuplets 970

segno 857
inputting 329
multiple 858
sections 857

selecting 33, 334, 336, 341, 345
bars 337, 338
beats 339
blue 648, 899
changing the selection. See navigation
chord symbols 337–339
chords 342
everything 335–339
extending selection 334, 336
filters 340, 341
flows 336
items 153, 334, 336, 345
items behind other items 334
key signatures 337–339
lyrics 703
marquee 33, 335
more 334, 336
notations 33, 335
notes 33, 334, 335, 341, 342, 345
Play mode 413
rehearsal marks 337–339
repeat endings 337–339
status display 32
staves 336
system objects 337–339
system text 337–339
system track 337
tempo marks 337–339
time signatures 337–339
tools 32, 33, 144, 413
transposing selections 202, 697
Write mode 144

semibreves. See whole notes
semiquavers. See sixteenth notes
semitones. See half-steps
sends 471

mixer 469
separators

dynamics 634
fingerings 670
systems. See system dividers
time signatures 956, 958
timecodes 849

septuplets. See tuplets

sequences
bar numbers 570–572
page numbers 377
rehearsal marks 841
subordinate 572
types 842

sets
drum sets. See drum sets
master pages. See master page sets

setting up
audio devices 45, 207, 208
drum sets 109
duplex printing 522
key commands 50
MIDI recording 207
percussion kit note input 182
percussion kits 109
windows 36
workspaces 36

settings
audio 45
copying properties 395
default 45, 90
harp pedals 794
layout-specific 90
MIDI import 66
mouse input 154, 155
note input 165, 167, 168
preferences 45
properties 147, 149
videos 137

Setup mode 16, 80
adding players 99
ensembles 99
flows. See flows
instruments. See instruments
layouts. See layouts
panels 31, 80, 81, 85, 87
percussion 109
player groups 119
players. See players
signposts 349
switching 80

sextuplets. See tuplets
sfz. See dynamics
shakes. See jazz ornaments
shape

bar number enclosures 564
beaming 581, 586, 588
chord diagrams 608, 612–614
noteheads 719, 722
slurs 890
tuplet brackets 973–975

sharing staves. See condensing. See also divisi
sharps. See accidentals
short

notes 68, 169, 170, 190, 407, 495, 682, 686
stemlets 588

shortcuts. See key commands
showing. See hiding
shrinking. See size
side stick. See unpitched percussion. See also playing 
technique-specific noteheads
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signatures
annotations 537
key signatures. See key signatures
printing 537
time signatures. See time signatures

signposts 349
barlines 555, 560
bars 555
chord symbols 598, 600, 601
clefs 619
dynamics 634
exporting 525, 537
extra staves 910
figured bass 313, 651, 652, 657
frame breaks 388
harp pedaling 794, 796, 797
hiding 345, 350
key signatures 695
ossia staves 911
percussion legends 990
playing techniques 815
printing 522, 537
showing 350
staff changes 910
system breaks 388, 389
tempo marks 928, 932
text 405
time signatures 555, 956, 958, 960
trills 748–750
tuplets 973, 976

silence
hairpins. See niente hairpins
missing sounds 479
muting items 462
notes 782
playback template 473, 474, 479
rests. See rests

simile
dynamics 243, 245, 639
hiding 820
playing techniques 820
showing 820

simple time signatures. See time signatures
single bar rests

bar counts 885
H-bars 885
hiding 884
showing 884

single barlines 558
single-line

percussion kits 983, 984
staves 909

single-note tremolos. See tremolos
single-voice contexts 997

articulations 548
grace notes 683
guitar pre-bends 776
stem direction 683, 921
tie curvature direction 943

six-line staff
tablature. See tablature

sixteenth notes 11, 146
beats 236
metronome marks 230
swing playback 231, 466
tuplets 197

size 382
arpeggio sign fingerings 668
audio buffer 207, 208
chord diagrams 610
cues 627
fingerings 668
gaps 115
grace notes 682, 684, 724
left-hand fingering 665
lyrics 708
noteheads 719
notes 627, 724
pages 90, 368, 533
paper 533, 534
rastral 382
space 382
staves 90, 370, 382, 383
system objects 370, 383
time signatures 954, 955
tracks 426, 455
unit of measurement 45
video window 140

slants
beams 580, 686
pedal line hooks 808

slash notation 869
slash regions 869

chord symbols 600, 601, 869
counts 876, 877
deleting 350
filter 340
font style 864
handles 875
hiding other notes 872
hiding rests 873
highlights 869, 870
inputting 332
length 875
moving 872, 874
multiple 871
overlapping 871
parentheses 877
placement 877
popover 324
rests 873
showing other notes 872
staff position 872
staff-relative placement 877
stem direction 871
stems 875
vertical position 872
viewing options 870
voices 871, 1001

slash voices 963, 1001
caret 157, 175
changing 353, 1002
inputting 175
moving 872
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slash voices (continued)
multiple-voice contexts 871
percussion kits 109, 180, 1003
playback 1001
popover 324
regions 324, 869
staff position 872
stem direction 924
stemless 157, 175
vertical position 872

slashes 869
dynamics 634
figured bass 315
grace notes 682, 683, 685, 686
noteheads 719, 722, 869, 1001
notes. See slash voices. See also tremolo strokes
regions. See slash regions
stemless 1002
stems. See tremolo strokes
time signatures 956, 958
tremolos. See tremolo strokes
voices. See slash voices

slides
fingerings. See fingering slides
pitch. See glissando lines. See also pitch bends

slight bends. See guitar bends
slurs 887, 940

angles 890
arpeggio signs. See curved arpeggio signs
articulations 549, 551, 890
collision avoidance 891, 895
cross-staff 211, 895
cross-voice 211, 895
curvature 889, 893, 894
dashed 891
deleting 350
dotted 891
duration 900
East Asian elision 716
editorial 891
endpoints 889, 890
filter 340
flat slurs 893
formatting 892, 893
frame breaks 890
gaps 890
grace notes 211, 683, 888, 889
guitar techniques 288
hammer-ons 288, 780
inputting 211, 288, 896
inverting 889, 893, 894
length 898
linking 342, 899
moving 897
muting 462
nested 890
nested slurs 895, 896
overlapping 891
panel 146
placement 887, 889, 890, 893, 894
playback 211, 460, 900
position 887, 889, 890, 893
pull-offs 288, 780

slurs (continued)
selecting 334, 345
shape 890
staff lines 889
stem direction 890, 893
styles 891, 892
system breaks 890
ties 888, 890
ties vs. slurs 940
unlinking 342, 900
within slurs 895, 896

small notes 724
cues. See cues
staves. See staff size

smears. See jazz ornaments
smooth

automation 442
dynamics 433
glissando lines 763
jazz articulations 786

SMuFL 396
tokens 399

snap pizzicato. See playing techniques
snare drums

rolls. See tremolos
solfège chord symbols 250
solid

slurs 891
tempo marks 937
ties 941

solo. See divisi. See also text objects
solo players 94

adding 95
empty staves 373
extra staves 910
ossia staves 911
staff labels 901
staff size 383
staves 374, 375

soloing 469
deactivating 462, 469
instruments 461
playback 460
tracks 461

sonata. See flows
songs. See flows
sordino. See playing techniques
sorting

layouts 128
sostenuto pedal 801

MIDI controller 812
sound libraries 473, 506

changing 479
expression maps 489
loading sounds 417, 473, 479
missing sounds 479
percussion maps 509
playback 488, 506
trills 754

sounding
duration 686
percussion legend ranges 990, 992
pitch. See sounding pitch. See also concert pitch
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sounding pitch 127, 733
harmonics 737
input pitch 167
layouts 127

sounds. See playback
soundtracks

audio 141
volume 141

source instruments 627
source notes 669
space size 370, 382, 383
spacing

accidentals 544
arpeggio signs 760
caesuras 265
condensing 392
cross-staff beams 584
cues 406
frets 116
galley view 34
grace notes 406
gradual dynamics 645
layout options 90
lyrics 407, 710, 711
notes. See note spacing
percussion kits 115
rehearsal marks 839
staves 371, 382, 408
stems 584
systems 382
tacets 392
voice columns 999

speech bubbles
comments. See comments

speed
arpeggio signs 762
beaming. See fanned beams
bpm 932
changing 233, 234, 449, 450, 463, 933, 934
frame rates 141
grace notes 686
playback 463, 926
tempo marks 926, 933–935
tremolos 965
trills 745, 754, 755
videos 141

spelling
accidentals 187, 200
notes 187, 200

spin boxes 150
split point

MIDI import 66
split stems 544

appearance 545
splitting

bars 555
beams 576
brackets 731
flows 355
multi-bar rests 884
notehead brackets 731
pedal lines 806
project window 40

splitting (continued)
slash regions 874
staves 329, 857
ties 590, 947
tuplets 970

spreads page arrangement 35, 530
square

accidental brackets 542, 736
bracketed noteheads 728, 729
noteheads 722

squeezes. See jazz ornaments
staccato. See articulations. See also playback 
techniques
stacking order

accidentals 543
lines 827

staff grouping
barline joins 560
changing 593
default settings 55, 593, 594
ensemble types 593, 594

staff labels 129, 901
alignment 132
changing 131
changing first system indent 915
condensed staves 908
Cubase 902
default settings 55
divisi 908
galley view 34
grouping 908
hiding 903
indents 904, 914
instrument change labels 906
instrument names 129, 131, 132, 134, 398, 902, 
903
length 903
MusicXML import 902
numbering 101, 902, 908
percussion 109, 907, 983, 993
project templates 55
resetting 134
showing 903
tokens 398
transposing instruments 901, 904, 905

staff lines
erasing 664, 674
number 375, 983, 984
slurs 889
string indicators 674
tablature 116, 917
ties 939

staff position
lines 760, 829, 831, 832
note input 182
percussion 985, 988, 989
percussion kits 114, 182

staff size 370, 382, 534
changing 370, 383, 384
custom 384
dialog 384
individual staves 383
layouts 909
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staff size (continued)
MusicXML files 63
rastral size 382
space size 382

staff spacing 370, 408
changing 371, 408
condensing 392
default settings 371, 408
divisi 372
galley view 408, 410
hiding staves 373–375
justification 372, 408
layout options 90
rehearsal marks 839

staff text 397
alignment 404
formatting 308, 310
hiding 405
inputting 307
moving 404
showing 405
signposts 349

staff-relative placement
articulations 550
bar numbers 569
beaming 578, 579
changing 343
cue labels 343
dynamics 343, 629
figured bass 656
fingering 667
fingerings 663, 664
guitar bends 343
guitar pre-bends 776
hammer-ons 783
harmonics 739
left-hand fingerings 668
lines 828, 829
lyrics 714, 715
octave lines 343
ornaments 343
pedal lines 803
percussion legends 343
playing techniques 343
pull-offs 783
rehearsal marks 839
repeat markers 860
resetting 344
slash region counts 877
slurs 894
string indicators 301–303, 674, 677
tapping 783
text 343
trills 343
tuplet brackets 974

start area 28
start position

frames 385, 387
lines 832
pages 385, 387
playback 457
systems 385, 388

start position (continued)
trills 743
videos 139

start repeat barlines 237, 558
inputting 240, 242
playthroughs 464

start signs
appearance 808
pedal lines 808, 810
text 810

starting 160
area 28
Hub 53
MIDI recording 204
note input 160, 161, 165
playback 458
players 28
projects 28, 54, 55
timecode values 850
workspaces 36

status bar 32
selection tools 33
view types 34

status display 32
staves 11, 909

adding 910
arranging tools 350
bar numbers 566, 567
bar rests. See bar rests
barlines 560, 561
beaming 583–585
brackets 55, 593, 594
casting off 385, 386
chord symbols 127, 253, 600, 601, 604, 605
clefs 621
collision avoidance 371, 372, 408, 410
comments 356, 358
condensing. See condensing
copying items 351, 352
crossing notes 583
dialog 384
dividers. See system dividers
divisi 916
dynamics 245, 247, 343, 637
dynamics linking 342, 648
empty. See empty staves. See also blank staves
extra 910
fermatas 691
figured bass 313, 651
fingerings 664
five-line 907, 909, 983
fixing 385, 386
galley view 42
gaps 857
glissando lines 274, 275
grids 907, 983
groups 561, 594
height 370–372, 381, 382
hiding 93, 123, 125, 126, 373–375, 918
indents 382, 904, 909, 914, 915
inputting on multiple 161, 177
instrument change labels 906
instrument changes 102, 103
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staves (continued)
key signatures 218, 219, 693
labels. See staff labels
large time signatures 955
layout options 909
margins 381
markers 845
moving 371, 381
multiple voices 174, 392
notation 917, 918
note input 161, 177
notes 353
number 373, 375, 910, 911
order 97, 98
ossia staves. See ossia staves
page view 42
pauses 689
percussion 983, 984
pick-up bars. See pick-up bars
playback 458
rasterizing. See staff size
reducing 392
rehearsal marks 913
repeat endings 913
repeat markers 860
selecting 336
showing 42, 123, 125, 373–375
single-line 845, 850, 851, 907, 909, 983
size. See staff size
slurs 895, 899
slurs linking 342
spacing. See staff spacing
splitting 329, 857
staff labels. See staff labels
stem length 925
string indicators. See string indicators
swapping contents 353
swing playback 467
system breaks 388
system dividers 911, 912
system objects 913
tablature 917, 918
tacets 389
tempo marks 913
text 307, 913
ties 189, 939, 946
time signatures 224–227, 913, 949, 955
timecodes 845, 850, 851
transposing instruments 104
vertical spacing. See staff spacing
voices 174
width 382

Steinberg Hub 53
opening projects 56, 57
starting projects 54, 55
video tutorials 53

stem direction 921
beam groups 923
beam placement 578, 585
centered beams 582
changing 353, 871, 923, 924
chords 922
drum sets 112

stem direction (continued)
filters 340
grace notes 683, 685
guitar pre-bends 776
middle line 921
multiple-voice contexts 922
notes crossed to other staves 583, 1001
notes on middle line of staff 921
percussion kits 109, 112, 183, 993, 994
resetting 579, 925
rhythm slashes 871, 924
single-voice contexts 921, 924
slurs 890, 893
staff-relative placement 579
tie curvature 939
ties 923
voices 353, 921, 924, 997

stemless
rhythm slashes 157, 175, 1002

stemlets 588
stems 575, 921

altered unisons 544
articulations 550
audio 73, 74
beam placement 585
beaming 578, 584
deleting tremolos 965
direction. See stem direction
double 174, 544, 997. See also voices
flags 921
gaps 584. See also note spacing
grace notes 685
length 685, 925
removing direction changes 925
rhythm slashes 871, 875, 1002
slurs 889
split stems 544, 545
stemlets. See stemlets
tablature 918
tremolos 963, 966
tuplet placement 967
voices 921, 924

step input. See note input
stickings 982
stopped pitch 733

harmonics 737
stopping. See starting
stopping finger. See left-hand fingering
straight lines

glissando lines 763
guitar bends 768
jazz articulations 788

straight playback. See swing playback
stress marks. See articulations
strikethrough text 308
string designation. See string indicators
string indicators 665, 674, 726

deleting 676
duration 675, 818
horizontal position 678
inputting 291, 294, 301–303
inside staff 303, 674, 676
lines 301, 302, 675, 818
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string indicators (continued)
moving 677, 678
outside staff 301, 302, 674
panel 294, 302
placement 677
popover 291, 294, 301
position 677

string instruments 100, 104
fingering shifts 671
playing techniques. See playing techniques
specifying string 726
substitution fingering 661

string pitches
changing 118
fretted instruments 118

string shift indicators 671
angles 671
direction 672, 726
thickness 671

strings
adding 116
bends. See guitar bends
changing 726, 919
changing pitch 116
chord diagrams 609, 614
deleting 116
fingering 665, 726. See also string indicators
fretted instruments 83, 104, 116
hammer-ons. See hammer-ons
harmonics 733
indicators. See string indicators
notes out of range 727, 919
numbers. See string indicators
pull-offs. See hammer-ons
resetting 919
slurs. See hammer-ons
tapping. See tapping
tuning 83, 104

strokes
figured bass 315
slurs 891
ties 941
tremolos 963–965

structures
repeat 325, 464, 853, 857, 861

strumming
fingering 668

styles
appearance 344
breath marks 688
caesuras 689
fermatas 687
glissando lines 763, 764
jazz articulations 788
margins 367
niente hairpins 638
resetting 344
slurs 891, 892
tempo marks 927, 935
ties 941, 942
time signatures 956, 957

sub-brackets 595–597
hiding 596
showing 596

sub-sub-brackets. See sub-brackets
subdivision

bars 590
tempo equations 937

subito. See dynamic modifiers
subordinate bar numbers 572

adding 572
subsequent repeats

bar numbers 573
substitution fingering 661

handles 662
position 662

subtitles 88, 364. See also flow headings
suffixes

dynamics 639
instrument changes 103
playing techniques 814
rehearsal marks 842
timecodes 849

sul ponticello. See playing techniques
sul tasto. See playing techniques
suppressing playback 462
suspensions

chord symbols 251
figured bass 313, 315, 654, 655

sustain pedal 801
continuation lines 809
inputting 293, 298, 299
level changes 298, 300, 802
merging 807
MIDI controller 208, 812
MusicXML import 812
popover 293, 298
removing retakes/level changes 803
retakes 298, 300, 802
splitting 806

sustaining instruments 646
SVG files 535

color 536
exporting 525, 527
fonts 537
layout numbers 128
layouts 525, 527

swapping
note order 999
notes 353
staves 353
voices 354

swash
arpeggio signs 757

swing playback 466
disabling 468
enabling 231, 467
popover 231
ratios 466
triplets 466

switches 492, 500
creating 502, 503
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switching
flows 346, 347
layouts 24, 36
notes to percussion instruments 981
tabs 39

syllables
dynamics 643
lyrics 704
position 710
tempo marks 936
types 705

symbols
bar repeats 861, 867
bar rests 886
caret 157
chords. See chord symbols. See also chord 
diagrams
ornaments 741
pedal lines 808
playing techniques 813
speech bubbles. See comments
vibrato bar 778

symphony. See flows
syncing

videos to music 139
syncopation

beat grouping 590
stemlets 588

system breaks 367, 388
automatic 385
bar repeats 385, 388
copying to other layouts 393, 394
deleting 389
divisi 916
hiding staves 374
inserting 388
lines 825
signposts 349, 388, 389
slurs 890
staff spacing 371
staff visibility 374
ties 944

system dividers 911
hiding 912
showing 912
width 912

system formatting 393
copying to other layouts 394

system objects 913
layouts 913
lines 305
positions 913
rehearsal marks 839
repeat endings 853, 855
repeat markers 859
selecting 334, 337–339
size 370, 383, 909
tempo marks 926, 929
text 307
time signatures 955

system spacing 371, 408
changing 371
default settings 371, 408
justification 372, 408

system text 397, 913
alignment 404
borders 404
formatting 308, 310
hiding 405
inputting 307
moving 404
multiple positions 913
selecting 334, 337–339
showing 405
signposts 349
staff-relative placement 343
stave positions 913

system track 337
deleting music 554
hiding 338, 345
inputting bars 240
inputting beats 240
selecting music 338, 339

systemic barlines
braces 592
brackets 592
secondary brackets 595, 596
sub-brackets 595, 596
sub-sub-brackets 597
text alignment 404

systems
bar numbers 563, 567, 569
breaks. See system breaks
casting off 385, 386
changing indents 915
chord symbols 605
coda gap 859
condensed staves. See condensing
dividers. See system dividers
divisi 916
fixing 385, 386
gaps 857
indents 382, 904, 909, 914, 915
rehearsal marks 839
sections 857
selecting 334, 336
spacing. See system spacing
splitting 857
staff labels 903, 908, 915
text. See system text
timecodes 850, 851
tonality 700
track. See system track
trill marks 745
vertical position. See system spacing
width 382

T
tabla notation 996
tablature 917

beaming 918
bend intervals 774
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tablature (continued)
bends. See guitar bends
bracketed noteheads 728, 729, 768, 773
caret 157
changing string for notes 919
chords 165, 184
clefs 616
dead notes 782
default notation 161, 165
dives 773
frets 116
green notes 917, 919
guitar bends 768, 918
harmonics 734, 737
hiding 918
hold lines 768, 775
intervals 774
note input 165, 184
notes out of range 199, 727, 917, 919
open pitches 118
parenthesized fret numbers 768, 773
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
question marks 199, 917
resetting strings 919
rhythms 918
showing 918
stems 918
strings 116, 118, 161, 165
ties 938
trills 744
tuning 104, 116, 118, 119

tables
comments 361

tabs
bar 27
closing 39
groups 40
hiding 25
layouts 36, 38
moving 40, 41
opening 38
order 40
showing 25
showing multiple 40
switching 39
view options 38

tacets 17, 389
formatting 389
hiding 390
margins 392
paragraph style 389
removing players from flows 123
showing 390
text 391

tambourine. See unpitched percussion. See also playing 
technique-specific noteheads
tanto. See tempo marks
tap tempo 231
tapping 665, 779

deleting 785
inputting 290
moving 783

tapping (continued)
popover 268
staff-relative placement 783

techniques 813
combinations 499, 503
endpoint configurations 484
exclusion groups 497
expression maps 489
guitar 778
percussion 506, 511, 985, 987
playback 499, 503, 512, 513

templates 55
brackets 55
categories 55
ensembles 83, 99
flow headings 364
master pages 363
new projects 53
pages 21, 363
playback 415, 473, 474, 479, 482
players 83, 99
staff grouping 55, 594
staves 55, 594
titles 364

tempo 926
bpm 932
changing 450
default 926, 932
deleting changes 451
drawing 447
editing 447
equations. See tempo equations
finding 320, 847
fixed tempo 463, 472
follow tempo 463, 472
inputting 449
marks. See tempo marks
metronome marks 932
MIDI recording 463
muting in playback 462
Play mode 447
range 934
recording 463
tracks. See tempo tracks

tempo changes. See tempo marks
tempo equations 937

inputting 230, 231
panel 231
popover 230

tempo marks 447, 926, 935
abbreviated 931
absolute tempo changes 231, 927
alignment 929
appearance 928
beat units 230, 342, 933
changing 342, 928, 931, 933
components 927, 928
continuation lines 926, 935–937
decimal places 233, 234, 933
deleting 932
equations. See tempo equations
filters 340
finding 320, 847
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tempo marks (continued)
formatting 936, 937
gradual tempo changes 231, 927, 934, 935
handles 935
hiding 932
hyphens 936
inputting 228, 231, 233, 234
integers 233, 234
length 935
metronome marks. See metronome marks
moving 450, 930
multiple positions 913, 929
muting in playback 462
panel 231
parentheses 927, 928
placement 929
playback 464, 926, 932, 934
poco a poco 929
popover 229
position 929
rehearsal marks 839
relative tempo changes 231, 927, 934
repeats 464
reset tempo 231, 927
selecting 334, 337–339
showing 932
signposts 349, 928, 932
style 936
text 342, 931
types 229, 231, 927
vertical positions 913

Tempo panel 231
tempo tracks 70–72

dialog 71, 72
exporting 72
importing 70, 71
Play mode 447. See also time track

tenor clef. See clefs
tenuto. See articulations
terminal lines 825
terminology

British vs. American English 11
note durations 11

text 397
abbreviated tempo text 931
alignment 308, 404
annotations 825
borders 404
codes. See tokens
comments 356, 360
default settings 307
dynamics 639, 643
editing 310, 397
editor. See text editor
expressive 628, 639
filter 340
flow titles 136
formatting 308, 405
glissando lines 765
hiding 405
horizontal 838
horizontal alignment 404
inputting 307, 835

text (continued)
lines 825, 835–838
lyrics 704, 708
markers 318, 319, 844, 846
missing fonts 58
moving 404
multiple positions 913
music fonts 396
paragraph styles 405
pedal lines 810, 811
playing techniques 813, 814
rehearsal marks 839
repeat markers 858
showing 405
signposts 349, 405
staff-relative placement 343
system text 307, 913
tacets 391
tempo marks 342, 931
tokens. See tokens
types 397

text editor 308, 310
comments 357
lyrics 708
Write mode 308

text frames
flow headings 380
identifying 397
running headers 380

text objects 397, 916
editing 310
identifying 397

theme
changing 43

theorbo. See fretted instruments
thickness

brackets 595
grace note slashes 684
string shift indicators 671
ties 942

thru
MIDI 204

thumbs 665
fingerings 665
inputting 215
popover 214, 215

tick
breath marks 688

tie chains 938
articulations 550, 938
bracketed noteheads 730
clefs 617
deleting 947
glissando lines 766
selecting 938
slurs 888
splitting 947
stem direction 923
tablature 938
tremolos 964

ties 19, 938, 940, 944
accidentals 945
appearance 941
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ties (continued)
articulations 550, 551, 938
bracketed noteheads 730
breaking 947
cautionary accidentals 542, 736
chains. See tie chains
chords 943
clef changes 945
clefs 617
collision avoidance 939
cross-staff 189, 946
cross-voice 189, 946
curvature direction 943, 944
dashed 941, 942
deleting 947
dotted 941, 942
editorial 941
forcing 171
formatting 942
frame breaks 944
grace notes 189, 945
guitar bends 775
half-dashed 941
inputting 144, 189
inverting 944
laissez vibrer 946
non-adjacent notes 189, 945
non-standard types 944
note grouping 171
parentheses 730
placement 939
position 888, 939
slurs 888, 890
slurs vs. ties 940
solid 941
splitting 171, 947
staff lines 939
stem direction 923
style 941, 942
system breaks 944
tablature 938
tie chains. See tie chains
time signature changes 945
time signatures 938
tremolos 964
voices 939, 943

TIFF files 535
color 536
exporting 525, 527
layout numbers 128
layouts 525, 527
resolution 536

time
display 472, 473
inserting 238–240
latency 204, 207
markers 844
rhythmic position 20
signatures. See time signatures
track. See time track
transport window 472, 473
videos 139

time and date. See date and time

time bars. See repeat endings
time signatures 949, 951

above staff 955
additive 951
aggregate 951
alternating 951
appearance 950, 961
bar numbers 569
barlines 558, 561
beam grouping 20, 575, 590
beat groups 20, 957
bracketed groups 954
changing 179, 342, 555
click 204
compound 951
custom 951
deleting 961
denominators 949, 956, 957
design 961
filter 340
font 950
font styles 961
height 950
hiding 960
inputting 220, 224, 225
Insert mode 179
interchangeable 951
irregular 951
large 954
MIDI recording 204
moving 959
multiple positions 913
non-power of two 951
note grouping 20, 575, 590
noteheads 957
numerators 949, 956, 957
open 951, 956, 958
panel 222
parentheses 220, 224, 956, 958
pick-up bars 222, 226, 227, 951, 953
placement 950
polymeter 224–227, 949
popover 220
position 224, 225, 955, 959
rest grouping 575, 590
selecting 334, 337–339
separators 956, 958
showing 960
signposts 349, 555, 956, 958, 960
simple 951
size 955
styles 956, 958
system objects 955
ties 938, 945
types 220, 951
upbeats. See pick-up bars
vertical position 913, 954, 955

Time Signatures (Meter) panel 222
time track 447

changing tempo 450
collapsing 455
deleting tempo changes 451
expanding 455
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time track (continued)
inputting tempo changes 449
moving tempo changes 450

timecodes 849
changing 137, 846, 850
dialog 137
drop frame 849
flows 87
frequency 851
inputting 318
markers 318–320
non-drop frame 849
offset 850
panel 319
staff 845, 850
staff spacing 371, 408
start values 850
tempo 320
transport window 472, 473
vertical position 850

times played
changing 464

timpani
key signatures 83
rolls. See tremolos

title pages
text tokens 397

titles
accidentals 399
adding 88, 397
changing 88, 136, 397
default master pages 680
flow headings 380
flows 135, 364
hiding 379, 380
movements 364
projects 135
running headers 380
showing 379, 380
templates 364
text tokens 397

tokens 397
accidentals 399
clefs 399
date 401
file names 398, 528
flow headings 364
flow numbers 364
flows 135, 399, 400
inputting 397
master pages 680
music symbols 399
page numbers 401
project information 88, 135, 399
Roman numerals 400
SMuFL 399
staff labels 398
time 401
titles 135

tonality systems 700
custom. See custom tonality systems
octave divisions 700
panel 219

tones
intervals. See whole steps. See also pitch
microtones. See microtones. See also quarter tones

tongue clicks. See playing techniques
toolbar 24

hiding 24
transport options 24, 25
workspace options 24, 25

toolboxes 32
Notations 143, 151
Notes 143, 144
Play 412, 413

tools 32
arranging. See arranging
selecting 32, 33
timecodes 849

touched pitch 733
harmonics 737

track names
MIDI import 66

tracks 426
automation. See automation lanes
chords. See chords track
collapsing 455
dynamics. See dynamics lanes
expanding 455
height 455, 456
hiding 455, 456
independent voice playback 460, 487
instruments. See instrument tracks
markers 454
muting 461
piano roll editor 420
playing techniques. See playing techniques lanes
showing 455, 456
soloing 461
system. See system track
tempo. See tempo tracks
time. See time track
types 426
velocity. See velocity lanes
video 455
voices 460

transition lines 818, 823
automation 442
duration 819
dynamics 433
inputting 291, 295, 297
playing techniques 821
showing 821

translation lyrics 703
changing lines to 713
changing lyrics to 704
popover 311

transport 472
basic options 24, 25
hiding 472
playhead 457
playhead position 472, 473
repeats 464
showing 472
window 472

Transpose dialog 202, 203
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transposed pitch 127
chord symbols 127, 606, 607
clefs 619, 620
input pitch 167
instrument transpositions 904
layouts 127
note input 167
part layouts 124, 127
showing 127
staff labels 901, 904
status display 32
viewing 127

transposing 203
accidentals 203
chord symbols 127, 202, 203, 599
clefs 83, 621
dialog 203
expression maps 488, 490, 492, 496
figured bass 201, 202
instruments. See transposing instruments
key signatures 202, 203, 696, 697
layouts 124, 127, 131
notes 198, 199, 201–203, 424
octaves 199
pitch. See transposed pitch
popover 198
selections 202
staff labels 905

transposing instruments 104, 127, 901
chord symbols 606, 607
clefs 83, 619
concert pitch 127
instrument transpositions 904, 905
key signatures 127, 694, 696, 699
layout names 131
layouts 127
staff labels 901, 904, 905
transposed pitch 127

tre corde 801
treble clef. See clefs
trees

stems. See split stems
tremblements 741
tremolo arm. See vibrato bar
tremolo strokes 963, 965, 1001

changing number 965
tremolos 963

angles 964
articulations 511
deleting 965
inputting 323, 325, 330, 331
measured 963
multi-note 323, 963
panel 325, 331
placement 964
playback 460, 511–513
popover 323, 330
position 964, 966
single-note 323, 963
speed 965
strokes. See tremolo strokes
tie chains 964
tuplets 963

tremolos (continued)
types 323, 963
unmeasured 963

triangle noteheads 721, 723
percussion 985

trill intervals 748, 749, 753
accidentals 752
appearance 752, 753
auxiliary notes 752
changing 749, 750
deleting 751
hiding 749
Hollywood-style 752
indicators 748
inputting 271
microtonal 748
position 753
resetting 751
showing 749
signposts 349, 749

trill lines 745, 746
hiding 746
length 747
showing 746
speed 745, 746

trills 741, 744, 754
accidentals 752, 753
alignment 743
appearance 752, 753
auxiliary notes 752
deleting 350
deleting intervals 751
extension lines. See trill lines
filter 340
generated 755
grace notes 754
handles 747
hiding marks 745
Hollywood-style 752
inputting 267, 271, 272
intervals 267, 748, 749, 752, 753
length 747
lines. See trill lines
moving 742, 743
panel 270, 272
pitch 749, 750, 756
placement 742
playback 512, 513, 754, 755
popover 267
position 742, 743
resetting 751
sampled 755
signposts 349, 748–750
speed 745, 754, 755
staff-relative placement 343
start position 743
starting pitch 756
tablature 744

trimming flows 235, 236, 554
triple accidentals

respelling 200
transposing 203

triple-dotted notes 172
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triplets 967
inputting 144, 194, 195
swing playback 466

troppo. See tempo marks
tucking index

changing 827
lines 827

tuning
changing 83, 116, 118
chord diagrams 610, 612, 613
custom 116, 118, 119, 609, 610
dialog 116
exporting 119
fretted instruments 83, 104, 116
guitar 83, 104, 116
importing 118
open pitches 118
strings 118
systems. See tonality systems

tuplet brackets 973
end position 974
handles 973
hiding 973
hooks 973
horizontal 975
position 967
showing 973

tuplet numbers 975, 976
appearance 976
hiding 976
horizontal position 976

tuplet ratios. See tuplet numbers
tuplets 967

accidentals 185
appearance 973, 975, 976
articulations 209, 549
barlines 970
beams 588, 972
beat units 197
brackets. See tuplet brackets
deleting 969, 972
end position 974
filter 340
formatting 976
handles 973
hiding 976
hooks 973
horizontal brackets 975
inputting 194, 968, 969
inverting 974
moving 353, 971, 976
nested tuplets 968
notes 969
numbers. See tuplet numbers
percussion kits 981
placement 967
popover 194, 195
position 967
quantization 68
ratios. See tuplet numbers
showing 976
signposts 349, 973, 976
slurs 211

tuplets (continued)
staff-relative placement 974
swing playback 466
tremolos 963
turning into normal notes 969
turning notes into 969
types 195, 967
unscaling 969

Turkish music
octave divisions 700

turn off. See hiding. See also deactivating
turns 741

intervals 741
jazz. See jazz ornaments
pages. See frame breaks

tutorials 53
tutti 916
two-up page arrangement 530
types

appearance 344
arpeggio signs 268
articulations 787
bar repeats 324
barlines 558
breath marks 262, 688
caesuras 262, 689
caret 157
chord symbols 249, 599
clefs 257
dynamics 243, 628
enclosures 564
fermatas 262, 687
fingerings 214, 670
glissando lines 268
grace notes 685
holds 262, 687
jazz articulations 267, 786–788
key signatures 216
lines 823, 825
lyrics 311, 703, 704
notehead sets 718
noteheads 719, 722
notes 146
octave lines 258, 622
ornaments 266, 787
pauses 262, 687
pedal lines 293, 801
percussion legends 992
playing techniques 291, 813
rehearsal marks 842
repeat endings 322
repeat markers 322
resetting 344
rhythm slashes 1002
syllables 704, 705
templates 55
tempo marks 229, 231, 927
text 397
ties 941
time signatures 220, 951, 956, 958
tracks 426
tremolos 323, 963
tuplets 195, 967
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U
ukulele. See fretted instruments
una corda pedal 801

appearance 811
MIDI controller 812
text 811

unassigned instruments
loading sounds 479

uncompressed MusicXML 63, 64
undamped. See playing techniques. See also laissez 
vibrer ties
underlines

text 308
ungrouping

dynamics 648
playing techniques 822

unisons 916
altered. See altered unisons
stems 174
voices 174, 999

units
beats 137, 231, 320, 342, 932, 933
measurement 45
metronome marks 342, 933
quantization 68
rhythmic grid 155
swing playback 466
system track 337
tempo 231, 320
time 137, 472
tuplets 195
video 137

Universal Indian Drum Notation 996
unlinking

dynamics 650
slurs 900

unmeasured tremolos. See tremolos
unpitched percussion 978, 985

articulations 511, 981
drum sets. See drum sets
dynamics in kits 982
exporting kits 980
ghost notes. See bracketed noteheads
grid kit presentation 112–115
groups 112
importing kits 980
Indian drum notation 996
individual instruments 978
instrument order 114
kits. See percussion kits
legends 990–992
MIDI files 995
moving notes 981
MusicXML files 995
naming groups 113
notations 981
note input 180, 182, 183, 421
noteheads 985, 989
parentheses. See bracketed noteheads
percussion maps 488, 506
Play mode 420, 995
playback 488, 506, 511, 985

unpitched percussion (continued)
playing techniques 511, 982, 985, 987, 988
presentation types 109, 978, 983, 984
rhythm slashes 109, 1003
scrapes. See playing techniques
staff labels 907
staff position 985, 988, 989
staves 109, 983, 984
stem direction 109, 183, 993, 994
stickings 982
techniques. See playing techniques
tremolos 511
tuplets 981
voices in kits 993, 994

unscaling tuplets 969
up arpeggio signs. See arpeggio signs
up-bow breath marks 688
up-stem voices. See voices
upbeats. See pick-up bars
upper case

flow numbers 400
Roman numerals 400

upper notes
trills 756

user interface 23
transport options 25
windows 23

user name
comments 356, 361

V
value fields 150
value line

automation 439, 442
dynamics 429, 433
tempo 447

values
changing 150
frame rates 137
latency compensation 207
metronome marks 342, 933
notes. See note durations
rhythmic grid 32, 156
timecodes 137, 850

valves
fingerings 670

velocity
bracketed noteheads 729
changing 438
expression maps 496
lanes. See velocity lanes
MIDI import 66

velocity lanes 429, 437, 438
changing velocity 438
hiding 438
resetting velocity 439
showing 438

verse numbers 716
hiding 716
lyric line numbers 712
showing 716
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versions
files 57

vertical alignment
dynamics 647, 648
lines 821
playing techniques 821

vertical justification
staves 372, 408
systems 372, 408

vertical lines. See lines. See also arpeggio signs
vertical position

articulations 549–551
bar numbers 567–569
breath marks 689
caesuras 690
changing 343
chord symbols 604, 605
dynamics 629, 640
fermatas 689
figured bass 652, 656
fingerings 661, 667, 668
flipping items 343
flow headings 364, 379, 380
harp pedal diagrams 798
instruments 97, 98
layouts 128
lines 826, 828, 829, 832
lyrics 701, 703, 710, 712–715
markers 845
modifiers 640
ornaments 742
pauses 689
pedal lines 803
players 97, 98
playing techniques 343, 815
poco a poco 640
rehearsal marks 839, 913
repeat endings 855, 913
repeat markers 859, 860, 913
rests 879
rhythm slashes 872
slurs 890, 893
staves 97, 98, 371, 372, 408
system objects 913
system text 913
systems 371, 372, 408
tacets 392
tempo marks 913, 929
text 343, 913
ties 939
time signatures 913, 954, 955, 959
timecodes 845, 850
tremolos 964
trills 742
tuplets 967

vertical spacing
bracketed noteheads 729, 731
chord diagrams 610
ossia staves 911
percussion kits 115
staves. See staff spacing
systems. See system spacing
tacets 392

vibrato. See playing techniques
vibrato bar 768, 773, 778

chords 773
deleting 350, 785
dips 286, 778, 782
dives 773, 778
duration 784
inputting 280–283, 287, 288
intervals 774, 782
length 784
lines 287, 288, 778, 784
playback 773
pre-dives. See guitar pre-bends
returns 773, 778
scoops 778

Video Properties dialog 137
videos 53, 136

adding 139
audio 141, 469
dialog 137
flows 87
formats 137
frame rates 141, 142
hiding 140
locating 139
markers 454, 844
mixer 469
panel 319
reloading 139
removing 141
size 140
start position 139
syncing 139
timecodes 849, 850
track 455
tutorials 53
volume 141
window 140

view options 34, 537
background color 44
bar numbers 566
bar repeats 864
changing 32
chord symbols 600, 604
colors 44
comments 356, 361
exporting 537
figured bass 657
frame break signposts 388
full screen mode 41
galley view 34, 42
harp pedaling 727
hiding 345
layouts 27, 36
mixer 471
moving music 346–348
music area 28, 35, 42
notes 997
notes out of range 727
page arrangements 32, 35, 42
page color 44
page view 34, 42
panels 31, 37
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view options (continued)
percussion legends 990
playhead 458, 473
print preview 345, 518
printing 537
rests 882
signposts 350
slash regions 870
system break signposts 389
system track 338
tabs 27, 36, 38
time signature signposts 960
timecode 473
tracks 426, 455
transport 473
types 34
video window 140
voices 997
windows 41
zoom 35, 348, 426

vivace. See tempo marks
vocal scores. See layouts
vocal staves

barlines 55
brackets 55
staff grouping 55, 594

voice colors
exporting 537
hiding 345, 997
printing 537
showing 997

voice column index 998, 999
order 999

voices 174, 544, 997
accidental stacking order 543
adding 174
alignment 998
articulations 548
automation 439
bar rests 188
beaming 923
caret 157, 174
changing 353, 354, 1002
chord symbol playback 453
chords 192
colors 997
column index 999
creating new 174
cues 627
deleting 1000
direction 871
drum sets 112
dynamics 245, 247, 429, 637
endpoints 487
fermatas 689, 691
filters 340
flows 487
glissando lines 274, 275
grace notes 683
hiding 872
identifying 32, 997
inputting 174, 192, 421
Insert mode 178, 179

voices (continued)
MIDI recording 206
moving notes 353
octave lines 260
order 999
overlapping 999
parts. See layouts
percussion kits 109, 993, 994
piano roll editor 420
placement 998
playback 460, 487
playing techniques 295, 297
position 998
rests 879, 881, 886
rhythm slashes 175, 871
selecting 334
showing 872
slash regions 872
slashes 175, 353, 871, 1001, 1002
slurs 889, 893, 895
status bar 32
stem direction 921, 924, 993, 994, 997, 1001
swapping contents 354
swapping order 999
switching between 174
ties 189, 943, 946

volta lines. See repeat endings
volume

channel meters 469
dynamics 628, 633
MIDI 650
mixer 469
playback 496
resetting 462
silence playback template 473, 474
velocity 496
video audio 141

VST and MIDI Instruments panel 412, 415
VST instruments 415

allowing 418
blocking 418
editing 415
endpoints 481, 484
expression maps 489
instances 415
loading 417, 418
names 482
numbering 415
percussion maps 488
playback 473, 474, 481, 488, 506
ports 482

W
w/ bar. See vibrato bar
walker noteheads 722, 723
warnings

audio engine 32
deleting players 81, 98
different Dorico versions 57
MIDI input 32
missing fonts 58
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watermarks 537
exporting 525
printing 522

WAV files
exporting 73, 74

wavy lines. See wiggly lines. See also lines
wedge lines 305, 823

hiding 820
inputting 305
showing 819, 820, 833

wedge noteheads 721, 723
weight

time signatures 961
Western tonality

key signatures 693
octave divisions 700

whammy bar. See vibrato bar
white noteheads 718, 719, 723
whole notes 11, 146

beats 236
metronome marks 230
tuplets 197

whole step trills 748, 754
appearance 752
hiding 745, 749
inputting 267, 272
position 753
showing 745, 749

whole steps 541
automation 439
bend intervals 774, 782
pitch bend 439
string pitches 116
tonality systems 700
transposing instruments 104, 699
trills. See whole step trills

whole tone chord symbols 251
width

accidentals 544
barlines 558
bars 382
braces 595
brackets 595, 597
H-bars 884
hairpins 632
note durations 406, 515. See also note spacing
noteheads 721
system dividers 912
systems 382

wiggly lines 763, 786, 823
glissando lines 763, 764
hiding 820
inputting 273–277, 305
jazz articulations 267, 270, 276, 277, 786, 788
showing 819, 820, 833
trills 745, 746

wildcards. See tokens
wind instruments

playing techniques 294
windows

mixer 469, 471
moving tabs 41
multiple 38, 40, 41

windows (continued)
opening 41
playback 41
project 23
splitting 40
tabs 40
transport 472
video 140
VST instruments 415
workspaces 36

wood block
adding 95, 105

workflow
comments 356

worksheets
extracts. See flows
text alignment 404

workspaces 16
key commands 13, 50
options 24, 25
preferences 45
setting up 36

Write mode 16, 143
caret 160
inputting notations 209
inputting notes 157
inputting vs. editing 153
navigation. See navigation
panels 31, 143, 146, 147, 153
popovers 18
selecting 334, 336, 338, 339
selecting notes 345
signposts 349
switching 143
system track 337
text editor 308
toolboxes 32, 143, 144, 151
Transpose dialog 203

X
X-noteheads 720, 723

dead notes 782

Z
zero

chord diagrams 608, 614
string indicators 674

zig-zag arrangement
accidentals 543

zoom 32
bar repeats 864
changing 348
chord symbols 604
drum editor 426
event display 426
lyrics 708
options 32, 35, 348
piano roll editor 426
slash regions 870
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